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ENGLISH

About this user guide

Thank you for choosing this LG product. Please carefully read this user
quide before using the device for the first time to ensure safe and proper
use.
+ Always use genuine LG accessories. The supplied items are designed
only for this device and may not be compatible with other devices.

+ Descriptions are based on the device default settings.

- Default apps on the device are subject to updates, and support for
these apps may be withdrawn without prior notice. If you have any
questions about an app provided with the device, please contact an
LG Service Centre. For user-installed apps, please contact the relevant
service provider.

- Modifying the device's operating system or installing software from
unofficial sources may damage the device and lead to data corruption
or data loss. Such actions will violate your LG licence agreement and
void your warranty.

- Some content and illustrations may differ from your device, depending
on the area, service provider, software version, or OS version, and are
subject to change without prior notice.

- Software, audio, wallpaper, images, and other media supplied with
your device are licenced for limited use. If you extract and use these
materials for commercial or other purposes, you may be infringing
copyright laws. As a user, you are fully responsible for the illegal use of
media.

+ Additional charges may incur for data services, such as messaging,
uploading, downloading, auto-syncing and location services. To avoid
additional charges, select a data plan suitable to your needs. Contact
your service provider to obtain additional details.

- This user guide is written in major languages for each country.
Depending on the language used, content may partly differ.



Instructional notices

A WARNING: Situations that could cause injury to the user and third
parties.

A CAUTION: Situations that may cause minor injury or damage to the
device.

E NOTE: Notices or additional information.

About this user guide
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Guidelines for safe and efficient use

Please read these simple guidelines. Not following these guidelines may be
dangerous or illegal.

Should a fault occur, a software tool is built into your device that will gather a
fault log. This tool gathers only data specific to the fault, such as signal strength,
cell ID position in sudden call drop and applications loaded. The log is used only to
help determine the cause of the fault. These logs are encrypted and can only be
accessed by an authorised LG Repair centre should you need to return your device
for repair.

Exposure to radio frequency energy
Radio wave exposure and Specific Absorption Rate (SAR) information.

This device has been designed to comply with applicable safety requirements for
exposure to radio waves. These requirements are based on scientific guidelines that
include safety margins designed to assure the safety of all persons, regardless of
age and health.

+ The radio wave exposure guidelines employ a unit of measurement known
as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using
standardised methods with the device transmitting at its highest certified
power level in all used frequency bands.

+ While there may be differences between the SAR levels of various LG device
models, they are all designed to meet the relevant guidelines for exposure to
radio waves.

+ The SAR limit recommended by the International Commission on Non-lonizing
Radiation Protection (ICNIRP) is 2 W/kg averaged over 10 g of tissue.

+ The highest SAR value for this model tested for use at the ear is 0.551 W/kg
(10 g) and when worn on the body is 1.531 W/kg (10 g).

+ This device meets RF exposure guidelines when used either in the normal use
position against the ear or when positioned at least 5 mm away from the body.
When a carry case, belt clip or holder is used for body-worn operation, it should
not contain metal and should position the product at least 5 mm away from
your body. In order to transmit data files or messages, this device requires a
quality connection to the network. In some cases, transmission of data files
or messages may be delayed until such a connection is available. Ensure the
above separation distance instructions are followed until the transmission is
completed.



Information about the RF exposure from FCC

In August 1996, the Federal Communications Commission (FCC) of the United
States, with its action in Report and Order FCC 96-326, adopted an updated safety
standard for human exposure to radio frequency (RF) electromagnetic energy
emitted by FCC regulated transmitters. Those guidelines are consistent with the
safety standard previously set by both international and US. standards. The design
of this device complies with FCC guidelines and these international standards.

Part 15.19 statement

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that
may cause undesired operation.

Part 15.21 Statement

Changes or modifications not expressly approved by the manufacturer could void
the user's authority to operate the equipment.

Body-worn Operation

This device was tested for typical bodyworn operations with the back of the device
kept 0.39 inches (1cm) between the user's body and the back of the device. To
comply with FCC RF exposure requirements, a minimum separation distance of
0.39 inches (1cm) must be maintained between the user's body and the back of
the device.

Any beltclips, holsters, and similar accessories containing metallic components
may not be used. Body-worn accessories that cannot maintain 0.39 inches (1cm)
separation distance between the user's body and the back of the device, and have
not been tested for typical body-worn operations may not comply with FCC RF
exposure limits and should be avoided.
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Part 15.105 Statement
This equipment has been tested and found to comply with the limits for a class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates uses and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

+ Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.

Product care and maintenance

+ Use only in-box accessories which are authorised by LG. LG does not guarantee
any damage or failure which is caused by third party accessories.

+ Some contents and illustrations may differ from your device without prior
notice.

+ Do not disassemble this unit. Take it to a qualified service technician when repair
work is required.

+ Repairs under warranty, at LG's discretion, may include replacement parts
or boards that are either new or reconditioned, provided that they have
functionality equal to that of the parts being replaced.

+ Keep away from electrical appliances such as TVs, radios and personal
computers.

+ The unit should be kept away from heat sources such as radiators or cookers.
+ Do not drop.
+ Do not subject this unit to mechanical vibration or shock.

+ Switch off the device in any area where you are required to by special
regulations. For example, do not use your device in hospitals as it may affect
sensitive medical equipment.
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Do not handle the device with wet hands while it is being charged. It may cause
an electric shock and can seriously damage your device.

Do not charge a handset near flammable material as the handset can become
hot and create a fire hazard.

Use a dry cloth to clean the exterior of the unit (do not use solvents such as
benzene, thinner or alcohol).

Do not charge the device when it is on soft furnishings.

The device should be charged in a well ventilated area.

Do not subject this unit to excessive smoke or dust.

Do not keep the device next to credit cards or transport tickets; it can affect the
information on the magnetic strips.

Do not tap the screen with a sharp object as it may damage the device.

Do not expose the device to liquid or moisture.

Use accessories like earphones cautiously. Do not touch the antenna
unnecessarily.

Do not use, touch or attempt to remove or fix broken, chipped or cracked glass.
Damage to the glass display due to abuse or misuse is not covered under the
warranty.

Your device is an electronic device that generates heat during normal operation.
Extremely prolonged, direct skin contact in the absence of adequate ventilation

may result in discomfort or minor burns. Therefore, use care when handling your
device during or immediately after operation.

If your device gets wet, immediately unplug it to dry off completely. Do not
attempt to accelerate the drying process with an external heating source, such
as an oven, microwave or hair dryer.

Guidelines for safe and efficient use 9



+ The liquid in your wet device, changes the colour of the product label inside your
device. Damage to your device as a result of exposure to liquid is not covered
under your warranty.

A mobile device requires proper air circulation in order to dissipate heat. Direct
skin contact and inadequate circulation of air flow to the device may cause the
device to overheat. The device must be at least 1.0cm from between the user's
body.

+ Prevent dust of any other foreign substances from getting into the Charger/
USB cable port. It may cause heat or fire.

- Avoid exposing the device to low air pressure at high altitude.

Do not expose the device to extremely low air pressure. Otherwise, it can cause
explosion of the battery or leakage of flammable liquid or gas.

Efficient device operation

Electronics devices
All devices may receive interference, which could affect performance.

+ Do not use your device near medical equipment without requesting permission.
Please consult your doctor to determine if operation of your device may
interfere with the operation of your medical device.

+ Pacemaker manufacturers recommend that you leave at least 15 cm of space
between other devices and a pacemaker to avoid potential interference with the
pacemaker.

+ This device may produce a bright or flashing light.
+ Some hearing aids might be disturbed by devices.

+ Minor interference may affect TVs, radios, PCs etc.

Use your device in temperatures between 0 °C and 35 °C, if possible. Exposing
your device to extremely low or high temperatures may result in damage,
malfunction, or even explosion.
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Road safety

Check the laws and regulations on the use of devices in the area when you drive.
+ Do not use a hand-held device while driving.
- Give full attention to driving.

+ Pull off the road and park before making or answering a call if driving conditions
SO require.

+ RF energy may affect some electronic systems in your vehicle such as car
stereos and safety equipment.

+ When your vehicle is equipped with an air bag, do not obstruct with installed
or portable wireless equipment. It can cause the air bag to fail or cause serious
injury due to improper performance.

If you are listening to music whilst out and about, please ensure that the volume
is at a reasonable level so that you are aware of your surroundings. This is of
particular importance when near roads.

Avoid damage to your hearing

To prevent possible hearing damage, do not listen at high volume
levels for long periods.

Damage to your hearing can occur if you are exposed to loud sound for long
periods of time. We therefore recommend that you do not turn on or off the
handset close to your ear. We also recommend that music and call volumes are set
to a reasonable level.

+ When using headphones, turn the volume down if you cannot hear the people
speaking near you, or if the person sitting next to you can hear what you are
listening to.

E + Excessive sound pressure from earphones and headphones can cause
hearing loss.
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Glass Parts

Some parts of your device are made of glass. This glass could break if your device is
dropped on a hard surface or receives a substantial impact. If the glass breaks, do
not touch or attempt to remove it. Stop using your device until the glass is replaced
by an authorised service provider.

Blasting area

Do not use the device where blasting is in progress. Observe restrictions and follow
any regulations or rules.

Potentially explosive atmospheres
+ Do not use your device at a refueling point.
+ Do not use near fuel or chemicals.

+ Do not transport or store flammable gas, liquid or explosives in the same
compartment of your vehicle as your device or accessories.

In aircraft
Wireless devices can cause interference in aircraft.
+ Turn your device off before boarding any aircraft.

- Do not use it on the ground without permission from the crew.

Children

Keep the device in a safe place out of the reach of small children. It includes small
parts which may cause a choking hazard if detached.

Emergency calls

Emergency calls may not be available on all mobile networks. Therefore you should
never depend solely on your device for emergency calls. Check with your local
service provider.
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Battery information and care

+ You do not need to completely discharge the battery before recharging. Unlike
other battery systems, there is no memory effect that could compromise the
battery's performance.

+ Use only LG batteries and chargers. LG chargers are designed to maximise the
battery life.

+ Do not disassemble or short-circuit the battery.

+ Keep the metal contacts of the battery clean.

Replace the battery when it no longer provides acceptable performance. The
battery pack may be recharged hundreds of times before it needs replacing.

Recharge the battery if it has not been used for a long time to maximise
usability.

Do not expose the battery charger to direct sunlight or use it in high humidity,
such as in the bathroom.

Do not leave the battery in hot or cold places, as this may deteriorate battery
performance.

+ Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions.

+ Always unplug the charger from the wall socket after the device is fully charged
to save unnecessary power consumption of the charger.

+ Actual battery life will depend on network configuration, product settings,
usage patterns, battery and environmental conditions.

+ Make sure that no sharp-edged items such as animal's teeth or claws, come
into contact with the battery. This could cause a fire.

+ Power Consumption (Networked Standby Mode) : 0.5 W

Securing personal information

Make sure to protect your personal information to prevent data leakage or
misuse of sensitive information.

Always back up important data while using the device. LG is not responsible for
any data loss.

Make sure to back up all data and reset the device when disposing of the device
to prevent any misuse of sensitive information.
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+ Read the permission screen carefully while downloading applications.

+ Be cautious using the applications that have access to multiple functions or to
your personal information.

+ Check your personal accounts regularly. If you find any sign of misuse of your
personal information, ask your service provider to delete or change your account
information.

+ If your device is lost or stolen, change the password of your account to secure
your personal information.

+ Do not use applications from unknown sources.

A Notice for Battery replacement

Li-lon Battery is a hazardous component which can cause injury.

- Battery replacement by a non-qualified professional can cause damage

to your device.

Do not replace the battery by yourself. The battery can be damaged,
which can cause overheat and injury. The battery must be replaced by
a qualified professional. The battery should be recycled or disposed
separately from household waste.

In case this product contains a battery incorporated within the product
which cannot be readily removed by end-users, LG recommends that
only qualified professionals remove the battery, either for replacement
or for recycling at the end of this product’s working life. To prevent
damage to the product, and for their own safety, users should not
attempt to remove the battery and should contact LG Service Helpline,
or other independent service providers for advice.

Removal of the battery will involve dismantling of the product case,
disconnection of the electrical cables/ contacts, and careful extraction of
the battery cell using specialised tools. If you need the instructions for
qualified professionals on how to remove the battery safely, please visit
http7/wwwi.ge.com/global/sustainability/environment/take-back-recycling.
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Camera features

Timelapse Control
You can record Time-lapse videos optimised for the situation.

Videos can be recorded with optimal speed and steady motion by
analyzing a variety of shooting environments. The time-lapse speed can be
automatically adjusted according to the shooting target and environment.
Itis also possible to select the time-lapse speed manually.

1 Tap (3 and select Time-lapse by swiping camera modes.

Set camera — «—— Set flashlight

Select screen ratio Set steady cam

e—— Select zoom
«—— Select time-lapse speed
.« .
Select time-lapse for
camera modes

2 Tap e torecord avideo.

- You can change a zoom and time-lapse speed during time-lapse
recording.

+ To pause the recording, tap @. To continue the recording, tap .

While recording a video, you may spread or pinch two fingers to
zoom in or out.

+ While recording a video, you may tap the desired area to adjust the
brightness.
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3 Tap = to stop recording.
+ The recorded video will be saved in Gallery.

5 + Audio is not recorded during Time-lapse recording.

3D AR Effect

Depth camera on the back of the product allows you to shoot realistic
3D AR Effect by recognising facial contours in greater detail. Because
your face is accurately recognised, you can shoot a sticker without your
hands appearing even if your face is partially covered by your hands.

1 Tap (&) and select Sticker by swiping camera modes.
2 Select @

3 Swipe the sticker list left or right to select the AR sticker to use.
+ The face detected by the camera is scanned in 3D.

Custom-designed Features
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A Tap () to take a photo, or tap and hold () to record a video.
+ The photo or video is taken with the 3D AR Effect applied.

5 + The 3D scanning feature of Depth camera is available only for close-up
portrait shooting.

3D Photo Effect

3D Photo Effect allows you to take 3D photos that give a greater feeling
of depth to portraits by using the Depth camera on the back of the
product. Photos taken with 3D Photo Effect can be viewed as moving
pictures in the Gallery app.

1 Tap (3 and select Portrait by swiping camera modes.

2 Select 3D Photo Effect by swiping effect modes for Portrait.

— Select 3D Photo Effect
for effect modes

1— .
Select Portrait for camera
modes
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3 Tap () to take a photo.
+ The photo will be saved in Gallery.
. appears on the image taken with 3D Photo Effect.
4 Select a 3D photo from Gallery or Preview and tap (= to apply a photo
effect.
- Select Save a copy or OK after applying the effect.

« This feature is available only when taking a photo with the rear camera.

+ When you see the message “3D Photo Effect is available’, press
to take a photo. Otherwise, the 3D Photo Effect will not be applied to
the saved photo.
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Audio recording features

Video recording with specialised audio

recording options

You can record a video using three different voice recording options to suit
your purpose.

1 Tap (@ and select Video by swiping camera modes.

2 Tap @ and select Basic, ASMR Recording, or Voice Bokeh by swiping
audio options.

«———— Audio options

Basic
You can record a video with stable stereo sound.

ASMR Recording

With two sensitive microphones in the device, you can record an ASMR
video.
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Voice Bokeh

You can emphasize the voice of a subject by reducing ambient noise.
+ To reduce ambient noise, drag the slide bar to 0.

e

Recording ASMR sounds

This feature allows you to record the audio clearly and precisely by
amplifying the sound from the microphones.

1 Tap Essentials > HD Audio Recorder and tap => ASMR.
2 Tap @ to record the audio.
- To pause the recording, tap @. To continue the recording, tap @.

3 Tap @ to end the audio recording.

LG 3D Sound Engine

LG 3D Sound Engine feature allows you to hear stereoscopic and
optimised sound. When playing music or video, you can enjoy stereoscopic
and immersive sound as if you were listening in the field.

1 Drag the notifications panel downwards.

2 Tap (®)to turn on or off the LG 3D Sound Engine feature.
Or tap Settings > Sound > Sound quality and effects > LG 3D
Sound Engine and tap (0 ) to activate it.

« If you connect an external audio device such as an earphone or speaker

to the product, a pop-up appears to turn on the LG 3D Sound Engine
feature.
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Google Assistant

Google Assistant overview

Your device has the built-in Google Assistant feature. Find answers and
get things done while on-the-go.

E « To use this feature, first connect to the network.

Launching Google Assistant

T Press the Google Assistant key on the left side of the device.
or
Swipe diagonally from a bottom edge corner of the screen.

2 Tap GET STARTED.

3 Follow the on-screen instructions.
« The device saves your voice data for recognition.

/A Set whether to use the voice match unlock function.

« If you use the voice match unlock function, you can unlock the
device even when the device screen is turned off or the device is
charging by saying “OK Google” or “Hey Google”.

E « This feature may be more vulnerable to security than the other screen
locks, such as Pattern, PIN, and Password.
When a similar voice or your recorded voice is used, the screen may be
unlocked.

« To use this feature, on the home screen, tap Settings > Lock screen
& security > Secure lock settings > Smart Lock, and then use the
screen lock method you set to unlock the device. Tap Voice Match,
then enter the currently used unlock method again. Note that Swipe is
excluded.

« You need to unlock the device by using the specified method if you fail to

unlock the device with voice recognition. See Setting a screen lock for details.

Custom-designed Features
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5 Tap Finish.

Accessing by Voice

T When the home screen is turned off or locked, say “OK Google” or
“Hey Google”.

2 When the Google Assistant screen appears, say a command or ask a
question.

Accessing from Home Screen

1 Press the Google Assistant key on the left side of the device.
or
Swipe diagonally from a bottom edge corner of the screen.

2 Say a command or question when you see «« -+ on the bottom of the
screen.

E + In an environment where Wi-Fi or mobile data connection is poor, the
Google Assistant function may be restricted and the speech recognition
accuracy rate may be lowered.

« If the speech is ambiguous, the microphone is covered, a media player is
playing, or the surrounding is loud, the speech recognition accuracy rate
may be lowered. \When you are using the product via voice commands,
say with accurate pronunciation in a quite environment for better
speech recognition accuracy.
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Fingerprint recognition

Fingerprint recognition overview
You must register your fingerprint on your device first before using the
fingerprint recognition function.
You can use the fingerprint recognition function in the following cases:
+ To unlock the screen.
+ To view the locked content in the Gallery.
- Confirm a purchase by signing into an app or identifying yourself with
your fingerprint.
E « You can use fingerprint data for user authentication. There is a
possibility that the fingerprint sensor might recognise a different but
very similar fingerprint as the same registered fingerprint. To strengthen

security, it is recommended that you use the pattern, PIN, or password
method for unlocking the screen.

« If the device cannot detect your fingerprint or you forgot the value
specified for registration, visit the nearest LG Customer Service Centre
with your device and ID card.
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Precautions for fingerprint recognition

Fingerprint recognition accuracy may decrease due to a number of
reasons. To maximise the recognition accuracy, check the following before
using the device.

At the bottom centre of the product’s screen, there is a built-in sensor
that recognises fingerprints. Be careful not to scratch or damage the
fingerprint sensor with metal objects such as coins or keys.

If there are foreign substances (sweat, lotion, water, dirt, grease, etc.)
on the fingerprint sensor or on the finger to be put on the sensor,
fingerprint recognition may not work properly. Wipe the sensor and the
finger clean and remove all moisture before putting the finger on the
sensor.

If the finger's surface is rough due to it being scarred or pruney from
water, the sensor may not be able to recognise the fingerprint. In such
a case, register another fingerprint.

If you bend your finger or use the fingertip only, your fingerprint may
not be recognised. Make sure that your finger covers the entire surface
of the fingerprint sensor.

Scan only one finger for each registration. Scanning more than one
finger may affect fingerprint registration and recognition.

+ The device may generate static electricity if the surrounding air is dry.
If the surrounding air is dry, avoid scanning fingerprints, or touch a
metallic object such as a coin or a key before scanning fingerprints to
remove static electricity.
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Registering fingerprints
You can register and save your fingerprint on the device to use fingerprint
identification.

7 On the home screen, tap Settings > Lock screen & security >
Fingerprints.

« Alock screen must be set in order to be able to use this feature.

+ If the screen lock is not active, configure the lock screen by following the
on-screen instructions. See Setting a screen lock for details.

2 Check the location of the fingerprint sensor at the bottom centre of
the screen, and lightly put the finger on the sensor.

E + Make sure that the finger fully covers the fingerprint sensor.

3 Follow the on-screen instructions.
+ Until the fingerprint registration is completed, move the same finger
around on the sensor little by little.
+ Put the finger on the sensor. When you feel a vibration, remove the
finger from the sensor.
4 When the fingerprint registration is done, tap OK.

- Tap Add more to register another fingerprint. Since the fingerprint
recognition success rate depends on the condition of the registered
fingerprint, it is recommended that you register several different
fingerprints.
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Managing fingerprints
You can edit or delete registered fingerprints.

T On the home screen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 From the fingerprint list, tap a fingerprint to rename it. To delete it, tap
.

Displaying the fingerprint icon when screen if
off

You can set how to display the fingerprint sensor location on the screen
when the screen is off.

7 Onthe home screen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock the screen via the set method.

3 Checkif @ is enabled for the Tap to show icon when screen is off
option. If you don't want to use the function, disable the function by

dragging @ .

Setting the effect when touching the fingerprint icon

You can change the screen effect that appears when you touch the
fingerprint icon.

1 Tap Settings > Lock screen & security > Fingerprints.
2 Unlock according to the specified lock method.
3 Tap lcon effect and select the desired effect.
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Unlocking the screen with a fingerprint

You can unlock the screen or view the locked content by using your
fingerprint. Activate the desired function:

7 On the home screen, tap Settings > Lock screen & security >
Fingerprints.

2 Unlock according to the specified lock method.

3 On the fingerprint settings screen, activate the desired function:
- Screen lock: Unlock screen with a fingerprint.

- Content lock: Unlock content with a fingerprint. To do this, make
sure that the content lock is set.

Multi-tasking feature

Recent Uses Screen

Swipe the Home button — upward and hold to view the recent use
history.

Pop-up window

You can open multiple apps on the screen and easily switch between
them at any time.

1 Swipe up on — from the bottom of the screen.

2 Tap the app icon on the top left of the app screen and select Pop-up
window.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.
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3 The app appears in the form of a pop-up window on the screen.

L]

np

np

5

Using the pop-up window
+ — :Minimises the pop-up window. The pop-up window is minimised

+ This feature may not be available in some apps or screens.

into the app icon floating on the screen, which can be moved anywhere

you want.

. 2 :Expands the app to full screen.

X :Closes the app.

To move the pop-up window: Drag the top of the pop-up window.

To adjust the size of the pop-up window: Drag the left, right or
bottom edge of the pop-up window.

+ You can open up to 5 apps using the pop-up windows.

+ To select an app from the opened apps, tap one of the pop-up windows.
The selected pop-up window comes to the front.

« Pop-up windows cannot be moved to the status bar or navigation bar area.

Custom-designed Features
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Using the app folder for pop-up windows

If you tap — on the pop-up window, the pop-up window is minimised into
the app icon.

You can move the app icon anywhere you want by dragging it.

If two or more pop-up windows are minimised, the app folder is created to
contain the app icons.

E - The recently-used app icon is used as the app folder icon. If you tab the
icon, all the icons for the minimised pop-up windows appear in the app
folder.

- If you touch and hold the app folder for pop-up windows and drag the
app folder into Remove, the app folder will be removed.

+ To remove one of the apps from the app folder, open the app folder and
drag the app icon out of the app folder.

Multi window

When using gesture navigation
1 Swipe up on — from the bottom of the screen.
+ Recently-used apps appear.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.
2 Tap the app icon on the top left of the app to be displayed in the
multiwindow and select Multi window.
+ The selected app appears at the top half of the screen.

3 Tap the other app to be displayed in the multi window.
+ The selected app appears at the bottom half of the screen.
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When using Buttons only navigation
1 Tap[Jon the navigation bar.
+ Recently-used apps appear.
- If you tap the app icon, the App info, Multi window, Pop-up
window and Pin app options appear.
2 Tap the app icon on the top left of the app to be displayed in the
multiwindow and select =
+ The selected app appears at the top half of the screen.

3 Tap the other app to be displayed in the multi window.

5 + To adjust the size of the split screen, drag the bar on the centre of the
screen.

+ To deactivate the multi window feature, drag the centre bar up or down
to the end of the screen.

+ The multi window feature is not supported in some LG apps or apps
downloaded from the Play Store.
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AOD(always-on display)
You can view the date, time or signature when the main screen is turned
off.

Swipe the bottom of the Always-on display screen to activate features
including Camera, Capture+, Wi-Fi, sound settings, Bluetooth®, Flash,
Music and more.

T On the home screen, tap Settings > Display > AOD(always-on
display).
2 Select the image you want to display and tap SAVE.

- Tap the desired image among Digital clock, Analog clock, Dual
clock, Signature or Image.

- Tap Show display and select Tap to show for 10 seconds or
Always show.

- Tap Quick tools & music player to swipe over the status icons for
Quick tools and the music player.

- To enhance brightness for the Always-on display feature, tap
Brighter display.

- To view the help for Always-on display, tap Help.

E + The battery may drain faster when you use Always-on display. Turn this
feature off to save battery power.

+ To deactivate Always-on display feature, on the home screen, tap
Settings > Display > AOD(always-on display), and then tap @ .
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Notes on Water Resistant
Properties

This product is water and dust resistant in compliance with the Ingress
Protection rating IP68.

Your product has undergone testing in a controlled environment and is
proven to be water and dust resistant in certain circumstances (meets
the requirements of classification IP68 as described by the international
standard IEC 60529 - Degrees of Protection provided by Enclosures [IP
Code]; test conditions: 15-35 °C, 86-106kPa, 1.5 meter; for 30 minutes).
Do not expose the device in conditions that are different from the test
conditions. Results may vary in actual use.

/\ WARNING

Despite a rating of IP68, your device is not impervious to conditions not
tested in LG's controlled environment. Please note that any damages that
occur due to such causes changes the colour of the LDI (Liquid Damage
Indicator). If the colour of LDl located inside the product changes, the
product is to be considered ineligible for any free-of-charge repair services
provided under the product’s limited warranty.

Avoid exposing the product to environments with excessive dust or
moisture. Do not use the product in the following environments.

Do not immerse the product in any liquid chemicals (soap, etc.)
other than water.

@ Do not immerse the product in salt water, including seawater.
@ Do not immerse the product in a hot spring.

@ Do not swim with this product.
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&% Do not place the product directly on sand (such as at a beach) or
¥ mud.

Do not immerse your product in water deeper than approximately
1.5 meters.
Do not immerse your product in water for longer than 30 minutes.

- If your product becomes wet be sure to wipe the microphone, speaker,
and stereo jack with a dry cloth before use.

+ Should your product or your hands become wet, dry them before
handling the product.

+ Do not use the product in places where it may be sprayed with high
pressure water (e.g. near a faucet or shower head) or submerge it in
water for extended periods of time, as the product is not designed to
withstand high water pressure.

- This product is not resistant to shock. Do not drop the product or
subject it to shock. Doing so might damage or deform the main unit,
causing water leakage.

- The product’s water and dust resistant features may be damaged by
dropping or receiving an impact.

- If the product gets wet, use a clean, soft cloth to dry it thoroughly.

+ The touch screen and other features may not work properly if the
device is used while wet.

« Your product is water resistant only when the SIM/Memory card tray is
properly inserted into the product.

+ Do not open or close the SIM/Memory card tray while the product is
wet or immersed in water. Exposing the open tray to water or moisture
may damage the product.

- The SIM/Memory card tray contains rubber [packing] to help prevent
dust, water, or moisture from entering the product. Do not damage the
rubber [packing] as this may allow dust, water, or moisture to enter
your product and cause damage.
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A + Failure to follow the provided instructions may invalidate your device's
limited warranty.
« If the device is wet, the LDI located inside the device changes in colour.
In this case, the device is ineligible for any free-of-charge repair services
provided under the device's limited warranty.
« Despite a rating of IP68, your device is not completely impervious to
water in any situation.
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Product components and
accessories

The following items are included with your device.

+ Device + Charger
- USB cable - Quick Start Guide
+ Ejection pin

A .

« The items supplied with the device and any available accessories may

Basic Functions

The items described above may be optional.

vary depending on the area and service provider.

Always use genuine LG Electronics accessories. Using accessories made
by other manufacturers may affect your device's call performance or
cause malfunctions. This may not be covered by LG's repair service.

« Some of the device parts are made of tempered glass. If you drop your

device on a hard surface or subject it to severe impact, the tempered
glass may be damaged. If this happens, stop using your device
immediately and contact an LG Customer Service Centre.

If any of these basic items are missing, contact the dealer from which
you purchased your device.

« To purchase additional items, contact an LG Customer Service Centre.

Some items in the product box are subject to change without notice.

- The appearance and specifications of your device are subject to change

without prior notice for product improvement.
Device specifications may vary depending on the area or service provider.

Remove the protective film from the Fingerprint sensor before using the
fingerprint recognition feature.
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Parts overview

Earpiece — l
Front camera lens —
Volume keys (+/-) —I:

Google Assistant key —s -—

— Proximity/Ambient light
sensor

*— Power/Lock key

— Touch screen

— Fingerprint sensor

— —
Stereo headset jack 4 t Charger/USB cable port
Microphone ——— == Nano-SIM card tray
©)
Rear camera lenses —1—©)
O
Flash ——

§ 1 NFC

— Wireless charging
antenna area

Speaker LI

Basic Functions

Microphone
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A Do NOT attempt to remove the back cover by yourself.

+ Doing so may severely damage the battery and device, which could
cause overheating, fire, and injury. This device's back cover and battery
are not to be removed or replaced by a non-qualified professional.

+ Your phone is an electronic device that generates heat during normal
operation. Extremely prolonged, direct skin contact in the absence of
adequate ventilation may result in discomfort or minor burns. Therefore,
use care when handling your phone during or immediately after
operation.

- Volume keys
- Adjust the volume for ringtones, calls or notifications.

- While using the Camera, gently press a Volume key to take a photo.
To take continuous photos, press and hold the Volume key.

- Press the Volume Down key twice to launch the Camera app when
the screen is locked or turned off. Press the Volume Up key twice to
launch Capture+.

+ Power/Lock key
- Briefly press the key when you want to turn the screen on or off.
- Press and hold the key when you want to select a power control
option.
- Google Assistant key

- You can short-press it once to run Google Assistant. You can press
and hold it to run Google Assistant and then release the finger from
the key to run the voice command function.

- See the Google Assistant for details.
- Fingerprint sensor

- You can use the fingerprint sensor at the bottom centre of the
screen to use the fingerprint recognition function. See Fingerprint
recognition overview for details.
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5 - Some functions may be restricted depending on the region and product
specifications of different telecommunications providers.
+ There are NFC chip and wireless charging antennas built into the rear
part of the product. Be careful not to damage or cover the NFC chip or
wireless charging antennas.

+ Do not put heavy objects on the device or sit on it. Failure to do so may
damage the touch screen.

Screen-protective film or accessories may interfere with the proximity
sensor.

« If your device is wet or is being used in a humid place, the touch screen
or keys may not function properly.

There are two microphones built into this product. Be careful not to cover
the microphones. While you are talking on the phone, do not cover the
microphone with your hand or fingers.

Do not use a phone case that is not a genuine product or cover the
microphone with accessories, tape, etc.

Hold the product correctly as shown in the image when you are using it.

Microphone Do not cover the microphone.
1
A
_—
— o — o ]

\ 7

%

— — y
N 2
~ 7\
Microphone Do not cover the microphone.
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Turning the power on or off

Turning the power on
When the power is turned off, press and hold the Power/Lock key.

E + When the device is turned on for the first time, initial configuration
takes place. The first booting time for the smart phone may be longer
than usual

Turning the power off
Press and hold the Power/Lock key, then select Power off.

Restarting the device

When the device is not working properly or does not respond, restart it by
following the instructions below.

1 Press and hold the Power/Lock key and the Volume Down key at the
same time until the power is turned off.

2 When the device is restarted, release the key.

E « This function is not available when the device is connected to LG Dual
Screen (LM-G905N).

Power control options

Press and hold the Power/Lock key, then select an option.
- Power off: Turn the device off.

- Power off and restart: Restart the device.
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Installing the SIM card

Insert the SIM (Subscriber Identity Module) card provided by your service
provider to start using your device.

A + Be careful with the ejection pin since it has a sharp edge.

« In order for the water-resistant and dust-resistant features to work
effectively, the card tray must be inserted correctly.

7 Insert the pin into the hole of the card tray and press the pin, and then
pull the card tray out of the product.

2 Align the Nano-SIM card or memory card on the card tray and press
the card in the direction of the arrow as shown in the figure.

A

SIM card

Memory card
(optional-sold separately)
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This device supports only Nano SIM cards.

Nano Micro Standard

e @

For problem-free performance, it is recommended that you use the
device with the correct type of SIM card. Always use a factory-made
SIM card supplied by the operator.

Do not lose your SIM card. LG is not responsible for damage and other
issues caused by loss or transfer of a SIM card.

Be careful not to damage the SIM card when you insert or remove it.
When you insert the SIM card or memory card, place it on the card tray
correctly.

\When you insert the card tray back into the device, insert it horizontally
in the direction of arrow as shown in the figure. Make sure that the card
placed on the card tray does not move out of its position.

Insert the SIM card with the gold-coloured contacts facing downwards.
Be sure to insert the SIM card into the device by following the
instructions in the user manual.

If you insert or remove the card tray from the device, be careful not to
let water or other liquids enter into the card tray. If a wet card tray or
card is inserted into the device, your device may get damaged.

Memory card is an optional item.

Frequent writing and erasing of data may shorten the memory card
lifespan.

Some memory cards may not be fully compatible with the device. If you
use an incompatible card, it may damage the device or the memory card,
or corrupt the data stored in it.
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Inserting the memory card

Insert the memory card into your device.

The device can support up to a 2 TB microSD card. Depending on the
memory card manufacturer and type, some memory card may not be
compatible with your device.

1 Insert the ejection pin into the hole on the card tray.
2 Pullout the card tray.

3 Put the memory card on the card tray with the gold-coloured contacts
facing downwards.

Memory card
(optional-sold separately)

L SIM card )

4 Insert the card tray back into the slot.
+ Some memory cards may not be fully compatible with the device. If you

use an incompatible card, it may damage the device or the memory card,
or corrupt the data stored in it.

E « Frequent writing and erasing of data may shorten the memory card
lifespan.
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Removing the memory card
Unmount the memory card before removing it for safety.
7 On the home screen, tap Settings > Storage > /..

2 Insert the ejection pin into the hole in the card tray and then pull out
the card tray from the device.

3 Remove the memory card from the card tray.
4 Insert the card tray back into the slot.
A + Do not remove the memory card while the device is transferring or
accessing information. This may cause data to be lost or corrupted, or
may damage the memory card or the device. LG is not responsible for

losses that result from the abuse or improper use of memory cards,
including the loss of data.

Battery
Charging the battery

Before using the device, fully charge the battery.
Charge the device with the USB Type-C cable.

Charging cable terminal
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A « If there is moisture on the charging port, exposed terminals, charging
cable, charging adapter, etc, do not use or charge the product. The
product may malfunction or get broken or damaged, and there is risk
of injury caused by electric shock, fire, overheating, explosion, etc. If
you find moisture on such areas, stop using or charging the product
immediately and completely remove the moisture.

+ Do not separate the battery cover.

This product uses a non-removable battery. Do not remove or replace

the battery cover or the battery. If you remove or replace the battery

cover or the battery, the product may be damaged, overheated or
explode.

Only use the USB cable and charging adapter provided with the product

as basic components.

Your device has an internal rechargeable battery. For your safety, do not
remove the embedded battery.

« Using the device when it is charging may cause electric shock. To use the
device, stop charging it.

E + Remove the charger from the power socket after the device is fully
charged. This prevents unnecessary power consumption.

.

A charging adapter that supports fast charging is included with the
product. The fast charging feature may not work if a fast charging
adapter other than the genuine adapter provided with the product is
used.

« Another way to charge the battery is by connecting a USB cable
between the device and a desktop or laptop computer: This may take
longer than plugging the adapter to a wall outlet.

« Do not charge the battery by using a USB hub that is unable to maintain
the rated voltage. Charging may fail or unintentionally stop.

« When you are visiting the Service Centre with a battery issue, bring the

product and the charger with you Since the battery is a consumable, the

battery life may be shortened as times goes by.
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Precautions when using the device

+ Make sure to use the USB cable provided; do not use third party USB
cables or chargers with your device. The LG limited warranty does not
cover the use of third party accessories.

- Failure to follow the instructions in this quide and improper use may
damage the device.

Wireless charging

This device supports wireless charging feature. Charge the device with a
Qi certified wireless charger (optional, sold separately).

Charging the battery with a wireless charger

1 Place your device on the centre of the wireless charger aligned with
the wireless charging antenna on the back of the device.
+ To check the wireless charging antenna area, see Parts overview.

2 When the battery is fully charged, remove the device from the charger.

A + When you charge the battery with a wireless charger, do not put a
magnetic, metallic or conductive materials between the device and the
charger: This may disturb charging of the device and the charger may
become heated. In this case, the device, charger or SIM/Memory cards
may be damaged.
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If the battery temperature exceeds a certain level while charging the
device, charging may be stopped.

If magnetic, metallic or conductive materials are attached on the back
of the device or a protective case is inserted, the device may not charge
properly.

If you charge the battery with a wireless charger in areas where the
network signal strength is weak, the network performance of your
device may be further degraded.

Charge the device with a Qi certified wireless charger (optional, sold
separately). Because the LG limited warranty does not cover the use of
third party accessories, contact the third party manufacturer.

This product supports wireless charging. Use a Qi certified wireless
charger (sold separately) to charge the product. Some coiled wireless
chargers may not support wireless charging. Wireless chargers that
support EPP (Extended Power Profile) allow high-speed wireless
charging.

LG Electronics is not responsible for any issues concerning accessories
of other brands. For such issues, contact the manufacturer of the
accessory product.

Using the battery efficiently

Battery lifespan may decrease if you keep many apps and functions
running simultaneously and continuously.

Cancel background operations to increase battery life.

To minimise battery consumption, follow these tips:
+ Turn off the Bluetooth or Wi-Fi network function when not using

them.

Set the screen timeout to as short a time as possible.
Minimise the screen brightness.

Set a screen lock when the device is not used.

Check the battery level while using any downloaded apps.
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Touch screen

You can familiarise yourself with how to control your device by using
touch screen gestures.

Tapping

Lightly tap with your fingertip to select or run an app or option.

Touching and holding

Touch and hold for several seconds to display a menu with available
options.

Basic Functions
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Double-tapping

Tap twice quickly to zoom in or out on a web page or map.

Dragging

Touch and hold an item, such as an app or widget, then move your finger
to another location in a controlled motion. You can use this gesture to
move an item.

Swiping

Touch the screen with your finger and move it quickly without pausing.
You can use this gesture to scroll through a list, a web page, photos,
screens, and more.
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Pinching and spreading
Pinch two fingers to zoom out such as on a photo or map. To zoom in,
spread your fingers apart.

.

.

.

.

S

/,'

« Do not expose the touch screen to excessive physical shock. You might

damage the touch sensor.

« A touch screen failure may occur if you use the device near a magnetic,

metallic or conductive material.

If you use the device under bright lights, such as direct sunlight, the
screen may not be visible, depending on your position. Use the device

in a shady location or a location with an ambient light that is not too
bright and bright enough to read books.

Do not press the screen with excessive force.

Gently tap with your fingertip on the option you want.

Touch control may not work properly if you tap while wearing a glove or
by using the tip of your fingernail.

« Touch control may not work properly if the screen is moist or wet.

« The touch screen may not function properly if a screen-protective film

or accessory purchased from a third party store is attached to the
device.

Displaying a static image for extended periods of time may result in
after-images or screen burn-in. Turn off the screen or avoid displaying
the same image for a long time when you do not use the device.
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Home screen

Home screen overview

The Home screen is the starting point for accessing various functions and
apps on your device. Swipe up from the bottom edge of any screen to
directly go to the Home screen.

You can manage all apps and widgets on the Home screen. Swipe the
screen left or right to view all installed apps at a glance.

Home screen layout
You can view all apps and organise widgets and folders on the Home
screen.

Status bar —

Weather widget —

*+— Google Search widget

Folder —<E|

[——%——— Pageicon
*— Quick access area

Navigation bar

E + The Home screen may differ depending on the manufacturer policy, user
settings, software version or service provider.
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Status bar: View status icons, the time and the battery level

Weather widget: View the information of weather and time for a
specific area.

Google Search widget: Type or speak to pull open Google Search.

Folder: You can create folders to classify the app based on desired
criteria.

+ Page icon: Display the total number of Home screen canvases. You

can tap the desired page icon to go to the page you selected. The icon
reflecting the current canvas will be highlighted.

Quick access area: Fix main apps at the bottom of the screen so that
they can be accessed from any Home screen canvas.

Navigation bar: You can go to the previous screen or home screen
while using the app, and check the list of apps you used recently.

Using Navigation bar
Here is the gestures guide to control the Navigation bar.

To go to Home screen, swipe up from the bottom edge of the screen.
To go back to the previous screen, swipe in from the left or right edge
of the screen.

To go to Overview screen, swipe up and hold from the bottom edge of
the screen.

To quickly switch between apps, swipe right at the bottom edge of the
screen to go to previously used apps.

- Gestures is the default for the Navigation bar. To change it to Buttons
only<]/Q/ [:] on the home screen, tap Settings > Display >
Navigation bar, then select Buttons only.
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Status icons

When there is a notification for an unread message, calendar event or
alarm, the status bar displays the corresponding notification icon. Check
your device's status by viewing notification icons displayed on the status

bar.
% No signal
3 Data is being transmitted over the 5G network
® Alarm is set
i Vibrate mode is on

Bluetooth is on

e Connected to a computer via USB
[ Battery level
4+ Airplane mode is on
A Missed calls
= Wi-Fiis connected
X Mute mode is on
’ GPSison
(0} Hotspot is on
N NoSMcard
N The NFC mode is on

«+ Some of these icons may appear differently or may not appear at all,
depending on the device's status. Refer to the icons according to the
actual environment and area in which you are using the device and your
service provider.

Displayed icons may vary, depending on the area or service provider.
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Notifications panel

You can open the notifications panel by dragging the status bar
downward on the main screen.

+ You can drag down the notice window or tap the arrow icon to open
the list of quick setting icons.

- You can tap ~® to add, delete or arrange icons in the notice window.

- If you touch and hold the icon, the settings screen for the
corresponding function appears.

« You can use the notifications panel even on the lock screen. Drag the
notifications panel while the screen is locked to quickly access the
desired features.
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Switching the screen orientation

You can set the screen orientation to automatically switch according to
the device’s physical orientation.

On the notification panel, tap Rotation from the quick access icon list.

You can also tap Settings > Display and activate Auto-rotate screen on
the home screen.

<ans

Editing the Home screen

On the Home screen, touch and hold on an empty space, then select the
desired action from below.

- Torearrange the Home screen canvases, touch and hold on a canvas,
then drag it to another location.

- To add a widget to the Home screen, touch and hold on a blank area of
the Home screen, then select Widgets.

- To change wallpapers, themes, icons, and AOD, touch and hold on a
blank area of the Home screen, then select Wallpaper & theme.
You can also tap Settings > Display > Home screen > Wallpaper on

the home screen, then select wallpapers, themes, icons, and AOD, to
apply to the device.
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- To change the grid, touch and hold on a blank area of the Home screen,
then select Grid. Tap the desired grid, then tap Apply.

- To configure the Home screen settings, touch and hold on a blank area
of the Home screen, then select Home screen settings. See Home
screen settings for details.

- Toview or reinstall the uninstalled apps, touch and hold on a blank area
of the Home screen, then select App trash. See App trash for details.
+ To change the default screen, touch and hold on a blank area of the

Home screen, move to desired screen, tap £}, then tap the screen once
more.

e——— Default screen
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Viewing the background theme

You can view only the background image by hiding the apps and widgets
on the Home screen.
Spread two fingers apart on the Home screen.

- Toreturn to the original screen, which displays apps and widgets, pinch
your fingers on the Home screen or drag up — from the bottom edge
of the screen.

np

Moving apps on the Home screen

On the Home screen, touch and hold an app, then drag it to another
location.

« To keep frequently used apps at the bottom of the Home screen, touch
and hold an app, then drag it to the quick access area at the bottom.

+ To remove an icon from the quick access area, drag the icon to the
Home screen.
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Using folders from the Home screen

Creating folders
On the Home screen, touch and hold an app, then drag it over another
app.

A new folder is created and the apps are added to the folder.

Editing folders

On the Home screen, tap a folder and do one of the following actions.
- To edit the folder name tap the folder name.
- To edit the colour, tap the right upper circle.

- To add apps, touch and hold an app, then drag it over the folder and
release it.

- To remove an app from the folder; touch and hold the app and drag it to
outside the folder If the removed app is the only one app that existed
in the folder, the folder is removed automatically.

+ You can also add or remove apps after tapping ().

E + You cannot change the folder colour while using downloaded theme.
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Home screen settings
You can customise the Home screen settings.
1 On the home screen, tap Settings > Display > Home screen.
2 Customise the following settings:
+ Select Home: Select a Home screen mode.
- Wallpaper: Change the Home screen background wallpaper.

- Screen swipe effect: Select an effect to apply when the Home
screen canvas switches.

+ lcon shape: Choose if you want icons to have square or rounded
corners.

- Google feed: Show to the left of the main Home screen.
- Sort apps by: Set how apps are sorted on the Home screen.

+ Hide apps: Select which apps you want to hide from the Home
screen.

+ Loop Home screen: Enable to allow continuous Home screen
scrolling (loop back to first screen after the last screen).

- Swipe down on the Home screen: Enable to search apps or
contents, or view natifications by swiping down on the home
screen.

- Swipe up on the Home screen: Enable to search apps or contents,
or view notifications by swiping up on the home screen.

- Home screen lock: Enable to prevent apps and widgets from being
rearranged or removed.
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Screen lock

Screen lock overview

Your device's screen turns off and locks itself if you press the Power/Lock
key. This also happens after the device is left idle for a specified period of
time.

If you press the Power/Lock key when a screen lock is not set, the Home
screen appears immediately.

To ensure security and prevent unwanted access to your device, set a
screen lock.

E « A screen lock prevents unnecessary touch input on the device screen
and reduces battery consumption. \We recommend that you activate the
screen lock while not using the device.

Setting a screen lock
There are several options available for configuring the screen lock settings.

7 Onthe home screen, tap Settings > Lock screen & security > Select
screen lock and then select the method you prefer.

2 Customise the following settings:
+ None: Deactivate the screen lock function.
- Swipe: Swipe on the screen to unlock the screen.
- Pattern: Draw a pattern to unlock the screen.
+ PIN: Enter a numeric password to unlock the screen.
+ Password: Enter an alphanumeric password to unlock the screen.

Fingerprints: Unlock the screen by using your fingerprint.
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Customise Lock screen
You can customise lock screen.
1 On the home screen, tap Settings > Lock screen & security >
Customise Lock screen.
2 Select a function you want to set.
- Wallpaper: Allow you to set the background for your Lock screen.
+ Clock: Allow you to set where to position the clock on the Lock screen.
+ Shortcuts: Allow you to choose apps to run on your Lock screen.
This setting appears only when a screen lock is set.
- \Weather animation: Enable this option to display weather
animations for the current location on the Lock screen.
- Contact info for lost phone: Allow you to set text to be displayed
on the Lock screen to identify the phone's owner.

Secure lock settings
You can set secure lock settings.

T On the home screen, tap Settings > Lock screen & security > Secure
lock settings.

2 Select a function you want to set.

- Make pattern visible (shown only when Pattern is set as a screen
lock): Turn on to make pattern visible.

+ Lock timer: Allow you to set the amount of time before the screen
automatically locks after the backlight turns off (time-out due to
inactivity).

- Power key instantly locks: Enable this option to instantly lock the
screen when the Power/Lock key is pressed. This setting overrides
the Security Lock timer setting.

+ Show lockdown option (shown only when a screen lock is set):
Enable this option to display the Lockdown icon when you press
and hold the Power/Lock button. Tap the Lockdown icon to turn off
Smart Lock, biometric unlocking, and notifications on the lock screen.
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+ Smart Lock: Allow you to set trusted devices, places, voice, and/or
on-body detection that will allow your phone to remain unlocked.

E + Available menu options may vary depending on the lock screen method
selected.

KnockON

You can turn the screen on or off by double-tapping the screen.

5 « This option is available only on the Home screen provided by LG. It may
not function properly on a custom launcher or on the Home screen
installed by the user.

+ When tapping the screen, use your fingertip. Do not use a fingernail.

+ To use the KnockON feature, make sure that the proximity/light sensor
is not blocked by a sticker or any other foreign substance.

Turning the screen on
Double-tap the middle of the screen.

- Tapping the top or bottom of the screen may decrease the recognition
rate.

Turning the screen off
Double-tap on an empty space on the Home screen and Lock screen.
You can also double-tap an empty space on the status bar.

Disable KnockON

If you don't want to use the KnockON function, set as follows:

On the home screen, tap Settings > Extensions > KnockON and drag it
to disable the function.
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Memory card encryption

You can encrypt and protect data saved on the memory card. The
encrypted data in the memory card cannot be accessed from another
device.

71 On the home screen, tap Settings > Lock screen & security >
Encryption & credentials > Encrypt SD card.

7 Read the on-screen overview of memory card encryption and then tap
Continue to continue.
3 Select an option and tap Encrypt now.

- New data encryption: Encrypt only data that is saved on the
memory card after encryption.

Full encryption: Encrypt all the data currently saved on the memory
card.

Exclude media files: Encrypt all files, except for media files such as
music, photos and videos.

E + Once memory card encryption starts, some functions are not available.

- If the device is turned off while encryption is underway, the encryption
process will fail, and some data may be damaged. Therefore, be sure to
check if the battery level is sufficient before starting encryption.

Encrypted files are accessible only from the device where the files were
encrypted.

+ The encrypted memory card cannot be used on another LG device. To
use the encrypted memory card on another mobile device, format the
card.

+ You can activate memory card encryption even when no memory card
is installed into the device. Any memory card that is installed after
encryption will automatically be encrypted.
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Taking screenshots

You can take screenshots of the current screen you are viewing.

Via a shortcut

Press and hold the Power/Lock key and the Volume Down key at the
same time for at least two seconds.

+ Screenshots can be viewed from the Screenshots folder in the
Gallery.

Via Screenshot
On the screen where you want to take a screenshot, drag the status bar
downwards, then tap @.

E + See Writing notes on a screenshot for details.
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Entering text

Using the Smart toolbar

You can use various keyboard input methods in one place. You can select

the desired input method from the top of the keyboard.

1 Select the desired keyboard input method from the Smart toolbar.

2 Tap---and select the input method you want to show on the Smart
toolbar, or reorganise them.

_—
Smart —¢

toolbar

+ You can add up to 6 tools to Smart toolbar.

« Some supporting input methods may differ depending on the device
you have.

+ You can turn on or off the Smart toolbar feature from the keyboard
settings.

+ You can also use the keyboard input methods by tapping £63.

- ©:Add emajis.
- [ :Add stickers.

+ @ :You can use Tenor's GIF keyboard. Tap Accept to use this
feature.

+ (35 :Add my emojis.
+ 22 :Open Draw chat.
+ 63 Access keyboard settings.
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- :Tap & to enter text with your voice.

- To maximise the voice command recognition, speak clearly.

- To enter text with your voice, make sure that your device is
connected to a network.

- To select the language for voice recognition, tap %% > Languages
on the voice recognition screen.

- This function may not be supported, or the supported languages
may differ depending on the service area.

- [ : Open the clip tray.

2 Enter text by handwriting. It is required to download the input
language data for handwriting. Tap Download to download the
input language data for handwriting.

- =) : Activate floating keyboard when you use the Multi-window
feature. You can also move the keyboard to the desired location.

+ Tap B8 in Smart toolbar.

- If the device is connected to LG Dual Screen, you can capture the
screen of LG Dual Screen and attach it during keyboard input. For
more details, refer to Using Instant Capture on Dual Screen.

+ Tap &3in Smart toolbar.

- If the device is connected to LG Dual Screen, You can expand the
keyboard vertically and use the upper screen as an app screen
and the bottom screen as a keyboard screen. For more detalls,
refer to Using Dual Keyboard on Dual Screen.
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Using the Smart keyboard
You can use the Smart keyboard to enter and edit text.

With the Smart keyboard, you can view text as you type without
bothering to alternate between the screen and a conventional keyboard.
This allows you to easily find and correct errors when typing.

Moving the cursor

With the Smart keyboard, you can move the cursor to the exact position
you want. When typing text, touch and hold on the space bar and then
drag left or right.

< () =

E - This option is available only on the QWERTY keyboard.

Suggesting words

Smart keyboard automatically analyses your usage patterns to suggest
frequently used words as you type. The longer you use your device, the
more precise the suggestions are.

Enter text, then tap a suggested word or gently drag the left or right side
of the keyboard upwards.

Basic Functions 68



+ The selected word is automatically entered. You do not need to
manually type every letter of the word.

[— —
g g
7

Copy and Paste

You can cut or copy text from an app, and then paste the text into the
same app. Or, you can run other apps and paste the text into them.

Ty

7 Touch and hold around the text you want to copy or cut.
2 Drag @/ W to specify the area to copy or cut.

3 Select either Cut or Copy.
+ Cut or copied text is automatically added to the clip tray.

/A Touch and hold the text input window, then select Paste.

« If there is no item that has been copied or cut, the Paste option will not
appear.

Basic Functions 69



Content sharing

Playing content from another device
You can play photos, videos or songs saved on your device froma TV.

71 Connect the TV and your device to the same Wi-Fi network.

2 While viewing the items from the Gallery or Music app, tap Cgor : >
Play on other device.
Or on the home screen, tap Settings > Connected devices > Screen
sharing and then tap () ) to activate it.

3 Select the TV you want to connect to.

E « For use with Chromecast, Google Play services should be up to date.

Viewing content from nearby devices

You can view content from various devices, such as a computer, NAS or
mobile device, by using the Gallery or Music apps.

Connecting the devices

Connect both your device and another device that support DLNA function
to the same wireless network.

E + Make sure that File sharing (DLNA) is activated on both the device and
the connected device.
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Searching for nearby devices

You can view a list of DLNA devices on the same network by selecting the
: > Nearby devices menu in each app.

Use content from nearby devices as if you were using it on your device.

Sending or receiving files
You can share files between your device and another LG device, or a tablet.

Sending files

From the Gallery or other apps, tap : > Share or o<, then select a device
on the file sharing list.

Receiving files
Drag the status bar downward and then tap File sharing.

If your device does not support the file sharing feature, on the home
screen, tap Settings > Connected devices > File sharing > SmartShare
Beam

E + You can share files with certain devices that support DLNA.
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Do not disturb

You can limit or mute notifications to avoid disturbances for a specific
period of time.
On the home screen, tap Settings > Sound > Do not disturb.
+ Mode and select the mode you want:
- Priority only: Receive sound or vibrate notifications for the selected
apps. Even when Priority only is turned on, alarms still sound.
- Total silence: Disable both the sound and vibration.
- Select priorities: Receive alarms and the notifications for the selected
apps.
- Calls from: Set up a range of notifications when receiving a call.

+ Repeated calls: Second call from the same caller within 15 min is not
silenced.

- Messages from: Set up a range of notifications when receiving a
message.

Use Do not disturb: Turn on the Do not disturb feature.

Sleeping: Set the schedule for which you want to turn on the Do not
disturb feature.

Help: View the help for Do not disturb.
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Installing and uninstalling apps

Installing apps
Access an app store to search and download apps.

+ You can use SmartWorld, Play Store or the app store provided by your
service provider.

E + Some app stores may require you to create an account and sign in.
+ Some apps may charge fees.

« If you use mobile data, you may be charged for data usage, depending
on your pricing plan.

+ Smart\World may not be supported depending on the area or service
provider.

Uninstalling apps

Uninstall apps that you no longer use from your device.

Uninstalling with the touch and hold gesture

Press and hold any empty area on the screen, and then press € of the
app you want to delete.

Uninstalling by using the settings menu
On the home screen, tap Settings > Apps > App info, select an app, then
tap Uninstall

I_;'] + Some apps cannot be uninstalled by users.
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Uninstalling apps from the app store

To uninstall an app, access the app store from which you download the
app and uninstall it.

Installing and uninstalling apps during the

setup

\When you turn on the device for the first time, you can download
recommended apps.

You can skip to the next step without installation.

App trash
You can view the uninstalled apps. You can also reinstall apps which were
uninstalled within 24 hours from now.
7 On the home screen, tap Management > App trash.
You can also touch and hold an empty area of the Home screen, then
tap App trash.
7 Activate the desired function:
+ Restore: Reinstall the selected app.
« {ij : Remove the uninstalled apps permanently from the device.

E + Uninstalled apps are automatically removed from the device 24 hours
after they were uninstalled. If you want to reinstall the uninstalled apps,
you must download them again from the app store.

- This feature is activated on the default Home screen only. If you
uninstall apps while using the EasyHome screen or other launcher, they
are immediately and permanently removed from the device.
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App Shortcuts

On the Home screen, touch and hold an app icon such as Call, Message,
Camera, Gallery and Settings to display a quick access menu. Use apps
more easily through App Shortcuts.

- Tap & to set the widgets for the app.
+ Tap () to check the app information.

E « This feature is available only on some apps.
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Phone

Voice call

Make a phone call by using one of the available methods, such as manually
entering a phone number and making a call from the contact list or the
list of recent calls.

Making a call from the keypad
7 Onthe home screen, tap (@ > Dial.

2 Make a call by using a method of your choice:
- Enter a phone number and tap @@.
+ Touch and hold a speed dial number.

« Search for a contact by tapping the initial letter of a contact name
in the contact list, and then tap @@.

E + Toenter "+" when making an international call, touch and hold number
0.

+ See Adding contacts for details on how to add phone numbers to the
speed dial list.

Making Calls from Contacts
7 Onthe home screen, tap (8 > Contacts.

7 After selecting the number you want to call from the list of contacts,

tap &...
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Answering a call
To answer a call, drag @ on the incoming call screen.
+ When the stereo headset is connected, you can make calls by using the
call/end button on the headset.
+ To end a call without turning off the screen, on the home screen, tap
Settings > Network & internet > Call > Answer and end calls and
then activate End call with the Power key.

E + On the home screen, tap Settings > Network & internet > Call >
Answer and end calls > End call with the Power key, you can end a
call by pressing the Lock/Power key while the call-in-process screen is
turned on.

Rejecting a call
To reject an incoming call, drag @ across the incoming call screen.

- To send a rejection message, drag the rejection message option
across the screen.

+ To add or edit a rejection message, On the home screen, tap Settings >
Network & internet > Call > Call blocking & Decline with message.

+ When a call is coming in, press the Volume Up, Volume Down or Power/
Lock key to mute ringtone or vibration, or to hold the call

Checking an incoming call while using an app

When a call comes in while using an app, a pop-up notification can be
displayed at the top of the screen. You can receive the call, reject the call,
or send message from the pop-up screen.

5 + On the home screen, tap Settings > Network & internet > Call >
Additional settings > Incoming voice call pop-up and then select the
desired way you would like to display the incoming call while using an

app.
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Viewing missed calls
If there is a missed call, the status bar at the top of the screen displays X.

To view missed call details, drag the status bar downwards. You can also
tap (@ > Call logs on the home screen.

Functions accessible during a call

During a call, you can access a variety of functions by tapping the
on-screen buttons:

- Contacts: View the contact list during a call.

+ Hold: Place the current call on hold.

- Dialpad: Display or hide the dial pad.

- Speaker: Turn on the speakerphone function.

- Mute: Mute your voice so that your voice cannot be heard by the other
party.

+ Bluetooth: Switch the call to a Bluetooth device that is paired and
connected.

- @ :Endacal

« ¢+ :Access additional call options.

« Available settings items may vary depending on the area or service
provider.
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Making a three-way calling
You can make a call to another contact during a call.
1 Duringacal, tap : >Add call.

2 Enter a phone number and tap @.
+ The two calls are displayed on the screen at the same time, and the
first callis put on hold.

3 To start a conference call, tap Merge calls.

E + You may be charged a fee for each call. Consult with your service
provider for more information.

Viewing call records

To view recent call records, on the home screen, tap (8> Call logs. Then,
you can use the following functions:

- To view detailed call records, select a contact. To make a call to the
selected contact, tap &...

- To delete call records, tap : > Delete.

E « The displayed call duration may differ from the call charge. Consult with
your service provider for more information.

+ The deleted call history can not be restored.

« Pinch two fingers or spread your fingers apart to adjust the font size of
call logs or contacts.

Configuring call options
You can configure various call options.

7T On the home screen, tap (8 > Dial or Call logs.

2 Tap : > Call settings and then configure the options to suit your
preferences.
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Messaging

Sending a message
You can create and send messages to your contacts using the Messaging
app.

5 + Sending messages abroad may incur additional charges. Consult with

your service provider for more information.

T Onthe home screen, tap ©.

2 Tep D

3 Specify a recipient and create a message.
+ To use multimedia options, tap ().
+ To access optional menu items, tap .

4 Tap B> to send the message.

Reading a message
You can view exchanged messages organised by contact.
T On the home screen, tap ©.

2 Select a contact from the message list.

+ While on the message list or chat window, you can adjust the font size
by placing two fingers on the screen and either widening or narrowing
the fingers.
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Configuring messaging settings

You can change messaging settings to suit your preferences.
T Onthe home screen, tap ©.

2 Tap : > Settings from the message list.

E « You can designate settings for the notice window, blocking calls, disaster
alert, multimedia messages, etc.

Camera

Starting the camera

You can take a photo or record a video to cherish all of your memorable
moments.

On the home screen, tap (&).

5

Before taking a photo or recording a video, wipe the camera lens with a
soft cloth.

Be careful not to stain the camera lens with your fingers or other
foreign substance.

.

Images included in this user guide may be different from the actual
device.

.

Photos and videos can be viewed or edited from the Gallery. See Gallery
overview for details.

Refrain from using the product for a purpose that may violate someone
else’s privacy or rights.

Useful Apps 82



Taking a photo
You can take photos with the camera in the product.
1 Tap (3 and focus on the subject.
+ You can touch the subject to focus on.
+ You may spread or pinch two fingers to zoom in or out.
« Select a zoom from @3/ @ / @.
2 Tap( totake aphoto.
+ You can also press the Volume Down or Volume Up key to take a
photo.
+ You can take a photo while recording a video by pressing @ on the
screen.
- The options displayed on the shooting screen may differ depending
on the selected camera (front or rear) and camera mode.

+ The camera will turn off automatically if you do not use it for a while
after running the Camera app.

Start Google Lens
Set/Cancel timer Current camera mode
setting | —— Switch to front-facing/
Set/Cancel flash — l rear-facing camera
setting
Apply filter effect —s l_—_lj ~—— Take photo
1 T Select zoom
Choose screen ratio —
. . L Preview
Set camera — | Auto scene optimizer
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5 + You can run the camera app by short-pressing the power key twice. On
the home screen, tap Settings > Extensions > Shortcuts and then tap
Open Camera to activate it.

+ When the screen is turned off or locked, start the camera by pressing
the Volume Down key twice.

+ On the home screen, tap Settings > Extensions > Shortcuts and then
tap Open Camera @ ) to activate it.

Customising the camera options
You can customise a variety of camera options to suit your preferences.
Tap £83 on the screen.

E « Available options vary depending on the selected camera (front or rear
camera) and the selected camera mode.

Auto scene By recognizing the scene that is being recorded, applies the

optimizer optimal resolution setting automatically.

Composition By recognizing the hgman figure vyhen taking a portrait,
recommends the optimal composition.

Tips Notifies the user when the subject’s eyes were closed or the

P picture is blurry for optimal photography.

Photo size Allows you to choose the photo size and aspect ratio.
Obtain photos in vivid colours and get compensated effects

HDR even when they are taken against the light. These functions
are provided by the high dynamic range (HDR) technology
equipped in the camera.

Utera v_\nde . Corrects the screen distortion when taking ultra wide-angle

shot distortion

- photos.

correction
Saves storage space by compressing the image file in HEIF

SAVE as HEIF | format. Other devices may not support image files in HEIF

format.
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Live photo

Record the action before and after you take a photo.

Grid

Display guide grids so that you can take photos or record
videos based on the horizontal and vertical reference lines.

Cheese shutter

Allows you to take a photo by saying ‘Cheese] ‘Smile,
‘Whiskey, ‘Kimchi, or LG’

Add signature

Display a personalised signature on the photos.

Tag locations

Save the image with GPS location data.

Select if you want to store the pictures and videos in the

Storage Internal storage or SD card. (Available when a memory card
is inserted.)
Help Provide Help for each camera menu.

Additional options on the front camera

Selfie distortion

Corrects distorted parts of the face.

correction
Save as flipped | Saves as flipped images when taking a selfie.
Selfie shot Take a selfie by selecting its option between Gesture shot

and Auto shot.

E + You can apply the make-up effect when taking a selfie using the front

camera.

+ Gesture shot is taken by recognizing the shape of a hand and Auto
shot is taken by recognizing a face.
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Mode Selection

You can conveniently select from the modes displayed on the screen
which are selected to suit the shooting environment.

Tap () and swipe the camera modes left or right, or swipe the screen left
or right to select a camera mode.

< nimp

|
l

Camera modes
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Using camera modes

Recording a video
1 Tap (& and select Video by swiping camera modes.

2 Tap e torecord avideo.

Set camera — «—— Set/Cancel flash setting
Select screen resolution ] ] Apply filter effect
Turn On/Off steady cam —
e Select zoom
Preview ——— *— Switch to front-facing/
I rear-facing camera

————— Recording a video

- To take a photo while recording a video, tap ® .

- To pause the video recording, tap (1. To resume the video recording,
tap(e.

+ While recording a video, you may spread or pinch two fingers to
zoom in or out.

While recording a video, you may tap the desired area to adjust the
brightness.

You can switch to and from the front camera and rear camera while
recording a video by pressing {o}.

3 Tap(= toend the video recording.
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E - You can save storage space by setting the Save as HEVC option in 3.
It compresses the video file in HEVC format.

+ Other devices may not support video files in HEVC format.

Taking a photo
Tap (&) and select Photo by swiping camera modes.
See Taking a photo for more details.

Taking portraits

You can take photos that make the subject more distinct and stand out
by blurring the background.

1 Tap (& and select Portrait by swiping camera modes.
« Select a desired effect by swiping effect options for portrait.
+ Tap & to adjust the aperture value.

2 Tap () to take a photo.

Set camera —* — Set timer setting

Choose screen ratio Set aperture value

:'— Select an effect

option for portrait.
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E + \When you see the message “Portrait is available’, start taking a photo.

+ The Portrait feature may not work if the camera cannot recognise the
subject.

- While taking a photo, keep the distance to your subject to 1.3 ~ 5 feet.
« This feature is not available if the surroundings are too dark.

Using a sticker
You can apply a variety of stickers to your photos or videos.
You can create richer content by using 3D AR Effect.
1 Tap (@ and select Sticker by swiping camera modes.
+ Select a desired sticker by swiping stickers.
2 Tap( totakeaphoto,ortap and hold(  to record a video.

« The front and rear cameras cannot be switched while recording a
video.
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3 Tap = toend the video recording.

+ The photo or video will be saved in Gallery.

Set camera —

Choose screen ratio —41

-

E - Tap @ to use 3D AR Sticker.

See 3D AR Effect for more details.
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Using additional camera modes
Tap (&) and select More by swiping camera modes.

Night View
You can take vivid and clear night photos. Night View will run
automatically when you take a photo in a low light conditions.
You can also take clear night scenes by using the Night View feature
manually.
1 Tap (3 and select More by swiping camera modes.
2 Tap S
+ Select a zoom from @9 / @3.
3 Tap () to take a photo.
- To adjust the brightness of the photo, slide & left or right.

Set camera —* — Set timer setting

1

Choose screen ratio —

+—— Adjust brightness

5 + Hold steady and firm so that the camera does not shake while taking
a photo.
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Panorama

You can create a panoramic photo by moving the camera in one direction

to photograph and stitch continuous shots of a wide view.

1 Tap (3 and select More by swiping camera modes.

2 Tapq
+ Select a zoom from ) / @3.

3 Tap(  and then slowly move the camera in one direction.

/. Tap @ to stop capturing the panoramic.

Set camera —a':l

+ When moving the camera in one direction, make sure that the screen
you shoot is not out of the guide line.
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Manual Camera

You can create photos featuring professional touch by using a variety of
advanced features.

1 Tap (3 and select More by swiping camera modes.

2 Tap&b.
3 Customise the following camera settings.
- Select a zoom from @9 / .
- If you set Auto for options, the options are automatically adjusted
according to the shooting target and environment.
- If the Focus peaking option is set, the focus area is highlighted in
color. This feature is available only in Manual Focus (MF) mode.

Set camera — *— Set timer setting

Choose screen ratio ] ] Set flash setting

Apply filter effect —

Reset the —— e— Displays the
settings various Graphy
options
1 1
Adjust white ——
: balance I— Adjust shutter
. speed
Adjust focus
_ Adjust ISO
Adjust speed

brightness

4 Tap(  to take the photo.
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E - If you tap (&) and select a Graphy effect, a list of recommended photos
with various settings will appear.

+ Selecting the Graphy effects allows you to shoot using the white
balance, shutter speed, and ISO setting values applied to the
recommended photo.

« This feature is available only in Manual camera mode.

You can see a variety of recommended photos if you download the

Graphy app from the Google Play Store.

You may be charged for data usage, depending on your pricing plan.

- Tap £83, then tap @ ) from the Graphy photos menu to deactivate this

feature.

Customising the camera options
You can customise a variety of camera options to suit your preferences.

Tap €3 in Manual Camera.

Photo size Allows you to choose the photo size and resolution.
The image is stored as a RAW file format so that you can
Save as RAW modify it.
The DNG and JPEG files are created while taking a photo, then
saved as a non compressed high resolution image.
Ultra
wide shot Corrects the screen distortion when taking ultra wide-angle
distortion photos.
correction
h Adjust the white balance, ISO and shutter speed for the
Graphy recommended photo.
photos )
See Manual Camera for details.
Guide Display guide grids so that you can take photos based on the

horizontal and vertical reference lines.

Add signature

Display a personalised signature on the photos.
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Tag locations | Save the image with GPS location data.

Select if you want to store the pictures and videos in the

Storage Internal storage or SD card. (Available when a memory card is
inserted.)
Help Provide Help for each camera menu.
Slo-mo

Create a fun video by changing the speed of movement. This function is
useful when you want to playback a video at a slower speed compared to
the actual speed of the original clip.

1 Tap (@ and select More by swiping camera modes.
2 Tap@.

3 Select an interval & or entire & to apply the slow motion effect to it.

« Part Slo-mo: Allows you to apply a slow motion effect to a specific
section of the video.

- Press © at the moment where you want the slow motion effect
to be applied. With a short-press, slow motion effect will be
applied for 0.5 second. With a long-press, slow motion effect will
be applied until you release your finger.

+ All Slo-mo: Allows you to apply a slow motion effect to the entire
video.
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Settings —e «— Set flash setting

Select an interval —41

/A Tap (e toshoot video.

- To pause the video recording, tap (1. To resume the video recording,
tap .

5 If you want to finish shooting, press (= .

YouTube Live
You can record a video and directly upload to YouTube.

To use this feature, you must meet the eligibility requirements. Contact
YouTube for the requirements.

T Onthe home screen, tap (&).
2 Select More by swiping camera modes, then tap ().
5 « YouTube Live is available only when your device is connected to the

Internet. If you use mobile data, you may be charged for data usage,
depending on your pricing plan.
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Useful camera features

Taking a photo with the Al feature

When taking a photo, the Al feature recognises a subject and applies the
optimum effect to the photo.

E - Tap ' to deactivate the Al feature.

Auto-Exposure/Auto-Focus lock

You can fix the current exposure level and focus position by touching and
holding the screen in the Auto mode. To turn off the feature, tap a blank
area on the screen.

Auto-Exposure/
Auto-Focus lock

E « This feature is available only in specific modes.
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Switching between cameras

You can switch between the front and rear cameras to suit your
environment.
- To switch between the front and rear cameras, swipe the screen up or
down on the shooting screen in the Camera app.

<=1 @ 11mp

5 « Use the front camera to take selfies. See Selfie shot for details.

Zoom in or out

You may spread or pinch two fingers to zoom in or out when you take
photos or videos.

5 - Zoom in/out function is not available in the selfie mode (front camera).
+ This function is not supported in a number of modes.
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Using the Burst Shot
You can take consecutive photos and view them as moving pictures in the
Gallery.
1 Tap (@ and select Photo.
2 Tapandhold
+ Multiple, consecutive photos are taken while you are holding down

Gesture shot

You can take selfies by using gestures.

Show your palm to the front camera and then clench your fist.

You can also clench your fist and then open it towards the front camera.
+ In three seconds, a photo is taken.

o

z D

i

E - To use this feature, switch to the front camera mode, then tap @ >
Selfie shot > Gesture shot.
+ Make sure that your palm and fist are within the reference line so that
the camera can detect them.
- This feature may not be available while using some of the camera features.
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Auto shot

You can use the face detection feature to take selfies easily and
conveniently. You can set the device so that, when you look at the screen,
the front camera detects your face and takes a selfie automatically.

- The white coloured guide frame appears when the front camera
detects your face. If the subject within the guide frame stops moving,
the guide frame colour turns yellow, then the camera takes a photo.

E - Tap §63 > Selfie shot > Auto shot to enable the Auto shot feature.

Interval shot
You can take selfies at an interval.

While using the front camera, you can show your palm to the camer,
then clench your fist twice quickly.

+ Four photos are taken at reqular intervals after a timer delay of three
seconds.

Save as flipped

Before taking a photo with the front camera, tap 63 > Save as flipped.
The image is flipped horizontally.

5 + When using the front camera, you can change how selfies are taken in
the camera options. See Customising the camera options for details.

Selfie shot

You can use the front camera to view your face on the screen and take selfies.
1 Tap (&) and select Photo by swiping camera modes.

2 Tap £} to switch to the front camera.

3 Tap(  to take photos.
- Tap ) to apply various beauty effects.
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Gallery

Gallery overview
You can view and manage photos and videos saved on your device.

Viewing photos
You can view the photos saved to the product.
1 Tap @M and select a desired folder.
7 Tap adesired photo.
+ The Gallery folder contains Photos, Albums, Memories, and Play.

— Start Google Lens.

Back to the previous —¢ ~— Access additional options.
screen.

»— Preview gallery

1
Add to or remove from —* *7— Delete images.

your favourites. I
i Share images.
it images.

« Details menu appears when the screen is lightly touched. Touching the
screen once again makes the menu disappear.

Useful Apps 101



Playing a video
You can view the videos saved to the product.

Back to the — ~— Access additional
previous screen. options.

Pause or play the ———
video.

»— Preview gallery.

L J :
Add to or remove from — *7— Delete images.

our favourites.
y I— Share images.
Edit images.

E « To adjust the sound volume, drag the right side of the video screen up
or down.

« To adjust the screen brightness, drag the left side of the screen up or
down.

+ Dragging the screen to the left on the video play screen allows you to
rewind (REW) and dragging to the right allows you to fast forward (FF).
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Deleting files
You can delete files by using one of the following options:
+ Touch and hold a file from the file list, then tap Delete.

- Deleted files are automatically moved to : > Trash and they can be
restored to the Gallery within 7 days.

- Tap [x] to completely delete the files. In this case, the files cannot be
restored.

Sharing files
You can share files by using one of the following options:

- While viewing photo or video, tap «& to share the file by using the
method you want.

E - If you take photos or videos after you tap (&) > 63 > Tag locations @ )
, the location-specific memories album is automatically created after a
certain time under the Memories tab of Gallery.

.

You can search the photos or videos by place, tag, camera mode, etc. by
tapping Q in the gallery.

- Some file formats may not be supported, depending on the installed
software.

+ Some files may not be opened due to encoding.
« Files that exceed the size limit may cause an error.
+ You need to activate the GPS feature to create Memory albums.

Making a collage
You can make a collage from the associated content.
1 Tap@¥and select : > Make collage.

2 Select the desired images to add to the collage and then tap Make
collage.
+ Select the desired layout from the bottom of the screen.
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3 Tap Make.

E « A maximum of 9 images can be used to create a collage.

Creating a movie

You can create a new movie by putting images and videos together.
1 Tap@andselect : > Create movie.

2 Select images or videos for your movie and tap Create movie.

3 Edit the selected images and videos and then tap Save.

——— Effecting files

L

Resetting files

Previewing a file

Deleting files ———

Adding files

E « A maximum of 50 videos can be used to create a movie.
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Making a GIF

You can easily make a GIF file using recorded video.
Tap @ and select Making a GIF.

Creating video
T At the desired starting point while watching a video, tap .

2 Select the length of the GIF you want to create.
+ GIF is generated for the time selected from the specified starting
point.
- For videos that are less than 5 seconds, GIF images are
automatically generated for the remaining time.

Creating GIF Photographs
1 Inthe photograph list in the Gallery, tap : > Create GIF.

2 Select a picture to turn into a GIF photograph, and then tap Next.

+ You can add/delete a photograph, adjust the speed or screen ratio,
and set the photograph order.

E - Creating GIF photographs is a function provided for the user to produce
creative images. Violating rights such as intellectual property right
or defaming the reputation of another person by using the creating
GIF photographs function may lead to a civil or criminal liability in
accordance with the related laws. Be cautious not to copy or transmit
another person's work without authorization. LG Electronics is not liable
in any way for such acts by users.

+ You can select up to 100 photographs to produce when you create a
GIF
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Contacts

Contacts overview
You can save and manage contacts.
On the home screen, tap Essentials > Contacts.

Adding contacts

Adding new contacts

1 Onthe contact list screen, tap -
- A pop-up appears for selecting the saving location for contact.
Select the location you want.

2 Enter contact details and tap Save.

Importing contacts
You can import contacts from another storage device.

T Onthe contact list screen, tap : > Manage contacts > Import.

2 Select the source and target locations of the contact you want to
import, and then tap OK.

3 Select the contacts and tap Import.

Adding contacts to the speed dial list
T On the contact list screen, tap : > Speed dial.
7 Tap Add contact from a speed dial number.

3 Select a contact.

E + While adding a new contact, tap {313} to add a speed dial number.
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Searching for contacts
You can search for contacts by using one of the following options:

- Tap the search bar at the top of the Contacts screen and enter the
desired contact or phone number you want to search for.

+ Scroll the contact list up or down.
+ From the index of the contact list screen, tap the initial letter of a
contact.

E + Pressing the search bar at the top of the Contacts screen and entering
a contact or phone number brings up the integrated search results from
the call history and contacts list saved onto the product.

Contacts list

Editing contacts
1 On the contact list screen, select a contact.
2 On the contact detail screen, tap / and edit details.

3 Tap Save to save changes.

Deleting contacts
You can delete contacts by using one of the following options:
+ On the contact list screen, touch and hold a contact you want to
delete, then tap [
- Tap ¢ > Delete on the contact list screen.

E + Deleted contacts may not be restored.

Useful Apps 107



Adding favourites

You can register frequently used contacts as favourites.
T On the contact list screen, select a contact.

2 On the contact detail screen, tap ¥y

Creating groups

T On the contacts group list, tap -+

2 Enter anew group name.

3 Tap Add members, select contacts, then tap Add.

/| Tap Save to save the new group.

QuickMemo+

QuickMemo+ overview

You can make creative notes by using a variety of options on this
advanced notepad feature, such as image management and screenshots,

which are not supported by the conventional notepad.

This device supports the Active Pen AES2.0 (Active Electrostatic).

Creating a note
71 On the home screen, tap Essentials > QuickMemo+.
7 Tap @ to create a note.

- @ :Saveanote.

+ <5 :Undo the previous edit.

+ > :Redo the recently deleted edits.

« T :Enter a note by using the keypad.

- ok : Save your favorite pen types.

-/ :Write notes by hand.
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« A :Erase handwritten notes.
+ g :Change into the calligraphy font as you write by hand.
+ ¢ :Access additional options.

3 Tap @ to save the note.

Writing notes on a screenshot
1 While viewing the screen you want to capture, drag the status bar
downwards and then tap @.
+ The screen is captured and displayed as a thumbnail on the right
bottom of the screen.
2 To write notes on the screen, tap 7.
3 Write notes using the tools.
- TQ :Zoom in or out, or adjust the area to capture.
+ / :Write notes by hand.
« & :Erase handwritten notes.
+ €5 :Undo the previous edit.
+ ( :Redo the recently deleted edits.
+ (35 :Crop the screen as you desire.
4 Tap and save the notes.
+ Saved notes can be viewed in Gallery.
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Additional features after capturing a screenshot

— Tap to capture entire
screen by using the scroll
capture feature.

«— Tap to record the screen.
Tap to write notes on the Tap to delete the captured
captured screen. screen shot.

1
Tap to share the captured —————

screen shot.

E « You can capture the entire screen by using the scroll capture feature.

- While using an app such as Messaging and Chrome, drag the
notifications panel downwards and then tap @. Then, tap (v to
capture the entire screen you are currently viewing as a single file.

« This feature is available only on some apps that support the scroll
capture feature.

+ Pinch two fingers or spread your fingers apart to change the memo
layout.
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Clock

Alarm
You can set an alarm to trigger it at a specified time.

7 On the home screen, tap Essentials > Clock > Alarm.
2 Tap-toadd a new alarm.

3 Configure the alarm settings and tap Save.

« If you select a previously set alarm, you can edit the alarm.

- Todelete an alarm, tap : > Delete at the top of the screen. You can also
touch and hold the alarm.

World clock

You can view the current time in cities around the world.
7 On the home screen, tap Essentials > Clock > World clock.
2 Tap-andaddacity.
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Timer
You can set the timer to trigger an alarm after a specified period of time.
1 On the home screen, tap Essentials > Clock > Timer.

2 Set the time and tap Start.
+ To suspend the timer, tap Pause. To resume the timer, tap Resume.

3 Tap Stop to stop the timer alarm.

Stopwatch
You can use the stopwatch to record a lap time.
1 On the home screen, tap Essentials > Clock > Stopwatch.
2 Tap Start to initiate the stopwatch.
+ Torecord a lap time, tap Lap.
3 Tap Pause to suspend the stopwatch.
- To resume the stopwatch, tap Resume.
+ To clear all the records and restart the stopwatch, tap Reset.
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Music

You can play and manage songs or music albums.
T On the home screen, tap Essentials > Music.
7 Select a category.

3 Select a music file.
Turn on/off Flash Light.

Set sound effects.

Back to the previous — «— Access additional options.
screen.

— Pause or play.
Tap to play from the — — Tap to play the next file /
beginning of the current Touch and hold to fast
file / Double-tap to play forward.
the previous file / Touch
and hold to rewind.
Play in random order. ——T L

— Select a repeat mode.

Adjust the sound volume. —-

1
Add to or delete from your ——
favourites.

T

— Go to Now playing list.

E « Some file formats may not be supported, depending on the installed
software.

« Files that exceed the size limit may cause an error.

« Music files may be protected by international copyright owners or
copyright laws. You may have to obtain legal permission before copying
amusic file. To download or copy a music file, first check the copyright
law for the relevant country.

This model supports Hi-Fi audio playback. Hi-Fi audio files display the
Hi-Fi icon.

.

If you set the flashlight, flashlight blinks to fit the music being played.
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Calculator

You can use two types of calculators: the simple calculator and the
scientific calculator.
1 On the home screen, tap Essentials > Calculator.
2 Use the keypad to make a calculation.
- If you want to calculate from the beginning, tap and hold (]

ThinQ
You can easily connect the product with ol appliances to monitor and

conveniently use the appliances.
On the home screen, tap Essentials > ThinQ

I_;r] + Washing machine, dryer, styler, dishwasher, oven, and robot cleaner can
only be registered when the product is in the standby mode.

+ Look for the ThinQ mark on the product to see if it can be connected to
ThinQ app.
« Tap = to check various function of the ThinQ app.
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LG Health

You can manage your health and maintain good exercise habits by
keeping track of the exercises you do.

Getting started with LG Health

You can configure LG Health when launching the app for the first time or
after resetting it.

7 On the home screen, tap Essentials > LG Health.

2 Follow the on-screen instructions to complete configuration.

Using LG Health

You can view main information on LG Health and manage the amount of
physical exercise and health information.

T On the home screen, tap Essentials > LG Health.

2 The following options are available.
= :View your exercise log on the day you want to check.

- © :Begin tracking an exercise. The route and amount of your
physical exercise are recorded for each exercise type.

« + :Set your daily exercise goals including calories and steps, or set
various LG Health settings.

E « Health-related information provided by LG Health is designed for user
convenience and cannot be used for purposes of disease prevention,
treatment, diagnosis or other medical issues.

+ LG Health may vary or may not be available, depending on the country
and service provider. LG Health functions that are available and apps
that can be added to LG Health may vary, depending on the country. This
is due to differing laws and regulations.
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HD Audio Recorder

The HD Audio Recorder allows you to configure the audio settings
manually so that you can record audio based on your environment.

Recording modes

You can record a high definition audio file by selecting and configuring the
desired audio mode to suit the recording environment.

On the home screen, tap Essentials > HD Audio Recorder > =.

Normal
You can record audio without extra settings.

ASMR
You can record ASMR sound.

Concert
You can record audio in a concert or other music event.

Custom
You can manually configure the desired settings to record audio.

Studio Mode

With Studio mode, you can play an audio file or music and record your
voice at the same time, create a chord by recording your voice multiple
times, and record your comments over the presenter's or speaker’s original
audio file.

7 Onthe home screen, tap Essentials > HD Audio Recorder > =>
Custom.

Tap J+
Select an audio file to use as background music.

Tap @ to record voice.

u b WN

Tap @ to save the recorded file.
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E « Background music can only be played through earphones. Make sure to
plug in earphones before using this feature.

- To change additional settings, tap + > Settings, then customise the file
type, bit depth, sampling rate and other settings.

+ When you select the Concert or Custom mode with earphones
connected, {,, appears. Tap { and then select the microphone to use.

» You can monitor the the sound quality with the connected earpiece
while recording audio. While recording audio in Studio mode, sound
monitoring is not supported. You can hear only the background music.

Game Launcher

You can set whether to use the game launcher where you can view the
list of games installed on the product and select game settings such as
muting media volume, limiting alerts, etc.

7 On the home screen, tap Game Launcher.

2 Select the desired option.

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise
it

On the home screen, tap Management > Smart Doctor.
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LG Mobile Switch

Easily transfer data from a used device to a new device via LG Mobile
Switch.
1 On the home screen, tap Management > LG Mobile Switch.
You can also tap Settings > System > Backup > LG Mobile Switch.
- If the app is not installed on the product, download and install the
LG Mobile Switch app from the Google Play Store.

7 Follow the on-screen instructions to select a desired method for
transfer.

E - Data in a Google Account will not be backed up. VWhen you synchronise
your Google Account, Google apps, Google contacts, Google Calendar,
Google memo app data and apps downloaded from the Play Store are
stored on the Drive app automatically.

« Fully charge the battery before transferring data to avoid unintentional
powering off during the process.

App trash

You can see the list of apps deleted on the home screen. The app that was
deleted within the last 24 hours can be recovered.

On the home screen, tap Management > App trash.
For more details, refer to App trash.
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SmartWorld

You can download a variety of games, audio content, apps and fonts
provided by LG Electronics. Customise your device to suit your preferences
by using Home themes and fonts.

E « If you use mobile data, you may be charged for data usage depending
on your pricing plan.

« This feature may not be supported depending on the area or service
provider.

7 On the home screen, tap Services > SmartWorld.
2 Tap : >LG Account, then sign in.

3 Select and download the desired content items.

Downloading SmartWorld app

If the SmartWorld app is not installed, follow these steps to download it.

T On the home screen, tap Settings > System > Update centre > App
Updates.

2 From the list, select SmartWorld and tap Download.
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RemoteCall Service

Your device can be remotely diagnosed for resolving issues. First, make a
phone call to an LG Customer Service Centre as follows:

« To use this function, first you must agree to usage of the function.

+ If you use mobile data, you may be charged for data usage depending
on your pricing plan.

T On the home screen, tap Services > RemoteCall Service.
2 Connect a call to an LG Customer Service Centre.

3 After the call connects, follow the service associates instructions to
enter a six-digit access number.
+ Your device is remotely connected and the remote support service
starts.

Cell Broadcast

You can view real-time text broadcasts on emergency situations, such as
typhoons, floods and earthquakes.

On the home screen, tap Services > Cell Broadcast.
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Google apps

You can use Google apps by setting a Google Account. The Google
Account registration window appears automatically when you use a
Google app for the first time. If you do not have a Google Account, create
one from your device. For details on how to use an app, see the Help in
the app.

E + Some apps may not work depending on the area or service provider.

Calendar

The Calendar app allows you to track your schedule of events (that you
created), organised by Day, 3-day, Week or Month.

Chrome
A fast, simple, and secure web browser, built for the modern web.

Docs

Docs is a collaborative, word-processing tool that powers productivity. Use
Docs to create, edit and work together in real-time.

Drive

Drive is a file storage and sharing app that makes it easy to find, share and
collaborate on work projects from anywhere, instantly.

Duo

Make simple, high quality video calls to your friends and family on Android
phones and iPhones.

Gmail

Gmail is an easy to use mail app that keeps your messages safe, makes
your inbox smarter, and helps you stay organised.
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Google

The Google app keeps you in the know about the things you care about.
Find quick answers, explore your interests, and get a feed of stories and
updates on topics that matter to you.

Maps

Going somewhere? Go with Maps, the app you can rely on for real-time
GPS navigation, traffic, transit, and details about millions of places, such as
reviews and popular times.

Photos

Home for all your photos and videos, automatically organised so you can
share and save what matters.

Play Movies & TV

Use your Google Account to rent or purchase movies. Purchase content
and play it anywhere.

YT Music

A new music streaming service from YouTube.

Sheets

Sheets is a collaborative spreadsheet processing tool that powers
productivity. Use Sheets to import, organise and analyse information
together in real-time.

Slides

Google Slides is a collaborative presentation creation tool that powers
productivity. Use Slides to organise information, present results, and make
decisions together in real-time.

YouTube

Watch your favourite channels, listen to music you love, and upload videos
to share with people around the world.
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Assistant
Your device has the Google Assistant built-in. Find answers and get things

done while on-the-go. To get started, just tap the Google Assistant key
on the side of the phone or touch and hold the home button of the phone.
E + The Google Assistant is not available in certain languages and countries.

Files

You can view and manage files saved on your device.
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Settings
You can customise the device settings in accordance with your
preferences.

On the home screen, tap Settings.

E « If you enter a keyword on the search window at the top of the screen,
you can conveniently run the items that need to be set.

Network & internet
Wi-Fi

You can connect to nearby devices over a Wi-Fi network.

Connecting to a Wi-Fi network
71 On the settings screen, tap Network & internet > Wi-Fi.
2 Tap to activate it.
+ Available Wi-Fi networks appear automatically.
3 Select a network.
+ You may need to enter the network’s Wi-Fi password.

+ The device skips this process for previously accessed Wi-Fi
networks. If you do not want to automatically connect to a certain
Wi-Fi network, tap the network and then tap Forget network.
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Wi-Fi network settings
On the settings screen, tap Network & internet > Wi-Fi.

- Switch to mobile data:If the mobile data connection function is
activated but the device cannot connect to the Internet via Wi-Fi
connection, the device automatically connects to the Internet via the
mobile data connection.

E « This feature depends on the service provider.

-+ :Customise Wi-Fi network settings.

Wi-Fi Direct
You can connect your device to other devices that support Wi-Fi Direct to

share data directly with them. You do not need an access point. You can
connect with more than two devices by using \Wi-Fi Direct.

1 On the settings screen, tap Network & internet > Wi-Fi> ¢ >
Advanced Wi-Fi > Wi-Fi Direct.

+ Nearby devices that support Wi-Fi Direct automatically appear.

2 Select a device.
« Connection occurs when the device accepts the connection request.

E + The battery may drain faster when using Wi-Fi Direct.
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Mobile data

You can turn mobile data on and off. You can also manage mobile data
usage.

Turning on mobile data
1 On the settings screen, tap Network & internet > Mobile data.
2 Tap to activate it.

Customising mobile data settings
71 On the settings screen, tap Network & internet > Mobile data.
2 Customise the following settings:

+ On:Set to use data connections on mobile networks.

+ Limit mobile data usage: Set a limit for mobile data usage to block
mobile data if the limit is reached.

« + :Customise mobile data settings.

- Data usage volume is measured based on the product, and the
volume calculated by your mobile provider may be different.

Call

You can customise call settings, such as voice call and international call
options.

+ Some features may not be supported depending on the area or service
provider.

71 Onthe settings screen, tap Network & internet > Call.

2 Customise the settings.
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Tethering
USB tethering

You can connect the device to another device via USB and share mobile
data.
1 Connect your device and other devices via USB cable.

2 On the settings screen, tap Network & internet > Tethering > USB
tethering and then tap (1)) to activate it.

5 « This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ \When connecting to a computer, download the USB driver from
www.lg.com and install it on the computer.

+ You cannot send or receive files between your device and a computer
while USB tethering is turned on. Turn off USB tethering to send or
receive files.

+ Operating systems that support tethering are Window XP or higher, or
Linux.

Wi-Fi hotspot
You can set the device as a wireless router so that other devices can
connect to the Internet by using your device's mobile data.

T On the settings screen, tap Network & internet > Tethering > Wi-Fi
hotspot and then tap () ) to activate it.

2 Tap Set up Wi-Fi hotspot, and enter the Wi-Fi name (SSID) and
password.

3 Turn on Wi-Fi on the other device, and select the name of the device
network on the Wi-Fi list.

4 Enter the network password.
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5 - This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tether#wifi

Wi-Fi hotspot turn off timer

When the Wi-Fi hotspot has not been used for a specific period of time,
it is automatically disconnected. You can set the time for automatic
disconnection.

Bluetooth tethering

A Bluetooth-connected device can connect to the Internet by using your

device's mobile data.

1 On the settings screen, tap Network & internet > Tethering >
Bluetooth tethering and then tap () ) to activate it.

2 Turn on Bluetooth on both devices and pair them.

I_;'] « This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http7/www.android.com/tether#Bluetooth_tethering

Help
You can view help on using tethering and hotspots.
On the settings screen, tap Network & internet > Tethering > Help.
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Airplane mode

You can turn off the call and mobile data functions. \When this mode is
on, functions that do not involve data, such as games and music playback,
remain available.

7 Onthe settings screen, tap Network & internet > Airplane mode.

2 Tap Turn on in the confirmation screen.

Mobile networks
You can customise the mobile networks settings.

T On the settings screen, tap Network & internet > Mobile networks.

2 Customise the following settings:

- Data roaming: Browse the web, use emails, multimedia messages
and other data services overseas.

- Network mode: Select a network type.

+ Access Point Names: View or change the access point for using
mobile data services. To change the access point, select a choice
from the access point list.

- Network operators: Search for network operators and connect
automatically to a network.
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VPN

You can connect to a safe virtual network, such as an intranet. You can
also manage connected virtual private networks.

Adding VPN
1 On the settings screen, tap Network & internet > VPN.
2 Tap+

5 - This feature is available only when the screen lock is activated. If the
screen lock is deactivated, a notification screen appears. Tap Change
from the notification screen to activate the screen lock. See Setting a
screen lock for details.

3 Enter VPN details and tap Save.

Configuring VPN settings
71 Tapa VPN from the VPN list.

2 Enter the VPN user account details and tap Connect.

- To save the account details, select the Save account information
checkbox.

Private DNIS

You can configure the Private DNS (Domain Name System) options.
71 On the settings screen, tap Network & internet > Private DNS.
2 Select the desired option and tap Save.
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Connected devices

Bluetooth

You can connect your device to nearby devices that support Bluetooth to
exchange data with them. Connect your device to a Bluetooth headset
and a keyboard. This makes it easier to control the device.

Pairing with another device

71 On the settings screen, tap Connected devices > Bluetooth.

2 Tap to activate it.
+ Available devices appear automatically.
+ To refresh the device list, tap (.

5 + Only devices set as visible are displayed on the list.

3 Select a device from the list.

4 Follow the on-screen instructions to perform authentication.

E « This step is skipped for previously accessed devices.

Sending data via Bluetooth

1 Select afile.
- You can send multimedia files or contacts.

2 Tap << > Bluetooth.

3 Select a target device for the file.
« The file is sent as soon as the target device accepts it.

E + File sharing processes may differ, depending on the file.
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Screen sharing

You can play the screen and sound of the device on a different device,
such as a TV, that supports the Miracast function.

7 On the settings screen, tap Connected devices > Screen sharing.
2 Tap () toactivate it.

3 Select a device from the list of nearby devices.
« If the desired device does not appear, tap Search to refresh the list.

+ After connecting to the device, the device displays the screen of
your device.

« Screen sharing turns off automatically if there is no sharing-compatible
device in the vicinity.

NFC

You can use the device as a transportation card or credit card. You can also
share data with the other device.

7 On the settings screen, tap Connected devices > NFC.

2 Tap())toactivate it.

« Touch your device with other device that supports NFC to allow
sharing data.

E + NFC antenna may be located differently depending on the device type.
See Parts overview for details about the NFC antenna area.
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Sharing panel

You can share contents from Gallery, Music and File Manager with nearby
devices. Also you can share the content with specific people in apps that
work with Google Direct Share.

7 Onthe settings screen, tap Connected devices > Sharing panel.

7 Tap @ to deactivate each option.

- Nearby devices: You can display the nearby devices to which you
can share contents on the Gallery, Music, and File Manager apps.

- Direct share: From an app which supports Google Direct Share, you
can display an icon which allows you to share contents to specific
people.

File sharing

You can send and receive files between your device and other LG devices
or tablets.

7 On the settings screen, tap Connected devices > File sharing.
2 Customise the following settings:
+ VELVET: Change the device name.

- Save to: Set the destination folder to save files sent from other
devices in.

+ File sharing: Permit receipt of files sent from other devices.

- SmartShare Beam: Share files with other devices via SmartShare
Beam.

+ Help: You can view help on sharing files.
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Media server

You can share media content on your device with nearby devices that
support DLNA.

71 On the settings screen, tap Connected devices > Media server.

2 Customise the following settings:
- Content sharing: Share content on your device with nearby devices.
+ VELVET: Set your device’s name.

E - Depending on the user's product, the menu names may appear
differently.

- Content to share: Select the type of media content to share with
other devices.

- Allowed devices: View a list of devices permitted to access content

on your device.

Not-allowed devices: View a list of devices not permitted to access

content on your device.

Printing
You can connect your device to a Bluetooth printer and print photos or
documents saved on the device.
On the settings screen, tap Connected devices > Printing.
- Tap Default Print Service to search for printers you can connect to. Or;
tap ¢ > Add printer to manually add a printer.
+ Tap (+) Add service to download the printer app you want.

E « This is available only when the mobile network or the Bluetooth
function is turned on.

- To down the printer app in (+) Add service, first log on to your Google
account.
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Sound

You can customise sound, vibrate and notification settings.

On the settings screen, tap Sound and customise the following settings:

Sound profile: Change the sound mode to Sound, Vibrate only, or
Silent.

Volume: Adjust the sound volume for various items.

Ringtone: Select a ringtone for incoming calls. Add or delete ringtones.
Notification sound: Select a notification ringtone. Set music saved on
the device as a notification ringtone.

Ring with vibration: Set the device to vibrate and play a ringtone
simultaneously.

Ringtone ID: Create a ringtone for an incoming call from a particular
contact.

Flash alert for incoming call: Set the flash to blink according to LG
ringtone.

Do not disturb: Set the time, range and app type to receive
notification messages. Receive notification messages only on particular
days of the week.

Sound quality and effects: Use the function to set the sound quality
and effects while playing a song or video.

- Volume: Adjust the sound volume for various items.

Normalize volume: Use the function to normalise the volumes of
different sound sources.

- Equalizer: Use the function to adjust the equaliser settings.

LG 3D Sound Engine: Use the function to play music or video in
three-dimensional, immersive and vivid sound when earphones,
speaker or other external audio devices are connected. See LG 3D
Sound Engine for detalls.
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- Live Caption: Set the device to detect the voice in the media and
automatically generate subtitles.

- Vibration strength: Adjust the vibration intensity.

- Vibration type: You can select the type of vibration when receiving
calls.

- Vibrate on tap: Set the device to vibrate when you tap certain items
on the screen.

- Dialing keypad sound: Select the keypad sound effect.
+ LG Keyboard sound: Select LG keyboard sound effect.
+ Touch sound: Select a sound effect for tapping an item.

- Screen lock sound: Select a sound effect when the screen is locked or
unlocked.

Notifications

You can check a list of installed apps, and configure the settings for
notifications.

7 On the settings screen, tap Notifications.

2 Customise the settings as desired.
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Display

You can customise detailed settings for each screen type.

On the settings screen, tap Display and customise the following settings:

- Home screen: Customise settings for the Home screen. See Home
screen settings for details.

- Navigation bar: Set the style of the navigation bar with Gestures
or Buttons only. you can also change the button combination when
you set Buttons only as a style of the navigation bar. For detalils, see
Navigation bar.

- Status bar: Set the color of the status bar on the top of the screen, or
set the notification icon display and battery percentage display.

AOD(always-on display): Always display information, such as the date,
time and notifications, even when the screen is turned off. For details,
see AOD(always-on display).

Comfort view: Set the device to reduce amount of blue light on screen
to reduce eye strain.

« This function is not available when the device is connected to LG Dual
Screen (LM-G905N).

- Night mode: You can apply a dimmed screen theme to avoid glare on
the screen at night time.

- Screen colour: Adjust the colour, colour temperature for the desired
screen.

E - Tap) to reset the settings.

+ Video Enhancer: \When playing back a video in full screen mode, you
can change the settings for brighter and more dynamic colour display.

+ Font: Change the font size, bold text or type.

+ Accent colour: Change the point color for settings, menus, notification
windows, etc.
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- Display size: Set the items on the screen to a size easy for you to see.
Some items may change position.

+ Full screen apps: Adjust the screen size of apps.

- Brightness: Use the slide bar to change the device's screen brightness.
To automatically adjust screen brightness according to ambient light
intensity, tap the Auto switch.

- Auto: Set the device so that the screen brightness is automatically
adjusted in accordance with the ambient light intensity.

- Screen timeout: Automatically turn off the screen when the device is
left idle for a specified period of time.

- Auto-rotate screen: Automatically rotate the screen according to the
device's orientation.

- Screen saver: Display a screen saver when the device is connected to
the holder or charger: Select a screen saver type to display.

- One-handed screen: Make the screen size smaller to conveniently use
the device with one hand. Drag the Home touch button at the bottom
of the screen to the left or right.

Wallpaper & theme

You can select wallpaper, screen theme, icon style or AOD (Always-on
Display) for your device.

71 Onthe settings screen, tap Wallpaper & theme.
7 Tap Wallpaper, Theme, Icon, or AOD to customise the settings.
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Lock screen & security

You can customise lock screen and security settings.
7 On the settings screen, tap Lock screen & security.

2 Customise the settings.
- Google Play Protect: Scan your device daily for potentially harmful
apps.
- Find My Device: Remotely track the device location. You can also
protect your data securely if you lost your device.

- Security update: Check for software update and configure
automatic installation settings.

- Select screen lock: Select the desired screen lock method. See
Setting a screen lock for details.

+ Customise Lock screen: Change the information displayed on the
locked screen.

- Secure lock settings: Change the secure lock settings.

- Fingerprints: Use your fingerprint to unlock the screen or content.
See Fingerprint recognition overview for details.

- Content lock: Allow you to set a lock type (password or pattern)
for your Gallery files.
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Encryption & credentials: Configure the settings for SD card
encryption and credentials.

Encrypt SD card: Encrypt the memory card to prevent use on
another device. See Memory card encryption for detalls.

- Credential protection: View the type of the storage where the
security certificate will be saved.

Trusted credentials: View your system's root CA certificates and
user-installed CA certificates.

User credentials: \View and change secure certificate information
stored on your device.

- Install from storage: Install a secure certificate from a storage.

Clear credentials: Delete user-installed secure certificates and
related credentials.

Phone administrators: Allow privileges to restrict the control or
use of the device to particular apps.

Trust agents: View and use trust agents installed on the device.

Screen pin: Fix the app screen so that only the currently active app
can be used.

Usage access: VView details on usage of apps on the device.
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Privacy
You can find and adjust all your privacy settings.
7 On the settings screen, tap Privacy.

2 Customise the settings.
- Permission manager: Allows you to check and change the
permissions granted to the apps.

+ Lock screen: Allows you to set notifications to show on the lock
screen.

- Make passwords visible: Enable this option to briefly show each
character of the password as you type it so you can see what you've
entered.

- Device Personalisation Services: Allows you to get a suggestion
based on users, apps, and interactive content.

+ Auto-fill service from Google: Enable this option to enter your
information saved in your account such as password, address,
or credit card number with a single tap. You can also disable this
option, use the Google Autocomplete feature, or add a new service
account.

- Google Location History: Allows you to enable or disable Location
History. When enabled, Google periodically stores and uses your
phone's most recent location data in connection with your Google
Account.

From the Location History screen, tap & to view and/or manage
your location data.

+ Activity controls: Select activities and information which you want
Google to save.

+ Ads: Allows you to check the advertising ID and set the personalised
ads.

- Usage and diagnostics: Enable this option to help improve the
Android experience by automatically sending diagnostic, device, and
app usage data to Google.
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Location

You can check how your location information is shared and configure the
permission to access your location information.

On the settings screen, tap Location and set the desired function.

Extensions

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise
it

On the settings screen, tap Extensions > Smart Doctor.

Context Awareness

You can automatically change your device settings according to the usage
pattern and location.

71 On the settings screen, tap Extensions > Context Awareness.

7 Activate items you want to automatically change settings for.
+ AUTOMATED: You can set the device to change the sound
profile, Bluetooth and Wi-Fi options automatically in different
environments, such as At home, Away from home, At work, and Off
work. You can also set an app to open when earphones are plugged
in or a Bluetooth device is connected.

E « To use this feature, home or work location must be preset in My places.
On the settings screen, tap Location > My places to set the locations.
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Personalized service
You can get intelligent results when using the integrated search.

1

On the settings screen, tap Extensions > Personalized service.

2 Tap () to activate it.

Gaming
You can configure settings for game tools, graphics and battery saving
feature.

1
2

On the settings screen, tap Extensions > Gaming.
Customise the following settings:
- Game Launcher:Tap () ) to use the game launcher.

- Game tools: You can run the function while playing games by
touching the game tools icon among the home touch buttons.

- Game graphics: Adjust the game graphics.

E + \When you change the resolutions on some games, the screen display

feature may not work properly.
« This function may not be available in certain game apps.

- Break time: Reduce the screen brightness and performance
whenever you leave the game running for more than 5 minutes.
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Screen recording
You can configure the settings for screen recording.
T On the settings screen, tap Extensions > Screen recording.
2 Customise the following settings:
+ Include yourself in video by: Select one from the following options.

- Image:Includes your profile image in video when recording. After
selecting this, tap @ and select a profile image. Then, adjust the
size of the image using the slide bar.

- Front camera:Includes yourself recorded using the front camera
while recording the screen.

- Never: Nothing is included.

- Audio source: Choose the audio source between Mic and
Contents.

- Video resolution: Select the resolution for screen recording.

To record the screen

1 Drag the status bar downward to open the Quick access icons list.

2 (If necessary, swipe left over the Quick access icons area.) Tap G

3 Read the disclaimer and tap Start. It will start recording in 3 seconds.

4 To stop recording, tap (® located at the bottom right of the screen.
The recorded video will be saved in Gallery.

E - If you violate another person's rights such as portrait right or intellectual
property right or defame another person’s reputation by using the
functions provided for the screen recording service, you may be held
liable to civil, criminal or administrative charges in accordance with the
relevant laws. LG Electronics is not legally responsible in any way for the
acts of users.
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Dual App

You can install duplicate messenger apps on the product and use two

accounts at the same time.

7 On the settings screen, tap Extensions > Dual App.

7 After reading the disclaimer, tap Confirm.

3 Inthe list of available apps, tap Install to install a copy of a desired app
and follow the on-screen instructions.

+ On the screen, the list of available dual apps is shown. During
installation, app icons are generated on the home screen.

Pen

You can configure options for using an Active pen (optional-sold
separately). Please note that this device supports the Active Pen AES2.0
(Active Electrostatic).

T On the settings screen, tap Extensions > Pen.

2 Customise the following settings:
+ Pen key shortcuts: Configure the shortcuts on each button on
your Active pen.

+ Pen Pop shortcut: Select which apps (up to five) to display as a
shortcut when the pen is removed from the device.

+ Memo preview: Turn on to display recent memos in Pen pop.

+ Drawing sound: Turn on to apply sound effects in drawing mode.

- Show pointer: Turn on to see a pen pointer over where the pen
hovers.

- Ignore navigation bar gestures: Block navigation bar gestures
from being input, which is useful when drawing or writing on the
edge of the screen with an Active pen.

Settings 146



Shortcuts
You can use buttons such as the Lock/Power, Volume, and Google
Assistant to run certain apps or functions right away.
71 Onthe settings screen, tap Extensions > Shortcuts.
2 Customise the following settings.
- Open Camera: Press Power key twice to open Camera.

- Open Screen-off memo: Press Volume Up key twice to open
Screen-off memo when the screen is locked or off.

- Open Camera: Press Volume Down key twice to open Camera
when the screen is locked or off.

- Open Google Assistant: Press the Google Assistant key on the
side of the phone.

- Talk to Google Assistant: Press and hold the Google Assistant key
to quickly talk to your Assistant.

E + Google Assistant does not support certain languages.

KnockON

Double-tap the screen to turn the screen on or off.
See KnockON for details.

Increase touch sensitivity

You can set the touch screen more sensitive to your touch. Recommended
to turn this feature on when using a screen protector.

On the settings screen, tap Extensions > Increase touch sensitivity.
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Apps

You can check a list of installed apps, and configure the settings for
notifications, app permissions, and more.

1 On the settings screen, tap Apps.

2 Customise the settings.

Battery

You can view the current battery information or turn on power-saving
mode.

71 Onthe settings screen, tap Battery.

2 Customise the following settings:
- Battery usage: View the battery usage detalils.

- Optimized charging: Automatically adjust charging speed according
to how you charge to reduce heat and extend lifespan of battery.

- Adaptive battery: Allow you to save the battery by stopping apps
running in the background.

- Background restrictions: Enable this option to restrict background
apps to save the battery while using the device. Restricted apps
for power saving may not work properly or may not send you
notifications.

- Battery saver: Reduce battery consumption by cutting down some
device settings, such as the display brightness, speed and vibration
intensity.

- Power saving exclusions: Select apps to use without any
functional limitation while in power saving or battery optimisation
mode.
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Storage

You can view and manage internal storage on the device or storage space
of the memory card.

1 On the settings screen, tap Storage.

2 Customise the following settings:

- Internal storage: View the total storage space and free space in the
devices internal storage. View a list of apps in use and the storage
capacity for each app.

+ SD card: View the total storage space and free space in the
memory card. This option appears only when a memory card is
inserted. To unmount the memory card, tap

Accounts
You can add users to share your device and register a cloud account.
1 On the settings screen, tap Accounts.

2 Customise the settings.

Digital Wellbeing & parental
controls

You can view the product use time and set the timer for each app.

Also, you can manage the mobile phone use time by using the Sleep
Preparation Mode and Focus Mode.

Select Digital Wellbeing & parental controls on the settings screen and
set the desired function.
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Google

You can use Google settings to manage your Google apps and account
settings.

On the settings screen, tap Google.

System

Update centre

You can check and install the latest version of the app or software
provided by LG.

1 On the settings screen, tap System > Update centre.

2 Customise the following settings:

+ App Updates: Check if an app update is available. If available, you
can install the update.

- Software Update: Check if a software update is available. If
available, you can install the update.

Language & keyboard

You can customise language and keyboard settings for your device.
1 On the settings screen, tap System > Language & keyboard.

2 Customise the following settings:
- Language: Select a language to apply for the device.

- Manage keyboards: You can change the product’s basic keyboard
setting, set the use environments for LG Keyboard or other installed
keyboards, and set the speech recognition function for Google Voice
input. Also, you can set whether to display the keyboard button in
the touch button area on the home screen so that you can quickly
switch to another keyboard.
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Physical keyboard: Select to use the physical keyboard, or check
keyboard shortcut keys.

Autofill service: Enable this option to enter your information saved
in your account such as password, address, or credit card number
with a single tap. You can also disable this option, use Google
Autocomplete, or add a new service account.

Text-to-speech output: Configure the settings for text-to-speech
output.

Pointer speed: Adjust the pointer speed of a mouse or trackpad.

Reverse mouse buttons: Reverse the right mouse button to
perform primary direct-manipulation actions.

Date & time
You can customise date and time settings for your device.
1 On the settings screen, tap System > Date & time.

2 Customise the settings.

Memory

You can view the average amount of memory usage over a certain period
of time and the memory occupied by an app.

71 On the settings screen, tap System > Memory.

7 Tap w to set a time slot to retrieve data.
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Backup

You can back up data saved on your device to another device or account.
T On the settings screen, tap System > Backup.

2 Customise the following settings:
+ LG Mobile Switch: Allow you to transfer data from an old LG device
to your new LG device. See LG Mobile Switch for detalls.

- Backup & restore: Back up your device data or restore data to your
device from a backup.

A + Resetting your device may delete backup files saved in storage. Make
sure to copy and store the important backup files to your PC.

+ Google backup: Change Google drive backup settings. You can
also check the backup account currently used, or add a new backup
account.

Restart & reset
You can reset the device including network and app settings.
7 Onthe settings screen, tap System > Restart & reset.

2 Customise the following settings:

- Auto-restart: Automatically restart and optimise the phone at a
set time. Tap () to activate this feature. The device automatically
restarts at a set time and optimise itself: Select a date and time for
restart.
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E + You can set the device to restart itself once a week. The device
automatically restarts in an hour from the preset time.

+ Once the device restarts, notifications and badges are erased. Save
important data before the preset time.

« The Auto-restart feature is not activated in the following situations:
When the screen is turned on, when the device is in use, when the
battery levelis 30% or less, or when the USIM card is locked.

- Depending on the telecommunication provider, the auto-restart
function may or may not be available.

+ Network settings reset: Reset Wi-Fi, Bluetooth and other network
settings.

Reset app preferences: Reset the settings for an app. The data
saved in the app will not be deleted.

- Factory data reset: Reset all settings for the device and delete
data.

E « Restarting and resetting your device deletes all data on it. Enter your
device name, Google Account and other initial information again.

« After data initialization, the data cannot be restored.

About phone

You can view information about your device, such as the name, status,
software details and legal information.

On the settings screen, tap System > About phone and view information.

Regulatory & safety
You can view regulatory marks and related information on your device.
On the settings screen, tap System > Regulatory & safety.
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Accessibility
You can manage accessibility plug-ins installed on your device.
T On the settings screen, tap Accessibility.

2 Customise the following settings:

- Vision > TalkBack: Set the device to notify screen status or actions
via voice.

- Vision > Voice notifications: Set the device to read the caller
information via voice.

- Vision > Font: Change the font size, bold text or type.

- Vision > Display size: Set the items on the screen to a size easy for
you to see. Some items may change position.

- Vision > Touch zoom: Zoom in or out by tapping the screen three
times.

- Vision > Window zoom: Zoom in or out within a window and invert
the colour.

- Vision > Large mouse pointer: Magnify the mouse pointer.

- Vision > High contrast screen: Turn the background colour into
black for a high contrast screen.

- Vision > Screen colour inversion:Increase the display colour
contrast for people with low vision.

- Vision > Screen colour adjustment: Adjust the display colour.
- Vision > Monochrome: Switch the screen to grayscale mode.

« Vision > End call with the Power key: End a call by pressing the
Power/Lock key.

- Hearing > Live Caption: Set the device to detect the voice from the
media and automatically generate subtitles.

- Hearing > Caption preferences: Turn on the subtitle service when
playing videos for the hearing impaired.

- Hearing > Flash alerts: Set the device to notify you with a blinking
light for incoming calls, messages and alarms.
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+ Hearing > Mute all sounds: Mute all sounds and lower volume on
the receiver.

+ Hearing > Audio channel: Select the audio type.

- Hearing > Sound balance: Adjust the audio output balance. Use the
slide bar to change the balance.

+ Motor & cognition > Touch assistant: Turn on the touch board to
make buttons and gestures easier to use.

+ Motor & cognition > Touch input: Enter text by touching and
holding the screen or modify it by simply touching the screen.

- Motor & cognition > Physical keyboard: Customise the keyboard
settings.

+ Motor & cognition > Auto mouse click: Automatically click the
mouse pointer in case of no movement.

+ Motor & cognition > Touch and hold for calls: Answer or decline
calls by touching and holding the call button instead of dragging it.

+ Motor & cognition > Screen timeout: Turn off the screen
automatically when the device is left idle for a specified period of
time.

+ Motor & cognition > Touch control areas: Limit the touch area
so that only a particular portion of the screen can be controlled by
touch input.

+ Accessibility features shortcut: Quickly access a frequently used
function by tapping O three times.

- Auto-rotate screen: Automatically change the screen orientation
according to the physical position of the device.

- Select to Speak: Allow you to tap items to hear spoken feedback.
+ Switch Access: Create key combinations to control your device.
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LG Language Settings

Select a language to use on your device.
+ On the home screen, tap Settings > System > Language & keyboard
> Language > Add language, and select a language.
- Touch and hold = and drag it to the top of the language list to set it
as a default language.

LG Bridge

LG Bridge overview

LG Bridge is an app that helps you manage the photos, music, videos

and documents saved on your LG smartphone from your computer
conveniently. You can back up contacts, photos and more to the computer
or update the device software.

E + See LG Bridge help for details.
+ The supported features may vary depending on the device.

+ LG USB driver is a necessary program to connect your LG smartphone
with the computer and is installed when you install LG Bridge.

LG Bridge functions
+ Back up data from the device to a computer or restore data from a
computer to the device via USB cable connection.

+ Update the device software from a computer via USB cable connection.

Appendix 157



Installing LG Bridge on a computer
1 Go to wwwilg.com from your computer.
2 Select your region.
3 Click Support > Software & Firmware.
4 Enter the name of your device.
OR
Select by the Product Category.
5 Go to PC Sync > LG Bridge to download the setup file.

+ Go to Details to view the minimum requirements for installing
LG Bridge.

Phone software update

LG Mobile phone software update from the

Internet

For more information about using this function, please visit
http//wwwi.lg.com/common/index,sp, select your country and language.
This feature allows you to conveniently update the firmware on your
phone to a newer version from the Internet without needing to visit a
service centre. This feature will only be available if and when LG makes a
newer firmware version available for your device.

Because the mobile phone firmware update requires the user's full
attention for the duration of the update process, please make sure

you check all instructions and notes that appear at each step before
proceeding. Please note that removing the USB cable during the upgrade
may seriously damage your mobile phone.

+ LG reserves the right to make firmware updates available only for

selected models at its own discretion and does not guarantee the
availability of the newer version of the firmware for all handset models.
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LG Mobile Phone software update via Over-
the-Air (OTA)

This feature allows you to conveniently update your phone's software to
a newer version via OTA, without connecting a USB cable. This feature will

only be available if and when LG makes a newer firmware version available
for your device.

To perform the phone software update,

Settings > System > Update centre > Software Update > Check now
for update.

E « Your personal data from internal phone storage—including information
about your Google Account and any other accounts, your system/
application data and settings, any downloaded applications and your
DRM licence—might be lost in the process of updating your phone's
software. Therefore, LG recommends that you backup your personal
data before updating your phone’s software. LG does not take
responsibility for any loss of personal data.

« This feature depends on the area or service provider.
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Anti-Theft Guide

Set up your device to prevent other people from using it if it's been reset

to factory settings without your permission. For example, if your device is

lost, stolen, or wiped, only someone with your Google Account or screen

lock information can use the device.

All you need to make sure your device is protected is:

- Set a screen lock: If your device is lost or stolen but you have a screen

lock set, the device can't be erased using the Settings menu unless
your screen is unlocked.

+ Add your Google Account on your device: If your device is wiped but
you have your Google Account on it, the device can't finish the setup
process until your Google Account information is entered again.

After your device is protected, you'll need to either unlock your screen or
enter your Google Account password if you need to do a factory reset.
This ensures that you or someone you trust is doing the reset.

E « Do not forget your Google Account and password you had added to
your device prior to performing a factory reset. If you can't provide the
account information during the setup process, you won't be able to use
the device at all after performing the factory reset.
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Open Source Software Notice
Information

To obtain the source code under GPL, LGPL, MPL, and other open
source licenses, that is contained in this product, please visit
http://opensource.lge.com.

In addition to the source code, all referred license terms, warranty
disclaimers and copyright notices are available for download.

LG Electronics will also provide open source code to you on CD-ROM
for a charge covering the cost of performing such distribution (such
as the cost of media, shipping, and handling) upon email request to
opensource(@lge.com.

This offer is valid for a period of three years after our last shipment of this
product. This offer is valid to anyone in receipt of this information.

Regulatory information
(Regulation ID number, E-labeling, etc.)

For regulatory details, go to Settings > System > Regulatory & safety.
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Trademarks

+ Copyright ©2020 LG Electronics Inc. All rights reserved. LG and the
LG logo are registered trademarks of LG Group and its related entities.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Photos, Google Play Protect, Google Calendar,
Google Docs, Google Drive, Google Sheets and other related marks and
logos are trademarks of Google LLC.

- Bluetooth®is a registered trademark of Bluetooth SIG, Inc. worldwide.

+ Wi-Fi® and the Wi-Fi logo are registered trademarks of the Wi-Fi
Alliance.

+ All other trademarks and copyrights are the property of their
respective owners.

HE HEVCAdvance™

‘E Covered by Patents at patentlisthevcadvance.com
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Laser safety statement

Caution!

This product employs a Laser system. To ensure proper use of this
product, please read this owner's manual carefully and retain for future
reference. Should the unit require maintenance, contact an authorised
service centre.

Use of controls, adjustments, or the performance of procedures other
than those specified herein may result in hazardous radiation exposure.
To prevent direct exposure to laser beam, do not try to open the enclosure
or make direct contact with the laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

DECLARATION OF CONFORMITY

Hereby, LG Electronics declares that this LM-G900EM product is in
compliance with the essential requirements and other relevant provisions
of Directive 2014/53/EU.

A copy of the Declaration of Conformity can be found at
http//wwwi.lg.com/global/declaration
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Contact office for compliance of

this product

LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

The use of the 5150 - 5350 MHz band is restricted to indoor use only.
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More information

Tempered glass parts

Tempered glass parts of this device are not permanent and they may wear
out over time.

- If you drop your device on a hard surface or subject it to severe impact,
the tempered glass may be damaged.

If this happens, stop using your device immediately and contact an LG
Customer Service Centre.

- You can purchase protective cases to protect your device from damage
on the market.

Note that these protective cases are not covered under the warranty
service provided by LG Electronics and safety is not guaranteed.

Aspect ratio
This device uses 20.5:9 aspect ratio.
+ Some downloaded apps may not support 20.5:9 aspect ratio.

In this case, select the most optimal screen ratio for the app or consult
the app provider for more information.
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Guide to data transfers

- For the data that can be exchange between LG devices or between the

LG device and a third party device, see the following table.

Third party
LG device Android iOS device
Type Item details - device —
LG device - LG device
LG device

Contacts, messages,

dial logs, calendar, voice @) O O
Personal | recordings
data Memos X O

Alarms X X
Media Photos, videos, songs,
data documents o o O

Home screen settings

(folders and widgets) % X X
Screen
settings Lock screen settings

(screen lock settings @) X X

excluded)

Downloaded apps O O
Apps Personal data of the o X B

downloaded app

Public certificate @) @) X
Others | Settings (Wi-Fi, Bluetooth,

Calls, sound & notification, @) X X

accessibility, battery)

E + Some data may not be transmitted depending on the software version,
app version, operating system, manufacturer or service provider's policy.
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Supported Frequency Bands Transmitter Output power

GSM 900 33.7dBm
GSM 1800 30.7dBm
WB1 24.7 dBm
W B8 25.5dBm
LTE B1 24.2 dBm
LTEB3 24.7 dBm
LTEB7 24.7 dBm
LTEBS8 25.5dBm
LTEB20 25.5dBm
LTEB28 25.5dBm
LTEB38 25.2dBm
LTE B40 25.2dBm
5G Sub6n1 24.7dBm
5G Sub6n3 24.7 dBm
5G Sub6n28 24.5dBm
5G Sub6n40 25.2dBm
5G Sub6n78 22.7dBm
BT 2.4GHz 11dBm
WLAN 2.4GHz 19.5dBm
WLAN 5GHz 19.dBm
NFC - 23 dBuA/m

Travel Adapter Information can be found at
http//wwwi.lg.com/global/support/cedoc/cedoc
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Disposal of your old appliance

1. This crossed-out wheeled bin symbol indicates that waste electrical
and electronic products (WEEE) should be disposed of separately
from the municipal waste stream.

N 2 Old electrical products can contain hazardous substances so correct
disposal of your old appliance will help prevent potential negative
consequences for the environment and human health. Your old
appliance may contain reusable parts that could be used to repair
other products, and other valuable materials that can be recycled to
conserve limited resources.

3. You can take your appliance either to the shop where you purchased
the product, or contact your local government waste office for
details of your nearest authorised WEEE collection point. For
the most up to date information for your country please see
wwwi.lg.com/global/recycling

Disposal of waste batteries/accumulators

1. This symbol may be combined with chemical symbols for mercury
(Hg), cadmium (Cd) or lead (Pb) if the battery contains more than
0.0005% of mercury, 0.002% of cadmium or 0.004% of lead.

2. All batteries/accumulators should be disposed separately from the

municipal waste stream via designated collection facilities appointed
by the government or the local authorities.

3. The correct disposal of your old batteries/accumulators will help
to prevent potential negative consequences for the environment,
animal and human health.

4. For more detailed information about disposal of your old batteries/
accumulators, please contact your city office, waste disposal service
or the shop where you purchased the product.
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FAQ

This chapter lists some problems you might encounter when using your
device. Some problems require you to call your service provider, but most
are easy to fix yourself.

SIM card error
Make sure the SIM card is correctly inserted.

No network connection or dropped network
Signal is weak. Move to a window or an open area.
You are outside the carrier network area. Move and check the network.

Calls are not available

New network not authorised.

Make sure you have not set call barring for the incoming number:
Make sure you have not set call barring for the number you are dialling.

Device cannot be turned on
When the battery is completely discharged, your device will not turn on.
Fully charge the battery before turning on the device.

Charging error

Make sure device is charging at a normal temperature.
Check the charger and its connection to the device.

Use only in-box accessories which are authorised by LG.

The battery depletes faster than when first purchased

When you expose the device or the battery to very cold or hot
temperatures, the battery life may be reduced.

Battery consumption will increase when you use certain features or apps,
such as GPS, games or the Internet.

The battery is consumable and the battery life will get shorter over time.
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Error messages appear when launching the camera
Charge the battery.

Free some memory by transferring files to a computer or deleting files
from your device.

Restart the device.

If you are still having trouble with the camera app after trying these tips,
contact a LG Electronics Service Centre.

The photo quality is poor
The quality of your photos may vary, depending on the surroundings and
the photography techniques you use.

If you take photos and videos, standard angle quality is better than wide-
angle.

If you take photos in dark areas, at night or indoors, image noise may
occur or images may be out of focus.

If you have any problems, reset the options.

The touch screen responds slowly or incorrectly

If you attach a screen protector or optional accessories to the touch
screen, the touch screen may not function properly.

If you are wearing gloves, if your hands are not clean while touching the
touch screen or if you tap the screen with sharp objects or your fingertips,
the touch screen may malfunction.

The touch screen may malfunction in humid conditions or when exposed
to water.

Restart your device to clear any temporary software bugs.

If the touch screen is scratched or damaged, visit a LG Electronics Service
Centre.
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Hangs or freezes

Restart the device

- If your device freezes or hangs, you may need to close apps or turn the
device off and then on again.

Perform a boot-up

- Asoft reset may be used to reset the device if the screen freezes, or
the buttons, touch screen or device are no longer responding.

- To perform a soft reset of your device, simply press and hold the
Volume Down and Power keys until the device restarts.

E « This function is not available when the device is connected to LG Dual
Screen (LM-G905N).

Reset the device
+ If the methods above do not solve your problem, perform a factory
data reset.
- On the settings screen, tap System > Restart & reset > Factory data
reset.

- This method resets all settings for the device and deletes data.
Before performing the factory data reset, remember to make back-
up copies of all important data stored in the device.

- If you registered a Google Account to the device, you must sign in to
the same Google Account after resetting the device.
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Bluetooth device is not located
Make sure the Bluetooth wireless feature is activated on your device.

Make sure the Bluetooth wireless feature is activated on the device you
wish to connect to.

Make sure your device and the other Bluetooth device are within the
maximum Bluetooth range (10 m).

If the tips above do not solve your problem, contact a LG Electronics
Service Centre.

A connection is not established when you connect the
device to a computer
Make sure the USB cable you are using is compatible with your device.

Make sure you have the proper driver installed and updated on your
computer.

Downloaded application causes a lot of errors
Application has problems.
Remove and reinstall the application.
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Getting to Know LG Dual Screen

You can connect an LG Dual Screen to this product for use.

E - You can connect the LG dual screen (hereinafter “Dual Screen”) to a
dedicated LG VELVET (hereinafter “phone”), to use the product.

+ Depending on the performance of the a dedicated phone, some features
of Dual Screen may be limited. Also, the product may not support other
mobile devices.

« This product is not water resistance. Do not expose the device to liquid
or moisture.

« If the device is wet, the LDI located inside the device changes in colour.
In this case, the device is ineligible for any free-of-charge repair services
provided under the device's limited warranty.

Guidelines for safe and efficient use

Please read these simple guidelines. Not following these guidelines may
be dangerous or illegal.

Product care and maintenance

+ Use only in-box accessories which are authorised by LG. LG does not guarantee
any damage or failure which is caused by third party accessories.

+ Some contents and illustrations may differ from your device without prior notice.

+ Do not disassemble this unit. Take it to a qualified service technician when repair
work is required.
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Repairs under warranty, at LG's discretion, may include replacement parts
or boards that are either new or reconditioned, provided that they have
functionality equal to that of the parts being replaced.

Keep away from electrical appliances such as TVs, radios and personal
computers.

The unit should be kept away from heat sources such as radiators or cookers.

Do not drop.

Do not subject this unit to mechanical vibration or shock.

Switch off the device in any area where you are required to by special
regulations. For example, do not use your device in hospitals as it may affect
sensitive medical equipment.

Do not handle the device with wet hands while it is being charged. It may cause
an electric shock and can seriously damage your device.

Use a dry cloth to clean the exterior of the unit (do not use solvents such as
benzene, thinner or alcohol).

Do not subject this unit to excessive smoke or dust.

Do not keep the device next to credit cards or transport tickets; it can affect the
information on the magnetic strips.

Do not tap the screen with a sharp object as it may damage the device.

Do not expose the device to liquid or moisture.

Do not use, touch or attempt to remove or fix broken, chipped or cracked glass.
Damage to the glass display due to abuse or misuse is not covered under the
warranty.

Your device is an electronic device that generates heat during normal operation.
Extremely prolonged, direct skin contact in the absence of adequate ventilation

may result in discomfort or minor burns. Therefore, use care when handling your
device during or immediately after operation.

If your device gets wet, immediately unplug it to dry off completely. Do not
attempt to accelerate the drying process with an external heating source, such
as an oven, microwave or hair dryer.

The liquid in your wet device changes the colour of the product label inside your
device. Damage to your device as a result of exposure to liquid is not covered
under your warranty.

LG Dual Screen (LM-G905N) 175



+ A product requires proper air circulation in order to dissipate heat. Direct skin
contact and inadequate circulation of air flow to the device may cause the
device to overheat. The device must be at least 1.0cm from between the user's
body.

Please ensure that the product does not get in contact with liquid. Do not use
or recharge the product if it is wet. Once the product becomes wet, the liquid
damage indicator changes Colour. Please note that this will limit you from
receiving any free-of-charge repair services provided under warranty.

Efficient device operation

Electronics devices
All devices may receive interference, which could affect performance.

+ Do not use your device near medical equipment without requesting permission.
Please consult your doctor to determine if operation of your device may
interfere with the operation of your medical device.

+ Pacemaker manufacturers recommend that you leave at least 15 cm of space

between other devices and a pacemaker to avoid potential interference with the
pacemaker.

Some hearing aids might be disturbed by devices.
+ Minor interference may affect TVs, radios, PCs etc.

+ Use your device in temperatures between 0 °C and 35 °C, if possible. Exposing
your device to extremely low or high temperatures may result in damage,
malfunction, or even explosion.

Road safety

Check the laws and regulations on the use of devices in the area when you drive.
+ Do not use a hand-held device while driving.
+ Give full attention to driving.

+ Pull off the road and park before making or answering a call if driving conditions
so require.

+ RF energy may affect some electronic systems in your vehicle such as car
stereos and safety equipment.

LG Dual Screen (LM-G905N) 176



+ When your vehicle is equipped with an air bag, do not obstruct with installed
or portable wireless equipment. It can cause the air bag to fail or cause serious
injury due to improper performance.

- If you are listening to music whilst out and about, please ensure that the volume
is at a reasonable level so that you are aware of your surroundings. This is of
particular importance when near roads.

Glass Parts

Some parts of your device are made of glass. This glass could break if your device is
dropped on a hard surface or receives a substantial impact. If the glass breaks, do
not touch or attempt to remove it. Stop using your device until the glass is replaced
by an authorised service provider.

Blasting area

Do not use the device where blasting is in progress. Observe restrictions and follow
any regulations or rules.

Potentlally explosive atmospheres
Do not use your device at a refueling point.
+ Do not use near fuel or chemicals.

+ Do not transport or store flammable gas, liquid or explosives in the same
compartment of your vehicle as your device or accessories.

Children

Keep the device in a safe place out of the reach of small children. It includes small
parts which may cause a choking hazard if detached.
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Product components and
accessories

The following items are included with your product.
+ Product + Quick Start Guide
+ Charging Adapter

A .

.

.

Make sure to use the authentic accessories provided by LG Electronics.
Using products that are not authentic may cause deterioration of phone
call quality, device malfunction, etc. In such a case, you may not be able
to receive service provided by LG Electronics.

Some of Dual Screen parts are made of tempered glass. If you drop your
product on a hard surface or subject it to severe impact, the tempered
glass may be damaged. If this happens, stop using your product
immediately and contact an LG Customer Service Centre.

« The appearance and specifications of your product are subject to

change without notice.

The exterior and specifications of Dual Screen may be changed without
prior notification to improve its performance.
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Parts overview

Front

o
1
|

117

~—

Unfolded
(4 ==Y

|0

(5
— 0
1—0
@ Cover Display © Product screen
@ Volume keys ©® Communication/Power terminal
© Google Assistant key @ Pogo Pin Port

O Hole for earpiece

+ This manual is designed for users who connect a phone to this Dual
Screen. For more information on how to use this Dual Screen and the
phone, please visit www.lg.com and refer to the detailed user manual.
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Plugging the phone into the Dual
Screen

71 Completely unfold the Dual Screen so that it is parallel to a flat
surface.

2 Slide the bottom of your phone into the bottom of the Dual Screen as
shown in the figure. At this time, make sure that the @) part of the
phone fits the @ part of the Dual Screen correctly.
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3 Press the @ part of the phone with your finger to engage the edge of
the phone with that of the Dual Screen.

U

/4 Press the @ part of the phone to fully engage the Dual Screen with

the phone.
of

7

= ‘XS

A + Make sure that your phone is fully inserted into the Dual Screen before
use.
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Removing the phone from the
Dual Screen

1 Unfold the Dual Screen completely and hold it firmly with both hands
as shown in the figure.

2 Press the @ part of the Dual Screen with your finger while
simultaneously pushing the back of the phone with your other fingers
to pull the edge of the phone out of the Dual Screen.
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3 Pull the @ part of the phone out of the Dual Screen following the
same directions from the previous step.

4 Hold the Dual Screen with both hands and slide the phone in the
direction of the arrow to remove it. Be careful not to twist the phone
left or right or push it up at an excessive angle.

/\ CAUTION:
+ Do not lift the phone from the Dual Screen at an acute angle as shown below.
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If you pull the phone from the Dual Screen at an excessive angle or

with excessive force when removing the phone, you may damage the
Communication/Power terminal on the bottom of the Dual Screen or
the USB data communication and charger port on the phone. Be sure to
push up the phone in the direction of the arrow as shown in the figure
when removing it.

Be careful not to drop the Dual Screen or the phone while inserting or
removing the phone.

When you insert or pull out your phone from the Dual Screen, be
cautious not to use excessive force. Doing so may damage the Dual
Screen.

Some of the Dual Screen parts are made of tempered glass. Dropping
the Dual Screen on a hard surface or subjecting it to a strong impact
may cause the tempered glass to crack or wear, damaging the Dual
Screen or causing injury. If this happens, stop using the Dual Screen
immediately and visit your nearest LG Customer Service Centre for
repair.

In the following situations, the Dual Screen folder may not close fully or
the Dual Screen may not operate normally due to poor communication
or faulty connection of the power terminal.

- If you attach a protective film, protective glass, or other accessories
on the Dual Screen or the screen of your phone

If you attach a protective film or thick stickers on the Dual Screen
connection area or the rear side of your phone

If you insert sheets of paper or cards between the Dual Screen and
your phone

If you use the wireless charging or NFC function while your phone is
inserted into the Dual Screen, charging may not work properly.

\When the phone is mounted on the Dual Screen, it cannot be connected
toa TV with an HDMI cable. When the phone is unmounted from the
Dual Screen, it can be connected to a TV with an HDMI cable.
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Using the Charging Adapter

You can use the charging adapter to charge your phone or move data

while your phone is inserted into the Dual Screen.

1 With the phone mounted on the Dual Screen, connect the charging
adapter to the charging port at the bottom of the Dual Screen as
shown in the figure below.

4 N
»><—— Pogo Pin Port
",
@Z Charging Adapter
. J

E + Pogo Pin will not function if it is connected in a reverse direction.
+ The USB connection via Pogo Pin does not support OTG, audio, HDMI or
USB 3.0. For these, directly connect the cable to the port on the phone
after removing the Dual Screen.
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2 Connect a USB Type-C cable.
+ You can charge the phone or move data.

L

Charging Cable Connector =

E + When the charging adapter is not in use, disconnect power of the
charger and keep it separately from the charger cable connector. If the
magnet part of the charging adapter gets in contact with nearby metals
or conductive substances, it may be broken, burned, or damaged from
electric shock.

.

Make sure that you always use the charging adapter provided with the
Dual Screen. If you lose the charging adapter or want to purchase a new
one, call the LG Electronics Customer Service Centre for details.

« The charging adapter and the charging port at the bottom of the
Dual Screen are connected magnetically. Do not shake or pull out the
charging adapter while using it.
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Using the Dual Screen

Picking up and hanging up the call with the
Google Assistant key

With Dual Screen and the phone connected, you can answer the call by
pressing the Google Assistant key once. To end the call, press the Google
Assistant key twice to hang up.
+ You can pick up or hang up the call with the Google Assistant key only
when the cover of the Dual Screen is fully closed.
+ Make sure that the product and the phone are connected through at
least one sync.

When making a phone call
When making a phone call, you can fold the Dual Screen outward to 360
°orfolditinward to O °.
« If you are using the Dual Screen by folding it 360 °, make sure that the
front and back of the Dual Screen are in full contact. In this case, the
screen of the Dual Screen automatically turns off to save the power.

360° 0°
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Using the Dual Screen

Unfold the Dual Screen to put the two screens side by side.

e

e Phone screen

Product
screen

‘mﬂ

Adjusting the Screen Colour

When using the product screen and the phone screen at the same time, a
colour difference may occur between the two screens.

- Try adjusting the colour temperature. On the home screen, tap
Settings > Display > Screen colour, then adjust Colour Temperature.

+ Colours may look different depending on the viewing angle, so adjust
the colours in a fully unfolded state.

Using Dual Screen Home

Getting to Know Dual Screen Home

The Dual Screen home can operate independently of the product’s screen.
+ It provides quick launch icons and a home touch bar.
+ You can change the background and set up widgets.

- On the home screen, you can also run different apps from the apps
drawer and generate or delete folders.
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Getting to know Dual Screen Home layout

You can use various functions by running the icons provided on the home
screen.

»— Quick access area

Navigation bar

E + The background of the Dual Screen may differ from the figure
depending on the manufacturer’s policies, user settings, software
versions, services provided by telecommunication providers, etc.

- Quick access area: Fix main apps at the bottom of the screen so that
they can be accessed from any Home screen canvas.

- Navigation bar: You can do some gestures to go to the Home screen,
previous screen, Overview screen, or quickly switch between apps.
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Using the Dual Screen Panel

You can open the Dual Screen panel by dragging down the top of the
screen.

+ You can adjust the screen brightness on the Dual Screen panel.

- If you activate synchronization by selecting Sync, the screen
brightness of the dual screen comes in sync with that of the
connected product.

- You can tap Screenshot to capture the product screen.

+ You can turn off the product screen by tapping Dual Screen.
- The dual screen and the connected phone are disconnected.

- You can tap (& to enter the settings menu of the dual screen.

’ «— Dual Screen settings
Adjust screen —

A

Screenshot ——— T Dual Screen
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Making Changes to Dual Screen Home
Touch and hold an empty area on the dual screen home and run a desired
function.

- To add a widget to the Home screen, touch and hold on a blank area of
the Home screen, then select Widgets.

- To change wallpapers, touch and hold on a blank area of the Home
screen, then select Wallpapers.

- To change the default screen, touch and hold on a blank area of the

Home screen, move to desired screen, tap £}, then tap the screen once
more.

Default screen

Widgets I Wallpapers
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Viewing the Dual Screen background

You can view only the background image by hiding the apps and widgets
on the Home screen.

Spread two fingers apart on the Home screen.

« Toreturn to the original screen, which displays apps and widgets, pinch
your fingers on the Home screen or tap <}

Setting Dual Screen environment

You can set the dual screen environment on the phone connected to the
dual screen.

T On the home screen, tap Settings > Display > Dual Screen.

I_;r] + You must connect your phone to the dual screen to see the menu item
for dual screen environment setting.
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7 Select and set the desired functions.

- Cover Display: You can set whether to use cover display on the
front of the dual screen.

- Display timeout / Daily timeout: You can set whether to use
both screens at the same time.

Dual Screen Tool: If you connect your phone to the dual screen,
the dual screen tools appear on the screen. The brightness level is
synchronized with that of the Dual Screen.

- Use Dual Screen: You can turn on and off the dual screen, switch
screens between the phone and the dual screen.

- Reverse fold: You can set the behavior for the opposite screen
when the dual screen is folded back.

Brightness: You can adjust the screen brightness by moving the
control bar to the left or right.

- Keep the same as main screen: You can synchronize the
brightness level with that of the connected phone.

- Wide view: You can set an app to be expanded on both screens.

Wallpaper: You can select the wallpaper for the Home screen.

- App drawer icon: You can show or hide the App drawer on your
product.

Multi App Shortcut: You can set two apps to run on the main
screen and dual screen at the same time.

- My Pick App: You can select apps to run automatically every time
you turn on the dual screen.

E - The list of apps that appear on the screen may differ depending on the
installed apps.
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Dual Screen Tool

If you connect your phone to the dual screen and turn on the dual screen,
the Dual Screen Tools menu icon J appears on the side of the phone
screen.

Tap Jto open the Dual Screen Tools menu and access the options shown
below.

9 / @ You can tap it lightly to show or hide the Dual Screen Tools menu.

@ You can switch the screens between the dual screen and the phone.

@ You can send the screen from the phone to the dual screen.

@ You can bring the screen from the dual screen to the phone.

If you use the dual screen only, you can lower the brightness level of
the phone screen (main screen) to save battery. If you do not want to
use this function, swipe the main screen.

@ You can turn off the dual screen.

A

»—— Dual Screen Tool

—— Swap screens
—— Show main on Dual Screen
*— Show Dual Screen on main

—— Put main screen to sleep

*—— Turn off Dual Screen

T
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E « If you turn off your phone, the dual screen also turns off. However, if you
turn off the dual screen, the phone stays on.
« This feature is not available on the lock screen and is activated when

you unlock the screen.

Using Multi-Page Mode

You can extend the use of an app to the main screen and the dual screen

for convenience.

E « This function is also available in partner apps in addition to the Camera

and Gallery apps.
« The Ul may differ depending on the app used.
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Using Multi-Page Mode in Camera
You can shoot a photo or video on the phone or dual screen and view the
result on the other screen.

1 On the home screen, tap (&) on the phone or dual screen and shoot a
photo or video.
7 After shooting a photo or video, select the Preview icon.

+ You can view the photo or video you have taken on the other screen
where the camera is not running.

l

I
Preview icon

E + Once you tap the Preview icon to view a photo or video, the preview
screen stays on and automatically displays the last photo or video taken
as you shoot more photos and videos.

+ This function does not remain active if you close the Camera app and
open again.
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Using Multi-Page Mode in Gallery

Tap [{(Jin a folder in Gallery on the dual screen or phone to view enlarged
photo or video on the opposite screen.

1 On the home screen, tap 8 on the phone or dual screen.

2 Select an album folder and then tap (]

+ The photo or video will be displayed in an enlarged view on the
opposite screen.

+ Tap [7J[] to quit this function.

Extension icon Restore icon

l
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Using Dual Screen app

Each time you turn on the dual screen, the preset dual screen apps run

automatically.

71 On the home screen, tap Settings > Display > Dual Screen > My Pick
App.

2 Select the apps that will run automatically each time you turn on the
dual screen.

+ Some apps cannot be run as dual screen apps.

« The list of apps that appear on the screen may vary depending on the
installed apps.

Making a Video Call Using the Dual Screen
You can display your image on the Dual Screen and the image of your
counterpart on the phone.

- Start a video call on your phone.

- The image of your counterpart is displayed on the phone screen
and your image is displayed at the lower right corner of the phone
screen.

- Tap [s£] at the top of the phone screen to display your image on the

Dual Screen.

- Tap (38) again to revert to the previous display mode.

E « The title at the top and the button at the bottom appear at the same
time and disappear 4 seconds later.

+ While you are making or answering a video call on the phone, you can
use other apps or functions on the Dual Screen.
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Moving between App Screens on Dual Screen

You can swipe the screen with three fingers to move an app screen
between the dual screen and the phone.
- Swipe the app screen left or right with three fingers to move freely
between the main screen and the dual screen.

I\

Swipe the app screen Move the app screen to the
with three fingers main screen

o\

Swipe the app screen Move the app screen to the
with three fingers dual screen

E - To use this feature, three fingers must touch the screen at the same
time.
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Using Dual Keyboard on Dual Screen

While using the keyboard in landscape mode, you can expand the
keyboard to use the top screen as an app screen and the bottom screen
as a keyboard screen.

7 Switch the dual screen to landscape mode on the keyboard input
screen.
2 Tap 8in the keyboard input window of the dual screen.

+ You can type on the keyboard on the bottom screen while viewing
the text entered on the top screen.

+ Tap Hin the expanded state to return the bottom keyboard to its
original position.

Dual Keyboard

E » To move the app screen up or down, touch the screen with three fingers
at the same time to move it up or down. See Moving between App
Screens on Dual Screen for details.
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Using Mirror Mode on Dual Screen

When taking photos using the camera, you can preview the photos on the
dual screen.

T On the home screen, tap ().

2 Tap [J] on the top of the camera screen.
+ Mirror Mode appears on the dual screen.

Dual Mirror mode

rl

I\ I\

E + You can also take pictures or videos directly from the dual screen.

Use the dual screen to adjust the angle for various situations as listed
below.

+ High angle shot: Use when capturing an image of a crowd at a concert
or festival or when capturing an image of a large space.

+ Low angle shot: Use when capturing an image of your child at the
child's eye level or when capturing an image of high buildings, etc.

High angle shooting Low angle shooting
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Using Instant Capture on Dual Screen
When the phone is connected to the dual screen, the Instant Capture [
function is enabled on the LG Keyboard.
You can use the keyboard on the main screen, capture the screen on the
dual screen, and insert it directly into the keyboard input window.
Tap [ on the LG Keyboard input screen.

+ The screen on the dual screen is captured and automatically attached

to the keyboard input window.

.-7 Instant Capture

-~

e ——— Captured screen

i\

E + You cannot extend the keyboard to both screens with this feature
enabled.
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LG Game Pad

You can use virtual controllers on the product screen to play games on the
phone. When playing the game, separate the main screen and the dual
screen so that the controller does not block the game screen.

71 Onthe home screen, tap Game Launcher and select LG Game Pad

LG Game Pad

+ LG Game Pad appears on the product screen.

2 Tap @] and then swipe it left and right to select your preferred style of
LG Game Pad.
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You can play the game by holding the Dual Screen as shown below.

5 + LG Game Pad is only available for games that support hardware game
pads.

+ Depending on the game, some apps or buttons may not support LG
Game Pad.
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Create Custom Game Pad

In addition to the LG Game Pad, you can customise your own game pad.
You can create your own game pad that syncs with the buttons to play
the game.

7 Run the game on the Dual Screen.

« Turn the device horizontally so that the Dual Screen is at the top
and the phone screen is at the bottom.

Ve

A

2 On the home screen, tap Game Launcher and select LG Game Pad @
,and then swipe it to the right end of the screen.
- Create Custom Game Pad appears on the screen.
- Tap+ on the Create Custom Game Pad screen.
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3 Tap — on the top right of the Custom Game Pad screen to display the
available buttons and select a button to use on the my Custom Game
Pad.

+ The selected button appears on the Custom Game Pad screen.

O

4 While watching the game screen on the Dual Screen, place the
selected button onto the desired location of your phone screen.

+ Select [g3l on the game of the Dual Screen and sync it with the newly
created button.

+ Adjust the position and size of the newly created button on your
phone screen.

I_;r] - By operating the newly created button on your phone screen, you can
get the same effect as operating the button on the dual screen.
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A

5 Tap\/ to save Custom Game Pad.

+ When saving Custom Game Pad, the game title is used as the title
of Custom Game Pad.

E + Custom Game Pad you created will be the dedicated game pad for the
game.

+ Some buttons may not work when the game is updated.

+ Custom Game Pad can be created only on the phone screen. the Dual
Screen does not support it.
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Trademarks

+ Copyright ©2020 LG Electronics Inc. All rights reserved. LG and the
LG logo are registered trademarks of LG Group and its related entities.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Photos, Google Play Protect, Google Calendar,
Google Docs, Google Drive, Google Sheets and other related marks and
logos are trademarks of Google LLC.

- All other trademarks and copyrights are the property of their
respective owners.

DECLARATION OF CONFORMITY

Hereby, LG Electronics declares that this LM-G905N product is in
compliance with the essential requirements and other relevant provisions
of Directive 2014/35/EU and 2014/30/EU.

A copy of the Declaration of Conformity can be found at
http//wwwi.lg.com/global/declaration

Contact office for compliance of
this product

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands
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More information

Precautions on product handling
+ This product cannot be used alone.

+ Do not use or charge the Dual Screen when there is moisture in the
communication and power terminal of the Dual Screen.

- This may cause fire, electric shock, injury, or device malfunction.

- If there is moisture, stop using the device immediately and remove
the moisture completely.

+ The liquid in your wet device, changes the colour of the Dual Screen
label inside your device. Damage to your device as a result of exposure
to liquid is not covered under your warranty.

Tempered glass parts

Tempered glass parts of this device are not permanent and they may wear
out over time.

+ If you drop your device on a hard surface or subject it to severe impact,
the tempered glass may be damaged.

If this happens, stop using your device immediately and contact an LG
Customer Service Centre.

- You can purchase protective cases to protect your device from damage
on the market.

Note that these protective cases are not covered under the warranty
service provided by LG Electronics and safety is not guaranteed.

Using the battery
+ This Dual Screen does not use its own battery.
- If the Dual Screen is mounted with a phone, it uses the phone's battery.
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Disposal of your old appliance

1. This crossed-out wheeled bin symbol indicates that waste electrical
and electronic products (WEEE) should be disposed of separately
from the municipal waste stream.

N 2 Old electrical products can contain hazardous substances so correct
disposal of your old appliance will help prevent potential negative
consequences for the environment and human health. Your old
appliance may contain reusable parts that could be used to repair
other products, and other valuable materials that can be recycled to
conserve limited resources.

3. You can take your appliance either to the shop where you purchased
the product, or contact your local government waste office for
details of your nearest authorised WEEE collection point. For
the most up to date information for your country please see
www.lg.com/global/recycling
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FRANCAIS
A propos de ce guide de l'utilisateur

Merci davoir choisi LG. Pour une utilisation slire et adéquate, veuillez lire
attentivement ce guide de l'utilisateur avant d'utiliser cet appareil pour la
premiere fois.
- Utilisez toujours des accessoires dorigine LG. Les éléments fournis sont
congus uniquement pour ce téléphone et peuvent ne pas étre compatibles
avec dautres appareils.

+ Les descriptions sont basées sur les parametres par défaut de appareil.

- Les applications installées par défaut sur lappareil sont sujettes a des
mises a jour et a une prise en charge qui peuvent étre supprimées sans
préavis. Si vous avez des questions a propos d'une application fournie avec
lappareil, veuillez contacter un Centre de service LG. Pour les applications
installées par utilisateur, veuillez contacter le fournisseur de ce service.

La modification du systeme dexploitation de lappareil ou l'installation de
logiciels de sources non officielles peut endommager lappareil et entrainer
la corruption ou la perte de données. Ces actions enfreignent votre
contrat de licence LG et annulent votre garantie.

+ Certains contenus et illustrations peuvent différer de votre appareil en
fonction de la région, de lopérateur de téléphonie, de la version logicielle
ou de la version du systeme dexploitation, et sont sujets a modification
sans préavis.

- Leslogiciels, les sons, les fonds décran, les images et les autres
éléments multimédias fournis avec votre appareil font lobjet d'une
licence d'utilisation limitée. Si vous recopiez et utilisez ces éléments a
des fins commerciales ou toute autre, vous pouvez enfreindre les droits
dauteur. En tant qu'utilisateur, vous étes entierement responsable en cas
d'utilisation illégale déléments multimédias.

+ Des frais supplémentaires peuvent sappliquer pour les services de
données comme la messagerie, le chargement et le téléchargement, la
synchronisation automatique ou les services de localisation. Pour éviter
[application de frais supplémentaires, choisissez un abonnement adapté a
vos besoins. Contactez votre opérateur pour plus d'informations.

+ Ce quide d'utilisation est rédigé dans les langues principales de chaque
pays. Il est possible que le contenu varie de maniere partielle en fonction
de lalangue utilisée.



Remarques instructives

AVERTISSEMENT : Situations susceptibles de causer des blessures a
[utilisateur et a des tiers.

A AVERTISSEMENT : Situations susceptibles de causer des blessures |égeres
ou dendommager lappareil

E REMARQUE : Remarques et informations complémentaires.

A propos de ce guide de ['utilisateur
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Recommandations pour une utilisation
siire et efficace

Veuillez lire ces recommandations. Leur non-respect peut savérer dangereux, voire
illégal

En cas de panne, un outil logiciel intégré a votre appareil crée un historique des pannes.
Cet outil recueille uniquement les données spécifiques a la panne, comme lintensité du
signal, la position de D de cellule lors d'une perte d'appel soudaine, et les applications
chargées. Lhistorique nest utilisé que pour déterminer la raison de la panne. Ces
historiques sont chiffrés et ne peuvent étre consultés que par un centre de réparation
agréé LG, dans le cas oli vous devriez retourner lappareil pour réparation.

Informations importantes sur l'appareil

+ Les applications et services proposés par appareil sont susceptibles détre modifiés
ou annulés sans préavis, selon la situation du fournisseur et la version du logiciel que
vous utilisez.

+ Lorsque lappareil est activé pour la premiére fois, la configuration initiale a lieu. Le
premier démarrage peut étre plus long que dordinaire.

A lire attentivement avant utilisation

+ Pour acheter des accessoires en option, contactez le centre d'informations clientele
LG pour obtenir la liste des revendeurs.

+ Lapparence et les caractéristiques techniques de lappareil sont sujettes a
modification sans préavis.

+ Utilisez uniqguement les produits dans le cadre de ['utilisation pour laquelle ils sont
prévus. Lutilisation d'applications ou de logiciels non certifiés peut endommager
lappareil et n'est pas prise en charge par la garantie.



Exposition aux radiofréquences

CET APPAREIL EST CONFORME A LA REGLEMENTATION INTERNATIONALE EN MATIERE
D'EXPOSITION AUX ONDES RADIO.

Vlotre téléphone portable est un émetteur récepteur radio. Il a été congu et fabriqué de
maniére a respecter les limites recommandées par les directives internationales (ICNIRP) en
matiére dexposition aux fréquences radioélectriques. Ces limites font partie d'un ensemble
de directives et déterminent les niveaux autorisés dénergie radioélectrique pour la population.
Ces directives ont été établies par des organismes scientifiques indépendants a partir
dévaluations complétes et régulieres issues détudes scientifiques.

Les recommandations relatives a lexposition aux ondes radio utilisent une unité de

mesure appelée DAS (débit dabsorption spécifique). La limite DAS fixée dans les directives
internationales est de 2,0 W/kg*. Lors des tests visant a déterminer le DAS, le téléphone

est utilisé dans des positions de fonctionnement standard et fonctionne a son niveau de
puissance certifié le plus élevé dans toutes les bandes de fréquences testées. Bien que le
taux d'absorption spécifique soit déterminé sur le niveau de puissance certifié le plus élevé,

le taux d'absorption spécifique réel du téléphone en fonctionnement peut étre largement
inférieur a la valeur maximale. Cela est di au fait que le téléphone est congu pour fonctionner
a différents niveaux de puissance de maniere a n'utiliser que la puissance dont il a besoin pour
accéder au réseau. En principe, plus vous étes proche d'une antenne relais, plus la puissance
de sortie est faible. Avant détre commercialisé, tout modeéle de téléphone doit étre soumis a
des tests visant a garantir sa conformité a la directive européenne RED 2014/53/EU.

Cette directive impose le respect de regles strictes afin de garantir la sécurité des utilisateurs
et de lensemble de la population, et prévenir tout risque sanitaire.

La valeur DAS (sur 10g) la plus élevée enregistrée pour ce modele lors des tests effectués
afin de vérifier sa conformité aux normes définies pour une utilisation au niveau de loreille est
de 0,551 Wrkg.

Cet appareil est conforme aux directives en matiere dexposition aux fréquences
radioélectriques lorsqu'il est utilisé soit dans sa position normale, cest-a-dire au niveau de
loreille, soit a une distance minimale de 5 mm du reste du corps.

Lorsqu'un étui, un clip ceinture ou un support est utilisé a des fins de transport, il ne doit
pas contenir de parties métalliques et doit garantir une distance minimale de 5 mm entre
le produit et le corps. Pour pouvoir transmettre des fichiers de données ou des messages,
cet appareil requiert une connexion de qualité au réseau. Dans certains cas, la transmission
de fichiers de données ou de messages peut étre retardée jusqua ce qu'une telle connexion
soit possible. Veillez a bien suivre les instructions relatives a la distance de séparation pour
[établissement de la transmission.

La valeur DAS (sur 10g) la plus élevée enregistrée pour ce modele lors des tests effectués
afin de vérifier sa conformité aux normes définies pour une utilisation au niveau du corps est
de 1,531 Wrkg.
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* La limite DAS applicable aux équipements mobiles utilisés par le public est de

2,0 watts/kilogramme (W/kg) en moyenne sur dix grammes de tissu cellulaire.

Ces directives comprennent des marges de sécurité destinées a assurer une protection
supplémentaire pour les consommateurs et a prendre en compte toute variation de
mesure.

Les valeurs DAS peuvent varier selon les normes de présentation des informations en
vigueur dans les différents pays et selon la bande de réseau utilisée.

Pour connaitre les valeurs DAS autorisées dans les autres pays, veuillez consulter la
rubrique des informations relatives aux produits sur le site www.g.com/fr.

Pour activer ou désactiver les acces sans fil aux réseaux tels que le Wi-Fl, le
Bluetooth® ou la connexion aux données mobiles, appuyez sur les boutons on/off
respectifs dans le menu paramétres de votre appareil.

Par ailleurs, vous pouvez empécher toute connexion sans fil en activant le mode avion.

Mesures touchant a la sécurité

+ Dans certains lieux ou situations tels que les avions, les hopitaux, les stations
services, et les garages professionnels, [usage du téléphone est interdit. Il est donc
impératif de respecter strictement les consignes de sécurité propres a chacune de
ces situations et déteindre votre téléphone lorsque cela est requis.

Par ailleurs, pour éviter les risques d'interférences, les personnes porteuses
d'implants électroniques (stimulateurs cardiaques, pompes a insuline,
neurostimulateurs..) doivent conserver une distance de 15 cm entre le mobile et
limplant et ne ['utiliser que du c6té opposé au coté ol celui-ci est situé.

+ Téléphoner en conduisant, méme avec des équipements qui ne sont pas interdits par
la réglementation, est dangereux. Cela augmente le risque d'accident provenant de
la distraction créée par la conversation elle méme. Aussi est-il interdit de téléphoner
en conduisant et [utilisation d'un kit mains-libres ne doit pas étre considéré comme
une solution.
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Informations sur l'exposition a énergie
électromagnétique des radiofréquences (RF) provenant
de la Federal Communication Commission (FCC)

En aolt 1996, la Federal Communication Commissions (FCC) des Etats-Unis,
dans le Report and Order FCC 96-326, a adopté une nouvelle norme de
sécurité relative a lexposition des personnes a [énergie électromagnétique
des radiofréquences (RF) émise par les émetteurs réglementés par la FCC.
Ces directives sont conformes aux normes de sécurité déja définies par les
organes normatifs américains et internationaux. La conception de cet appareil
est conforme aux directives de la FCC et a ces normes internationales.

Déclaration section 15.19

Cet appareil est conforme aux normes FCC Part 15. Son utilisation est soumise aux
deux conditions suivantes :

(1) cet appareil ne doit émettre aucune interférence nuisible et

(2) cet appareil doit accepter toute interférence recue, y compris les interférences
susceptibles dentrainer un dysfonctionnement.

Déclaration section 15.21

Tout changement ou toute modification non approuvé expressément par le fabricant
peut annuler le droit d'utilisation de lappareil.

Fonctionnement prés du corps

Cet appareil a été testé pour une utilisation avec le dos du téléphone maintenu a Tcm
du corps. Pour se conformer aux exigences de la FCC en matiere dexposition aux

RF, le dos du téléphone doit étre maintenu a au moins 1cm de distance du corps de
lutilisateur.

Les pinces pour ceinture, étuis et accessoires similaires fournis par des tiers et utilisés
avec cet appareil ne doivent contenir aucune piece métallique. Les accessoires portés
au niveau du corps sans respect de la distance de sécurité de 1 cm entre le corps

de lutilisateur et larriere de l'appareil et qui nont pas été testés pour une utilisation
typique en cas de transport sur soi peuvent ne pas étre conformes aux limites
dexposition aux RF et ne doivent pas étre utilisés.
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Déclaration section 15.105

Ce périphérique a été testé et correspond a la classe B telle que définie pour les
appareils numériques, conformément a la section 15 des réglementations FCC. Cette
classification a été mise au point pour offrir une protection raisonnable contre les
interférences nocives dans le secteur résidentiel. Cet appareil génere, utilise et émet des
radiofréquences et, s'il nest pas installé et utilisé conformément aux instructions, peut
causer des interférences nuisibles aux radiocommunications. Cependant, il est possible
que des interférences se produisent dans une installation particuliére. Si cet appareil
provoque des interférences nuisibles a la réception télévisuelle (ce qui peut étre vérifié
en allumant et en éteignant les équipements), il est fortement conseillé a ['utilisateur
dessayer de corriger ces interférences en prenant une ou plusieurs des mesures
suivantes :

Réorienter ou déplacer lantenne de réception.
+ Augmenter la distance séparant le dispositif du récepteur.

+ Raccorder lappareil a une prise placée sur un circuit différent de celui sur lequel est
branché le récepteur.

- Contacter un revendeur ou un technicien spécialisé en radio/TV pour obtenir de
laide.
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Entretien et réparation

Utilisez uniquement les accessoires fournis dans lemballage, car ils sont autorisés par
LG. LG noffre aucune garantie en cas de dommage ou de défaillance causée par des
accessoires fournis par un tiers.

Certains contenus et illustrations peuvent différer de votre appareil sans quaucun avis
préalable ne soit nécessaire.

Ne démontez pas le téléphone. Si une réparation savere nécessaire, confiez-le a un
technicien qualifié.

Les réparations couvertes par cette garantie peuvent inclure, a la discrétion de LG, des
piéces ou circuits de remplacement neufs ou reconditionnés, sous réserve que leurs
fonctionnalités soient équivalentes a celles des pieces remplacées.

Tenez votre téléphone éloigné des appareils électriques, tels que téléviseurs, postes
radio et ordinateurs personnels.

Ne placez pas votre téléphone a proximité de sources de chaleur, telles qu'un radiateur
Ou une cuisiniere.

Ne le faites pas tomber.

Ne soumettez pas votre téléphone a des vibrations mécaniques ou a des chocs.

Eteignez votre appareil dans les zones oli des réglements spéciaux lexigent. Par
exemple, n'utilisez pas votre appareil dans les hdpitaux, car celui-ci pourrait perturber le
bon fonctionnement des équipements médicaux sensibles.

Sivos mains sont humides, ne manipulez pas lappareil lorsqu'il est en cours de charge.
Ceci peut provoquer une décharge électrique et endommager gravement votre appareil

Ne mettez pas un téléphone en charge a proximité de matieres inflammables car il
pourrait chauffer et déclencher un incendie.

Pour nettoyer lextérieur de lappareil, utilisez un chiffon sec. N'utilisez pas de solvant, tel
que du benzene, un diluant ou de lalcool.

Ne rechargez pas appareil lorsqu'il est posé sur du tissu.

Rechargez l'appareil dans une zone bien ventilée.

Nexposez pas le téléphone a de la fumée ou de la poussiere en quantité excessive.

Ne placez pas votre appareil a proximité de cartes de crédit ou de titres de transport, car
il pourrait altérer les données des bandes magnétiques.

Ne touchez pas [écran avec un objet pointu qui risquerait dendommager lappareil.

Ne mettez pas lappareil en contact avec des liquides ou des éléments humides.

Utilisez les accessoires tels que les oreillettes avec précaution. Ne manipulez pas
lantenne inutilement.
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Evitez d'utiliser, de toucher ou de tenter de retirer ou de réparer du verre cassé,
ébréché ou fissuré. Un endommagement de [écran en verre causé par une utilisation
abusive ou incorrecte nest pas couvert par la garantie.

Votre appareil est un appareil électronique qui génere de la chaleur en
fonctionnement normal. Lors d'une utilisation prolongée dans un environnement
mal ventilé, le contact direct avec la peau peut provoquer une géne ou des
brllures bénignes. Manipulez des lors votre appareil avec précaution lors de son
fonctionnement ou immédiatement apres utilisation.

Sivotre appareil est mouillé, débranchez-le immédiatement et laissez-le sécher
totalement. Ne tentez pas d'accélérer le séchage avec une source de chaleur externe
(four classique ou micro-ondes, seche-cheveux..).

Le liquide contenu dans votre appareil lorsqu'il est mouillé modifie la couleur de
[étiquette produit se trouvant a lintérieur de lappareil. Un endommagement de
lappareil consécutif a une exposition a des liquides n'est pas couvert par la garantie.

Un appareil mobile a besoin d'une bonne circulation dair pour détruire la chaleur. En
raison d'une circulation insuffisante du contact direct avec la peau et du flux dair sur
lappareil, lappareil peut étre trop chauffé. Lappareil doit mesurer au moins 1,0 cm
entre le corps de ['utilisateur.

Empéchez la poussiere de toute substance étrangeére de pénétrer dans le port
chargeur / cable USB. Cela peut causer de la chaleur ou un incendie.
Evitez dexposer 'appareil 2 de faibles pressions atmosphériques a haute altitude.

N'exposez pas lappareil a des pressions atmosphériques extrémement faibles. Cela
pourrait entrainer lexplosion de la batterie ou provoquer la fuite de liquide ou gaz
inflammable.

Fonctionnement optimal de l'appareil

Appareils électroniques

Tous les appareils portables peuvent étre soumis a des interférences pouvant affecter
leurs performances.

N'utilisez pas votre appareil a proximité déquipements médicaux sans autorisation.
Demandez l'avis de votre médecin afin de déterminer si le fonctionnement de
votre appareil est susceptible d'interférer avec le fonctionnement de votre appareil
médical.

Les appareils peuvent nuire au bon fonctionnement de certaines prothéses
auditives.

Pour les porteurs d'implants électroniques, des précautions sont a prendre : utilisez
le téléphone sur le coté opposé a limplant.
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+ Des interférences mineures peuvent perturber le bon fonctionnement des
téléviseurs, radios, ordinateurs, etc.

- Utilisez si possible votre appareil dans une plage de températures comprise entre
0 °Cet 35 °C. Exposer votre appareil a des températures extrémement basses
ou hautes peut lendommager ou provoquer des dysfonctionnements, voire le faire
exploser.

Stimulateurs cardiaques

Les fabricants de stimulateurs cardiagues recommandent de maintenir une distance
minimale de 15 cm entre un téléphone portable et un stimulateur cardiaque afin
déviter toute interférence avec ce dernier. Pour ce faire, utilisez le téléphone sur loreille
opposée a votre stimulateur cardiaque et ne le transportez pas dans une poche de
chemise.

Hopitaux

Eteignez votre appareil sans fil lorsque cela vous est demandé dans les hopitaus,
cliniques et établissements de santé ; ce type dappareil peut en effet provoquer des
interférences avec des équipements médicaux sensibles.

Sécurité au volant

Vérifiez les lois et réglements en vigueur en matiere d'utilisation des appareils dans la
zone ol vous conduisez.

N'utilisez pas d'appareil portatif en conduisant.

Concentrer toute votre attention sur la conduite.

Utilisez un kit mains libres, si disponible.

Si les conditions de conduite le permettent, quittez la route et garez-vous avant
démettre ou de recevoir un appel.

Les radiofréquences peuvent affecter certains systemes électroniques de votre
véhicule motorisé, tels que le systéme audio stéréo ou les équipements de sécurité.
Lorsque votre véhicule est équipé d'un airbag, ne génez pas son déclenchement
avec un équipement sans fil portable ou fixe. Il risquerait de lempécher de souvrir ou
provoquer de graves blessures en raison de performances inadéquates.

Lorsque vous écoutez de la musique en extérieur, veuillez vous assurer que le
volume niest pas trop élevé de facon a bien entendre ce qu'il se passe autour de
vous. Ceci est particulierement important a proximité des routes.
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Evitez toute nuisance auditive

Afin déviter des dommages auditifs éventuels, ne pas écouter a un
niveau sonore élevé pendant une longue durée.

Ce produit est conforme aux exigences posées par la norme EN 60950-1/A12 (tel que

décrit dans les normes EN 50332-1/-2)

Afin de protéger vos capacités auditives, n'exposez pas votre ouie a de hauts volumes

sonores pendant de longues périodes. Nous vous recommandons de ne pas allumer ou

éteindre votre téléphone pres de votre oreille. Pendant les communications ou lorsque

vous écoutez de la musique, réglez le volume a un niveau raisonnable.

+ Lorsque vous utilisez le kit main libre, baissez le volume si vous ne pouvez pas

entendre les gens parler autour de vous ou si la personne a c6té de vous peut
entendre ce que vous écoutez.

E « Un volume sonore trop élevé provenant des vos écouteurs (oreillettes,
casques) pourrait entrainer déventuels dommages auditifs.

Parties en verre

Certaines parties de votre téléphone portable sont en verre. Ce verre pourrait se briser
en cas de chute sur une surface dure ou d'impact considérable. Dans ce cas, évitez de
toucher ou de retirer le verre brisé. N'utilisez plus votre téléphone portable jusqua ce
que ce verre soit remplacé par un fournisseur de service agréé.

Zone de déminage

N'utilisez pas lappareil lorsque des opérations de dynamitage sont en cours. Respectez
les restrictions, les reglements et les lois en vigueur.

Zones a atmospheére explosive
+ Nutilisez pas votre appareil dans une station-service.
- Nutilisez pas votre téléphone a proximité de carburant ou de produits chimiques.

Ne transportez pas ou ne stockez pas des produits dangereux, des liquides ou des
gaz inflammables dans le méme compartiment de votre voiture que votre appareil
OU Ses accessoires.
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En avion
Les appareils sans fil peuvent générer des interférences dans les avions.
Eteignez votre appareil avant dembarquer dans un avion.

+ Ne lutilisez pas au sol sans autorisation de [équipage.

Enfants

Conservez lappareil dans un endroit sdr; hors de portée des enfants. En effet, un enfant
risquerait de sétouffer avec les petites pieces.

Appels d'urgence

Il est possible que les numéros d'urgence ne soient pas disponibles sur tous les réseaux
de téléphonie mobile. Vous ne devez donc pas dépendre uniquement de votre appareil
pour passer un appel d'urgence. Renseignez-vous aupres de votre opérateur.

Informations sur la batterie et précautions d'usage

Il n'est pas nécessaire de décharger completement la batterie avant de la
recharger. Contrairement aux autres batteries, elle n'a pas deffet mémoire pouvant
compromettre ses performances.

Utilisez uniquement les batteries et chargeurs LG. Les chargeurs LG sont congus
pour optimiser la durée de vie de votre batterie.

Ne démontez pas et ne courtcircuitez pas la batterie.

Les contacts métalliques de la batterie doivent toujours rester propres.

Procédez au remplacement de la batterie lorsque celle-ci noffre plus des
performances acceptables. La batterie peut étre rechargée des centaines de fois
avant qu'un remplacement ne soit nécessaire.

Rechargez la batterie en cas de non-utilisation prolongée afin doptimiser sa durée
d'utilisation.

N'exposez pas le chargeur de la batterie au rayonnement direct du soleil.

N'exposez pas lappareil a des températures élevées ou basses, cela pourrait affecter
les performances de la batterie.

La batterie risque dexploser si vous la remplacez par un modele inadéquat. Mettez
la batterie au rebut conformément aux instructions.

Débranchez systématiquement le chargeur de la prise murale lorsque lappareil est
completement chargé pour éviter toute consommation dénergie inutile.

La durée de vie réelle de la batterie dépend de la configuration du réseau, des
parametres du produit, de ['utilisation, de a batterie et des conditions extérieures.
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+ Tenez la batterie hors de portée des animaux et de leurs crocs ou griffes, ainsi que
des objets pointus en général. Le non-respect de cette consigne peut entrainer un
incendie.

+ Consommation électrique (en mode veille en réseau) : 0,5 W

Conditions d'utilisation pour réduire le niveau

d’exposition du consommateur aux rayonnements

+ Téléphonez dans de bonnes conditions de réception pour diminuer la quantité de
rayonnements. Pour ce faire, évitez de téléphoner dans les parking souterrains, lors
de déplacements en train ou en voiture.

« Téléphonez quand le téléphone capte au mieux (affichage d'un maximum de
barettes de réception de réseau).

+ Utilisez un kit main libre tout en veillant & éloigner le téléphone du ventre pour les
femmes enceintes et des parties génitales pour les adolescents.

Précautions d'usage préconisées par le constructeur

+ Evitez de téléphoner dans les parking souterrains, les ascenseurs, lors de
déplacements en train, en voiture ou dans un secteur mal couvert par le réseau.

« Les personnes porteuses d'implants électroniques (stimulateurs cardiaques..)
doivent conserver une distance de 15 centimetres entre le mobile et limplant et ne
[utiliser que du c6té opposé au coté ol celui-ci est Situé.

« Utilisez un kit piéton (oreillettes) le plus souvent possible, notamment en cas
d'usage fréquent ou prolongé du téléphone mobile.

- Eloignez votre téléphone mobile du ventre chez les femmes enceintes ou du bas du
ventre chez les enfants et adolescents.

Sécurisation des informations personnelles

+ Assurez-vous de protéger vos informations personnelles afin déviter les fuites de
données ou une utilisation abusive des informations confidentielles.

+ Effectuez toujours une copie de sauvegarde des données importantes lorsque vous
utilisez lappareil. LG nlest pas responsable de la perte de données.

+ Assurez-vous de sauvegarder toutes les données et de réinitialiser [appareil lors
de [élimination de lappareil afin déviter toute utilisation abusive des informations
confidentielles.

« Lisez attentivement [écran dautorisation lors du téléchargement des applications.
+ Soyez prudent lorsque vous utilisez des applications qui ont acces a plusieurs
fonctions ou a vos informations personnelles.
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« Vérifiez régulierement vos comptes personnels. Sivous détectez le moindre signe
d'une utilisation abusive de vos informations personnelles, demandez a votre
fournisseur de services de supprimer ou de modifier les informations de votre
compte.

Si votre appareil est perdu ou volé, changez le mot de passe de votre compte afin de
sécuriser vos informations personnelles.

- Nutilisez pas d'applications provenant de sources inconnues.

A Instructions relatives au remplacement de la batterie

« Les batteries Li-lon sont des composants dangereux qui peuvent provoquer
des blessures.

« Le remplacement de la batterie par un professionnel non qualifié peut
endommager votre appareil

+ Ne remplacez pas vous-méme la batterie. La batterie pourrait étre
endommagée et risquerait de provoquer une surchauffe et des blessures.
La batterie doit étre remplacée par un professionnel qualifié. La batterie doit
étre recyclée et ne pas étre jetée avec les déchets ménagers.

« Dans le cas ol ce produit contiendrait une batterie intégrée impossible a
retirer facilement par les utilisateurs finaux, LG recommande de confier
exclusivement a des professionnels qualifiés le soin de retirer la batterie, que
ce soit pour la remplacer ou pour la recycler lorsque le produit est arrivé en
fin de vie. Pour éviter dendommager le produit et pour leur propre sécurité,
les utilisateurs ne doivent pas tenter de retirer la batterie et ils doivent
demander conseil a laide en ligne de LG Service ou a dautres prestataires
de services indépendants.

Le retrait de |a batterie implique de démonter le boitier du produit, de
débrancher les cables/contacts électriques et dextraire avec précaution

la cellule de la batterie en saidant doutils spécialisés. En allant sur
http7//wwwi.lge.com/global/sustainability/environment/take-back-recycling,
vous trouverez des instructions destinées aux professionnels qualifiés sur
les procédures a employer pour retirer la batterie en toute sécurité.
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Caractéristiques de la Photo

Intervalle Control

Vous pouvez enregistrer des vidéos en Intervalle optimisées a la situation.
Les vidéos peuvent étre enregistrées a la vitesse optimale et avec un
mouvement régulier grace a lanalyse d'une grande variété denvironnements
de prise. La vitesse d'accéléré peut étre réglée automatiquement en fonction
de la cible et de lenvironnement de prise. Il est aussi possible de sélectionner
manuellement la vitesse daccéléré.

1 Appuyez sur (&) et sélectionnez Intervalle en passant entre les modes de

la caméra.
Ajuster la caméra — «—— Régler la lumiére du flash
Sélectionner a rapport de ] ] Régler la stabilité de la
‘écran caméra
e——— Sélectionner le zoom
e——— Sélectionner une vitesse
Intervalle
) . B

Sélectionner l'accéléré pour
les modes caméra

2 Appuyez sur e pour enregistrer une vidéo.
+ Vous pouvez changer le zoom et la vitesse daccéléré pendant
l'enregistrement de laccéléré.

- Pour mettre en pause lenregistrement, appuyez sur @. Pour
poursuivre lenregistrement, appuyez sur (e .

+ Pendant l'enregistrement d'une vidéo, vous pouvez étendre ou pincer
deux doigts pour effectuer un zoom avant ou arriere.
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+ Pendant 'enregistrement d'une vidéo, vous pouvez appuyer sur la zone
souhaitée pour régler la luminosité.
3 Appuyez sur = pour arréter lenregistrement.
- Lavidéo enregistrée est stockée dans la Galerie.

E « laudio nlest pas enregistré pendant lenregistrement en Intervalle.

Effet 3D AR

La caméra de profondeur a larriére du produit vous permet davoir un

Effet 3D AR réaliste qui reconnait les contours des visages plus en
profondeur. Votre visage étant reconnu avec précision, vous pouvez prendre
un autocollant sans que vos mains apparaissent, méme si elles couvrent en
partie votre visage.

1 Appuyez sur (&) et sélectionnez Autocollant en passant entre les modes
de la caméra.
2 Sélectionnez @

3 Faites glisser la liste des autocollants vers la gauche ou la droite pour
sélectionner lautocollant RA de votre choix.

« Le visage détecté par la caméra est numérisé en 3D.
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/. Appuyez sur () pour prendre une photo, ou sur () de maniére prolongée
pour enregistrer une vidéo.

+ Laphoto ou la vidéo est prise en appliquant [Effet 3D AR.

E « Lafonction de numérisation en 3D de la caméra de profondeur est
uniquement disponible pour les prises de portrait en gros plan.

Effet Photo 3D

LEffet Photo 3D vous permet de prendre des photo 3D donnant plus de
profondeur aux portraits grace a la caméra de profondeur située a larriere du
produit. Les photos prises avec |Effet Photo 3D peuvent étre vues comme
des images en mouvement dans lapplication Galerie.

1 Appuyez sur (&) et sélectionnez Portrait en passant entre les modes de
la caméra.

2 Sélectionnez Effet Photo 3D en passant entre les modes deffet pour
Portrait.

— Sélectionner Effet Photo
3D pour les modes deffet

L Sélectionner Portrait pour
les modes caméra
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3 Appuyez sur () pour prendre une phato.
+ La photo est stockée dans la Galerie.
. saffiche sur limage prise avec [Effet Photo 3D.

4 Sélectionnez une photo 3D depuis la Galerie ou Apercu, puis appuyez sur
‘) pour appliquer un effet de photo.

« Sélectionnez Enregistrer une copie ou sur OK apres avoir appliqué
leffet.

5 « Cette fonction nest uniquement disponible que pour la prise de photo
depuis la caméra arriere.
« Quand vous voyez le message « Effet Photo 3D disponible » appuyez sur

pour prendre une photographie. Sinon, 'Effet Photo 3D ne sappliquera
pas a la photo enregistrée.
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Fonctions d’enregistrement audio

Enregistrement vidéo avec options spécifiques
d'enregistrement audio

Vous pouvez enregistrer une vidéo en utilisant trois options différentes
denregistrement vocal pour sadapter a vos besoins.

T Appuyez sur (&) et sélectionnez Vidéo en passant entre les modes de
caméra.

2 Appuyez sur @ et sélectionnez Basique, Enregistrement vidéo en
qualité ASMR, ou Bokeh de la voix en passant entre les options daudio.

+—— Options audio

Basique
Vous pouvez enregistrer une vidéo avec un son stéréo stable.

Enregistrement vidéo en qualité ASMR

Avec quatre microphones sensibles dans lappareil, vous pouvez enregistrer
une vidéo ASMR.
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Bokeh de la voix
Vous pouvez mettre en avant la voix d'un sujet en réduisant le bruit ambiant.
+ Pour réduire le bruit ambiant, faites glisser la barre de défilement vers 02).

e

Enregistrement de sons ASMR

Cette fonction vous permet denregistrer de maniere claire et précise le son

en lamplifiant depuis les microphones.

1 Appuyez sur Essentiels > HD Audio Recorder et appuyez sur = >
ASMR.

2 Appuyez sur @ pour enregistrer [audio.

« Pour mettre en pause lenregistrement, appuyez sur @. Pour
poursuivre lenregistrement, appuyez sur @.

3 Appuyez sur @ pour arréter lenregistrement audio.

Moteur de Son 3D LG

La fonction Moteur de Son 3D LG vous permet découter un son
stéréoscopique et optimisé. Quand vous reproduisez de la musique ou une
vidéo, profitez d'un son stéréoscopique et immersif comme si vous étiez sur
le terrain.

1 Faites glisser le panneau de notifications vers le bas.

2 Appuyez sur (%) pour activer ou désactiver la fonction Moteur de Son 3D
LG.
Ou appuyez sur Parameétres > Son >Qualité du son et effets > Moteur
de Son 3D LG et appuyez sur () pour lactiver.

E - Sivous connectez un périphérique audio externe comme des écouteurs ou
un haut-parleur; une fenétre contextuelle souvre pour activer la fonction
Moteur de Son 3D LG.
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Google Assistant

Présentation de ['Assistant Google

Votre appareil integre la fonctionnalité Google Assistant. Trouvez des
réponses et faites avancer les choses pendant vos déplacements.

E « Pour utiliser cette fonction, connectez-vous dabord au réseau.

Lancement de ['Assistant Google

1

N

Appuyez sur la touche Google Assistant sur le coté gauche de lappareil
ou

Balayez en diagonal depuis un coin inférieur de [écran.

Appuyez sur PREMIERS PAS.

Suivez les instructions a [écran.

- Lappareil enregistre vos données vocales pour la reconnaissance.
Sélectionnez si vous souhaitez utiliser la fonction de déverrouillage par
correspondance vocale.

« Sivous utilisez la fonction de déverrouillage par correspondance vocale,
vous pouvez déverrouiller lappareil méme si [écran de lappareil est
éteint ou s'il charge en disant « OK Google » ou « Hey Google ».

E « Cette fonction peut étre plus vulnérable a la sécurité que les autres

Fonctionnalités personnalisées

verrouillages décran tels qu'un Schéma, un Code PIN ou un Mot de passe.
Lorsqu'une voix similaire a la votre ou un enregistrement de votre voix sont
utilisés, [écran peut étre déverrouillé.

« Pour utiliser cette fonctionnalité, sur [écran d'accueil, appuyez sur Paramétres
> Ecran de verrouillage et sécurité > Parameétre de verrouillage sécurisé >
Smart Lock, puis utilisez la méthode de verrouillage décran que vous avez réglé
pour déverrouiller [appareil. Appuyez sur Voice Match, puis saisissez de nouveau
la méthode de déverrouillage actuellement utilisée. Notez que Swipe est excepté.

« Vous devez déverrouiller appareil en utilisant la méthode spécifiée si vous ne
pouvez pas déverrouiller ['appareil avec la reconnaissance vocale. Voir Réglage
d'un écran de verrouillage pour plus de détails.
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5 Appuyez sur Terminer.

Acces par voix

7 Quand [écran d'accueil est éteint ou verrouillé, dites « OK Google » ou
« Hey Google ».

7 Quand [écran de Google Assistant saffiche, dites une commande ou
posez une question.

Acces depuis l'écran d'accueil

1 Appuyez sur la touche Google Assistant sur le c6té gauche de lappareil.
ou
Balayez en diagonal depuis un coin inférieur de [écran.

7 Prononcez une commande ou posez une question quand <« -« apparalt en
bas de l'‘écran.

E - Dans un environnement a faible couverture Wi-Fi ou de données mobiles,
la fonction de [Assistant Google peut étre restreinte et la précision de
reconnaissance vocale peut diminuer.

« Siles paroles sont ambigties, le micro couvert, le reproducteur de média est
en marche, ou lenvironnement est bruyant, la précision de la reconnaissance
vocale peut diminuer. Quand vous utilisez le produit via les commandes
vocales, prononcez de maniere précise dans un environnement calme pour
obtenir une meilleure précision de la reconnaissance vocale.
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Empreintes Digitales

Présentation de la Empreintes Digitales
Commencez par enregistrer votre empreinte digitale sur votre appareil avant
d'utiliser la fonction de reconnaissance d'empreinte digitale.
Vous pouvez utiliser cette fonction de reconnaissance d'empreinte digitale
dans les cas suivants:

+ Pour déverrouiller '‘écran.

+ Pour afficher le contenu verrouillé dans la Galerie.

+ Pour confirmer un achat en vous identifiant via une application ou en

utilisant votre empreinte digitale.

E « Vous pouvez utiliser lempreinte digitale pour authentifier 'utilisateur. Il est
possible que le capteur dempreintes digitales reconnaisse une empreinte
différente mais tres similaire a celle enregistrée. Afin de renforcer la
sécurité, il est recommandé d'utiliser un Schéma, un Code PIN ou un Mot de
passe comme méthode de déverrouillage de l'écran.

« Silappareil ne peut pas détecter votre empreinte digitale ou si vous avez
oublié la valeur spécifiée pour lenregistrement, rendez-vous au centre de
service client LG le plus proche avec votre appareil et la carte d'identification.
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Précautions relatives a la Empreintes Digitales

La précision de la Empreintes Digitales peut baisser au fil du temps pour un
certain nombre de raisons. Vérifiez donc les points suivants avant d'utiliser
lappareil pour la maximiser.

+ En bas au centre de [écran du produit, il y a un capteur intégré qui
reconnait les empreintes digitales. Veillez a ne pas rayer ou endommager
le capteur dempreintes digitales avec des objets métalliques comme des
pieces de monnaie ou des clés.

En cas de présence de substances étrangéres (sueur, lotion, eau, saleté,
graisse, etc.) sur le capteur dempreintes digitales ou sur le doigt devant
toucher le capteur, la reconnaissance des empreintes peut ne pas
fonctionner correctement. Essuyez le capteur et le doigt, nettoyez et
retirez toute 'humidité avant de presser de nouveau le doigt sur le capteur.
+ Sila surface du doigt est réche a cause de cicatrices ou ridée par leau, le

capteur peut ne pas étre capable de reconnaitre lempreinte. Dans ce cas,
enregistrez une autre empreinte digitale.

Sivous pliez votre doigt ou n'en utilisez que le bout, votre empreinte
digitale peut ne pas étre reconnue. Assurez-vous que votre doigt couvre
toute la surface du capteur d'empreintes.

+ Scannez un seul doigt pour chaque enregistrement. Scanner plusieurs
doigts peut affecter lenregistrement et la Empreintes Digitales.

- Lappareil peut générer de [électricité statique lorsque lair est sec. Si l'air
ambiant est sec, évitez d'analyser les empreintes digitales ou de toucher
un objet métallique tel qu'une piece de monnaie ou une clé avant de
procéder a ['analyse des empreintes digitales et afin d'éliminer ['électricité
statique.
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Enregistrement des empreintes digitales
Vous pouvez enregistrer votre empreinte digitale sur appareil pour utiliser
lidentification digitale.

1 Sur lécran d'accueil, appuyez sur Paramétres > Ecran de verrouillage et
sécurité > Empreintes digitales.

5 « Vous devez avoir réglé un écran de verrouillage pour pouvoir utiliser cette
fonction.

+ Sile verrouillage de ['écran n'est pas actif, configurez 'écran de verrouillage
en suivant les instructions fournies sur ['écran. Consultez la section Réglage
d'un écran de verrouillage pour plus d'informations.

2 Vérifiez lemplacement du capteur dempreintes digitales en bas au centre
de [écran et placez légerement le doigt sur le capteur.

E « Vérifiez que le doigt couvre entierement le capteur dempreintes digitales.

3 Suivez les instructions a [écran.

+ Jusqu'a achever ['enregistrement de lempreinte, déplacez peu a peu ce
méme doigt sur le capteur.

- Posez le doigt sur le capteur. Quans vous sentez une vibration, retirez le
doigt du capteur.

4 Une fois l'empreinte digitale enregistrée, appuyez sur OK.
+ Appuyez sur En ajouter d’autres pour enregistrer une autre empreinte
digitale. Le succes de la reconnaissance des empreintes dépend de la

condition de lempreinte enregistrée, il est donc recommandé que vous
enregistriez différentes empreintes digitales.
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Gestion des empreintes digitales

Vous pouvez modifier ou supprimer des empreintes digitales enregistrées.

1 Sur lécran d'accueil, appuyez sur Paramétres > Ecran de verrouillage et
sécurité > Empreintes digitales.

2 Déverrouillez lappareil selon le mode de déverrouillage spécifié.

3 Surla liste des empreintes digitales, appuyez sur une empreinte digitale
pour la renommer. Pour la supprimer, appuyez sur {ii).

Affichage de l'icone d'empreinte quand 'écran est

éteint

Vous pouvez définir comment afficher lemplacement du capteur

dempreintes sur [écran quand [écran est éteint.

1 Surlécran d'accueil, appuyez sur Paramétres > Ecran de verrouillage et
sécurité > Empreintes digitales.

2 Déverrouillez [écran selon la méthode spécifiée.

3 \Vérifiez si @  est activé pour loption Taper pour afficher l'icéne
lorsque l'écran est éteint. Si vous ne souhaitez pas utiliser cette
fonction, désactivez-la en glissant @ .

Ajuster leffet a 'appui sur l'icone des empreintes digitales

Vous pouvez changer leffet qui apparait a [écran quand vous appuyez sur

licdne des empreintes digitales.

1 Appuyez sur Paramétres > Ecran de verrouillage et sécurité >
Empreintes digitales.

2 Déverrouillez l'appareil selon le mode de déverrouillage spécifié.

3 Appuyez sur Effet d'icone et sélectionnez leffet souhaité.
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Déverrouillage de 'écran avec une empreinte digitale
Vous pouvez déverrouiller ['écran ou afficher le contenu verrouillé en utilisant
votre empreinte digitale. Activez la fonction souhaitée :
1 Sur lécran d'accueil, appuyez sur Paramétres > Ecran de verrouillage et
sécurité > Empreintes digitales.
2 Déverrouillez lappareil selon le mode de déverrouillage spécifié.
3 Sur l'écran des paramétres d'empreinte digitale, activez la fonction
souhaitée :
« Verrouillage de l'écran: Déverrouillage de [écran avec une empreinte
digitale.
+ Verrouillage du contenu : Déverrouillage de contenu avec une
empreinte digitale. Pour cela, assurez-vous que le verrouillage du
contenu est activé.

Fonction multitaches

Ecran des utilisations récentes

Balayez la touche d'accueil — vers le haut et maintenez enfoncé pour
afficher l'historique d'utilisation récente.

fenétre pop-up

Vous pouvez ouvrir plusieurs applications a [écran et passez facilement entre
elles a tout moment.

1 Balayez vers le haut — a partir du bord bas sur écran.

2 Appuyez sur l'icone dapplication sur la partie supérieure gauche de [écran
dapplication et sélectionnez fenétre pop-up.
- Sivous appuyez sur l'icone dapplication, les options Informations,
Multi Fenétres, Fenétre pop-up et Application Pin saffichent.
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3 Lapplication s'affiche dans une fenétre pop-up a lécran.

L]

np np

E « Cette fonction peut ne pas étre disponible dans certaines applications ou
écrans.

Utiliser la fenétre pop-up

« — :Minimise la fenétre pop-up. La fenétre pop-up est minimisée dans
licdne de lapplication flottant a [écran, et peut étre déplacée ol vous le
souhaitez.

- T 1:Développe lapplication en plein écran.
X :Ferme lapplication.

Pour déplacer la fenétre pop-up : Faites glisser le haut de la fenétre
pop-up.

- Pour ajuster la taille de la fenétre pop-up : Faites glisser le bord gauche,
droit ou inférieur de la fenétre pop-up.
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« Vous pouvez ouvrir jusqua 5 applications en utilisant des fenétres

contextuelles.

« Pour sélectionner une application parmi celles ouvertes, appuyez sur une

des fenétres contextuelles. La fenétre pop-up choisie passe devant.

« Les fenétres contextuelles ne peuvent pas étre déplacées dans la zone de barre

d'état ni de barre de navigation.

Utiliser le dossier d'applications pour les fenétres
contextuelles

Si vous appuyez sur — sur la fenétre pop-up, la fenétre pop-up est
minimisée dans l'icone d'applications.

Vous pouvez déplacer l'icéne des applications ou vous le souhaitez en la
faisant glisser.

Si au moins deux fenétres contextuelles sont minimisées, le dossier des
applications est créé pour contenir les icénes d'application.

5

« Licone dapplication récemment utilisée est utilisée comme icéne du dossier

des applications. Si vous appuyez sur l'icone, toutes les icones des fenétres
contextuelles minimisées apparaissent dans le dossier des applications.

« Sivous appuyez de fagon prolongée sur le dossier des applications pour

fenétres contextuelles, et faites glisser le dossier des applications dans
Supprimer, le dossier des applications sera supprimé.

« Pour supprimer ['une des applications du dossier des applications, ouvrez le

dossier des applications et faites glisser l'icéne dapplication hors du dossier.
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Multi Fenétres

En utilisant la navigation par gestes

1 Balayez vers le haut — a partir du bord bas sur écran.
« Les applications récemment utilisées saffichent.
+ Sivous appuyez sur l'icone d'application, les options Informations,
Multi Fenétres, Fenétre pop-up et Application Pin saffichent.

2 Appuyez sur licone d'application sur la partie supérieure gauche de [écran
d'application a afficher dans les fenétres multiples et sélectionnez Multi
Fenétres.

- Lapplication sélectionnée saffiche sur la moitié supérieure de [écran.
3 Appuyez sur lautre application a afficher dans les multi fenétres.
- L'application sélectionnée s'affiche sur la moitié inférieure de ['écran.

En utilisant la navigation touches tactiles uniquement

1 Appuyez sur[] de la barre de navigation.
+ Les applications récemment utilisées saffichent.
+ Sivous appuyez sur l'icone d'application, les options Informations,
Multi Fenétres, Fenétre pop-up et Application Pin saffichent.
2 Appuyez sur l'icone d'application sur la partie supérieure gauche de [écran
d'application a afficher dans les multi fenétres et sélectionnez =
- Lapplication sélectionnée saffiche sur la moitié supérieure de [écran.
3 Appuyez sur lautre application a afficher dans les multi fenétres.

E « Pour ajuster la taille de [écran fractionné, faites glisser la barre vers le centre
de [écran.

« Pour désactiver la fonction Multi Fenétres, faites glisser la barre du centre
vers le haut ou le bas, a lextrémité de [écran.

« Lafonction Multi Fenétres n'est pas prise en charge par certaines
applications LG ou applications téléchargées depuis e Play Store.
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AOD (always-on display)
Vous pouvez afficher la date, 'heure, ou encore la signature lorsque [écran
principal est éteint.

Balayez le bas de ['écran d'affichage Toujours activé pour activer les
fonctionnalités, notamment Camera, Capture+, Wi-Fi, les paramétres du son,
Bluetooth® Flash, Music et plus.
1 Surlécran d'accueil, appuyez sur Paramétres > Ecran > AOD (always-on
display).
7 Sélectionnez limage que vous voulez afficher et appuyez sur Enregistrer.
+ Appuyez sur limage souhaitée parmi Horloge numérique, Pendule,
Horloge double, Signature ou Image.
+ Appuyez sur Activer l'affichage et sélectionnez Taper pour afficher
pendant 10 secondes ou sur Toujours afficher.
- Appuyez sur Outils Rapides et lecteur audio pour faire défiler les
icones détat des outils rapides et du lecteur de musique.
+ Pour augmenter la luminosité pour la fonction Always-on display,
appuyez sur Plus grande luminosité de l'affichage.
+ Pour consulter [assistance dAlways-on display, appuyez sur Aide.

E « La batterie peut se décharger plus vite quand vous utilisez la fonction
Always-on display. Désactivez cette fonction pour prolonger la durée de la
batterie.
+ Pour désactiver loption daffichage AOD (always-on display), sur [écran
d'accueil, appuyez sur Paramétres > Ecran > AOD (always-on display),
puis appuyez sur @ ).
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Remarques concernant l'étanchéité du
produit

Ce produit est étanche et résistant a la poussiére conformément a la norme
de Protection d'entrée IP68.

Votre produit a été testé dans un environnement controlé et il a été
démontré qu'il est résistant a l'eau et a la poussiere dans certaines
circonstances (conformément a l'indice de protection IP68 tel que décrit par
la norme internationale IEC 60529 - Degrés de protection assurés par les
boftiers [code IP] ; conditions de test : 15-35 °C, 86-106 kPa, 1,5 métre,
pendant 30 minutes). N'exposez pas |'appareil a des conditions différentes
des conditions de test. Les résultats peuvent varier en situation d'utilisation
réelle.

/\ AVERTISSEMENT

Malgré la norme IP68, votre appareil n'est pas insensible aux conditions non
testées dans l'environnement controlé de LG. Remarque : tout dommage
conséquent dans de telles conditions entraine une modification de la couleur
du LDI (Liquid Damage Indicator). Si la couleur du LDI situé dans 'appareil
change, le produit n'aura pas droit aux services de réparation gratuits fournis
dans le cadre de la garantie limité du produit en question.

Evitez d'exposer le produit & des environnements présentant de la
poussiere ou un taux d'humidité excessifs. N'utilisez pas le produit dans les
environnements suivants.

N'immergez pas le produit dans des produits chimiques liquides
(savons, etc.) ou tout liquide autre que ['eau.

@ N'immergez pas le produit dans de ['eau salée (y compris l'eau de mer).
@ N'immergez pas le produit dans une source chaude.

@ Ne portez pas le produit sur vous lorsque vous nagez.
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Ne placez pas le produit directement sur le sable (sur une plage, par

exemple) ou de la boue.

@ N'immergez pas votre produit dans de l'eau a une profondeur

supérieure a environ 1,5 metre.
N'immergez pas votre produit dans de eau pendant plus de
30 minutes.

- Sivotre produit a été mouillé, essuyez le micro, le haut-parleur et la prise

stéréo avec un chiffon sec avant toute utilisation.

Si le produit ou vos mains deviennent mouillés, séchez-les avant de
manipuler l'appareil.

N'utilisez pas le produit dans des endroits ou il risquerait de recevoir de
l'eau a haute pression (pres d'un robinet ou d'une pomme de douche
par exemple), et ne limmergez pas dans 'eau pendant des périodes
prolongées, car il n'est pas concu pour résister a des pressions élevées.
Ce produit n'est pas résistant aux chocs. Ne le laissez pas tomber et ne

l'exposez pas a des chocs. Vous risqueriez d'endommager ou de déformer
l'unité principale et de provoquer des fuites.

- Larésistance du produit a l'eau et la poussiere risque d'étre réduite si vous

le faites tomber ou s'il subit un impact.

Si le produit est mouillé, utilisez un chiffon doux et propre pour le sécher
soigneusement.

+ Lécran tactile et les autres fonctionnalités risquent de ne pas fonctionner

correctement si l'appareil est utilisé mouillé.

+ Votre produit est étanche uniquement si le logement de la carte SIM/

Mémoire est correctement inséré dans le produit.

+ N'ouvrez pas ou ne fermez pas le logement de la carte SIM/Mémoire si le

produit est mouillé ou immergé. Toute exposition du logement ouvert a de
l'eau ou de I'humidité peut endommager le produit.

+ Le logement de la carte SIM/Mémoire contient un [joint] en caoutchouc

pour éviter que de la poussiere, de l'eau ou de 'humidité ne pénetre dans
le produit. Veillez a ne pas endommager le [joint] en caoutchouc car cela
risquerait de laisser la poussiére, l'eau ou ['humidité pénétrer dans votre
produit et 'endommager.
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A

« Tout manquement aux instructions fournies peut entrainer lannulation de
la garantie limitée de votre appareil.

« Sil'appareil est mouillé, le LDI situé a l'intérieur de 'appareil change de
couleur. Dans ce cas, l'appareil n'est pas éligible aux services de réparation
gratuits fournis dans le cadre de la garantie limitée de ['appareil.

+ Malgré une cote IP68, votre appareil n'est pas completement imperméable
a l'eau dans toutes les situations.
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Fonctions de base



Composants du produit et accessoires

Les accessoires suivants sont inclus avec votre appareil.

+ Appareil + Chargeur

- Cable USB + Guide de démarrage rapide

+ QOutil déjection

A

Les éléments décrits ci-dessus peuvent étre en option.

Les éléments fournis avec l'appareil et les éventuels accessoires disponibles
peuvent varier en fonction de la région et de ['opérateur de téléphonie.
Utilisez toujours des accessoires dorigine LG Electronics. Lutilisation
daccessoires dautres fabricants peut avoir une incidence sur la
performance d'appel de votre appareil et causer des dysfonctionnements.
Cela peut étre couvert par le service de réparation de LG.

Certaines parties de votre appareil sont en verre trempé. Sivous laissez
tomber cet appareil sur une surface dure ou le soumettez a de forts
impacts, le verre tempéré risque détre endommagé. Dans ce cas, cessez
d'utiliser votre appareil immédiatement et contactez un centre de service
client LG.

En cas dabsence de l'un de ces éléments de base, contactez le vendeur
aupres duquel vous avez acheté lappareil.

Pour acheter d'autres accessoires, contactez un centre de service client LG.
Certains éléments de la boite du produit peuvent changer sans préavis.
L'apparence et les spécifications de votre appareil peuvent étre changées
sans préavis pour améliorer le produit.

Les spécifications de lappareil peuvent varier en fonction de la région et de
lopérateur de téléphonie.

Retirez le film protecteur du capteur dempreintes digitales avant d'utiliser la
fonction dempreintes digitales.
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Présentation des piéces

Ecouteur —

/ﬁ:“:’jﬁﬁb

Lentille de l'appareil photo
frontal

Touches de volume (+/-) —I:

Touche Google Assistant —

Prise jack pour casque

— Capteur de lumiere

ambiante/de proximité

e— Touche

Alimentation/Verrouillage

L Ecran tactile

/@-— — Capteur dempreintes
digitales
S
— 1

stéréo

Micro ————

Objectif de lappareil photo —
arriere

Flash —

Haut-parleur

—

— NFC

— Zone de l'antenne de
chargement sans fil

Micro

Fonctions de base

Port du chargeur/cable USB

== Plateau de carte nano-SIM

41



A N'essayez PAS de retirer le cache arriere.

« Cela pourrait endommager gravement la batterie et [appareil, ce qui
pourrait provoquer une surchauffe, un incendie et des blessures. Le
cache arriere et la batterie de cet appareil ne doivent pas étre enlevés ou
remplacés par des professionnels non qualifiés.

- \otre téléphone est un appareil électronique qui produit de la chaleur
en fonctionnement normal. Lors d'une utilisation prolongée dans un
environnement mal ventilé, le contact direct avec la peau peut provoquer
une géne ou des br{lures bénignes. Manipulez donc votre téléphone avec
précaution lors de son fonctionnement ou immédiatement apres utilisation.

+ Touches de volume
- Régler le volume des sonneries, appels ou notifications.

- Appuyez légérement sur une touche de volume pour prendre une photo
lorsque vous utilisez la caméra. Pour des prises de photos en continu,
appuyez et maintenez enfoncée la touche de volume.

- Appuyez deux fois sur la touche Diminuer e volume pour ouvrir
I'application Appareil photo lorsque ['écran est verrouillé ou éteint.
Appuyez deux fois sur la touche Augmenter le volume pour ouvrir
Capturer+.

+ Touche Alimentation/Verrouillage

- Appuyez brievement sur la touche lorsque vous souhaitez activer ou
désactiver [écran.

- Appuyez de maniere prolongée sur la touche lorsque vous souhaitez
sélectionner une option de controle de lalimentation.

+ Touche Google Assistant

- Appuyez brievement une fois dessus pour lancer Google Assistant.
Maintenez-la enfoncée pour lancer Google Assistant puis relachez le
doigt de la touche pour lancer la fonction de commande vocale.

- Consultez la section Google Assistant pour plus d'informations.

- Capteur dempreintes digitales

- Vous pouvez utiliser le capteur dempreintes digitales en bas au centre
de lécran pour utiliser la fonction de reconnaissance des empreintes
digitales. Consultez la section Présentation de la Empreintes Digitales
pour plus d'informations.
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Certaines fonctions peuvent étre restreintes selon la région ou les
spécifications du pays des différents fournisseurs de télécommunications.

i

Une puce NFC et des antennes de chargement sans fil sont intégrées a
larriere du produit. Veillez a ne pas endommager ni couvrir la puce NFC ou
les antennes de chargement sans fil.

Ne posez pas dobjets lourds et ne vous asseyez pas sur lappareil. Cela
pourrait endommager ['écran tactile.

« Lefilm de protection de [écran ou des accessoires peuvent géner le capteur
de proximité.

['écran tactile ou les touches peuvent ne pas fonctionner correctement si
votre appareil est mouillé ou utilisé dans un lieu humide.

Le produit comporte deux microphones intégrés. Veillez a ne pas couvrir
les microphones. Pendant que vous parlez au téléphone, ne couvrez pas le
microphone avec votre main ou vos doigts.

Utilisez uniguement un étui de téléphone original et ne couvrez pas le
microphone daccessoires, ruban, etc.

Tenez correctement le produit quand vous ['utilisez comme indiqué sur la
figure.

Micro Ne pas couvrir le microphone.
1

%

"
— — |
\s I,
\ v
!
Micro Ne pas couvrir le microphone.
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Mise en marche / Arrét du téléphone

Mise en marche du téléphone

Alors que l'appareil est hors tension, appuyez de maniere prolongée sur la
touche Marche-Arrét/Verrouillage.

E « La configuration initiale seffectue lors de la premiere mise en marche de
lappareil. Le premier démarrage du smartphone peut étre plus long que
dordinaire.

Arrét du téléphone

Maintenez la touche Marche-Arrét/Verrouillage enfoncée, puis sélectionnez
Eteindre.

Redémarrage de l'appareil

Si lappareil ne fonctionne pas correctement ou ne répond pas, redémarrez-le

en suivant les instructions ci-dessous.

1 Maintenez la touche Marche-Arrét/Verrouillage et la touche Diminuer le
volume enfoncées en méme temps jusqu'a ce que |'appareil s'éteigne.

2 Lorsque l'appareil a redémarré, relachez la pression de votre doigt sur la
touche.

E « Cette fonction n'est pas disponible quand lappareil est connecté au Double
écran LG (LM-G905N).

Options de contrdle de l'alimentation
Maintenez le doigt appuyé sur la touche Marche-Arrét/Verrouillage, puis
sélectionnez une option.

- Eteindre: Fteindre lappareil.

+ Redémarrer: Redémarrage de appareil.

Fonctions de base 44



Installation de la carte SIM

Insérez la carte SIM (Subscriber Identity Module) fournie par votre opérateur
pour commencer a utiliser votre appareil.

A - Faites attention a loutil déjection car il est muni d'un bord tranchant.

E « Pour que [étanchéité a leau et a la poussiere soit effective, le support de
carte doit étre inséré correctement.

1 Insérez et enfoncez la tige dans lorifice de lemplacement de carte, puis
extrayez doucement le plateau de |a carte du produit.

2 Alignez la carte nano-SIM ou la carte mémoire dans le plateau de carte

et enfoncez la carte dans le sens indiqué par la fleche, comme illustré sur
la figure.

Carte SIM
Carte mémoire
(optionnelle, vendue séparément)
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Cet appareil ne prend en charge que les cartes nano SIM.

i

Nano Micro Standard
L)

Pour des performances optimales, il est recommandé d'utiliser lappareil
avec le type de carte SIM approprié. Utilisez toujours une carte SIM
fabriquée et fournie par lopérateur.

Ne perdez pas votre carte SIM. LG ne peut étre tenu responsable des
dommages et autres problémes causés par la perte ou le transfert d'une
carte SIM.

\eillez a ne pas endommager la carte SIM lorsque vous linsérez ou la
retirez.

Lorsque vous insérez une carte SIM ou une carte mémoire, placez-la sur le
support de carte correctement.

Lorsque vous réinsérez le support de carte dans votre appareil, insérez-le
horizontalement, dans la direction indiquée par la fleche sur l'illustration.
Assurez-vous que |a carte placée sur le support de carte nest pas délogée
de sa place.

Insérez la carte SIM avec les zones de contact dorées orientées vers le bas.

Assurez-vous de suivre les instructions du manuel d'utilisation pour insérez
la carte SIM dans lappareil.

Sivous insérez le support de carte dans lappareil ou si vous len retirez,
veillez a ne pas laisser deau ni dautre liquide s'infiltrer dans le support de
carte. Si une carte ou un support de carte mouillé est inséré dans lappareil,
votre appareil risque détre endommagé.

La carte mémoire est un élément en option.

L'écriture et l'effacement fréquents des données peut réduire la durée de vie
des cartes mémoire.

Certaines cartes mémoire peuvent ne pas étre pleinement compatibles
avec |'appareil. Sivous utilisez une carte incompatible, vous risquez
d'endommager |'appareil ou la carte mémoire, voire encore corrompre les
données qui sont dessus.
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Insertion de la carte mémoire

Insérez la carte mémoire dans votre appareil.

L'appareil peut prendre en charge des cartes microSD jusqu'a 2 To. Selon la
marque de votre carte mémoire et son type, elle peut ne pas étre compatible
avec votre appareil

1 Insérez la broche d'injection dans le support de carte.

7 Retirez le support de carte.

3 Placez la carte mémoire sur le support de carte avec les zones de contact
dorées orientées vers le bas.

N
&
-
2>
% Carte mémoire
(optionnelle, vendue séparément)
L Carte SIM )

/A Réinsérez le support de carte dans son emplacement.

A « Certaines cartes mémoire peuvent ne pas étre pleinement compatibles
avec |'appareil. Sivous utilisez une carte incompatible, vous risquez
d'endommager ['appareil ou la carte mémoire, voire encore corrompre les
données qui sont dessus.

E « L'écriture et l'effacement fréquents des données peut réduire la durée de vie
des cartes mémoire.
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Extraction de la carte mémoire

Pour plus de sécurité, démontez la carte mémoire avant de l'extraire.

7 Sur [écran daccueil, appuyez sur Paramétres > Stockage > /.

7 Insérez la broche déjection dans lorifice du support de carte, puis retirez
le support de carte de lappareil.

3 Retirez la carte mémoire du support de carte.
4 Réinsérez le support de carte dans son emplacement.

A + N'extrayez pas la carte mémoire alors que l'appareil est en train de
transférer ou d'accéder aux informations. Cela pourrait provoquer la perte
ou la corruption des données, voire endommager la carte mémoire ou
I'appareil. LG ne saurait étre tenu responsable des pertes résultant de
I'abus ou de ['utilisation impropre des cartes mémoire, y compris la perte de
données.

Batterie

Chargement de la batterie

Chargez entierement la batterie avant d'utiliser votre téléphone pour la
premiere fois.

Chargez l'appareil avec un cable USB type C.

~ Connecteur du cable de chargement
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Ne pas utiliser le produit ni le charger en cas d'humidité sur le port de
chargement, les bornes exposeées, le cable de chargement, ladaptateur
de chargement, etc. Le produit peut ne pas fonctionner correctement, se
casser ou étre endommagé, entrainant un risque de blessures suite a un
choc électrique, un incendie, une surchauffe, une explosion, etc. En cas
d’humidité a ces endroits, arrétez immédiatement d'utiliser ou de charger le
produit et retirez toute 'humidité.

Ne séparez pas le cache de la batterie.

La batterie de ce produit n'est pas amovible. Il ne faut pas extraire ni
remplacer le cache de la batterie ou la batterie. Si vous extrayez ou
remplacez le cache de la batterie ou la batterie, le produit peut étre
endommagé, surchauffer ou exploser.

Seul le cable USB et ladaptateur de chargement fournis avec le produit sont
des composants de base.

Votre appareil est équipé d'une batterie interne rechargeable. Pour votre
sécurité, ne retirez pas la batterie intégrée.

Lutilisation de lappareil en cours de charge peut provoquer un choc
électrique. Arrétez le chargement pour utiliser ['appareil.

Débranchez le chargeur de la prise dalimentation lorsque lappareil est
entierement chargé. Cela évite toute consommation délectricité inutile.

Un adaptateur de charge compatible avec la recharge rapide est inclus avec
le produit. La fonction de chargement rapide peut ne pas fonctionner si un
autre adaptateur de chargement rapide que ladaptateur dorigine fourni
avec le produit est utilisé.

Il'est également possible de recharger la batterie en branchant lappareil sur
un ordinateur de bureau portable au moyen d'un cable USB. Cela peut étre
plus long que de brancher ladaptateur sur une prise murale.

Ne chargez pas |a batterie avec un concentrateur USB incapable de
maintenir [a tension nominale. Le chargement pourrait échouer ou sarréter
involontairement.

Quand vous venez au service clientele pour un probleme de batterie,
apportez le produit et le chargeur car la batterie est une piece
consommable. La vie de la batterie peut diminuer au fil du temps.
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Précautions d'utilisation de l'appareil

+ Assurez-vous d'utiliser le cable USB fourni ; n'utilisez pas de cables USB ou
de chargeurs dautres fabricants avec votre appareil. La garantie limitée de
LG ne couvre pas ['utilisation daccessoires dautres fabricants.

- Sivous ne respectez pas les consignes figurant dans le guide, une
mauvaise manipulation risque dendommager lappareil

Chargement sans fil

Cet appareil prend en charge la fonction de chargement sans fil. Chargez
lappareil avec un chargeur sans fil certifié Qi (optionnel, vendu séparément).

Chargement de la batterie avec un chargeur sans fil

1 Placez votre appareil au centre du chargeur sans fil, en alignement avec
lantenne de chargement sans fil a larriere de appareil.
+ Pour voir lemplacement de lantenne de chargement sans fil, consultez
la section Présentation des pieces.

7 Lorsque la batterie est entierement chargée, retirez lappareil du chargeur.

A « Lorsque vous chargez la batterie avec un chargeur sans fil, ne placez pas
de matériaux magnétiques, métalliques ni conducteurs entre lappareil et le
chargeur. Cela pourrait perturber le chargement de lappareil et le chargeur
pourrait chauffer. Dans ce cas, lappareil, le chargeur ou les cartes SIM/
mémoire pourraient étre endommagés.
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E « Sila batterie dépasse une certaine température lors du chargement de
lappareil, le chargement pourrait sarréter.

+ Sides matériaux magnétiques, métalliques conducteurs sont attachés a
larriere de l'appareil, ou si une coque de protection est utilisée, lappareil
risque de ne pas charger correctement.

« Lorsque vous chargez la batterie avec un chargeur sans fil dans des zones
ou la force du signal de réseau est faible, la performance réseau de votre
appareil pourrait &tre encore plus basse.

« Chargez appareil avec un chargeur sans fil certifié Qi (optionnel, vendu
séparément). La garantie limitée de LG ne couvrant pas ['utilisation
daccessoires dautres fabricants, veuillez contacter ces derniers.

« Ce produit permet le chargement sans fil. Utilisez un chargeur sans fil Qi
certifié (vendu séparément) pour recharger le produit. Certains chargeurs
sans fil a bobine ne sont pas compatibles avec le chargement sans fil. Le
chargement sans fil haut débit est disponible sur les chargeurs sans fil avec
profil EPP (profil étendu d'alimentation).

+ LG Electronics n'est pas responsable des problemes liés aux accessoires
d'autres marques. Pour ces problemes, contactez le fabricant de laccessoire.

Utilisation optimale de la batterie

La durée de vie de la batterie peut diminuer si vous faites fonctionner
simultanément un grand nombre d'applications et de fonctionnalités
logicielles de maniére continue.

Annulez les taches darriere-plan pour prolonger lautonomie de la batterie.
Suivez les conseils ci-dessous pour limiter la consommation de la batterie :

- Désactivez les fonctions Bluetooth ou réseau Wi-Fi lorsque vous ne les
utilisez pas.

- Paramétrez un délai de mise en veille de I'écran le plus court possible.
+ Réduisez la luminosité de [écran.
+ Réglez le verrouillage de [écran lorsque lappareil n'est pas utilisé.

- Vérifiez le niveau de la batterie pendant ['utilisation d'applications
téléchargées.
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Ecran tactile

Vous pouvez vous familiariser avec les commandes tactiles de votre appareil.

Appuyer
Appuyez légérement avec le bout du doigt pour sélectionner ou exécuter une
application ou une option.

Appui de fagon prolongée
Restez appuyé sur ['écran pendant plusieurs secondes pour afficher un menu
contenant plusieurs options.
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Appuyer deux fois

Appuyez deux fois rapidement pour faire un zoom avant ou arriere sur une
page \Web ou une carte.

Faire glisser

Maintenez le doigt appuyé sur un élément, comme une application ou un
widget, puis faites glisser votre doigt vers un autre emplacement dans un
mouvement controlé. Vous pouvez utiliser ce geste pour déplacer un élément.

Glisser

Touchez ['écran avec votre doigt et déplacez-le rapidement, sans faire de
pause. Vous pouvez utiliser ce geste pour parcourir une liste, une page \Web,
des photos, des écrans, etc.
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Rapprocher/écarter

Rapprochez deux doigts pour faire un zoom arriére, sur une photo ou une
carte. Pour faire un zoom avant, écartez les doigts.

>

Wi
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Evitez dexposer [écran tactile a tout choc excessif Cela pourrait
endommager le capteur tactile.

['&cran tactile peut ne pas fonctionner si vous utilisez appareil a proximité
d'un matériau magnétique, métallique ou conducteur.

L'écran peut ne pas étre visible en fonction de votre position si vous utilisez
lappareil dans des conditions de forte luminosité, comme sous les rayons
directs du soleil. Utilisez lappareil a lombre ou dans un endroit ot la lumiere
ambiante nlest pas trop lumineuse, mais suffisamment pour la lecture.
N'appuyez pas trop fort sur [écran.

Appuyez légerement du bout du doigt sur [option de votre choix.

Les commandes tactiles peuvent ne pas fonctionner correctement si vous
portez des gants ou tapez avec vos ongles.

Les commandes tactiles peuvent ne pas fonctionner correctement si [écran
est humide ou mouillé.

L'écran tactile peut ne pas fonctionner correctement s'il est recouvert d'un
film de protection ou si le téléphone est équipé d'accessoires achetés dans
une boutique en ligne ou un point de vente.

Si une image fixe est affichée pendant une période prolongée, des images
rémanentes ou des images altérées risquent d'apparaitre. Eteignez [écran
ou évitez dafficher la méme image pendant une période prolongée si vous
n'utilisez pas l'appareil
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Ecran d'accueil

Présentation de 'écran d'accueil

Lécran daccueil est le point de départ de nombreuses applications et
fonctions. Balayez vers le haut depuis le bord inférieur d'un écran pour
accéder directement a [écran dAccueil.

Vlous pouvez gérer toutes les applications et tous les widgets sur ['écran
d'accueil. Faites glisser ['écran vers la gauche ou la droite pour voir toutes les
applications installées en un coup d'ceil.

Disposition de ['écran d'accueil

Affichez toutes les applications et organisez les widgets et les dossiers sur
l'écran d'accueil.

Barre détat —

Widget météo —

+— Widget de recherche Google

Dossier —-

[_+——— IcOne de page

«— Zone d'acces rapide

Barre de navigation

E + L8cran daccueil peut varier en fonction de la politique du fabricant, des
parameétres utilisateur; de la version logicielle et de votre opérateur.
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Barre d'état : Affichage des icones détat, de l'heure et du niveau de la
batterie.

Widget météo : Consultez la météo et ['heure pour une zone

géographique précise.

- Widget de recherche Google: Saisissez ou parlez pour ouvrir la recherche
Google.

+ Dossier :Vous pouvez créer des dossiers pour classer lapplication en

fonction des criteres souhaités.

Icone de page : Affiche le nombre total d'écrans d'accueil. Vous pouvez
appuyer sur licone de la page souhaitée pour aller a la page sélectionnée.
Licne correspondant a ['écran actuel sera affiché en surbrillance.

- Zone d'acces rapide : Ancrage des principales applications en bas de
[écran pour qu'elles restent accessibles depuis n'importe quelle page de
[écran daccueil.

Barre de navigation : Vous pouvez aller a [écran précédent ou a [écran
d'accueil pendant votre utilisation de l'application, et vérifiez la liste des
applications récemment utilisées.

Utiliser la barre de navigation.
Voici un guide des gestes pour contrdler la barre de navigation.
+ Pour aller a [écran dAccueil, balayez vers le haut depuis le bord inférieur
de [écran.
+ Pour revenir en arriere, balayez a partir du bord gauche ou droit de [écran.
+ Pour aller a [écran dApercu, balayez vers le haut a partir du bord inférieur
de [écran en maintenant le doigt.
- Pour basculer rapidement entre les apps, balayez vers la droite sur le bord
inférieur de [écran pour accéder aux apps précédemment utilisées.

5 « Les Gestes sont utilisés par défaut pour la barre de navigation. Pour
changer a Touches tactiles uniquement Q 1O/ [:1 sur [écran daccueil,
appuyez sur Paramétres > Ecran > Barre de navigation, puis sélectionnez
Touches tactiles uniquement.
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Icones d'état

Lorsqu'il y a une notification de message non lu, dévénement du calendrier ou
dalarme, la barre détat affiche l'icone de notification correspondante. Vérifiez
[état de votre téléphone en visualisant les icones de notification affichées sur
la barre détat.

x

Aucun signal

Transmission de données en cours sur le réseau 5G

Alarme activée

Mode Vibreur activé

Bluetooth activé

Connecté a un PC via un cable USB

Niveau de la batterie

Mode Avion actif

Appels manqués

Wi-Fi connecté

Mode Silence activé

GPS activé

Point d'accés Wi-Fi activé

Aucune carte SIM insérée

Le mode NFC est activé

« Certaines de ces icnes peuvent apparaitre différemment ou ne pas

apparaitre du tout en fonction de [état de [appareil. Reportez-vous aux
icones en fonction de lenvironnement et la zone réels dans lequel vous
utilisez lappareil et votre fournisseur de service.

« Lesicones affichées peuvent varier en fonction de la zone et de lopérateur.
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Panneau de notifications
Pour ouvrir le panneau de notifications, faites glisser la barre d'état vers le bas
sur ['écran principal.
+ Pour ouvrir la liste des icones de paramétres rapides, faites glisser vers le
bas la fenétre de notifications ou appuyez sur l'icone de fleche.
+ Vous pouvez appuyer sur /2 pour ajouter, supprimer ou réorganiser les
icones de la fenétre de notifications.
+ Sivous maintenez le doigt appuyé sur l'icone, [écran parametres de la
fonction correspondante apparait.

E « Vous pouvez utiliser le panneau de notifications méme sur [écran de
verrouillage. Faites glisser le panneau de notifications lorsque [écran est
verrouillé pour accéder rapidement aux fonctions souhaitées.
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Changement de l'orientation de ['écran

Vous pouvez régler le changement automatique de lorientation de [écran en
fonction de la position physique du téléphone.

Sur le panneau de notifications, appuyez sur Rotation depuis |a liste des
icones dacces rapide.

Vous pouvez également appuyer sur Paramétres > Ecran et activer Rotation
automatique de l'écran sur [écran dAccueil.

<aus

Modification de l'écran d'accueil

Sur ['écran d'accueil, maintenez le doigt appuyé sur un espace vide, puis
sélectionnez la fonction désirée ci-dessous.

+ Pour réorganiser les pages de écran daccueil, maintenez le doigt appuyé
sur une page puis faites-la glisser vers un autre emplacement.

- Pour ajouter un widget a votre écran d'accueil, restez appuyé sur une zone
vierge de votre écran d'accueil, puis sélectionnez Gadgets.

« Pour changer les fonds d'écran, themes, icnes et AOD, appuyez de
maniere prolongée sur une zone vide de |'écran d'accueil, puis sélectionnez
Fond d'écran & Theme.

\lous pouvez également appuyer sur Paramétres > Ecran > Ecran
d'accueil > Fond d'écran sur [écran d'accueil, puis sélectionnez fonds
décran, themes, icnes et AOD, a appliquer a lappareil.
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Pour modifier la grille, restez appuyé sur une zone vierge de votre écran
d'accueil, puis sélectionnez Grille. Appuyez sur la grille souhaitée, puis
appuyez sur Appliquer.

Pour paramétrer votre écran d'accueil, restez appuyé sur une zone
vierge de votre écran d'accueil, puis sélectionnez Paramétres de ['écran
d'accueil. Consultez la section Parameétres de [écran daccueil pour plus
d'informations.

Pour afficher ou réinstaller des applications désinstallées, maintenez
le doigt appuyé sur une zone vierge de votre écran daccueil, puis

sélectionnez Corbeille des apps. Consultez la section Corbeille des apps

pour plus d'informations.

vierge de [écran daccueil, déplacez-vous sur [écran souhaité, appuyez su
Y, puis appuyez une fois de plus sur [écran.

e FEcran par défaut

Fonctions de base

Pour changer [écran par défaut, maintenez le doigt appuyé sur une zone

r
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Visualisation du théme d'arriére-plan
Vous pouvez visualiser uniquement l'image d'arriere-plan en masquant les
applications et les widgets sur ['écran d'accueil.
Ecartez deux doigts sur I'écran d'accueil
+ Pour revenir a [écran dorigine, qui affiche les applications et les widgets,
rapprochez vos doigts sur [écran daccueil ou faites glisser vers le haut —
depuis le bord inférieur de [écran.

Déplacement d'applications sur 'écran d'accueil

Sur [écran d'accueil, maintenez le doigt appuyé sur une application, puis
faites-la glisser vers un autre emplacement.

Pour conserver vos applications fréquemment utilisées en bas de [écran
d'accueil, maintenez le doigt appuyé sur une application, puis faites-la
glisser sur la zone d'acces rapide dans |a partie inférieure.

+ Pour supprimer une icéne de la zone d'acces rapide, faites glisser l'icone
sur [écran daccueil.
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Utilisation de dossiers depuis 'écran d'accueil

Création de dossiers

Sur [écran d'accueil, maintenez le doigt appuyé sur une application, puis
faites-la glisser sur une autre application.

+ Unnouveau dossier est créé et [application y est ajoutée.

Modification de dossiers
Sur ['écran d'accueil, appuyez sur un dossier, puis exécutez une des actions
suivantes.

+ Pour modifier le nom du dossier;, appuyez sur le nom du dossier.

- Pour modifier la couleur, appuyez sur le cercle supérieur droit.

+ Pour ajouter des applications, restez appuyé sur une application, puis
faites-la glisser vers le dossier et relachez-la.

+ Pour supprimer une application du dossier, maintenez le doigt appuyé
sur lapplication et faites-la glisser en dehors du dossier. Si 'application
désinstallée est la seule application présente dans le dossier; ce dossier est
automatiquement supprimé.

- Vous pouvez également ajouter ou retirer des applications en appuyant

sur (¥).

5 « Vous ne pouvez pas changer la couleur du dossier si vous utilisez un théme
téléchargé.
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Paramétres de 'écran d'accueil
Vous pouvez personnaliser les parametres de [écran d'accueil.
1 Sur lécran d'accueil, appuyez sur Paramétres > Ecran > Ecran d'accueil
2 Personnalisez les parameétres suivants :
+ Sélectionnez Accueil: Sélectionnez un mode décran d'accueil
+ Fond d'écran: Modifier le theme d'arriere-plan de ['écran d'accueil.

- Effet de défilement des écrans d'accueil: Sélectionnez leffet que
vous souhaitez afficher lorsque vous passez d'une page de [écran
daccueil a une autre.

- Formes d'icones : Choisissez si vous souhaitez des icones a bords
carrés ou arrondis.

- Fil Google : S'affiche a gauche de [écran d'accueil principal

- Trier les applis par: Configurez la maniere dont les applications sont
affichées sur 'écran d'accueil

+ Masquer applis: Sélectionner les applications a masquer ou non sur
['écran d'accueil.

+ Laisser l'écran d'accueil tourner en boucle : Activez ce parametre
pour permettre le défilement en continu de [écran d'accueil (revient en
boucle au premier écran apres étre arrivé au dernier écran).

- Balayez I'Ecran d'accueil vers le bas. : permet de rechercher des
applications ou contenus, ou de voir les notifications en balayant [écran
daccueil vers le bas.

- Balayez I'Ecran d'accueil vers le haut. : permet de rechercher des
applications ou contenus, ou de voir les notifications en balayant [écran
daccueil vers le haut.

- Ecran d'accueil Verrou : Activez cette fonction pour empécher le
déplacement ou la suppression des applications et des widgets.
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Verrouillage de 'écran

Présentation du verrouillage de écran

Lorsque vous appuyez sur la touche Marche-Arrét/Verrouillage, [écran de
votre téléphone séteint et se verrouille. Cela est également le cas lorsque
votre appareil reste inactif pendant une période donnée.

Sivous appuyez sur la touche Marche-Arrét/Verrouillage lorsque

le verrouillage de [écran nest pas activé, [écran daccueil apparait
immédiatement.

Activez le verrouillage de [écran pour plus de sécurité et empécher tout accés

indésirable a votre appareil.

E « Leverrouillage de [écran évite les saisies non désirées sur [écran de lappareil

et réduit la consommation de la batterie. Nous vous recommandons

d'activer le verrouillage de ['écran pendant que vous n'utilisez pas l'appareil.

Réglage d'un écran de verrouillage

Plusieurs options sont disponibles pour configurer les parametres de
verrouillage de ['écran.

1 Sur lécran d'accueil, appuyez sur Paramétres > Ecran de verrouillage et
sécurité > Choisir €cran de verrouillage puis sélectionnez la méthode

que vous préférez.
7 Personnalisez les parametres suivants :
+ Aucun: Désactivation de la fonction de verrouillage de ['écran.
« Glisser: Déverrouillage de [écran d'un glissement de doigt.
+ Schéma: Déverrouillage de [écran en tracant un schéma.

- Code PIN: Déverrouillage de [écran grace a la saisie d'un mot de passe

numeérique.

+ Mot de passe: Déverrouillage de écran grace a la saisie d'un mot de

passe alphanumérique.

- Empreintes digitales: Déverrouillage de ['écran avec votre empreinte

digitale.
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Personnaliser ‘écran de verrouillage
Vous pouvez personnaliser [écran de verrouillage.
1 Sur lécran d'accueil, appuyez sur Paramétres > Ecran de verrouillage et
sécurité > Personnaliser l'écran de verrouillage.
2 Sélectionnez une fonction que vous souhaitez définir.
+ Fond d'écran: Vous permet de définir ['arriere-plan de votre écran de
verrouillage.
+ Horloge :Vous permet de définir l'emplacement de ['horloge sur ['écran de
verrouillage.

+ Raccourcis: Vous permet de choisir les applications a exécuter sur
votre écran de verrouillage. Ce parametre apparait uniquement
lorsqu'un verrouillage d'écran est défini.

- Animation météo: Activez cette option pour afficher les animations
météo pour l'emplacement actuel sur 'écran de verrouillage.

- Personne a contacter en cas de perte du téléphone: \Vous permet
de définir le texte a afficher sur ['écran de verrouillage pour identifier le
propriétaire du téléphone.

Parametre de verrouillage sécurisé

Vous pouvez définir les parametres de verrouillage sécurisé.

1 Sur lécran d'accueil, appuyez sur Paramétres > Ecran de verrouillage et
sécurité > Paramétre de verrouillage sécurisé.

2 Sélectionnez une fonction que vous souhaitez définir.

+ Rendre le schéma visible (uniqguement si le schéma est défini comme
verrouillage décran) :Rend le schéma visible.

Minuterie du verrouillage: Vous permet de définir la durée avant que
['écran ne se verrouille automatiquement apres la désactivation du
rétroéclairage (délai d'attente dd a l'inactivité).

+ Verrouillage instantané par bouton d'alimentation: Verrouillage
instantané de [écran lorsque vous appuyez sur la touche Marche-
Arrét/Verrouillage. Ce parametre remplace le parametre de minuterie
de verrouillage de sécurité.
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- Afficher le verrouillage (uniguement si un verrouillage de ['‘écran est
défini) : activez cette option pour afficher l'icéne de Verrouillage lorsque
vous maintenez enfoncé le bouton Marche-Arrét/Verrouillage. Appuyez
sur licone de Verrouillage pour désactiver Smart Lock, le déverrouillage
biométrique et les notifications de [écran de verrouillage.

+ Smart Lock: Vous permet de définir des dispositifs fiables, des lieux, la
voix et/ou la détection sur le corps qui permettra a votre téléphone de
rester déverrouillé.

5 « Les options de menu disponibles peuvent varier en fonction de la méthode
de verrouillage de [écran sélectionnée.

KnockON

Vous pouvez activer ou désactiver [écran en le touchant deux fois.

E « Cette option nest disponible que sur [écran daccueil de LG. Elle peut ne
pas fonctionner correctement sur un lanceur personnalisé ou sur [écran
d'accueil installé par ['utilisateur.

« Utilisez le bout du doigt pour appuyer sur [écran. N'appuyez pas avec vos
ongles.

« Pour utiliser la fonctionnalité KnockON, veillez a ce que le capteur de
proximité/lumiere ne soit pas obstrué par un autocollant ou autre corps
étranger.

Activation de l'écran
Appuyez deux fois au centre de [écran.
- Sivous appuyez en bas ou en haut, il se peut que le taux de
reconnaissance diminue.
Désactivation de l'écran

Appuyez deux fois sur un espace vide de [écran d'accueil et de [écran de
verrouillage.

Vous pouvez aussi appuyer deux fois sur un espace vide dans |a barre d'état.
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Désactivation de KnockON
Sivous ne souhaitez pas utiliser la fonction KnockON, procédez comme suit :

Sur [écran d'accueil, appuyez sur Paramétres > Extensions > KnockON et
faites-le glisser pour désactiver la fonction.

Cryptage de la carte mémoire

Vlous pouvez crypter et protéger les données enregistrées sur la carte
mémoire. Les données cryptées sur la carte mémoire sont inaccessibles
depuis un autre appareil.

1 Sur lécran d'accueil, appuyez sur Paramétres > Ecran de verrouillage et
sécurité > Cryptage et données d'identification > Crypter la carte SD.

7 Lisez la présentation a [écran concernant le cryptage de la carte mémoire,
puis appuyez sur Continuer pour continuer.

3 Sélectionnez une option et appuyez sur Cryptez.

- Cryptage du nouveau fichier: Cryptage uniquement des données
enregistrées sur la carte mémoire apres le cryptage.

- Cryptage complet: Cryptage de toutes les données actuellement
enregistrées sur la carte mémoire.

+ Exclure les fichiers multimédia: Cryptage de tous les fichiers, sauf les
fichiers multimédias comme la musique, les photos et les vidéos.
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L'acces a certaines fonctions est limité une fois le cryptage de la carte
mémoire commencé.

i

Si vous éteignez l'appareil en cours de cryptage, le processus échouera et
certaines données peuvent étre endommagées. \érifiez donc que le niveau
de chargement de la batterie est suffisant avant de lancer le cryptage.

Les fichiers cryptés ne sont accessibles que depuis lappareil sur lequel ils
ont été cryptés.

La carte mémoire cryptée ne peut étre utilisée sur un autre appareil LG.
Pour utiliser une carte mémoire cryptée sur un autre terminal mobile, vous
devez la formater.

Vous pouvez activer le cryptage de la carte mémoire méme si aucune
carte mémoire n'est insérée dans 'appareil. Toute carte mémoire installée
ultérieurement sera automatiquement cryptée.

Captures d'écran

Vous pouvez réaliser des captures de 'écran que vous consultez.

Par raccourci

Appuyez de maniére prolongée sur la touche Marche-Arrét/Verrouillage
et la touche Diminuer le volume en méme temps pendant au moins deux
secondes.

+ Les captures d'écran peuvent étre visualisées depuis le dossier
Screenshots sous Galerie.

Via Capture d'écran
Sur ['écran que vous souhaitez capturer, faites glisser la barre d'état vers le
bas puis appuyez sur @.

E + Consultez la section Annotation d'une capture décran pour plus
d'informations.
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Saisie de texte

Utilisation de la barre d'outils Smart

Vous pouvez utiliser plusieurs méthodes de saisie au clavier au méme endroit.
Vous pouvez sélectionner la méthode de saisie souhaitée a partir du haut du
clavier.

1 Sélectionnez la méthode de saisie au clavier souhaitée dans la barre
d'outils Smart.

2 Appuyez sur - - - et sélectionnez la méthode de saisie que vous souhaitez
afficher sur la barre doutils Smart, ou réorganisez-la.

.

Barre d'outils —¢
intelligente

E + Vous pouvez ajouter jusqua 6 outils a la barre d'outils intelligente.

« Certaines méthodes de saisie peuvent différer selon 'appareil dont vous
disposez.

« Vous pouvez activer ou désactiver la fonction de barre d'outils Smart a
partir des parametres du clavier.

+ Vous pouvez également utiliser les méthodes de saisie au clavier en
appuyant sur §G3.

+ © :Ajouter des emajis.
- [&): Ajouter des autocollants.

- @ :Vous pouvez utiliser le clavier de GIF de Tenor. Appuyez sur
Accepter pour utiliser cette fonction.

- (35 :Ajouter mes emojis.
+ 22 :Ouvrir le chat de dessin.
+ §03: Accédez aux paramétres du clavier.
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O : Appuyez sur & pour saisir du texte a laide de votre voix.

- Pour maximiser la reconnaissance vocale, parler clairement.

- Pour pouvoir utiliser |a saisie vocale, assurez-vous que votre appareil
est connecté a un réseau.

- Pour sélectionner la langue de |a reconnaissance vocale, appuyez sur
£ > Langues sur ['écran de la reconnaissance vocale.

- Cette fonction peut ne pas étre prise en charge ou les langues
prises en charge peuvent différer selon le domaine de service.

:Ouvrez le Presse-papier.
P :Saisie de texte avec écriture manuscrite Il est nécessaire de
télécharger les données de langue de saisie manuscrite. Appuyez

sur Télécharger pour télécharger les données de langue de saisie

manuscrite.

:Activez le clavier flottant lorsque vous utilisez la fonction Multi-
fenétre. Vous pouvez également déplacer le clavier a 'endroit souhaité.

Appuyez sur 59, dans la barre d'outils Smart.

- Silappareil est connecté au Double écran LG, vous pouvez capturez
[écran du Double écran LG et le joindre pendant |a saisie de clavier.
Pour en savoir plus, consultez Utiliser Capturer Instant sur Dual
Screen.

Appuyez sur f8 dans la barre d'outils Smart.

- Silappareil est connecté au Double écran LG, vous pouvez
développer le clavier verticalement et utilisez [écran supérieur
comme écran d'application et [écran du bas comme écran de clavier.
Pour en savoir plus, consultez Utiliser le double clavier sur Dual
Screen.
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Utilisation du clavier Smart
Vous pouvez utiliser le clavier Smart pour saisir et modifier du texte.

Le clavier Smart vous permet de visualiser le texte en cours de saisie sans
avoir a basculer entre 'écran et un clavier conventionnel. Il vous permet
également de repérer et de corriger facilement les erreurs en cours de saisie.

Déplacement du curseur

Le clavier Smart vous permet de déplacer le curseur exactement la ol vous
le souhaitez. Lorsque vous saisissez du texte, restez appuyé sur la barre
d'espacement et faites glisser vers la gauche ou la droite.

<= () =y

E « Cette option nest disponible que sur le clavier QWERTY.

Suggestion de mots

Le clavier Smart analyse automatiquement vos habitudes d'utilisation pour
vous suggeérer des mots fréquemment utilisés en cours de frappe. Plus vous
utiliserez votre appareil, plus les suggestions seront pertinentes.

Saisissez du texte, puis appuyez sur le mot suggéré ou faites glisser
légerement le coté gauche ou droit du clavier vers le haut.
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+ Le mot sélectionné est automatiquement inséré. Il n'est pas nécessaire de
taper manuellement chaque lettre du mot.

[— —
g g
4 &

Copier-coller

Vous pouvez couper ou coller du texte depuis une application, puis le
coller dans la méme application. Ou vous pouvez encore exécuter d'autres
applications et coller du texte dedans.

1 Maintenez le doigt appuyé sur le texte que vous souhaitez copier ou
couper.

7 Faites glisser @/ @ pour définir la section a copier ou couper.
3 Sélectionnez Couper ou Copier.
« Le texte coupé ou copié est automatiquement placé dans le presse-
papiers.

/4 Maintenez le doigt appuyé sur la fenétre de saisie de texte, puis
sélectionnez Coller.

E « Siaucun élément na été copié ou coupé, loption Coller napparaitra pas.
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Partage de contenu

Lecture de contenu d’un autre appareil

Vous pouvez lire des photos, vidéos ou chansons enregistrées sur votre
appareil a partir d'un téléviseur.

7 Connectez le téléviseur et votre appareil au méme réseau Wi-Fi.

7 Lorsque vous consultez des éléments dans 'application Galerie ou
Musicque, appuyez sur Cgou : > Lire sur un autre appareil
Ou, sur [écran daccueil, appuyez sur Parameétres > Appareils connectés
> Partage d'écran et appuyez ensuite sur () ) pour lactiver.

3 Sélectionnez le téléviseur auquel vous souhaitez vous connecter.

E « Pour utiliser Chromecast, les services Google Play doivent étre a jour.

Affichage de contenu d'appareils a proximité

Vous pouvez consulter le contenu de différents appareils, tels qu'un
ordinateur, un NAS ou un appareil mobile, avec les applications Galerie ou
Musique.

Connexion des appareils

Connectez votre appareil et un autre appareil qui prend en charge la fonction
DLNA, au méme réseau sans fil.

E « Assurez-vous que File Sharing (DLNA, le partage de fichier) est activé sur
I'appareil et ['appareil connecté.
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Recherche d'appareils a proximité

Vous pouvez afficher une liste des appareils DLNA sur le méme réseau en
sélectionnant longlet : > Appareils a proximité dans chaque application.

Utilisez le contenu des appareils a proximité comme si vous le faisiez sur
votre appareil.

Envoi ou réception de fichiers

Vous pouvez partager des fichiers entre votre appareil et un autre appareil LG,
ou une tablette.

Envoi de fichiers

Depuis lapplication Galerie ou une autre application, appuyez sur + >
Partager ou sur o<, puis sélectionnez un appareil dans la liste de partage de
fichiers.

Réception de fichiers

Faites défiler la barre d'état vers le bas et appuyez sur Partage de fichier.

Sivotre appareil ne prend pas en charge la fonctionnalité de partage de
fichiers, sur [écran d'accueil, appuyez sur Parametres > Appareils connectés
> Partage de fichiers > SmartShare Beam

E « Vous pouvez partager des fichiers avec certains appareils prenant en charge
le DLNA.
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Ne pas déranger

Vous pouvez limiter ou désactiver les notifications pour éviter détre dérangé
pendant une période donnée.
Sur [écran d'accueil, appuyez sur Parameétres > Son > Ne pas déranger.

- Mode, puis sélectionnez le mode souhaité :

- Prioritaires uniquement : Ne recevoir des notifications sonores ou
des vibrations que pour les applications sélectionnées. Méme quand
Prioritaires uniquement est activé, les alarmes continuent démettre des
sons.

- Silence total : Désactiver a la fois les sons et les vibrations.

- Sélectionner les priorités: Recevoir des alarmes et les notifications pour
les applications sélectionnées.

- Appels provenant de: Configurez une série de notifications lors de la
réception d'un appel.

E « Appel répété: Le deuxieme appel du méme appelant dans les 15 minutes
n'est pas réduit au silence.

- Messages de: Configurez une série de notifications lors de la réception
d'un message.
- Utiliser le Ne pas déranger: Activez la fonction Ne pas déranger.

- Veille : Définissez la planification pour laquelle vous souhaitez activer la
fonctionnalité Ne pas déranger.

- Aide : Consultez l'aide pour Ne pas déranger.
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Installation et désinstallation
d'applications

Installation d'applications

Accédez a une boutique d'applications pour rechercher et télécharger des
applications.

- Vous pouvez utiliser SmartWorld, Play Store ou la boutique d'applications
fournie par votre opérateur de téléphonie mobile.

E - Certaines boutiques dapplications peuvent vous demander de créer un
compte et de vous identifier.

« Certaines applications sont payantes.

« Sivous utilisez des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit.

« SmartWorld n'est pas toujours pris en charge, selon l'opérateur et la région.

Désinstallation d'applications
Désinstallez les applications que vous n'utilisez plus sur votre appareil.

Désinstallation en maintenant le doigt appuyé

Maintenez enfoncé une zone vide de [écran, puis appuyez sur € de
lapplication que vous souhaitez supprimer.

Désinstallations depuis le menu Paramétres
Sur [écran d'accueil, appuyez sur Paramétres > Applications > Informations,
sélectionnez une application puis appuyez sur Désinstaller.

E « Certaines applications ne peuvent pas étre désinstallées par les utilisateurs.
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Désinstallation d'applications a partir des boutiques
d'applications

Pour désinstaller une application, accédez a la boutique d'application a partir
de laquelle vous avez téléchargé lapplication et désinstallez-la.

Installation et désinstallation d'applications lors du

premier démarrage

Lors du premier démarrage de lappareil, il est possible de télécharger des
applications recommandées.

Vous pouvez passer a [étape suivante sans installation.

Corbeille des apps

Vous pouvez voir les applications désinstallées. Vous pouvez aussi réinstaller
des applications qui ont été désinstallées depuis moins de 24 heures.

7 Sur [écran daccueil, appuyez sur Gestion > Corbeille des apps.
Vous pouvez maintenir le doigt appuyé sur une zone vierge de votre écran
daccueil, puis sélectionnez Corbeille des apps.

7 Activez la fonction souhaitée :
+ Restaurer :Réinstallation de ['application sélectionnée.

- {i1] : Retirez les applications désinstallées de votre appareil, de maniére
permanente.

E + Les applications désinstallées sont supprimées automatiquement de
l'appareil, 24 heures apres leur désinstallation. Si vous souhaitez réinstaller
des applications désinstallées, vous devez a nouveau les télécharger depuis
la boutique d'applications.

- Cette fonction n'est activée que sur ['écran d'accueil par défaut. Si vous
désinstallez des applications alors que vous utilisez ['écran EasyHome ou un
autre lanceur, elles sont supprimées de maniere immédiate et permanente
de l'appareil.
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Raccourcis des applications

Sur [écran d'accueil, maintenez le doigt appuyé sur licéne d'une application,
comme Appel, Message, Appareil photo, Galerie ou Parametres, pour afficher
un menu a acces rapide. Utilisez des applications plus facilement grace aux
raccourcis des applications.

+ Appuyez sur &] pour afficher les widgets de ['application.

+ Appuyez sur (§) pour vérifier les informations de I'application.

5 « Cette fonction est disponible uniguement sur certaines applications.
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Téléphone

Appels vocaux
Plusieurs options s'offrent a vous pour passer un appel téléphonique : saisir
manuellement un numéro de téléphone et appeler depuis |a liste de contacts
ou la liste des appels récents.
Emission d'un appel depuis le clavier
7 Sur [écran daccueil, appuyez sur (3 > Composer.
2 Emettez un appel en utilisant la méthode de votre choix :
- Entrez un numéro de téléphone et appuyez sur @@.
+ Maintenez le doigt appuyé sur un numéro rapide.

+ Recherchez un contact en appuyant sur la premiere lettre de son nom
sur la liste de contacts et appuyez sur @.

E + Pour saisir « + » pour les appels internationaux, maintenez le doigt appuyé
sur le chiffre 0.

« Reportez-vous a Ajout de contacts pour plus d'informations sur ['ajout de
numéros de téléphone a la liste de numérotation rapide.

Emission d’un appel depuis le Répertoire
1 Surlécran daccueil, appuyez sur (@ > Répertoire.

2 Apreés avoir choisi le numéro que vous souhaitez appeler de votre
répertoire, appuyez sur ..
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Réponse a un appel
Pour répondre a un appel, faites glisser @ sur lécran d'appel entrant.

- Lorsque le casque stéréo est connecté, vous pouvez émettre des appels
en utilisant le bouton appel/raccrocher du casque.

Pour raccrocher sans éteindre [écran, sur [écran d'accueil, appuyez sur
Paramétres > Réseau et Internet > Appels > Répondre et mettre fin
a des appels, puis activez Mettre fin aux appels a l'aide de la touche
Marche/Arrét.

E « Sur [écran daccueil, appuyez sur Paramétres > Réseau et Internet >
Appels > Répondre et mettre fin a des appels > Mettre fin aux appels
a l'aide de la touche Marche/Arrét, vous pouvez mettre fin a un appel en
appuyant sur la touche Marche/Arrét pendant que [écran de lappel est actif.

Rejet d'un appel
Pour rejeter un appel, faites glisser @ a travers 'écran d'appel entrant.
- Pour envoyer une réponse rapide, faites glisser (_) a travers ['écran.

+ Pour ajouter ou modifier une réponse rapide, sur [écran daccueil, appuyez
sur Paramétres > Réseau et Internet > Appels > Bloquer l'appel et le
rejeter avec un message.

En cas d'appel entrant, appuyez sur la touche Augmenter le volume,
Diminuer le volume ou Marche-Arrét/Verrouillage pour couper la sonnerie
ou le vibreur ou pour mettre 'appel en attente.

Vérification d’'un appel entrant pendant |'utilisation
d’une application
Lorsqu'un appel entre pendant ['utilisation d'une application, une notification

contextuelle peut safficher en haut de [écran. Vous pouvez recevoir un appel,
rejeter un appel ou envoyer un message depuis [écran contextuel.

E « Sur écran daccueil, appuyez sur Parametres > Réseau et Internet >
Appels > Parameétres supplémentaires > Notification des appels
entrants puis sélectionnez la maniere souhaitée pour afficher appel
entrant lors de ['utilisation d'une application.
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Affichage des appels manqués
Si vous avez manqué un appel, la barre détat en haut de [écran affiche X,

Pour afficher les détails sur lappel manqué, faites glisser la barre détat vers
le bas. Vlous pouvez également appuyer sur (8 > Journaux des appels sur
[écran daccueil.

Fonctions accessibles pendant un appel

Durant un appel, vous pouvez accéder a de nombreuses fonctions en
appuyant sur les boutons a [écran :

- Répertoire : Consultez |a liste de contacts pendant un appel.
- Attente: Placez 'appel en cours en attente.
- Clavier: Affichage ou masquage du clavier de numérotation.

Ht. parleur: Activation de la fonction haut-parleur.

Muet: Mise en silence pour que votre interlocuteur ne puisse pas entendre
votre VOix.

- Bluetooth: Faites basculer ['appel sur un appareil Bluetooth apparié et
connecté.

- @ :Raccrocher
: :Accédez a de nombreuses options d'appel.

E « Les différents parametres disponibles peuvent varier en fonction de la
région et de lopérateur de téléphonie.
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Conversation a trois

\ous pouvez émettre un appel vers un autre contact pendant un appel en
cours.

1 Durant un appel, appuyez sur & > Ajouter un appel

2 Entrez un numéro de téléphone et appuyez sur @®.

« Les deux appels apparaissent en méme temps a ['écran et le premier
appel est mis en attente.

3 Pour démarrer une téléconférence, appuyez sur Fusionner appels.

E + Chaque appel pourra vous étre facturé. Consultez votre opérateur de
téléphonie pour plus d'informations.

Affichage des enregistrements d'appel

Pour afficher les enregistrements dappel récents, sur [écran daccueil,
appuyez sur (9 > Journaux des appels. Vous pouvez enstite utiliser les
fonctions suivantes :
+ Sélectionnez un contact pour afficher les enregistrements d'appel
détaillés. Pour appeler le contact sélectionné, appuyez sur &...

« Pour supprimer les enregistrements dappel, appuyez sur : > Supprimer.
E « Ladurée dappel affichée peut-étre différente du colit de lappel. Consultez
votre opérateur de téléphonie pour plus d'informations.
« Lhistorique des appels supprimés ne peut pas étre restauré.

« Pincez deux doigts ou écartez les doigts pour ajuster a taille de la police
des journaux d'appels ou des contacts.

Configuration des options d'appel
Vous pouvez configurer différentes options d'appel.

7 Sur [écran daccueil, appuyez sur (8 > Cadran ou sur Journaux des
appels.

2 Appuyez sur : > Paramétres d'appel puis configurez les options en
fonction de vos préférences.
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Messagerie

Envoi d'un message
Vous pouvez créer et envoyer des messages a vos contacts sélectionnés avec
I'application de messagerie.

E « Lenvoi de messages a [étranger peut occasionner des frais supplémentaires.
Consultez votre opérateur de téléphonie pour plus d'informations.

T Sur lécran d'accueil, appuyez sur .
2 Appuyez sur GHEID.
3 Spécifiez un destinataire et composez votre message.
+ Pour utiliser les options multimédias, appuyez sur ().
- Pour accéder a des éléments de menu optionnels, appuyez sur .
/A Appuyez sur E> pour envoyer le message.

Lecture d'un message
Vous pouvez afficher les messages échangés, en les organisant par contact.
7 Sur [écran d'accueil, appuyez sur ).

7 Sélectionnez un contact sur la liste de messages.

E + Dans la liste de messages ou la fenétre de discussion, vous pouvez ajuster
la taille de la police en placant deux doigts sur [écran et en les rapprochant
ou en les éloignant.
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Configuration des parameétres de messagerie

Vous pouvez modifier les parametres de messagerie en fonction de vos
préférences.

T Sur lécran d'accueil, appuyez sur €.

7 Appuyez sur + > Paramétres sur la liste de messages.

E « Vous pouvez désigner des parametres pour la fenétre de notifications, le
blocage des appels, les alertes de catastrophe, les messages multimédia, etc.

Photo

Ouverture de l'appareil photo
Vous pouvez prendre une photo ou enregistrer une vidéo pour conserver tous
vos instants mémorables.

Sur lécran d'accueil, appuyez sur (&).

E « Avant de prendre une photo, essuyez ['objectif de 'appareil photo avec un
chiffon doux.

+ Veillez a ne pas tacher l'objectif avec vos doigts ou une substance étrangere.

+ Méme si le téléphone est en mode vibration ou silence, le son de lobturateur
est activé lors de la prise de photos.

« Lesimages de l'appareil figurant dans ce guide de ['utilisateur peuvent étre
différentes de la réalité.

« Ilest possible de visualiser ou de modifier des photos et vidéos a partir
de la Galerie. Consultez la section Présentation de la Galerie pour plus
d'informations.

+ Abstenez-vous d'utiliser le produit dans un but pouvant enfreindre la
confidentialité ou les droits d'un tiers.
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Prendre une photo

Vous pouvez prendre des photos avec la caméra du produit.

1 Appuyez sur (@ et faites une mise au point sur le sujet.
+ Vous pouvez toucher le sujet pour le mettre au point.

+ Vous pouvez étendre ou pincer deux doigts pour effectuer un zoom
avant ou arriere.

+ Sélectionnez un zoom depuis €9 / @9 / ©.
2 Appuyez sur(  pour prendre une photo.

+ Vous pouvez aussi appuyer sur la touche Diminuer le volume ou
Augmenter le volume pour prendre une photo.

+ Vous pouvez prendre une photo tout en enregistrant une vidéo en
appuyant sur ® a lécran,

- Les options affichées sur [écran de prise peuvent varier en fonction de
la caméra sélectionnée (avant ou arriére) et du mode de caméra.

+ La caméra séteindra automatiquement si vous n'utilisez pas pendant
un certain temps lapplication Caméra.

Lancez Recherche
sur la vision.
—— Mode A | phot
Ajuster/Supprimer le acgu; pparetiphoto
paramétre de chronometre Basculer  la caméra
& %
Ajuster/Supprimer le - ! frontale/arrere
paramétre de flash
Appliquer [effet filtre —s l:l_-l —— Prendre une photo
1 — Sélectionner le zoom
Choisir le format décran —
N . L Apercu
Ajuster la caméra — | I Optimiseur
automatique de scéne

Applications utiles 86



- Vous pouvez lancer lapplication de la caméra en appuyant brievement
la touche Marche/Arrét deux fois. Sur [écran d'accueil, appuyez sur

Paramétres > Extensions > Raccourcis et appuyez ensuite sur Ouvrir
Appareil photo pour [activer.

« Lorsque ['écran est éteint ou verrouillé, ouvrez |'appareil photo en appuyant
deux fois sur la touche Diminuer le volume.

« Sur [écran d'accueil, appuyez sur Parameétres > Extensions > Raccourcis et
appuyez ensuite sur Quvrir Appareil photo @ ) pour [activer.

Personnalisation des options de 'appareil photo
Vous pouvez personnaliser de nombreuses options de lappareil photo selon

vos préférences.

Appuyez sur €33 sur 'écran.

5

« Les options disponibles varient en fonction de ['appareil photo sélectionné
(frontal ou arriere) et du mode d'appareil photo sélectionné.

Optimiseur
automatique de
scene

En reconnaissant la scene en cours denregistrement, le
parametre de résolution optimal sapplique automatiquement.

Recommande la composition optimale en reconnaissant la

Composition ) ) h .
P silhouette humaine lors de la prise d'un portrait.
Astuce Informe [utilisateur si les yeux du sujet sont fermés ou si
limage est floue pour obtenir une photographie optimale.
Taille de la Vous permet de choisir la taille de la photo et son rapport
photo d'image.
Obtenez des photos aux couleurs vives et aux effets équilibrés,
HDR méme si vous les prenez a contre-jour. Ces fonctions sont

assurées par la technologie HDR (High Dynamic Range)
embarquée dans lappareil photo.

Correction des
distorsions de
plan ultra large

Corrige les distorsions de [écran lors de la prise de photos a
angle ultra large.
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Enregistrer au
format .HEIF

Economiser de l'espace de stockage en compressant le fichier
d'image en format HEIF. D'autres appareils peuvent ne pas
prendre en charge les fichiers image en format HEIF

Photo en direct

Enregistrez ['action avant et apres avoir pris une photo.

Affichage d'un quadrillage pour prendre des photos ou

Grille enregistrer des vidéos sur la base de lignes de référence
horizontales et verticales.
Vous permet de prendre une photo en disant « Cheese »,
Capture vocale

« Smile », « Whisky » « Kimchi » ou « LG ».

Ajouter une
signature

Affichez une signature personnalisée sur les photos.

Emplacement

Enregistrez l'image avec les données GPS associées.

Sélectionnez si vous souhaitez stocker les images et les vidéos

Stockage sur la Mémoire interne ou une Carte SD. (Disponible si une carte
mémoire est insérée.)
Aide Fournit de 'aide pour chaque menu de la caméra.
Options supplémentaires de la caméra frontale

Correction des
distorsions de
selfie

Corrige les parties déformées du visage.

Inverser et
Enregistrer

Enregistre les selfies pris en images inversées.

Prise de vue
Selfie

Prenez un selfie en sélectionnant [option Cliché pris avec un
geste de la main ou Prise de vue automatique.

E « Vous pouvez appliquer leffet magquillage lorsque vous prenez un selfie a

laide de la

caméra frontale.

« Le Cliché pris avec un geste de la main est pris en reconnaissant la forme

de lamain
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Choix du mode
Vous pouvez choisir facilement parmi les modes affichés a [écran lesquels
sont sélectionnés pour s'adapter a |'environnement de |a prise de vue.

Appuyez sur (&) et passez entre les modes de la caméra, ou balayez [écran
vers la gauche ou la droite pour sélectionner un mode caméra.

< nimp

|
l

Modes caméra
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Utiliser les modes de la caméra

Enregistrement vidéo

T Appuyez sur (&) et sélectionnez Vidéo en passant entre les modes de la
caméra.

2 Appuyez sur e pour enregistrer une vidéo.

Ajuster la caméra —e «—— Ajuster/Supprimer le
] ] parametre de flash
Appliquer leffet filtre

Sélectionner la résolution de
[écran

Activer/Désactiver la —
stabilité de la caméra

e—— Sélectionner le zoom
Apercu ——— *—— Basculer a la caméra
I frontale/arriere

L———————— Enregistrement vidéo

- Pour prendre une photo tout en enregistrant une vidéo, appuyez sur
©.

- Pour mettre en pause lenregistrement vidéo, appuyez sur (11). Pour
reprendre lenregistrement vidéo, appuyez sur e .

+ Pendant l'enregistrement d'une vidéo, vous pouvez étendre ou pincer
deux doigts pour effectuer un zoom avant ou arriere.

+ Pendant l'enregistrement d'une vidéo, vous pouvez appuyer sur la zone
souhaitée pour régler la luminosité.

« Vous passez entre ['appareil photo avant et arriére tout en enregistrant
une vidéo en appuyant sur {o}.

3 Appuyez sur (= pour arréter lenregistrement vidéo.
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E « Vous pouvez économiser de lespace de stockage en ajustant [option
Enregistrer au format HEVC dans $3. Cela compresse le fichier vidéo en
format HEVC.

« Dfautres appareils peuvent ne pas prendre en charge les fichiers vidéo en
format HEVC.

Prendre une photo

Appuyez sur (&) et sélectionnez Photo en passant entre les modes de la
caméra.

Consultez Prendre une photo pour plus de détails.

Prise de portraits

Vous pouvez prendre des photos faisant ressortir le sujet et en brouillant

[arriere-plan.

T Appuyez sur (&) et sélectionnez Portrait en passant entre les modes de
la caméra.

+ Sélectionnez un effet souhaité en passant entre les options deffet
pour Portrait.

- Appuyez sur & pour ajuster la valeur douverture.
2 Appuyez sur () pour prendre une photo.

Ajuster la caméra — o—— Sélectionner le paramétre
. I I de chronometre
Choisir le format décran Régler la valeur douverture

«— Sélectionnez une

option deffet pour
portrait.
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E + Quand vous voyez le message « Portrait est disponible. » commencez a
prendre une photo.

« La fonction Portrait peut ne pas fonctionner si 'appareil photo ne reconnait
pas le sujet.

« Lorsque vous prenez une photo, gardez une distance de 1,3 a 5 pieds par
rapport a votre sujet.

« Cette fonction n'est pas disponible si 'environnement est trop sombre.

Utiliser un autocollant

Vous pouvez appliquer une variété dautocollants a vos photos ou vidéos.

Vous pouvez créer des contenus plus riches en utilisant leffet 3D AR.

T Appuyez sur (&) et sélectionnez Autocollant en passant entre les modes
de la caméra.
+ Sélectionnez l'autocollant de votre souhait en passant entre les

autocollants.

2 Appuyez sur( | pour prendre une photo, ou sur . de maniére prolongée

pour enregistrer une vidéo.

« |l nest pas possible de passer entre les caméras avant et arriere
pendant lenregistrement d'une vidéo.
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3 Appuyez sur = pour arréter lenregistrement vidéo.
- Laphoto ou la vidéo est stockée dans la Galerie.

Ajuster la caméra —

Choisir le format décran —

E - Appuyez sur @ pour utiliser Sticker AR 3D.

Consultez Effet 3D
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Utiliser les modes supplémentaires de caméra
Appuyez sur (&) et sélectionnez Plus en passant entre les modes de la
caméra.

Vue nocturne

Vous pouvez prendre des photos précises et nettes de nuit. La Vue nocturne
démarre automatiquement lorsque vous prenez une photo dans des
conditions de faible éclairage.

Vous pouvez aussi prendre manuellement des scenes de nuit claire a laide de
la fonction Vue nocturne.
1 Appuyez sur (&) et sélectionnez Plus en passant entre les modes de la
caméra.
2 Appuyez sur (S
- Sélectionnez un zoom depuis @9 / @3.
3 Appuyez sur () pour prendre une photo.
- Pour ajuster la luminosité de la photo, faites glisser & sur la gauche

ou la droite.
Ajuster la caméra —¢ *— Sélectionner le parametre
o de chronometre
Choisir le format décran ——

+—— Ajuster la luminosité

E + Maintenez vous ferme pour que la caméra ne bouge pas pendant |a prise
d'une photo.
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Panorama
Vous pouvez prendre une photo panoramique en balayant la scene dans un
sens ; l'appareil photo juxtaposera les prises de vue continues.

T Appuyez sur (&) et sélectionnez Plus en passant entre les modes de la
caméra.

2 Appuyez sur ]

+ Sélectionnez un zoom depuis @9 / €.
3 Appuyez sur et déplacez lentement lappareil photo dans un sens.
A Appuyez sur @ pour arréter la prise de vue panoramique.

Ajuster la caméra —'::l

E + Quand vous déplacez la caméra dans un sens, vérifiez que [écran de la prise
ne sort pas des lignes de guidage.
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Caméra manuelle

De nombreuses fonctionnalités avancées vous permettent de créer des
photos daspect professionnel.

T Appuyez sur (&) et sélectionnez Plus en passant entre les modes de la
caméra.

2 Appuyez sur &),

3 Personnalisez les paramétres de l'appareil photo suivants.

+ Sélectionnez un zoom depuis @9 / 3.

+ Sivous ajustez les options sur Auto, les options sont
automatiquement ajustées en fonction de |a cible et de
lenvironnement de prise.

Si loption Focus peaking est cochée, la zone de mise au point est mise
en avant en couleur. Cette fonction est disponible uniqguement en mode

Focus (MF).
Ajuster la caméra ——e e—— Sélectionner le paramétre de
] ] chronometre
Choisir le format décran Régler le paramétre de flash

Appliquer leffet filtre —

Réinitialiser les ————————¢ o— Afficheles
parametres différentes
options Graphy
! 1
Ajuster la balance ———
des blancs I— Ajuster la vitesse
dobturation
Ajuster la mise
au point Ajuster la
AJUSEET la sensibilité ISO
luminosité

4 Appuyez sur () pour prendre la photo.
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+ Sivous appuyez sur (®) et sélectionnez un effet Graphy photos, une liste
des photos recommandées avec plusieurs options saffichent.

+ Choisir les effets Graphy vous permet de prendre des photos en utilisant
la balance des blancs, la vitesse dobturation et les valeurs de réglage ISO
appliquées a la photo recommandée.

« Cette fonction est disponible uniquement en mode Appareil photo manuel.
« Vous pouvez voir une grande variété de photos recommandées si vous
téléchargez l'application Graphy photos depuis Google Play Store.

« Lutilisation de données peut vous étre facturée selon le forfait auquel vous
avez souscrit.

- Appuyez sur §83, ensuite sur @ ) & partir du menu Graphy photo pour
désactiver cette fonctionnalité.

Personnalisation des options de ['appareil photo

Vlous pouvez personnaliser de nombreuses options de lappareil photo selon

vos préférences.

Appuyez sur §3 dans Caméra manuelle.

Taille de la
photo

Vous permet de choisir la taille de la photo et sa résolution.

Enregistrer en
tant que RAW

L'image est enregistrée au format RAW afin que vous puissiez la
modifier.

Les fichiers DNG et JPEG sont créés au moment de prendre une
photo, puis sauvegardé en tant qu'image a haute résolution non
compressée.

Correction des
distorsions

de plan ultra
large

Corrige les distorsions de [écran lors de la prise de photos a angle
ultra large.

Graphy photo

Réglez la balance des blancs, 1SO et la vitesse dobturation pour la
photo recommandée.

Consultez la section Caméra manuelle pour plus d'informations.
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Guide

Affichage d'un quadrillage pour prendre des photos sur la base
de lignes de référence horizontales et verticales.

Ajouter une
signature

Affichez une signature personnalisée sur les photos.

Emplacement

Enregistrez limage avec les données GPS associées.

Sélectionnez si vous souhaitez stocker les images et les vidéos

Stockage sur la Mémoire interne ou une Carte SD. (Disponible si une carte
mémoire est insérée.)
Aide Fournit de 'aide pour chaque menu de la caméra.
Slow motion

Créez une vidéo amusante en changeant la vitesse du mouvement. Cette
fonction est utile si vous souhaitez reproduire une vidéo a une vitesse
inféreure a la vitesse actuelle du clip dorigine.

T Appuyez sur (@ et sélectionnez Plus en passant entre les modes de la

caméra.

2 Appuyez sur @.
3 Sélectionnez un intervalle Q ou & pour lui appliquer leffet slow motion.

« Partie au ralenti : Vous permet d'appliquer leffet slow motion a une
section spécifique de la vidéo.

- Appuyez sur © au moment ol vous souhaitez appliquer leffet de
ralenti. Avec un bref appui, l'effet de ralenti sappliquera pendant
0,5 seconde. Avec un appui long, leffet de ralenti sappliquera
jusquiau retrait de votre doigt.

- Toute la Slow motion : Vous permet dappliquer leffet slow motion a
toute la vidéo.
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Parametres ——e +—— Régler le parametre de flash

Sélectionner un intervalle —41

4 Appuyez sur () pour filmer une vidéo.

- Pour mettre en pause lenregistrement vidéo, appuyez sur (;
reprendre lenregistrement vidéo, appuyez sur e .

5 Pour stopper la prise de vue, appuyez sur (= .

YouTube Live

Vous pouvez enregistrer une vidéo et la charger directement sur YouTube.
Pour utiliser cette fonctionnalité, vous devez satisfaire les exigences
déligibilité. Contactez YouTube pour connaitre les exigences.

T Sur lécran d'accueil, appuyez sur (&).

2 Sélectionnez Plus en passant entre les modes de caméra, puis appuyez
sur (o).

5 « YouTube Live est disponible uniquement lorsque votre appareil est connecté

alnternet. Si vous utilisez des données mobiles, vous pouvez étre facturé
selon le forfait auquel vous avez souscrit.
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Fonctions utiles de la caméra

Prendre une photo avec la fonction Al

Quand vous prenez une photo, la fonction Al reconnait un sujet et applique le

meilleur effet a la photo.

E « Appuyez sur' pour désactiver la fonction Al

Verrouillage d'exposition automatique/mise au point
automatique

Vous pouvez corriger le niveau dexposition et [a position de mise au point
actuels en restant appuyé sur [écran en mode auto. Pour désactiver cette
option, appuyez sur une zone vierge de ['écran.

Verrouillage
d'exposition
automatique
/mise au point
automatique

E « Cette fonction est disponible uniguement dans certains modes.
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Passage en mode appareil frontal/arriére
Vous pouvez basculer entre les appareils photo frontal et arriére pour vous
adapter a votre environnement.
+ Pour basculer entre les appareils photo frontal et arriere, balayez [écran
vers le haut ou le bas sur [écran de prise dans lapplication Caméra.

<= @ mp

E « Utilisez lappareil photo frontal pour prendre des selfies. Consultez la section
Prise de vue Selfie pour plus d'informations.

Zoom avant ou arriere

Vous pouvez étendre ou pincer deux doigts pour effectuer un zoom avant ou
arriere lorsque vous prenez une photo ou une vidéo.

E « Lafonction zoom avant/arriére nest pas disponible dans le mode selfie

(caméra frontale).
« Cette fonction n'est pas prise en charge dans un certain nombre de modes.
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Utiliser le premier plan
Vous pouvez faire des photos daffilée et les voir comme s'il sagissait
d'images mobiles dans la Galerie.
T Appuyez sur (&) et sélectionnez Photo.
7 Maintenez enfoncé
« Plusieurs photos daffilée sont prises pendant que vous appuyez sur

Cliché pris avec un geste de la main
Vous pouvez prendre des selfies en effectuant des gestes.
Montrez la paume de votre main a la caméra frontale puis serrez votre poing.
Vous pouvez également serrer le poing et ['ouvrir en direction de la caméra
frontale.

+ Une photo est prise dans les trois secondes.

o

z D

m

E « Pour utiliser cette fonction, passez en mode caméra frontale, puis appuyez
sur §63 > Prise de vue Selfie > Cliché pris avec un geste de la main.
+ Veillez a ce que votre paume et votre poing se trouvent au niveau de la ligne
de référence pour que lappareil photo puisse les détecter.
« Cette fonction peut ne pas étre disponible selon les fonctions de la caméra
déja en cours d'utilisation.
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Prise de vue automatique

Vous pouvez utiliser la fonction de détection de visage pour prendre des
selfies de maniere facile et pratique. Vous pouvez régler ['appareil de maniere
a ce que lorsque vous regardez 'écran, l'appareil photo frontal détecte votre
visage et prenne un selfie automatiquement.

+ Le cadre blanc apparait lorsque la caméra frontale détecte votre visage. Si
le sujet dans le cadre cesse de bouger, le cadre devient jaune, et la caméra
prend une photo.

E « Appuyez sur @ > Prise de vue Selfie > Prise de vue automatique pour
activer la prise de vue automatique.

Intervalle de prises de vue
Vous pouvez prendre des selfies a un intervalle donné.

Sivous utilisez lappareil photo frontal, vous pouvez montrer la paume de
votre main a lappareil photo puis serrez votre poing deux fois rapidement.

+ Quatre photos sont prises a intervalles réguliers apres un compte a
rebours de trois secondes.

Inverser et Enrengistrer

Avant de prendre une photo avec la caméra frontale, appuyez sur §63 >
Inverser et Enrengistrer. Limage est inversée a ['horizontale.

E « Lorsque vous utilisez la caméra frontale, vous pouvez changer la facon
dont les selfies sont pris dans les options de appareil photo. Voir
Personnalisation des options de [appareil photo pour plus de détails.

Prise de vue Selfie

Vous pouvez utiliser appareil photo frontal pour voir votre visage sur [écran

et prendre des selfies.

T Appuyez sur (&) et sélectionnez Photo en passant entre les modes de la
caméra.

2 Appuyez sur {0 pour passer a la caméra avant.
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3 Appuyez sur () pour prendre des photos.
- Appuyez sur §) pour appliquer plusieurs effets esthétiques.

Galerie

Présentation de la Galerie
Vous pouvez visualiser et gérer les photos et vidéos enregistrées sur votre
appareil

Affichage des photos
Vous pouvez afficher les photos enregistrées du produit.
T Appuyez sur [ et sélectionnez le dossier souhaité.

7 Appuyez sur une photo de votre choix.
+ Le dossier Galerie contient des Photo, des Albums, des Souvenirs, et

des Lire.
1— Lancez Recherche sur la vision.
Retour a [écran précédent. — ~— Accéder aux options
supplémentaires.
»— Apercu Galerie
Ajouter aux/retirer des favoris. —e *— Supprimer des images.

Partager des images.
Modifier des images.
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E + Lemenu des détails saffiche sur un |éger appui de [écran. Un deuxieme
appui sur [écran fait disparaitre le menu.

Lecture d'une vidéo
Vlous pouvez afficher les vidéos enregistrées sur le produit.

Retour a lécran —s — Accéder aux options
précédent. supplémentaires.

Suspendre ou lire la ————
vidéo.

»— Apercu Galerie

U Supprimer des images.

Ajouter aux/retirer des —
favoris.

Partager des images.
Modifier des images.

E « Pour régler le volume sonore, faites glisser le coté droit de [écran vidéo vers
le haut ou vers le bas.
« Pour régler la luminosité de [écran, faites glisser le c6té gauche de [écran
vidéo vers le haut ou vers le bas.
« En faisant glisser [écran vers la gauche de [écran de lecture vidéo, vous
pouvez aller en arriere (REW) et vers la droite, vous pouvez avancer la vidéo
(FF).
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Suppression de fichiers
Pour supprimer des fichiers, utilisez ['une des options suivantes :
+ Appuyez sur un fichier de la liste de facon prolongée, puis appuyez sur
Supprimer.
- Les fichiers supprimés sont automatiquement déplacés a la : > Corbeille
et ils peuvent étre restaurés dans la Galerie pendant 7 jours.

- Appuyez sur [x] pour définitivement effacer les fichiers. Dans ce cas, ils ne
pourront plus étre restaurés.

Partage de fichiers
Pour partager des fichiers, utilisez ['une des options suivantes :

- Pendant le visionnage d'une photo ou d'une vidéo, appuyez sur &< pour
partager le fichier a laide de la méthode de votre choix.

E - Sivous prenez des photos ou des vidéos aprés avoir appuyé sur (8> §63 >
Emplacement @ ), lalbum de souvenirs est automatiquement créé a un
emplacement spécifique apres un certain temps dans longlet Mémoires de
la Galerie.

« Vous pouvez rechercher les photos ou les vidéos par endroit, étiquette,
mode caméra, etc. en appuyant surQ dans la galerie.

« Certains formats de fichiers peuvent ne pas étre pris en charge en fonction
du logiciel installé.

+ Un encodage peut empécher louverture de certains fichiers.
« Les fichiers qui dépassent |a taille limite peuvent causer une erreur.
« Vous devez activer la fonction GPS pour créer des albums de mémoire.

Création d'un collage
Vous pouvez créer un collage a partir du contenu associé.
T Appuyez sur [ et sélectionnez + > Effectuer collage.

2 Sélectionnez les images que vous souhaitez ajouter au collage, puis
appuyez sur Effectuer collage.

+ Sélectionnez la disposition souhaitée depuis le bas de [écran.
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3 Appuyez sur Créer.

5 «+ Un collage peut étre créé a partir d'un maximum de 9 images.

Création d'un film
Vous pouvez créer un nouveau film en assemblant des images et des vidéos.
1 Appuyez sur ¥ et sélectionnez + > Créer un film.

2 Sélectionnez des images ou vidéos pour votre film, puis appuyez sur
Créer un film.

3 Modifiez les images et les vidéos sélectionnées, puis appuyez sur
Enregistrer.

——— Mise en effet des
[ fichiers
Réinitialisation des
fichiers

Prévisualisation d'un
fichier

Suppression de ———
fichiers

Ajout de fichiers

E « Un film peut étre créé a partir d'un maximum de 50 vidéos.
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Création d'un GIF
Vous pouvez facilement créer un fichier GIF a laide d'une vidéo enregistrée.
Appuyez sur 3 et sélectionnez Création d'un GIF.

Créer une vidéo

T Au point de départ souhaité en regardant une vidéo, appuyez sur @
2 Sélectionnez la longueur du GIF que vous voulez créer.
« Le fichier GIF est généré pour la durée sélectionnée a partir du point de
départ indiqué.
- Pour les vidéos de moins de 5 secondes, les images GIF sont
automatiquement générées pour la durée restante.

Créer des photos GIF

1 Dans la liste des photos de la galerie, appuyez sur + > Créer un GIF.

2 Sélectionnez une image pour la transformer en GIF, puis appuyez sur
Créer un GIF.

- \ous pouvez ajouter/supprimer une photographie, régler la vitesse ou
le format décran, ajuster la séquence de photographie.

E « Créer des photos GIF est une fonction fournie pour que l'utilisateur
réalise des images créatives. Violer des droits tels que le droit de propriété
intellectuelle ou diffamer la réputation d'un tiers a l'aide de la fonction de
création de GIF peut entrainer des responsabilités civiles ou pénales en
vertu des lois concernées. \eiller a ne pas copier ou transmettre le travail
d'une autre personne sans son autorisation. LG Electronics nest en aucun
cas responsable des actes commis par les utilisateurs.

« Vous pouvez sélectionner la production de jusqua 100 photos lorsque vous
créez un GIE
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Répertoire

Présentation du répertoire
Vous pouvez enregistrer et gérer vos contacts.
Sur [écran daccueil, appuyez sur Essentiels > Répertoire.

Ajout de contacts

Ajouter de nouveaux contacts

T Sur lécran du répertoire, appuyez sur -

+ Une fenétre pop-up saffiche pour choisir lemplacement
denregistrement du contact. Sélectionnez lemplacement que vous
voulez.

2 Entrez les coordonnées du contact et appuyez sur Enregistrer.

Importation de contacts
Vous pouvez importer des contacts depuis un autre périphérique de stockage.
T Surl'écran du répertoire, appuyez sur : > Gérer les contacts > Importer.

2 Sélectionnez les emplacements source et cible du contact a importer, puis
appuyez sur OK.

3 Sélectionnez des contacts et appuyez sur Importer.

Ajouter de contacts a la liste de numérotation rapide
1 Surl'écran du répertoire, appuyez sur + > Numéros rapides.

7 Appuyez sur Ajouter un contact a partir d'un numéro rapide.

3 Sélectionnez un contact.

E « Lorsque vous ajoutez un nouveau contact, appuyez sur [ pour ajouter un
numéro rapide.
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Recherche de contacts
Vous pouvez rechercher des contacts en utilisant ['une des options suivantes :

+ Appuyez sur la barre de recherche en haut de écran du répertoire et
saisissez le contact ou le numéro de téléphone que vous souhaitez
rechercher.

- Faites défiler la liste de contacts vers le haut ou vers le bas.

+ Depuis lindex de [écran de a liste de contacts, tapez la premiére lettre du
nom du contact.

5 « Appuyer sur la barre de recherche en haut de [écran du répertoire, et
introduire un contact ou un numéro de téléphone fait apparaitre les
résultats de recherche intégrés depuis [historique des appels et la liste de
contacts enregistrée dans le produit.

Liste de contacts

Modification des contacts
1 Sélectionnez un contact sur lécran de la liste de contacts.

2 Sur [écran des coordonnées du contact, appuyez sur /° et modifiez ses
coordonnées.

3 Appuyez sur Enregistrer pour enregistrer les modifications.

Suppression de contacts
Pour supprimer des contacts, utilisez ['une des options suivantes :
+ Sur l'écran des contacts, restez appuyé sur un contact que vous souhaitez
supprimer, puis appuyez sur [i1].
+ Appuyez sur ¢ > Supprimer sur 'écran des contacts.

5 « Les contacts supprimés peuvent ne pas étre restaurés.
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Ajouter de favoris

Vous pouvez enregistrer les contacts que vous appelez fréquemment dans
vos favoris.

1 Sélectionnez un contact sur [écran de la liste de contacts.

2 Sur lécran des coordonnées du contact, appuyez sur ¥.

Création de groupes
1 Dans la liste de groupes de contact, appuyez sur -+
Saisissez un nom pour ce nouveau groupe.

2

3 Appuyez sur Ajouter des membres, sélectionnez des contacts, puis
appuyez sur Ajouter.

4

Appuyez sur Enregistrer pour enregistrer le nouveau groupe.

QuickMemo+

Présentation de QuickMemo+

Vous pouvez concevoir des notes créatives a l'aide de nombreuses options
sur ce bloc-note aux fonctions avancées, comme la gestion des images

et captures d'écran, qui ne sont pas prises en charge par le bloc-note
conventionnel.

Cet appareil prend en charge le stylet actif AES2.0 (électrostatique actif).

Création d'une note
1 Sur[écran d'accueil, appuyez sur Essentiels > QuickMemo+.
7 Appuyez sur @ pour créer une note.

- @ :Enregistrement d'une note.

< :Annuler la derniere modification.

(7 :Rétablir les modifications récemment supprimées.

+ (T :Rédaction d'une note a l'aide du clavier.

- 9 :Enregistrement de vos types de stylet préférés.

-/ :Rédaction de notes a la main.
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- A :Effacement des notes manuscrites.

+ ¢ :Changement a la police de calligraphie quand vous écrivez a la
main.

« & :Accéder aux options supplémentaires.
3 Appuyez sur @ pour enregistrer la note.

Annotation d'une capture d'écran
1 Tout en affichant 'écran que vous souhaitez capturer, faites glisser la
barre d'état vers le bas, puis appuyez sur @.
« LBcran est capturé et affiché comme miniature en bas a droite de
[écran.
2 Pour rédiger des notes a [écran, appuyez sur 2.,
3 Ecrire des notes avec les outils.
- T3 : Zoom avant ou arriere, ou ajustement de la zone pour capturer.
/ :Rédaction de notes a la main.
- & Effacement des notes manuscrites.
« <5 :Annuler la derniére modification.
+ (7 :Rétablir les modifications récemment supprimées.
« (35 :Rogner lécran a votre choix.
4 Appuyez sur </ et enregistrez les notes.
- Les notes enregistrées peuvent étre visualisées dans Galerie.
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Fonctions supplémentaires aprées avoir fait une capture
d'écran

—— Appuyer pour capturer [écran
entier avec la fonction de
capture de défilement.

«—————— Appuyer pour enregistrer [écran.

Appuyer pour écrire des notes Appuyer pour supprimer [écran
sur ['écran capturé. capturé.
1
Appuyer pour partager [écran ——
capturé.

Vous pouvez capturer [écran entier avec la fonction de capture de
défilement.

5
+ Quand vous utiliser une application comme la Messagerie ou Chrome, faites
glisser le panneau de notifications vers le bas puis appuyez sur 0 Appuyez
ensuite sur :»»: pour capturer tout [écran que vous étes en train de voir
comme un unique fichier.
« Cette fonction est disponible uniquement sur certaines applications prenant
en charge la fonction de capture de défilement.

« Pincez deux doigts ou écartez les doigts pour changer la disposition du
mémo.
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Horloge

Alarme

Vous pouvez définir une alarme pour quelle se déclenche a une heure précise.
7 Sur [écran daccueil, appuyez sur Essentiels > Horloge > Alarme.

2 Appuyez sur - pour ajouter une nouvelle alarme.

3 Configurez les paramétres de lalarme et appuyez sur Enregistrer.

E « Sivous sélectionnez une alarme précédemment réglée, vous pouvez la
modifier.

- Pour supprimer une alarme, appuyez sur s > Supprimer en haut de [écran.
Autrement, maintenez le doigt appuyé sur lalarme.

Fuseaux horaires
Vous pouvez voir 'heure actuelle dans dautres villes du monde.

7 Sur [écran daccueil, appuyez sur Essentiels > Horloge > Fuseaux
horaires.

2 Appuyez sur - et ajoutez une ville.
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Minuteur

Vous pouvez régler le minuteur pour déclencher une alarme lorsque le délai
défini slest écoulé.

7 Sur [écran daccueil, appuyez sur Essentiels > Horloge > Minuteur.

2 Définissez I'heure et appuyez sur Démarrer.

+ Pour suspendre le minuteur, appuyez sur Pause. Pour relancer le
minuteur, appuyez sur Reprendre.

3 Appuyez sur Arréter pour arréter [alarme du minuteur.

Chronométre
Vous pouvez utiliser le chronometre pour enregistrer un temps par tour.
1 Surlécran daccueil, appuyez sur Essentiels > Horloge > Chronométre.
2 Appuyez sur Démarrer pour lancer le chronomeétre.
+ Pour enregistrer un temps par tour, appuyez sur Tour.
3 Appuyez sur Pause pour suspendre le chronométre.
« Pour relancer le chronometre, appuyez sur Reprendre.

- Pour effacer tous les enregistrements et relancer le chronometre a
zéro, appuyez sur Réinit.
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Musique

Vous pouvez jouer ou gérer des chansons et albums musicaux.

1 Sur [écran daccueil, appuyez sur Essentiels > Musique.

72 Sélectionnez une catégorie.
3 Sélectionnez un fichier de musique.

Allurner/éteindre la lumiére du
flash
Définir des effets sonores.

Retour a [écran précédent. —s

Appuyer pour lire le fichier —
actuel depuis le début/Appuyer
deux fois pour lire le fichier
précédent/Appuyer et maintenir
pour un retour rapide.

Lire de fagon aléatoire. ——I

Ajustez le volume sonore. —

—— Accéder aux options

supplémentaires.

— Pause/lecture.

— Appuyer pour lire le fichier
suivant/Appuyer et maintenir
pour une avance rapide.

L— Sélectionner un mode répétition.

L]

— Accéder a Liste de lecture en

L
Ajouter aux/supprimer des ——— |
favoris.

Applications utiles

cours.

116



« Certains formats de fichiers peuvent ne pas étre pris en charge en fonction

du logiciel installé.

« Les fichiers qui dépassent |a taille limite peuvent causer une erreur.
« Les fichiers musicaux peuvent appartenir a leurs détenteurs et étre

protégés par les lois internationales sur les droits dauteur. Lobtention
d'une autorisation légale peut-étre nécessaire avant la copie d'un fichier de
musique. Avant de télécharger ou de copier un fichier de musique, prenez
connaissance de la loi sur les droits dauteur applicable dans le pays.

+ Ce modele prend en charge la lecture audio haute fidélité. Une icone Hi-Fi

figure sur les fichiers audio haute fidélité.

« Sivous ajustez le flash, le flash clignote pour sadapter a la musique

reproduite.

Calculatrice

Vous pouvez effectuer vos calculs a laide d'une calculatrice ordinaire ou
scientifique.

7 Sur [écran daccueil, appuyez sur Essentiels > Calculatrice.

2 Utilisez le clavier pour effectuer un calcul.
+ Sivous voulez faire le calcul depuis le début, maintenez enfoncé {X]

ThinQ

Vous pouvez connecter facilement le produit a des appareils IdO pour les
surveiller et les utiliser facilement.

Sur [écran d'accueil, appuyez sur Essentiels > ThinQ

5

« Lelave-linge, le séche-linge, le styler, le lave-vaisselle, le four et le robot de

nettoyage ne peuvent étre enregistrés que si le produit est en mode veille.

+ Rechercher la marque ThinQ sur le produit pour voir s'il peut étre connecté

a lapplication ThinQ.

« Appuyez sur = pour vérifier les différentes fonctions de (application ThinQ.
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LG Health

Vous pouvez gérer votre santé et adopter de bonnes habitudes en termes
d'exercice physique en enregistrant les exercices que vous effectuez.

Mise en route de LG Health

Vous pouvez configurer LG Health lors du premier démarrage de 'application
ou apres sa réinitialisation.

1 Surlécran daccueil, appuyez sur Essentiels > LG Health.

7 Suivez les instructions a [écran pour terminer la configuration.

Utilisation de LG Health

Vous pouvez visualiser les principales informations sur LG Health et gérer la
quantité d'activité physique et les informations sur votre santé.

7 Sur [écran daccueil, appuyez sur Essentiels > LG Health.
7 Les options suivantes sont disponibles.
+ — :Consultez votre journal d'exercices du jour que vous souhaitez
vérifier :
- © :Commencez d'enregistrer un exercice. Le parcours et la durée de
l'exercice physique sont enregistrés pour chague type d'exercice.

-+ :Définissez vos objectifs d'exercice quotidien, y compris les calories
dépensées et votre nombre de pas, ou définissez différents parametres
de LG Health.

E « Les informations relatives a la santé fournies par LG Health sont destinées a
l'usage de ['utilisateur et ne doivent pas étre utilisées a quelque fin médicale
que ce soit (prévention, traitement, diagnostic, etc.).

+ LG Health peut varier ou ne pas étre disponible en fonction du pays et de
lopérateur. Les fonctions LG Health disponibles et les applications pouvant
étre ajoutées a LG Health peuvent varier d'un pays a autre. en fonction des
lois et réglementations locales.
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HD Audio Recorder

HD Audio Recorder permet de configurer les parametres audio manuellement
pour enregistrer des fichiers audio en fonction de votre environnement.
Modes d'enregistrement

Vous pouvez enregistrer un fichier audio haute définition en sélectionnant
et configurant le mode audio souhaité pour qu'il corresponde a votre
environnement denregistrement.

Sur [écran d'accueil, appuyez sur Essentiels > HD Audio Recorder >=.

Normale
Vous pouvez enregistrer de |'audio sans parametres particuliers.

ASMR
Vous pouvez enregistrer un son ASMR.

Concert

Vous pouvez enregistrer de l'audio lors d'un concert ou autre événement
musical.

Personnalisée

Vous pouvez configurer manuellement les paramétres désirés pour
lenregistrement audio.

Mode Studio

En mode studio, vous pouvez lire un fichier audio ou de la musique et
enregistrer votre voix en méme temps, créer un cheeur en enregistrant votre
voix plusieurs fois et enregistrer vos commentaires sur ceux du présentateur
ou orateur du fichier audio dorigine.

T Surlécran d'accueil, appuyez sur Essentiels > HD Audio Recorder > =
> Personnalisée.

Appuyez sur d 4.
Sélectionnez un fichier audio a utiliser comme musique de fond.
Appuyez sur . pour enregistrer votre Voix.

u b wN

Appuyez sur @ pour sauvegarder 'enregistrement.
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De la musique ne peut étre jouée en arriere-plan que via des écouteurs.
Assurez-vous d'avoir raccordé des écouteurs a votre appareil avant de vous
servir de cette fonction.

i

Pour modifier d'autres parametres, appuyez sur > Parameétres, puis
personnalisez le type de fichier, profondeur de bits, taux déchantillonnage et
autres parametres.

Quand vous sélectionnez le mode Concert ou Personnalisé avec des
écouteurs connectés, (), Saffiche. Appuyez sur Uy et sélectionnez le
microphone a utiliser.

Vous pouvez surveiller la qualité sonore via les écouteurs connectés
pendant que vous enregistrez de laudio. Lorsque vous enregistrez de laudio
en mode studio, le contréle du son nest pas pris en charge. Vous ne pouvez
entendre que la musique de fond.

Lanceur De Jeu

Vous pouvez définir si vous souhaitez utiliser le Lanceur de Jeu dol vous
pouvez voir a liste des jeux installés dans le produit, et sélectionnez les
parameétres de jeu comme couper le son du volume multimédia, limiter les
alertes, etc.

7 Sur [écran daccueil, appuyez sur Lanceur De Jeu.

7 Sélectionnez l'option désirée.

Smart Doctor

Vous pouvez utiliser la fonction Smart Doctor pour diagnostiquer [état de
lappareil et loptimiser.
Sur [écran d'accueil, appuyez sur Gestion > Smart Doctor.
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LG Mobile Switch

Transférez facilement des données de votre ancien appareil vers votre nouvel
appareil via LG Mobile Switch.

1 Surlécran daccueil, appuyez sur Gestion > LG Mobile Switch.
Vous pouvez aussi appuyer sur Paramétres > Systéme > Sauvegarder >
LG Mobile Switch.
« Silapplication n'est pas installée sur le produit, téléchargez et installez
l'application LG Mobile Switch depuis le Google Play Store.
2 Suivez les instructions qui saffichent a [écran pour sélectionner la
méthode souhaitée pour le transfert.

E + Les données d'un compte Google ne sont pas sauvegardées. Lorsque vous
synchronisez votre compte Google, vos applications Google, vos contacts
Google, votre calendrier Google ou votre bloc-notes Google, les données et
applications téléchargées sur le Play Store sont automatiquement stockées
dans lapplication Drive.

+ Rechargez completement la batterie avant de procéder au transfert de
données afin déviter une mise hors tension involontaire durant le processus.

Corbeille des apps

Vous pouvez voir (a liste des applications supprimées de ['écran d'accueil.
L'application qui a été supprimée dans les 24 heures précédentes peut étre
récupérée.

Sur [écran d'accueil, appuyez sur Gestion > Corbeille des apps.

Pour en savoir plus, consultez Corbeille des apps.
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SmartWorld

Vous pouvez télécharger de nombreux jeux, contenus audio, applications et
polices de caractéres fournis par LG Electronics. Personnalisez votre appareil
selon vos préférences en utilisant des themes d'accueil, des themes de clavier
et des polices de caractere.

E « Sivous utilisez des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit.

- Cette fonctionnalité peut ne pas étre prise en charge en fonction de la
région ou de l'opérateur de téléphonie.

7 Sur [écran daccueil, appuyez sur Services > SmartWorld.
7 Appuyez sur : >LG Comptes, puis connectez-vous.
3 Sélectionnez et téléchargez les éléments de contenu souhaités.

Téléchargement de l'application Smart\World

Si lapplication SmartWorld nest pas installée, procédez comme suit pour la
télécharger.

1 Surlécran daccueil, appuyez sur Paramétres > Systéme > Centre de
mises a jour > Mise a jour des applications.

2 Surlaliste, sélectionnez SmartWorld et appuyez sur Télécharger.
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RemoteCall Service

Votre appareil peut étre diagnostiqué a distance pour la résolution des
problemes. Appelez d'abord un centre de service client LG comme suit :

5 « Pour utiliser cette fonction, vous devez d'abord accepter ['utilisation de la
fonction.

« Sivous utilisez des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit.

T Surlécran d'accueil, appuyez sur Services > RemoteCall Service.
2 Appelez le centre de service client LG.

3 Une fois la communication établie, suivez les instructions de lassistant
pour entrer un numéro d'acces a six chiffres.
- Votre appareil est alors connecté et le service d'assistance a distance
commence.

Message de diffusion

Vous pouvez visualiser les messages diffusés en temps réel sur les situations
d'urgence, comme les typhons, les inondations et les tremblements de terre.

Sur [écran d'accueil, appuyez sur Services > Message de diffusion.
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Applications Google

Vous pouvez utiliser des applications Google en paramétrant un

compte Google. La fenétre denregistrement de compte Google apparait
automatiquement lorsque vous utilisez une application Google pour la
premiere fois. Si vous navez pas de compte Google, créez-en un a partir de
votre appareil. Pour plus d'informations sur l'utilisation d'une application,
consultez [Aide dans lapplication.

E « Certaines applications peuvent ne pas fonctionner selon la région ou
lopérateur de téléphonie.

Agenda

L'application d'agenda vous permet de suivre vos événements (ceux que vous
avez créés), classés par jour, période de 3 jours, semaine ou mois.

Chrome

Un navigateur Web rapide, simple et sécurisé, concu pour le WWeb moderne.

Docs

Docs est un outil collaboratif de traitement de texte qui stimule la
productivité. Utilisez Docs pour créer, modifier et travailler ensemble en temps
réel.

Drive

Drive est une application de stockage et de partage de fichiers qui facilite

la recherche, le partage et la collaboration sur des projets de travail de
n'importe ou, instantanément.

Duo

Faites des appels vidéo simples et de haute qualité a vos amis et votre famille
sur les téléphones Android et les iPhones.

Gmail

Gmail est une application de messagerie facile a utiliser qui sécurise vos
messages, rend votre boite de réception plus intelligente et vous aide a rester
organisé.
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Google

L'application Google vous tient au courant des choses qui vous intéressent.
Trouvez des réponses rapides, explorez vos centres d'intérét et retrouvez des
histoires et des mises a jour sur des sujets qui vous intéressent.

Maps

Vous allez quelque part ? Go with Maps, l'application sur laquelle vous pouvez
compter pour la navigation GPS en temps réel, le trafic, le transit, et des
détails sur des millions de lieux, tels que les critiques et les temps populaires.
Photos

Accueil pour toutes vos photos et vidéos, organisé automatiquement afin que
VOus puissiez partager et enregistrer ce qui compte.

Play Films et TV

Utiliser votre compte Google pour louer ou acheter des films. Achetez du
contenu et lisez-le n'importe ou.

YT Music

Un nouveau service de musique en streaming de YouTube.

Sheets

Sheets est un outil collaboratif de traitement de feuille de calcul qui stimule
la productivité. Utilisez Sheets pour importer, organiser et analyser des
informations ensemble en temps réel.

Slides

Google Slides est un outil de création de présentation collaborative qui
stimule la productivité. Utilisez Slides pour organiser les informations,
présenter les résultats et prendre des décisions ensemble en temps réel.

YouTube

Regardez vos chaines préférées, écoutez de la musique que vous aimez et
mettez en ligne des vidéos a partager avec des gens du monde entier.
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Assistant

Votre appareil est équipé de [Assistant Google intégré. Trouvez des réponses
et faites avancer les choses pendant vos déplacements. Pour commencer,
appuyez simplement sur la touche Assistant Google située sur le coté du
téléphone ou appuyez de maniere prolongée sur le bouton principal du
téléphone.

5 « LAssistant Google n'est pas disponible dans certaines langues et certains
pays.

Files
Vous pouvez afficher et gérer des fichiers enregistrés sur votre appareil.
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Parametres

Vous pouvez personnaliser les paramétres de ['appareil, en fonction de vos
préférences.

Sur [écran d'accueil, appuyez sur Paramétres.

E - Sivous saisissez un mot clé dans la fenétre de recherche en haut de [écran,
vous pouvez lancer facilement les éléments a configurer.

Réseau et Internet

Wi-Fi
Vous pouvez vous connecter a des appareils se trouvant a proximité par le
biais d'un réseau Wi-Fi.
Connexion a un réseau Wi-Fi
1 Surlécran parameétres, appuyez sur Réseau et Internet > Wi-Fi.
2 Appuyez sur () ) pour lactiver.
« Les réseaux Wi-Fi disponibles apparaissent automatiquement.
3 Sélectionnez un réseau.
« |l peut vous étre demandé dentrer le mot de passe du réseau Wi-Fi.

+ Vous en serez dispensé toutefois si vous avez déja accédé a ce
réseau \Wi-Fi précédemment. Si vous ne souhaitez pas étre connecté
automatiquement a un réseau Wi-Fi donné, appuyez sur le réseau, puis
appuyez sur Retirer.
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Paramétres du réseau Wi-Fi
Sur [écran parametres, appuyez sur Réseau et Internet > Wi-Fi.

- Passer en données mobiles: Si la fonction de connexion de données
mobiles est activée mais que |'appareil ne peut pas se connecter a Internet
par le Wi-Fi, l'appareil se connecte automatique a Internet via la connexion
de données mobiles.

E « Cette fonction dépend de lopérateur.

-+ :Personnalisation des parametres du réseau Wi-Fi.
Wi-Fi Direct
Vous pouvez connecter votre appareil a d‘autres appareils compatibles Wi-Fi
Direct pour partager des données directement avec eux. \Jous n'avez pas

besoin de point d'acces. Vous pouvez vous connecter a plus de deux appareils
a laide de Wi-Fi Direct.

T Sur lécran paramétres, appuyez sur Réseau et Internet > Wi-Fi> ¢ >
Parameétres Wi-Fi avancés > Wi-Fi Direct.
+ Les appareils compatibles Wi-Fi Direct apparaissent automatiquement.
2 Sélectionnez un appareil.

« La connexion est établie lorsque lappareil accepte la demande de
connexion.

E « Le niveau de la batterie peut baisser rapidement lors de ['utilisation de la
fonction Wi-Fi Direct.
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Données mobiles

Vous pouvez activer et désactiver les données mobiles. Vous pouvez
également gérer ['utilisation des données mobiles.

Activation de la connexion de données mobiles

1 Surlécran parameétres, appuyez sur Réseau et Internet > Données
mobiles.

2 Appuyez sur pour lactiver.

Personnalisation des paramétres de données mobiles

1 Sur[écran parametres, appuyez sur Réseau et Internet > Données
mobiles.

2 Personnalisez les parameétres suivants :

« Activé :Réglage pour utiliser les connexions de données sur les
réseaux mobiles.

- Limiter ['usage des données mobiles: Définissez une limite
d'utilisation des données mobiles.

: :Personnalisez les paramétres de données mobiles.

+ Le volume d'utilisation des données est mesuré en fonction du produit
est peut différer du volume calculé par votre opérateur.

Appels

\ous pouvez personnaliser les parametres dappel, comme les options
dappels audio et dappels internationaux.

E « Certaines fonctionnalités peuvent ne pas étre prises en charge en fonction
de la région ou de l'opérateur de téléphonie.

1 Surlécran parameétres, appuyez sur Réseau et Internet > Appels.
7 Personnalisez les paramétres.
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Partage de connexion

Partager connexion USB

Vous pouvez connecter lappareil a un autre appareil via USB et partager des
données mobiles.

1 Connectez votre appareil a dautres appareils a laide du cable USB.

2 Sur [écran des paramétres, appuyez sur Réseau et Internet > Partage
de connexion > Partager connexion USB puis appuyez sur () ) pour
lactiver.

E « Cette option utilise des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit. Consultez votre opérateur de téléphonie
pour plus d'informations.

« Lorsque vous connectez appareil a un ordinateur; téléchargez le pilote USB
sur le site wwwilg.com et installez-le.

+ Vous ne pouvez pas envoyer ou recevoir des fichiers entre votre appareil
et votre ordinateur lorsque le partage de connexion via USB est activé.
Désactivez le partage de connexion via USB pour envoyer ou recevoir des
fichiers.

« Les systemes dexploitation qui prennent en charge le partage de connexion
sont Windows XP et supérieur, ou Linux.

Point d'accés Wi-Fi

Vous pouvez définir un appareil comme routeur Wi-Fi pour permettre a
d'autres appareils de se connecter a Internet en utilisant les données mobiles
de votre appareil.

1 Sur [écran des parametres, appuyez sur Réseau et Internet > Partage de
connexion > Point d'acceés Wi-Fi puis appuyez sur () ) pour lactiver.

2 Appuyez sur Configurer le hotspot (point d'accés Wi-Fi partagé), puis
saisissez le Nom Wi-Fi (SSID) et le mot de passe.

3 Activez le Wi-Fi sur lautre appareil, puis sélectionnez le nom du réseau de
lappareil dans la liste Wi-Fi.

4 Entrez le mot de passe réseau.
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E - Cette option utilise des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit. Consultez votre opérateur de téléphonie
pour plus d'informations.

« Pour plus d'informations, rendez-vous sur ce site \Web :
http//www.android.com/tether#wifi

Minuteur de désactivation du Point d'acces Wi-Fi

Lorsque le Point d'acces Wi-Fi nest pas utilisé pendant une période
déterminée, il est automatiquement déconnecté. Vous pouvez définir le
moment de la déconnexion automatique.

Partage de connexion Bluetooth
Un appareil connecté via Bluetooth peut se connecter a Internet a laide des
données mobiles de votre appareil.

1 Sur [écran des paramétres, appuyez sur Réseau et Internet > Partage
de connexion > Partage de connexion Bluetooth puis appuyez sur () )
pour lactiver.

7 Activez la connexion Bluetooth sur les deux appareils puis connectez-les.

5 « Cette option utilise des données mobiles, vous pouvez étre facturé selon le
forfait auquel vous avez souscrit. Consultez votre opérateur de téléphonie
pour plus d'informations.

« Pour plus d'informations, rendez-vous sur ce site Web :
http//www.android.com/tether#Bluetooth_tethering

Aide
Vous pouvez consulter aide en ligne au sujet des modems affiliés et des
hotspots.

Sur [écran parametres, appuyez sur Réseau et Internet > Partage de
connexion > Aide.
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Mode Avion

\ous pouvez désactiver les fonctions d'appel et de données mobiles. Lorsque
ce mode est activé, les fonctions n'utilisant pas de données, comme des jeux
et la musique, restent disponibles.

1 Sur[écran parametres, appuyez sur Réseau et Internet > Mode Avion.
7 Appuyez sur Activer sur [écran de confirmation.

Réseaux mobiles

Vous pouvez personnaliser les paramétres des réseaux mobiles.

1 Sur [écran paramétres, appuyez sur Réseau et Internet > Réseaux
mobiles.

2 Personnalisez les paramétres suivants :

- Itinérance de données: Surfer sur Internet, envoyer des MMS et
utiliser la messagerie électronique ainsi que dautres services de
données a [étranger.

- Mode réseau : Sélection d'un type de réseau.

- Noms des points d'acces : Affichage ou modification du point
dacces pour ['utilisation des services de données mobiles. Pour une
modification, sélectionnez le point dacces de votre choix sur la liste.

- Opérateur réseau : Recherche des opérateurs de réseau pour une
connexion automatique.
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VPN

Vous pouvez vous connecter a un réseau virtuel sécurisé, comme un IntraNet.
Vous pouvez également gérer des réseaux privés virtuels connectés.

Ajouter d’'un VPN
T Surlécran parameétres, appuyez sur Réseau et Internet > VPN.
2 Appuyez sur .

E « Cette fonctionnalité n'est disponible que lorsque le verrouillage de ['écran
est activé. Un écran de notification apparalt si le verrouillage de ['écran est
désactivé. Appuyez sur Modifier sur [écran de notification pour activer
le verrouillage de [écran. Consultez la section Réglage d'un écran de
verrouillage pour plus d'informations.

3 Entrez les informations sur le VPN et appuyez sur Enregistrer.

Configuration des parametres du VPN
1 Appuyez sur un VPN sur la liste VPNS.

7 Entrez les informations sur le compte utilisateur VPN et appuyez sur
Accéder.

+ Pour enregistrer les informations sur le compte, cochez la case
Enregistrer les informations de compte.

DNS privé
Vous pouvez configurer les options de DNS privé (Domain Name System ou
Systeme de noms de domaine).

1 Surlécran parameétres, appuyez sur Réseau et Internet > DNS privé.
2 Configurez l'option souhaitée et appuyez sur Enregistrer.
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Appareils connectés

Bluetooth

Vous pouvez connecter votre appareil a des appareils compatibles Bluetooth
se trouvant a proximité pour échanger des données avec eux. Connectez
votre appareil a un casque et a un clavier Bluetooth. Cela rend plus facile le
controle de lappareil.

Appairage avec un autre appareil

1 Sur [écran paramétres, appuyez sur Appareils connectés > Bluetooth.

2 Appuyez sur () ) pour lactiver.
« Les appareils disponibles apparaissent automatiquement.
- Pour actualiser la liste des appareils, appuyez sur ().

E « Seuls les appareils dont la visibilité a été activée apparaissent sur la liste.

3 Sélectionnez un appareil sur la liste.
/A Suivez les instructions a [écran pour procéder a lauthentification.

E « Cette étape est ignorée pour les appareils auxquels vous avez acces
précédemment.

Envoi de données via Bluetooth
1 Sélectionnez un fichier,
+ Vous pouvez envoyer des fichiers multimédias ou des contacts.
7 Appuyez sur <> Bluetooth.
3 Sélectionnez un appareil cible pour le fichier.
- Le fichier est envoyé dés que lappareil cible laccepte.

E « Les processus de partage peuvent varier en fonction du type de fichier.
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Partage d'écran

Vous pouvez lire 'écran et le son de I'appareil sur un autre appareil, comme un

téléviseur, qui prend en charge la fonction Miracast.

7 Sur [écran paramétres, appuyez sur Appareils connectés > Partage
d'écran.

2 Appuyez sur () ) pour lactiver.

3 Sélectionnez un appareil sur la liste les appareils a proximité.

+ Silappareil désiré napparait pas, appuyez sur Rechercher pour
réactualiser (a liste.

« Une fois la connexion établie, [écran de votre téléphone apparait sur le
téléviseur.

E « Le partage d'écran est automatiquement désactivé si aucun appareil
compatible ne se trouve a proximité.

NFC

Vous pouvez utiliser votre appareil comme titre de transport ou carte de
crédit. Vous pouvez aussi partager des données avec l'autre appareil.

1 Sur [écran paramétres, appuyez sur Appareils connectés > NFC.

2 Appuyez sur () ) pour lactiver.

+ Touchez votre appareil avec un autre appareil qui prend en charge le
protocole NFC pour permettre le partage de données.

E « Lemplacement de lantenne NFC peut varier en fonction de appareil
Consultez Présentation des pieces pour plus de détails concernant
l'antenne NFC.
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Panneau de partage

\ous pouvez partager des contenus depuis Galerie, Musique ou Gestionnaire

de fichiers, avec des appareils a proximité. Vous pouvez également partager

des contenus avec des personnes spécifiées dans les applications qui

fonctionnent avec Google Direct Share.

1 Surlécran parameétres, appuyez sur Appareils connectés > Panneau de
partage.

2 Appuyez sur @  pour désactiver chaque option.

- Appareils a proximité: Vous pouvez afficher les appareils a proximité
vers lesquels vous pouvez partager du contenu vers les applications de
Galerie, Musique et Gestionnaire de fichiers.

« Partage direct: Depuis une application prenant en charge Google
Direct Share, vous pouvez afficher une icone vous permettant de
partager des contenus a des personnes spécifiques.

Partage de fichiers
Vous pouvez envoyer et recevoir des fichiers entre votre appareil et dautres
appareils ou une tablette LG.
1 Sur [écran paramétres, appuyez sur Appareils connectés > Partage de
fichiers.
7 Personnalisez les paramétres suivants :
+ VELVET : Modification du nom de lappareil.

- Enregistrer dans : Définition du dossier de destination pour
lenregistrement des fichiers envoyés depuis dautres appareils.

- Partage de fichier : Permission de réception de fichiers envoyés depuis
dautres appareils.

+ SmartShare Beam : Partage de fichiers avec dautres appareils via
SmartShare Beam.

- Aide :Vous pouvez consulter ['aide sur le partage de fichiers.
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Serveur multimédia

Vous pouvez partager le contenu multimédia de votre appareil avec des
appareils compatibles DLNA a proximité.

7 Sur [écran paramétres, appuyez sur Appareils connectés > Serveur
multimédia.

2 Personnalisez les parameétres suivants :

- Partage de contenu : Partage du contenu multimédia de votre appareil

avec des appareils a proximité.
VELVET : Définition du nom de votre appareil.

« En fonction du produit de ['utilisateur, les noms de menu peuvent étre
|égerement différents.

+ Mes contenus partagés : Sélection du type de contenu multimédia a

partager avec dautres appareils.

- Appareils autorisés : Affichage d'une liste d'appareils autorisés a

accéder a votre contenu.

Appareils non autorisés : Affichage d'une liste dappareils non
autorisés a accéder a votre contenu.

Impression

\lous pouvez connecter votre appareil a une imprimante Bluetooth et
imprimer des photos ou documents enregistrés sur [appareil.

Sur [écran parametres, appuyez sur Appareils connectés > Impression.
+ Appuyez sur Service d'impression par défaut pour rechercher des
imprimantes auxquelles vous connecter. Ou, appuyez sur : > Ajouter des
imprimantes pour ajouter manuellement une imprimante.

- Appuyez sur (+) Ajt service pour télécharger lapplication d'imprimante
que vous souhaitez.

5

« Ceci est uniquement disponible si le réseaux mobiles ou la fonction
Bluetooth est activé.

- Pour descendre (application d'imprimante dans (+) Ajt service, connectez-
vous d'abord a votre compte Google.
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Son

Vous pouvez personnaliser les paramétres de sonnerie, vibreur et notification.

Sur ['écran paramétres, appuyez sur Son et personnalisez les parametres
suivants :

- Profil des sons : Changez le mode sonore sur Son, Vibreur seul ou

Silencieux.

+ Volume: Réglez le volume sonore pour différents éléments.

- Sonnerie: Sélection d'une sonnerie pour les appels entrants. Ajouter ou

suppression de sonneries.

Son de notification: Sélection d'une sonnerie de notification. Définition
d’'une musique enregistrée sur lappareil en tant que sonnerie de
notification.

- Sonnerie avec vibreur : Activation du vibreur en plus de la sonnerie.

- Ring ID: Créez une sonnerie pour les appels entrants d'un contact en

particulier.

- Alerte clignotante pour un appel entrant : Réglez le flash pour qu'il

clignote en fonction de la sonnerie LG.

Ne pas déranger : Définition de [heure, du type de notification et du type
d'application pour la réception de messages de notification. Réception de
messages de notification uniquement certains jours de la semaine.

- Qualité du son et effets : Utilisez cette fonction pour définir la qualité du

son et les effets lors de |a lecture d'un morceau ou d'une vidéo.

- Volume: Réglez le volume sonore pour différents éléments.

- Normaliser le volume : Utilisez la fonction pour normaliser les volumes
de différentes sources sonores.

- Egaliseur: Utilisez la fonction pour ajuster les parametres de ['‘égaliseur.

- Moteur de Son 3D LG : Utilisez la fonction pour lire de la musique
ou des vidéos en trois dimensions, un son immersif et vif lorsque des
écouteurs, un haut-parleur ou d'autres périphériques audio externes

sont connectés. Consultez la section Moteur de Son 3D LG pour plus
d'informations.
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- Sous-titre : définissez lappareil pour détecter la voix provenant du
multimédia et générer automatiquement des sous-titres.

+ Puissance du vibreur: Ajustement de l'intensité du vibreur.

Type de vibration: Vous pouvez sélectionner un type de vibration pour la
réception d'appels.

- Vibration lorsqu'on appuie: Activation du vibreur associée a ['utilisation
des fonctions tactiles.

- Pavé numérique sonore lors de la composition des numéros:
Sélectionnez leffet sonore du clavier

+ Son du clavier LG : Sélectionnez leffet sonore du clavier LG.
+ Son touches : Sélectionnez un effet sonore pour appuyer sur un élément.

- Son verrouillage écran : Sélectionnez un effet sonore lorsque ['écran est
verrouillé ou déverrouillé.

Notifications

Vous pouvez consulter [a liste des applications installées et configurer les
parametres pour les notifications.

1 Surlécran parameétres, appuyez sur Notifications.

7 Personnalisez les parameétres a votre choix.
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Ecran

Vous pouvez personnaliser des paramétres détaillés pour chaque type décran.
Sur 'écran paramétres, appuyez sur Ecran et personnalisez les parametres
suivants :
- Ecran d'accueil : Personnalisation des paramétres pour [écran
d'accueil Consultez la section Parametres de [écran daccueil pour plus
d'informations.

Bar d'navigation. : Définissez le style de la barre de navigation avec
Gestes ou Touches tactiles uniqguement. Vous pouvez aussi changer

la combinaison des touches quand vous avez choisi Touches tactiles
uniquement comme style de la barre de navigation. Pour plus de détails,
voir Barre de navigation.

- barre d'état : Définissez la couleur de la barre détat en haut de [écran,

ou définissez laffichage des icones de notification et du pourcentage de
batterie.

AOD (always-on display) :Informations toujours affichées, comme la
date, I'heure et les notifications, méme lorsque [écran est éteint. Pour plus
de détails, voir AOD (always-on display).

- Confort visuel : Régler votre appareil pour diminuer la quantité de lumiére
bleue sur 'écran afin de diminuer votre effort visuel.

E « Cette fonction n'est pas disponible quand lappareil est connecté au Double
écran LG (LM-G905N).

+ Mode nuit : Vous pouvez appliquer un théme décran assombri pour éviter
les reflets sur [écran la nuit.

+ Couleur de l'écran : Ajustez la couleur, la température de couleur ou les
valeurs RGB pour [écran souhaité.

E + Appuyez surs pour réinitialiser les parametres.

- Amplificateur pour Vidéo :Lors de la lecture d'une vidéo en mode plein
couleur, vous pouvez changer les parametres pour que laffichage soit plus
lumineux et les couleurs plus dynamiques.
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Police : Modifiez |a taille de police, le caractere gras ou le type.

Couleur d'accentuation : changez la couleur du point pour les réglages,
les menus, les fenétres de notification, etc.

Taille d'affichage : Réglez les éléments sur [écran a la taille que vous
souhaitez. Certains éléments peuvent changer de position.

+ Plein écran applications : Réglez |a taille de [écran des applications.

+ Luminosité : Utilisez la barre de réglage pour modifier la luminosité de

[écran du téléphone. Pour un ajustement automatique de la luminosité de
['écran en fonction de lintensité de ['éclairage ambiante, appuyez sur le
bouton Auto.

Auto :Régler ['appareil pour que la luminosité de ['écran soit
automatiquement ajustée en fonction de l'intensité lumineuse ambiante.

+ Mise en veille de ['écran : Désactivation automatique de [écran quand

lappareil reste inactif pendant une période donnée.

- Rotation automatique de "écran : Rotation automatique de [écran en

fonction de lorientation de lappareil.

Economiseur d'écran : Affichage d'un écran de veille lorsque 'appareil est
connecté au support ou au chargeur. Sélection d'un écran de veille.

Ecran d'une seule main: Réduisez votre écran afin de pouvoir vous servir

facilement de lappareil d'une seule main. Faites glisser la touche d'accueil

depuis le bas de ['écran vers la gauche ou la droite.

Fond d'écran & Theme

Vous pouvez sélectionner le fond décran, le theme de [écran, le style des
icones ou loption AOD (Always-on Display) sur votre appareil.

1

Sur [écran des parametres, appuyez sur Fond décran & Theme.

2 Appuyez sur Fond d'écran, Théme, Icéne ou AOD pour personnaliser les

parametres.
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Ecran de verrouillage et sécurité

Vous pouvez personnaliser les paramétres de [écran de verrouillage et de
sécurité.

1 Sur [écran paramétres, appuyez sur Ecran de verrouillage et sécurité.

7 Personnalisez les parameétres.

- Google Play Protect : Analysez quotidiennement votre appareil a la

recherche d'applications potentiellement dangereux.

+ Localiser mon appareil : Suivre a distance 'emplacement de ['appareil.

Vous pouvez également protéger vos données en toute sécurité si vous
avez perdu votre appareil

+ Mise a jour de sécurité : Vérifiez la mise a jour du logiciel et configurez

les parametres d'installation automatique.

« Choisir 'écran de verrouillage : Sélection d'une méthode de

verrouillage de [écran. Consultez la section Réglage d'un écran de
verrouillage pour plus d'informations.

Personnaliser l'écran de verrouillage : Modifiez les informations
affichées sur ['‘écran verrouillé.

- Parametre de verrouillage sécurisé : Modifier les parametres de

verrouillage sécurisé

- Empreintes digitales: Utilisation de votre empreinte digitale pour

déverrouiller [écran ou du contenu. Consultez la section Présentation
de la Empreintes Digitales pour plus d'informations.

Verrouillage du contenu : Vous permet de définir un type de
verrouillage (mot de passe ou motif) pour vos fichiers de Galerie.
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- Cryptage et données d'identification : Configurez les parametres
pour le cryptage et les informations d'identification de la carte SD.
- Crypter la carte SD : Cryptage de la carte mémoire pour empécher
toute utilisation sur un autre appareil. Consultez la section Cryptage
de la carte mémoire pour plus d'informations.

Protection des données d'identification : Affichage du type de
stockage pour l'enregistrement du certificat de sécurité.

Certificats de confiance : Affichez les certificats d'autorité de
certification racine de votre systéme et les certificats d'autorité de
certification installés par utilisateur.

Données d'identification de 'utilisateur : Affichez et modifiez les
informations de certificat sécurisées stockées sur votre appareil.

Installer depuis la mémoire :Installez un certificat sécurisé a partir

d'un stockage.
- Effacer les certificats : Supprimez les certificats sécurisés installés

par ['utilisateur et les informations d'identification associées.

- Administrateurs de ['appareil : Attribution de privileges pour limiter le
controle et ['utilisation de l'appareil pour des applications données.

- Trust agents : Affichage et utilisation des trust agents installés sur
[appareil.

- Epinglage de lécran : Epinglage de lécran d'application pour une
utilisation de l'application actuellement active uniquement.

Accés aux données d'utilisation : Affichage des informations
relatives a l'utilisation des applications sur appareil
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Confidentialité

Vous pouvez retrouver et ajuster tous vos parametres de confidentialité.

1 Sur [écran paramétres, appuyez sur Confidentialité.

7 Personnalisez les parametres.

Permission responsable: vous permet de vérifier et de modifier les
permissions octroyées aux applications.

Ecran de verrouillage: vous permet de définir les notifications a
afficher sur [écran de verrouillage.

Rendre les mots de passe visibles : Activez cette option pour afficher
brievement chaque caractére du mot de passe au fur et a mesure que
vous le saisissez afin que vous puissiez voir ce que vous avez entré.

Services de personnalisation de l'appareil : Vous permet dobtenir
une suggestion en fonction des utilisateurs, des applications et du
contenu interactif.

Saisie automatique Google : Activez cette option pour entrer vos
informations enregistrées dans votre compte, telles que votre mot

de passe, votre adresse ou votre numéro de carte de crédit, en un
seul appui. Vous pouvez également désactiver cette option, utiliser la
saisie semi-automatique de Google ou ajouter un nouveau compte de
service.

Historique des positions Google: vous permet d'activer ou de
désactiver [historique des emplacements. Si cette fonction est
activée, Google enregistre et utilise régulierement les données des
emplacements les plus récents de votre téléphone avec votre compte
Google.

Depuis [écran d'historique des emplacements, appuyez sur + pour
afficher ou gérer vos données demplacements.

Commandes relatives a l'activité : sélectionne les activités et les
informations que vous souhaitez que Google enregistre.

Annonces: vous permet de vérifier lidentifiant de publicité et de
configurer les annonces personnalisées.

Utilisation et diagnostics :activez cette option pour aider a améliorer
votre expérience Android, en envoyant automatiquement les données
de diagnostic, de lappareil et d'utilisation des applications a Google.
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Position

Vous pouvez vérifier comment sont partagées vos informations
demplacement et configurer les autorisations pour accéder a vos
informations demplacement.

Sur [écran parametres, appuyez sur Position et configurez la fonctionnalité
souhaitée.

Extensions

Smart Doctor

Vous pouvez utiliser la fonction Smart Doctor pour diagnostiquer [état de
lappareil et loptimiser.

Sur [écran parametres, appuyez sur Extensions > Smart Doctor.

Context Awareness

Vous pouvez modifier automatiquement les parametres de votre appareil en
fonction de votre mode d'utilisation et de votre position.

7 Sur [écran paramétres, appuyez sur Extensions > Context Awareness.

7 Activez les éléments dont vous souhaitez modifier les parametres
automatiquement.

- AUTOMATISE :Vous pouvez ajuster l'appareil pour modifier les
options de profil audio, Bluetooth et Wi-Fi automatiquement dans des
environnements différents, comme A la maison, Loin de la maison, Au
bureau, Hors bureau. Vous pouvez aussi régler une application pour
qu'elle souvre lors du branchement des écouteurs ou d'un appareil
Bluetooth.

5 « Pour utiliser cette fonction, les emplacements de maison et de bureau
doivent étre prédéfinis dans Mes endroits. Sur [écran des parametres,
appuyez sur Position > Mes endroits pour définir les emplacements.
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Service personnalisé

Vous pouvez obtenir des résultats intelligents grace a la recherche intégrée.

T Surlécran des paramétres, appuyez sur Extensions > Service
personnalisé.

2 Appuyez sur () ) pour lactiver.

Gaming
Vous pouvez configurer les réglages des outils de jeu, du graphisme pour le
jeu et de la fonction déconomie de batterie.
7 Sur [écran paramétres, appuyez sur Extensions > Gaming.
7 Personnalisez les parameétres suivants :
+ Lanceur De Jeu : Appuyez sur () ) pour utiliser le lanceur de jeux.

+ Outils de jeu : Vous pouvez lancer la fonction tout en jouant a des jeux
en appuyant sur l'icdne des outils de jeu parmi les touches tactiles.

- Graphisme pour le jeu :Régler le graphisme pour le jeu.

E « Lorsque vous changez les résolutions sur certains jeux, la fonctionnalité
daffichage de [écran peut ne pas fonctionner correctement.

« Cette fonction peut ne pas étre disponible dans certaines applications de
jeux.

- Durée de la pause : Réduire la luminosité et la performance de [écran
lorsque vous laissez le jeu tourner pendant plus de 5 minutes.
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L'enregistrement d'écran
Vous pouvez configurer les parametres pour l'enregistrement de ['écran.

T Surl'écran paramétres, appuyez sur Extensions > L'enregistrement
d'écran.

7 Personnalisez les parameétres suivants :

S'inclure soi-méme dans une vidéo en : Sélectionnez lune des

options suivantes.

- Image :Incluez votre image de profil en vidéo lors de
l'enregistrement. Apres ['avoir sélectionnée, appuyez sur @ puis
sélectionnez une image de profil. Ajustez ensuite la taille de limage
a l'aide de la barre de défilement.

- Appareil Photo frontal :Incluez-vous en vidéo a 'aide de la caméra
frontale lors de l'enregistrement de ['écran.

- Jamais :Rien n'est inclus.

- Source audio : Choisissez la source audio entre Micro et Contenu.

- Résolution vidéo : Sélectionnez la résolution de l'enregistrement de

['écran.

Pour enregistrer l'écran

1 Faites glisser la barre d'état vers le bas pour ouvrir la liste des icbnes
d'acces rapides.

2 (Sinécessaire, faites glisser vers la gauche le champ des icones d'acces
rapides.) Appuyez sur B

3 Lisez l'exclusion de responsabilité et appuyez sur Démarrer.
L'enregistrement commencera au bout de 3 secondes.

A Pour stopper l'enregistrement, appuyez sur (®) en bas a droite de ['écran.
La vidéo enregistrée est stockée dans la Galerie.

5

« Sivous violez les droits d'un tiers comme le droit de portrait ou de propriété
intellectuelle ou si vous diffamez la réputation d'une autre personne en
utilisant les fonctions fournies par le service denregistrement d'écran,
vous pouvez étre tenu pour responsable de charges civiles, pénales ou
administratives en vertu des lois concernées. LG Electronics nest en aucun
cas légalement responsable des actes commis par les utilisateurs.
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App en double

Vous pouvez installer des applications de messagerie en double sur le produit
et utiliser deux comptes en méme temps.

1 Sur [écran paramétres, appuyez sur Extensions > App en double.

2 Apres avoir lue lexclusion de responsabilité, appuyez sur Confirmer.

3 Dans la liste des applications disponibles, appuyez sur Installer pour
installer un clone de lapplication souhaitée et suivez les instructions a
[écran.

« LBcran affiche la liste des applications en double disponibles. Pendant
linstallation, les icones dapplication sont créées sur [écran daccueil.

Stylet

Vous pouvez configurer des options pour utiliser un stylet (en option -
vendu séparément) Cet appareil prend en charge le stylet actif AES2.0
(électrostatique actif).

7 Sur 'écran paramétres, appuyez sur Extensions > Stylet.

7 Personnalisation des paramétres suivants :

+ Touche Stylet Raccourcis : Configurez les raccourcis sur chaque
bouton de votre stylet actif.

+ Raccourcis des apps: Sélectionnez les applications (jusqu'a cing) a
afficher en tant que raccourci lorsque le stylet est retiré de l'appareil.

+ Apercu mémo: Activer pour afficher les mémos récents dans la fenétre
Stylet.

- Son de dessin: Activer pour entendre des effets sonores en mode
dessin.

- Affich. pointeur : Activer pour voir un pointeur la ol passe le stylet.

Ignorer les gestes de la barre de navigation :Bloquez les gestes de
la barre de navigation détre saisis, trés utile lorsque vous dessinez ou
écrivez sur le bord de [écran avec un stylet actif.
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Raccourcis

Vous pouvez utiliser les boutons comme Marche-Arrét/Verrouillage,
Volume et Google Assistant pour lancer certaines applications ou fonctions
directement.

1 Surl'écran parametres, appuyez sur Extensions > Raccourcis.

7 Personnalisez les parameétres suivants.

+ Ouvrir Appareil photo : Appuyez deux fois sur la touche
d'alimentation pour ouvrir la caméra.

+ Ouvrir Mémo écran éteint : Appuyez deux fois sur la touche Volume
Haut pour ouvrir la note décran lorsque [écran est verrouillé ou éteint.

+ Ouvrir Appareil photo : Appuyez deux fois sur la touche Volume Haut
pour ouvrir Camera lorsque ['‘écran est verrouillé ou éteint.

+ Ouvrir Google Assistant : Appuyez sur la touche Assistant Google
située sur le coté du téléphone.

« Parler a Google Assistant : Appuyez et maintenez la touche
Assistant Google pour parler rapidement a votre assistant.

E + Google Assistant ne prend pas en charge certaines langues.

KnockON

Appuyez deux fois sur ['écran pour activer ou désactiver ['écran.
Consultez la section KnockON pour plus d'informations.

Augmenter la sensibilité tactile

Vous pouvez régler [écran tactile pour qu'il soit plus sensible a votre toucher.
Il est recommandé dactiver cette fonctionnalité si vous utilisez un protecteur
décran.

Sur [écran des parametres, appuyez sur Extensions > Augmenter la
sensibilité tactile.
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Applications

Vous pouvez consulter la liste des applications installées et configurer les
parametres pour les notifications, les autorisations d'application, etc.

7 Sur [écran parameétres, appuyez sur Applications.

7 Personnalisez les parameétres.

Batterie

Vous pouvez afficher les informations relatives a la batterie ou activer le
mode économie dénergie.
1 Sur[écran parameétres, appuyez sur Batterie.
2 Personnalisez les parameétres suivants :
- Utilisation batterie : Affichage des informations relatives a ['utilisation
de la batterie.
+ Rechargement optimisé : Ajuste automatiquement la vitesse de
chargement en fonction de votre méthode de charge pour réduire la
chaleur et prolonger la durée de vie de la batterie.

- Batterie adaptative : \ous permet d'économiser |a batterie en
arrétant ['exécution d'applications en arriere-plan.

Restrictions tache de fond : Activez cette option pour restreindre
l'arriére-plan et économiser (a batterie lorsque vous utilisez I'appareil.
Les applications restreintes pour faire des économies de batterie
peuvent ne pas fonctionner correctement ou ne pas vous envoyer de
notifications.

- Economie d'énergie : Economie dénergie de la batterie a travers la
réduction de certains paramétres, comme la luminosité de [affichage, la
vitesse et l'intensité des vibrations.

+ Exclusions de l'économie d'énergie : Sélectionner des applications a

utiliser sans limitation de fonctionnalité pendant que vous vous trouvez

en mode doptimisation de batterie ou déconomie dénergie.
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Stockage

Vous pouvez afficher et gérer la mémoire interne de lappareil et lespace de
stockage de la carte mémoire.

7 Sur [écran parameétres, appuyez sur Stockage.

7 Personnalisez les parameétres suivants :

- Mémoire interne : Affichage de lespace de stockage total et
possibilité de libérer de lespace sur la mémoire interne de lappareil.
Affichage de la liste des applications utilisées et de la capacité de
stockage de chacune.

- Carte SD : Affichage de lespace de stockage total et possibilité de
libérer de l'espace sur la carte mémoire. Cette option napparait que
lorsqu'une carte mémoire est insérée. Pour démonter la carte mémoire,
appuyez sur

Comptes

Vous pouvez ajouter des utilisateurs pour partager votre appareil et
enregistrer un compte cloud.

1 Sur[écran parametres, appuyez sur Comptes.

7 Personnalisez les parameétres.

Bien-étre numérique et controle
parental

Vous pouvez voir le temps d'utilisation du produit et ajuster le chronometre
de chaque application. De méme, vous pouvez gérer le temps d'utilisation du
téléphone mobile a laide du mode Préparation au sommeil et du mode Mise
au point.

Sélectionnez Bien-&tre numérique et controle parental sur [écran des
parametres pour ajuster la fonction souhaitée.
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Google

Vous pouvez utiliser les parametres Google pour gérer vos applications
Google et les parameétres de votre compte.

Sur [écran parametres, appuyez sur Google.

Systéme

Centre de mises a jour

Vous pouvez vérifier et installer la derniere version de ['application ou du
logiciel fourni par LG.

1 Sur[écran parametres, appuyez sur Systéme > Centre de mises a jour.
2 Personnalisez les parameétres suivants :

- Mise a jour des applications : \Vérifiez si une mise a jour de
l'application est disponible. Si disponible, vous pouvez installer la mise
ajour.

+ Mise a jour logicielle : Vérifiez si une mise a jour du logiciel est
disponible. Si disponible, vous pouvez installer la mise a jour.

Langue et clavier
Vous pouvez personnaliser les paramétres de langue et de clavier de votre
appareil.
7 Sur 'écran parametres, appuyez sur Systéme > Langue et clavier.
7 Personnalisez les parametres suivants :
+ Langue : Sélectionnez une langue a utiliser pour ['appareil.

+ Gérer les claviers :Vous pouvez changer le parametre du clavier de
base du produit, définir les environnements d'utilisation pour Clavier LG
ou dautres claviers installés, et définir la fonction de reconnaissance
pour la saisie de Google Voice. Et, vous pouvez aussi opter pour afficher
le bouton du clavier dans la zone des boutons tactiles sur [écran
daccueil
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- Clavier physique : Sélectionnez cette option pour utiliser le clavier
physique ou les touches de raccourci clavier.

+ Services Saisie automatique : Activez cette option pour entrer vos
informations enregistrées dans votre compte, telles que votre mot de
passe, votre adresse ou votre numéro de carte de crédit, en un seul
appui. Vous pouvez également désactiver cette option, utiliser la saisie
semi-automatique Google ou ajouter un nouveau compte de service.

- Parameétres de la synthése vocale : Configurez les parametres de
synthese vocale.

- Vitesse du curseur : Réglage de la vitesse du pointeur de la souris ou

du pavé tactile.

Inverser les boutons de la souris :Inversion du bouton droit de la

souris pour les manipulations directes de base.

Date et heure

Vous pouvez personnaliser les parametres de date et d'heure de votre
appareil.

T Surlécran parameétres, appuyez sur Systéme > Date et heure.
7 Personnalisez les paramétres.

Mémoire
Vous pouvez afficher la quantité moyenne de mémoire utilisée sur une
période donnée et la mémoire occupée par une application.

1 Surlécran paramétres, appuyez sur Systéme > Mémoire.
2 Appuyez sur w pour définir la période de recherche des données.
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Sauvegarder

Vous pouvez sauvegarder les données enregistrées sur votre téléphone sur
un autre appareil ou compte.

1 Sur [écran paramétres, appuyez sur Systéme > Sauvegarder.
7 Personnalisez les parameétres suivants :
+ LG Mobile Switch :Vous permet de transférer les données d'un ancien
appareil LG sur votre nouvel appareil LG. Consultez |a section LG Mobile
Switch pour plus d'informations.

- Sauvegarder et restaurer : Sauvegardez les données de votre appareil
ou restaurez les données sur votre appareil a partir d'une copie de
sauvegarde.

« Les fichiers de sauvegarde enregistrés sur la mémoire peuvent étre
supprimés en cas de réinitialisation. Assurez-vous de copier et stocker les
fichiers de sauvegarde importants sur votre PC.

- Sauvegarde Google : Modifiez les parametres de sauvegarde Google
Drive. Vous pouvez également vérifier le compte de sauvegarde
actuellement utilisé ou ajouter un nouveau compte de sauvegarde.

Redémarrer & Réinitialiser
Vlous pouvez réinitialiser ['appareil, y compris les paramétres réseau et de
lapplication.
T Surl'écran des paramétres, appuyez sur Systéme > Redémarrer &
Réinitialiser.
2 Personnalisez les parameétres suivants :
- Redémarrage automatique : Redémarrez et optimisez
automatiquement le téléphone a une heure définie. Appuyez sur () )
pour activer cette fonction. L'appareil redémarre automatiquement a
un moment donné et s'auto-optimise. Sélectionnez une date et une
heure pour le redémarrage.

Parameétres 155



Vous pouvez configurer [appareil pour qu'il se redémarre une fois par
semaine. L'appareil redémarre automatiquement dans ['heure qui suit
['heure prédéfinie.

i

Une fois ['appareil redémarré, les notifications et les badges sont effacés.
Sauvegardez les données importantes avant ['heure prédéfinie.

La fonction de redémarrage automatique n'est pas activée dans les
situations suivantes : Lorsque [écran est allumé, lorsque lappareil est utilisé,
lorsque le niveau de la batterie est de 30 % ou moins ou lorsque la carte
USIM est verrouillée.

- En fonction de votre opérateur de télécommunications, la fonction de
redémarrage automatique peut étre disponible ou non.

Réinitialiser les parameétres réseaux : Réinitialisation du \Wi-Fi,
Bluetooth et dautres parametres réseau.

Réinitialiser les préférences des applications : Réinitialisez les
paramétres d'une application. Les données enregistrées dans
['application ne seront pas supprimées.

Réinitialiser valeurs d'usine : Réinitialisation de tous les parametres
de lappareil et suppression des données.

E + Redémarrer et réinitialiser votre appareil supprime toutes les données qu'il
contient. Saisissez a nouveau le nom de lappareil, votre compte Google et
dautres informations initiales.

« Apres linitialisation des données, les données ne peuvent pas étre
restaurées.
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A propos du téléphone

Vous pouvez afficher des informations sur appareil, comme le nom, [état, la
version logicielle et les informations [égales.

Sur lécran paramétres, appuyez sur Systéme > A propos du téléphone et
consultez les informations.

Réglementations et sécurité

Vous pouvez afficher les marques réglementaires et les informations
connexes sur votre appareil.

Sur [écran parametres, appuyez sur Systéme > Réglementations et
sécurité.
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Accessibilité

Vous pouvez gérer les plug-ins d'accessibilité installés sur votre appareil.

7 Sur [écran paramétres, appuyez sur Accessibilité.

7 Personnalisez les parametres suivants :
- Visuelles > TalkBack : Configuration de lappareil pour délivrer des

messages vocaux sur [état de [écran ou des actions.

- Visuelles > Notifications vocales : Configuration de 'appareil pour

qu'il lise a haute voix les informations de ['appelant.

« Visuelles > Police : Modifiez la taille de police, le caractere gras ou le

type.

Visuelles > Taille d'affichage : Réglez les éléments sur [écran a la taille
que vous souhaitez. Certains éléments peuvent changer de position.
Visuelles > Zoom tactile : Zoom avant ou arriere avec trois pressions
sur [écran.

- Visuelles > Zoom sur la fenétre :Faites un zoom avant ou arriere sur

la fenétre et inversez la couleur.

- Visuelles > Pointeur de grande taille : Agrandit le curseur.

- Visuelles > Ecran fortement contrasté : Change les couleurs

d'arriere-plan en noir pour obtenir un contraste élevé.

- Visuelles > Inversion des couleurs de l'écran : Amélioration du

contraste des couleurs pour les personnes malvoyantes.

Visuelles > Ajustement des couleurs de l'écran : Réglage de la
couleur d'affichage.

Visuelles > Monochrome : Ecran en mode échelle de gris.

Visuelles > Mettre fin aux appels a l'aide de la touche Marche/
Arrét :Raccrocher avec la touche Marche-Arrét/Verrouillage.

- Auditives > Live Captions : Définissez l'appareil pour détecter la voix

provenant du multimédia et générez automatiquement des sous-titres.

+ Auditives > Préférences pour les sous-titres : Activation du

service de sous-titrage lors de |a lecture vidéo pour les personnes
malentendantes.

Auditives > Alertes flash : Configurez de lappareil pour faire clignoter
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le flash lors des appels entrants, des messages et des alarmes.

+ Auditives > Couper tous les sons : Désactiver tous les sons et réduire
le volume du récepteur.

Auditives > Canal audio : Sélection du type de son.

+ Auditives > Balance du son : Ajustement de la balance de sortie du
son. Modifiez la balance a laide du curseur.

+ Motricité et cognitives > Touch assistant : Activation du panneau
tactile pour accéder facilement aux actions les plus courantes.

+ Motricité et cognitives > Saisie tactile : Entrer du texte en restant
appuyé sur 'écran ou en modifier en le touchant tout simplement.

- Motricité et cognitives > Clavier physique : Personnalisation des
parametres du clavier.

+ Motricité et cognitives > Clic automatique : Le curseur clique
automatiquement en cas d'absence de mouvement.

- Motricité et cognitives > Maintenez enfoncé pour les appels :
Réponse ou rejet des appels en maintenant le bouton d'appel appuyé
au lieu de le faire glisser.

+ Motricité et cognitives > Mise en veille de ['écran: Désactivation
automatique de [écran quand lappareil reste inactif pendant une
période donnée.

- Motricité et cognitives > Zones de commande tactile : Limitation
des commandes tactiles a une zone de [écran.

+ Raccourci vers les fonctions d'accessibilité : Acces rapide a une
fonction fréquemment utilisée en appuyant sur O trois fois.

- Rotation automatique de l"écran : Changement automatique de
l'orientation de ['écran en fonction de la position physique de 'appareil

+ Sélectionner pour prononcer :\ous permet dappuyer sur des
éléments pour écouter des commentaires oraux.

+ Switch Access : Création de combinaisons de touches pour

commander votre appareil.
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Parameétres de langue LG

Sélectionnez une langue a utiliser sur votre appareil.
+ Sur [écran daccueil, appuyez sur Parameétres > Systeme > Langue et
clavier > Langue > Ajouter une langue, puis sélectionnez une langue.

- Restez appuyé sur = et faites-la glisser jusquen haut de a liste des
langues pour en faire la langue par défaut.

LG Bridge

Présentation de LG Bridge

LG Bridge est une application qui vous permet de gérer les photos, chansons,
vidéos et documents enregistrés sur votre smartphone LG depuis votre
ordinateur de maniére pratique. Vous pouvez sauvegarder vos contacts,
photos et bien plus encore sur lordinateur ou mettre a jour le logiciel de
[appareil.

E « Consultez aide en ligne de LG Bridge, pour plus de détails.
« Les fonctionnalités prises en charge peuvent varier en fonction de lappareil.

« Vous avez besoin du pilote LG USB pour connecter votre smartphone LG a
lordinateur. Il s'installe lors de linstallation de LG Bridge.

Fonctions de LG Bridge
+ Sauvegardez les données depuis lappareil sur un ordinateur ou restaurez
les données depuis un ordinateur sur lappareil, par le biais d'une connexion
par cable USB.
- Mettez le logiciel de lappareil a jour depuis un ordinateur par le biais d'une
connexion par cable USB.
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Installation de LG Bridge sur un ordinateur

1 Rendez-vous sur www.lg.com depuis votre ordinateur.

7 Sélectionnez votre région.

3 Cliquez sur Support > Logiciel et Micrologiciel.

4 Sélectionnez le nom de votre téléphone.
ou
Sélectionnez la Catégorie de produit.

5 Allez a Synchronisation PC > LG Bridge pour télécharger le fichier de
configuration.

« Allez a Détails pour consulter les exigences minimales requises pour
linstallation de LG Bridge.

Mise a jour du logiciel du téléphone

Mise a jour du logiciel LG Mobile Phone a partir

d'Internet

Pour des informations complémentaires sur ['utilisation de cette fonction,
consultez le site http//www.lg.com/common/index.sp et sélectionnez votre
pays et votre langue.

Cette fonction vous permet de mettre a jour le micro-logiciel sur votre
appareil et de télécharger la version la plus récente depuis Internet, sans faire
appel a un centre de services. Cette fonction sera disponible uniqguement si
LG fournit une version plus récente du micro-logiciel pour votre téléphone.

La mise a jour du micro-logiciel du téléphone mobile requiert lattention
complete de [utilisateur pendant toute la durée du processus. Assurez-vous
de bien lire toutes les instructions et remarques qui saffichent a chaque
étape avant de continuer. Attention : retirer le cable USB durant la mise a
niveau peut gravement endommager votre téléphone mobile.

E + LG seréserve le droit de mettre a disposition les mises a jour micro-
logicielles de certains modeles uniquement, et ce a son entiére discrétion,
et ne garantit pas la disponibilité de versions micro-logicielles plus récentes
pour lensemble de ses modéles de téléphones portables.
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Mise a jour du logiciel LG Mobile Phone par liaison
radio (OTA, Over-the-Air)

Cette fonction vous permet de mettre a jour le logiciel de votre téléphone et
de télécharger la version la plus récente via OTA, sans utiliser de cable USB.

Cette fonction sera disponible uniquement si LG fournit une version plus
récente du micro-logiciel pour votre téléphone.

Pour mettre a jour le logiciel du téléphone,

Parametres > Systéme > Centre de mises a jour > Mise a jour logicielle >
Rechercher les mises a jour maintenant.

E « Vos données personnelles enregistrées sur le téléphone, y compris les
informations relatives a votre compte Google et a tout autre compte,
les données et parametres systeme et d'application, ainsi que toutes les
applications téléchargées et vos licences DRM, peuvent étre perdues lorsque
vous mettez a jour le logiciel de votre appareil. Par conséquent, LG vous
recommande de sauvegarder vos données personnelles avant de mettre
ajour le logiciel de votre téléphone. LG ne peut étre tenu responsable de
toute perte de données personnelles.

« Cette fonctionnalité peut ne pas étre prise en charge en fonction de la
région ou de [opérateur de téléphonie.
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Guide contre le vol

Configurez votre appareil pour empécher dautres personnes de ['utiliser
sans votre autorisation s'il a été réinitialisé avec les parametres d'usine.
Par exemple, si votre appareil est perdu, volé ou effacé, seule une personne
disposant des informations relatives a votre compte Google ou au
verrouillage de [écran peut ['utiliser.

Il vous suffit de vous assurer que votre appareil est protégé comme suit :

Définissez un écran de verrouillage :si votre appareil est perdu ou volé
mais que vous avez défini un verrouillage décran, il n'est pas possible de
leffacer depuis le menu Parametres sauf si [écran est déverrouillé.

Ajouter votre compte Google sur votre appareil : si votre appareil est
effacé mais qu'il est doté de votre compte Google, le processus de
configuration ne peut se terminer sur lappareil tant que vos informations
de compte Google ne sont pas saisies a nouveau.

Une fois votre appareil protégé, vous devrez soit déverrouiller [écran, soit
saisir le mot de passe de votre compte Google si vous avez besoin de faire
une réinitialisation d'usine. La réinitialisation ne peut donc étre réalisée que
par vous-méme ou une personne en laquelle vous avez confiance.

E - Noubliez pas lidentifiant et le mot de passe du compte Google que vous
avez saisis sur lappareil avant deffectuer la réinitialisation d'usine. Si vous
ne pouvez pas fournir les informations du compte pendant le processus de
configuration, vous ne pourrez pas utiliser lappareil apres avoir effectué la
réinitialisation des données d'usine.
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Informations sur les logiciels libres

Pour obtenir le code source sous |a licence publique générale, |a licence
publique générale limitée, la licence publique Mozilla ou les autres licences
libres de ce produit, rendez-vous sur http.//opensource.lge.com.

En plus du code source, tous les termes de la licence, ainsi que les exclusions
de garantie et les droits dauteur, sont disponibles au téléchargement.

LG Electronics peut aussi vous fournir le code source sur CD-ROM moyennant
le paiement des frais de distribution (support, envoi et manutention) sur
simple demande adressée par e-mail a opensource@lge.com.

Cette offre est valable pour une période de trois ans a compter de la date
de la derniere distribution de ce produit. Cette offre est valable pour toute
personne possédant cette information.

Infos réglementaires
(numéro d'identification
réglementaire, étiquetage
électronique, etc.)

Pour connaitre les informations concernant la réglementation et la sécurité,
aller a Parametres > Systéme > Réglementations et sécurité.
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Marques commerciales
+ Copyright ©2020 LG Electronics Inc. Tous droits réservés. LG et le logo LG
sont des marques déposées de LG Group et de ses entités apparentées.

- Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Google Photos, Google Play Protect, Google Calendar, Google
Docs, Google Drive, Google Sheets et dautres marques et logos associés
sont des marques commerciales de Google LLC.

+ Bluetooth® est une marque déposée de Bluetooth SIG, Inc. dans le monde
entier.

- Wi-Fi® et le logo Wi-Fi sont des marques déposées de Wi-Fi Alliance.

- Tous les autres marques commerciales et tous les autres droits dauteur
sont la propriété de leurs propriétaires respectifs.

HE HEVCA\dvance”

Covered by Patents at patentlist.hevcadvance.com
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Avertissement relatif au laser

Attention !

Ce produit utilise un systéme Laser. Pour garantir une utilisation conforme

du produit, veuillez lire attentivement le manuel utilisateur et conservez-le
afin de pouvoir vous y référer ultérieurement. Si lunité nécessite un entretien,
contactez un centre de réparation agréé.

L'utilisation de commandes, de réglages ou de procédures autres que ceux
spécifiés dans ce document peut provoquer une exposition a des rayons
dangereux.

Pour éviter toute exposition directe aux rayons laser, nessayez pas douvrir le
couvercle ou dentrer directement en contact avec le laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

DECLARATION DE CONFORMITE

Par la présente, LG Electronics déclare que le produit LM-G900EM
est conforme aux exigences fondamentales et aux autres dispositions
pertinentes de la directive 2014/53/EU.

Consultez la Déclaration de conformité sur
http//wwwi.lg.com/global/declaration
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Contactez notre service pour
connaitre les normes auxquelles ce
produit est conforme

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

['utilisation de la bande 5150 - 5350 MHz est limitée a une utilisation en
intérieur uniquement.

AT [BE [BG|CH|CY|CZ|DE|DK|EE|EL|ES|FI|FR
Q HR(HU|IE [IS|IT| L |LT|LU|LV |[MT|NL|NO|PL
PT{RO|SE | SI | SK|UK|AL|ME|RS |MK|TR |BA|XK
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En savoir plus

Parties en verre trempé
Les parties en verre trempé de cet appareil ne sont pas permanentes et
peuvent s'user au fil du temps.
+ Sivous laissez tomber cet appareil sur une surface dure ou le soumettez a
de forts impacts, le verre tempéré risque détre endommagé.
Dans ce cas, cessez d'utiliser votre appareil immédiatement et contactez
un centre de service client LG.
- \ous pouvez acheter des étuis protecteurs pour protéger votre appareil de
tout dommage dans le commerce.
Notez que ces étuis protecteurs ne sont pas couverts par la garantie
fournie par LG Electronics et leurs sécurité nest pas garantie.

Rapport d'image
Cet appareil utilise un rapport d'image de 20,5:9.
+ Ilest possible que certaines applications téléchargées ne prennent pas en
charge un rapport d'image de 20,5:9.
Dans ce cas, sélectionnez le rapport d'image optimal pour application ou
consultez le fournisseur dapplication pour plus d'informations.
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Guide pour les transferts de données

+ Pour connaltre les données pouvant étre échangées entre des appareils
LG ou entre lappareil LG et un appareil tiers, consultez le tableau suivant.

Appareil .
Appareil LG |  Android A':;%a,;ell
Type Détails de lélément - tiers N
Appareil LG - ]
Appareil LG Appareil LG

Contacts, messages, journaux

de numérotation, calendrier; O O O
Données enregistrements vocaux
personnelles | \1émos X o)

Alarmes X X
Données | Photos, vidéos, chansons,
multimédia | documents o o o

Paramétres de [écran

daccueil (dossiers et widgets) © X X
P'a’ramétres Parameétres de [écran de
décran verrouillage (paramétres o v N

de verrouillage de écran

exclus)

Applications téléchargées @) O
A Données personnelles de )

B . (@) X

lapplication téléchargée

Certificat public @) @) X
Autres Parametres (Wi-Fi, Bluetooth,

appels, son & notification, O X X

accessibilité, batterie)

E « Certaines données peuvent ne pas étre transmises, en fonction de la
version logicielle, de la version de lapplication, du systéme deexploitation et
de la politique du fabricant de lappareil ou de lopérateur.
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Bandes de fréquence prises en charge

Puissance de sortie de l'émetteur

GSM 900 33.7dBm
GSM 1800 30.7 dBm
W B1 24.7 dBm
W B8 25.5dBm
LTEB1 24.2 dBm
LTEB3 24.7 dBm
LTEB7 24.7 dBm
LTEB8 25.5dBm
LTEB20 25.5dBm
LTEB28 25.5dBm
LTEB38 25.2dBm
LTE B40 252 dBm
5G Sub6n1 24.7 dBm
5G Sub6n3 24.7 dBm
5G Sub6n28 24.5dBm
5G Sub6n40 252 dBm
5G Sub6n78 22.7dBm
BT 2.4GHz 11dBm
WLAN 2.4GHz 19.5dBm
WLAN 5GHz 19.dBm
NFC - 23 dBuA/m

Retrouvez les informations concernant ladaptateur de
voyage sur http7//www.lg.com/global/support/cedoc/cedoc
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Recyclage de votre ancien appareil

1. Ce symbole de poubelle barrée d'une croix indique que votre
équipement électrique et électronique (EEE) ne doit pas étre jeté
avec les ordures ménageres. Il doit faire [objet d'un tri et d'une collecte
sélective séparée.

2. Les équipements électriques que vous jetez peuvent contenir des
substances dangereuses. Il est donc important de les jeter de facon
appropriée afin déviter des impacts négatifs sur lenvironnement et la
santé humaine. Léquipement que vous jetez peut également contenir
des pieces réutilisables pour la réparation d'autres produits ainsi que des
matériaux précieux pouvant étre recyclés pour préserver les ressources
de la planete.

3. Vous pouvez rapporter votre appareil au commergant qui vous la
vendu ou contacter votre collectivité locale pour connaitre les points de
collecte de votre EEE. Vous trouverez également des informations a jour
concernant votre pays en allant sur www.quefairedemesdechets.fr

Recyclage des batteries/accumulateurs usagés

1. Ce symbole peut étre associé aux symboles chimiques du mercure
(Hg), du cadmium (Cd) ou du plomb (Pb) si la batterie contient plus de
0,0005 % de mercure, 0,002 % de cadmium ou 0,004 % de plomb.

2. Les batteries/accumulateurs doivent étre jetés séparément, dans les
déchetteries prévues a cet effet par votre municipalité ou étre rapportés
dans un magasin de téléphonie mobile.

3. La mise au rebut de vos batteries/accumulateurs dans une poubelle
appropriée ou dans un magasin de téléphonie mobile aidera a réduire les
risques pour environnement et votre santé.

4. Pour plus d'informations concernant le recyclage de vos batteries/
accumulateurs, veuillez contacter votre mairie, le service des ordures
ménageres ou encore le magasin ol vous avez acheté ce produit.
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FAQ

Ce chapitre répertorie quelques-uns des problemes que vous pouvez
rencontrer lors de ['utilisation de votre appareil. Certains dentre eux
nécessitent que vous appeliez votre opérateur, mais vous pouvez facilement
en résoudre la plupart par vous-méme.

Erreur carte SIM

Vérifiez que la carte SIM est correctement insérée.

Pas de connexion ou réseau perdu

Le signal est faible. Placez-vous pres d'une fenétre ou dans un espace ouvert.
Vous étes a lextérieur de la zone couverte par lopérateur. Déplacez-vous et
vérifiez le réseau.

Les appels sont indisponibles

Nouveau réseau non autorisé.

Assurez-vous de ne pas avoir interdit le numéro entrant.

Assurez-vous de ne pas avoir interdit le numéro que vous appelez.

Impossible d'allumer l'appareil
Si la batterie est totalement vide, lappareil ne sallume pas.
Procédez a une charge complete de la batterie avant dallumer lappareil
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Erreur de chargement
Chargez votre appareil dans des conditions de températures normales.
Vérifiez le chargeur et sa connexion a lappareil

Utilisez uniqguement les accessoires fournis dans lemballage, car ils sont
autorisés par LG.

La batterie se vide plus vite qu'a l'origine

L'exposition de lappareil ou de la batterie a des températures trés chaudes ou
tres froides peut réduire la durée de la batterie.

La consommation de la batterie augmente lors de ['utilisation de certaines
fonctionnalités ou applications (par exemple, GPS, jeux, Internet).

La batterie est un consommable dont la durée de vie diminuera avec le temps.

Des messages d'erreur apparaissent lors de l'activation de
l'appareil photo
Rechargez |a batterie.

Libérez de la mémoire en transférant des fichiers sur un ordinateur ou en en
supprimant.

Redémarrage de lappareil.

Si les problemes liés a lappareil photo persistent apres avoir suivi ces conseils,
contactez un centre de service LG Electronics.

La qualité des photos est mauvaise

La qualité de vos photos dépend de lenvironnement et des techniques
photographiques que vous utilisez.

Sivous prenez des photos et vidéos, la qualité sera meilleure avec un angle
standard quavec un grand angle.

Sivous prenez des photos dans des endroits sombres, la nuit ou en intérieur,
les images peuvent étre floues ou produire du bruit.

En cas de problémes, réinitialisez les options.
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L'écran tactile répond lentement ou de maniére incorrecte

Sivous utilisez un film protecteur ou dautres accessoires avec [écran tactile, il
est possible qu'il ne fonctionne pas correctement.

Le port de gants, l'utilisation de [écran tactile avec des mains sales, des objets
pointus ou le bout de vos doigts peut empécher le bon fonctionnement de
[écran tactile.

Lécran tactile risque de mal fonctionner dans des conditions humides ou s'il
est exposé a leau.

Redémarrez votre appareil pour éliminer des bugs logiciels temporaires.

Si lécran tactile est griffé ou endommagé, rendez-vous dans un centre de
service LG Electronics.

Le téléphone raccroche ou se fige

Redémarrez l'appareil
- Sivotre appareil se fige ou raccroche, vous devrez peut-étre fermer des
applications, ou éteindre lappareil et le redémarrer.
Réinitialisez l'appareil
- Une réinitialisation logicielle peut étre utilisée pour réinitialiser lappareil
si [écran se bloque, ou si les boutons, [écran tactile ou lappareil ne
répondent plus.

+ Pour effectuer une réinitialisation logicielle de votre apparelil, il suffit de
maintenir enfoncées les touches Diminuer le volume et Marche/Arrét
jusqua ce qu'il redémarre.

E « Cette fonction nest pas disponible lorsque lappareil est connecté au LG
Dual Screen (LM-G905N).
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Réinitialiser le périphérique
+ Siles méthodes ci-dessus ne parviennent pas a résoudre le probléme,
procédez a la réinitialisation des paramétres par défaut.

+ Sur [écran parametres, appuyez sur Systéme > Redémarrer &

Réinitialiser > Réinitialiser valeurs d'usine.

- Cette méthode réinitialise tous les parametres de lappareil et
suppression des données. Avant de procéder a la réinitialisation aux
valeurs d'usine, rappelez-vous de faire des copies de sauvegarde de
toutes les données importantes que contient lappareil.

Si vous avez enregistré un compte Google sur le téléphone, vous devez
vous connecter au méme compte Google apres avoir réinitialiser le
téléphone.

Lappareil Bluetooth n'est pas localisé

Assurez-vous que la fonctionnalité sans fil Bluetooth est activée sur votre
appareil

Assurez-vous que la fonctionnalité sans fil Bluetooth est activée sur appareil
auquel vous souhaitez vous connecter.

Assurez-vous que votre appareil et lautre appareil Bluetooth se trouvent
dans la plage Bluetooth maximale (10 m).

Si les conseils ci-dessous ne résolvent pas votre probléme, contactez un
centre de service LG Electronics.

La connexion ne s'établit pas lorsque vous connectez votre
appareil a un ordinateur

Assurez-vous que le cable USB que vous utilisez est compatible avec votre
appareil.

Assurez-vous davoir installé et mis a jour les pilotes appropriés sur votre
ordinateur.

Le téléchargement d'une application provoque de
nombreuses erreurs.

L'application rencontre des problemes.

Supprimez et réinstallez lapplication.
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Découvrir LG Dual Screen

Vous pouvez connecter un Double écran LG a ce produit pour ['utiliser.

E « Vous pouvez connecter le double écran LG (désormais le « Double écran »)
aun VELVET LG dédié (désormais « téléphone »), pour utiliser le produit.

« Certaines options du Dual Screen peuvent étre limitées en fonction des
performances du téléphone dédié. Le produit peut également ne pas
prendre en charge dautres appareils mobiles.

« Ce produit nest pas étanche. Ne mettez pas lappareil en contact avec des
liquides ou des éléments humides.

« Sil'appareil est mouillé, le LDI situé a l'intérieur de 'appareil change de
couleur. Dans ce cas, l'appareil n'est pas éligible aux services de réparation
gratuits fournis dans le cadre de la garantie limitée de ['appareil.

Recommandations pour une utilisation
siire et efficace

Veuillez lire ces recommandations. Leur non-respect peut savérer dangereux, voire
illégal.

Entretien et réparation

« Utilisez uniquement les accessoires fournis dans lemballage, car ils sont autorisés par
LG. LG noffre aucune garantie en cas de dommage ou de défaillance causée par des
accessoires fournis par un tiers.

+ Certains contenus et illustrations peuvent différer de votre appareil sans quaucun avis
préalable ne soit nécessaire.

+ Ne démontez pas le téléphone. Si une réparation savere nécessaire, confiez-le a un
technicien qualifié.

+ Les réparations couvertes par cette garantie peuvent inclure, a la discrétion de LG, des
piéces ou circuits de remplacement neufs ou reconditionnés, sous réserve que leurs
fonctionnalités soient équivalentes a celles des pieces remplacées.

+ Tenez votre téléphone éloigné des appareils électriques, tels que téléviseurs, postes
radio et ordinateurs personnels.
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Ne placez pas votre téléphone a proximité de sources de chaleur, telles qu'un radiateur
Ou une cuisiniere.

Ne le faites pas tomber.

Ne soumettez pas votre téléphone a des vibrations mécaniques ou a des chocs.

Eteignez votre appareil dans les zones ol des réglements spéciaux lexigent. Par
exemple, n'utilisez pas votre appareil dans les hdpitaux, car celui-ci pourrait perturber le
bon fonctionnement des équipements médicaux sensibles.

Sivos mains sont humides, ne manipulez pas lappareil lorsqu'il est en cours de charge.
Ceci peut provoquer une décharge électrique et endommager gravement votre appareil.

Pour nettoyer [extérieur de lappareil, utilisez un chiffon sec. N'utilisez pas de solvant, tel
que du benzene, un diluant ou de lalcool.

Nexposez pas le téléphone a de la fumée ou de la poussiere en quantité excessive.

Ne placez pas votre appareil a proximité de cartes de crédit ou de titres de transport, car
il pourrait altérer les données des bandes magnétiques.

Ne touchez pas [écran avec un objet pointu qui risquerait dendommager lappareil

Ne mettez pas lappareil en contact avec des liquides ou des éléments humides.

Evitez d'utiliser, de toucher ou de tenter de retirer ou de réparer du verre cassé,
ébréché ou fissuré. Un endommagement de [écran en verre causé par une utilisation
abusive ou incorrecte nest pas couvert par la garantie.

Votre appareil est un appareil électronique qui génere de la chaleur en
fonctionnement normal. Lors d'une utilisation prolongée dans un environnement
mal ventilé, le contact direct avec la peau peut provoquer une géne ou des
briilures bénignes. Manipulez dés lors votre appareil avec précaution lors de son
fonctionnement ou immédiatement apreés utilisation.

Sivotre appareil est mouillé, débranchez-le immédiatement et laissez-le sécher
totalement. Ne tentez pas d'accélérer le séchage avec une source de chaleur externe
(four classique ou micro-ondes, seche-cheveux..).

Le liquide contenu dans votre appareil lorsqu'il est mouillé modifie la couleur de
[étiquette produit se trouvant a lintérieur de appareil. Un endommagement de
lappareil consécutif a une exposition a des liquides n'est pas couvert par la garantie.

Un appareil mobile a besoin d'une bonne circulation dair pour détruire la chaleur. En
raison d'une circulation insuffisante du contact direct avec la peau et du flux dair sur
lappareil, lappareil peut étre trop chauffé. Lappareil doit mesurer au moins 1,0 cm
entre le corps de ['utilisateur.
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+ Assurez-vous que le produit nentre pas en contact avec de leau. Vous ne devez
pas utiliser ou charger le produit s'il est mouillé. Lorsque le produit a été mouillé,
lindicateur de dommage causé par un liquide change de couleur. Cela annule les
services de réparation gratuits dans le cadre de la garantie.

Fonctionnement optimal de l'appareil

Appareils électroniques

Tous les appareils portables peuvent étre soumis a des interférences pouvant affecter
leurs performances.

+ Nutilisez pas votre appareil a proximité déquipements médicaux sans autorisation.
Demandez l'avis de votre médecin afin de déterminer si le fonctionnement de
votre appareil est susceptible d'interférer avec le fonctionnement de votre appareil
médical.

Les appareils peuvent nuire au bon fonctionnement de certaines protheses
auditives.

Pour les porteurs d'implants électroniques, des précautions sont a prendre : utilisez
le téléphone sur le coté opposé a limplant.

Des interférences mineures peuvent perturber le bon fonctionnement des
téléviseurs, radios, ordinateurs, etc.

Utilisez si possible votre appareil dans une plage de températures comprise entre
0 °Cet 35 °C. Exposer votre appareil a des températures extrémement basses
ou hautes peut lendommager ou provoquer des dysfonctionnements, voire le faire
exploser.

Stimulateurs cardiaques

Les fabricants de stimulateurs cardiagues recommandent de maintenir une distance
minimale de 15 cm entre un téléphone portable et un stimulateur cardiaque afin
déviter toute interférence avec ce dernier. Pour ce faire, utilisez le téléphone sur loreille
opposée a votre stimulateur cardiaque et ne le transportez pas dans une poche de
chemise.

Hopitaux

Eteignez votre appareil sans fil lorsque cela vous est demandé dans les hopitau,
cliniques et établissements de santé ; ce type d'appareil peut en effet provoquer des
interférences avec des équipements médicaux sensibles.

LG Dual Screen (LM-G905N) 180



Sécurité au volant

Vérifiez les lois et réglements en vigueur en matiere d'utilisation des appareils dans la
zone ol vous conduisez.

N'utilisez pas d'appareil portatif en conduisant.

Concentrer toute votre attention sur la conduite.

Utilisez un kit mains libres, si disponible.

Si les conditions de conduite le permettent, quittez la route et garez-vous avant
démettre ou de recevoir un appel.

Les radiofréquences peuvent affecter certains systemes électroniques de votre
véhicule motorisé, tels que le systéme audio stéréo ou les équipements de sécurité.

Lorsque votre véhicule est équipé d'un airbag, ne génez pas son déclenchement
avec un équipement sans fil portable ou fixe. Il risquerait de lempécher de souvrir ou
provoquer de graves blessures en raison de performances inadéquates.

Lorsque vous écoutez de la musique en extérieur, veuillez vous assurer que le
volume niest pas trop élevé de facon a bien entendre ce qu'il se passe autour de
vous. Ceci est particulierement important a proximité des routes.

Parties en verre

Certaines parties de votre téléphone portable sont en verre. Ce verre pourrait se briser
en cas de chute sur une surface dure ou d'impact considérable. Dans ce cas, évitez de
toucher ou de retirer le verre brisé. N'utilisez plus votre téléphone portable jusqua ce
que ce verre soit remplacé par un fournisseur de service agréé.

Zone de déminage

N'utilisez pas lappareil lorsque des opérations de dynamitage sont en cours. Respectez
les restrictions, les reglements et les lois en vigueur.

Zones a atmospheére explosive
+ Nutilisez pas votre appareil dans une station-service.
+ Nutilisez pas votre téléphone a proximité de carburant ou de produits chimiques.

Ne transportez pas ou ne stockez pas des produits dangereux, des liquides ou des
gaz inflammables dans le méme compartiment de votre voiture que votre appareil
OU Ses accessoires.
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En avion
Les appareils sans fil peuvent générer des interférences dans les avions.
- Eteignez votre appareil avant dembarquer dans un avion.

+ Ne lutilisez pas au sol sans autorisation de [équipage.

Enfants

Conservez lappareil dans un endroit sir; hors de portée des enfants. En effet, un enfant
risquerait de sétouffer avec les petites pieces.
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Composants du produit et accessoires

Les accessoires suivants sont inclus avec votre produit.

+ Produit + Guide de démarrage rapide

- Adaptateur de chargement

A .

Assurez-vous de n'utiliser que les accessoires dorigine fournis par LG
Electronics. Utiliser des produits non dorigine peut entrainer la détérioration
de la qualité de l'appel téléphonique, un dysfonctionnement de lappareil,
etc. Dans ce cas, il se peut que vous ne pouviez pas recevoir les services
proposés par LG Electronics.

Certaines parties du Dual Screen sont en verre trempé. Si vous laissez
tomber ce produit sur une surface dure ou le soumettez a de forts impacts,
le verre trempé risque détre endommagé. Dans ce cas, cessez d'utiliser
votre produit immeédiatement et contactez un centre de service client LG.

L'apparence et les spécifications de votre produit peuvent étre changées
sans préavis.

Lextérieur du Dual Screen et ses spécifications peuvent changer sans
notification préalable afin d'améliorer ses performances.
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Présentation des piéces

Avant

119
Il

(5
%/Lh_J 164
1—0
@ Cover Display @ Ecran du produit

Borne de communication/
alimentation

® Touche Google Assistant @ Port a broches Pogo

@ Touches de volume

O Prise pour écouteurs

5 « Ce manuel est concu pour les utilisateurs connectant leur téléphone au
Double écran. Pour en savoir plus sur comment utiliser le Double écran et le
téléphone, visitez www.lg.com et consultez le manuel d'utilisation détaillé.
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Brancher le téléphone au Dual Screen

1 Dépliez complétement le Dual Screen pour qu'il soit paralléle a une
surface plane.

2 Glissez le bas de votre téléphone dans le bas du Dual Screen comme
montré sur a figure. En méme temps, vérifiez que la partie 0 du
téléphone semboite correctement a la partie @ du Dual Screen.

LG Dual Screen (LM-G905N) 185



3 Appuyez sur la partie @) du téléphone avec votre doigt pour emboiter
lextrémité du téléphone avec le Dual Screen.

N

U

4 Appuyez sur la partie o du téléphone pour emboiter complétement le

téléphone au Dual Screen.

—— =

7

!
—~

A « Assurez-vous que votre téléphone est correctement inséré dans le Dual
Screen avant de ['utiliser.
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Extraire le téléphone du Dual Screen

1 Dépliez complétement le Dual Screen et tenez-le fermement a deux
mains comme illustré sur la figure.

»

N\

7 Appuyez sur la partie 0 du Dual Screen avec votre doigt tout en
appuyant simultanément sur le dos du téléphone avec vos autres doigts
pour sortir lextrémité du téléphone du Dual Screen.

o
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3 Sortez la partie 0 du téléphone du Dual Screen en suivant les mémes
instructions que pour [étape précédente.

4 Tenez le Dual Screen a deux mains et glissez le téléphone dans le sens
de la fleche pour le retirer. Veillez a ne pas pencher le téléphone vers la
gauche ou la droite, ou a trop lincliner.

/\ AVERTISSEMENT :
+ Ne pas trop incliner le téléphone du Dual Screen comme montré ci-dessous.
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A « Sivous inclinez trop le téléphone ou si vous exercez une force excessive
pour le retirer du Dual Screen, vous pouvez endommager la borne de
communication/alimentation située en bas du Dual Screen ou les ports USB
de communication de données et du chargeur du téléphone. Assurez-vous
de pousser le téléphone dans le sens de la fleche comme indiqué sur la
figure pour le retirer.

« Faites attention de ne pas faire tomber le Dual Screen ni le téléphone lors
de l'insertion ou du retrait de ce dernier.

- Quand vous insérez ou retirez votre téléphone du Dual Screen, veillez a ne
pas exercer trop de force. Cela pourrait endommager le Dual Screen.

Certaines parties de votre Dual Screen sont en verre trempé. Si le Dual
Screen chute sur une surface dure, ou s'il est soumis a un fort impact, le
verre trempé pourrait se briser ou se fissurer, ce qui pourrait endommager
le Dual Screen ou entrainer des blessures. Si cela survient, n'utilisez plus le
Dual Screen, et rendez-vous aupres du service client LG le plus proche pour
le faire réparer.
« Dans les situations suivantes, le rabat du Dual Screen peut ne pas
fermer entiérement ou il se peut que le Dual Screen ne fonctionne pas
normalement en raison d'une faible communication ou d'une erreur de
connexion de la borne d'alimentation.
- Sivous fixez un film ou un verre de protection, ou tout autre accessoire
sur le Dual Screen ou [écran de votre téléphone.
- Sivous fixez un film de protection ou des autocollants épais sur la zone
de connexion du Dual Screen ou a larriere de votre téléphone.
- Sivous insérez des cartes en papier rigide entre le Dual Screen et votre
téléphone.
« Sivous utilisez le chargement sans fil ou la fonction NFC pendant que

votre téléphone est inséré dans le Dual Screen, le chargement peut ne pas
fonctionner correctement.

Quand le téléphone est fixé au Dual Screen, il ne peut pas étre connecté
a un téléviseur avec un cable HDMI. Quand le téléphone est retiré du Dual
Screen, il peut étre connecté a un téléviseur avec un cable HDMI.
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Utiliser l'adaptateur de chargement

Vous pouvez utiliser ladaptateur de chargement pour charger votre
téléphone ou transférer des données quand votre téléphone est inséré dans
le Dual Screen.

T Avec le téléphone monté sur le Dual Screen, connectez ladaptateur de
chargement au port de chargement situé en bas du Dual Screen, comme
montré sur la figure ci-dessous.

,/
P

ort a broches Pogo

~
e—— Adaptateur de
chargement

E « Pogo Pin ne fonctionnera pas s'il est connecté a lenvers.

« La connexion USB via Pogo Pin ne prend pas en charge OTG, audio, HDMI ni
USB 3.0. Pour ces connexions, connectez directement le cable au port sur le
téléphone apres avoir retiré le Dual Screen.
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2 Connectez un cable USB type C.
+ Vous pouvez charger le téléphone ou transférer les données.

Connecteur du cable de chargement P

E « Sivous n'utilisez pas l'adaptateur de chargement, débranchez le chargeur
de lalimentation et retirez-le du connecteur du cable de chargement. Si la
partie magnétique de ladaptateur de chargement entre en contact avec
des éléments métalliques proches ou des substances conductrices, un choc
électrique peut le casser; le briler ou lendommager.

« Assurez-vous de toujours utiliser ladaptateur de chargement fourni avec
le Dual Screen. Si vous perdez l'adaptateur de chargement ou souhaitez en
acheter un neuf, appelez le centre de service clientele de LG Electronics pour
en savoir plus.

L'adaptateur de chargement et le port de chargement situés au bas du Dual
Screen possedent une connexion magnétique. Ne pas secouer ni extraire
ladaptateur de chargement pendant son utilisation.
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Utiliser le Dual Screen

Décrocher et raccrocher l'appel avec la touche Google

Assistant

Avec Dual Screen et le téléphone connecté, vous pouvez répondre a lappel
en appuyant une fois sur la touche Google Assistant. Pour terminer appel,
appuyez sur la touche Google Assistant deux fois pour raccrocher.
+ Vous pouvez décrocher ou raccrocher avec la touche Google Assistant
uniquement si le cache du Dual Screen est entiérement fermé.

+ Assurez-vous que le produit et le téléphone sont connectés via au moins
une synchronisation.

Effectuer un appel
Pour effectuer un appel, dépliez le Dual Screen 360° ou repliez-le a 0°.

+ Sivous utilisez le Dual Screen en le pliant a 360°, assurez-vous que lavant
et larriere du Dual Screen font bien contact. Dans ce cas, [écran du Dual
Screen séteint automatiquement pour faire des économies dénergie.

360 ° 0°
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Utiliser le Dual Screen
Dépliez le Dual Screen pour mettre les deux écrans cote a cote.

/ B
Ecrandu —f—— 4 Fcrandu
produt/ téléphone

Réglage de la couleur de écran

Lorsque vous utilisez en méme temps [écran du produit et [écran du
téléphone, une différence de couleur peut étre remarquée entre les deux
écrans.

- Essayez d'ajuster la température de couleur. Sur [écran d'accueil, appuyez
sur Parameétres > Ecran > Couleur de l'écran puis ajustez la température
de la couleur.

+ Les couleurs peuvent sembler différentes en fonction de langle de vision :
réglez donc les couleurs avec le produit completement déplié.

Utiliser 'accueil de Dual Screen

Découvrir l'accueil de Dual Screen

L'accueil de Dual Screen peut fonctionner séparément de [écran du produit.
- Il fournit des icones de lancement rapide et une barre tactile d'accueil

- Vous pouvez changer larriere-plan et configurer les widgets.

+ Sur [écran daccueil, vous pouvez aussi lancer différentes applications
depuis le tiroir dapplications et générer ou supprimer des dossiers.
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Découvrir la disposition de l'accueil Dual Screen

Vous pouvez utiliser plusieurs fonctions en exécutant les icones fournies sur
[écran daccueil.

»— Zone d'acces rapide

Barre de navigation.

E « Larriére-plan du Dual Screen peut varier de la figure en fonction des
politiques du fabricant, les parametres de ['utilisateur, les versions logicielles,
les services fournis par les opérateurs de télécommunication, etc.

- Zone d'acces rapide : Ancrage des principales applications en bas de
[écran pour quelles restent accessibles depuis n'importe quelle page de
[écran daccueil.

- Barre de navigation :\ous pouvez faire certains gestes pour aller a
[écran dAccueil, [écran précédent, [écran dApercu ou basculer rapidement
entre les applications.

LG Dual Screen (LM-G905N) 194



Utilisation du tableau de bord du Dual Screen

Vous pouvez ouvrir le Tableau de bord du Dual Screen en faisant glisser vers
le bas la partie supérieure de [écran.

- Vous pouvez ajuster la luminosité de [écran sur le Tableau de bord du Dual
Screen.

- Sivous activez la synchronisation en sélectionnant Synchro, la
luminosité de [écran du double écran se synchronise avec celle du
produit connecté.

- Vous pouvez appuyer sur Capture d'écran pour capturer [écran du
produit.

+ Vous pouvez désactiver [écran du produit en appuyant sur Dual Screen.
- Le Dual Screen et le téléphone connecté sont déconnectés.

- Vous pouvez appuyer sur [ pour accéder au menu de configuration du
double écran.

4 «—— Paramétres Dual Screen
Ajuster la luminosité de -1
T

Capture décran ——— e—— Dual Screen
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Changer l'accueil du Dual Screen
Maintenez enfoncé une zone vide de laccueil de Dual Screen et lancez la
fonction souhaitée.

- Pour ajouter un widget a votre écran d'accueil, restez appuyé sur une zone
vierge de votre écran daccueil, puis sélectionnez Gadgets.

Pour modifier les fonds décran, restez appuyé sur une zone vierge de
votre écran daccueil, puis sélectionnez Fonds d'écran.

Pour changer [écran par défaut, maintenez le doigt appuyé sur une zone
vierge de [écran d'accueil, déplacez-vous sur [écran souhaité, appuyez sur
), puis appuyez une fois de plus sur lécran.

Ecran par défaut

Gadgets | L Fond décran
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Affichage de larriére-plan du Dual Screen

Vous pouvez visualiser uniquement l'image darriere-plan en masquant les
applications et les widgets sur [écran daccueil

Ecartez deux doigts sur [écran daccueil

+ Pour revenir a [écran dorigine, qui affiche les applications et les widgets,
rapprochez vos doigts sur [écran d'accueil ou appuyez sur <]

Réglage de l'environnement du Dual Screen

Vous pouvez définir lenvironnement du Dual Screen sur le téléphone
connecté au double écran.

1 Surlécran d'accueil, appuyez sur Paramétres > Ecran > Dual Screen.

E « Vous devez connecter votre téléphone au Dual Screen pour voir [élément de
menu pour ajuster environnement du Dual Screen.
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2 Sélectionnez et ajustez les fonctions désirées.

+ Mise en veille de l'écran : Vous pouvez aussi le définir pour afficher le
cache sur lavant du Dual Screen.

- Délai d'expiration quotidien: \ous pouvez le définir pour utiliser les
deux écrans a la fois.

+ Outil Dual Screen : Sivous connectez votre téléphone au Dual Screen,
les outils du Dual Screen s'affichent a [écran. Le niveau de luminosité
est synchronisé a celui du Dual Screen.

« Utiliser Dual Screen : Vous pouvez allumer ou éteindre le Dual Screen,
et passer entre les écrans du téléphone et du Dual Screen.

- Pliage inverse :Vous pouvez définir le comportement de [écran
opposé quand le double écran est rabattu vers arriere.

+ Luminosité : Vous pouvez régler la luminosité de [écran en faisant
glisser la barre de contrdle vers la gauche ou la droite.

- Conserver les parametres de luminosité de l'écran principal :
Vous pouvez synchroniser la luminosité a celle du téléphone.

- Affichage étendu :\ous pouvez ajuster une application pour quelle se
développe sur les deux écrans.

+ Fond d'écran: Vous pouvez sélectionner le fond décran pour [écran
daccueil

+ Icones de l'onglet App :Vous pouvez afficher ou masquer le tiroir des
applications sur votre produit.

- Raccourci vers plusieurs apps : Vous pouvez définir lexécution de
deux applications sur [écran principal et le double écran en méme
temps.

« Application Mon choix : ous pouvez sélectionner les applications
pour les lancer automatiquement a chaque activation du Dual Screen.

E « Laliste des applications présentes a [écran peuvent varier en fonction des
applications installées.
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Outil Dual Screen

Si vous connectez votre téléphone au Dual Screen et allumez le Dual Screen,
les Outils Dual Screen 9 saffichent sur le coté de [écran du téléphone.
Appuyez sur J pour ouvrir le menu Outils Dual Screen et accéder aux
options montrées ci-dessous.

% / @ Vous pouvez appuyez légerement dessus pour afficher ou masquer le
menu Outils Dual Screen.

@ Vous pouvez basculer entre les écrans entre le Dual Screen et le
téléphone.

@ Vous pouvez envoyer [écran depuis le téléphone au Dual Screen.

@ Vous pouvez ramener [écran du Dual Screen au téléphone.

Sivous n'utilisez que le Dual Screen, vous pouvez diminuer la luminosité
de [écran du téléphone (écran principal) pour économiser la batterie. Si
vous ne voulez pas utiliser cette fonction, balayez [écran principal.

@ Vous pouvez désactiver Dual Screen.

B

»—— (Outil Dual Screen

»—— Changer décran

»—— Montrer ['affichage principal
sur Dual Screen

»—— Montrer Dual Screen sur
laffichage principal

»—— Mettre en veille [écran
principal

*— Désactiver Dual Screen
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E « Sivous désactivez votre téléphone, le Dual Screen se désactivera aussi.
Néanmoins, si vous désactivez le Dual Screen, le téléphone restera allumé.

« Cette fonction n'est pas disponible sur [écran de verrouillage et est activée
si vous déverrouillez [écran.

Utiliser le mode Multi-page

Vous pouvez développer utilisation d'une application a [écran principal et au
Dual Screen pour plus de commodité.

E « Cette fonction est aussi disponible pour les applications partenaires, en plus

des applications de Caméra et de Galerie.
« LUl peut différer en fonction de 'application utilisée.

LG Dual Screen (LM-G905N) 200



Utiliser le mode Multi-page dans Caméra

Vous pouvez prendre une photo ou une vidéo sur le téléphone ou le Dual

Screen et voir le résultat sur lautre écran.

1 Sur lécran daccueil, appuyez sur (&) sur le téléphone ou le Double écran et
prenez une photo ou une vidéo.

2 Apres avoir pris une photo ou une vidéo, sélectionnez licéne dApercu.

+ Vous pouvez voir la photo ou la vidéo que vous avez prise sur lautre
écran quand la caméra ne fonctionne pas.

|
Icéne de
prévisualisation

E + Quand vous avez appuyé sur l'icone de prévisualisation pour voir une photo
ou une vidéo, [écran d'apercu reste allumé et affiche automatiquement
la derniere photo ou vidéo prise quand vous prenez plus de photos ou de
vidéos

« Cette fonction n'est plus active si vous éteignez l'application de Caméra et
la rallumez ensuite.
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Utiliser le mode Multi-page dans Galerie

Appuyez sur [4J[] dans un dossier de la Galerie sur le Dual Screen ou le
téléphone pour voir une photo ou vidéo en plus grand sur lautre écran.

T Surlécran daccueil, appuyez sur 3 sur le téléphone ou le Double écran.

2 Sélectionnez lalbum puis appuyez sur [<[J.
+ La photo ou la vidéo saffichera en plus large sur [écran opposé.

+ Appuyez sur ()] pour abandonner cette fonction.

Icone Extension Icbne Restaurer

l

B
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Utiliser 'application Dual Screen

A chaque fois que vous activez le double écran, les applications prédéfinies du

double écran slexécutent automatiquement.

1 Sur lécran d'accueil, appuyez sur Paramétres > Ecran > Dual Screen >
Application Mon choix.

7 Sélectionnez les applications qui sexécuteront automatiquement a
chaque activation du Dual Screen.

E « Certaines applications ne peuvent pas étre exécutées comme applications
double écran.

« Laliste des applications présentes a [écran peuvent varier en fonction des
applications installées.

Faire un appel vidéo avec Dual Screen
Vous pouvez afficher votre image sur le Dual Screen et l'image de votre
interlocuteur sur le téléphone.
- Lancez un appel vidéo sur votre téléphone.
- Limage de votre interlocuteur saffiche sur [écran du téléphone et votre
image saffiche dans le coin inférieur droit de [écran du téléphone.
- Appuyez sur 5] en haut de [écran du téléphone pour afficher votre image
sur le Dual Screen.

- Appuyez sur [38] de nouveau pour revenir au mode daffichage
précédent.

5 « Le titre en haut et le bouton en bas saffichent en méme temps et
disparaissent 4 secondes plus tard.

+ Quand vous faites ou vous répondez un appel vidéo sur le téléphone, vous
pouvez utiliser d'autres applications ou fonctions sur le Dual Screen.
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Se déplacer entre les écrans d'application sur le Dual

Screen

Vous pouvez balayer [écran avec trois doigts pour déplacer un écran
d'application entre le Dual Screen et le téléphone.

- Balayez [écran dapplication vers la gauche ou la droite avec trois doigts
pour le déplacer librement entre [écran principal et le double écran.

Y \
> =

I\

Balayer [écran dapplication avec trois doigts Déplacer [écran d'application a [écran principal
Balayer [écran d'application avec trois doigts Déplacer [écran dapplication a lécran du Dual
Screen

E - Pour utiliser cette fonction, il faut que trois doigts touchent [écran en méme
temps.
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Utiliser le double clavier sur Dual Screen

Quand vous utilisez le clavier en mode paysage, vous pouvez développer le
clavier verticalement et utilisez [écran supérieur comme écran d'application et
[écran du bas comme écran de clavier.

1 Basculez le double écran en mode paysage sur [écran de saisie du clavier.
2 Appuyez sur &3 dans la fenétre de saisie du clavier du double écran.

« Vous pouvez saisir sur le clavier de [écran du bas tout en lisant le texte
saisi sur [écran du haut.

- Appuyez sur f en mode développé pour que le clavier inférieur
retourne a sa position normale.

Clavier Double

E + Pour déplacer [écran d'application vers le haut ou le bas, appuyez
simultanément avec trois doigts sur [écran tout en le faisant glisser vers
le haut ou vers le bas. Voir Se déplacer entre les écrans dapplication sur le
Dual Screen pour plus de détails.
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Utiliser le Mode partage d'écran sur Dual Screen

Quand vous prenez des photos avec la caméra, vous pouvez les prévisualiser
sur le double écran.

T Sur lécran daccueil, appuyez sur ().
2 Appuyez sur ][] en haut de [écran de la caméra.
- Le Mode partage d'écran saffiche sur le Dual Screen.

Mode partage décran

rl

o\ I\

E + Vous pouvez aussi prendre des photos ou des vidéos directement depuis le
double écran.

Utilisez le double écran pour ajuster langle pour les différentes situations
mentionnées ci-dessous.

+ Vue grand angle : sert a capturer une image avec une foule de personnes,
comme lors d'un concert ou d'un festival, ou pour capturer limage d'un
grand espace.

+ Vue contre-plongée : cela sert a capturer une image de votre enfant a la
hauteur de ses yeux, ou pour capturer une image de gratte-ciels, par ex.

Prise grand angle Prise en contre-plongée
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Utiliser Capturer Instant sur Dual Screen
Quand le téléphone est connecté au Dual Screen, la fonction Capturer
Instant 3] est activée sur le clavier LG.
Vous pouvez utiliser le clavier sur [écran principal, capturer [écran sur le
double écran et linsérer directement dans la fenétre de saisie du clavier.
Appuyez sur B9 sur [écran de saisie du Clavier LG.

+ LBcran du double écran est capturé et automatiquement attaché a la

fenétre de saisie du clavier.
Y

l-i Capturer Instant

s — Ecran capturé

)\

E + Vous ne pouvez pas développer le clavier sur les deux écrans avec cette
option activée.
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LG Game Pad

Vous pouvez utiliser des manettes virtuelles sur [écran du produit pour jouer
a des jeux sur le téléphone. Lorsque vous jouez, séparez [écran principal et le
double écran pour que la manette ne bloque pas [écran de jeu.

1 Sur[écran daccueil, appuyez sur Lanceur De Jeu et sélectionnez LG
Game Pad @

LG Game Pad

- Le LG Game Pad s’affiche sur [écran du produit.

2 Appuyez sur @ puis balayez vers la gauche ou la droite pour choisir votre
LG Game Pad préféré.
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Vous pouvez jouer au jeu en tenant le Dual Screen comme illustré ci-dessous.

E + Le LG Game Pad nest disponible que pour les jeux prenant en charge les
boitiers de commande physiques.

- Enfonction du jeu, certaines applications ou boutons peuvent ne pas
prendre en charge le LG Game Pad.
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Créer un Game Pad personnalisé

En plus du LG Game Pad, vous pouvez personnaliser votre propre manette
de jeu. Vous pouvez créer votre propre manette se synchronisant avec les
touches pour jouer au jeu.

1 Lancez le jeu sur le Dual Screen.

« Tournez lappareil a l'horizontal pour que le Dual Screen soit en haut et
[écran du téléphone est en bas.

Ve

A

2 Sur lécran daccueil, appuyez sur Lanceur De Jeu et sélectionnez LG
Game Pad @ puis balayez vers lextrémité droite de [écran.

« Créer un Custom Game Pad saffiche sur [écran.
« Appuyez sur = sur [écran Créer un Custom Game Pad.
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3 Appuyez sur - en haut a droite de [écran Game Pad personnalisé
pour afficher les touches sélectionnées, et sélectionnez une touche pour
[utiliser sur mon Game Pad personnalisé.

+ Latouche sélectionnée saffiche sur [écran Game Pad personnalisé.

/. Quand vous regardez lécran de jeu sur le Dual Screen, placez la touche
sélectionnée a lemplacement souhaité de votre écran de téléphone.

+ Sélectionnez [§ sur le jeu du Dual Screen et synchronisez-le avec la
nouvelle touche créée.

+ Ajustez la position et la taille a la nouvelle touche créée sur votre écran
de téléphone.

E - En utilisant la nouvelle touche créée sur votre écran de téléphone, vous
pouvez avoir le méme effet quen l'utilisant sur le Dual Screen.
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5 Appuyez sur \/ pour enregistrer Game Pad personnalisé.

+ Quand vous enregistrez le Game Pad personnalisé, le titre du jeu est
utilisé comme titre du Game Pad personnalisé.

E + Le Game Pad personnalisé que vous avez créé sera la manette dédiée au
jeu.
+ Certaines touches peuvent ne pas fonctionner quand le jeu sera mis a jour.
- Le Game Pad personnalisé ne peut étre créé que sur lécran du téléphone.
Le Dual Screen ne le prend pas en charge.
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Marques commerciales
+ Copyright ©2020 LG Electronics Inc. Tous droits réservés. LG et le logo LG
sont des marques déposées de LG Group et de ses entités apparentées.

- Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Google Photos, Google Play Protect, Google Calendar, Google
Docs, Google Drive, Google Sheets et d'autres marques et logos associés
sont des marques commerciales de Google LLC.

- Tous les autres marques commerciales et tous les autres droits dauteur
sont la propriété de leurs propriétaires respectifs.

DECLARATION DE CONFORMITE

Par la présente, LG Electronics déclare que le produit LM-G905N
est conforme aux exigences fondamentales et aux autres dispositions
pertinentes de la directive 2014/35/EU et 2014/30/EU.

Consultez la Déclaration de conformité sur
http//www.lg.com/global/declaration

Contactez notre service pour
connaitre les normes auxquelles ce
produit est conforme

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands
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En savoir plus

Précautions de manipulation du produit
Ce produit ne peut pas étre utilisé seul.

Ne pas utiliser ou charger le Dual Screen si la borne de communication ou

d'alimentation du Dual Screen est humide.

- Cela pourrait causer un incendie, un choc électrique, une blessure ou un
dysfonctionnement de lappareil.

- En cas de présence d'humidité, cessez d'utiliser votre appareil
immédiatement et retirez toute humidité.

Le liquide contenu dans votre appareil lorsqu'il est mouillé modifie la
couleur de [étiquette Dual Screen se trouvant a lintérieur de lappareil. Un
endommagement de lappareil consécutif a une exposition a des liquides
nest pas couvert par la garantie.

Parties en verre trempé
Les parties en verre trempé de cet appareil ne sont pas permanentes et
peuvent s'user au fil du temps.

+ Sivous laissez tomber cet appareil sur une surface dure ou le soumettez a
de forts impacts, le verre tempéré risque détre endommagé.
Dans ce cas, cessez d'utiliser votre appareil immédiatement et contactez
un centre de service client LG.

- Vous pouvez acheter des étuis protecteurs pour protéger votre appareil de
tout dommage dans le commerce.

Notez que ces étuis protecteurs ne sont pas couverts par la garantie
fournie par LG Electronics et leurs sécurité n'est pas garantie.

Utilisation de la batterie
+ Ce Dual Screen n'utilise pas sa propre batterie.

+ Sile Dual Screen est monté avec un téléphone, il utilise la batterie du
téléphone.
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Recyclage de votre ancien appareil

1. Ce symbole de poubelle barrée d'une croix indique que votre
équipement électrique et électronique (EEE) ne doit pas étre jeté
avec les ordures ménageres. Il doit faire lobjet d'un tri et d'une collecte

_— sélective séparée.

. Les équipements électriques que vous jetez peuvent contenir des
substances dangereuses. Il est donc important de les jeter de fagon
appropriée afin déviter des impacts négatifs sur lenvironnement et la
santé humaine. Léquipement que vous jetez peut également contenir
des pieces réutilisables pour la réparation dautres produits ainsi que
des matériaux précieux pouvant étre recyclés pour préserver les
ressources de la planéte.

N

3. Vous pouvez rapporter votre appareil au commergant qui vous la
vendu ou contacter votre collectivité locale pour connaitre les points
de collecte de votre EEE. Vous trouverez également des informations
ajour concernant votre pays en www.lg.com/global/recycling
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. DEUTSCH
Uber dieses Benutzerhandbuch

Vielen Dank, dass Sie sich fir dieses LG Produkt entschieden haben. Lesen Sie
dieses Benutzerhandbuch vor der erstmaligen Verwendung des Gerats sorgfaltig
durch, um die sichere und ordnungsgemaRe Verwendung zu gewahrleisten.
+ Verwenden Sie ausschlieRlich Originalzubehor von LG. Die mitgelieferten
Artikel sind nur fir die Verwendung mit diesem Gerat vorgesehen und sind
maglicherweise nicht mit anderen Geraten kompatibel.

Die Beschreibungen basieren auf den Standardeinstellungen des Geréts.

StandardmaRig auf dem Gerat vorinstallierte Apps unterliegen Aktualisierungen.
Moglicherweise werden diese Apps ohne vorherige Ankindigung nicht mehr
untersttzt. Sollten Sie Fragen zu einer auf dem Gerat vorinstallierten App
haben, wenden Sie sich bitte an ein LG Servicezentrum. Bei benutzerinstallierten
Apps wenden Sie sich bitte an den entsprechenden Anbieter.

+ Das Verandern des Betriebssystems des Gerats oder das Installieren von
Software von inoffiziellen Quellen kann zu Schaden am Gerat und zu
Beschadigung oder Verlust von Daten fihren. Derartige Handlungen stellen
Verst6Re gegen Ihre Lizenzvereinbarung mit LG dar und haben das Erloschen
der Garantie zur Folge.

« Einige Inhalte und Abbildungen weichen je nach Region, Dienstanbieter;
Softwareversion oder Version des Betriebssystems moglicherweise von lhrem
Gerat ab und unterliegen Anderungen ohne Vorankindigung.

- Software, Audiodateien, Hintergrundbilder, Bilder sowie andere Medien auf
diesem Gerat unterliegen einer Lizenzvereinbarung fur die eingeschrankte
Nutzung. Wenn Sie diese Materialien fir gewerbliche oder sonstige Zwecke
extrahieren und verwenden, stellt dies méglicherweise einen Verstol? gegen
Urheberrechtsgesetze dar. Als Benutzer tragen Sie die volle Verantwortung bei
illegaler Verwendung von Medien.

+ Eskonnen zusatzliche Kosten fiir Datendienste wie den Versand von
Nachrichten, das Hochladen und Herunterladen von Inhalten, die automatische
Synchronisation oder die Verwendung von Standortdiensten anfallen. Wahlen
Sie einen Ihren Anforderungen entsprechenden Datentarif aus, um zusatzliche
Kosten zu vermeiden. \Wenden Sie sich an Ihren Netzanbieter, wenn Sie weitere
Informationen wiinschen.

« Dieses Benutzerhandbuch wurde in den Hauptsprachen jeden Landes verfasst.
Je nach Sprache kann der Inhalt teilweise voneinander abweichen.



Gebrauchshinweise

WARNUNG: Situationen, die zu Verletzungen des Benutzers und Dritter fihren
kénnen

ACHTUNG: Situationen, die zu kleineren Verletzungen oder Schaden am Gerat
fihren kénnen

E HINWEIS: Hinweise oder weitere Informationen

Uber dieses Benutzerhandbuch
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Richtlinien fiir den sicheren und
effizienten Gebrauch

Lesen Sie diese einfachen Richtlinien sorgfaltig durch. Die Nichtbeachtung dieser Richtlinien
kann gefahrlich oder gesetzeswidrig sein. Sollte eine Storung auftreten, sorgt ein in lhrem
Gerat integriertes Software-Tool dafir, dass ein Fehlerprotokoll erstellt wird. Dieses Tool erfasst
nur Informationen tber die aufgetretene Stérung wie z. B. Signalstarke, Cell ID Position bei
plotzlichem Gesprachsabbruch und geladene Apps. Das Protokoll dient ausschlieRlich dazu,

die Ursache der Stérung zu bestimmen. Die Protokolle sind verschliisselt und kénnen nur von
einem autorisierten LG-Reparaturzentrum abgerufen werden, falls Sie lhr Gerat zur Reparatur
geben mussen.

Sicherheitshinweis (iber die Einwirkung
elektromagnetischer Energie im Radiofrequenzbereich

Informationen zur Einwirkung elektromagnetischer Felder und zur Spezifischen
Absorptionsrate (SAR).

Dieses Gerét entspricht den geltenden Sicherheitsbestimmungen hinsichtlich der Einwirkung
elektromagnetischer Felder. Diese Bestimmungen basieren auf wissenschaftlichen Richtlinien,
die auch Sicherheitsabstande definieren, um eine gesundheitliche Gefahrdung von Personen
(unabhangig von Alter und allgemeinem Gesundheitszustand) auszuschlieRen.

+In den Richtlinien hinsichtlich der Einwirkung elektromagnetischer Felder wird eine
MaReinheit verwendet, die als Spezifische Absorptionsrate bzw. SAR bezeichnet wird. Der
SAR-Wert wird mit standardisierten Testmethoden ermittelt, bei denen das Gerat in allen
getesteten Frequenzbandern mit der hochsten zulassigen Sendeleistung betrieben wird.

+ Auch wenn Unterschiede zwischen den SAR-Werten verschiedener LG-Gerdtemodelle
bestehen, entsprechen sie in jedem Fall den geltenden Richtlinien hinsichtlich der
Einwirkung elektromagnetischer Felder.

+ Der von der Internationalen Kommission fiir den Schutz vor nichtionisierenden Strahlen
(International Commission on Non-lonizing Radiation Protection, ICNIRP) empfohlene SAR-
Grenzwert liegt bei 2 W/kg gemittelt tber zehn (10) Gramm Gewebe.

+ Der hochste fur dieses Modell ermittelte SAR-Wert bei Verwendung am Ohr liegt bei
0,551 W/kg (10 g) bzw. 1,531 W/kg (10 g), wenn das Gerat am Korper getragen wird.

Dieses Gerat entspricht den Sicherheitsstandards hinsichtlich der Strahlenbelastung bei
normaler Verwendung am Ohr oder wenn der Abstand vom Korper mindestens 5 mm
betragt. Tragetaschen, Gurtelclips oder Vorrichtungen zum Tragen des mobilen Gerats

am Korper diirfen kein Metall enthalten und missen das Gerat in einem Abstand von
mindestens 5 mm vom Kérper halten. Um Dateien oder Nachrichten tbertragen zu kénnen,
benotigt dieses Gerat eine qute Netzverbindung. In einigen Fallen wird die Ubertragung

von Dateien und Nachrichten verzogert, bis die Netzverbindung entsprechend gut ist.
Stellen Sie sicher; dass der oben genannte Abstand eingehalten wird, bis die Ubertragung
abgeschlossen ist.



Informationen der FFC zur HF-Belastung

Im August 1996 hat die Federal Communications Commission (FCC) der Vereinigten Staaten
mittels der Manahme Report and Order FCC 96-326 einen neuen Sicherheitsstandard fiir
die Exposition des Menschen gegentuiber elektromagnetischer Hochfrequenz (HF)-Energie
angenommen, die von FCC-konformen Sendern abgegeben wird. Diese Richtlinien stehen

im Einklang mit dem Sicherheitsstandard, der zuvor durch internationale und US-Standards
festgelegt wurde. Das Design dieses Gerats entspricht den FCC-Richtlinien und diesen
internationalen Standards.

Teil 15.19 der Erklarung

Dieses Gerat wurde geprUft und erfUllt die Grenzwerte gemaR Teil 15 der Richtlinien der
amerikanischen Bundesbehorde fur das Fernmeldewesen FCC (Federal Communications
Commission). Beim Betrieb mussen demnach folgende

Bedingungen erfillt werden:
(1) Das Gerat darf keine schadlichen Funkstorungen verursachen.

(2) Dieses Gerat muss empfangene Stérungen aufnehmen, die unerwiinschten Betrieb
verursachen kénnen.

Teil 15.21 der Erklarung

Anderungen oder Modifikationen, die nicht ausdrticklich vom Hersteller genehmigt wurden,
kénnen zum Erléschen der Berechtigung des Benutzers zum Bedienen des Gerats fihren.
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Tragen am Korper

Dieses Gerat wurde fir den typischen korpernahen Betrieb getestet, wobei die Riickseite des
Gerats 0.39 Zoll (1cm) zwischen dem Kérper des Benutzers und der Rickseite des Gerats
gehalten wurde. Um den FCC-Anforderungen zur HF-Belastung zu entsprechen muss ein
minimaler Trennungsabstand von 0.39 Zoll (1cm) zwischen dem Korper des Benutzers und der
Ruckseite des Gerats eingehalten werden.

Alle Gurtelclips, Halfter und ahnliches Zubehér, das metallische Komponenten enthalt, darf
nicht verwendet werden. Am Korper getragenes Zubehdr, das keinen Trennungsabstand von
0.39 Zoll (1cm) zwischen dem Korper des Benutzers und der Rickseite des Gerats einhalten
kann und nicht fiir den typischen kdrpernahen Betrieb getestet wurde, entspricht eventuell
nicht den RF-Belastungsgrenzen der FCC und sollte vermieden werden.

Teil 15.105 der Erklarung

Dieses Gerat wurde geprUft und gemaR Teil 15 der Richtlinien der FCC als digitales Gerat

der Klasse B eingestuft. Diese Vorgaben dienen dazu, bei einer Verwendung im hauslichen
Bereich einen angemessenen Schutz vor schadlichen Funkstorungen zu gewahrleisten. Das
Gerat erzeugt und verwendet elektromagnetische Energie im Radiofrequenzbereich und kann
diese an die Umgebung abgeben. Bei einer nicht sachgemaRen Installation oder Verwendung
kann dies FunkUbertragungen Giber Radiofrequenzen storen. Es kann jedoch nicht garantiert
werden, dass bei einer bestimmten Installation keine Funkstérungen auftreten. \Wenn dieses
Gerat schadigende Stérungen oder Stérungen des Fernsehempfangs verursacht, was durch
Aus- und Einschalten des Gerats festgestellt werden kann, wird der Benutzer aufgefordert, die
Stérungen durch eine oder mehrere der folgenden MaRnahmen zu beheben:

+ Richten Sie die Antenne neu aus oder stellen Sie sie an einem anderen Ort auf.
« VergroRern Sie den Abstand zwischen Gerat und Empfanger.

+ SchlieRen Sie das Gerat an einen Anschluss an, der mit einem anderen Stromkreis
verbunden ist als der Empfanger.

+ Wenden Sie sich an lhren Handler oder einen fachkundigen Radio- und Fernsehtechniker.
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Pﬂege und Wartung des Telefons

Verwenden Sie nur von LG zugelassenes Zubehor. LG tibernimmt keine Haftung fir
Schaden oder Fehler, die durch Zubehor von Drittanbietern verursacht werden.

+ Einige Inhalte und Abbildungen weichen méglicherweise von Ihrem Gerat ab und
unterliegen Anderungen ohne Vorankiindigung.

Offnen Sie dieses Mobiltelefon nicht. Sollten Reparaturen erforderlich sein, wenden Sie sich
an einen qualifizierten Kundendienstmitarbeiter.

+ LG ist berechtigt, bei Reparaturen im Rahmen der Garantie neue oder tberholte Ersatzteile
oder Platinen zu verwenden, sofern diese tber den gleichen Funktionsumfang verfiigen wie
die zu ersetzenden Teile.

+ Benutzen Sie dieses Mobiltelefon nicht in der Nahe elektrischer Gerate (z. B. Fernsehgerate,
Radios, PCs).

+ Halten Sie das Telefon von Warmegquellen wie Heizungen oder Herdplatten fern.
+ Lassen Sie das Telefon nicht fallen.

+ Setzen Sie das Telefon keinen starken Erschiitterungen oder St6Ren aus.

Schalten Sie das Gerat aus, wenn dies aufgrund von jeweils geltenden Bestimmungen
erforderlich ist. Verwenden Sie Ihr Gerat beispielsweise nicht in Krankenhausern, da sonst
die Funktionalitat empfindlicher medizinischer Gerate beeintrachtigt werden kann.

Fassen Sie das Gerat wahrend des Ladevorgangs nicht mit nassen Handen an. Es besteht
sonst Stromschlaggefahr, auch kann das Gerat schwer beschadigt werden.

+ Laden Sie das Telefon nicht in der Nahe von entflammbarem Material auf, da das Telefon
heil werden kann und somit eine Brandgefahr darstellt.

+ Reinigen Sie das Gerat auRen mit einem trockenen Tuch (verwenden Sie keine
Lésungsmittel wie Benzin, Verdiinner oder Alkohol).

Legen Sie das Gerat beim Aufladen nicht auf Polstermabel.

Das Gerdt sollte in einer gut beltifteten Umgebung aufgeladen werden.

+ Bewahren Sie das Telefon nicht in sehr verrauchten oder staubigen Umgebungen auf.
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Bewahren Sie das Gerat nicht in der Nahe von Gegenstanden mit Magnetstreifen
(Kreditkarten, Flugtickets usw.) auf, da andernfalls die auf dem Magnetstreifen
gespeicherten Informationen beschadigt werden kénnten.

Bertihren Sie das Display nicht mit spitzen oder scharfen Gegenstanden; andernfalls kann
das Gerat beschadigt werden.

Setzen Sie das Gerat keiner Feuchtigkeit oder Nasse aus.

Verwenden Sie Zubehdrteile (wie z. B. Kopfhérer) immer mit der erforderlichen Sorgfalt.
Berthren Sie die Antenne nicht unnétig.

Bertihren, entfernen oder reparieren Sie nicht zerbrochenes oder gesprungenes
Glas. Schaden am Glas-Display aufgrund von Missbrauch fallen nicht unter die
Garantiebedingungen.

Dies ist ein elektronisches Gerat, das sich bei normalem Betrieb erhitzt. Besteht
anhaltender, direkter Hautkontakt ohne angemessene Beluiftung, kann es zu Beschwerden
oder leichten Verbrennungen kommen. Gehen Sie daher wahrend und direkt nach dem
Betrieb vorsichtig mit Ihrem Gerat um.

Falls Ihr Gerat nass wird, missen Sie es sofort vom Netz trennen und vollstandig trocknen
lassen. Versuchen Sie nicht, das Trocknen mit einer externen Heizquelle, wie Ofen,
Mikrowelle oder Haartrockner; zu beschleunigen.
Die Flussigkeit in lhrem nassen Gerat andert die Farbe der Produktkennzeichnung in lhrem
Gerat. Gerateschaden, der aufgrund des Eindringens von Fliissigkeiten entsteht, fallt nicht
unter die Garantiebedingungen.
Ein Mobilgerdt erfordert hinreichende Luftzirkulation, damit Hitze abgefuihrt werden kann.
Bei direktem Hautkontakt oder bei nicht angemessener Luftzirkulation zum Gerat kann
dieses zu hei werden. Zwischen Gerat und Korper des Benutzers muss mindestens ein
Abstand von 1,0 cm vorhanden sein.

+ Achten Sie darauf, dass in den Anschluss vom Ladegerdt / USB-Kabel kein Staub oder
Fremdkérper eindringen kann. Dies kann zu Uberhitzung oder gar Feuer fihren.

+ Setzen Sie das Gerdt nicht niedrigem Luftdruck in groRen Héhen aus.

+ Setzen Sie das Gerat nicht extrem niedrigem Luftdruck aus. Ansonsten kénnte die Batterie
explodieren oder es kénnte entflammbare Flissigkeit oder Gas austreten.
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Effizienter Betrieb des Gerats

Elektronische Gerate
Bei jedem Gerat kann es zu Interferenzen kommen, die die Leistung beeintrachtigen konnen.

+ Verwenden Sie das Gerat nicht ohne ausdrtickliche Erlaubnis in der Nahe medizinischer
Gerate. Bitte besprechen Sie mit Ihrem Arzt, ob die Verwendung des Gerats Stérungen
Ihres medizinischen Gerdts verursachen kann.

+ Hersteller von Herzschrittmachern empfehlen, dass ein Mindestabstand von 15 cm
zwischen anderen Geraten und einem Herzschrittmacher eingehalten wird, um mégliche
Storungen zu vermeiden.

+ Das Gerat kann hell aufleuchten oder blinken.
+ Einige Horhilfen kénnen durch das Gerat beeintrachtigt werden.

+ Bei Fernsehgeraten, Radios, PCs usw. konnen ebenfalls leichte Interferenzen auftreten.

Verwenden Sie lhr Gerat nach Méglichkeit nur bei Temperaturen zwischen 0 °C und
35 °C. Die Verwendung bei besonders niedrigen oder hohen Temperaturen kann zu
Beschadigungen, Fehlfunktionen oder sogar zu einer Explosion fihren.

Sicherheit im StraRenverkehr

Erkundigen Sie sich tber die jeweils geltenden Gesetze und Bestimmungen zur Verwendung
von Geraten in Fahrzeugen.

- Benutzen Sie kein Handheld-Gerat, wenn Sie wahrend der Fahrt am Steuer sitzen.
+ Richten Sie Ihre ganze Aufmerksamkeit auf den StraRenverkehr.
+ Parken Sie ggf. zuerst das Fahrzeug, bevor Sie Anrufe tatigen oder entgegennehmen.

+ Elektromagnetische Strahlen kénnen uU. elektronische Systeme in Ihrem Fahrzeug stéren,
wie beispielsweise das Autoradio oder Sicherheitssysteme.

+ Falls Ihr Fahrzeug mit einem Airbag ausgestattet ist, achten Sie darauf, das Telefon nicht auf
bzw. vor dem Airbag abzulegen und die Freisprecheinrichtung nicht in der Nahe des Airbags
zu installieren. Andernfalls kann die Funktionsweise des Airbags beeintrachtigt werden, was
zu schweren Verletzungen fihren kann.

+ Wenn Sie Musik horen, wahrend Sie unterwegs sind, stellen Sie sicher, dass die Lautstarke
auf ein angemessenes Maf3 eingestellt ist, sodass Sie Ihre Umgebung wahrnehmen. Dies ist
vor allem dann wichtig, wenn Sie sich in der Nahe einer StraRe befinden.
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Vermeiden von Horschaden

Um einer Schadigung des Gehors vorzubeugen, sollten Sie nicht tiber einen
langeren Zeitraum mit hoher Lautstarke horen.

\Wenn Sie langere Zeit einem hohen Gerduschpegel ausgesetzt sind, konnen Horschaden
auftreten. Wir empfehlen deshalb, dass Sie das Telefon beim Ein- und Ausschalten nicht
ans Ohr halten. Es empfiehlt sich auRerdem, die Lautstarke von Musik und Anrufen auf ein
angemessenes MafR einzustellen.

+ Reduzieren Sie die Lautstarke bei der Verwendung von Kopfhérern, wenn Sie die Stimmen
von Personen in lhrer Nahe nicht héren konnen oder wenn die Person neben lhnen lhre
Musik héren kann.

E + UbermaRige Lautstarke und tibermaRiger Druck der Ohrhérer und Kopfhorer
kénnen zu Horverlust fihren.

Glasteile

Einige Teile Ihres Gerats bestehen aus Glas. Dieses Glas kann brechen, wenn Ihr Gerat auf eine
harte Oberflache fallt oder einem harten StoR ausgesetzt wird. Sollte das Glas zerbrechen,
berthren Sie es nicht und versuchen Sie nicht, es zu entfernen. Verwenden Sie das Gerat erst
wieder, wenn das Glas von einem autorisierten Handler ersetzt wurde.

Sprenggebiete

Benutzen Sie das Telefon nicht in Sprenggebieten. Beachten Sie die Einschrankungen und
befolgen Sie alle geltenden Vorschriften und Regeln.

Explosmnsgefahrdete Orte
Verwenden Sie das Geréat nicht an Tankstellen.
+ Verwenden Sie das Telefon nicht in der Nahe von Kraftstoffen oder Chemikalien.

+ Transportieren und lagern Sie keine brennbaren Flissigkeiten, Gase oder Explosivstoffe im
selben Fach oder Raum Ihres Fahrzeugs, in dem sich auch Ihr Gerat oder Geratezubehor
befindet.
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In Flugzeugen
In einem Flugzeug konnen Telefone zu Interferenzen fihren.
+ Schalten Sie daher Ihr Gerat aus, bevor Sie in ein Flugzeug steigen.

+ Verwenden Sie es auch nicht wahrend des Aufenthalts auf dem Flughafengelande, sofern
dies nicht ausdrlicklich vom Personal erlaubt wurde.

Kinder

Bewahren Sie das Gerat an einem sicheren Ort auRerhalb der Reichweite von Kleinkindern auf.
Es enthalt Kleinteile, die verschluckt oder eingeatmet werden konnten.

Notrufe

Notrufe sind mdglicherweise nicht in allen Mobilfunknetzen mdglich. Verlassen Sie sich daher
bei Notrufen nie ausschlieRlich auf Ihr Gerat. Weitere Informationen dazu erhalten Sie von
Ihrem Dienstanbieter.

Hinweise zum Akku und zur Pflege des Akkus

+ Esist nicht erforderlich, den Akku vor dem Laden vollstandig zu entladen. Anders als bei
herkémmlichen Akkus tritt bei diesem Akku kein Memory-Effekt auf, der die Leistung
vermindert.

+ Verwenden Sie ausschlieRlich Akkus und Ladegerate von LG. Ladegerdte von LG sind so
ausgelegt, dass die Lebensdauer des Akkus optimiert wird.

Offnen Sie nicht den Akku und schlieRen Sie ihn nicht kurz.

Achten Sie darauf, dass die Kontakte des Akkus sauber sind.

+ Tauschen Sie den Akku aus, wenn die Leistung nicht mehr zufriedenstellend ist. Ein Akku
kann mehrere hundert Mal aufgeladen werden, bevor er ausgetauscht werden muss.

Wenn Sie den Akku langere Zeit nicht verwendet haben, laden Sie ihn erneut auf, um
maximale Leistung zu erzielen.

+ Setzen Sie das Ladegerat keiner direkten Sonneneinstrahlung oder hoher Luftfeuchtigkeit
(z B.in einem Badezimmer) aus.

+ Bewahren Sie den Akku nicht in sehr heiRen oder sehr kalten Raumen auf, da dies die
Leistung beeintrachtigen kann.

Bei Austausch des Akkus mit einem ungeeigneten Akkutyp besteht Explosionsgefahr.
Entsorgen Sie unbrauchbar gewordene Akkus gemaR den Anweisungen.
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+ Entfernen Sie das Ladegerat immer aus der Steckdose, wenn das Gerat voll aufgeladen ist.
So vermeiden Sie, dass das Ladegerat unnétig Strom verbraucht.

Die tatsachliche Akkulaufzeit ist abhangig von der Netzwerkkonfiguration, den
Produkteinstellungen, dem Gebrauch und den Umgebungsbedingungen.

+ Stellen Sie sicher; dass keine spitzen Gegenstande wie Tierzahne oder Nagel in Kontakt mit
dem Akku kommen. Dies konnte ein Feuer verursachen.

+ Stromverbrauch (Stand-by-Modus im Netzwerk): 0,5 W

Schutz personlicher Daten

+ Schtzen Sie lhre personlichen Daten, um Weitergabe und Missbrauch von sensiblen
Informationen zu verhindern.

+ Erstellen Sie bei der Benutzung des Gerats immer eine Sicherheitskopie von wichtigen
Daten. LG Ubernimmt keinerlei Haftung fiir Datenverlust.

« Erstellen Sie vor der Entsorgung des Gerdts eine Sicherheitskopie all Ihrer Daten, und
setzen Sie das Gerat auf die Werkseinstellungen zuriick, um dem Missbrauch von sensiblen
Informationen vorzubeugen.

+ Lesen Sie sich vor dem Herunterladen von Anwendungen die Angaben auf dem
Berechtigungsbildschirm gut durch.

Seien Sie vorsichtig bei der Nutzung von Anwendungen, die Zugriff auf mehrere Funktionen
oder lhre persénlichen Daten haben.

+ Priifen Sie regelmaRig lhre persénlichen Konten. \Wenn Sie irgendein Anzeichen fiir
den Missbrauch Ihrer persénlichen Daten bemerken, bitten Sie Ihren Netzanbieter, Ihre
Kontodaten zu l6schen oder zu andern.

+ Wenn lhr Gerat gestohlen wird oder Sie es verloren haben, andern Sie das Passwort lhres
Kontos, um lhre personlichen Daten zu schiitzen.

+ Nutzen Sie keine Anwendungen von unbekannten Quellen.
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A Hinweis zum Akkuaustausch

Li-lon Akkus konnen bei unsachgemaRer Verwendung zu Verletzungen fihren.

Das Austauschen des Akkus durch einen NICHT qualifizierten Techniker kann zu
Schaden am Gerat fuhren.

Tauschen Sie den Akku nicht selbst aus. Beschadigungen am Akku kdnnen zu
Uberhitzung und Verletzungen fiihren. Der Akku darf nur von einer qualifizierten
Fachperson ausgetauscht werden. Der Akku sollte durch Recycling aufbereitet
oder getrennt vom Hausmdill entsorgt werden.

Falls dieses Produkt einen im Gerat fest verbauten Akku enthalt, der nicht ohne
weiteres durch den Endbenutzer entfernt werden kann, empfiehlt LG, dass nur
qualifizierte Fachkrafte den Akku entfernen, entweder um ihn durch einen neuen
zu ersetzen oder um ihn am Ende der Lebensdauer des Produktes dem Recycling
zuzufithren. Um Schaden am Produkt zu vermeiden und fir die eigene Sicherheit,
sollten Benutzer nicht versuchen, den Akku zu entfernen und diesbeziiglich die
LG-Beratungsstelle oder einen anderen unabhangigen Dienstleister zwecks
Beratung kontaktieren.

Das Entfernen des Akkus erfordert ein Zerlegen des Produkts, die Trennung der
elektrischen Leitungen/Kontakte und eine sorgfaltige Entnahme der Akkuzelle
mit Spezialwerkzeugen. Wenn Sie die Anweisungen fiir qualifizierte Fachkrafte
bendtigen, wie man den Akku sicher entfernen kann, besuchen Sie bitte
http//www.ge.com/global/sustainability/environment/take-back-recycling.

Richtlinien fir den sicheren und effizienten Gebrauch
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Kamerafunktionen

Zeitraffer-Steuerung

Sie kénnen fur die jeweilige Situation optimierte Zeitraffer-Videos aufnehmen.
Durch Analyse verschiedener Aufnahmeumgebungen konnen Videos von Objekten,
die in stetiger Bewegung sind, bei optimaler Geschwindigkeit aufgenommen
werden. Je nach Aufnahmemotiv und Umgebung kann die Zeitraffer-
Geschwindigkeit automatisch angepasst werden. Auch manuelle Einstellung der
Zeitraffer-Geschwindigkeit ist moglich.

T Auf (&) tippen und durch Wischen tiber die Kameramodi den Modus Zeitraffer
auswahlen.

Einstellungen der Kamera —— o—— Blitzlicht einstellen
Seitenverhaltnis wahlen ] ] Steadycam einstellen
e——————— Zoom auswahlen
o——— Zeitraffer-Geschwindigkeit
auswahlen
t—— BeidenKameramodi
Zeitraffer auswahlen

2 Tippen Sie auf e, um ein Video aufzunehmen.

« Wahrend das Zeitraffer-Video aufgenommen wird, kdnnen Sie die Zoom-
Einstellung und die Zeitraffer-Geschwindigkeit andern.

- Um die Aufzeichnung vortbergehend anzuhalten, auf @) tippen. Um die
Aufzeichnung fortzusetzen, auf ‘@  tippen.

+ Beim Aufzeichnen eines Videos kénnen Sie durch Spreizen oder
Zusammenziehen von zwei Fingern hinein- bzw. herauszoomen.

« Beim Aufzeichnen eines Videos konnen Sie einen Brereich antippen, um die
Helligkeit anzupassen.
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3 Um die Aufnahme zu beenden, auf =  tippen.
« Das aufgezeichnete Video wird in der Galerie gespeichert.

E « Bei der Aufnahme von Zeitraffer-Videos erfolgt keine Tonaufnahme.

3D AR-Effekt

Die Tiefen-Kamera auf der Ruickseite des Produkts erméglicht lhnen, realistische
Fotos mit 3D AR Effekt aufzunehmen, indem Konturen von Gesichtszligen
detaillierter dargestellt werden. \Weil Ihr Gesicht genau erkannt wird, kdnnen Sie
einen Sticker aufnehmen, ohne dass lhre Hande erscheinen, auch dann, wenn Ihr
Gesicht teilweise durch Ihre Hande bedeckt wird.

1 Auf (&) tippen und durch Wischen tiber die Kameramodi den Modus Sticker
auswahlen.

72 Wahlen Sie @)

3 Wischen Sie tiber die Sticker-Liste nach links oder rechts und wahlen sie den
AR-Sticker aus, der benutzt werden soll.

+ Das von der Kamera erkannte Gesicht wird in 3D gescannt.

MaRgeschneiderte Funktionen
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4 Um ein Foto aufzunehmen, tippen Sie auf (") ;um ein Video aufzuzeichnen,
halten Sie, lf) berthrt.
+ Das Foto oder Video wird unter Anwendung des 3D AR Effektes
aufgenommen.

E « Bei der Tiefen-Kamera steht die Funktion zum 3D-Scannen nur bei
Nahaufnahmen im Hochformat zur Verftigung.

3D-Foto-Effekt

Wenn Sie die Tiefen-Kamera auf der Rickseite des Produkts verwenden, erméglicht
Ihnen der 3D-Foto-Effekt, das Empfinden von Tiefe bei 3D-Portrataufnahmen

zu verstarken. Fotos mit 3D-Foto-Effekt konnen in der Galerie-App als sich
bewegende Bilder angezeigt werden.

1 Auf (&) tippen und durch Wischen tiber die Kameramodi den Modus Portrét
auswahlen.

7 Durch Wischen iiber die Effektmodi konnen Sie bei Portrat den 3D-Foto-
Effekt auswahlen.

— Einen 3D-Foto-Effekt in den
Effektmodi auswahlen

L Beiden Kameramodi Portrat
wahlen
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3 Tippen Sie auf (), um ein Foto aufzunehmen.
« Das Foto wird in der Galerie gespeichert.
- @) erscheint auf dem Bild, das mit dem 3D-Foto-Effekt
aufgenommen wurde.
/. Wahlen Sie in der Galerie oder der Vorschau ein 3D-Foto aus und tippen Sie auf
‘), um einen Foto-Effekt anzuwenden.

+ Wahlen Sie nach der Anwendung des Effekts Eine Kopie speichern oder
OK aus.

E + Die Funktion steht nur zur Verfiigung, wenn ein Foto mit der hinteren Kamera
aufgenommen wird.

« Wenn die Meldung 3D-Foto-Effekt ist verfiigbar angezeigt wird, kénnen Sie zur
Aufnahme eines Fotos auf () tippen. Ansonsten wird der 3D-Foto-Effekt nicht
auf das gespeicherte Foto angewendet.

MaRgeschneiderte Funktionen 20



Funktionen der Tonaufnahme

Videoaufnahmen mit speziellen Optionen der

Tonaufzeichnung

Sie kénnen ein Video aufnehmen und dabei drei verschiedene Arten der
Tonaufzeichnung wahlen.

T Auf (@) tippen und durch Wischen tiber die Kameramodi den Modus Videos
auswahlen.

2 Auf @ tippen und durch Wischen (iber die Audio-Optionen eine der folgenden
Funktionen auswahlen: Allgemein, ASMR Aufnahme oder Stimmen-Bokeh.

o————— Audio-Optionen

Allgemein
Sie konnen ein Video mit konstantem Stereoton aufnehmen.

ASMR Aufnahme

Mit den zwei hochempfindlichen Mikrofonen, die in diesem Gerat vorhanden sind,
konnen Sie ein ASMR Video aufnehmen.
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Stimmen-Bokeh

Durch diese Funktion werden bei Tonaufnahmen die Stimmen deutlich und klar
hervorgehoben, wahrend Umgebungsgerausche reduziert werden.

+ Um Umgebungsgerdusche zu reduzieren, den Schieberegler nach 0y) ziehen.

Tonaufnahmen mit ASMR (Autonomous Sensory

Meridian Response)

Die Funktion ASMR (Autonomous Sensory Meridian Response) erméglicht
lhnen, den Ton deutlich und klar aufzunehmen, indem der von den Mikrofonen
aufgenommene Ton verstarkt wird.

1 Auf Zubehér > HD Audiorekorder tippen und dann auf = > ASMR.
2 Um den Ton aufzunehmen, auf @ tippen.
- Um die Aufzeichnung voriibergehend anzuhalten, auf @@ tippen. Um die
Aufzeichnung fortzusetzen, auf @ tippen.

3 Um die Tonaufzeichnung zu beenden, auf @) tippen.

LG 3D-Sound Modul

Mit der Funktion LG 3D-Sound Modul kdnnen Sie optimierten Stereosound
geniefen. Bei der Wiedergabe von Musik oder Videos horen Sie den Stereoton so,
als waren Sie mitten im Geschehen.

1 Ziehen Sie das Benachrichtigungs-Panel nach unten.

7 Um das LG 3D-Sound Modul ein- oder auszuschalten, auf@ tippen.
Oder tippen Sie auf Einstellungen > Ton > Soundqualitat und Effekte >
LG 3D-Sound Modul und tippen Sie dann auf () ), um diese Funktion zu
aktivieren.

E « Wenn Sie ein externes Audiogerat an das Produkt anschlieRen, z. B. Ohrhorer oder
Lautsprecher, wird ein Popup-Fenster angezeigt, mit dem Sie die Funktion
LG 3D-Sound Modul einschalten kénnen.
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Google Assistant

Google Assistant im Uberblick

Ihr Gerat hat den Google Assistant bereits integriert. Damit finden Sie Antworten
und kénnen Dinge erledigen, auch wahrend Sie unterwegs sind.

5

Um diese Funktion zu verwenden, missen Sie zunachst die Verbindung zum
Netzwerk herstellen.

Google Assistant starten

7 Dricken Sie auf der linken Seite des Gerats auf die Google-Assistant-Taste.

Oder.

Wischen Sie von einer unteren Bildschirmecke aus diagonal nach oben.
7 Tippen Sie auf JETZT STARTEN.

3 Folgen Sie den Anweisungen auf dem Bildschirm.
« Das Gerdt speichert die Eigenschaften lhrer Stimme, um sie wiedererkennen

zu konnen.

/. Wahlen Sie, ob Voice Match zum Entsperren des Gerates dienen soll.

+ Wenn Sie Voice Match zum Entsperren des Gerats benutzen, kénnen Sie

5

MaRgeschneiderte Funktionen

das Gerat auch bei ausgeschaltetem Bildschirm oder wahrend des Ladens
entsperren, indem Sie “OK Google” oder “Hey Google” sagen.

Diese Funktion ist maglicherweise anfalliger fir Sicherheitsliicken als andere
Bildschirmsperren wie, Muster; PIN oder Passwort.

Bei Verwendung einer ahnlichen Stimme oder einer Aufnahme Ihrer Stimme kann
der Bildschirm entsperrt werden.

Um am Homescreen diese Funktion zu benutzen, tippen Sie auf Einstellungen >
Sperrbildschirm & Sicherheit > Einstellungen zur sicheren Sperre > Smart Lock,
und benutzen Sie dann die Methode der Bildschirmsperre, die Sie zum Entsperren des
Gerdts festgelegt haben. Tippen Sie auf Voice Match (Stimmerkennung) und geben
Sie dann erneut die derzeit benutzte Entsperrmethode an. Beachten Sie, dass Ziehen
ausgenommen ist.

\Wenn es lhnen nicht gelungen ist, durch Benutzung der Spracherkennung das Gerat zu
entsperren, miissen Sie das Gerat durch Einsatz der spezifizierten Methode entsperren.
Details finden Sie unter Bildschirmsperre festlegen.
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5 Tippen Sie auf Beenden.

Zugriff mittels Stimme

1 Wenn der Homescreen ausgeschaltet oder gesperrt ist, sagen Sie “OK
Google” oder “Hey Google”.

72 Wenn der Google Assistant-Bildschirm angezeigt wird, sprechen Sie einen
Befehl oder stellen Sie eine Frage.

Zugriff Giber den Homescreen

1 Driicken Sie auf der linken Seite des Geréats auf die Google-Assistant-Taste.
Oder.
Wischen Sie von einer unteren Bildschirmecke aus diagonal nach oben.

2 Wenn Sie unten auf dem Bildschirm «« - = sehen, sprechen Sie einen Befehl oder
stellen Sie eine Frage.

E « Ineiner Umgebung, wo die Verbindung mittels Wi-Fi oder Mobilfunknetz schlecht
ist, kann die Funktion Google Assistant eingeschrankt und die Genauigkeit der
Spracherkennungsfunktion reduziert sein.

« Wenn das Gesprochene undeutlich ist, das Mikrofon abgedeckt, ein Medienplayer
lauft oder die Umgebungsgerdusche laut sind, kann die Genauigkeit der
Spracherkennungsfunktion reduziert sein. \Wenn Sie das Produkt per
Sprachbefehle bedienen, dann sprechen Sie die Befehle mdglichst deutlich in einer
stillen Umgebung, damit die Spracherkennung besser funktioniert.
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Fingerabdruckerkennung

Fingerabdruckerkennung im Uberblick

Sie mussen zuerst lhren Fingerabdruck auf dem Gerat registrieren, bevor Sie die
Fingerabdruckerkennungsfunktion verwenden.

Sie konnen die Fingerabdruckerkennungsfunktion in den folgenden Fallen
verwenden:

+ Zum Entsperren des Bildschirms.

+ Zum Anzeigen der gesperrten Inhalte in der Galerie.

- Bestatigen Sie Ihren Einkauf, indem Sie sich in einer App anmelden oder indem
Sie sich mit Ihrem Fingerabdruck identifizieren.

E « Sie konnen zur Benutzeridentifizierung die Fingerabdruckdaten benutzen. Es ist
maglich, dass der Fingerabdrucksensor den Fingerabdruck mit einem ahnlichen
Fingerabdruck verwechselt. Um die Sicherheit zu erhdhen, wird empfohlen, dass
Sie zum Entsperren des Bildschirms ein Muster; eine PIN oder ein Passwort
benutzen.
Wenn das Gerat Ihren Fingerabdruck nicht erkennen kann oder Sie den fiir die
Registrierung festgelegten Wert vergessen haben, wenden Sie sich mit Ihrem
Gerat und Ihrem Ausweis an das nachstgelegene LG Kundenzentrum.

MaRgeschneiderte Funktionen
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Vorkehrungen fiir die Fingerabdruckerkennung

Die Genauigkeit der Fingerabdruck-Erkennung kann sich aus verschiedenen
Grinden verringern. Um die Genauigkeit der Erkennung zu optimieren, sollten Sie
vor Verwendung des Gerats Uberpriifen, ob folgende Bedingungen erfillt sind.

« Mittig im unteren Bereich des Bildschirms befindet sich im Gerét ein
eingebauter Sensor zur Erkennung von Fingerabdriicken. Achten Sie darauf, den
Fingerabdrucksensor nicht mit Metallgegenstanden wie Miinzen oder Schltssel
zu beschadigen oder zu zerkratzen.

+ Befindet sich auf dem Fingerabdrucksensor oder auf dem Finger, der auf
den Sensor gelegt wird, eine fremde Substanz (wie Schweil, Lotion, Wasser,
Schmutz, Fett usw.), funktioniert die Fingerabdruckerkennung maéglicherweise
nicht. Dann wischen Sie den Sensor und den Finger sauber und entfernen Sie
jegliche Feuchtigkeit, bevor Sie erneut den Finger auf den Sensor legen.

+ Wenn die Oberflache des Fingers vernarbt ist oder durch Einwirkung von
Wasser rau oder schrumpelig ist, ist der Sensor méglicherweise nicht in der
Lage, den Fingerabdruck zu erkennen. Registrieren Sie in diesem Fall den
Abdruck eines anderen Fingers.

+ Wenn Sie den Finger krimmen oder nur die Fingerkuppe verwenden, wird der
Fingerabdruck moglicherweise nicht erkannt. Achten Sie darauf, dass Ihr Finger
die gesamte Oberflache des Fingerabdrucksensors bedeckt.

+ Scannen Sie pro Registrierung nur einen Finger. WWenn Sie mehr als einen
Finger scannen, kann dies die Fingerabdruckregistrierung und -erkennung
beeintrachtigen.

+ Bei trockener Umgebungsluft erzeugt das Gerat moglicherweise statische
Elektrizitat. Vermeiden Sie, bei trockener Umgebungsluft Fingerabdrticke zu
scannen. Bertihren Sie alternativ vor dem Scannen von Fingerabdriicken einen
Metallgegenstand, zum Beispiel eine Miinze oder einen Schliissel, um statische
Elektrizitat abzuleiten.
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Fingerabdriicke registrieren
Sie kénnen lhren Fingerabdruck im Gerat registrieren und speichern, um die
Fingerabdruckidentifizierung zu verwenden.

1 Tippen Sie am Homescreen auf Einstellungen > Sperrbildschirm & Sicherheit
> Fingerabdriicke.

E + Um diese Funktion verwenden zu kénnen, muss ein Sperrbildschirm eingestellt
werden.

« Wenn die Bildschirmsperre nicht aktiviert ist, befolgen Sie die angezeigten
Anweisungen und konfigurieren Sie die Bildschirmsperre. Details finden Sie unter
Bildschirmsperre festlegen.

2 Suchen Sie mittig im unteren Bereich des Bildschirms die Position des
Fingerabdrucksensors und setzen Sie sanft den Finger auf den Sensor.

E + Achten Sie darauf, dass der Finger den Fingerabdrucksensor vollstandig bedeckt.

3 Folgen Sie den Anweisungen auf dem Bildschirm.
+ Bewegen Sie denselben Finger nach und nach auf dem Sensor umher, bis die
Registrierung des Fingerabdrucks abgeschlossen ist.
« Legen Sie den Finger auf den Sensor. \Wenn Sie eine Vibration wahrnehmen,
heben Sie den Finger vom Sensor ab.
/. Tippen Sie nach der Registrierung des Fingerabdrucks auf OK.

« Tippen Sie auf Weitere hinzufiigen, um einen weiteren Fingerabdruck zu
registrieren. Es wird empfohlen, mehrere verschiedene Fingerabdrticke zu
registrieren. Denn die Fingerabdruckerkennungsrate ist abhangig von der
Qualitat und Aufnahmebedingung des registrierten Fingerabdrucks.
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Fingerabdriicke verwalten
Sie kénnen registrierte Fingerabdriicke bearbeiten oder ldschen.

1 Tippen Sie am Homescreen auf Einstellungen > Sperrbildschirm & Sicherheit
> Fingerabdriicke.

2 Nutzen Sie zum Entsperren die festgelegte Sperrmethode.

3 Tippen Sie in der Liste der Fingerabdriicke auf einen Fingerabdruck, um ihn
umzubenennen. Tippen Sie zum Léschen des Fingerabdrucks auf iij.

Bei ausgeschaltetem Bildschirm das Fingerabdruck-

Symbol anzeigen

Sie kénnen festlegen, wie auf dem Bildschirm die Position des
Fingerabdrucksensors angezeigt werden soll, wenn der Bildschirm ausgeschaltet
ist.

1 Tippen Sie am Homescreen auf Einstellungen > Sperrbildschirm & Sicherheit
> Fingerabdriicke.

2 Den Bildschirm mit der festgelegten Methode entsperren.

3 Prifen Sie, ob fir die Option Bei ausgeschaltetem Bildschirm tippen um das
Symbol anzuzeigen @  aktiviert ist. \Wenn Sie diese Funktion nicht benutzen
wollen, dann deaktivieren Sie die Funktion, indem Sie @  ziehen.

Effekt bei Beriihrung des Fingerabdrucksymbols festlegen

Sie konnen den Bildschirmeffekt andern, der bei Berihrung des
Fingerabdrucksymbols erscheint.

1 Tippen Sie auf Einstellungen > Sperrbildschirm & Sicherheit >
Fingerabdriicke.

2 Nutzen Sie zum Entsperren die festgelegte Sperrmethode.

3 Tippen Sie auf Symbol Touch-Effekt und wéhlen Sie den gewiinschten Effekt.
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Bildschirm mit einem Fingerabdruck entsperren

Sie kénnen den Bildschirm mit Ihrem Fingerabdruck entsperren oder die gesperrten
Inhalte anzeigen. So aktivieren Sie die gewiinschte Funktion:

1 Tippen Sie am Homescreen auf Einstellungen > Sperrbildschirm & Sicherheit
> Fingerabdriicke.

2 Nutzen Sie zum Entsperren die festgelegte Sperrmethode.

3 Aktivieren Sie auf dem Bildschirm mit den Fingerabdruckeinstellungen die
gewuinschte Funktion:
« Bildschirmsperre: Bildschirm per Fingerabdruck entsperren.

- Inhaltssperre:Inhalte mit einem Fingerabdruck entsperren. Stellen Sie
hierzu sicher, dass die Inhaltssperre aktiviert ist.

Funktion Multi-Tasking

Zuletzt verwendete App-Bildschirme

Sie kdnnen den Verlauf der zuletzt verwendeten Apps betrachten, indem Sie die
Home-Schaltflache = nach oben ziehen und halten.

Popup-Fenster

Sie kdnnen mehrere Apps gleichzeitig auf dem Bildschirm ¢ffnen. Dann kénnen Sie

jederzeit leicht zwischen ihnen wechseln.

1 Ziehen Sie = vom unteren Rand des Bildschirms nach oben.

2 Tippen Sie oben links iiber dem App-Bildschirm auf das App-Symbol und
wahlen Sie Popup-Fenster.

+ Nach dem Antippen des App-Symbols werden folgende Optionen angezeigt:
App-Info, Multi Window, Popup-Fenster und App anheften.
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3 Der App-Bildschirm wird in Form eines Popup-Fensters angezeigt.

L]

np np

E « Diese Funktion ist méglicherweise bei manchen Apps oder Bildschirmen nicht
verfligbar.

Popup-Fenster benutzen
+ — :Popup-Fenster minimieren. Das Popup-Fenster wird auf GroRe des App-
Symbols minimiert, das frei auf dem Bildschirm schwebt und beliebig platziert
werden kann.
- 1:Das App-Fenster auf Vollbild maximieren.
+ X : App schlieRen.
+ Popup-Fenster bewegen: Oben am Popup-Fenster ziehen.

- Die GroRe des Popup-Fensters dandern: Am linken, rechten oder unteren Rand
des Popup-Fensters ziehen.

E + Sie konnen bis zu 5 Apps in Popup-Fenstern ffnen.

+Um eine der gecffneten Apps auszuwahlen, auf das betreffende Popup-Fenster
tippen. Das ausgewahlte Popup-Fenster rlickt in den Vordergrund.

« Popup-Fenster kénnen nicht in den Bereich der Statusleiste oder Navigationsleiste
verschoben werden.
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Fiir Popup-Fenster den App-Ordner verwenden

\Wenn Sie im Popup-Fenster auf — tippen, wird das Popup-Fenster auf App-
SymbolgréRe minimiert.

Das App-Symbol kann durch Ziehen frei positioniert werden.

\Werden zwei oder mehr Popup-Fenster minimiert, wird ein App-Ordner erstellt, der
die App-Symbole enthalt.

5 « Als Symbol fiir diesen App-Ordner wird das Symbol der zuletzt verwendeten App
benutzt. Wenn Sie auf dieses Symbol tippen, werden alle Symbole der minimierten
Popup-Fenster im App-Ordner angezeigt.

« Wenn Sie den App-Ordner flr Popup-Fenster bertihrt halten und ihn dabei auf
Entfernen ziehen, wird der App-Ordner entfernt.

« Um eine App aus dem App-Ordner zu entfernen, den App-Ordner 6ffnen und das
betreffende App-Symbol aus dem App-Ordner ziehen.

Multi Window

Bei Navigation durch Gesten
1 Ziehen Sie — vom unteren Rand des Bildschirms nach oben.
+ Die zuletzt verwendeten Apps werden angezeigt.
+ Nach dem Antippen des App-Symbols werden folgende Optionen angezeigt:
App-Info, Multi Window, Popup-Fenster und App anheften.
2 Tippen Sie oben links iiber dem App-Bildschirm auf das Symbol der App, die per
Multi Window angezeigt werden soll, und wahlen Sie Multi Window.
+ Die ausgewahlte App wird in der oberen Halfte des Bildschirms angezeigt.
3 Tippen Sie auf die andere App, die per Multi Window angezeigt werden soll.
+ Die ausgewahlte App wird in der unteren Halfte des Bildschirms angezeigt.
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Bei Navigation durch Tasten
1 Tippen Sie in der Navigationsleiste auf |:]
« Die zuletzt verwendeten Apps werden angezeigt.
+ Nach dem Antippen des App-Symbols werden folgende Optionen angezeigt:
App-Info, Multi Window, Popup-Fenster und App anheften.
2 Tippen Sie oben links iiber dem App-Bildschirm auf das Symbol der App, die per
Multi Window angezeigt werden soll, und wéhlen Sie .
- Die ausgewahlte App wird in der oberen Halfte des Bildschirms angezeigt.

3 Tippen Sie auf die andere App, die per Multi Window angezeigt werden soll.

E « Um die GroRe des geteilten Bildschirms anzupassen, in der Mitte des Bildschirms
an der Fenster-Trennleiste ziehen.

« Um die Funktion Multi Window zu deaktivieren, die Trennleiste nach unten oder
oben zum Bildschirmrand ziehen.

« Die Funktion Multi Window wird von manchen LG Apps oder aus dem Play Store
heruntergeladenen Apps nicht unterstutzt.
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AOD (always-on display)
Sie konnen das Datum, die Uhrzeit oder lhre Signatur sehen, wenn der
Hauptbildschirm ausgeschaltet ist.

Wischen Sie unten Uber den Bildschirm des Always-on displays, um Funktionen
zu aktivieren, wie: Kamera, Capture+, Wi-Fi, Audioeinstellungen, Bluetooth®, Blitz,
Musik und weitere.

1 Tippen Sie am Homescreen auf Einstellungen > Anzeige > AOD
(always-on display).
7 Wihlen Sie das Bild aus, das angezeigt werden soll, und tippen Sie auf
Speichern.
« Tippen Sie auf das gewunschte Bild unter Digitaluhr, Analoguhr, Dualuhr,
Signatur oder Bilder.
« Tippen Sie auf Anzeige einblenden und wahlen Sie Bei Beriihrung fiir 10
Sekunden zeigen oder Immer anzeigen.
« Tippen Sie auf Schnellwerkzeuge und Musik-Player, um Uber die
Statussymbole von Schnellwerkzeugen und Musik-Player zu wischen.
+ Um die Helligkeit der Always-on display-Funktion zu erhéhen, tippen Sie auf
Hellere Anzeige.

+ Um die Hilfe fiir Always-on display anzuzeigen, auf Hilfe tippen.

E « Die Akkulaufzeit kann sich verringern, wenn Sie die Funktion ,Always-on display”
verwenden. Deaktivieren Sie diese Funktion, um die Akkulaufzeit zu verlangern.

+ Um die Funktion Always-on Display zu deaktivieren, tippen Sie auf dem
Homescreen auf Einstellungen > Anzeige > AOD (always-on display) und dann

auf @ .
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Hinweise zur Wasserdichte

Dieses Produkt ist wasser- und staubdicht nach Schutzart IP68.

Das Produkt wurde unter kontrollierten Bedingungen getestet und wurde unter
bestimmten Umstanden fiir wasser- und staubdicht befunden (entsprechend

den Klassifikationsanforderungen der Schutzart IP68 gemar dem internationalen
Standard IEC 60529 - Schutzarten durch Gehause [IP-Code]; Testbedingungen:
15-35°C, 86-106kPa, 1,5 Meter, 30 Minuten lang). Setzen Sie das Gerat keinen
Bedingungen aus, die sich von den Testbedingungen unterscheiden. Die Ergebnisse
kénnen in der Praxis variieren.

A WARNUNG

Trotz der Schutzart IP68 ist Ihr Gerat nicht unempfindlich gegentber Bedingungen,
die nicht in der kontrollierten Umgebung von LG getestet wurden. Bitte beachten
Sie, dass Schaden, die aus solchen Griinden eintreten, die Farbe des LDI (Liquid
Damage Indicator) &ndern. Wenn sich die Farbe des LDl im Inneren des Gerats
andert, kann fur das Produkt kein im Rahmen der beschrankten Garantie
angebotenes kostenloses Reparaturservice in Anspruch genommen werden.
Vermeiden Sie, das Produkt extrem staubigen oder feuchten Umgebungen
auszusetzen. Verwenden Sie das Produkt nicht in den folgenden Umgebungen.

Tauchen Sie das Produkt nicht in irgendwelche flissige Chemikalien (Seife
usw.) auRer Wasser.

Tauchen Sie das Produkt nicht in Salzwasser einschlieRlich Meerwasser.
Tauchen Sie das Produkt nicht in heiRe Quellen.

Schwimmen Sie nicht, wahrend Sie das Produkt an ihrem Kérper tragen.
Legen Sie das Produkt nicht direkt auf Sand (z. B. am Strand) oder
Schlamm.

Tauchen Sie Ihr Produkt nicht in Wassertiefen tber ca. 1,5 Meter.
Tauchen Sie das Produkt nicht [anger als 30 Minuten in Wasser.

RO®WLD®S
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+ Wenn Ihr Produkt nass wird, wischen Sie Mikrofon, Lautsprecher und
Audioanschluss mit einem trockenen Tuch ab, bevor Sie es wieder verwenden.

- Falls das Produkt oder Ihre Hande nass werden, trocknen Sie sie vor dem
Umgang mit dem Gerat griindlich ab.

- Verwenden Sie das Produkt nicht an einem Ort, wo es mit einem
Hochdruckwasserstrahl bespritzt werden kann (z. B.in der Nahe eines
Wasserhahns oder einer Dusche), und legen Sie es nicht fiir [angere Zeit in
Wasser, da das Produkt keinen hohen Wasserdruck aushalten kann.

+ Dieses Produkt ist nicht bestandig gegen Erschutterungen. Lassen Sie das
Produkt nicht fallen und setzen Sie es keinen StoRen aus. Dadurch konnte das
Gehause beschadigt oder verformt werden, was dazu fiihren kann, dass das
Produkt nicht mehr wasserdicht ist.

+ Die Wasser- und Staubdichte des Produkts kann durch Fallenlassen oder StoRe
beeintrachtigt werden.

+ Wenn das Produkt nass wird, trocknen Sie es griindlich mit einem weichen

Tuch ab.

Der Touchscreen und andere Funktionen funktionieren méglicherweise nicht

richtig, wenn das Produkt in nassem Zustand verwendet wird.

+ Das Produkt ist nur wasserdicht, wenn das SIM-/Speicherkartenfach richtig in
das Produkt eingesetzt wurde.

- Offnen oder SchlieBen Sie das SIM-/Speicherkartenfach nicht, wenn das
Produkt nass ist oder in Wasser eingetaucht wurde. Wird das offene Fach
Wasser oder Feuchtigkeit ausgesetzt, kann es zu Schaden am Produkt
kommen.

+ Das SIM-/Speicherkartenfach enthalt Gummi [Dichtung], um das Eindringen
von Staub, Wasser oder Feuchtigkeit in das Produkt zu verhindern. Beschadigen
Sie nicht das Gummi [Dichtung], da sonst Staub, Wasser oder Feuchtigkeit in
das Produkt eintreten und Schaden verursachen konnen.

A « Bei Nichtbeachtung der Hinweise kann die beschrankte Gerategarantie erldschen.

« Falls das Gerat nass ist, wechselt das LDl innerhalb des Gerats die Farbe. In
diesem Fall kann das Gerat nicht mehr unter Geltendmachung der begrenzten
Gerategarantie kostenlos repariert werden.

« Trotz IP68-Klassifizierung ist Ihr Gerat nicht in jeder Situation vollstandig
wasserdicht.
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Grundlegende
Funktionen



Geratekomponenten und Zubehor

Folgende Elemente sind im Lieferumfang Ihres Gerats enthalten.

. Gerat + Ladegerat
+ USB-Kabel + Schnellstarthandbuch
+ Auswurfstift

A

Die oben beschriebenen Komponenten sind méglicherweise optional

Die im Lieferumfang des Gerats enthaltenen Komponenten und jegliches
verfiigbares Zubehor kénnen je nach Gebiet oder Netzanbieter unterschiedlich
sein.

Verwenden Sie ausschlieRlich Originalzubehér von LG Electronics. Das Verwenden
von Zubehdr von anderen Herstellern kann die Anrufleistung lhres Gerats
beeintrachtigen oder Fehlfunktionen verursachen. Dies wird maglicherweise nicht
durch den Reparaturservice von LG abgedeckt.

Einige Teile lhres Gerats bestehen aus Hartglas. \Wenn das Gerat auf eine harte
Flache fallt oder starken St6Ren ausgesetzt wird, kann das Hartglas beschadigt
werden. In diesem Fall horen Sie bitte sofort auf, das Gerat zu verwenden und
kontaktieren Sie ein LG Servicezentrum.

Sollte eine dieser Grundkomponenten fehlen, wenden Sie sich an den Handler; bei
dem Sie das Gerat gekauft haben.

Wi

Wenn Sie zusatzliche Komponenten kaufen méchten, wenden Sie sich an das LG
Servicezentrum.

Einige im Lieferumfang des Gerats enthaltene Komponenten kdnnen sich ohne
vorherige Ankiindigung andern.

Aussehen und Spezifikationen des Produkts kénnen zwecks
Produktverbesserungen ohne Vorankiindigung geandert werden.

Die Geratespezifikationen kénnen je nach Gebiet und Netzanbieter variieren.

Vor Verwendung der Funktion zur Fingerabdruckerkennung miissen Sie vom
Fingerabdruck-Sensor die Schutzfolie entfernen.

Grundlegende Funktionen 37



Teiletibersicht
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A Versuchen Sie NICHT, die hintere Abdeckung selber zu entfernen.

+ Sonst kénnten Akku und Gerat schwer beschadigt werden, sodass dann
Uberhitzungs- und Brandgefahr sowie Verletzungsgefahr besteht. Die hintere
Abdeckung und der Akku dieses Gerats drfen nur von einer qualifizierten
Fachperson entfernt oder ausgetauscht werden.

Ihr Telefon ist ein elektronisches Gerat, das bei normalem Betrieb \Warme
erzeugt. Sehr langer direkter Hautkontakt ohne ausreichender Belliftung kann
zu Beschwerden oder kleineren Verbrennungen ftihren. Gehen Sie daher wahrend
oder direkt nach dem Betrieb vorsichtig mit Ihrem Telefon um.

+ Lautstarketasten

- Sie konnen die Lautstarke fiir Klingeltone, Medien, Anrufe oder
Benachrichtigungen anpassen.

- Driicken Sie bei Verwendung der Kamera leicht eine Lautstarketaste, um ein
Foto aufzunehmen. Um Fotos in Serie aufzunehmen, bertihren und halten Sie
die Lautstarketaste.

- Um die Kamera zu starten, wenn der Bildschirm gesperrt oder ausgeschaltet
ist, zwei Mal auf die Leiser-Taste driicken. Um Capture+ zu starten zwei Mal
auf die Lauter-Taste drticken.

+ Ein-/Aus-/Sperrtaste
- Drticken Sie die Taste kurz, um den Bildschirm ein- oder auszuschalten.

- Dricken und halten Sie die Taste, um weitere Optionen der Ein-/ Aus-/
Sperrtaste auswahlen zu kénnen.

+ Google-Assistant-Taste

- Um Google Assistant auszufithren, konnen Sie einmal kurz auf die Taste
druicken. Um die Spracherkennungsfunktion einzuschalten, halten Sie die
Google-Assistant-Taste gedrickt und lassen dann los.

- Details finden Sie unter Google Assistant.
+ Fingerabdrucksensor

- Um die Fingerabdruck-Erkennungsfunktion zu benutzen, unter in der Mitte
des Bildschirms auf den Fingerabdrucksensor drticken. Details finden Sie
unter Fingerabdruckerkennung im Uberblick.
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Je nach Region, Produktspezifikationen und Telekommunikationsdienstanbieter
koénnen einige Funktionen eingeschrankt sein.

Auf der Ruickseite sind im Produkt ein NFC-Chip und Antennen zum drahtlosen
Aufladen eingebaut. Achten Sie darauf, dass der NFC-Chip und die Antennen zum
drahtlosen Aufladen nicht abgedeckt oder beschadigt werden.

Legen Sie keine schweren Gegenstande auf das Gerat und setzen Sie sich nicht
darauf. Anderenfalls kann der Touchscreen beschadigt werden.

Eine Bildschirmschutzfolie und Zubehér kénnen den Naherungssensor
beeintrachtigen.

Wenn das Gerat nass ist oder an einem feuchten Ort verwendet wird,
funktionieren der Touchscreen oder die Tasten mdglicherweise nicht richtig.

In diesem Produkt sind zwei Mikrofone eingebaut. Achten Sie darauf, dass die
Mikrofone nicht abgedeckt sind. Wenn Sie tber das Telefon ein Gesprach fiihren,
dann achten Sie darauf, das Mikrofon nicht mit Hand oder Finger abzudecken.

Benutzen Sie keine Schutzhtille, die nicht vom Hersteller stammen und decken Sie
das Mikrofon nicht mit Zubehor, Klebeband usw. ab.

Halten Sie das Produkt bei Benutzung stets auf korrekte \Weise - siehe Abbildung.

Mikrofon

|

= =

Mikrofon

Grundlegende Funktionen

Bedecken Sie das Mikrofon nicht.

Z

R

~r
]
]

Bedecken Sie das Mikrofon nicht.
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Gerat ein- oder ausschalten

Gerat einschalten
Wenn das Gerat ausgeschaltet ist, drlicken und halten Sie die Ein-/Aus-/Sperrtaste.

E + Beim ersten Einschalten des Gerats wird die Erstkonfiguration durchgefihrt. Der
erste Start des Smartphones kann langer als gewéhnlich dauern.

Gerat ausschalten

Driicken und halten Sie die Ein-/Aus-/Sperrtaste und wahlen Sie anschlieRend
Ausschalten.

Gerat neu starten

\Wenn das Gerat nicht ordnungsgemaf? funktioniert oder nicht reagiert, starten Sie
es neu, indem Sie die folgenden Anweisungen befolgen.

1 Halten Sie gleichzeitig die Ein-/Aus-/Sperrtaste und die Leiser-Taste gedriickt,
bis das Gerat ausgeschaltet ist.

7 Lassen Sie die Tasten los, wenn das Gerat neu startet.

E « Diese Funktion ist nicht verfigbar;, wenn das Gerat an einen LG Dual-Bildschirm
(LM-G905N) angeschlossen ist.

Optionen der Ein-/Aus-/Sperrtaste

Driicken und halten Sie die Ein-/Aus-/Sperrtaste und wahlen Sie dann eine Option
aus.

+ Ausschalten: Schalten Sie das Gerdt aus.
+ Ausschalten und neu starten: Gerat neu starten.

Grundlegende Funktionen 41



SIM-Karte einlegen

Legen Sie die von lhrem Dienstanbieter zur Verfligung gestellte SIM-Karte ein, um
das Gerat verwenden zu kénnen (SIM - Subscriber Identity Module = Teilnehmer-
|dentitat-Modul).

A « Seien Sie vorsichtig mit dem Auswurfstift, da er eine scharfe Kante hat.

E + Fireine effektive Wasser- und Staubresistenz muss der Kartentrager richtig
eingesetzt sein.

1 Fuhren Sie den Auswurfstift in das Loch des Kartentragers ein und drticken Sie
mit dem Stift. Ziehen Sie dann den herausstehenden Kartentrager aus dem
Gerat.

2 Richten Sie die Nano-SIM-Karte oder die Speicherkarte auf dem Kartentrager
aus und drticken Sie die Karte in Pfeilrichtung - siehe Abbildung.

&

SIM-Karte
Speicherkarte
(optional-separat erhaltlich)
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Grundlegende Funktionen

Dieses Gerat unterstiitzt nur Nano-SIM-Karten.

Nano Micro Standard

Damit das Gerat fehlerfrei funktioniert, sollte der richtige SIM-Kartentyp
verwendet werden. Verwenden Sie ausschlieRlich industriell hergestellte SIM-
Karten des Dienstanbieters.

Verlieren Sie Ihre SIM-Karte nicht. LG ist nicht verantwortlich, wenn durch Verlust
oder Fremdnutzung der SIM-Karte Schaden oder andere Probleme entstehen.

Achten Sie darauf, die SIM-Karte beim Einsetzen oder Entfernen nicht zu
beschadigen.

Platzieren Sie die SIM-Karte oder Speicherkarte beim Einlegen ordnungsgemaf
auf dem Kartentrager.

Wenn Sie den Kartentrager zurtck in das Gerat einsetzen, setzen Sie ihn wie
dargestellt horizontal in Pfeilrichtung ein. Stellen Sie sicher, dass sich die Karte auf
dem Kartentrager nicht bewegt.

Legen Sie die SIM-Karte mit den goldfarbenen Kontakten nach unten ein.

Setzen Sie die SIM-Karte in das Gerat ein, indem Sie die Anweisungen in der
Bedienungsanleitung befolgen.

Achten Sie beim Einsetzen oder Entfernen des Kartentragers darauf, dass kein
Wasser oder andere Flissigkeiten in den Kartentrager gelangen. Wenn ein
Kartentrager oder eine Karte in nassem Zustand in das Gerat eingesetzt wird,
kann Ihr Gerat beschadigt werden.

Die Speicherkarte ist ein optionales Zubehor.

Durch haufiges Schreiben und Léschen von Daten kann die Lebensdauer der
Speicherkarte verkirzt werden.

Bestimmte Speicherkarten sind maglicherweise nicht vollstandig kompatibel mit
dem Gerat. Wenn Sie eine nicht kompatible Karte verwenden, kann das Gerat
oder die Speicherkarte beschadigt oder die darauf gespeicherten Daten konnen
unlesbar werden.
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Speicherkarte einsetzen

Legen Sie die Speicherkarte in Ihr Gerat ein.

Das Gerat unterstUtzt microSD-Karten mit bis zu 2 TB. Abhangig vom Hersteller
und der Art der Speicherkarte sind manche Speicherkarten gegebenenfalls nicht
mit Ihrem Gerat kompatibel

1 Stecken Sie den Auswurfstift in das Loch im Kartentrager.

7 Ziehen Sie den Kartentrager heraus.

3 Legen Sie die Speicherkarte mit den goldfarbenen Kontakten nach unten auf
den Kartentrager.

Speicherkarte
(optional, separat verkauft)

L SIM-Karte )

/. Schieben Sie den Kartentrager zurtick in den Einschub.

A + Bestimmte Speicherkarten sind moglicherweise nicht vollstandig kompatibel mit
dem Gerat. Wenn Sie eine nicht kompatible Karte verwenden, kann das Gerat
oder die Speicherkarte beschadigt oder die darauf gespeicherten Daten kénnen
unlesbar werden.

E + Durch haufiges Schreiben und Léschen von Daten kann die Lebensdauer der
Speicherkarte verkirzt werden.
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Speicherkarte entnehmen

Bevor Sie die Speicherkarte entfernen, wahlen Sie zur Sicherheit tiber die
Einstellungen die Option Auswerfen an.

1 Tippen Sie auf dem Homescreen auf Einstellungen > Speicherort > /.

2 Stecken Sie den Auswurfstift in das Loch im Kartentrager und ziehen Sie dann
den Kartentrager aus dem Gerat.

w

Entfernen Sie die Speicherkarte vom Kartentrager.

A Schieben Sie den Kartentrager zurtick in den Einschub.

A - Entfernen Sie die Speicherkarte nicht, wahrend das Gerat Daten tbertragt oder
darauf zugreift. Sonst konnten Daten verloren gehen oder unlesbar werden
bzw. die Speicherkarte oder das Gerat kann beschadigt werden. LG haftet
nicht fir Verluste, die aus dem Missbrauch oder der falschen Verwendung von
Speicherkarten resultieren. Dazu zahlt auch der Verlust von Daten.

Akku

Akku laden

Laden Sie vor der Verwendung des Gerats den Akku vollstandig auf.
Laden Sie das Gerat mit dem USB-Typ-C-Kabel.

Ladekabel-Anschluss
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A « Das Produkt nicht benutzen oder laden, falls Ladeanschluss, Anschlisse, das
Ladekabel, der Ladeadapter usw. feucht sind. Sonst konnte das Produkt in seiner
Funktion gestort werden oder ausfallen, und es besteht Verletzungsgefahr durch
Stromschlag, Feuer, Uberhitzung, Explosion usw. Wenn diese Teile feucht oder
nass sind, beenden Sie sofort die Benutzung oder das Aufladen des Produkts und
entfernen Sie die Nasse oder Feuchtigkeit vollstandig.

+ Die Akkuabdeckung nicht trennen.
Dieses Gerat ist mit einem nicht entfernbaren Akku ausgestattet. Den Akku oder
die Akkuabdeckung nicht entfernen oder auswechseln. \Wenn Sie versuchen, den
Akku oder die Akkuabdeckung zu entfernen oder auszuwechseln, kdnnte das
Produkt beschadigt werden und es konnte sich tberhitzen oder explodieren.

Benutzen Sie ausschlieklich USB-Kabel und Ladeadapter; die mit dem Produkt als
Basiskomponenten geliefert werden.

« |hr Gerat verfiigt tber einen internen, wiederaufladbaren Akku. Zu Ihrer eigenen
Sicherheit sollten Sie den eingebauten Akku nicht entfernen.

« Das Verwenden des Gerats wahrend des Ladens kann zu Stromschlagen ftihren.
Brechen Sie zum Verwenden des Gerats den Ladevorgang ab.

E « Trennen Sie das Ladegerat von der Steckdose, wenn das Gerat vollstandig geladen
ist. So wird ein unnotiger Stromverbrauch verhindert.

+ Ein Ladegerat, das schnelles Laden unterstutzt, ist im Lieferumfang des Produkts
enthalten. Die Funktion ftr schnelles Laden funktioniert gegebenenfalls nicht,
wenn ein anderes Ladegerat als das Original-Ladegerat aus dem Lieferumfang
verwendet wird.

Eine andere Maglichkeit zum Laden des Akkus besteht darin, das Gerat tber ein
USB-Kabel mit einem Desktop- oder Laptop-Computer zu verbinden. Dies kann
langer dauern, als wenn Sie den Adapter an eine Steckdose anschlieRen.

« Laden Sie den Akku nicht mithilfe eines USB-Hubs, der die Nennspannung nicht
aufrechterhalten kann. Anderenfalls ist das Laden eventuell nicht méglich oder
wird ungewollt abgebrochen.

+ Wenn Sie ein Servicezentrum aufsuchen, weil der Akku nicht mehr richtig
funktioniert, dann bringen Sie das Produkt und das Ladegerat mit. Weil der Akku
ein Verbrauchsartikel ist, kann die Lebensdauer des Akkus kiirzer sein als die des
Produkts.
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VorsichtsmaRnahmen bei der Verwendung des Gerats
+ Verwenden Sie unbedingt das mitgelieferte USB-Kabel; verwenden Sie
mit Ihrem Gerat keine USB-Kabel oder Ladegerate anderer Hersteller. Die
beschrankte Garantie von LG deckt die Verwendung von Zubehdrteilen anderer
Hersteller nicht ab.

Die Nichtbeachtung der Anweisungen in diesem Benutzerhandbuch oder eine
falsche Verwendung des Gerats kann zu Schaden am Gerat flhren.

Drahtloses Aufladen

Dieses Gerat unterstiitzt die drahtlose Ladefunktion. Laden Sie das Gerat mit
einem Qi-zertifizierten drahtlosen Ladegerat (optional, separat erhaltlich).

Akku mit drahtlosem Ladegerat aufladen

1 Platzieren Sie Ihr Gerat auf der Mitte des drahtlosen Ladegerats und richten Sie
es an der Antenne fUr das drahtlose Aufladen hinten am Gerat aus.

- Informationen zur Uberprtifung des Antennenbereichs fiir das drahtlose
Aufladen finden Sie unter Teiletibersicht.

2 Trennen Sie das Gerat vom Ladegerat, wenn der Akku volistandig geladen ist.

A « Wenn Sie den Akku mit einem drahtlosen Ladegerdt laden, legen Sie keine
magnetischen, metallischen oder leitenden Materialien zwischen das Gerat
und das Ladegerat. Dies kann zu einer Stérung beim Aufladen oder beim Gerat
fiihren und das Ladegerat kann sich erhitzen. In diesem Fall konnen das Gerét, das
Ladegerat oder die SIM-/Speicherkarten beschadigt werden.
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Wenn die Akkutemperatur wahrend dem Aufladen eine bestimmte Temperatur
Ubersteigt, kann das Aufladen angehalten werden.

Wenn magnetische, metallische oder leitende Materialien an der Hinterseite
des Gerats befestigt sind oder eine Schutzhiille angebracht ist, [adt das Gerat
mdglicherweise nicht ordnungsgemaR.

Wenn Sie den Akku mit einem drahtlosen Ladegerat in Bereichen mit schwacher
Signalstarke laden, kann sich die Netzwerkleistung lhres Gerats weiter
verschlechtern.

Laden Sie das Gerat mit einem Qi-zertifizierten drahtlosen Ladegerat (optional,
separat erhaltlich). Da die beschrankte Garantie von LG die Verwendung

von Zubehorteilen anderer Hersteller nicht abdeckt, kontaktieren Sie den
Dritthersteller:

Dieses Produkt unterstlitzt kabelloses Laden. Laden Sie das Produkt mit einem
kabellosen Ladegerat mit Qi-Zertifizierung (nicht im Lieferumfang). Manche
gewickelten kabellosen Ladegerate unterstutzen kabelloses Laden moglicherweise
nicht. Kabellose Ladegerate mit EPPUnterstiitzung (Extended Power Profile)
ermdglichen superschnelles kabelloses Aufladen.

LG Electronics ist nicht verantwortlich fiir Probleme in Bezug auf Zubehor

anderer Hersteller oder Marken. \Wenden Sie sich bei Problemen dieser Art an den
Hersteller der entsprechenden Zubehorprodukte.

Akku effizient verwenden

Die Akkulaufzeit kann sich verringern, wenn Sie gleichzeitig und Uber einen
langeren Zeitraum zahlreiche Apps und Funktionen ausfihren.

Beenden Sie Hintergrundvorgange, um die Akkulaufzeit zu verlangern.

Befolgen Sie fur einen moglichst geringen Energieverbrauch des Akkus die
folgenden Tipps:

Deaktivieren Sie die Bluetooth-oder Wi-Fi-Funktion, wenn Sie sie nicht
verwenden.

Legen Sie eine maglichst kurze Zeit bis zum automatischen Ausschalten des
Bildschirms fest.

Verringern Sie die Bildschirmhelligkeit.
Aktivieren Sie die Bildschirmsperre, wenn das Gerat nicht verwendet wird.
Uberpriifen Sie den Akkustand, wenn Sie heruntergeladene Apps verwenden.
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Touchscreen

Sie konnen mithilfe von Touchscreen-Gesten ihr Gerat bedienen.

Tippen

Tippen Sie mit der Fingerspitze leicht auf eine App oder Option, um sie
auszuwahlen oder auszuftihren.

Beriihren und Halten

Bertihren und halten Sie die Anzeige mehrere Sekunden lang, um ein Ment mit
verfligbaren Optionen zu 6ffnen.
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Zweimal tippen

Durch schnelles zweimaliges Tippen kénnen Sie die Ansicht auf einer \Webseite oder
Karte vergroRern oder verkleinern.

Ziehen

Beriihren und halten Sie ein Element, etwa eine App oder ein Widget, und bewegen
Sie dann den Finger gezielt an eine andere Position. Mit dieser Geste konnen Sie ein
Element verschieben.

Wischen

Bertihren Sie mit dem Finger den Bildschirm und fihren Sie ohne Unterbrechung
eine schnelle Bewegung durch. Mit dieser Geste konnen Sie unter anderem in einer
Liste, auf einer Webseite, durch Fotos oder zwischen Bildschirmen scrollen.
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Finger zusammen bewegen oder auseinanderziehen

Bewegen Sie zwei Finger zusammen, um die Ansicht zu verkleinern, beispielsweise
auf einem Foto oder einer Karte. Ziehen Sie zum VergréRern der Ansicht Ihre Finger
auseinander.

v

/,'

Setzen Sie den Touchscreen keinen tibermaRigen StéRen aus. Anderenfalls kénnte
der Beriihrungssensor beschadigt werden.

>

E « Eskann zu Fehlfunktionen des Touchscreens kommen, wenn Sie das Gerat in der
Nahe von magnetischen, metallischen oder leitenden Materialien verwenden.

Wenn Sie das Gerat bei hellen Lichtverhaltnissen wie beispielsweise direkter
Sonneneinstrahlung verwenden, ist der Bildschirm je nach Ihrer Position
maglicherweise nicht sichtbar. Verwenden Sie das Gerdt an einem schattigen
Standort oder einem Standort mit Umgebungslicht, das nicht zu hell, aber hell
genug zum Lesen von Blichern ist.

« Drlicken Sie nicht mit ibermaRiger Kraft auf den Bildschirm.
« Tippen Sie mit der Fingerspitze leicht auf die gewiinschte Option.

« Die Touch-Steuerung funktioniert méglicherweise nicht richtig, wenn Sie mit
einem Handschuh oder der Spitze Ihres Fingernagels auf den Bildschirm tippen.

« Die Touch-Steuerung funktioniert moglicherweise nicht richtig, wenn der
Bildschirm feucht oder nass ist.

+ DerTouchscreen funktioniert moglicherweise nicht richtig, wenn das Gerat mit
einer Bildschirmschutzfolie oder Zubehor aus anderen Geschaften ausgestattet
ist.

« Wenn Uber langere Zeit ein statisches Bild angezeigt wird, kann dies zu
Nachbildern oder einem eingebrannten Bildschirm fihren. Schalten Sie die Anzeige
aus oder verhindern Sie, dass bei Nichtverwendung des Gerats tber [angere Zeit
dasselbe Bild angezeigt wird.
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Homescreen

Homescreen im Uberblick

Uber den Homescreen haben Sie Zugriff auf verschiedene Funktionen und Apps auf
lhrem Gerat. Um zum Homescreen zu gelangen, wischen Sie in einem beliebigen
Bildschirm vom unteren Bildschirmrand nach oben.

Sie kénnen alle Apps und Widgets auf dem Homescreen verwalten. Wischen Sie
den Bildschirm nach links oder rechts, um alle installierten Apps auf einen Blick
anzuzeigen.

Layout des Homescreens

Sie konnen alle Apps anzeigen und die Widgets und Ordner auf dem Homescreen
organisieren.

Statusleiste —

Wetter-Widget —

+— Google-Suche-Widget

Ordner —

[ +——— Seitensymbol

o— Schnellzugriffsbereich

Navigationsleiste

E « Der Homescreen kann je nach Herstellerrichtlinie, Benutzereinstellung, Software-
Version oder Dienstanbieter unterschiedlich sein.
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- Statusleiste: In der Statusleiste kénnen Sie Statussymbole, die Uhrzeit und den
Akkustand anzeigen.

+ Wetter-Widget: Sehen Sie sich Wetter- und Zeit-Informationen fiir ein
bestimmtes Gebiet an.

- Google-Suche-Widget: Verwenden Sie die Googel-Suche, indem Sie die
Begriffe sprechen oder eingeben.

+ Ordner: Sie kdnnen Ordner anlegen oder Apps auf Basis von gewiinschten
Kriterien klassifizieren.

+ Seitensymbol: Die Gesamtzahl der Seiten des Homescreens anzeigen. Sie
kénnen auf das Symbol der gewlinschten Seite tippen, um zur gewahlten Seite
zu gelangen. Das Symbol der aktuellen Seite wird hervorgehoben.

+ Schnellzugriffbereich: Sie kdnnen wichtige Apps am unteren Bildschirmrand
fixieren, um von jeder beliebigen Seite des Homescreens darauf zuzugreifen.

- Navigationsleiste: \Wahrend der Benutzung der App konnen Sie zum vorigen
Bildschirm oder zum Homescreen wechseln und die Liste der Apps einsehen, die
Sie zuletzt verwendet haben.

Navigationsleiste benutzen

Hier finden Sie eine Anleitung, wie Sie mit Gesten die Navigationsleiste steuern

kénnen.

« Um zum Homescreen zu wechseln, wischen Sie vom unteren Bildschirmrand
nach oben.

+ Um zum vorigen Bildschirm zu wechseln, wischen Sie vom linken oder rechten
Bildschirmrand nach innen.

+ Um zum Ubersichtsbildschirm zu wechseln, ziehen Sie vom unteren
Bildschirmrand nach oben und halten Sie.

+ Um schnell zwischen Apps umzuschalten, wischen Sie am unteren
Bildschirmrand nach rechts, womit Sie zu den zuvor verwendeten Apps
gelangen.

E « Die Standardeinstellung fir die Navigationsleiste ist Gesten. Um zu Nur Tasten
Q 1Q/ [:l zu wechseln, auf dem Homescreen auf Einstellungen > Anzeige >
Navigationsleiste tippen, dann Nur Tasten auswahlen.
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Statussymbole

\Wenn eine Benachrichtigung Uber eine ungelesene Nachricht, ein Kalenderereignis
oder einen \Wecker angezeigt wird, erscheint in der Statusleiste das entsprechende
Benachrichtigungssymbol. Mithilfe der in der Statusleiste angezeigten
Benachrichtigungssymbole kénnen Sie den Status lhres Gerdts tiberprifen.

x

Kein Signal

%

Daten werden Uber das 5G-Netzwerk bertragen

Wecker eingestellt

Vibrationsmodus aktiviert

Bluetooth aktiviert

Uber USB mit einem Computer verbunden

Akkustand

Flugmodus EIN

Entgangene Anrufe

Wi-Fi verbunden

Stummschaltung aktiviert

GPS aktiviert

Hotspot aktiviert

Keine SIM-Karte eingelegt

Der NFC-Modus ist eingeschaltet

Je nach Geratestatus werden einige dieser Symbole mdglicherweise anders
dargestellt oder tiberhaupt nicht angezeigt. Achten Sie auf die Symbole
entsprechend der Umgebung und des Bereichs, in dem Sie das Gerat und lhren
Dienstanbieter verwenden.

Die angezeigten Symbole kénnen je nach Region oder Netzanbieter
unterschiedlich sein.
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Benachrichtigungs-Panel

Sie kénnen das Benachrichtigungs-Panel ¢ffnen, indem Sie die Statusleiste auf dem

Hauptbildschirm nach unten ziehen.

+ Um die Liste der Symbole fiir die Schnelleinstellungen anzuzeigen, kénnen Sie
das Hinweisfenster nach unten ziehen oder auf das Pfeilsymbol tippen.

- Im Hinweisfenster kannen Sie auf ¢2 tippen, um Symbole hinzuzufiigen, zu
|6schen oder anders anzuordnen.

+ Wenn Sie das Symbol beriihren und halten, wird der Bildschirm mit den
Einstellungen fir die entsprechende Funktion angezeigt.

E « Sie konnen das Benachrichtigungs-Panel auch auf dem Sperrbildschirm
verwenden. Ziehen Sie fiir einen schnellen Zugriff auf die gewlinschten Funktionen
das Benachrichtigungs-Panel nach unten, wahrend der Bildschirm gesperrt ist.
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Bildschirmausrichtung wechseln

Sie kénnen festlegen, dass die Bildschirmausrichtung je nach physischer
Gerateausrichtung automatisch wechselt.

Tippen Sie im Benachrichtigungs-Panel in der Liste der Schnellzugriffssymbole auf
Drehung.

Tippen Sie alternativ auf dem Homescreen auf Einstellungen > Anzeige und
aktivieren Automatisch drehen.

<aus

Homescreen bearbeiten
Bertihren und halten Sie eine freie Stelle auf dem Homescreen und wahlen Sie dann
den gewiinschten Vorgang aus den unten genannten Vorgangen aus.
» Wenn Sie die Seiten des Homescreens neu anordnen mochten, bertihren und
halten Sie eine Seite und ziehen Sie sie an eine andere Position.
+ Um ein Widget zum Homescreen hinzuzufiigen, bertihren und halten Sie eine
freie Stelle auf dem Homescreen und wahlen Sie Widgets.
+ Um Hintergrund, Thema, Symbole oder AOD zu andern, bertihren und halten Sie
eine freie Stelle auf dem Homescreen und wahlen Hintergrund & Thema.

Alternativ tippen Sie auf dem Homescreen auf Einstellungen > Anzeige >
Homescreen > Hintergrund, und wahlen dann Hintergriinde, Themen, Symbole
oder AOD fir das Gerat aus.
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+ Um das Raster zu wechseln, halten Sie eine freie Stelle am Homescreen beriihrt
und wahlen Sie Raster aus. Auf das gewtinschte Raster tippen und dann auf
Anwenden tippen.

+ Um die Homescreen Einstellungen zu konfigurieren, bertihren und halten
Sie eine freie Stelle auf dem Homescreen und wahlen Sie Homescreen
Einstellungen. Details finden Sie unter Homescreen Einstellungen.

+ Um deinstallierte Apps anzusehen oder erneut zu installieren, bertihren
und halten Sie eine freie Stelle auf dem Homescreen und wahlen Sie App
Papierkorb. Detalils finden Sie unter App Papierkorb.

« Um den Standardbildschirm zu andern, bertihren und halten Sie eine freie Stelle
auf dem Homescreen, gehen Sie zum gewiinschten Bildschirm, tippen Sie auf
2 und tippen Sie erneut auf den Bildschirm.

e———— Standardbildschirm
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Hintergrunddesign anzeigen
Um nur das Hintergrundbild anzuzeigen blenden Sie Apps und Widgets aus.
Ziehen Sie zwei Finger auf dem Homescreen auseinander.

+ Ziehen Sie zwei Finger auf dem Homescreen zusammen, um zum
urspriinglichen Bildschirm mit angezeigten Apps und Widgets zurtickzukehren.
Sie kénnen auch vom unteren Bildschirmrand aus — nach oben ziehen.

np

Apps auf dem Homescreen verschieben
Beriihren und halten Sie auf dem Homescreen eine App und ziehen Sie sie an eine
andere Position.

+ Um haufig verwendete Apps dauerhaft unten auf dem Homescreen zu
positionieren, beriihren und halten Sie eine App und ziehen Sie sie unten in den
Schnellzugriffsbereich.

+ Um ein Symbol aus dem Schnellzugriffsbereich zu entfernen, ziehen Sie das
entsprechende Symbol auf den Homescreen.
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Ordner auf dem Homescreen verwenden

Ordner erstellen

Bertihren und halten Sie auf dem Homescreen eine App und ziehen Sie sie tber
eine andere App.
+ Es wird ein neuer Ordner erstellt und die Apps werden dem Ordner hinzugefiigt.

Ordner bearbeiten
Tippen Sie auf dem Homescreen auf einen Ordner und flihren Sie eine der
folgenden Aktionen aus.

+ Um den Ordnernamen zu bearbeiten, auf den Ordnernamen tippen.

+ Um die Farbe zu andern, auf den Kreis rechts oben tippen.

+ Um Apps hinzuzufiigen, bertihren und halten Sie eine App, ziehen Sie sie Uber
den Ordner und lassen Sie los.

+ Um eine App aus dem Ordner zu entfernen, das App-Symbol gedriickt halten
und dabei aus dem Ordner heraus ziehen. Wenn die installierte App die einzige
App im Ordner ist, wird der Ordner automatisch entfernt.

- Sie kénnen auch Apps hinzufiigen oder entfernen, wenn Sie auf () tippen.

E « Sie kénnen die Farbe des Ordners nicht andern, wahrend Sie ein
heruntergeladenes Thema verwenden.
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Homescreen Einstellungen
Sie kénnen die Homescreen Einstellungen anpassen.
1 Tippen Sie auf dem Homescreen auf Einstellungen > Anzeige > Homescreen.
7 Passen Sie die folgenden Einstellungen an:
- Benutzeroberflache wahlen: Homescreen-Modus auswahlen.
+ Hintergrund: Hintergrund des Homescreens andern.

- Bildschirm-Wischeffekt: Effekt auswahlen, der beim Wechsel zwischen
den Seiten des Homescreens angewendet werden soll

+ Symbolkonturen: \Wahlen Sie, welche Form die Symbole haben sollen.
+ Google Feed:Im Haupt-Homescreen links anzeigen.

+ Apps sortieren nach: Festlegen, wie Apps auf dem Homescreen sortiert
werden.

« Apps ausblenden: Wahlen Sie, welche Apps auf dem Homescreen
ausgeblendet werden sollen.

- Homescreen Schleife: Aktivieren, um ein endloses Scrollen des
Homescreens zuzulassen (d.h. nach dem letzten Bildschirm wird erneut der
erste Bildschirm angezeigt).

+ Am Homescreen nach unten wischen: Festlegen, ob beim Wischen nach
unten am Homescreen die Suche nach Apps und Inhalten ausgefthrt wird
oder die Benachrichtigungen angezeigt werden sollen.

- Am Homescreen nach oben wischen: Festlegen, ob beim \Wischen nach
oben am Homescreen die Suche nach Apps und Inhalten ausgefiihrt wird.

+ Homescreen fixieren: \Wenn Sie diese Funktion aktivieren, wird verhindert,
dass Apps und Widgets anders angeordnet oder entfernt werden.
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Bildschirmsperre

Bildschirmsperre im Uberblick

Der Bildschirm Ihres Gerats wird beim Driicken der Ein-/Aus-/Sperrtaste
automatisch ausgeschaltet und gesperrt. Dies geschieht auch dann, wenn das
Gerat fur einen bestimmten Zeitraum nicht verwendet wird.

Sollten Sie die Ein-/Aus-/Sperrtaste driicken, wenn keine Bildschirmsperre aktiviert
ist, wird sofort der Homescreen angezeigt.

Aktivieren Sie die Bildschirmsperre, um die Sicherheit Ihres Gerats zu gewahrleisten
und den unerwUnschten Zugriff auf Ihr Gerat zu vermeiden.

E « Durch die Bildschirmsperre werden unnétige Touch-Eingaben auf dem
Geratebildschirm verhindert und der Energieverbrauch des Akkus wird reduziert.
Es wird empfohlen, die Bildschirmsperre zu aktivieren, wenn Sie das Gerat nicht
verwenden

Bildschirmsperre festlegen
Es stehen verschiedene Optionen fiir die Konfiguration der Einstellungen beziglich
der Bildschirmsperre zur Verfligung.

1 Tippen Sie auf dem Homescreen auf Einstellungen > Sperrbildschirm
& Sicherheit > Bildschirmsperre auswahlen und wahlen Sie dann die
bevorzugte Methode.
7 Passen Sie die folgenden Einstellungen an:
+ Keine: Bildschirmsperrfunktion deaktivieren.
« Ziehen: Ziehen Sie am Bildschirm, um ihn zu entsperren.
+ Muster: Bildschirm durch Zeichnen eines Musters entsperren.
+ PIN: Bildschirm durch Eingabe eines numerischen Passworts entsperren.

+ Passwort: Bildschirm durch Eingabe eines alphanumerischen Passworts
entsperren.

+ Fingerabdriicke: Bildschirm mit Ihrem Fingerabdruck entsperren.
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Sperrbildschirm anpassen:
Sie kénnen den Sperrbildschirm anpassen.
1 Tippen Sie am Homescreen auf Einstellungen > Sperrbildschirm & Sicherheit
> Sperrbildschirm anpassen.
7 Wihlen Sie eine Funktion, die Sie einstellen wollen.
« Hintergrund: Zum Festlegen des Hintergrundes Ihres Sperrbildschirms.
+ Uhr:Zum Festlegen der Position der Uhr auf dem Sperrbildschirm.
+ Verkniipfungen: Zum Auswahlen der Apps, die auf dem Sperrbildschirm

ausgefiihrt werden sollen. Die Einstellungen treten nur in Kraft, wenn der
Sperrbildschirm erscheint.

+ Wetteranimation: \Wetteranimationen fir den aktuellen Standort auf dem
Sperrbildschirm anzeigen.

« Kontaktinfo fiir verlorenes Telefon: Text festlegen, der auf dem
Sperrbildschirm angezeigt wird, der den Eigner des Telefons angibt.

Einstellungen zur sicheren Sperre
Sie kdnnen Einstellungen zum Sperren des Bildschirms festlegen.

1 Tippen Sie am Homescreen auf Einstellungen > Sperrbildschirm & Sicherheit
> Einstellungen zur sicheren Sperre.

7 Wihlen Sie eine Funktion, die Sie einstellen wollen.

+ Muster sichtbar machen (wird nur angezeigt, wenn Muster als
Bildschirmsperre festgelegt ist): Einschalten, damit das Muster sichtbar
gemacht wird.

+ Sperr-Timer: Zum Festlegen der Zeit, die verstreicht, bevor der Bildschirm
automatisch gesperrt wird, nachdem die Hintergrundbeleuchtung sich
ausgeschaltet hat (ZeitUberschreitung durch Inaktivitat).

« Ein-/Austaste sperrt sofort: Bei Aktivierung dieser Option wird der
Bildschirm sofort gesperrt, wenn die Ein-/Aus-/Sperrtaste gedriickt wird.
Diese Einstellung hat Vorrang vor der Einstellung des Sperr-Timers.

- Sperrmodus einblenden (wird nur angezeigt, wenn eine Bildschirmsperre
festgelegt ist): Aktivieren Sie diese Option, damit das Sperrmodus-Symbol
angezeigt wird, wenn die Taste Ein/Aus / Sperre gedriickt gehalten wird.
Tippen Sie auf das Sperrmodus-Symbol, wenn Sie Smart Lock, biometrisches
Entsperren und Benachrichtigungen auf dem Sperrbildschirm ausschalten
wollen.
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+ Smart Lock: Ermaglicht Ihnen, das Telefon entsperrt zu halten, wenn Sie
vertrauenswiirdige Gerate, Orte und/oder Stimmen festgelegt haben und/
oder das Tragen am Korper erkannt wird.

E + Je nach ausgewahlter Bildschirmsperre gibt es unterschiedliche Mentioptionen.

KnockON

Sie kdnnen den Bildschirm ein- oder ausschalten, indem Sie zweimal auf den
Bildschirm tippen.

5 « Diese Option ist nur auf dem von LG bereitgestellten Homescreen verfigbar. Bei
Verwendung eines anderen Launchers oder auf einem vom Benutzer installierten
Homescreen funktioniert sie maglicherweise nicht richtig.

« Tippen Sie mit der Fingerspitze auf den Bildschirm, nicht mit dem Fingernagel.

« Stellen Sie zur Verwendung der KnockON-Funktion sicher; dass der Annaherungs-/
Lichtsensor nicht durch einen Aufkleber oder einen sonstigen Fremdkérper
verdeckt wird.

Bildschirm einschalten
Tippen Sie zweimal auf die Mitte des Bildschirms.

+ Wenn Sie oben oder unten auf den Bildschirm tippen, kann sich die
Erkennungsrate verringern.

Bildschirm ausschalten

Tippen Sie zweimal auf eine freie Stelle auf dem Homescreen und dem
Sperrbildschirm.

Sie kénnen auch zweimal auf eine freie Stelle in der Statusleiste tippen.

KnockON deaktivieren
\Wenn Sie die Funktion KnockON nicht benutzen wollen, dann nehmen Sie folgende
Einstellung vor.

Tippen Sie auf dem Homescreen auf Einstellungen > Erweiterungen > KnockON
und ziehen Sie, um die Funktion zu deaktivieren.
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Verschliisselung der Speicherkarte

Sie konnen auf der Speicherkarte gespeicherte Daten verschlisseln und
schitzen. Von anderen Geraten kann nicht auf die verschliisselten Daten auf der
Speicherkarte zugegriffen werden.

1 Tippen Sie am Homescreen auf Einstellungen > Sperrbildschirm & Sicherheit
> Verschliisselung & Anmeldeinformationen > SD-Karte verschliisseln.
2 Lesen Sie die auf dem Bildschirm angezeigte Ubersicht tiber die

Speicherkarten-Verschlisselung und tippen Sie dann auf Fortfahren, um
fortzufahren.

3 Wahlen Sie eine Option aus und tippen Sie auf Verschliisseln.
« Neue Daten verschliisseln: Nur Daten verschliisseln, die nach der
Verschlusselung auf der Speicherkarte gespeichert werden.
- Komplette Verschliisselung: Alle aktuell auf der Speicherkarte
gespeicherten Daten verschlisseln.
- Mediendateien ausschlieRen: Alle Dateien aulRer Mediendateien wie Musik,
Fotos und Videos verschlisseln.

Nach dem Starten der Speicherkartenverschlisselung stehen einige Funktionen
nicht zur Verfiigung.

il

Wenn Sie das Gerat wahrend der Verschllsselung ausschalten, wird der
Verschlisselungsvorgang abgebrochen und es kann zu Beschadigung einiger
Daten kommen. Achten Sie deshalb vor dem Starten der Verschlisselung darauf,
dass der Akkustand ausreichend ist.

Auf verschlisselte Dateien kann nur von dem Gerat zugegriffen werden, auf dem
die Dateien verschlisselt wurden

Die verschliisselte Speicherkarte kann nicht in einem anderen LG Gerét verwendet
werden. Um die verschlisselte Speicherkarte in einem anderen Mobilgerat zu
verwenden, formatieren Sie die Karte.

« Sie kénnen die Speicherkartenverschlisselung auch dann aktivieren, wenn keine
Speicherkarte in das Gerat eingelegt ist. Eine nach der Verschlisselung eingelegte
Speicherkarte wird automatisch verschliisselt
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Screenshots erstellen

Sie konnen Screenshots vom aktuell angezeigten Bildschirm erstellen.

Uber eine Tastenkombination

Halten Sie gleichzeitig die Ein-/Aus-/Sperrtaste und die Leiser-Taste flir mindestens
zwei Sekunden gedrtckt halten.

« Screenshots kénnen im Ordner Screenshots in der Galerie angezeigt werden.

Mittels Screenshot
Ziehen Sie auf dem Bildschirm, von dem Sie einen Screenshot erstellen mochten,
die Statusleiste nach unten und tippen Sie dann auf @.

E « Details finden Sie unter Notizen auf einem Screenshot erstellen.
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Text eingeben

Smarte-Symbolleiste verwenden

Sie kénnen an einer Stelle verschiedene Tastatur-Eingabemethoden benutzen.
Oben auf der Tastatur kénnen Sie die gewtinschte Eingabemethode auswahlen.

T Wahlen Sie die gewtinschte Tastatur-Eingabemethoden Uber die Smarte-
Symbolleiste aus.

2 Tippen Sie auf * * und wahlen Sie die Eingabemethode, die (iber die Smarte-
Symbolleiste angezeigt werden soll, oder organisieren Sie die Symbole neu.

_—
Smarte —

Symbolleiste

E « Sie kénnen bis zu 6 \Werkzeuge Uber die Smarte-Symbolleiste hinzufiigen.

« Je nach verwendetem Gerat konnen die unterstitzten Eingabemethoden
unterschiedlich sein.

- Uber die Tastatur-Einstellungen kénnen Sie die Funktion Smarte-Symbolleiste
einschalten oder ausschalten.

« Auch durch Tippen auf §83 kénnen Sie Tastatur-Eingabemethoden benutzen.

. @:Emojis hinzuftigen
- [ : Sticker hinzufiigen.

- @ :Sie kénnen die GIF Tastatur von Tenor benutzen. Um diese Funktion zu

benutzen, auf Akzeptieren tippen.
+ (35 :Meine Emajis hinzufiigen.
+ 22 :Draw Chat 6ffnen.
+ §63 : Zugriff auf Tastatur-Einstellungen.
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- :Tippen Sie auf §, um Text mittels Sprache einzugeben.
- Sprechen Sie zur Optimierung der Sprachbefehlserkennung klar und
deutlich.
- Um Text mittels Sprache einzugeben, stellen Sie sicher, dass Ihr Gerat mit
einem Netzwerk verbunden ist.
- Um die Sprache fir die Spracherkennung auszuwahlen, tippen Sie auf
dem Spracherkennungsbildschirm auf % > Sprachen.

Diese Funktion wird mdglicherweise nicht unterstiitzt und die
unterstitzten Sprachen kénnen je nach Versorgungsgebiet
unterschiedlich sein.

. : Zwischenablage 6ffnen.

- 2 Text per Handschrift eingeben: Zur Benutzung der Handschrift-Funktion
missen die Daten der Eingabesprache heruntergeladen werden. Um die
Daten der Eingabesprache fiir die Handschrift-Funktion herunterzuladen,
auf Herunterladen tippen.

. :Bei Benutzung der Multi-Window-Funktion kdnnen Sie die Tastatur
schwebend stellen. Sie kénnen die Tastatur auch an die gewUnschte Position
ziehen.

+ In der Smart-Symbolleiste auf 3 tippen.

- Wenn das Gerat am LG Dual-Bildschirm angeschlossen ist, kdnnen Sie
den Bildschirminhalt des LG Dual-Bildschirms erfassen und wahrend
Tastatureingaben anfligen. Weite Informationen finden Sie unter
Funktion Direkte Aufnahme mit dem Dual Bildschirm benutzen.

- In der Smart-Symbolleiste auf & tippen.

- Wenn das Gerat am LG Dual-Bildschirm angeschlossen ist, kdnnen Sie
die Tastatur vertikal erweitern und den oberen Bildschirm als App-
Bildschirm und den unteren Bildschirm als Tastatur-Bildschirm benutzen.
Weite Informationen finden Sie unter Dual-Tastatur am Dual Bildschirm
verwenden.
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Smart Keyboard-Funktion verwenden

Mithilfe der Smart Keyboard-Funktion kdnnen Sie Text eingeben und bearbeiten.
\Wenn Sie die Smart Keyboard-Funktion verwenden, kénnen Sie den Text bei der
Eingabe sehen, ohne zwischen dem Bildschirm und einer herkémmlichen Tastatur
wechseln zu missen. So kénnen Sie Fehler bei der Texteingabe ganz leicht finden
und korrigieren.

Cursor verschieben

Mit der Smart Keyboard-Funktion kénnen Sie den Cursor genau an die gewiinschte
Position verschieben. Beriihren und halten Sie bei der Texteingabe die Leertaste und
ziehen Sie dann nach links oder rechts.

< () =

E « Diese Option ist nur auf der QWERTZ-Tastatur verftigbar.

Worter vorschlagen

Bei Verwendung der Smart Keyboard-Funktion werden Ihre Nutzungsmuster
automatisch analysiert, um bei der Texteingabe haufig verwendete \Worter
vorzuschlagen. Je [anger Sie Ihr Gerat verwenden, umso praziser sind die
Vorschlage.

Geben Sie Text ein und tippen Sie dann auf ein vorgeschlagenes \Wort oder wischen
Sie die linke oder rechte Seite der Tastatur leicht nach oben.
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+ Das ausgewahlte Wort wird automatisch eingegeben. Sie missen nicht jeden
einzelnen Buchstaben des Worts manuell eingeben.

[— ]
; !
4

Kopieren und Einfiigen

Sie kénnen Text in einer App ausschneiden oder kopieren und den Text dann in der
gleichen App einfiigen. Sie kénnen auch andere Apps ausflhren und den Text in
diese Apps einfligen.

e

1 Berthren und halten Sie den Bereich rund um den Text, den Sie kopieren oder
ausschneiden mochten.

2 Ziehen Sie @ / B, um den zu kopierenden oder auszuschneidenden Bereich
festzulegen.

3 Wahlen Sie entweder Ausschneiden oder Kopieren aus.

+ Ausgeschnittener oder kopierter Text wird automatisch der Zwischenablage
hinzugeflgt.

A Bertihren und halten Sie das Texteingabefenster und wahlen Sie anschlieRend
Einfiigen aus.

E « Ist kein Element kopiert oder ausgeschnitten worden, wird die Option Einfiigen
nicht angezeigt.
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Inhalte teilen

Inhalte iiber ein anderes Gerat wiedergeben

Sie kénnen auf dem Gerat gespeicherte Fotos, Videos oder Musiktitel auf einem
Fernsehgerat wiedergeben.

T Verbinden Sie das Fernsehgerat und Ihr Gerdt mit demselben Wi-Fi-Netzwerk.

2 Tippen Sie bei der Betrachtung von Elementen der Galerie oder der Musik-App
auf Cg oder auf ¢ > Auf anderem Gerit wiedergeben.
Oder tippen Sie auf dem Homescreen auf Einstellungen > Verbundene Geréte
> Screen Share und dann auf (1)), um die Funktion zu aktivieren.

3 Wahlen Sie das Fernsehgerat aus, mit dem Sie eine Verbindung herstellen
mochten.

E +Um Chromecast verwenden zu kénnen, aktualisieren Sie Google Play auf die
aktuellste Version.

Inhalte von Geraten in der Nahe anzeigen

Mithilfe der Apps Galerie oder Musik kénnen Sie Inhalte von verschiedenen Geraten
wie einem Computer, einem NAS oder einem Mobilgerat betrachten.

Gerate verbinden

Verbinden Sie lhr Gerat und das andere Gerat, das die DLNA-Funktion unterstitzt,
mit demselben drahtlosen Netzwerk.

E « Stellen Sie sicher, dass die Funktion fiir den Dateiaustausch (DLNA) sowohl auf
dem Gerat als auch auf Ihrem verbundenen Gerat aktiviert ist.
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Nach Geréaten in der Ndhe suchen

Sie konnen eine Liste der mit demselben Netzwerk verbundenen DLNA-Gerate
anzeigen. \Wahlen Sie dazu in der jeweiligen App das Menii : > Geréte in der
Umgebung aus.

Sie konnen Inhalte von Geraten in der Nahe so nutzen, als wirden Sie sie auf lhrem
eigenen Gerdt verwenden.

Dateien senden oder empfangen

Sie kénnen auf Ihrem Gerat gespeicherte Dateien mit einem anderen LG Gerat oder
Tablet gemeinsam nutzen.

Dateien senden

Tippen Sie in der App Galerie oder in einer anderen App auf : > Teilen oder auf o<,
und wahlen Sie ein Gerat aus der Liste flr den Dateiaustausch aus.

Dateien empfangen
Ziehen Sie die Statusleiste nach unten und tippen Sie auf Dateiaustausch.

Falls Ihr Gerat die Funktion flr den Dateiaustausch nicht unterstutzt, tippen Sie auf
dem Homescreen auf Einstellungen > Verbundene Gerdte > Dateiaustausch >
SmartShare Beam () ).

E + Mit bestimmten Geraten, die DLNA unterstutzen, kénnen Sie Dateien gemeinsam
nutzen.
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Nicht storen

Sie kénnen Benachrichtigungen fur einen bestimmten Zeitraum einschranken oder
ausschalten, um Stérungen zu vermeiden.

Tippen Sie auf dem Homescreen auf Einstellungen > Ton > Nicht stéren.
+ Tippen Sie auf Modus und wahlen Sie den gewlnschten Modus:

- Nur mit Prioritat: Akustische oder Vibrationsbenachrichtigungen fr die
ausgewahlten Apps erhalten. Auch wenn Nur mit Prioritat aktiviert ist,
ertonen Wecker dennoch.

- V6llig lautlos: Tone und Vibration deaktivieren.

- Prioritaten auswahlen: Fur die ausgewahlten Apps Wecker ertonen lassen und
Benachrichtigungen erhalten.

- Anrufe von: Eine Reihe Benachrichtigungen erstellen, die bei Empfang von
Anrufen ausgegeben werden.

E « Wiederholte Anrufe: Zweiter Anruf vom selben Anrufer innerhalb von 15
Minuten ist nicht stumm geschaltet.

- Nachrichten von: Eine Reihe Benachrichtigungen erstellen, die bei Empfang
von Nachrichten ausgegeben werden.

+ Nicht-storen aktivieren: Die Funktion Nicht-storen einschalten.

+ Ruhezustand: Den Zeitplan einrichten, durch den festgelegt wird, wann die
Funktion Nicht-stéren aktiviert werden soll.

- Hilfe: Die Hilfe fur ,Nicht stdren” anzeigen.
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Apps installieren und deinstallieren

Apps installieren
Rufen Sie einen App Store auf, um nach Apps zu suchen und Apps herunterzuladen.

+ Sie konnen SmartWorld, Play Store oder den App Store des Netzanbieters
verwenden.

E « Einige App-Stores erfordern die Erstellung und Anmeldung mit einem Konto.
« Einige Apps konnen Kosten verursachen.

+ Wenn Sie eine mobile Datenverbindung verwenden, kénnen je nach Tarif Kosten
fir die Datennutzung entstehen.

« SmartWorld wird mdglicherweise je nach Gebiet oder Netzanbieter nicht
unterstitzt

Apps deinstallieren

Sie konnen Apps von Ihrem Gerat deinstallieren, die Sie nicht mehr verwenden
mochten.

Durch Beriihren und Halten deinstallieren

Eine freie Stelle auf dem Homescreen gedriickt halten und dann bei der App, die Sie
|6schen wollen, auf @ dricken.

Mithilfe des Meniis ,Einstellungen” deinstallieren
Tippen Sie auf dem Homescreen auf Einstellungen > Apps > App Info, wahlen Sie
die App und tippen Sie auf Deinstallieren.

E « Einige Apps kénnen vom Benutzer nicht deinstalliert werden.
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Apps liber den App Store deinstallieren

Rufen Sie zum Deinstallieren einer App den App Store auf, iiber den Sie die App
heruntergeladen haben, und deinstallieren Sie die App.

Apps wahrend der Einrichtung installieren und

deinstallieren

Wenn Sie das Gerat zum ersten Mal einschalten, kdnnen Sie empfohlene Apps
herunterladen.

Sie kénnen diesen Schritt auch auslassen und zum nachsten Schritt tbergehen.

App Papierkorb
Sie konnen sich die deinstallierten Apps anzeigen lassen. Sie kdnnen Apps auch
innerhalb von 24 Stunden nach der Deinstallation neu installieren.
1 Tippen Sie auf dem Homescreen auf Management > App Papierkorb.
Sie kénnen auch eine freie Stelle auf dem Homescreen bertihren und halten
und dann auf App Papierkorb tippen.
2 So aktivieren Sie die gew(inschte Funktion:
+ Wiederherstellen: Ausgewahlte App neu installieren.
- {i1] : Deinstallierte Apps endgiiltig vom Gerat entfernen.

E « Deinstallierte Apps werden 24 Stunden nach der Deinstallation automatisch vom
Gerat entfernt. Wenn Sie deinstallierte Apps neu installieren méchten, missen Sie
sie erneut aus dem App Store herunterladen.

« Diese Funktion ist nur auf dem Standard-Homescreen aktiviert. \Wenn Sie Apps
bei Verwendung der EasyHome-Oberflache oder eines anderen Launchers
deinstallieren, werden die Apps sofort endgiltig vom Gerat entfernt.
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App-Verkniipfungen

Beriihren und halten Sie auf dem Homescreen ein App-Symbol wie Anruf,
Nachricht, Kamera, Galerie und Einstellungen, um ein Schnellzugriff-Ment

anzuzeigen. App-Verknipfungen sind hilfreich, um Apps einfacher zu benutzen.

+ Um die Widgets fur die App festzulegen, tippen Sie auf &)
+ Um App-Informationen anzuzeigen, auf () tippen.

E « Diese Funktion ist nur bei manchen Apps verfiigbar.
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Telefon

Sprachanruf

Sie kénnen einen Anruf auf mehrere Arten tatigen, beispielsweise durch Eingabe
einer Telefonnummer, aus Ihrer Kontaktliste oder aus der Liste der letzten Anrufe.
Anruf liber das Tastenfeld tatigen

1 Tippen Sie auf dem Homescreen auf (8 > Wihlen.

7 Tatigen Sie einen Anruf auf die von lhnen gewiinschte Art:
- Geben Sie eine Telefonnummer ein und tippen Sie auf ®.
+ BerUhren und halten Sie eine Kurzwahlnummer.

+ Geben Sie den Anfangsbuchstaben des Namens eines Kontakts in der
Kontaktliste ein, um nach dem Kontakt zu suchen. Tippen Sie dann auf °

E «Um fir einen internationalen Anruf das ,+" einzugeben, bertihren und halten Sie
die 0.

« Informationen zum Hinzuftigen von Telefonnummern zur Kurzwahlliste finden Sie
unter Kontakte hinzufiigen.

Aus Kontakten heraus Anrufe tatigen

1 Tippen Sie auf dem Homescreen auf (> Kontakte.

2 Aus der Liste der Kontakte die Nummer auswahlen und dann auf &, tippen.
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Anruf annehmen
Um einen Anruf entgegenzunehmen, ziehen Sie am Bildschirm des eingehenden
Anrufs das Symbol @®.
+ Wenn ein Stereo-Headset angeschlossen ist, kdnnen Sie Anrufe (iber die
Anruf-/Ende-Taste am Headset tatigen.

+ Um einen Anruf ohne Ausschalten des Bildschirms zu beenden, tippen Sie auf
dem Homescreen auf Einstellungen > Netzwerk & Internet > Anruf > Anrufe
annehmen und beenden und aktivieren Sie dann Anrufe mit der Ein-/Aus-
Taste beenden.

E « Tippen Sie am Homescreen auf Einstellungen > Netzwerk & Internet > Anruf
> Anrufe annehmen und beenden > Anrufe mit der Ein-/Aus-Taste beenden,
dann kénnen Sie ein Telefonat beenden, indem Sie die Ein-/Aus-/Sperrtaste driicken,
wahrend der Bildschirm des laufenden Telefonats angezeigt wird.

Anruf abweisen
Um einen Anruf abzulehnen, ziehen Sie am Bildschirm des eingehenden Anrufs €.
+ Um eine Abweisungsnachricht zu senden, ziehen Sie die Abweisungsnachricht-
Option () Uber den Bildschirm.

- Um eine Abweisungsnachricht hinzuzufiigen oder zu bearbeiten, tippen Sie auf
dem Homescreen auf Einstellungen > Netzwerk & Internet > Anruf > Anrufe
sperren & mit einer Nachricht ablehnen.

+ Driicken Sie bei einem eingehenden Anruf die Taste fir Lauter, fir Leiser oder
die Ein-/Aus-/Sperrtaste, um den Klingelton oder die Vibration auszuschalten
oder den Anruf zu halten.

Uberpriifung eines eingehenden Anrufs bei

Verwendung einer App

\Wenn wahrend der Verwendung einer App ein Anruf eingeht, kann eine Pop-up-
Benachrichtigung oben am Bildschirm angezeigt werden. Vom Pop-up-Bildschirm aus
konnen Sie den Anrufen entgegennehmen, ablehnen oder eine Nachricht senden.

E « Tippen Sie auf dem Homescreen auf Einstellungen > Netzwerk & Internet >
Anruf > Zustzliche Einstellungen > Popup fiir eingehende Anrufe und wahlen
Sie dann, wie bei Benutzung einer App ein eingehender Anruf angezeigt werden soll.
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Entgangene Anrufe anzeigen

Bei einem entgangenen Anruf wird in der Statusleiste am oberen Bildschirmrand
24 angezeigt.

Ziehen Sie die Statusleiste nach unten, um Details zu den entgangenen Anrufen
anzuzeigen. Sie kénnen auch auf dem Homescreen auf (8 > Anrufliste tippen.

Verfiigbare Funktionen wahrend eines Anrufs
Wahrend eines Anrufs konnen Sie verschiedene Funktionen nutzen, indem Sie auf
folgende Tasten auf dem Bildschirm tippen:
- Kontakte: Zeigt die Kontaktliste wahrend eines Anrufs an.
- Halten: Das aktuelle Gesprach halten.
- Tasten: \Wahltastatur anzeigen oder verbergen.
+ Lautspr.: Freisprechfunktion aktivieren.
+ Stumm: Mikrofon ausschalten, sodass |hr Gesprachspartner Sie nicht mehr
horen kann.
+ Bluetooth: Schaltet den Anruf auf ein Bluetooth-Gerat um, das gekoppelt und
verbunden ist.
- @ :Einen Anruf beenden.
+ :Zusatzliche Anruf-Optionen 6ffnen.

E « Die verfligbaren Einstellungen kénnen je nach Gebiet oder Netzanbieter
unterschiedlich sein.
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Drei-Teilnehmer-Anruf tatigen
Wahrend eines Anrufs kdnnen Sie einen anderen Kontakt anrufen.
1 Tippen Sie wahrend eines Anrufs auf : > Anruf hinzuf.
7 Geben Sie eine Telefonnummer ein und tippen Sie auf e
« Die beiden Anrufbildschirme werden gleichzeitig auf dem Bildschirm
angezeigt. Der erste Anruf wird gehalten.

3 Um eine Konferenzschaltung zu beginnen, tippen Sie auf Konferenz.

E « Jeder Anruf kann Kosten verursachen. \Wenden Sie sich an Ihren Netzanbieter;
wenn Sie weitere Informationen wiinschen.

Anrufliste anzeigen

Um die Liste kurzlich durchgefiihrter Telefonate einzusehen, tippen Sie auf dem
Homescreen auf (&) > Anrufliste. Dann kénnen Sie die folgenden Funktionen
verwenden:

+ Um detaillierte Anrufinformationen anzuzeigen, wahlen Sie einen Kontakt aus.
Um den ausgewahlten Kontakt anzurufen, tippen Sie auf &...

- Um die Anrufliste zu [8schen, tippen Sie auf : > Ldschen.

E « Die angezeigte Anrufdauer kann von den Anrufgebiihren abweichen. Wenden Sie
sich an lhren Netzanbieter; wenn Sie weitere Informationen wiinschen.

+ Der geléschte Anrufverlauf kann nicht wiederhergestellt werden.

«Um die SchriftgroRe von Anrufprotokollen oder Kontakten anzupassen, ziehen Sie
zwei Finger am Bildschirm zusammen oder auseinander:

Anrufoptionen konfigurieren
Sie kénnen verschiedene Anrufoptionen festlegen.

T Tippen Sie auf dem Homescreen auf (8> Wahlen oder Anrufliste.

2 Tippen Sie auf : > Anrufeinstellungen und legen Sie die Optionen nach lhren
Wiinschen fest.
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Nachrichten

Nachricht senden

Mit der Nachrichten-App koénnen Sie Nachrichten erstellen und an Ihre Kontakte
senden.

E - Das Versenden von Nachrichten im Ausland kann zusatzliche Kosten verursachen.
Wenden Sie sich an lhren Netzanbieter, wenn Sie weitere Informationen wiinschen.

1 Tippen Sie auf dem Homescreen auf ).

2 Tippen Sie auf GHIID.

3 Geben Sie einen Empfanger an und erstellen Sie eine Nachricht.
- Um Multimediafunktionen zu nutzen, auf () tippen.
- Um optionale Mentielemente zu 6ffnen, tippen Sie auf .

A Tippen Sie auf B>, um die Nachricht zu senden.

Nachricht lesen
Sie kénnen ausgetauschte Nachrichten pro Kontakt anzeigen.
1 Tippen Sie auf dem Homescreen auf €.
2 Wihlen Sie einen Kontakt aus der Nachrichtenliste aus.
E « In einer Nachrichtenliste oder einem Chat-Fenster kénnen Sie die SchriftgroRe

anpassen, indem Sie zwei Finger auf den Bildschirm setzen und die Abstand
zwischen den Fingern vergroRern bzw. verkleinern.
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Nachrichteneinstellungen konfigurieren
Sie kénnen die Nachrichteneinstellungen nach lhren \Wiinschen andern.

1 Tippen Sie auf dem Homescreen auf €.
2 Tippen Sie in der Nachrichtenliste auf : > Einstellungen.

5 « Fir das Hinweisfenster, Anrufsperre, Katastropfenalarm, Multimedia-Meldungen
etc. kdnnen Sie Einstellungen vornehmen.

Kamera

Kamera einschalten
Sie konnen Fotos oder Videos aufnehmen, um besondere Momente festzuhalten.
Tippen Sie auf dem Homescreen auf (&).

E Wischen Sie die Kameralinse mit einem sanften Tuch ab, bevor Sie ein Foto
aufnehmen oder Video aufzeichnen.

Achten Sie darauf, die Kameralinse nicht mit Ihren Fingern oder anderen
Fremdgegenstanden zu verschmutzen.

Auch wenn das Telefon auf Vibrieren oder Stumm geschaltet ist, ist beim
Aufnehmen von Fotos das Ausloser-Klicken zu horen.

Die Bilder in diesem Benutzerhandbuch kdnnen vom eigentlichen Gerat
abweichen.

Unter Galerie kénnen Sie Fotos und Videos anzeigen und bearbeiten. Details
finden Sie unter Galerie im Uberblick.

Benutzen Sie das Produkt nicht fiir einen Zweck, durch den die Rechte oder die
Privatsphare anderer verletzt werden kénnte.
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Ein Foto aufnehmen
Nehmen Sie mit der im Produkt vorhandenen Kamera ein Foto auf.
T Auf (@) tippen und das Motiv fokussieren.

- Sie kénnen auf dem Bildschirm das Motiv bertihren, damit sich die Kamera
darauf fokussiert.

« Durch Spreizen oder Zusammenziehen von zwei Fingern kdnnen Sie in das
Motiv hinein- oder herauszoomen.

+ Wahlen Sie einen Zoom-Faktor aus ¢.9 / (29 / ,

2 Tippen Sie auf ., um ein Foto aufzunehmen.
+ Sie konnen auch mittels Lauter- oder Leiser-Taste ein Foto aufzunehmen.
- \Wahrend der Aufnahme eines Videos konnen Sie ein Foto machen, indem
Sie auf dem Bildschirm auf @ driicken.

+ Die auf dem Aufnahme-Bildschirm angezeigten Optionen kénnen
sich je nach ausgewahlter Kamera (vordere oder hintere Kamera) und
Kameramodus unterscheiden.

Nach dem Offnen der Kamera-App schaltet sich diese automatisch aus,
wenn sie flr eine \Weile nicht benutzt wird.

Google Lens starten.
Einstellungen zum Timer Q:rt#gfr;odus
festlegen/loschen 7
:| ——— Zuvorderer/hinterer
Einstellungen zum Blitz ! ! Kamera wechseln
festlegen/6schen
Filter-Effekt anwenden —» I___l_-l «—— Foto aufnehmen
1 — Zoom auswahlen
Seitenverhaltnis wahlen —
. . | S Vorschau
Einstellungen der Kamera 1 I Automatische

Szenen-Optimierung
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E « Sie kénnen die Kamera-App ausfiihren, indem Sie zweimal kurz die Ein-/Aus-Taste
dricken. Tippen Sie auf dem Homescreen auf Einstellungen > Erweiterungen >
Verkniipfungen und dann auf Kamera 6ffnen, um die Funktion zu aktivieren.

« Wenn der Bildschirm ausgeschaltet oder gesperrt ist, kénnen Sie die Kamera
durch zweimaliges Driicken der Leiser-Taste aktivieren.

« Tippen Sie auf dem Homescreen auf Einstellungen > Erweiterungen >
Verkniipfungen und dann auf Kamera 6ffnen @ ), um die Funktion zu

aktivieren.

Kameraoptionen anpassen
Sie kénnen eine Vielzahl von Kameraoptionen nach Ihren Wiinschen festlegen.
Tippen Sie auf dem Bildschirm auf §63.

E + Die verfligbaren Optionen hangen von der ausgewahlten Kamera (vordere oder
hintere Kamera) und dem ausgewahlten Kameramodus ab.

Automatische
Szenen-
Optimierung

Beim Erkennen der aufgenommenen Szene wird die optimale
Auflésung automatisch eingestellt.

Bildkomposition

Beim Aufnehmen eines Portrats wird bei der Erkennung einer Person
die optimale Komposition empfohlen.

Damit optimale Fotos entstehen, wird der Benutzer informiert, wenn

Tipps die Augen der aufgenommenen Person geschlossen waren oder
wenn das Bild unscharf ist.

FotogroRe Ermaglicht, die GroRe des Fotos und das Seitenverhaltnis zu wahlen.
Fotos in lebendigen Farben erstellen und Ausgleichseffekte

HDR auch dann erzielen, wenn die Fotos oder Videos bei Gegenlicht
aufgenommen werden. Diese Funktionen werden tber die HDR-
Technologie (High Dynamic Range) der Kamera bereitgestellt.

Korrektur von

Verzerrungen bei
Ultraweitwinkel

Korrigiert Verzerrungen auf dem Bildschirm beim Aufnehmen von
Ultraweitwinkel-Fotos.

Im Format HEIF
speichern

Sie kénnen Speicherplatz sparen, indem Sie die Bilddatei
komprimieren und im HEIF-Format (HEIF - High Efficiency Image File
Format) speichern. Es ist maglich, dass andere Gerate Bilddateien im
HEIF-Format nicht unterstiitzen.
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Live-Foto Die Aktionen vor und nach der Aufnahme eines Fotos aufzeichnen.
Bildraster einblenden, um die Kamera bei der Aufnahme von Fotos
Raster und Videos anhand der horizontalen und vertikalen Hilfslinien

auszurichten.

Sprachausloser

Ermdglich Ihnen, Fotos aufzunehmen, indem Sie ‘Cheese, ‘Smile]
‘Whiskey; Kimchi" oder LG’ sagen.

S.Ignat.l.” Anzeige einer personalisierten Signatur auf den Fotos.
hinzufiigen
Starldorte Bild mit GPS-Standortdaten speichern.
speichern
Wahlen Sie, ob Sie Bilder und Videos im Internen Speicher oder
Speicher auf einer Speicherkarte speichern mochten. (Verfigbar, wenn eine
Speicherkarte eingelegt ist.)
Hilfe Hilfe fur jedes Kamera-MenU anzeigen.

Zusatzliche Optionen fiir die vordere Kamera

Korrektur von
Verzerrungen bei
Selfies

Korrigiert verzerrte Gesichtspartien.

Gespiegelt
speichern

Nach dem Aufnehmen eines Selfies dieses gespiegelt speichern.

Selfie-Aufnahme

Machen Sie ein Selfie, indem Sie die Option zwischen Gesten-
Ausléser und Auto-Ausldser auswahlen.

5 « Wenn Sie mit der Front-Kamera ein Selfie machen, kénnen Sie den Makeup-Effekt

anwenden.

« Gesten-Ausloser wird aktiviert, wenn die Form einer Hand erkannt wird, und
Auto-Ausloser wird aktiviert, wenn ein Gesicht erkannt wird.
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Modus-Auswahl
Sie kénnen bequem unter den auf dem Bildschirm angezeigten Modi auswahlen, die
passend auf die jeweiligen Aufnahmebedingungen ausgelegt sind.

Um den Kameramodus auszuwahlen, auf (&) tippen und tiber die Kameramodi links
oder rechts wischen, oder links oder rechts tber den Bildschirm wischen.

<= lnmp

|
l

Kameramodi
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Kameramodi nutzen

Ein Video aufnehmen

T Auf (&) tippen und durch Wischen tiber die Kameramodi den Modus Videos
auswahlen.

2 Tippen Sie auf ¢, um ein Video aufzunehmen.

Einstellungen der Kamera —e —— Einstellungen zum Blitz
] ] festlegen/loschen
Auflésung auswahlen Filter-Effekt anwenden

Steadycam ein-/ausschalten —

e——————— Zoom auswahlen

Vorschau ——— e——— Zwischen vorderer/hinterer
I Kamera wechseln

L———————— EinVideo aufnehmen

+ Um ein Foto wahrend einer Videoaufnahme aufzunehmen, tippen Sie auf ©.

+ Um die Videoaufnahme voriibergehend anzuhalten, tippen Sie auf (11). Um
die Videoaufnahme fortzusetzen, tippen Sie auf '® .

+ Beim Aufzeichnen eines Videos konnen Sie durch Spreizen oder
Zusammenziehen von zwei Fingern hinein- bzw. herauszoomen.

+ Beim Aufzeichnen eines Videos konnen Sie einen Brereich antippen, um die
Helligkeit anzupassen.

+ Wahrend einer Videoaufzeichnung kénnen Sie zwischen vorderer und
hinterer Kamera hin- und herschalten, indem Sie auf@ driicken.

3 Tippen Sie auf (=, um die Videoaufnahme zu beenden.
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E « Sie konnen Speicherplatz sparen, indem Sie unter@ die Option Im Format HEVC
speichern auswahlen. Dann wird die Videodatei komprimiert im Format HEVC
(High Efficiency Video Coding) gespeichert.

+ Esist méglich, dass andere Gerate Videodateien im HEVC-Format nicht
unterstdtzen.

Ein Foto aufnehmen
Auf (&) tippen und Foto auswahlen, indem Sie tiber die Kameramodi wischen.
Weitere Informationen finden Sie unter Ein Foto aufnehmen.

Portrataufnahmen machen
Sie kdnnen Fotos in der Weise aufnehmen, dass das Motiv sich deutlicher abhebt
und der Hintergrund unscharf dargestellt wird.
T Auf (&) tippen und durch Wischen tiber die Kameramodi den Modus Portrét
auswahlen.
« Durch Wischen tber die Effektoptionen bei Portrat kdnnen Sie den
gewUnschten Effekt auswahlen.

- Um den Blendenwert anzupassen, auf ) tippen.

2 Tippen Sie auf (), um ein Foto aufzunehmen.

Einstellungen der Kamera — +— Timer-Einstellungen festlegen

Seitenverhaltnis wahlen Blendenwert anpassen

- Den optimalen Effekt

fiir das Portrat
auswahlen.
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Wenn die Meldung "Portrét ist verfiigbar" angezeigt wird, damit beginnen, ein
Foto oder ein Video aufzunehmen

i

Damit die Portrat-Funktion funktioniert, muss die Kamera das Motiv erkennen
kénnen.

+ Wahrend Sie ein Foto aufnehmen, sollte der Abstand zum Motiv ungefahr 40 bis
150 cm betragen.

Diese Funktion steht nicht in einer lichtarmen Umgebung zur Verfiigung.

Sticker verwenden

Bei Fotos und Videos konnen verschiedene Sticker zur Anwendung gebracht
werden.

Durch 3D AR-Effekte kénnen Sie hre Aufnahmen bereichern.

T Auf (&) tippen und durch Wischen tiber die Kameramodi den Modus Sticker
auswahlen.
+ Wahlen Sie den gewlnschten Sticker, indem Sie tiber die Sticker wischen.

2 Um ein Foto aufzunehmen, tippen Sie auf ; um ein Video aufzuzeichnen,
halten Sie, (  gedriickt.

+ Wahrend der Aufnahme eines Videos kann nicht zwischen vorderer und
hinterer Kamera gewechselt werden.
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3 Tippen Sie auf =, um die Videoaufnahme zu beenden.

« Das Foto oder Video wird in der Galerie gespeichert.

Einstellungen der Kamera —

Seitenverhaltnis wahlen —41

-

E « Um 3D AR Sticker zu verwenden, auf @ tippen.

— Timer-Einstellungen festlegen

Weitere Informationen finden Sie unter 3D AR-Effekt.
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Weitere Kameramodi nutzen

Auf (&) tippen und Mehr auswahlen, indem Sie iiber die Kameramadi wischen.

Foto bei Nacht

Sie kénnen klare und lebendige Nachtaufnahmen machen. Die Funktion Foto
bei Nacht wird automatisch aktiviert, wenn Sie ein Foto bei schwachem Licht
aufnehmen.

Sie kénnen die Funktion Foto bei Nacht auch manuell aktivieren, um klare
Nachtaufnahmen zu machen.
1 Aufo tippen und Mehr auswahlen, indem Sie Uiber die Kameramodi wischen.
2 Tippen Sieauf (.

- Wihlen Sie einen Zoom-Faktor aus €9 / 3.
3 Tippen Sie auf (), um ein Foto aufzunehmen.

+ Um die Helligkeit des Fotos anzupassen, ziehen Sie, g. nach links oder
rechts.

Einstellungen der Kamera ——e e—— Timer-Einstellungen festlegen

Seitenverhaltnis wahlen ——T

+—— Helligkeit einstellen

E « Halten Sie bei der Aufnahme die Kamera ruhig und stabil, damit das Foto nicht
verwackelt wird.
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Panorama

Sie kdnnen eine Panoramaaufnahme erstellen, indem Sie die Kamera in eine
Richtung bewegen, um Fotos in Serie aufzunehmen und diese zu einem breiten Bild
zusammenzuflgen.

1 Auf@ tippen und Mehr auswahlen, indem Sie Uiber die Kameramodi wischen.

2 Tippen Sie auf )=y
- Wahlen Sie einen Zoom-Faktor aus €9 / .

Tippen Sie auf ( und bewegen Sie die Kamera dann langsam in eine Richtung.

w

A Tippen Sie auf @), um die Panorama-Aufnahme zu beenden.

Einstellungen der Kamera —ol:l

E + Wenn Sie die Kamera in eine Richtung bewegen, achten Sie darauf, dass der
Bildschirm auf der Fiihrungslinie bleibt.
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Kamera Manuell
Mit vielen erweiterten Funktionen kénnen Sie Ihre Fotos professionell gestalten.
1 Auf@ tippen und Mehr auswahlen, indem Sie Giber die Kameramodi wischen.
2 Tippen Sie auf &).
3 Passen Sie die folgenden Kameraeinstellungen an:
- Wahlen Sie einen Zoom-Faktor aus €9 / 3.

+ Wird unter Optionen Auto eingestellt, werden je nach Aufnahmemotiv und
Umgebung die Funktionen automatisch angepasst.
- Ist Focus peaking ausgewahlt, wird der fokussierte Bereich farblich

hervorgehoben angezeigt. Diese Funktion ist nur im Kameramodus
Manueller Fokus verfligbar.

Einstellungen der Kamera ——e — Timer-Einstellungen festlegen

Seitenverhaltnis wahlen ] ]

Blitzeinstellungen festlegen

Filter-Effekt anwenden ——

Die Einstellungen ———¢ -

Anzeige der
zurlicksetzen verschiedenen
Graphy-Optionen
\WeiRabgleich —I {
eiRabgleic|
durchfihren |— Belichtungszeit
einstellen
Fokus einstellen

ISO-Empfindlich-
Helligkeit keit einstellen
einstellen

/I Tippen Sie auf (, um das Foto aufzunehmen.
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E « Wenn Sie auf@ tippen und einen Graphy-Effekt auswahlen, wird eine Liste
empfohlener Fotos mit verschiedenen Einstellungen angezeigt.

« Wenn Sie Graphy-Effekte auswahlen, kénnen Sie unter Benutzung der
empfohlenen Einstellwerte fiir Weiabgleich, Belichtungszeit und ISO das Foto
aufnehmen.

Diese Funktion ist nur im Kameramodus Manuell verftigbar:

+ Wenn Sie vom Google Play Store die Graphy Fotos-App herunterladen und
installieren, kénnen Sie verschiedene empfohlene Fotos sehen.
« Eskénnen je nach Tarif Kosten fiir die Datennutzung entstehen.

Tippen Sie auf€§§ und dann im Menii bei Graphy Fotos auf @), um diese

Funktion zu deaktivieren.

Kameraoptionen anpassen

Sie kénnen eine Vielzahl von Kameraoptionen nach Ihren Wiinschen festlegen.

Tippen Sie unter Kamera Manuell auf §G3.

FotogroRe Ermdglicht, die GréRe des Fotos und die Auflésung zu wahlen.
Das Bild wird im RAW-Dateiformat gespeichert, sodass Sie es
verandern konnen.

Als RAW ) .

speichern DNG- und JPEG-Dateien werden wahrend der Aufnahme von Fotos
erstellt und dann als nicht-komprimierte, hochauflésende Bilder
gespeichert.

Korrektur von

Verzerrungen bei
Ultraweitwinkel

Korrigiert Verzerrungen auf dem Bildschirm beim Aufnehmen von
Ultraweitwinkel-Fotos.

Passen Sie den \Weiabgleich, den ISO-Wert und die Belichtungszeit

Graphy Fotos mit einem empfohlenen Foto an.
Details finden Sie unter Kamera Manuell.
e g Bildraster zur Aufnahme von Fotos anzeigen, die sich an den
Hilfslinie ) ) e o
horizontalen und vertikalen Hilfslinien orientieren.
S.Ignat."." Anzeige einer personalisierten Signatur auf den Fotos.
hinzufiigen
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Standorte

) Bild mit GPS-Standortdaten speichern.
speichern

Wahlen Sie, ob Sie Bilder und Videos im Internen Speicher oder
Speicher auf einer Speicherkarte speichern mochten. (Verfigbar, wenn eine
Speicherkarte eingelegt ist.)

Hilfe Hilfe fir jedes Kamera-MenU anzeigen.

Zeitlupe

Sie kénnen ein SpaRk-Video kreieren, indem Sie die Geschwindigkeit von
Bewegungen andern. Diese Funktion ist auch nutzlich, wenn Sie ein Video in einer
langsameren Geschwindigkeit als jener des Original-Videos wiedergeben wollen.

1 Auf@ tippen und Mehr auswahlen, indem Sie tiber die Kameramodi wischen.

2 Tippen Sie auf @.

3 Intervall _@, oder Gesamt ﬁ@, auswahlen, um den Zeitlupeneffekt darauf
anzuwenden.

+ Bereich in Zeitlupe: Ermdglicht, Zeitlupeneffekt auf einen bestimmten

Abschnitt des Videos anzuwenden.

- Drticken Sie in dem Moment auf «©, ab dem der Zeitlupeneffekt
angewendet werden soll. Wenn Sie kurz driicken, wird der
Zeitlupeneffekt fur 0,5 Sekunden wirksam. \Wenn Sie lange dricken, wird
der Zeitlupeneffekt angewendet, bis Sie Ihren Finger loslassen.

+ Alles in Zeitlupe: Ermdglicht, Zeitlupeneffekt auf das gesamte Video
anzuwenden.
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Einstellungen ——e +— Blitzeinstellungen festlegen

Intervall auswahlen —41

/A Tippen Sie auf (e, um ein Video aufzunehmen.

+ Um die Videoaufnahme vortbergehend anzuhalten, tippen Sie auf (11). Um
die Videoaufnahme fortzusetzen, tippen Sie auf '® .

5 Um die Aufnahme zu beenden, tippen Sie auf (= .

YouTube Live
Sie konnen ein Video aufnehmen und direkt auf YouTube hochladen.

Um diese Funktion benutzen zu kénnen, miissen Sie dazu berechtigt sein.
Kontaktieren Sie YouTube, um sich Uber die Erfordernisse zu informieren.

1 Tippen Sie auf dem Homescreen auf (&).
2 Uber die Kameramodi wischen und Mehr auswahlen, dann auf ((e)) tippen.
E « YouTube Live steht nur zur Verfligung, wenn Ihr Gerat mit dem Internet verbunden

ist. Wenn Sie eine mobile Datenverbindung verwenden, kénnen je nach Tarif
Kosten fir die Datennutzung entstehen.
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Nitzliche Kamerafunktionen

Foto mit der Al-Funktion aufnehmen

\Wenn Sie ein Foto unter Benutzung der Al-Funktion aufnehmen, wird das Motiv
erkannt und es wird der optimale Effekt angewendet.

5 « Um die Al-Funktion zu deaktivieren, tippen Sie auf.

Sperre fiir Automatische Belichtung/Automatischen Fokus
Sie kénnen die aktuelle Belichtung und die Fokusposition fixieren, indem Sie
den Bildschirm im Automatisch-Modus berthren und halten. Um die Funktion
auszuschalten, tippen Sie auf eine freie Stelle auf dem Bildschirm.

Sperre fir Automatische
Belichtung/
Automatischen Fokus

E « Diese Funktion ist nur in bestimmten Modi verfiigbar.
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Zwischen Kameras wechseln

Sie kdnnen entsprechend lhrer Aufnahmebedingungen zwischen der vorderen und

der hinteren Kamera wechseln.
« Um zwischen vorderer und hinterer Kamera umzuschalten, im
Aufnahmebildschirm der Kamera-App nach oben oder unten wischen.

< @ )

E - Verwenden Sie die vordere Kamera, um Selfies aufzunehmen. Details finden Sie
unter Selfie-Aufnahme.

Ansicht vergréRern oder verkleinern

Beim Aufnehmen von Fotos oder Videos kénnen Sie durch Spreizen oder
Zusammenziehen von zwei Fingern ins Motiv hinein- oder herauszoomen.

E « Im Selfie-Modus (Front-Kamera) ist hinein- und herauszoomen nicht maglich.
« Invielen Modi wird diese Funktion nicht unterstitzt.
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Serienaufnahme verwenden

Sie kdnnen eine Folge von Fotos machen und sie dann in der Galerie als Film
wiedergeben.

1 Tippen Sie auf (&) und wahlen Sie Foto.

7 Halten Sie " gedriickt.

+ Solange Sie () gedrckt halten, wird eine Folge mehrerer Fotos
aufgenommen.

Gesten-Ausldser
Sie konnen Selfies mittels Gesten aufnehmen.
Halten Sie lhre Handflache in die vordere Kamera und ballen Sie sie dann zu einer
Faust.
Sie konnen Ihre Handflache auch zu einer Faust ballen und zur vorderen Kamera
hin 6ffnen.

+ Nach drei Sekunden wird ein Foto aufgenommen.

o

a D

\

)

Um diese Funktion zu verwenden, wechseln Sie zur vorderen Kamera und tippen
Sie auf §83 > Selfie-Aufnahme > Gesten-Ausléser

« Stellen Sie sicher, dass sich Ihre Handflache und Ihre Faust innerhalb der Hilfslinien
befinden, damit sie von der Kamera erkannt werden konnen.

Diese Funktion ist bei Verwendung mancher Kamera-Funktionen gegebenenfalls
nicht verfligbar.

i
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Auto-Ausloser

Mit der Gesichtserkennungsfunktion kénnen Sie Selfies ganz einfach und
problemlos aufnehmen. Sie kénnen die Gerateeinstellungen so festlegen, dass die
vordere Kamera Ihr Gesicht erkennt und automatisch ein Selfie aufnimmt, wenn Sie
den Bildschirm betrachten.

Der weiRe Filhrungsrahmen erscheint, wenn die vordere Kamera ein Gesicht
erkennt. Sobald das Motiv innerhalb des Fiihrungsrahmens sich nicht mehr
bewegt, andert sich die Rahmenfarbe zu Gelb und die Kamera nimmt ein Foto
auf.

- Tippen Sie auf@ > Selfie-Aufnahme > Auto-Ausléser, um die Funktion Auto-
Ausloser zu aktivieren.

Intervallaufnahme
Sie konnen Selfies im Intervall aufnehmen.

Bei Verwendung der vorderen Kamera kénnen Sie auch lhre Handflache in die
Kamera halten und sie zweimal schnell zu einer Faust ballen.

+ In regelmaRigen Intervallen werden vier Fotos aufgenommen, nachdem ein
Timer von drei Sekunden abgelaufen ist.

Gespiegelt speichern
Tippen Sie vor Aufnahme eines Fotos mit der vorderen Kamera auf 63>
Gespiegelt speichern. Das Bild wird horizontal gespiegelt.

E « Sie konnen in den Kameraoptionen andern, wie Selfies bei Verwendung der
vorderen Kamera aufgenommen werden. Details siehe unter Kameraoptionen
anpassen.

Selfie-Aufnahme

Mit der vorderen Kamera kénnen Sie Ihr Gesicht auf dem Bildschirm anzeigen und
Selfies aufnehmen.

T Auf (&) tippen und Foto auswahlen, indem Sie tiber die Kameramodi wischen.
7 Tippen Sie auf €0, um auf die Frontkamera umzuschalten.

3 Tippen Sie auf _, um ein Foto aufzunehmen.
- Um verschiedene Beauty-Effekte anzuwenden, tippen Sie auf ).
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Galerie
Galerie im Uberblick

Sie kdnnen Fotos oder Videos, die auf lhrem Gerat gespeichert sind, ansehen und
verwalten.

Fotos anzeigen
Sie konnen die im Produkt gespeicherten Fotos ansehen.
T Auf @ tippen und den gewiinschten Ordner auswahlen.

7 Auf das gewiinschte Foto tippen.
+ Der Ordner Galerie enthalt Fotos, Alben, Erinnerungen und Wiedergeben.

| — Google Lens starten.
e
Zurlck zum vorherigen —e o— Zugriff auf zusatzliche
Bildschirm. Optionen.

»— Galerie-Vorschau

—

Zu Favoriten hinzufiigen oder —e *— Bilder léschen
von Favoriten entfernen.

Bilder mit anderen teilen.
Bilder bearbeiten.

E + Wenn Sie leicht den Bildschirm beriihren, wird das Info-Men angezeigt. Nach
erneutem Berthren des Bildschirms wird das Menu wieder ausgeblendet.
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Ein Video wiedergeben
Sie kénnen die im Produkt gespeicherten Video ansehen.

Zurtick zum —s e—— Zugriff auf zusatzliche
vorherigen Optionen.
Bildschirm.

Video anhalten oder ——
abspielen.

»— Galerie-Vorschau

Zu Favoriten hinzufiigen oder —e *— Bilder [6schen.

von Favoriten entfernen. aa—

Bilder mit anderen
Bilder bearbeiten. teilen.

E « Ziehen Sie die rechte Seite des Videobildschirms nach oben oder unten, um die
Lautstérke anzupassen.
« Ziehen Sie die linke Seite des Bildschirms nach oben oder unten, um die
Bildschirmhelligkeit anzupassen.

« Zum Zuriickspulen (REW) des Videos auf dem Video-Wiedergabebildschirm den

Bildschirm nach links ziehen, fir schnellen Vorlauf nach vorne (FF) nach rechts
ziehen.
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Dateien l6schen
Loschen Sie Dateien mit einer der folgenden Optionen:

Berihren und halten Sie eine Datei aus der Dateiliste und tippen Sie dann auf
Loschen.

Geldschte Dateien werden automatisch in den ¢ > Papierkorb verschoben und
kénnen innerhalb von 7 Tagen in der Galerie wiederhergestellt werden.

Ber(ihren Sie zum vollstandigen Léschen der Dateien [x]. In diesem Fall knnen
die Dateien nicht wiederhergestellt werden.

Dateien teilen
Teilen Sie Dateien mithilfe einer der folgenden Optionen:

- Tippen Sie wahrend der Anzeige eines Fotos oder Videos auf < um die Datei
auf die gewlinschte Weise zu teilen.

5

Wenn Sie nach Tippen auf (8) > §63 > Standort speichern @ ) Fotos oder
Videos aufnehmen, wird nach einer bestimmten Zeit in der Galerie automatisch
unter der Registerkarte Erinnerungen ein ortsbezogenes Erinnerungsalbum
erstellt.

Sie kdnnen nach Fotos oder Videos suchen anhand von Suchkriterien wie Ort, Tag,
Kameramodus usw. indem Sie in der Galerie aqu tippen.

Je nach installierter Software konnen einige Dateiformate nicht unterstutzt
werden.

Aufgrund von Verschlisselung kénnen einige Dateien moglicherweise nicht
gedffnet werden.

Dateien, die die GréRenbeschrankung tbersteigen, kénnen Fehler verursachen.

Um Erinnerungen-Alben anzulegen, muss die GPS-Funktion aktiviert sein.

Eine Collage erstellen
Sie kénnen eine Collage aus zugehdrigem Inhalt erstellen.

T Tippen Sie auf ¥ und wahlen Sie : > Collage erstellen.

2 Wihlen Sie die gewtinschten Fotos aus, die zur Collage hinzugefiigt werden
sollen, und tippen Sie dann auf Collage erstellen.

+ Wahlen Sie das gewUinschte Layout am unteren Rand des Bildschirms aus.
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3 Tippen Sie auf Erstellen.

E + Eskénnen maximal 9 Bilder verwendet werden, um eine Collage zu erstellen.

Film erstellen

Durch das Zusammenfiigen von Bildern und Videos kénnen Sie einen neuen Film

erstellen.
T Tippen Sie auf ¥ und wahlen Sie : > Film erstellen.

2 Wahlen Sie Bilder oder Videos fiir Inren Film aus und tippen Sie auf Film
erstellen.

3 Bearbeiten Sie die gewahlten Bilder und Videos und tippen Sie dann auf
Speichern.

o———— Effekte auf Dateien
[ anwenden
Dateien zurticksetzen

-—

Vorschau einer Datei

Dateien l6schen ———

Dateien hinzufiigen

E « Eskonnen maximal 50 Bilder verwendet werden, um einen Film zu erstellen.
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Ein GIF erstellen
Sie kénnen aus einem aufgezeichneten Video ganz einfach eine GIF erstellen.
Auf @ tippen und Ein GIF erstellen auswahlen.

Video kreieren

1 Tippen Sie, wahrend Sie sich das Video ansehen, beim gewiinschten Punkt auf

2 Wihlen Sie die Lange des GIFs das Sie erstellen méchten.

+ Das GIF wird vom ausgewahlten Zeitpunkt ausgehend in der gewahlten
Lange erstellt.

+ Bei Videos von unter 5 Sekunden werden GIF-Bilder automatisch fir die
verbleibende Zeit erstellt.

GIF-Fotos erstellen
1 Tippen Sie in der Galerie in der Liste der Fotos auf : > GIF erstellen.

7 Wihlen Sie ein Bild, das in ein GIF-Foto konvertiert werden soll, und tippen Sie
dann auf Weiter.

« Sie kénnen Fotos loschen oder hinzuftigen, die Geschwindigkeit oder das
Bildschirm-Seitenverhaltnis anpassen,die Anordnung der Fotos andern.

E + Die Funktion zum Erstellen von GIF-Fotos eroffnet dem Benutzer die Moglichkeit,
Kreativ-Bilder zu erstellen. Falls Sie die Rechte anderer Personen verletzen, zum
Beispiel das Urheberrecht, oder andere Personen diffamieren oder verleumden
mit Hilfe von Funktionen wie die zur Erstellung von GIF-Fotos, kdnnen Sie gemaRk
gesetzlicher Vorschriften des Zivilrechts oder Strafrechts zur Verantwortung
gezogen werden. Seien Sie vorsichtig und kopieren oder tbertragen Sie keine
Werke von anderen, ohne vorher die Erlaubnis eingeholt zu haben. LG Electronics
ist auf keinen Fall verantwortlich fiir derlei Handlungen von Benutzern.

+ Zur Erstellung eines GIF kdnnen bis zu 100 Fotos ausgewahlt werden.
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Kontakte

Kontakte im Uberblick
Sie kénnen Kontakte speichern und verwalten.
Tippen Sie auf dem Homescreen auf Zubehor > Kontakte.

Kontakte hinzufiigen

Neue Kontakte hinzufiigen

1 Tippen Sie in der Kontaktliste auf -

« Ein Popup-Fenster wird eingeblendet, in dem Sie den Speicherort des
Kontaktes auswahlen konnen. Wahlen Sie den gewiinschten Ort.

7 Geben Sie die Kontaktdaten ein und tippen Sie auf Speichern.

Kontakte importieren
Sie kénnen Kontakte von einem anderen Speichergerdt importieren.

1 Tippen Sie in der Kontaktliste auf * > Kontakte verwalten > Importieren.

7 Wahlen Sie Quell- und Zielverzeichnis des Kontakts aus, den Sie importieren
mochten, und tippen Sie dann auf Ok.

3 Wahlen Sie die Kontakte aus und tippen Sie auf Importieren.

Kontakte zur Kurzwahlliste hinzufiigen

1 Tippen Sie in der Kontaktliste auf * > Kurzwahl.

2 Tippen Sie Kontakt hinzufiigen einer Kurzwahlnummer.
3 Wahlen Sie einen Kontakt aus.

E « Tippen Sie beim Hinzufligen eines neuen Kontakts auf 313}, um eine
Kurzwahlnummer hinzuzufiigen.
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Kontakte suchen
Suchen Sie nach Kontakten mit einer der folgenden Optionen:

+ Tippen Sie oben auf dem Kontakte-Bildschirm auf die Suchleiste und geben Sie
den Namen oder die Telefonnummer des gesuchten Kontakts an.

« Scrollen Sie in der Kontaktliste nach oben oder unten.

- Tippen Sie auf den Anfangsbuchstaben eines Kontakts im Verzeichnis der
Kontaktliste.

E + Wenn Sie oben auf dem Kontakte-Bildschirm auf die Suchleiste tippen und den
Namen oder die Telefonnummer des gesuchten Kontakts angeben, werden die
kombinierten Suchergebnisse aus dem im Gerat gespeicherten Anrufverlauf und
der Kontaktliste angezeigt.

Kontaktliste

Kontakte bearbeiten
1 Wahlen Sie einen Kontakt aus der Kontaktliste aus.
2 Tippen Sie in den Kontaktinformationen auf /% und bearbeiten Sie die Detalils.

3 Tippen Sie auf Speichern, um die Anderungen zu speichern.

Kontakte l6schen
Sie kénnen Kontakte l6schen, indem Sie eine der folgenden Optionen nutzen:

+ Auf dem Bildschirm mit der Kontaktliste den zu [6schenden Kontakt beriihren
und halten und dann auf [i1] tippen.

- Tippen Sie in der Kontaktliste auf * > Léschen.

E + Geloschte Kontakte kénnen nicht wiederhergestellt werden.
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Favoriten hinzufiigen
Sie kénnen haufig genutzte Kontakte als Favoriten anlegen.
1 Wahlen Sie einen Kontakt aus der Kontaktliste aus.

2 Tippen Sie in den Kontaktinformationen auf 1.

Gruppen erstellen
1 Tippen Sie in der Kontaktgruppenliste auf -
2 Geben Sie einen neuen Gruppennamen ein.

3 Tippen Sie auf Mitglieder hinzufiigen, wahlen Sie Kontakte aus und tippen Sie
dann auf Hinzufiigen.

/. Tippen Sie auf Speichern, um die neue Gruppe zu speichern.

QuickMemo+
QuickMemo+ im Uberblick

Mit den verschiedenen Optionen dieser erweiterten Editorfunktion kénnen Sie
kreative Notizen erstellen. Zu diesen Optionen gehdren Bildverwaltung und
Screenshots, die vom herkémmlichen Editor nicht unterstitzt werden.

Dieses Gerat unterstlitzt Active Pen AES2.0 (Active Electrostatic).

Notiz erstellen
1 Tippen Sie auf dem Homescreen auf Zubehér > QuickMemo+.
2 Tippen Sie auf Q um eine Notiz zu erstellen.

- @ :Notiz speichern.

+ < :Letzte Bearbeitung riickgangig machen.

+ (7 :Zuletzt geloschte Bearbeitungen erneut ausfiihren.

T :Notiz mithilfe der Tastatur eingeben.
- 9k :Bevorzugte Stifttypen speichern.
-/ :Handschriftliche Notizen erstellen.
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- & :Handschriftliche Notizen radieren.
+ g :BeiHandschrift in eine Kalligrafie-Schrift umwandeln.
* 1 Zugriff auf zusatzliche Optionen.

3 Tippen Sie auf ° um die Notiz zu speichern.

Notizen auf einem Screenshot erstellen
1 Ziehen Sie auf dem Bildschirm, von dem Sie einen Screenshot erstellen
mochten, die Statusleiste nach unten und tippen Sie dann auf @).
« Der Bildschirminhalt wird erfasst und wird auf dem Bildschirm unten rechts
als Miniaturbild angezeigt.
7 Um auf dem Bildschirm Notizen zu schreiben, auf :&: tippen.
3 Sie kdnnen Notizen schreiben und dazu die \Werkzeuge benutzen.
- 13 :Hinein- oder herauszoomen oder den zu erfassenden Bereich anpassen.
/ :Handschriftliche Notizen erstellen.
+ & :Handschriftliche Notizen radieren.
« €:Letzte Bearbeitung riickgangig machen.
« (7 :Zuletzt geldschte Bearbeitungen erneut ausfthren.
+ (35 Den Bildschirminhalt wunschgema® beschneiden.
/. Um die Notiz zu speichern, auf \/ tippen.
« Gespeicherte Notizen kénnen in der Galerie eingesehen werden.
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Zusatzliche Funktionen nach Erstellen eines Screenshots

— Tippen, um den gesamten
Bildschirminhalt zu erfassen,
indem Sie die Funktion fiir die
Scroll-Aufnahme verwenden

o————— Tippen, um den Bildschirminhalt

aufzunehmen.
Tippen, um auf dem erfassten Tippen, um den erfassten
Bildschirm Notizen zu machen. Screenshot zu l6schen.

5

1

Tippen, um den erfassten ———————
Screenshot mit anderen zu teilen.

Sie kdnnen den gesamten Bildschirm aufnehmen, indem Sie die Funktion fiir die
Scroll-Aufnahme verwenden.

Wahrend Sie eine App benutzen, wie zum Beispiel Messaging oder Chrome, ziehen
Sie das Benachrichtigungs-Panel nach unten und tippen dann aufO, Tippen Sie
dann auf :do: um den derzeit angezeigten gesamten Bildschirminhalt zu erfassen
und als eine einzige Datei zu speichern.

Diese Funktion ist nur bei manchen Apps verfiigbar, die die Funktion fiir die Scroll-
Aufnahme unterstitzen.

Um das Memo-Layout zu andern, ziehen Sie zwei Finger am Bildschirm zusammen
oder auseinander.

Ntzliche Apps 110



Uhr

Wecker

Sie kénnen einen Wecker einstellen, der zu einer bestimmten Uhrzeit ausgeldst
wird.

1 Tippen Sie auf dem Homescreen auf Zubehér > Uhr > Wecker.
2 Tippen Sie auf - um einen neuen Wecker hinzuzufiigen.

3 Konfigurieren Sie die Wecker-Einstellungen und tippen Sie auf Speichern.

« Wenn Sie einen zuvor eingestellten Wecker auswahlen, kénnen Sie ihn bearbeiten.

« Tippen Sie zum Loschen eines \Weckers oben auf dem Bildschirm auf E >
Loschen. Sie kénnen den Wecker auch beriihren und halten.

Weltzeit

Sie kénnen die aktuelle Zeit in Stadten auf der ganzen \Welt anzeigen.
1 Tippen Sie auf dem Homescreen auf Zubehér > Uhr > Weltzeit
2 Tippen Sie auf - und fiigen Sie eine Stadt hinzu.
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Timer

Sie kdnnen einen Timer einstellen, der nach einer bestimmten Zeit einen Alarm
auslost.

1 Tippen Sie auf dem Homescreen auf Zubehér > Uhr > Timer.

2 Stellen Sie die Zeit ein und tippen Sie auf Starten.

+ Um den Timer vortibergehend anzuhalten, tippen Sie auf Pause. Um den
Timer fortzusetzen, tippen Sie auf Fortsetzen.

3 Tippen Sie auf Anhalten, um den Timeralarm zu beenden.

Stoppuhr
Mit der Stoppuhr kdnnen Sie eine Rundenzeit aufzeichnen.
1 Tippen Sie auf dem Homescreen auf Zubehér > Uhr > Stoppuhr.
2 Tippen Sie auf Starten, um die Stoppuhr zu starten.
+ Um eine Rundenzeit aufzuzeichnen, tippen Sie auf Runde.
3 Tippen Sie auf Pause, um die Stoppuhr anzuhalten.
+ Um die Stoppuhr fortzusetzen, tippen Sie auf Fortsetzen.

« Tippen Sie zum Ldéschen aller Aufzeichnungen und Neustarten der Stoppuhr
auf Zuriicksetzen.
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Musik

Sie konnen Musiktitel und Alben wiedergeben und verwalten.

1 Tippen Sie auf dem Homescreen auf Zubehér > Musik.

2 Wihlen Sie eine Kategorie aus.
3 Wahlen Sie eine Musikdatei aus.

Flash Light
einschalten/ausschalten.
Soundeffekte festlegen.
Zuriick zum vorherigen — —— Zugriff auf zusatzliche
Bildschirm. Optionen

— Anhalten oder wiedergeben.

Tippen, um die aktuelle Datei — — Tippen, um die nachste Datei
von Beginn an wiederzugeben/ wiederzugeben/Berihren und
Doppeltippen, um die vorherige halten, um vorzuspulen.

Datei wiederzugeben/Beriihrt
halten, um zuriickzuspulen.

In zufalliger Reihenfolge ——T L— Wiederholungsmodus
wiedergeben. auswahlen.
Lautstarke einstellen. — R — Zur jetzt abgespieleten
Zu Favoriten hinzufiigen oder ———— 1 Playliste gehen.

5

aus Favoriten l6schen.

Je nach installierter Software kdnnen einige Dateiformate nicht unterstutzt
werden.

Dateien, die die GréRenbeschrankung tibersteigen, konnen Fehler verursachen.

Musikdateien sind méglicherweise durch internationale Urheberrechte der
Eigentlmer oder Urheberrechtsgesetze geschiitzt. Moglicherweise ist eine
gesetzliche Erlaubnis vor dem Kopieren einer Musikdatei erforderlich. Priifen Sie
zuerst die Gesetzgebung zum Urheberrecht des betreffenden Landes, bevor Sie
eine Musikdatei herunterladen oder kopieren.

Dieses Modell untersttitzt die Wiedergabe von Hi-Fi-Audiodateien. Hi-Fi-
Audiodateien sind mit dem Hi-Fi-Symbol gekennzeichnet.

Wenn Sie das Flash Light einstellen, blinkt der Blitz im Rhythmus der gespielten
Musik.
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Rechner
Sie konnen zwischen zwei Arten von Rechnern wahlen: dem einfachen Rechner und
dem wissenschaftlichen Rechner.
1 Tippen Sie auf dem Homescreen auf Zubehér > Rechner.
7 Uber das Tastenfeld kannen Sie eine Berechnung vornehmen.
- U die Berechnung erneut durchzufiihren, {X] gedriickt halten.

ThinQ

Sie konnen das Produkt leicht mit IoT-Anwendungen (IoT - Internet of Things)
verbinden, um diese auf bequeme Art zu nutzen und zu tiberwachen.

Tippen Sie auf dem Homescreen auf Zubehdr > ThinQ

E Um Waschmaschine, Trockner; Styler, Geschirrsptilmaschine, Backofen oder
Staubsauger-Roboter zu registrieren, muss sich das Produkt im Standby-Modus

befinden.

Achten Sie auf das ThinQ-Kennzeichen auf dem Produkt, um zu sehen, ob es mit

der ThinQ-App verbunden werden kann.

Um die verschiedenen Funktion der ThinQ-App zu sehen, tippen Sie auf =—.
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LG Health

Sie konnen lhren Gesundheitszustand Uberwachen und sich gute
Trainingsgewohnheiten aneignen, indem Sie lhre kérperlichen Aktivitaten erfassen.

Erste Schritte mit LG Health

Sie konnen LG Health konfigurieren, wenn Sie die App erstmals starten oder
nachdem Sie sie zurtickgesetzt haben.

1 Tippen Sie auf dem Homescreen auf Zubehér > LG Health.

7 Befolgen Sie die Anweisungen auf dem Bildschirm, um die Konfiguration
durchzufthren.

LG Health verwenden

Sie kénnen wichtige Informationen in LG Health abrufen und den Umfang der
kérperlichen Aktivitaten und die Gesundheitsinformationen verwalten.

1 Tippen Sie auf dem Homescreen auf Zubehér > LG Health.

2 Folgende Optionen sind verfgbar
-+ = :Trainingsprotokoll fiir den gewlinschten Tag anzeigen.

- Q :Kérperliche Aktivitat erfassen. Die Route und der Umfang Ihrer
korperlichen Aktivitaten fiir jede Art von absolviertem Training werden
aufgezeichnet.

: :Tagliche Trainingsziele einschlielich Kalorien und Schritte oder
verschiedene Einstellungen furr LG Health festlegen.

E + Uber LG Health bereitgestellte Gesundheitsinformationen dienen dem
Benutzerkomfort und kdnnen nicht zur Verhtitung, Behandlung und Diagnose von
Krankheiten oder sonstigen medizinischen Problemen genutzt werden.

+ LG Health kann je nach Land und Netzanbieter variieren oder ist méglicherweise
nicht verfigbar. Die verfiigbaren LG Health-Funktionen und die Apps, die LG
Health hinzugefiigt werden kénnen, kénnen je nach Land variieren. Dies liegt an
unterschiedlichen Gesetzen und Vorschriften.
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HD Audiorekorder

Der HD Audiorekorder erméglicht es Ihnen, die Audio-Einstellungen manuell
einzustellen, damit Sie Audioinhalte gemaR Ihrer Umgebung aufnehmen kénnen.

Aufnahmemodi

Sie konnen eine High-Definition-Audiodatei aufnehmen, indem Sie den
gewtnschten Audio-Modus so wahlen und konfigurieren, dass er der
Aufnahmeumgebung angepasst ist.

Tippen Sie auf dem Homescreen auf Zubehdr > HD Audiorekorder > =.

Normal
Sie kénnen Audiodateien ohne zusatzliche Einstellungen aufnehmen.

ASMR
Sie kénnen Ton mit ASMR (Autonomous Sensory Meridian Response) aufnehmen.

Konzert
Sie konnen Audiodateien bei einem Konzert oder Musikevent aufnehmen.

Benutzerdefiniert

Sie konnen die gewiinschten Einstellungen manuell konfigurieren, um Audiodateien
aufzunehmen.

Studio-Modus

Im Studio-Modus konnen Sie eine Audiodatei oder Musik wiedergeben und
gleichzeitig Ihre Stimme aufnehmen. Sie konnen Ihre Stimme auch mehrmals
aufnehmen und daraus einen Chor erstellen oder Kommentare aufnehmen und sie
(ber die Original-Audiodatei des Referenten oder Sprechers legen.

1 Tippen Sie auf dem Homescreen auf Zubehér > HD Audiorekorder > = >
Benutzerdefiniert.

2 Tippen Sie auf J

3 Wahlen Sie die Audiodatei aus, die als Hintergrundmusik verwendet werden
soll

/ Tippen Sie auf @), um lhre Stimme aufzunehmen.
5 Tippen Sie auf @), um die aufgezeichnete Datei zu speichern.
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Hintergrundmusik kann nur tiber Kopfhdrer abgespielt werden. Stellen Sie vor
Verwendung dieser Funktion sicher, dass Kopfhorer eingesteckt sind.

i

+ Tippen Sie zum Andern der zusitzlichen Einstellungen auf E > Einstellungen und
passen Sie Dateityp, Bit-Tiefe, Abtastfrequenz und andere Einstellungen an.

+ Wenn Sie bei angeschlossenen Ohrhérern den Modus Konzert oder
Benutzerdefiniert wahlen, wird @¢ angezeigt. Tippen Sie auf \[I]° und wahlen Sie
das zu verwendende Mikrofon.

Sie kénnen bei der Aufzeichnung von Audio die Tonqualitdt mit den
angeschlossenen Ohrhorern berwachen. Bei der Aufzeichnung im Studio-
Modus wird die Sound-Uberwachung nicht unterstiitzt. Sie kdnnen nur die
Hintergrundmusik horen.

Spiele Launcher

Sie kénnen festlegen, ob Sie den Spiele Launcher benutzen wollen. Mit diesem
werden lhnen die auf dem Produkt installierten Spiele angezeigt, und Sie kénnen
Spiele-Einstellungen auswahlen, zum Beispiel den Ton von Medien stummschalten,
Wecker einschranken usw.

1 Tippen Sie auf dem Homescreen auf Spiele-Launcher.

2 Wahlen Sie die gewtinschte Funktion.

Smart Doctor

Sie kénnen die Funktion ,Smart Doctor” verwenden, um eine Diagnose Uber den
Zustand des Gerats zu erstellen und das Gerat zu optimieren.

Tippen Sie auf dem Homescreen auf Management > Smart Doctor.
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LG Mobile Switch

Ubertragen Sie einfach Daten von einem verwendeten Gerat auf ein neues Gerat:

mit LG Mobile Switch.

1 Tippen Sie auf dem Homescreen auf Management > LG Mobile Switch.
Oder Sie tippen auf Einstellungen > System > Sicherung > LG Mobile Switch.
« Falls diese App auf hrem Produkt nicht installiert ist, laden Sie die App LG

Mobile Switch vom Google Play Store herunter und installieren Sie sie.

2 Befolgen Sie die Anweisungen am Bildschirm, um die gewtinschte

Ubertragungsmethode auszuwahlen.

E « Daten in einem Google-Konto werden nicht gesichert. Wenn Sie Ihr Google-
Konto synchronisieren, werden lhre Google-Apps, Ihre Google-Kontakte, Ihr
Google-Kalender; Ihre Google Notizen App-Daten und Ihre aus dem Play Store
heruntergeladenen Apps automatisch in der Google Drive App gespeichert

« Laden Sie den Akku vollstandig auf, bevor Sie Daten tibertragen, damit sich das
Gerat wahrend des Vorgangs nicht versehentlich ausschaltet.

App Papierkorb

Sie kénnen die Liste der geléschten Apps auf dem Homescreen einsehen. Apps, die
in den letzten 24 Stunden geléscht worden sind, konnen wiederhergestellt werden.

Tippen Sie auf dem Homescreen auf Management > App Papierkorb.
Weite Informationen finden Sie unter App Papierkorb.
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SmartWorld

Sie konnen eine Vielzahl von Spielen, Audioinhalten, Apps und Schriftarten von
LG Electronics herunterladen. Passen Sie Ihr Gerat nach Ihren Wiinschen an und
verwenden Sie Hintergrundbilder und Schriftarten.

E + Wenn Sie eine mobile Datenverbindung verwenden, kénnen je nach Tarif Kosten
fur die Datennutzung entstehen.

+ Diese Funktion wird je nach Geratehersteller oder Netzanbieter moglicherweise
nicht unterstiitzt.

1 Tippen Sie auf dem Homescreen auf Zubehér > SmartWorld.
2 Tippen Sie auf ¢ > LG Konto, und melden Sie sich an.

3 Wahlen Sie die gewiinschten Inhaltselemente aus und laden Sie sie herunter.

SmartWorld-App herunterladen

\Wenn die SmartWorld-App nicht installiert ist, befolgen Sie diese Schritte zum
Herunterladen.

1 Tippen Sie auf dem Homescreen auf Einstellungen > System > Update-
Center > App Updates.

7 Wahlen Sie SmartWorld aus der Liste aus, und tippen Sie auf Herunterladen.
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RemoteCall Service

Fur Ihr Gerat kann eine Fernwartung zur Fehlerbehebung durchgefiihrt werden.
Rufen Sie zunachst ein LG Servicezentrum an:

E +Um diese Funktion zu verwenden, mssen Sie zuerst den Nutzungsbestimmungen
der Funktion zustimmen.

« Wenn Sie eine mobile Datenverbindung verwenden, kénnen je nach Tarif Kosten
fir die Datennutzung entstehen.

1 Tippen Sie auf dem Homescreen auf Dienste > RemoteCall Service.
7 Rufen Sie ein LG Servicezentrum an.

3 Befolgen Sie die Anweisungen des Kundendienstmitarbeiters und geben Sie
eine sechsstellige Zugangsnummer ein.
+ |hr Gerét ist per Fernzugriff verbunden und die Fernwartung beginnt.

Cell Broadcast

Sie kénnen Nachrichten Uber Notsituationen, wie Taifune, Uberschvvemmungen und
Erdbeben, in Echtzeit anzeigen.

Tippen Sie auf dem Homescreen auf Dienste > CB-Nachrichten.
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Google-Apps

Sie konnen Google-Apps verwenden, wenn Sie Uber ein Google-Konto verfiigen.
Das Fenster zur Registrierung lhres Google-Kontos wird automatisch angezeigt,
wenn Sie eine Google-App zum ersten Mal verwenden. \Wenn Sie nicht ber

ein Google-Konto verfiigen, richten Sie ein Google-Konto auf lhrem Gerat ein.
Informationen zur Nutzung einer App finden Sie in der Hilfefunktion der App.

E « Einige Apps sind je nach Gebiet oder Netzanbieter moglicherweise nicht verfiigbar,

Kalender

Mit der Kalender-App konnen Sie Ihren Tagesablauf nachverfolgen (soweit Sie
diesen erfasst haben). Sie kdnnen sich die Termine anzeigen lassen sortiert nach
Tag, 3 Tagen, Woche oder Monat.

Chrome
Ein schneller und sicherer Webbrowser, konzipiert fiir das moderne Internet.

Docs

Docs erméglicht Ihnen eine kollaborative Textverarbeitung, mit der Sie produktiv
arbeiten konnen. Benutzen Sie Docs zum Entwerfen, zum Bearbeiten und zum
Zusammenarbeiten mit anderen in Echtzeit.

Google Drive

Google Drive ist eine App zum Speichern und Teilen von Dateien. Damit kdnnen Sie
jederzeit und von Uberall aus Projekte finden, teilen und gemeinsam daran arbeiten.

Duo

Auf einfache Weise Videotelefonate mit hoher Qualitat mit Ihren Freunden und
Ihrer Familie tiber Android-Telefone und iPhones fuihren.

Gmail

Gmailist eine benutzerfreundliche E-Mail-App. Damit sind Ihre Nachrichten sicher;
Ihr Posteingang ist intelligenter organisiert und Sie selber haben immer alles parat.
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Google

Mit der Google-App bleiben Sie in Bezug auf die Dinge, die hnen wichtig sind, auf
dem Laufenden. Sie finden schnell Antworten, konnen Ihre Interessen erkunden und
erhalten Geschichten und Updates zu Themen, die Sie interessieren.

Maps

Sie wollen irgendwohin? Mit Maps haben Sie die Landkarte, auf die Sie sich
verlassen konnen, bei Echtzeit-GPS-Navigation, Verkehr, Durchreisen und fiir
Informationen tber Millionen von Orten, wie z.B. Berichte oder StoRRzeiten.

Fotos

Der Ort fir alle Ihre Fotos und Videos, automatisch geordnet, sodass Sie das teilen
und speichern kénnen, worauf es ankommt.

Play Filme & Serien

Mit Ihrem Google-Konto Filme ausleihen oder kaufen. Inhalte kaufen und tberall
abspielen.

YT Music

Ein neuer Musik-Streamingdienst von YouTube.

Tabellen

Google Tabellen bietet kollaborative Tabellenkalkulation, mit der Sie produktiv
arbeiten kénnen. Mit Tabellen kénnen Sie Informationen importieren, organisieren
und mit anderen analysieren, und das in Echtzeit.

Prasentationen

Google Prasentation bietet ein kollaboratives Prasentations- und
Erstellungswerkzeug, mit dem Sie produktiv arbeiten kénnen. Mit Google
Prasentation kénnen Sie Informationen organisieren, Ergebnisse prasentieren sowie
zusammen Entscheidungen treffen, und das in Echtzeit.

YouTube

Sie kénnen lhre Lieblingskanale sehen, Ihre Lieblingsmusik héren und Videos
hochladen, um sie mit anderen Menschen in der ganzen Welt zu teilen.
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Assistant

Inlhrem Gerdt ist der Google Assistant bereits integriert. Damit finden Sie
Antworten und kénnen Dinge erledigen, auch wahrend Sie unterwegs sind. Um zu
beginnen, einfach an der Seite des Telefons auf die Taste fiir den Google Assistant
drlicken oder die Home-Taste |hres Telefons gedriickt halten.

E « Der Google Assistant ist nicht in allen Sprachen und Landern verfiigbar.

Files

Sie kénnen auf dem Gerat gespeicherte Dateien anzeigen und verwalten.
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Einstellungen

Sie konnen die Gerateeinstellungen nach hren Wnschen anpassen.
Tippen Sie auf dem Homescreen auf Einstellungen.

5 + Wenn Sie oben auf dem Bildschirm im Suchfenster einen Suchbegriff eingeben,
kénnen Sie bequem zu den Elementen kommen, die eingestellt werden muissen.

Netzwerk & Internet

Wi-Fi
Uber ein Wi-Fi-Netzwerk (WLAN) kénnen Sie eine Verbindung zu Geraten in der
Nahe herstellen.

Verbindung mit einem Wi-Fi-Netzwerk herstellen
1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet > Wi-Fi.
2 Tippen Sie auf (), um die Funktion zu aktivieren.
« Verfligbare Wi-Fi-Netzwerke werden automatisch angezeigt.
3 Wihlen Sie ein Netzwerk aus.
« Sie missen moglicherweise das Passwort flr das Wi-Fi-Netzwerk eingeben.

« Bei zuvor genutzten Wi-Fi-Netzwerken Uberspringt das Gerat diesen
Vorgang. Wenn Sie nicht méchten, dass Ihr Gerat automatisch mit einem
bestimmten Wi-Fi-Netzwerk verbunden wird, bertihren Sie das Netzwerk
und tippen Sie dann auf Netzwerk entfernen.
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Einstellungen fiir das Wi-Fi-Netzwerk
Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet > Wi-Fi.
+ Zu mobilen Daten wechseln: \Wenn die Funktion fir die mobile
Datenverbindung aktiviert ist, sich das Gerat jedoch nicht tber Wi-Fi mit dem

Internet verbinden kann, wird fur die Verbindung des Gerats mit dem Internet
automatisch die mobile Datenverbindung verwendet.

E « Diese Funktion hangt vom Netzanbieter ab.

+ :Wi-Fi-Netzwerkeinstellungen anpassen.

Wi-Fi Direct
Sie konnen Ihr Gerat mit anderen Geraten verbinden, die Wi-Fi Direct unterstutzen,
um Daten direkt mit diesen Geraten zu teilen. Ein Zugangspunkt ist nicht

erforderlich. Mithilfe von Wi-Fi Direct konnen Sie Ihr Gerat mit mehr als zwei
Geraten verbinden.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet > Wi-Fi >
+ > Erweitertes Wi-Fi> Wi-Fi Direct.
+ Gerate in der Nahe, die Wi-Fi Direct unterstiitzen, werden automatisch
angezeigt.
7 Wahlen Sie ein Gerat aus.

« Eine Verbindung wird hergestellt, wenn das Gerat die Verbindungsanfrage
akzeptiert.

E « Der Akku kann sich maglicherweise schneller entladen, wenn Sie Wi-Fi Direct
verwenden
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Mobile Daten

Sie kdnnen Mobile Daten aktivieren und deaktivieren. AuRerdem kénnen Sie die
mobile Datennutzung verwalten.

Mobile Daten einschalten

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet > Mobile
Daten.

2 Tippen Sie auf , um die Funktion zu aktivieren.

Einstellungen fiir mobile Daten anpassen

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet > Mobile
Daten.

7 Passen Sie die folgenden Einstellungen an:
« Ein:Festlegen, dass mobile Datenverbindungen verwendet werden sollen.

+ Grenze fiir Mobilen Datenverbrauch: Legen Sie eine Obergrenze fiir die
mobile Datennutzung fest, damit mobile Daten blockiert werden, sobald
diese Grenze erreicht ist.

¢ :Einstellungen fir mobile Daten anpassen.

+ Das Datennutzungsvolumen wird auf Basis des Produkts gemessen; das von
Ihrem Dienstanbieter berechnete Volumen kann sich davon unterscheiden.

Anruf

Sie kénnen Anrufeinstellungen zum Beispiel fur Sprachanrufe sowie internationale
Anrufe anpassen.

5 - Einige Funktionen werden je nach Geratehersteller oder Netzanbieter
maglicherweise nicht unterstutzt.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet > Anruf.

7 Passen Sie die Einstellungen an.
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Tethering
USB-Tethering

Sie konnen das Gerat tiber USB mit einem anderen Gerat verbinden und mobile
Daten teilen.

1 Verbinden Sie lhr Gerat iiber ein USB-Kabel mit anderen Geraten.

2 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet >
Tethering > USB-Tethering und dann auf (7)), um die Funktion zu aktivieren.

E + Beidieser Option wird eine mobile Datenverbindung verwendet. Daher kdnnen
je nach Tarif Kosten fiir die Datennutzung entstehen. \Wenden Sie sich an lhren
Netzanbieter, wenn Sie weitere Informationen wiinschen.

Wenn Sie eine Verbindung zu einem Computer herstellen, laden Sie auf
www.lg.com den USB-Treiber auf den Computer herunter und installieren Sie ihn.

« Sie konnen keine Dateien zwischen Ihrem Gerat und einem Computer senden oder
empfangen, wenn USB-Tethering aktiviert ist. USB-Tethering zum Senden oder
Empfangen von Dateien ausschalten.

+ Zuden Betriebssystemen, die Tethering unterstiitzen, gehéren Windows XP oder
hoher und Linux.

Mobiler Wi-Fi Hotspot

Sie kénnen festlegen, dass Ihr Gerat als Wi-Fi-Router fungiert, sodass sich andere
Gerate Uber dieses mit dem Internet verbinden kénnen, indem sie die mobile
Datenverbindung lhres Gerats nutzen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet >
Tethering > Mobiler Wi-Fi Hotspot und tippen Sie dann auf () ), um die
Funktion zu aktivieren.

2 Tippen Sie auf Einrichten des mobilen Wi-Fi Hotspots und geben Sie den
Wi-Fi Namen (SSID) und das Passwort ein.

3 Aktivieren Sie Wi-Fi auf dem anderen Gerat und wahlen Sie in der Liste der
Wi-Fi-Netzwerke den Namen des Geratenetzwerks aus.

/. Geben Sie das Netzwerkpasswort ein.
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E + Beidieser Option wird eine mobile Datenverbindung verwendet. Daher kdnnen
je nach Tarif Kosten fiir die Datennutzung entstehen. \Wenden Sie sich an lhren
Netzanbieter, wenn Sie weitere Informationen wiinschen.

« Weitere Informationen finden Sie auf dieser Website:
http//www.android.com/tetherswifi

Deaktivierungs-Timer fiir den Wi-Fi Hotspot

\Wenn der Wi-Fi Hotspot fir einen bestimmten Zeitraum nicht verwendet wurde,
wird die Verbindung automatisch getrennt. Sie konnen den Zeitpunkt fur die
automatische Trennung der Verbindung einstellen.

Bluetooth-Tethering
Ein Uber Bluetooth verbundenes Gerat kann sich unter Verwendung der mobilen
Datenverbindung lhres Gerats mit dem Internet verbinden.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet >
Tethering > Bluetooth Tethering und dann auf () ), um die Funktion zu
aktivieren.

7 Aktivieren Sie Bluetooth auf beiden Geraten. Fiihren Sie anschlieRend die
Kopplung der Gerate durch.

E + Beidieser Option wird eine mobile Datenverbindung verwendet. Daher kdnnen
je nach Tarif Kosten fiir die Datennutzung entstehen. \Wenden Sie sich an lhren
Netzanbieter, wenn Sie weitere Informationen wiinschen.

« Weitere Informationen finden Sie auf dieser Website:
http//www.android.com/tether#Bluetooth_tethering

Hilfe
Sie kénnen Hilfe zu Tethering und Hotspots anzeigen.

Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet > Tethering
> Hilfe.
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Flugmodus

Sie konnen die Funktionen fiir Telefonanrufe und mobile Daten ausschalten.
Wenn dieser Modus aktiviert ist, stehen Funktionen, die keine Datenlbertragung
erfordern, wie beispielsweise Spiele und Musik, weiterhin zur Verfigung.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet >
Flugmodus.

2 Tippen Sie im Bestatigungsbildschirm auf Aktivieren.

Mobilfunknetze

Sie kénnen die Mobilfunknetz-Einstellungen anpassen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet >
Mobilfunknetze.

7 Passen Sie die folgenden Einstellungen an:

- Daten-Roaming:Internet, E-Mails, Multimedia-Nachrichten und andere
Datendienste auch im Ausland verwenden.

+ Netzwerkmodus: Netztyp auswahlen.

+ Zugangspunkte: Zugangspunkt zur Verwendung von mobilen
Datendiensten anzeigen oder andern. Um den Zugangspunkt zu wechseln,
aus der Zugangspunkte-Liste den gewtinschten Zugangspunkt auswahlen.

+ Netzbetreiber: Nach Netzbetreibern suchen und automatisch eine
Verbindung mit einem Netz herstellen.
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VPN

Sie kdnnen sich auch mit einem sicheren virtuellen Netzwerk wie einem Intranet
verbinden. Auch verbundene VPN-Netzwerke (virtuelle private Netzwerke) konnen
verwaltet werden.

VPN hinzufiigen

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet > VPN.

2 Auf—tippen.

E « Diese Funktion ist nur verfiigbar, wenn die Bildschirmsperre aktiviert ist. Beim
Deaktivieren der Bildschirmsperre wird ein Benachrichtigungsfenster angezeigt.
Tippen Sie im Benachrichtigungsfenster auf Andern, um die Bildschirmsperre zu
aktivieren. Details finden Sie unter Bildschirmsperre festlegen.

3 Geben Sie VPN-Details ein und tippen Sie auf Speichern.

VPN-Einstellungen konfigurieren
1 Tippen Sie in der VPNS-Liste auf ein VPN.

72 Geben Sie die Anmeldeinformationen fiir das VPN-Benutzerkonto ein und
tippen Sie auf Verbinden.

« Aktivieren Sie das Kontrollkastchen Kontoinformationen speichern, um die
Anmeldeinformationen zu speichern.

Private DNS

Sie konnen Optionen fur Private DNS (Domain Name System) konfigurieren.

1 Tippen Sie auf dem Einstellungsbildschirm auf Netzwerk & Internet > Private
DNS.

7 Wahlen Sie die gewtinschte Funktion aus und tippen Sie auf Speichern.
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Verbundene Gerate

Bluetooth

Sie konnen |hr Gerat mit Geraten in der Nahe verbinden, die Bluetooth
unterstitzen, um Daten mit ihnen auszutauschen. Verbinden Sie lhr Gerat mit
einem Bluetooth-Headset und einer Tastatur. So kann das Gerat leichter gesteuert
werden.

Mit einem anderen Gerat koppeln

1 Tippen Sie auf dem Einstellungsbildschirm auf Verbundene Geréte >
Bluetooth.

2 Tippen Sie auf () ), um die Funktion zu aktivieren.
« Verfligbare Gerate werden automatisch angezeigt.
- Um die Gerételiste zu aktualisieren, tippen Sie auf ().

E « Inder Liste werden nur als sichtbar eingestellte Gerdte angezeigt

3 Wihlen Sie ein Gerat aus der Liste aus.

4 Befolgen Sie die Anweisungen auf dem Bildschirm, um die Authentifizierung
durchzufthren.

E « Dieser Schritt wird fir Gerate Ubersprungen, auf die Sie bereits zugegriffen hatten.

Daten (iber Bluetooth senden

1 Wahlen Sie eine Datei aus.
+ Sie konnen Multimediadateien und Kontakte senden.

2 Tippen Sie auf «& > Bluetooth.

3 Wahlen Sie ein Zielgerat fur die Datei aus.
- Die Datei wird gesendet, sobald sie das Zielgerat akzeptiert.

E - Die Vorgehensweise zum Teilen von Dateien kann sich je nach Datei unterscheiden.
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Screen Share
Sie konnen Bild und Ton des Gerats auf einem anderen Gerat wie z. B. einem
Fernseher wiedergeben, der die Miracast-Funktion unterstutzt.

1 Tippen Sie auf dem Einstellungsbildschirm auf Verbundene Geréte > Screen
Share.
2 Tippen Sie auf () ), um die Funktion zu aktivieren.

3 Wahlen Sie aus der Liste mit Geraten in der Nahe ein Gerat aus.

« Falls das gewtinschte Gerat nicht in der Liste enthalten ist, tippen Sie auf
Suchen, um die Liste zu aktualisieren.

- Sobald das Gerat verbunden ist, wird darauf der Bildschirm lhres Gerats
angezeigt.

E « Die Bildschirmfreigabe schaltet sich automatisch ab, wenn sich kein kompatibles
Gerat in der Nahe befindet.

NFC

Sie konnen das Gerat als Fahr- oder Kreditkarte verwenden. Sie konnen auch Daten
mit einem anderen Gerat teilen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Verbundene Gerédte > NFC.

2 Tippen Sie auf () ), um die Funktion zu aktivieren.
- Berthren Sie Ihr Gerat mit einem anderen Gerat, das NFC unterstitzt, um
das Teilen von Daten zu ermdglichen.

E « Je nach Geratetyp kann sich die NFC-Antenne an einer anderen Stelle befinden.
Weitere Informationen zum Bereich der NFC-Antenne finden Sie unter
Teilelibersicht.
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Dialogfeld betreffs Teilen

Sie kénnen in Galerie, Musik oder Dateimanager gespeicherte Inhalte mit Geraten in
der Nahe teilen. Sie konnen ebenfalls die Inhalte mit bestimmten Personen in Apps
teilen, die mit Google Direct Share arbeiten.

1 Tippen Sie auf dem Einstellungsbildschirm auf Verbundene Geréte >
Dialogfeld betreffs Teilen.

2 Tippen Sie auf @ , um jede Option zu deaktivieren.
+ Gerate in der Umgebung: Sie konnen sich die Gerate in der Umgebung

anzeigen lassen, mit denen Inhalte der Apps Galerie, Musik und
Dateimanager gemeinsam genutzt (geteilt) werden konnen.

- Direktes Teilen:In einer App, die Google Direct Share unterstutzt, kann
ein Symbol angezeigt werden, das es ermdglicht, Inhalte mit bestimmten
Personen zu teilen.

Dateiaustausch
Sie konnen Dateien zwischen lhrem Gerat und anderen LG Geraten oder Tablets
austauschen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Verbundene Geréte >
Dateiaustausch.

7 Passen Sie die folgenden Einstellungen an:
« VELVET: Zur Anderung des Geratenamens.

« Speichern in: Zielordner zum Speichern von Dateien, die von anderen
Geraten gesendet wurden, festlegen.

- Dateiaustausch: Empfang von Dateien, die von anderen Geraten gesendet
werden, erlauben.

+ SmartShare Beam: Dateien mit anderen Geraten tiber SmartShare Beam
teilen.

- Hilfe: Hilfetexte tber das Teilen von Dateien ansehen und lesen.
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Medienserver
Sie kénnen auf dem Gerat gespeicherte Medieninhalte mit Geraten in der Nahe
teilen, die DLNA unterstiitzen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Verbundene Geréte >
Medienserver.

7 Passen Sie die folgenden Einstellungen an:
« Inhalte teilen:Inhalte auf Ihrem Gerat mit Geraten in der Nahe teilen.

+ VELVET:Den Namen |hres Gerats festlegen.

E + Je nach Produkt des Benutzers kénnen die Meniibezeichnungen verschieden
lauten

+ Geteilte Inhalte festlegen: Den Typ der Medien festlegen, die mit anderen
Geraten geteilt werden sollen.

- Erlaubte Geréte: Eine Liste der Gerdte anzeigen, die auf Inhalte auf lhrem
Gerat zugreifen durfen.

+ Nicht-zugelassene Gerate: Eine Liste der Gerate anzeigen, die nicht auf
Inhalte auf Ihrem Gerdt zugreifen drfen.

Drucken
Sie kdnnen |hr Gerat mit einem Bluetooth-Drucker verbinden und auf dem Gerat
gespeicherte Fotos oder Dokumente ausdrucken.
Tippen Sie auf dem Einstellungsbildschirm auf Verbundene Gerate > Drucken.
+ Tippen Sie auf Standarddruckdienst, um nach Druckern zu suchen, zu denen
Sie eine Verbindung herstellen kdnnen. Oder tippen Sie auf > Drucker
hinzufiigen, um manuell einen Drucker hinzuzufiigen.
- Um die gewtinschte Drucker-App herunterzuladen, tippen Sie auf (+) Dienst
hinzufiigen.

E « Das ist nur méglich, wenn das Mobilfunknetz oder die Bluetooth-Funktion
eingeschaltet ist.

+ Um die Drucker-App uber@ Dienst hinzufiigen herunterzuladen, mussen Sie
sich zunachst bei lhrem Google-Konto anmelden
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Ton

Sie konnen die Einstellungen fir Tone, Vibration und Benachrichtigungen anpassen.

Tippen Sie auf dem Einstellungsbildschirm auf Ton und passen Sie die folgenden
Einstellungen an:

+ Tonprofil: Andern Sie den Tonmodus zu Ton, Nur vibrieren oder Lautlos.

+ Lautstarke: Lautstarke fUr verschiedene Elemente einstellen.

+ Klingelton: Einen Klingelton fiir eingehende Anrufe auswahlen. Klingelténe
hinzufiigen oder l&schen.

+ Benachrichtigungston: Einen Benachrichtigungston auswahlen. Sie kénnen auf
dem Gerat gespeicherte Musik als Benachrichtigungston festlegen.

- Ton mit Vibration: Festlegen, dass das Gerat vibriert und gleichzeitig einen
Klingelton wiedergibt.

- Kontakt-Klingelton: Klingelton fir eingehende Anrufe von einem bestimmten
Kontakt erstellen.

+ Blink-Signal fiir eingehenden Anruf: Der Blitz wird so eingestellt, dass er
synchron zum LG-Klingelton blinkt.

+ Nicht stéren: Uhrzeit, Zeitraum und App-Typ zum Empfang von
Benachrichtigungen festlegen. Benachrichtigungen nur an bestimmten
Wochentagen erhalten.

- Soundqualitdt und Effekte: Mit dieser Funktion konnen Sie fur die Wiedergabe
eines MusikstUcks oder Videos die Tonqualitat und Effekte festlegen.

Lautstarke: Lautstarke fiir verschiedene Elemente einstellen.

Lautstarke normalisieren: Mit dieser Funktion konnen Sie die
unterschiedlichen Lautstarken von verschiedenen Tonquellen normalisieren.

- Equalizer: Damit kdnnen Sie die Equalizer-Einstellungen andern.

LG 3D-Sound Modul: Mit dieser Funktion kénnen Sie ein Musiksttick

oder Video im dreidimensionalen, immersiven und lebendig wirkenden Ton
wiedergeben, wenn Kopfhorer, Lautsprecher oder ein anderes externes
Audiogerat angeschlossen sind. Details finden Sie unter .G 3D-Sound Modul.
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- Live-Untertitel: Das Gerat so einstellen, dass es die Stimmen von
Medieninhalten erkennt und automatisch Untertitel erzeugt.

« Vibrationsstdrke: Vibrationsintensitat andern.

- Vibrationstyp: Sie kénnen die Art der Vibration wahlen, wenn Sie Anrufe
empfangen.

+ Vibrieren beim Tippen: Festlegen, dass das Gerat vibriert, wenn Sie auf
bestimmte Bildschirmelemente tippen.

- Ton der Wahltasten: Wahlen Sie den Klangeffekt des \Wahl-Tastenfeldes.
+ LG Tastatur Tone: Klangeffekt der LG Tastatur auswahlen.

+ Beriihrungston: Klangeffekt auswahlen, der nach Bertihren eines Elements
ausgegeben wird.

+ Ton bei Bildschirmsperre: Einen Ton auswahlen, der beim Sperren oder
Entsperren des Bildschirms ausgegeben wird.

Benachrichtigungen

Sie kénnen eine Liste von installierten Apps markieren und die Einstellungen
hinsichtlich Benachrichtigungen konfigurieren.

1 Auf dem Einstellungsbildschirm auf Benachrichtigungen tippen.

7 Die Einstellungen wunschgemaR konfigurieren.

Einstellungen

137



Anzeige

Fir jeden Bildschirm kénnen Sie detaillierte Einstellungen vornehmen.

Tippen Sie auf dem Einstellungsbildschirm auf Anzeige und passen Sie die
folgenden Einstellungen an:

+ Homescreen: Homescreen Einstellungen anpassen. Detalils finden Sie unter
Homescreen Einstellungen.

- Navigationsleiste: Sie konnen den Stil der Navigationsleiste so andern, dass
Sie mit Gesten oder nur Uber Schaltflachen navigieren kénnen. \Wenn Sie
nur mit Tasten navigieren, kdnnen Sie auch die Tastenkombinationen andern.
Einzelheiten dazu finden Sie unter Navigationsleiste.

- Statusleiste: Sie konnen die Farbe der Statusleiste am oberen Bildschirmrand
festlegen, die Anzeige des Benachrichtigungssymbols und die Anzeige des
Akku-Ladezustands.

AOD (always-on display): Informationen wie Datum, Uhrzeit und
Benachrichtigungen auch anzeigen, wenn der Bildschirm ausgeschaltet ist.
Details dazu siehe AOD (always-on display).

- Komfortansicht: Stellen Sie das Gerat so ein, dass die Menge blauen Lichts auf
dem Bildschirm reduziert wird, um die Augen zu entlasten.

E « Diese Funktion ist nicht verfugbar, wenn das Gerat an einen LG Dual-Bildschirm
(LM-G905N) angeschlossen ist.

+ Nachtmodus: Um zu verhindern, dass der Bildschirm bei nachtlicher Dunkelheit
blendet, konnen Sie den Bildschirm dimmen.

« Farben des Bildschirms: Fir den gewtnschten Bildschirm die Farbe und die
Farbtemperatur anpassen.

E + Um die Einstellungen zurtickzusetzen, tippen Sie auf'f).

+ Video Enhancer:Bei Wiedergabe eines Videos im Vollbildmodus kénnen Sie die
Einstellungen andern, sodass das Bild heller und farblich dynamischer angezeigt
wird.

+ Schriftart: GroRe der Schrift und ihre Attribute wie fett oder Schrifttyp usw.
andern.

+ Akzent-Farbe: Die Signal-Farbe der Fenster fir Einstellungen, Mens,
Benachrichtigungen usw. andern.
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+ AnzeigegroRe: Stellen Sie die Bildschirmelemente auf eine Grofe ein, die Sie
gut sehen konnen. Manche Elemente andern dann maéglicherweise ihre Position.

+ Apps in Vollbild: Passen Sie die BildschirmgréRe der Apps an.

+ Helligkeit: Verwenden Sie den Schieberegler, um die Bildschirmhelligkeit zu
andern. Um die Helligkeit des Bildschirms an die Intensitat des Umgebungslichts
anzupassen, tippen Sie auf den Automatisch-Schalter.

+ Automatisch: Legen Sie die Gerateeinstellungen so fest, dass die
Bildschirmhelligkeit entsprechend der Umgebungslichtintensitat automatisch
angepasst wird.

+ Bildschirmabschaltung: Bildschirm automatisch ausschalten, wenn das Gerat
flr einen bestimmten Zeitraum nicht verwendet wird.

+ Automatisch drehen: Bildschirm automatisch entsprechend der
Gerateausrichtung drehen.

+ Bildschirmschoner: Bildschirmschoner anzeigen, wenn das Gerat mit der
Halterung oder einem Ladegerat verbunden ist. Wahlen Sie den Typ des
anzuzeigenden Bildschirmschoners aus.

+ Einhandbedienung: Verkleinern Sie die GroRe des Bildschirms, um das Gerat
bequem mit einer Hand zu verwenden. Wischen Sie tiber die Bedienungsleiste
am unteren Ende des Bildschirms nach links oder rechts.

Hintergrund & Thema

Sie konnen fur Ihr Gerat den Hintergrund, das Bildschirmthema, Symbolstil oder
AOD (Always-on Display) auswahlen.

1 Auf dem Einstellungsbildschirm auf Hintergrund & Thema tippen.

7 Umdie Einstellungen anzupassen, auf Hintergrund, Thema, Symbol oder AOD

tippen.

Einstellungen 139



Sperrbildschirm & Sicherheit

Sie konnen die Einstellungen fir Bildschirmsperre und Sicherheit anpassen.
1 Tippen Sie auf dem Einstellungsbildschirm auf Sperrbildschirm & Sicherheit.

2 Passen Sie die Einstellungen an.

+ Google Play Protect: Taglich das Gerat scannen, um zu prifen, ob sich
potentiell gefahrliche Apps auf ihm befinden.

+ Mein Gerat finden: Mit dieser Funktion kénnen Sie von einem entfernten
Standort aus den Ort |hres Gerdts ermitteln und verfolgen. Damit kdnnen Sie
lhre Daten schiitzen, falls Sie Ihr Gerat verloren haben.

« Sicherheitsupdate: Auf Software-Updates priifen und Einstellungen zur
automatischen Installation konfigurieren.

+ Bildschirmsperre auswahlen: Bildschirmsperrverfahren auswahlen. Details
finden Sie unter Bildschirmsperre festlegen.

+ Sperrbildschirm anpassen: Die Informationen andern, die auf dem
Sperrbildschirm angezeigt werden.

- Einstellungen zur sicheren Sperre: Einstellungen zum Sperren des
Bildschirms andern.

- Fingerabdriicke:Ihren Fingerabdruck zum Entsperren des Bildschirms oder
von Inhalten verwenden. Details finden Sie unter Fingerabdruckerkennung
im Uberblick.

+ Inhaltssperre: Ermaglicht, fir die Dateien in der Galerie eine Sperre
einzurichten (durch Passwort oder Muster).
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+ Verschliisselung & Anmeldeinformationen: Die Einstellungen fiir SD-

Karten-Verschlisselung und Anmeldedaten konfigurieren.

- SD-Karte verschliisseln: Speicherkarte verschliisseln, um die
Verwendung auf einem anderen Gerat zu verhindern. Details finden Sie
unter Verschliisselung der Speicherkarte.

- Schutz der Anmeldedaten: Typ des Speichers anzeigen, auf dem das
Sicherheitszertifikat gespeichert wird.

- Vertrauenswiirdige Anmeldeinformationen: Anzeige der Root-CA-
Zertifikate Ihres Systems und der vom Benutzer installierten CA-
Zertifikate.

- Benutzeranmeldeinformationen: Die auf Ihrem Gerat gespeicherten
sicheren Zertifikatdaten anzeigen und andern.

- Aus dem Speicher installieren: Ein sicheres Zertifikat aus einem
Speicher installieren.

- Zertifikats-Speicher [6schen: Vom Benutzer installierte sichere
Zertifikate und entsprechende Anmeldedaten l6schen.

+ Gerdteadministratoren: Bestimmte Apps drfen die Steuerung oder

Verwendung des Gerats einschranken.

« Trust agents: Auf dem Gerat gespeicherte Trust agents anzeigen und
verwenden.
- Bildschirm fixieren: App-Bildschirm fixieren, sodass nur die derzeit aktive

App verwendet werden kann.

« Zugriff auf Nutzungsdaten: Details zur Nutzung von Apps auf dem Gerat
anzeigen.
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Datenschutz

Sie konnen alle Ihre Datenschutz-Einstellungen finden und anpassen.
1 Tippen Sie auf dem Einstellungsbildschirm auf Datenschutz.

2 Passen Sie die Einstellungen an.

- Berechtigungs-Verwaltung: Ermdglicht Ihnen, die den Apps zugewiesenen
Berechtigungen zu Uberpriifen und zu andern.

« Sperrbildschirm: Ermaglicht Ihnen, Benachrichtigungen festzulegen, die auf
dem Sperrbildschirm angezeigt werden.

« Passworter sichtbar machen: \Wenn beim Eintippen eines Passworts jedes
Zeichen kurz angezeigt werden soll, damit Sie sehen konnen, was Sie gerade
eingetippt haben, dann aktivieren Sie diese Option.

- Dienste zur Geratepersonalisierung: Ermoglich Ihnen, auf Grundlage von
Benutzern, Apps und interaktiver Inhalte Vorschlage zu erhalten.

« AutoFill-Dienst von Google: Aktivieren Sie diese Funktion, um die in
Ihrem Konto gespeicherten Informationen wie Passwort, Adresse oder
Kreditkartennummer mit einem einzigen Antippen einzuftigen. Sie kdnnen
diese Funktion auch deaktivieren, die Auto-Ausfullen-Funktion von Google
benutzen oder ein neues Dienst-Konto hinzuftigen.

+ Google-Standortverlauf: Sie konnen die Funktion Standort-Verlauf
aktivieren und deaktivieren. Ist die Funktion aktiviert, werden die zuletzt
ermittelten Standortdaten lhres Telefons in Verbindung lhres Google-Kontos
regelmaRig gespeichert und genutzt.

Um lhre Standortdaten einzusehen und/oder zu verwalten, auf dem
Bildschirm des Standortverlaufs auf * tippen.

« Aktivitatseinstellungen: Zum Auswahlen von Aktivitaten und
Informationen, die Google speichern soll.

+ Werbung: Erméglicht, die Werbe-ID zu Gberpriifen und die personalisierten
Werbespots festzulegen.

+ Nutzung & Diagnose: Nach Aktivierung werden Diagnose-, Gerate- und
App-Nutzungsdaten automatisch an Google gesendet, damit Sie Android als
noch komfortabler erleben kénnen.
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Standort

Sie kénnen uberpriifen, wie lhre Standortdaten anderen mitgeteilt werden, und
kénnen konfigurieren, wer auf ihre Standortdaten zugreifen darf.

Tippen Sie auf dem Einstellungsbildschirm auf Standort und legen Sie die
gewiinschten Funktionen fest.

Erweiterungen

Smart Doctor

Sie kénnen die Funktion ,Smart Doctor” verwenden, um eine Diagnose Uber den
Zustand des Gerats zu erstellen und das Gerat zu optimieren.

Tippen Sie auf dem Einstellungsbildschirm auf Erweiterungen > Smart Doctor.

Context Awareness

Gerateeinstellungen konnen je nach Nutzungsmuster und Standort automatisch
geandert werden.

1 Tippen Sie auf dem Einstellungsbildschirm auf Erweiterungen > Context
Awareness.

2 Aktivieren Sie die Elemente, fiir welche die Einstellungen automatisch geandert
werden sollen.

« AUTOMATISCH: Sie konnen das Gerat so einstellen, dass das Tonprofil,
Bluetooth und Wi-Fi-Funktionen in unterschiedlichen Umgebungen
automatisch geandert werden, zum Beipiel zu Hause, bei Verlassen des
Zuhauses, auf der Arbeit und bei Verlassen der Arbeit. Sie konnen das Gerat
auch so einstellen, dass eine bestimmte App gedffnet wird, sobald Kopfhérer
angeschlossen werden oder ein Bluetooth-Gerat verbunden wird.

E « Damit diese Funktion benutzt werden kann, missen unter Meine Orte die
Angaben fur Ihr Zuhause oder Ihren Arbeitsplatz eingetragen sein. Dazu tippen Sie
auf dem Einstellungsbildschirm auf Standort > Meine Orte, um diese anzugeben.
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Personalisierter Dienst

Bei Benutzung der integrierten Suchfunktion kénnen Sie intelligente Ergebnisse
erhalten.

1 Tippen Sie auf dem Einstellungsbildschirm auf Erweiterungen >
Personalisierter Dienst.

7 Um diese Funktion zu aktivieren, auf () ) tippen.

Spielen
Sie konnen Einstellungen fiir Spiel-Tools, Grafik und Akkusparfunktion
konfigurieren.
1 Tippen Sie auf dem Einstellungsbildschirm auf Erweiterungen > Spielen.
7 Passen Sie die folgenden Einstellungen an:
- Spiele Launcher: Um den Spiele Launcher zu benutzen, tippen Sie auf (1) ).

- Spiel-Tools: \Wahrend Sie ein Spiel spielen, kénnen Sie die Funktion aufrufen,
indem Sie in der Bedienungsleiste das Symbol Spiel-Tools bertihren.

- Spielgrafik: Spielegrafik anpassen.
E « Wenn Sie die Auflésung bei manchen Spielen andern, funktioniert die
Bildschirmanzeigefunktion méglicherweise nicht ordnungsgemag.

« Diese Funktion wird von einigen Spiele-Apps mdglicherweise nicht unterstttzt.

« Pause: Bildschirmhelligkeit und -leistung werden reduziert, wenn Sie das
Spiel [anger als 5 Minuten ohne Verwendung laufen lassen.
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Bildschirmaufnahme

Sie kénnen die Einstellungen zur Bildschirmaufnahme konfigurieren.

1 Tippen Sie auf dem Einstellungsbildschirm auf Erweiterungen >
Bildschirmaufnahme.

7 Passen Sie die folgenden Einstellungen an:
« Sich in das Video einfiigen, mit: \Wahlen Sie eine der folgenden Optionen.

- Bild: Wahrend der Aufnahme wird Ihr Profil-Bild in das Video eingeftigt.
Nach Auswahl dieser Option tippen Sie auf @ und wahlen ein Profil-Bild.
Passen Sie dann mit dem Schieberegler die GréRe des Bildes an.

- Vordere Kamera: Sie werden bei der Aufnahme mit der vorderen Kamera
aufgezeichnet und in das Video eingeflgt.

- Nie: Nichts ist enthalten.
« Audioquelle: \Wahlen Sie als Audioguelle entweder Mik. oder Inhalt.
+ Video-Auflésung: Wahlen Sie die Auflésung fur die Bildschirmaufnahme.

Den Bildschirm aufzeichnen:

1 Ziehen Sie die Statusleiste nach unten, um die Liste mit den
Schnellzugriffssymbolen zu 6ffnen.

2 (Falls erforderlich, wischen Sie nach links, iber den Bereich der Symbole fir den
Schnellzugriff.) G antippen.

3 Lesen Sie den Haftungsausschluss und tippen Sie auf Starten. Nach 3
Sekunden beginnt die Aufzeichnung.

4 Um die Aufzeichnung zu beenden, unten rechts am Bildschirm auf (=) tippen.
Das aufgezeichnete Video wird in der Galerie gespeichert.

E - Falls Sie die Personlichkeitsrechte anderer Personen verletzen, wie zum Beispiel
das Recht auf das eigene Bild, Urheberrechte oder andere diffamieren oder
verleumden mit Hilfe von Funktionen, die durch den Dienst Bildschirmaufnahme
verfligbar sind, kénnen Sie gemaR gesetzlicher Vorschriften des Zivilrechts,
Strafrechts oder Verwaltungsrechts zur Verantwortung gezogen werden. LG
Electronics ist auf keinen Fall gesetzlich verantwortlich fiir Handlungen von
Benutzern.
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Dual-App

Sie kénnen auf dem Produkt Messenger-Apps doppelt installieren, um zwei Konten
gleichzeitig benutzen zu kénnen.

1
2
3

Tippen Sie auf dem Einstellungsbildschirm auf Erweiterungen > Dual-App.
Tippen Sie nach dem Lesen des Haftungsausschlusses auf Bestatigen.

Tippen Sie in der Liste der verfiigbaren Apps bei dieser App auf installieren,

um eine Kopie der gewtinschten App zu installierne, und folgen Sie dann den

Anweisungen auf dem Bildschirm.

« Es wird die Liste verfligbarer Dual-Apps angezeigt. Auf dem Homescreen
werden wahrend der Installation Apps-Symbole generiert.

Stift

Fur die Benutzung eines Active Pen (optional, wird separat verkauft) kénnen Sie
Optionen konfigurieren. Beachten Sie bitte, dass dieses Gerat den Active Pen
AES2.0 (Active Electrostatic) unterstitzt.

1
2

Tippen Sie auf dem Einstellungsbildschirm auf Erweiterungen > Stift.

Die folgenden Einstellungen anpassen:

« Verkniipfungen der Stifttasten: Konfigurieren Sie die Verkntipfungen fir
jede Taste des Active Pen.

« App Verkniipfung: Wahlen Sie, welche Apps (bis zu funf) nach
Herausnehmen des Stifts angezeigt werden sollen.

+ Notizen-Vorschau: Die Anzeige kirzlich erstellter Notizen in Pen Pop
einschalten.

« Schreibgerdusche: Klangeffekte beim Zeichnen einschalten.

- Stiftzeiger einblenden: Anzeige eines Zeigers, wenn der Stift nahe am
Bildschirm bewegt wird.

+ Gesten der Navigationsleiste ignorieren: Die Eingabe von
Navigationsleisten-Gesten blockieren; das ist sinnvoll, wenn Sie am Rand des
Bildschirms mit einem Active Pen etwas zeichnen oder schreiben.
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Verkniipfungen
Um bestimmte Apps oder Funktionen sofort auszuftihren, kénnen Sie Tasten wie
Ein-/Aus-/Sperrtaste, Lautstarke und Google Assistant benutzen.

1 Tippen Sie auf dem Einstellungsbildschirm auf Erweiterungen >
Verkniipfungen.
7 Folgende Einstellungen kénnen Sie anpassen.

. Kamera Offnen: Zweimal auf die Ein/Aus-Taste driicken, um die Kamera zu
offnen.

- Screen-off memo 6ffnen: Zweimal die Lautertaste (+) drlicken, um Screen-
off-memo zu 6ffnen, wenn der Bildschirm gesperrt oder ausgeschaltet ist.

- Kamera Offnen: Zweimal die Leisertaste (-) driicken, um die Kamera zu
6ffnen, wenn der Bildschirm gesperrt oder ausgeschaltet ist.

+ Google Assistant 6ffnen: An der Seite des Telefons auf die Taste des
Google Assistant driicken.

+ Mit dem Google Assistant sprechen: Halten Sie die Google-Assistant-
Taste gedrickt, um sofort mit Inrem Assistant zu sprechen.

E + Bestimmte Sprachen werden vom Google Assistant nicht unterstiitzt.

KnockON

Sie kénnen den Bildschirm durch zweimaliges antippen ein- und ausschalten.
Details finden Sie unter KnockON.

Beriihrungsempfindlichkeit erh6hen

Sie konnen festlegen, dass der Touchscreen empfindlicher auf Berihrungen
reagiert. Bei Benutzung einer Displayschutzfolie wird empfohlen, diese Funktion
einzuschalten.

Tippen Sie am Einstellungsbildschirm auf Erweiterungen >
Beriihrungsempfindlichkeit erhhen.
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Apps
Sie konnen eine Liste von installierten Apps markieren und die Einstellungen
hinsichtlich Benachrichtigungen, Berechtigungen und mehr konfigurieren.

1 Tippen Sie auf dem Einstellungsbildschirm auf Apps.

7 Passen Sie die Einstellungen an.

Akku

Sie kénnen aktuelle Akkuinformationen anzeigen oder den Energiesparmodus
aktivieren.

1 Tippen Sie auf dem Einstellungsbildschirm auf Akku.

7 Passen Sie die folgenden Einstellungen an:
+ Akkuverbrauch: Details zur Akkunutzung anzeigen.

- Optimiertes Laden: Die Ladegeschwindigkeit wird je nach Art des Ladens
automatisch angepasst, um die Hitzeentwicklung zu reduzieren und die
Lebensdauer des Akkus zu verlangern.

+ Adaptiver Akku: Damit kann der Akkuverbrauch begrenzt werden, indem
verhindert wird, dass Apps im Hintergrund ausgefthrt werden.

« Einschrankungen der Hintergrundnutzung: Aktivieren Sie diese
Funktion, um Akku-Energie zu sparen, indem Sie Apps im Hintergrund
einschranken, wahrend Sie das Gerat benutzen. \WWenn Apps zwecks
Engeriesparens eingeschrankt sind, funktionieren diese méglicherweise nicht
ordnungsgema oder sie geben keine Benachrichtigungen aus.

+ Akkusparmodus: Durch Gerateeinstellungen den Stromverbrauch
verringern, indem Anzeigehelligkeit, Taktrate und Vibrationsintensitat
verringert werden.

+ Ausgenommen vom Energiesparen: Apps auswahlen, die ohne
Funktionseinschrankungen im Energiespar- oder Akku-Optimierungsmodus
verwendet werden.

Einstellungen 148



Speicher

Sie konnen den internen Geratespeicher oder den Speicherplatz auf der
Speicherkarte anzeigen und verwalten.

1 Tippen Sie auf dem Einstellungsbildschirm auf Speicher.

2 Passen Sie die folgenden Einstellungen an:

« Interner Speicher: Gesamten Speicherplatz und freien Speicherplatz im
internen Speicher des Gerdts anzeigen. Liste der verwendeten Apps und den
Speicherbedarf jeder App anzeigen.

+ SD-Karte: Gesamten Speicherplatz und freien Speicherplatz auf der
Speicherkarte anzeigen. Diese Option wird nur angezeigt, wenn eine
Speicherkarte eingelegt ist. Tippen Sie zum Auswerfen der Speicherkarte
auf

Konten

Sie kénnen Benutzer hinzuftigen, um lhr Gerat mit ihnen gemeinsam zu nutzen,
und ein Cloud-Konto registrieren

1 Tippen Sie auf dem Einstellungsbildschirm auf Konten.

7 Passen Sie die Einstellungen an.

Digital Wellbeing &
Jugendschutzeinstellungen

Sie kénnen einsehen, wie lange das Produkt genutzt worden ist, und Sie kénnen
fr jede App einen Timer einstellen, um die Nutzungsdauer zeitlich zu begrenzen.
Uber den Entspannungsmodus und den Konzentrationsmodus kénnen Sie die
Mobiltelefon-Nutzungszeit verwalten.

Wahlen Sie auf dem Einstellungsbildschirm Digital Wellbeing &
Jugendschutzeinstellungen und legen Sie die gewtinschte Funktion fest.
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Google
Mit Google-Einstellungen konnen Sie lhre Google-Apps und Kontoeinstellungen
verwalten.

Tippen Sie auf dem Einstellungsbildschirm auf Google.

System

Update-Center

Sie kénnen nach der neuesten Version der von LG zur Verfiigung gestellten App
oder Software suchen und diese installieren.

1 Tippen Sie auf dem Einstellungsbildschirm auf System > Update-Center.

7 Passen Sie die folgenden Einstellungen an:
+ App Updates: Sie konnen priifen, ob es ein App-Update gibt. Falls verfligbar,
konnen Sie das Update installieren.

- Software Update: Sie konnen priifen, ob es ein Software-Update gibt. Falls
verfligbar, kénnen Sie das Update installieren.

Sprache und Tastatur
Sie konnen die Einstellungen fir Sprache und Tastatur des Gerats anpassen.

1 Tippen Sie auf dem Einstellungsbildschirm auf System > Sprache und
Tastatur.

7 Passen Sie die folgenden Einstellungen an:
« Sprache: Sprache fiir das Gerat auswahlen.

- Tastaturen verwalten: Sie kénnen die grundlegenden Tastatur-
Standardeinstellungen des Produkts andern, die Nutzungsumgebungen
flr die LG Tastatur oder andere installierte Tastaturen festlegen und die
Spracherkennungsfunktion firr Google Voice einstellen. Es kann auch
festgelegt werden ob auf dem Homescreen auf der Navigationsleiste die
Tastatur-Schaltflache angezeigt wird, damit Sie schnell auf eine andere
Tastatur umschalten kénnen.
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« Physische Tastatur: Sie kénnen die physische Tastatur auswahlen oder
Tastatur-Schnellzugriff-Tasten markieren.

- AutoFill Dienst: Aktivieren Sie diese Funktion, um die in lhrem
Konto gespeicherten Informationen wie Passwort, Adresse oder
Kreditkartennummer mit einem einzigen Antippen einzuftigen. Sie
konnen diese Funktion auch deaktivieren, indem Sie die automatische
Vervollstandigung von Google verwenden oder ein neues Dienst-Konto
hinzuftgen.

« Text-zu-Sprache Ausgabe: Einstellungen fir die Text-in-Sprache-Ausgabe
festlegen.

« Zeigergeschwindigkeit: Zeigergeschwindigkeit einer Maus oder eines
Touchpads anpassen.

- Maustasten vertauschen: Kehren Sie die Maustastenfunktionen um, damit
die rechte Maustaste als primare Maustaste verwendet werden kann.

Datum und Uhrzeit

Sie konnen die Einstellungen fur Datum und Uhrzeit des Gerats anpassen.
1 Tippen Sie auf dem Einstellungsbildschirm auf System > Datum und Uhrzeit.

7 Passen Sie die Einstellungen an.

Arbeitsspeicher

Sie kénnen die durchschnittliche Arbeitsspeichernutzung tber einen bestimmten
Zeitraum und den von einer App belegten Arbeitsspeicher anzeigen.

1 Tippen Sie auf dem Einstellungsbildschirm auf System > Arbeitsspeicher.

2 Tippen Sie auf w, um einen Zeitraum zum Abrufen der Daten festzulegen.
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Sicherung

Sie kénnen auf lhrem Gerat gespeicherte Daten auf einem anderen Gerat oder in
einem anderen Konto sichern.

1 Tippen Sie auf dem Einstellungsbildschirm auf System > Sicherung.

7 Passen Sie die folgenden Einstellungen an:
LG Mobile Switch: Ermdglicht Ihnen, Daten von einem alten LG-Gerat auf
Ihr neues LG-Gerdt zu Ubertragen. Details finden Sie unter LG Mobile Switch.

+ Sichern & Wiederherstellen: Sichern Sie Ihre Geratedaten oder stellen Sie
Daten aus einer Sicherung auf Ihrem Gerat wieder her.

A + Wenn Sie lhr Gerat zurticksetzen, konnen Sicherungsdateien, die im Speicher
gespeichert sind, geloscht werden. Achten Sie darauf, wichtige Sicherungsdateien
auf lhren PC zu kopieren und zu speichern

+ Google Backup: Backup-Einstellungen von Google Drive andern. Sie konnen
auch das derzeit benutzte Backup-Konto priifen oder ein neues Backup-
Konto hinzuftigen.

Neu starten & zuriicksetzen

Sie konnen das Gerat zurticksetzen, einschlieRlich Einstellungen zu Netzwerk und
Apps.

1 Tippen Sie auf dem Einstellungsbildschirm auf System > Neu starten &
zuriicksetzen.

7 Passen Sie die folgenden Einstellungen an:

- Automatischer Neustart: Zur festgelegten Uhrzeit vollzieht das Telefon
automatisch einen Neustart und wird optimiert. Tippen Sie auf () ), um
diese Funktion zu aktivieren. Zur festgelegten Uhrzeit vollzieht das Telefon
automatisch einen Neustart und es optimiert sich selbst. \Wahlen Sie das
Datum und die Uhrzeit fiir den Neustart.
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E « Sie kénnen festlegen, dass das Gerat einmal pro \Woche den automatischen
Neustart vollzieht. Das Gerét startet innerhalb einer Stunde ab der
voreingestellten Uhrzeit neu.

Wenn das Gerat neu startet, werden Benachrichtigungen und App-Indikatoren
geloscht. Speichern Sie wichtige Daten, bevor der Neustart erfolgt.

Die Funktion Automatischer-Neustart wird in folgenden Situationen nicht

aktiviert: \Wenn der Bildschirm eingeschaltet ist, wenn das Gerat gerade benutzt

wird, wenn der Akkustand 30% oder niedriger ist, wenn die USIM-Karte gesperrt

ist.

- Es hangt vom Telekommunikationsdienstanbieter ab, ob die Funktion
Automatischer Neustart zur Verfigung steht oder nicht.

+ Netzwerkeinstellungen zuriicksetzen: \Wi-Fi, Bluetooth- und andere
Netzwerkeinstellungen zurticksetzen.

+ App-Einst. zuriicksetzen: Die Einstellungen fiir eine App zurlicksetzen. Die
in der App gespeicherten Daten werden nicht gel6scht.

+ Auf Werkszustand zuriick: Alle Einstellungen des Gerats zurlicksetzen und
Daten [6schen.

E « Beim Zuriicksetzen des Gerats werden alle darauf befindlichen Daten gel6scht.
Dann mussen Sie den Geratenamen, das Google-Konto und andere Informationen
zur Ersteinrichtung erneut eingeben.

Nach der Dateninitialisierung kénnen die Daten nicht wiederhergestellt werden.

Uber das Telefon

Sie konnen Informationen zu Ihrem Gerat wie Name, Status, Softwaredetails und
rechtliche Informationen anzeigen.

Auf dem Finstellbildschirm tippen Sie auf System > Uber das Telefon , sodass Sie
die Informationen einsehen kénnen.

Regulierungen & Sicherheit

Sie kénnen Konformitatszeichen und zugehdrige Informationen auf dem Gerat
anzeigen.

Tippen Sie auf dem Einstellungsbildschirm auf System > Regulierungen &
Sicherheit.
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Bedienungshilfen

Sie kénnen die auf lhrem Gerat installierten Plug-Ins zur erleichterten Bedienung
verwalten.

1 Tippen Sie auf dem Einstellungsbildschirm auf Bedienungshilfen.

2 Passen Sie die folgenden Einstellungen an:

« Sehen > TalkBack: Festlegen, dass das Gerat den Bildschirmstatus oder
Aktionen per Sprachausgabe meldet.

- Sehen > Sprachbenachrichtigungen: Festlegen, dass das Gerdt die
Anruferinformationen vorliest.

+ Sehen > Schriftart: GroRe der Schrift und ihre Attribute wie fett oder
Schrifttyp usw. andern.

+ Sehen > AnzeigegroRe: Stellen Sie die Bildschirmelemente auf eine
GroRe ein, die Sie gqut sehen kénnen. Manche Elemente andern dann
moglicherweise ihre Position.

+ Sehen > Touch-Zoom: Den Bildschirm durch dreimaliges Tippen vergroRern
oder verkleinern.

- Sehen > Fenster zoomen: VergroRern oder verkleinern Sie das Fenster und
invertieren Sie die Farbe.

« Sehen > GroRer Mauszeiger: Mauszeiger vergréRern.

« Sehen > Bildschirm mit hohem Kontrast: Fir eine kontrastreiche Anzeige
wird die Hintergrundfarbe auf schwarz gestellt.

+ Sehen >Umkehr der Bildschirmfarbe: Bildschirmkontrast fiir Personen mit
Sehschwache erhohen.

+ Sehen > Farbeinstellung des Bildschirms: Bildschirmfarben anpassen.

+ Sehen > Monochrom: Bildschirm in Graustufenmodus umschalten.

+ Sehen > Anrufe mit der Ein-/Aus-Taste beenden: Gesprach durch Driicken
der Ein-/Aus-/Sperrtaste beenden.

- Horen > Live-Untertitel: Das Gerat so einstellen, dass es die Stimmen von
Medieninhalten erkennt und automatisch Untertitel erzeugt.

+ Horen > Einstellungen fiir Untertitel: Fir Horgeschadigte kann fur die
Wiedergabe von Videos der Untertitel-Dienst aktiviert werden.

+ Horen > Blitz-Benachrichtigungen: Festlegen, dass das Gerat Sie tiber
eingehende Anrufe, Benachrichtigungen und Wecker mit einem Blinklicht
informiert.
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+ Horen > Alle Tone stummschalten: Alle Tone stummschalten und
Lautstarke am Horer verringern.

+ Horen > Audio-Kanal: Audiotyp auswahlen.

+ Horen > Klangabgleich: Audioausgangsbalance anpassen. Verwenden Sie
den Schieberegler, um die Balance zu andern.

+ Motorik & Wahrnehmung > Touch assistant: Touch-Board aktivieren,
damit Schaltflachen und Gesten einfacher zu verwenden sind.

+ Motorik & Wahrnehmung > Touch-Eingabe: Text durch Bertihren und
Halten des Bildschirms eingeben oder durch einfaches Bertihren verandern.

+ Motorik & \Wahrnehmung > Physische Tastatur: Tastatureinstellungen
anpassen.

+ Motorik & Wahrnehmung > Auto Mausklick: \Wenn keine Bewegung
stattfindet, den Mauszeiger automatisch klicken.

+ Motorik & Wahrnehmung > Fiir Anrufe beriihren und halten: Anrufe
durch Bertihren und Halten der Anruftaste statt durch Ziehen annehmen
oder ablehnen.

+ Motorik & Wahrnehmung > Bildschirmabschaltung: Bildschirm
automatisch ausschalten, wenn das Gerat fiir einen bestimmten Zeitraum
nicht verwendet wird.

+ Motorik & \Wahrnehmung > Touch-Control-Bereiche: Touch-Bereich
begrenzen, sodass nur ein bestimmter Teil des Bildschirms durch Touch-
Eingabe gesteuert werden kann.

+ Bedienungshilfen Schnellzugriff: Auf haufig verwendete Funktionen durch
dreimaliges Tippen auf O) schnell zugreifen.

+ Automatisch drehen: Bildschirmausrichtung automatisch entsprechend der
Gerateposition andern.

« Vorlesen: Dies ermdglicht Ihnen, Elemente anzutippen und gesprochenes
Feedback zu erhalten.

+ Schalterzugriff: Tastenkombinationen zur Steuerung des Gerats festlegen.
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LG Spracheinstellungen

Wahlen Sie eine Sprache fiir das Gerat aus.
+ Tippen Sie auf dem Homescreen auf Einstellungen > System > Sprache und
Tastatur > Sprache > Sprache hinzufiigen und wahlen Sie eine Sprache.

- Beruhren und halten Sie = und ziehen Sie das Symbol auf der Sprachenliste
nach oben, um die gewahlte Sprache als Standardsprache einzustellen.

LG Bridge

LG Bridge Ubersicht

Mit der App LG Bridge" konnen Sie die auf lhrem LG Smartphone gespeicherten
Fotos, Musik, Videos und Dokumente bequem auf Ihrem Computer verwalten. Sie
kénnen beispielsweise Kontakte und Fotos auf dem Computer sichern oder die
Geratesoftware aktualisieren.

E + Weitere Informationen finden Sie in der Hilfe zu LG Bridge.
« Die unterstiitzten Funktionen kénnen je nach Gerat unterschiedlich sein.

« Der LG USB-Treiber ist ein Programm, das fiir die Verbindung lhres LG
Smartphones mit einem Computer erforderlich ist und bei der Installation von LG
Bridge installiert wird.

Funktionen von LG Bridge
+ Sie konnen auf dem Gerdt gespeicherte Daten Uber eine USB-Kabel-Verbindung
auf einem Computer sichern oder auf einem Computer gespeicherte Daten auf
dem Gerat wiederherstellen.
+ Sie kénnen die Geratesoftware mittels USB-Kabel-Verbindung tber einen
Computer aktualisieren.
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LG Bridge auf einem Computer installieren
1 Rufen Sie auf lhrem Computer www.lg.com auf.

2 Wahlen Sie lhre Region.

3 Klicken Sie auf Support > Software und Firmware.

4

Geben Sie den Namen des Gerats ein.
ODER
Wahlen Sie nach Produktkategorie.

5 Offnen Sie PC-Synchronisierung > LG-Bridge, um die Setup-Datei
herunterzuladen.
. Offnen Sie Details, um die Mindestanforderungen fur die Installation von LG
Bridge anzuzeigen.

Telefonsoftware-Update

LG Mobile-Telefonsoftware-Update aus dem

Internet

Weitere Informationen zur Verwendung dieser Funktion finden Sie unter
http//www.lg.com/common/indexsp. \Wahlen Sie dort lhr Land und lhre Sprache aus.

Mit dieser Funktion kénnen Sie die Firmware des Telefons bequem tber das
Internet auf eine neuere Version aktualisieren, ohne ein Servicezentrum aufsuchen
zu mussen. Diese Funktion steht nur zur Verftigung, wenn LG eine neuere
Firmware-Version fir lhr Gerat zur Verfigung gestellt hat.

Wahrend der Aktualisierung der Firmware eines Mobiltelefons missen Sie
samtliche Anweisungen und Hinweise, die zu einem Schritt angezeigt werden,
genau Uberprfen, bevor Sie fortfahren. Wenn Sie bei der Aktualisierung das USB-
Kabel abziehen, kann das Mobiltelefon schwer beschadigt werden.

E + LG behdlt sich das Recht vor, Firmware-Updates nach eigenem Ermessen nur fiir
ausgewahlte Modelle zur Verfiigung zu stellen. AuRerdem garantiert LG nicht die
Verfigbarkeit einer neueren Firmware-Version fr alle Telefonmodelle.
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LG Mobile-Softwareupdate Over-the-Air (OTA)

Mit dieser Funktion konnen Sie die Software lhres Telefons bequem auf eine neue
Version aktualisieren, ohne dazu ein USB-Kabel anschlieRen zu miissen. Diese
Funktion steht nur zur Verfiigung, wenn LG eine neuere Firmware-Version fur Ihr
Gerat zur Verfligung gestellt hat.

Zum Ausfthren des Telefon-Software-Updates

Einstellungen > System > Update-Center > Software Update > Jetzt auf
Updates priifen.

E « |hre persénlichen Daten aus dem internen Telefonspeicher - einschlieRlich
Informationen tber Ihr Google-Konto und alle anderen Konten, Ihre System-/
Appdaten und -einstellungen, heruntergeladene Apps und lhre DRM-Lizenz -
konnten bei der Aktualisierung der Software des Telefons verloren gehen. LG
empfiehlt daher, dass Sie Ihre personlichen Daten sichern, bevor Sie die Software
des Telefons aktualisieren. LG tibernimmt keine Haftung fiir den Verlust von
personlichen Daten.

« Diese Funktion hangt vom Gebiet oder Netzanbieter ab.

Anhang 159



Diebstahlschutz

Richten Sie lhr Gerat so ein, dass andere Personen es nicht mehr verwenden
kénnen, wenn es ohne lhre Erlaubnis auf die Werkseinstellungen zurtickgesetzt
wird. Wenn beispielsweise |hr Gerat verloren geht, gestohlen oder geléscht wird,
kann nur jemand mit Ihrem Google-Konto oder mit Kenntnis der Informationen zur
Bildschrimsperre das Gerat verwenden.

Damit stellen Sie sicher, dass Ihr Gerat geschitzt ist:

Bildschirmsperre festlegen: Wenn Sie eine Bildschirmsperre festgelegt haben
und Ihr Gerat verloren geht oder gestohlen wird, kann das Gerat tber das Menu
LEinstellungen” nur geldscht werden, wenn der Bildschirm entsperrt ist.

Dem Gerat Ihr Google-Konto hinzufiigen: Wenn |hr Gerat geloscht wird und sich
darauf ein Google-Konto befindet, kann das Gerat den Einrichtungsvorgang nur
abschlieRen, wenn Ihre Google-Kontoinformationen erneut eingegeben werden.

Wenn |hr Gerdt geschitzt ist, miissen Sie den Bildschirm entsperren

oder das Passwort Ihres Google-Kontos eingeben, um das Telefon auf die
Werkseinstellungen zurlickzusetzen. Dies stellt sicher; dass nur Sie selbst oder
Personen lhres Vertrauens das Telefon zurlicksetzen konnen.

E « Priifen Sie, ob Sie noch die Anmeldeinformationen Ihres Google-Kontos kennen,
das Sie Ihrem Gerat hinzugefligt haben, bevor Sie es auf die Werkseinstellungen
zurlicksetzen. \Wenn Sie die Kontoinformationen wahrend der Installation
nicht eingeben kénnen, lasst sich das Gerat nach dem Zuriicksetzen auf die
Werkseinstellungen tiberhaupt nicht mehr verwenden

Anhang 160



Information: Hinweis beziiglich Open-
Source-Software

Den Quellcode unter GPL, LGPL, MPL sowie weitere Open-Source-Lizenzen, die
in diesem Produkt enthalten sind, kdnnen Sie unter http7//opensource.lge.com
herunterladen.

Neben dem Quellcode stehen dort alle verwiesenen Lizenzbedingungen,
Garantieausschlisse sowie Urheberrechtshinweise zum Download bereit.

LG Electronics bietet gegen eine kostendeckende Gebiihr (Medium, Versand und
Bearbeitung) den Quellcode auf CD-ROM an. Senden Sie dazu eine Anfrage per
E-Mail an: opensource@lge.com

Dieses Angebot gilt bis drei Jahre nach der letzten Auslieferung des Produkts.
Dieses Angebot gilt fir jeden Empfanger dieser Information.

Informationen zu Bestimmungen (ID-
Nummer der Bestimmung, E-Label etc.)

Einzelheiten zu Bestimmungen finden Sie unter Einstellungen > System >
Regulierungen & Sicherheit.
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Marken

+ Copyright ©2020 LG Electronics Inc. Alle Rechte vorbehalten. LG und das
LG-Logo sind eingetragene Marken der LG Group und ihrer verbundenen
Unternehmen.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Google Photos, Google Play Protect, Google Calendar; Google Docs,
Google Drive, Google Sheets und andere damit zusammenhangende Zeichen
und Logos sind Marken von Google LLC.

- Bluetooth® ist eine eingetragene Marke von Bluetooth SIG, Inc.
- Wi-Fi® und das Wi-Fi-Logo sind eingetragene Marken der Wi-Fi Alliance.
+ Alle anderen Marken und Urheberrechte sind Eigentum der jeweiligen Inhaber.

HE HEVCAdvance”

‘E Covered by Patents at patentlisthevcadvance.com
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Sicherheitshinweise zu Lasern

Achtung!

Dieses Produkt beinhaltet ein Lasersystem. Um den korrekten Umgang mit diesem
Produkt zu gewahrleisten, lesen Sie dieses Benutzerhandbuch aufmerksam durch,
und bewahren Sie es zur spateren Verwendung auf: Sollte das Produkt gewartet
werden mussen, kontaktieren Sie ein autorisiertes Servicezentrum.

Wenn fir die Steuerung, Einstellungen oder bestimmte Vorgange andere Prozesse
verwendet werden als die in diesem Benutzerhandbuch angegebenen, kann dies zu
gesundheitsgefahrdender Strahlenbelastung fithren.

Um sich nicht unmittelbar dem Laserstrahl auszusetzen, versuchen Sie nicht, das
Gehduse zu 6ffnen oder den Laser direkt zu berthren.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

KONFORMITATSERKLARUNG

LG Electronics erklart hiermit, dass das LM-G900EM den wichtigsten
Anforderungen und anderen relevanten Bestimmungen der Richtlinie 2014/53/
EU entspricht.

Eine Kopie der Konformitatserklarung finden Sie unter
http7//wwwi.lg.com/global/declaration
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Kontakt fiir Produktkonformitat

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)
Der Frequenzbereich von 5150 bis 5350 MHz ist auf die Nutzung in Innenraumen
beschrankt.

AT |BE |BG|CH|CY|CZ|DE|DK|EE|EL|ES|FI|FR

QHR HU|IE [ IS|IT|L |LT|LU|LV|MT|NL|NO|PL

PT|RO|SE | SI [ SK|UK|AL|ME|RS [MK]|TR |BA]|XK
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Weitere Informationen

Hartglasteile

Die Hartglasteile dieses Gerats sind nicht fiir Dauer ausgelegt und kénnen im Laufe
der Zeit verschleiRen.

+ Wenn das Gerat auf eine harte Flache fallt oder starken StoRen ausgesetzt
wird, kann das Hartglas beschadigt werden.
In diesem Fall horen Sie bitte sofort auf, das Gerat zu verwenden und
kontaktieren Sie ein LG Servicezentrum.

+ Auf dem Markt sind Schutzhllen fir den Schutz Ihres Gerats erhdltlich.

Beachten Sie, dass diese Schutzhdillen nicht von dem durch LG Electronics

geleisteten Garantieservice abgedeckt sind und eine Sicherheit nicht
gewahrleistet wird.

Seitenverhaltnis
Dieses Gerat verwendet ein Seitenverhaltnis von 20,5:9.

« Einige heruntergeladene Apps unterstitzen das Seitenverhaltnis von 20,5:9
gegebenenfalls nicht.
In diesem Fall kdnnen Sie das fir die App am besten geeignete

Bildschirmformat wahlen oder den Anbieter der App kontaktieren, um weitere
Informationen zu erhalten.
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Anleitung fiir Dateniibertragungen
+ Informationen zu Dateniibertragungen zwischen LG-Gerdten oder einem LG-
Gerat und einem Gerat eines Drittanbieters finden Sie in der folgenden Tabelle.

Android-
LG-Gerat Gerdt eines i0S-Gerat
p Details — Drittanbieters —
LG-Gerat - LG-Gerdt
LG-Gerat
Kontakte, Nachrichten,
Anruflisten, Kalender; O O O
EEeT AR o0rach-Memas
gatel Memos X @)
Wecker X X
Medien- Fotos, Videos, Lieder,
Dateien Dokumente O © o
Homescreen Einstellungen
(Ordner und Widgets) o % X
. Sperrbildschirm-
Qnzele Einstellungen
(Einstellungen fur @) X X
Bildschirmsperre nicht
enthalten)
Heruntergeladene Apps O O
ATE Personliche Daten der ¥ )
heruntergeladenen App o
Offentliches Zertifikat o) e} X
Andere Einstellungen (W\-FL‘
Bluetooth, Anrufe, Tone o N X
& Benachrichtigungen,
Bedienungshilfen, Akku)
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E « Einige Daten kénnen je nach Software-Version, App-Version, Betriebssystem,
Hersteller oder Richtlinie des Netzanbieters nicht tibertragen werden.

Unterstiitzte Frequenzbander Sendeleistung (Tx)
GSM 900 337dBm
GSM 1800 30.7dBm
WB1 247 dBm
W B8 25.5dBm
LTE B1 242 dBm
LTEB3 247 dBm
LTEB7 247 dBm
LTE B8 25.5dBm
LTE B20 255dBm
LTEB28 25.5dBm
LTE B38 252dBm
LTE B40 252 dBm
5G Sub6n1 247 dBm
5G Sub6n3 247 dBm
5G Sub6n28 24.5dBm
5G Sub6n40 252 dBm
5G Sub6n78 227 dBm
BT 2.4GHz 11 dBm
WLAN 2.4GHz 19.5dBm
WLAN 5GHz 19 dBm
NFC - 23 dBuA/m

Informationen zum Reiseadapter finden Sie unter
http//wwwi.lg.com/global/support/cedoc/cedoc
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Entsorgung lhrer Altgerdte

1. Das durchgestrichene Symbol eines fahrbaren Abfallbehalters weist darauf

hin, dass Elektro- und Elektronik-Produkte (WEEE) getrennt vom Hausmiill
entsorgt werden mussen.

2. Alte elektrische Produkte kénnen gefahrliche Substanzen enthalten, die eine

korrekte Entsorgung dieser Altgerate erforderlich machen, um schadliche
Auswirkungen auf die Umwelt und die menschliche Gesundheit zu vermeiden.
Ihre ausgedienten Gerdte kénnen wiederverwendbare Teile enthalten, mit
denen maéglicherweise andere Produkte repariert werden kénnen, aber

auch sonstige wertvolle Materialien enthalten, die zur Schonung knapper
Ressourcen recycelt werden kénnen.

3. Sie kénnen Ihr Gerat entweder in den Laden zurlickbringen, in dem Sie

das Produkt urspriinglich erworben haben, oder Sie kontaktieren Ihre
Gemeindeabfallstelle fir Informationen Uber die nachstgelegene autorisierte
WEEE-Sammelstelle. Die aktuellsten Informationen fur Ihr Land finden Sie
unter wwwi.lg.com/global/recycling

Entsorgen von alten Akkus

Anhang

1. Dieses Symbol kann mit den chemischen Symbolen ftir Quecksilber (Hg),
Kadmium (Cd) oder Blei (Pb) kombiniert sein, wenn die Akkus mehr als
0,0005 % Quecksilber; 0,002 % Kadmium oder 0,004 % Blei enthalten.

2. Akkus mssen immer getrennt vom Hausmiill in staatlichen oder kommunalen
Sammeleinrichtungen und entsprechend den geltenden Vorschriften entsorgt
werden.

3. Durch eine vorschriftsmaRige Entsorgung lhrer alten Akkus konnen schadliche
Auswirkungen auf Mensch, Tier und Umwelt vermieden werden.

4. Ausfuhrliche Informationen zur Entsorgung alter Akkus erhalten Sie bei den
lokalen Behérden, der Entsorgungseinrichtung oder dem Fachhandler; bei dem
Sie das Produkt erworben haben.
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Haufig gestellte Fragen

In diesem Kapitel werden einige Probleme aufgelistet, die bei der Verwendung des
Gerdts auftreten konnen. Bei einigen Problemen mssen Sie lhren Netzanbieter
kontaktieren, die meisten konnen Sie jedoch selbst einfach beheben.

SIM-Kartenfehler

\ergewissern Sie sich, dass die SIM-Karte richtig eingelegt ist.

Keine Netzwerkverbindung oder Verbindung verloren
Das Signal ist schwach. Gehen Sie ans Fenster oder ins Freie.

Sie befinden sich auRerhalb des Netzwerkbereichs Ihres Betreibers. Wechseln Sie
lhren Standort und Uberpriifen Sie das Netzwerk.

Anrufe sind nicht moglich
Neues Netz unzuldssig.

Stellen Sie sicher; dass Sie fur die eingehende Nummer keine Anrufsperre
eingerichtet haben.

Stellen Sie sicher, dass Sie fur die gewahlte Nummer keine Anrufsperre eingerichtet
haben.

Gerat kann nicht eingeschaltet werden
Wenn der Akku vollstandig entladen ist, schaltet sich Ihr Gerat nicht ein.
Laden Sie den Akku vollstandig auf, bevor Sie das Gerat einschalten.

Fehler beim Laden

Stellen Sie sicher; dass das Gerat bei normaler Temperatur geladen wird.
Uberpriifen Sie das Ladegerat und seine Verbindung mit dem Gerat.
Verwenden Sie nur von LG zugelassenes Zubehor.

Der Akkuverbrauch ist hoéher als unmittelbar nach dem Kauf

\Wenn Sie das Gerat oder den Akku sehr kalten oder heiRen Temperaturen
aussetzen, kann sich die Lebensdauer des Akkus verringern.

Der Akkuverbrauch erhoht sich, wenn Sie bestimmte Funktionen oder Apps wie
GPS, Spiele oder das Internet verwenden.

Der Akku ist ein VerschleiRteil und seine Lebensdauer verringert sich mit der Zeit.
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Beim Starten der Kamera erscheinen Fehlermeldungen
Laden Sie den Akku.

Geben Sie Speicherplatz frei, indem Sie Dateien auf einen Computer ibertragen
oder vom Gerat l6schen.

Gerat neu starten.

\Wenn Sie nach Anwendung dieser Tipps immer noch Probleme mit der Kamera-
App haben, wenden Sie sich an das LG Electronics Servicezentrum.

Die Fotoqualitat ist schlecht

Die Qualitat Ihrer Fotos kann sich abhangig von der Umgebung und den
angewendeten Fotografietechniken andern.

Bei der Aufnahme von Fotos und Videos ist die Qualitat im Standardmodus besser
als im Weitwinkelmodus.

\Wenn Sie Fotos in lichtarmer Umgebung, nachts oder in geschlossenen Raumen
aufnehmen, kann es zu Bildrauschen oder unscharfen Bildern kommen.

Setzen Sie die Optionen zurtick, wenn Probleme auftreten.

Der Touchscreen reagiert langsam oder falsch

Wenn Sie eine Schutzfolie oder optionales Zubehor am Touchscreen anbringen,
funktioniert der Touchscreen méglicherweise nicht richtig.

\Wenn Sie Handschuhe tragen, Ihre Hande beim Beriihren des Touchscreens nicht
sauber sind, oder wenn Sie den Bildschirm mit scharfen Gegenstanden oder Ihren
Fingernageln beriihren, funktioniert der Touchscreen méglicherweise nicht.

Feuchte Bedingungen oder der Kontakt mit \Wasser kénnen eine Fehlfunktion des
Touchscreens verursachen.

Starten Sie Ihr Gerat neu, um voriibergehende Softwarefehler zu beseitigen.

\Wenn der Touchscreen zerkratzt oder beschadigt ist, suchen Sie ein LG Electronics
Servicezentrum auf.

Anhang 170



Das Gerdt hangt sich auf oder stiirzt ab

Das Gerat neu starten

+ Wenn Ihr Gerat sich aufhangt oder abstUrzt, missen Sie moglicherweise
Anwendungen schlieRen oder das Gerat ausschalten und neu starten.

Einen Boot-Vorgang durchfiihren
+ Ein Warmstart Ihres Gerats kann durchgefthrt werden, wenn der Bildschirm
einfriert oder die Tasten, der Touchscreen oder das Gerat nicht mehr reagieren.
» Um bei lhrem Gerat einen Warmstart durchzufthren, halten Sie einfach die
Leisertaste und die Ein-/Austaste gedrlckt, bis das Gerat neu startet.

E « Diese Funktion steht nicht zur Verfligung, wenn das Gerat mit dem LG Dual
Bildschirm (LM-G905N) verbunden ist.

Das Gerat zuriicksetzen
+ Sollten die oben genannten Methoden das Problem nicht l&sen, stellen Sie lhr

Gerat auf den Werkszustand zuriick.

« Tippen Sie im Einstellungsbildschirm auf System > Neu starten &
zuriicksetzen > Auf Werkszustand zuriick.

- Alle Einstellungen des Gerats werden zuriickgesetzt und Daten werden
geloscht. Bevor Sie auf die Werkseinstellungen zuriicksetzen, sollten Sie
Sicherungskopien aller wichtigen Daten auf dem Gerat erstellen.

- Wenn Sie sich mit einem Google-Konto auf dem Gerat registriert haben,
mussen Sie sich nach dem Zurlicksetzen mit demselben Google-Konto
wieder anmelden.
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Kein Bluetooth-Gerat gefunden
Stellen Sie sicher, dass die Bluetooth-Funktion auf lhrem Gerat aktiviert ist.

Stellen Sie sicher, dass die Bluetooth-Funktion auf dem Gerat, mit dem Sie eine
Verbindung herstellen méchten, aktiviert ist.

Achten Sie darauf, dass zwischen lhrem Gerat und dem anderen Bluetooth-Gerat
der Abstand nicht gréRer als die maximale Bluetooth-Reichweite (10 m) ist.

\Wenn Sie lhr Problem mithilfe der obigen Tipps nicht l6sen kdnnen, wenden Sie sich
an ein LG Electronics Servicezentrum.

Beim AnschlieRen des Geréts an einen Computer wird keine
Verbindung hergestellt
Stellen Sie sicher; dass das verwendete USB-Kabel mit lhrem Gerat kompatibel ist.

Stellen Sie sicher, dass Sie den richtigen Treiber auf lhrem Computer installiert und
aktualisiert haben.

Eine heruntergeladene Anwendung verursacht eine Reihe von
Fehlern

Es gibt Probleme mit der App.

Entfernen Sie die Anwendung und installieren Sie sie erneut.
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LG Dual Bildschirm
(LM-G905N)



LG Dual Bildschirm kennen lernen

Sie kénnen einen LG Dual Bildschirm an dieses Produkt anschlieRen.

E « Sie konnen den LG Dual Bildschirm (nachfolgend als "Dual Bildschirm" bezeichnet)
an ein dediziertes LG VELVET (nachfolgend als "Telefon" bezeichnet) anschlieRen,
um das Produkt zu benutzen.

+ Je nach Leistungsvermdgen des dedizierten Telefons kénnen einige Funktionen
des Dual Bildschirms eingeschrankt sein. Auch werden andere Mobilgerdte
maoglicherweise nicht vom Produkt unterstiitzt.

Dieses Produkt ist nicht wasserdicht. Setzen Sie das Telefon keinen Fliissigkeiten
und keiner Feuchtigkeit aus.

« Falls das Gerdt nass ist, wechselt das LDl innerhalb des Gerats die Farbe. In
diesem Fall kann das Gerat nicht mehr unter Geltendmachung der begrenzten
Gerategarantie kostenlos repariert werden.

Richtlinien fiir den sicheren und
effizienten Gebrauch

Lesen Sie diese einfachen Richtlinien sorgfaltig durch. Die Nichtbeachtung dieser Richtlinien
kann gefahrlich oder gesetzeswidrig sein.

Pflege und Wartung des Telefons

+ Verwenden Sie nur von LG zugelassenes Zubehor. LG Gibernimmt keine Haftung fir
Schaden oder Fehler; die durch Zubehor von Drittanbietern verursacht werden.

+ Einige Inhalte und Abbildungen weichen méglicherweise von Ihrem Gerat ab und
unterliegen Anderungen ohne Vorankindigung.

- Offnen Sie dieses Mobiltelefon nicht. Sollten Reparaturen erforderlich sein, wenden Sie sich
an einen qualifizierten Kundendienstmitarbeiter.

LG ist berechtigt, bei Reparaturen im Rahmen der Garantie neue oder Uberholte Ersatzteile
oder Platinen zu verwenden, sofern diese tiber den gleichen Funktionsumfang verfligen wie
die zu ersetzenden Teile.

Benutzen Sie dieses Mobiltelefon nicht in der Nahe elektrischer Gerate (z. B. Fernsehgerate,
Radios, PCs).

+ Halten Sie das Telefon von Warmequellen wie Heizungen oder Herdplatten fern.

+ Lassen Sie das Telefon nicht fallen.
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+ Setzen Sie das Telefon keinen starken Erschiitterungen oder St6Ren aus.

+ Schalten Sie das Gerat aus, wenn dies aufgrund von jeweils geltenden Bestimmungen
erforderlich ist. Verwenden Sie Ihr Gerat beispielsweise nicht in Krankenhausern, da sonst
die Funktionalitdt empfindlicher medizinischer Gerate beeintrachtigt werden kann.

Fassen Sie das Gerat wahrend des Ladevorgangs nicht mit nassen Handen an. Es besteht
sonst Stromschlaggefahr, auch kann das Gerat schwer beschadigt werden.

Reinigen Sie das Gerat auRen mit einem trockenen Tuch (verwenden Sie keine
Lésungsmittel wie Benzin, Verdinner oder Alkohol).

Bewahren Sie das Telefon nicht in sehr verrauchten oder staubigen Umgebungen auf:

Bewahren Sie das Gerat nicht in der Nahe von Gegenstanden mit Magnetstreifen
(Kreditkarten, Flugtickets usw.) auf, da andernfalls die auf dem Magnetstreifen
gespeicherten Informationen beschadigt werden konnten.

Beriihren Sie das Display nicht mit spitzen oder scharfen Gegenstanden; andernfalls kann
das Gerdt beschadigt werden.

+ Setzen Sie das Gerat keiner Feuchtigkeit oder Nasse aus.

Bertihren, entfernen oder reparieren Sie nicht zerbrochenes oder gesprungenes
Glas. Schaden am Glas-Display aufgrund von Missbrauch fallen nicht unter die
Garantiebedingungen.

Dies ist ein elektronisches Gerat, das sich bei normalem Betrieb erhitzt. Besteht
anhaltender, direkter Hautkontakt ohne angemessene Beltiftung, kann es zu Beschwerden
oder leichten Verbrennungen kommen. Gehen Sie daher wahrend und direkt nach dem
Betrieb vorsichtig mit Ihrem Gerat um.

Falls Ihr Gerat nass wird, missen Sie es sofort vom Netz trennen und vollstandig trocknen
lassen. Versuchen Sie nicht, das Trocknen mit einer externen Heizquelle, wie Ofen,
Mikrowelle oder Haartrockner; zu beschleunigen.

Die Flussigkeit in lhrem nassen Gerat andert die Farbe der Produktkennzeichnung in lhrem
Gerat. Gerateschaden, der aufgrund des Eindringens von Fliissigkeiten entsteht, fallt nicht
unter die Garantiebedingungen.

Ein Mobilgerat erfordert hinreichende Luftzirkulation, damit Hitze abgefuihrt werden kann.
Bei direktem Hautkontakt oder bei nicht angemessener Luftzirkulation zum Gerat kann
dieses zu heiR werden. Zwischen Gerat und Korper des Benutzers muss mindestens ein
Abstand von 1,0 cm vorhanden sein.

+ Achten Sie darauf, dass das Produkt nicht mit Flissigkeiten in Beriihrung kommt.
Verwenden oder laden Sie das Produkt nicht, wenn es nass ist. Sobald das Produkt nass
wird, andert der Indikator fur Feuchtigkeitsschaden die Farbe. Beachten Sie, dass kostenlose
Reparaturen im Rahmen der Garantie damit ausgeschlossen sind.
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Effizienter Betrieb des Gerats

Elektronische Gerate
Bei jedem Gerat kann es zu Interferenzen kommen, die die Leistung beeintrachtigen konnen.

+ Verwenden Sie das Gerat nicht ohne ausdrtickliche Erlaubnis in der Nahe medizinischer
Gerate. Bitte besprechen Sie mit Ihrem Arzt, ob die Verwendung des Gerats Stérungen
Ihres medizinischen Gerdts verursachen kann.

+ Hersteller von Herzschrittmachern empfehlen, dass ein Mindestabstand von 15 cm
zwischen anderen Geraten und einem Herzschrittmacher eingehalten wird, um mégliche
Storungen zu vermeiden.

+ Einige Horhilfen kdnnen durch das Gerat beeintrachtigt werden.
+ Bei Fernsehgeraten, Radios, PCs usw. kdnnen ebenfalls leichte Interferenzen auftreten.

+ Verwenden Sie lhr Gerat nach Méglichkeit nur bei Temperaturen zwischen O °C und
35 °C. Die Verwendung bei besonders niedrigen oder hohen Temperaturen kann zu
Beschadigungen, Fehlfunktionen oder sogar zu einer Explosion fihren.

Sicherheit im StraRenverkehr

Erkundigen Sie sich tber die jeweils geltenden Gesetze und Bestimmungen zur Verwendung
von Geraten in Fahrzeugen.

+ Benutzen Sie kein Handheld-Gerat, wenn Sie wahrend der Fahrt am Steuer sitzen.

Richten Sie Ihre ganze Aufmerksamkeit auf den StraRenverkehr:

Parken Sie ggf. zuerst das Fahrzeug, bevor Sie Anrufe tatigen oder entgegennehmen.

+ Elektromagnetische Strahlen kénnen uU. elektronische Systeme in Ihrem Fahrzeug stéren,
wie beispielsweise das Autoradio oder Sicherheitssysteme.

Falls Ihr Fahrzeug mit einem Airbag ausgestattet ist, achten Sie darauf, das Telefon nicht auf
bzw. vor dem Airbag abzulegen und die Freisprecheinrichtung nicht in der Nahe des Airbags
zu installieren. Andernfalls kann die Funktionsweise des Airbags beeintrachtigt werden, was
zu schweren Verletzungen fihren kann.

+ Wenn Sie Musik horen, wahrend Sie unterwegs sind, stellen Sie sicher, dass die Lautstarke
auf ein angemessenes MaR eingestellt ist, sodass Sie Ihre Umgebung wahrnehmen. Dies ist
vor allem dann wichtig, wenn Sie sich in der Nahe einer Strae befinden.
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Glasteile

Einige Teile Ihres Gerats bestehen aus Glas. Dieses Glas kann brechen, wenn Ihr Gerat auf eine
harte Oberflache fallt oder einem harten Stof ausgesetzt wird. Sollte das Glas zerbrechen,
berthren Sie es nicht und versuchen Sie nicht, es zu entfernen. Verwenden Sie das Gerat erst
wieder, wenn das Glas von einem autorisierten Handler ersetzt wurde.

Sprenggebiete

Benutzen Sie das Telefon nicht in Sprenggebieten. Beachten Sie die Einschrankungen und
befolgen Sie alle geltenden Vorschriften und Regeln.

Explosmnsgefahrdete Orte
Verwenden Sie das Gerat nicht an Tankstellen.

+ Verwenden Sie das Telefon nicht in der Nahe von Kraftstoffen oder Chemikalien.

Transportieren und lagern Sie keine brennbaren Fliissigkeiten, Gase oder Explosivstoffe im
selben Fach oder Raum lhres Fahrzeugs, in dem sich auch Ihr Gerat oder Geratezubehor
befindet.

Kinder

Bewahren Sie das Gerat an einem sicheren Ort auRerhalb der Reichweite von Kleinkindern auf.
Es enthalt Kleinteile, die verschluckt oder eingeatmet werden kdnnten.
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Geratekomponenten und Zubehor

Folgende Elemente sind im Lieferumfang dieses Produkts enthalten.

+ Produkt + Schnellstarthandbuch
+ Ladeadapter

A « Achten Sie darauf, das Originalzubehor von LG Electronics zu verwenden.
Bei Benutzung von Nicht-Originalzubehdr kann es zu Qualitatseinbulen bei
Telefonaten oder zu Stérungen beim Gerat kommen usw. In diesem Fall erhalten
Sie méglicherweise keine Serviceleistungen von LG Electronics.

Einige Teile des Dual Bildschirms bestehen aus Hartglas. Wenn das Gerat auf
eine harte Flache fallt oder starken StéRen ausgesetzt wird, kann das Hartglas
beschadigt werden. In diesem Fall héren Sie bitte sofort auf, das Gerat zu
verwenden, und kontaktieren Sie ein LG Servicezentrum.

E « Aussehen und Spezifikationen des Produkts kénnen ohne Vorankiindigung
geandert werden.

+ Um die Leistungen zu verbessern, kénnen das AuRere des Produkts sowie dessen
Spezifikationen ohne Vorankiindigung geandert werden.
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Teiletibersicht

Vorderseite
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@ Cover Display © Produkt-Bildschirm
. Anschluss fiir Kommunikation /
@ Lautstarketasten Stromzufuhr
© Google-Assistant-Taste @ Federkontaktanschluss
9

@ Aussparung fiir den Ohrhorer

E + Dieses Handbuch ist fiir Benutzer, die ein Telefon an diesen Dual Bildschirm
anschlieRen wollen. Weitere Information zur Verwendung des Dual Bildschirms
und des Telefons finden Sie im entsprechenden ausfiihrlichen Benutzerhandbuch
unter www.g.com.
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Das Telefon am Dual Bildschirm
anschlieRen

1 Klappen Sie den Dual Bildschirm vollstandig auf, sodass er parallel zu einer
ebenen Flache ist.

7 Schieben Sie das untere Ende Ihres Telefons in das untere Teil des Dual
Bildschirms - siehe Abbildung. Achten Sie dabei darauf, dass sich die
Komponente o des Telefons korrekt in die Komponente 0 des Dual
Bildschirms einflgt.
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3 Driicken Sie den Bereich n des Telefons mit dem Finger nach unten, sodass
die Ecke des Telefons in der Ecke des Dual Bildschirms einrastet.

u@‘\L

R

A Driicken Sie auf den Bereich e des Telefons, sodass es vollstandig in den Dual

Bildschirm einrastet.
))/@{

o

2~

7/ \
oA

A « Stellen Sie vor der Verwendung sicher, dass Ihr Telefon vollstandig in den Dual
Bildschirm eingesetzt ist.
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Das Telefon vom Dual Bildschirm
losen

1 Klappen Sie den Dual Bildschirm vollstandig auf und halten Sie ihn mit beiden
Handen fest - siehe Abbildung.

2 Driicken Sie mit dem Finger gegen den Bereich o des Dual Bildschirms,
wahrend Sie gleichzeitig mit den anderen Fingern gegen die Rickseite des
Telefons driicken, um so die Ecke des Telefons vom Dual Bildschirm zu l6sen.
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3 Lésen Sie den Bereich 0 des Telefons auf die gleiche \Weise aus dem Dual
Bildschirm wie im vorigen Schritt.

(4
O

=——

/I Halten Sie den Dual Bildschirm mit beiden Handen fest und schieben Sie das
Telefon in Pfeilrichtung, um es herauszunehmen. Achten Sie darauf, dass Sie
das Telefon nicht nach links oder rechts verdrehen bzw. in einem tibermaRigen
Winkel nach oben anheben.

/\ VORSICHT:
+ Heben Sie das Telefon nicht in einem tibermaRigen Winkel vom Produkt an - siehe unten.
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LG Dual Bildschirm (LM-G905N)

Wenn Sie das Telefon in einem ibermaRigen Winkel oder mit (ibermaRiger
Kraftanwendung vom Dual Bildschirm trennen, kénnte unten am Dual Bildschirm
der Anschluss fiir die Stromzufuhr / Kommunikation oder am Telefon der USB-
Anschluss zur Datentibertragung und fir das Ladegerat beschadigt werden.
Achten Sie darauf, dass Sie das Telefon, wie in der Abbildung dargestellt, in die
Pfeilrichtung schieben, um es aus dem Produkt zu [6sen.

Achten Sie beim Einsetzen oder Herausnehmen des Telefons darauf, dass Sie den
Dual Bildschirm oder das Telefon nicht fallen lassen.

Beim Einsetzen und Herausziehen des Telefons in den Dual Bildschirm bzw. aus
diesem heraus vorsichtig vorgehen und nicht zu viel Kraft anwenden. Dadurch
kénnte dieser beschadigt werden.

Einige Teile des Dual Bildschirms bestehen aus Hartglas. Fallt der Dual Bildschirm
auf eine harte Oberflache oder wird er einem starken StoR ausgesetzt, kann
das gehartete Glas brechen und der Dual Bildschirm kénnte beschadigt werden,
was auch zu Verletzungen fihren kann. Falls dieser Fall eintritt, stellen Sie
sofort die Benutzung des Dual Bildschirms ein und wenden Sie sich an ein LG-
Kundenzentrum, um das Gerat reparieren zu lassen.

In folgenden Situationen wird méglicherweise der Dual Bildschirm nicht
vollstandig geschlossen oder der Dual Bildschirm arbeitet aufgrund fehlerhafter
Kommunikation oder einer gestorten Stromzufuhr nicht normal.

\Wenn Sie auf den Dual Bildschirm oder auf den Bildschirm des Telefons eine
Schutzfolie oder ein Schutzglas oder anderes Zubehdr anbringen

\Wenn Sie Uber den Bereich der Dual Bildschirm-Anschlisse oder auf der
Ruickseite des Telefons eine Schutzfolie oder ein starkes Etikett aufkleben

Wenn Sie zwischen Dual Bildschirm und lhrem Telefon ein Blatt Papier oder eine
Karte einfligen

Wenn Sie drahtlos aufladen oder die NFC-Funktion benutzen, wahrend lhr

Telefon in den Dual Bildschirm eingesetzt ist, erfolgt méglicherweise keine
ordnungsgemaRe Aufladung.

Wenn Ihr Telefon im Dual Bildschirm eingesetzt ist, kann es nicht per HDMI-Kabel
ans TV-Gerat angeschlossen werden. Wenn Ihr Telefon vom Dual Bildschirm gelést
worden ist, kann es per HDMI-Kabel ans TV-Gerat angeschlossen werden.
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Ladeadapter verwenden
Wahrend |hr Telefon im Dual Bildschirm eingesetzt ist, kann der Ladeanschluss zum

Aufladen des Telefons oder zur Datenlbertragung genutzt werden.

1 Wenn das Telefon im Dual Bildschirm eingesetzt ist, kdnnen Sie den
Ladeadapter unten am Dual Bildschirm an den Ladeanschluss anschlieen -

siehe Abbildung unten.

J

E « Federkontakte funktionieren nur dann, wenn sie in korrekter Richtung eingesteckt
sind.
+ Der USB-Anschluss tiber Federkontakt unterstitzt nicht OTG, Audio, HDMI und
USB 3.0. SchlieRen Sie hierfir das Kabel direkt am entsprechenden Anschluss des
Telefons an, nachdem Sie dieses vom Dual Bildschirm getrennt haben.

LG Dual Bildschirm (LM-G905N) 185



2 SchlieRen Sie ein USB-Kabel des Typs C an.
« Jetzt kdnnen Sie das Telefon aufladen oder Daten tbertragen.

5

LG Dual Bildschirm (LM-G905N)

",

Ladekabelanschluss >

Wenn der Ladeadapter nicht benutzt wird, trennen Sie das Ladegerat vom

Netz und bewahren Sie ihn getrennt vom Ladekabelanschluss auf. Da der
magnetische Teil des Ladeadapters mit in der Nahe befindlichen metallischen oder
leitenden Gegenstanden in Kontakt kommen kann, kénnte er durch Stromschlag
zerbrechen, verbrennen oder beschadigt werden.

Achten Sie darauf, nur den im Lieferumfang des Dual Bildschirms enthaltenen
Ladeadapter zu verwenden. Wenn Sie den Ladeadapter verloren haben oder
einen neuen erwerben mochten, wenden Sie sich an ein Kundenzentrum von LG
Electronics.

Der Ladeadapter und der Ladeanschluss unten am Dual Bildschirm werden
magnetisch miteinander verbunden. Riitteln Sie wahrend der Verwendung nicht
am Ladeadapter; und ziehen Sie ihn nicht ab.
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Den Dual Bildschirm verwenden

Mit der Google-Assistant-Taste ein Telefonat

annehmen und beenden

Mit dem Dual Bildschirm und angeschlossenem Telefon kénnen Sie einen Anruf
annehmen, indem Sie ein Mal auf die Google-Assistant-Taste drticken. Um das
Gesprach zu beenden, driicken Sie zwei Mal auf die Google-Assistant-Taste.
+ Nur wenn die Abdeckung des Dual Bildschirms vollstandig geschlossen ist, ist
es maglich, mit der Google-Assistant-Taste Telefonate anzunehmen und zu
beenden.

« Achten Sie darauf, dass das Produkt und das Telefon mindestens einmal durch
eine Synchronisierung verbunden wurden.

Telefonieren

Um ein Telefongesprach zu fithren, kénnen Sie den Dual Bildschirm auf 360°
aufklappen oder ihn zugeklappt lassen (0°).

+ Wenn Sie den Dual Bildschirm auf 360° aufklappen, dann achten Sie darauf,
dass Vorder- und Riickseite des Dual Bildschirms vollstandig in Kontakt sind. In
diesem Fall wird der Dual Bildschirm automatisch ausgeschaltet, um Strom zu
sparen.
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Den Dual Bildschirm verwenden
Dual Bildschirm aufklappen, sodass sich die beiden Bildschirme nebeneinander

befinden.
/ B

Produkt-Bildschirm — 77— o——— Telefon-Bildschirm

[

Bildschirmfarbe anpassen

Bei gleichzeitiger Verwendung von Produkt- und Telefon-Bildschirm kann zwischen
den beiden Bildschirmen ein Unterschied in der Farbdarstellung auftreten.

+ Versuchen Sie dann, die Farbtemperatur anzupassen. Tippen Sie auf dem
Homescreen auf Einstellungen > Anzeige > Farben des Bildschirms, passen
Sie dann die Farbtemperatur an.

+Je nach Sichtwinkel kdnnen die Farben anders wirken. Passen Sie die Farben
also nur an, wenn das Produkt vollstandig aufgeklappt ist.

Homescreen des Dual Bildschirms verwenden

Homescreen des Dual Bildschirms kennen lernen
Der Homescreen des Dual Bildschirms kann unabhangig vom Bildschirm des
Produkts bedient werden.

« Er bietet Schnellstart-Symbole und eine Navigationsleiste.

+ Sie kénnen den Hintergrund wechseln und Widgets einrichten.

+ Auf dem Homescreen kénnen auch verschiedene Apps aus dem App-Menu
ausgefihrt und es kénnen Ordner angelegt oder geléscht werden.
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Layout des Homescreen des Dual Bildschirms kennen lernen

Uber die Symbole auf dem Homescreen kénnen verschiedene Funktionen aktiviert
werden.

*— Schnellzugriffsbereich

Navigationsleiste

E « Je nach Herstellerrichtlinien, Benutzereinstellungen, Softwareversion und Diensten
des Telekommunikationsdienstanbieters usw. kann sich der Hintergrund des Dual
Bildschirms von der Abbildung unterscheiden.

+ Schnellzugriffbereich: Sie konnen wichtige Apps am unteren Bildschirmrand
fixieren, um von jeder beliebigen Seite des Homescreens darauf zuzugreifen.

- Navigationsleiste: Sie konnen durch Gesten zum Homescreen, zum vorigen
Bildschirm, zum Ubersichtsbildschirm oder schnell zwischen Apps wechseln.
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Das Bedienungsfeld des Dual Bildschirms verwenden

Sie konnen das Bedienfeld des Dual Bildschirms 6ffnen, indem Sie den oberen
Bildschirmbereich nach unten ziehen.

+ Auf dem Bedienfeld des Dual Bildschirms kénnen Sie die Bildschirmhelligkeit

einstellen.

- Wenn Sie durch Auswahl von Synchr. die Synchronisierung aktivieren, wird
die Bildschirmhelligkeit des Dual Bildschirms mit der des angeschlossenen
Mobiltelefons synchronisiert.

« Um den Inhalt des Produkt-Bildschirms zu erfassen, kénnen Sie auf

Screenshots tippen.

« Sie konnen den Produkt-Bildschirm ausschalten, indem Sie auf Dual Bildschirm

tippen.
- Der Dual Bildschirm

und das angeschlossene Telefon werden getrennt.

- Umins Einstellungsment des Dual Bildschirms zu gelangen, tippen Sie auf (.

! «— Dual
Bildschirmhelligkeit T———1 Bildschirm-Einstellungen
Screenshot ——— T Dual Bildschirm
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Homescreen des Dual Bildschirms andern
Einen leeren Bereich auf dem Dual Bildschirm-Homescreen gedriickt halten und die
gewUnschte Funktion ausfihren.
+ Um ein Widget zum Homescreen hinzuzuftigen, bertihren und halten Sie eine
freie Stelle auf dem Homescreen und wahlen Sie Widgets.
+ Um den Hintergrund zu andern, bertihren und halten Sie eine freie Stelle auf
dem Homescreen und wahlen dann Hintergrundbilder.
+Um den Standardbildschirm zu andern, bertihren und halten Sie eine freie Stelle
auf dem Homescreen, gehen Sie zum gewtinschten Bildschirm, tippen Sie auf
) und tippen Sie erneut auf den Bildschirm.

Standardbildschirm

Widgets ! L Hintergriinde
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Hintergrund des Dual Bildschirms anzeigen
Um nur das Hintergrundbild anzuzeigen blenden Sie Apps und Widgets aus.
Ziehen Sie zwei Finger auf dem Homescreen auseinander.

+ Ziehen Sie zwei Finger auf dem Homescreen zusammen, um zum
ursprunglichen Bildschirm mit angezeigten Apps und Widgets zurtickzukehren.
Sie konnen auch auf <] tippen.

Bedienungsumgebung des Dual Bildschirms festlegen
Sie kénnen die Umgebung des Dual Bildschirms tber das Telefon einstellen, das mit
dem Dual Bildschirm verbunden ist.

7 Tippen Sie auf dem Homescreen auf Einstellungen > Anzeige > Dual
Bildschirm.

E + Um das Men zur Einstellung der Umgebung des Dual Bildschirms angezeigt zu
bekommen, muss das Telefon am Dual Bildschirm angeschlossen sein
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2 Dann kénnen Sie bei den gewtinschten Funktionen Einstellungen durchfiihren.

- Cover Display: Sie konnen festlegen, ob Sie auf der Vorderseite des Dual

Bildschirms das Cover Display verwenden wollen.

- Displayabschaltung / Tagliche Auszeit: Sie konnen festlegen, ob beide
Bildschirme gleichzeitig benutzt werden sollen.

+ Dual Bildschirm Werkzeug: \Wenn Sie lhr Telefon am Dual Bildschirm

anschlieRen, werden auf dem Bildschirm die Werkzeuge fiir den Dual
Bildschirm angezeigt. Die Helligkeitsstufe wird mit der des Dual Bildschirms
synchronisiert.

+ Dual Bildschirm verwenden: Sie konnen den Dual Bildschirm ein- und

ausschalten und zwischen dem Dual Bildschirm und dem Telefon-Bildschirm

den Bildschirminhalt wechseln.

- Zuriickklappen: Sie konnen festlegen, wie der Bildschirm sich verhalt,
wenn der Dual Bildschirm zurtickgeklappt wird.

« Helligkeit: Sie konnen die Helligkeit des Bildschirms anpassen, indem Sie den

Schieberegler nach links oder rechts ziehen.

- Gleicher Wert des Hauptbildschirms: Sie kénnen die Helligkeit mit der
des verbundenen Telefons synchronisieren.

+ Wide view: Sie kénnen eine App so einstellen, dass sie erweitert Uber beide

Bildschirm angezeigt wird.

+ Hintergrund: Sie kénnen flir den Homescreen den Hintergrund auswahlen.

+ App Menii Symbole: Sie konnen das App-Ment auf Ihrem Produkt anzeigen

oder ausblenden.

+ Multi App Shortcut: Sie kdnnen festlegen, dass zwei Apps gleichzeitig

ausgeflhrt werden, wobei eine am Hauptbildschirm und die andere am Dual
Bildschirm angezeigt wird.

+ My Pick App:Sie kénnen Apps auswahlen, die jedes Mal automatisch

5

ausgeflhrt werden, wenn Sie den Dual Bildschirm einschalten.

- Die Liste der Apps, die auf dem Bildschirm erscheinen, kann sich je nach
installierten Apps unterscheiden
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Dual Bildschirm-Werkzeug

Wenn Sie Ihr Telefon am Dual Bildschirm anschlieRen und den Dual Bildschirm
einschalten, wird auf dem Bildschirm des Telefons an der Seite das !\/Ienljsymbolg
Dual Bildschirm-Werkzeug angezeigt.

Um das Menu Dual Bildschirm-Werkzeug zu 6ffnen, aufa tippen, um dann eine
der unten gezeigten Optionen auszuwahlen.

)@

Durch leichtes Antippen des Menusymbols fir das Dual Bildschirm-\Werkzeug
wird das Mend ein- oder ausgeblendet.

©

Sie konnen die Bildschirminhalte des Dual Bildschirms und des Telefon-
Bildschirms untereinander wechseln.

)

Sie kénnen den Bildschirminhalt des Telefons zum Dual Bildschirm verschieben.

®

Sie konnen den Bildschirminhalt vom Dual Bildschirm zum Telefon verschieben.

Wenn Sie nur den Dual Bildschirm verwenden, konnen Sie den Bildschirm des
Telefons (Hauptbildschirm) abdunkeln, um Akku-Energie zu sparen. Um diese
Funktion zu beenden, wischen Sie tiber den Hauptbildschirm.

Sie konnen den Dual Bildschirm ausschalten.

B

*—— Dual Bildschirm
Werkzeug
*— Bildschirme wechseln

*—— Hauptbildschirm am Dual

Bildschirm anzeigen

*—— Dual Bildschirm am

Hauptbildschirm anzeigen

*—— Hauptbildschirm in den
Ruhezustand versetzen

*—— Dual Bildschirm

\_/ ausschalten
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E + Wenn Sie das Telefon ausschalten, wird auch der Dual Bildschirm ausgeschaltet.
Wenn Sie jedoch nur den Dual Bildschirm ausschalten, bleibt das Telefon
eingeschaltet.

« Diese Funktion steht auf dem Sperrbildschirm nicht zur Verfiigung. Sie wird
aktiviert, wenn Sie den Bildschirm entsperren.

Den Mehrseiten-Modus verwenden

Fur eine angenehmere Nutzung konnen Sie die Verwendung einer App vom
Hauptbildschirm auf den Dual Bildschirm ausdehnen.

5 « Diese Funktion steht in den Apps Kamera und Galerie sowie in Partner-Apps zur

Verfiigung.

« Je nach benutzter App kann die Benutzeroberflache unterschiedlich sein.
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Bei der Kamera den Mehrseiten-Modus benutzen

Sie kénnen den Bildschirm des Telefons oder den Dual Bildschirm verwenden,
um ein Foto oder ein Video aufzunehmen, und Sie kdnnen den jeweils anderen
Bildschirm benutzen, um das Ergebnis zu betrachten.

1 Tippen Sie am Homescreen des Telefon-Bildschirms oder des Dual Bildschirms
auf (&) und nehmen Sie ein Foto oder Video auf.
2 Tippen Sie nach der Aufnahme des Fotos oder Videos auf das Vorschausymbol.

+ Dann kénnen Sie auf dem anderen Bildschirm, der nicht die Kamera zeigt,
das aufgenommene Foto oder Video ansehen.

l

|
Vorschausymbol

E « Sobald Sie auf das Vorschausymbol getippt haben, um das Foto oder Video zu
sehen, bleibt der Vorschau-Bildschirm eingeschaltet und zeigt automatisch das
letzte aufgenommene Foto oder Video, sofern Sie mehrere Fotos oder Videos
aufgenommen haben.

- Diese Funktion bleibt aktiv, bis die Kamera-App geschlossen wird
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In der Galerie den Mehrseiten-Modus benutzen

Um auf dem gegenuberliegenden Bildschirm das vergroRerte Bild oder Video zu
sehen, tippen Sie in einem Ordner der Galerie am Dual Bildschirm oder am Telefon

auf(d(]

1 Tippen Sie auf dem Telefon-Bildschirm oder auf dem Dual Bildschirm auf dem
Homescreen auf (3.

2 Wahlen Sie einen Alben-Ordner und tippen Sie dann auf [¢J(J.

+ Das Foto oder Video wird in der erweiterten Ansicht auf dem
gegenUberliegenden Bildschirm angezeigt.

+ Um die Funktion zu beenden, auf 5] ] tippen.

Erweiterungssymbol Symbol zum Beenden

l
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Dual Bildschirm-App verwenden
Jedes Mal, wenn Sie den Dual Bildschirm einschalten, wird automatisch die
vorgegebene Dual Bildschirm-App ausgefiihrt.

7 Tippen Sie auf dem Homescreen auf Einstellungen > Anzeige > Dual
Bildschirm > My Pick App.

2 Wihlen Sie die Apps aus, die jedes Mal automatisch ausgefiihrt werden sollen,
wenn Sie den Dual Bildschirm einschalten.

E - Einige Apps konnen nicht als Dual Bildschirm-Apps ausgefiihrt werden.

« Die Liste der Apps, die auf dem Bildschirm erscheinen, kann sich je nach
installierten Apps unterscheiden

Mit Hilfe des Dual Bildschirms ein Videotelefonat

fiihren
Dabei wird Ihr eigenes Bild auf dem Dual Bildschirm angezeigt und das Bild des
Gesprachspartners auf dem Telefon-Bildschirm.

- Starten Sie das Videotelefonat mit lhrem Telefon.

- Auf dem Bildschirm des Telefons wird das Bild Ihres Gesprachspartners
angezeigt, und in der Ecke unten rechts auf dem Telefon-Bildschirm wird Ihr
eigenes Bild angezeigt.

+ Damit Ihr eigenes Bild auf dem Dual Bildschirm angezeigt wird, tippen Sie oben
auf dem Telefon-Bildschirm auf [§¢]

- Wenn Sie erneut auf (3] tippen, kehren Sie zur vorigen Anzeigeart zurtick.

E « Der Titel oben und die Schaltflache unten erscheinen gleichzeitig und werden nach
4 Sekunden wieder ausgeblendet.

« Wahrend Sie mit dem Telefon Videotelefonate fiihren, konnen Sie auf den Dual
Bildschirm andere Apps oder Funktionen nutzen.
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Beim Dual Bildschirm zwischen App-Bildschirmen

wechseln
Sie kdnnen mit drei Fingern iber den Bildschirm wischen, um so den Bildschirm
einer App zwischen Dual Bildschirm und Telefon zu verschieben.

+ Indem Sie mit drei Fingern nach links oder rechts tber den App-Bildschirm
wischen, kénnen Sie ihn frei zwischen Hauptbildschirm und Dual Bildschirm

verschieben.

|
E» )

o\

Mit drei Fingern Gber den App-Bildschirm Den App-Bildschirm zum Hauptbildschirm
wischen verschieben
MI .
Mit drei Fingern Gber den App-Bildschirm Den App-Bildschirm zum Dual Bildschirm
wischen verschieben
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5 « Damit diese Funktion greift, muss der Bildschirm von drei Fingern gleichzeitig
beriihrt werden.

Dual-Tastatur am Dual Bildschirm verwenden

\Wenn Sie die Tastatur im Querformat benutzen, konnen Sie die Tastaturansicht
erweitern, sodass der obere Bildschirm als App-Bildschirm benutzt wird und der
untere Bildschirm zur Anzeige der Tastatur.

1 Wechseln Sie im Tastatur-Eingabebildschirm den Dual Bildschirm in das
Querformat.
7 Tippen Sie im Tastatur-Eingabebildschirm des Dual Bildschirms auf &3

« Sie kénnen im unteren Bildschirm Ihre Tastatureingaben machen, wahrend
Sie auf dem oberen Bildschirm das Geschriebene sehen.

+ Um die Tastatur in ihre urspriingliche Position zu bringen, im erweiterten
Status auf F3 tippen.

Dual Tastatur

5 «Um den App-Bildschirm nach unten oder oben zu bringen, den Bildschirm
gleichzeitig mit drei Fingern bertihren und nach oben oder unten verschieben
Details siehe unter Beim Dual Bildschirm zwischen App-Bildschirmen wechseln .
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Dual Bildschirm fiir Spiegelmodus verwenden

\Wenn Sie mit der Kamera Bilder aufnehmen, konnen Sie die Vorschau auch am Dual
Bildschirm sehen.

1 Tippen Sie auf dem Homescreen auf (&).

2 Tippen Sie oben im Kamera-Bildschirm auf [Ji].
« Auf dem Dual Bildschirm wird der Spiegelmodus angezeigt.

Dual-Spiegelmodus

rl

o\

E « Sie kénnen auch direkt vom Dual Bildschirm aus Fotos machen oder Videos
aufnehmen.

Sie kénnen den Dual Bildschirm verwenden, um den Winkel je nach Situation
wunschgemaR anzupassen - siehe unten.

- Steilwinkel-Aufnahme: Wird benutzt, um ein Bild mit vielen Menschen
aufzunehmen, zum Beispiel bei einem Konzert oder Fest, oder um ein Bild eines
groRen Raums aufzunehmen.

« Flachwinkel-Aufnahme: Wird benutzt, wenn Sie ein Bild Ihres Kindes aus
Augenhohe-Perspektive des Kindes aufnehmen wollen oder um hohe Gebaude
zu fotografieren usw.

Steilwinkel-Aufnahme Flachwinkel-Aufnahme

LG Dual Bildschirm (LM-G905N) 201



Funktion Direkte Aufnahme mit dem Dual

Bildschirm benutzen
\Wenn das Telefon am Dual Bildschirm angeschlossen ist, ist bei der LG Tastatur die
Funktion Direkte Aufnahme (] aktiviert.

Sie kénnen auf dem Hauptbildschirm die Tastatur benutzen, auf dem Dual
Bildschirm den Bildschirminhalt erfassen und diesen im Tastatur-Eingabefenster
einflgen.
Tippen Sie im LG-Tastatur-Eingabebildschirm auf 3],

« DerInhalt des Dual Bildschirms wird erfasst und automatisch dem Tastatur-

Eingabefenster angefiigt.
Y

l-i Direkte Aufnahme

N Erfasster Bildschirm
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E « Ist diese Funktion aktiviert, kann die Tastatur nicht tber beide Bildschirme
erweitert werden.

LG Gamepad

Um auf dem Telefon Spiele zu spielen, kdnnen Sie auf dem Produkt-Bildschirm
virtuelle Steuerungen benutzen. Wenn Sie das Spiel spielen, dann separieren Sie
den Hauptbildschirm vom Dual Bildschirm, sodass die Steuerungselemente nicht
den Spiele-Bildschirm verdecken.

1 Tippen Sie auf dem Homescreen auf Spiele-Launcher und wahlen Sie LG
Game Pad @

LG Gamepad

« Auf dem Produkt-Bildschirm erscheint das LG Gamepad.

2 Tippen Sie auf[& und wischen Sie dann nach links oder rechts, um den
gewlnschten Style des LG Gamepad auszuwahlen.
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Sie kénnen das Spiel spielen, indem Sie den Dual Bildschirm wie unten gezeigt
halten.

LG Gamepad ist nur verfligbar fir Spiele, die Hardware-Game Pads untersttitzen.

« Je nach Spiel werden méglicherweise einige Apps oder Tasten von LG Gamepad
nicht untersttitzt
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Eigenes Gamepad erstellen
Zusatzlich zum LG Gamepad kénnen Sie |hr eigenes Game Pad erstellen oder
anpassen. Sie kdnnen Ihr eigenes Game Pad erstellen, das mit den Tasten
synchronisiert wird, mit denen das Spiel gespielt wird.
1 Auf dem Dual Bildschirm das Spiel ausfiihren.
« Das Gerat horizontal drehen, sodass der Dual Bildschirm oben ist und der
Bildschirm des Telefons unten.

Ve

A

2 Tippen Sie auf dem Homescreen auf Spiele-Launcher und wahlen Sie
LG Gamepad [®]; dann zum rechten Ende des Bildschirms wischen.

+ Auf dem Bildschirm erscheint Eigenes Gamepad erstellen.
- Tippen Sie auf dem Bildschirm Eigenes Gamepad erstellen auf -
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3 Tippen Sie am Bildschirm Eigenes Gamepad oben rechts auf = damit die
verfligharen Tasten angezeigt werden. \Wahlen Sie die Taste aus, die fur ein
Eigenes Gamepad benutzt werden soll.

« Die ausgewahlte Taste erscheint auf dem Bildschirm fir ein Eigenes
Gamepad.

/A Wahrend Sie auf dem Dual Bildschirm das Spiel sehen, setzen Sie die
ausgewahlte Taste auf dem Telefon-Bildschirm an die gewiinschte Stelle.
+ Wahlen Sie beim Spiel auf dem Dual Bildschirm g, um es mit der neu
erstellten Taste zu synchronisieren.
« Passen Sie auf lhrem Telefon-Bildschirm die Position und GréRe der neu
erstellten Taste an.

E + Wenn Sie auf dem Telefon-Bildschirm die neu erstellte Taste betdtigen, hat das
dieselbe Wirkung als wenn Sie die Taste auf dem Dual Bildschirm betdtigen.
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5 Um ein Eigenes Gamepad zu speichern, auf \/’ tippen.
+ Wenn Sie ein Eigenes Gamepad speichern, wird es unter dem Namen des
Spiels gespeichert.

5 « Ein Eigenes Gamepad wird dem Spiel als dessen Gamepad fest zugeordnet.
+ Wenn das Spiel aktualisiert wird, kann es vorkommen, dass einige Tasten nicht
mehr funktionieren.
Ein Eigenes Gamepad kann nur auf dem Telefon-Bildschirm erstellt werden, nicht
auf dem Dual Bildschirm.
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Marken

+ Copyright ©2020 LG Electronics Inc. Alle Rechte vorbehalten. LG und das
LG-Logo sind eingetragene Marken der LG Group und ihrer verbundenen
Unternehmen.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Google Photos, Google Play Protect, Google Calendar; Google Docs,
Google Drive, Google Sheets und andere damit zusammenhangende Zeichen
und Logos sind Marken von Google LLC.

« Alle anderen Marken und Urheberrechte sind Eigentum der jeweiligen Inhaber.

KONFORMITATSERKLARUNG

LG Electronics erklart hiermit, dass das LM-G905N den wichtigsten
Anforderungen und anderen relevanten Bestimmungen der Richtlinie 2014/35/EU
und 2014/30/EU entspricht.

Eine Kopie der Konformitatserklarung finden Sie unter
http7//wwwi.lg.com/global/declaration

Kontakt fiir Produktkonformitat

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands
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Weitere Informationen

Vorkehrungen beim Umgang mit dem Produkt
+ Dieses Produkt kann nicht alleine, d. h. eigenstandig benutzt werden.

+ Wenn sich beim Produkt am Anschluss fiir Kommunikation/Stromzufuhr
Feuchtigkeit abgesetzt hat, sollten Sie das Produkt nicht benutzen und auch
nicht aufladen.

- Dies kann zu Feuer, Stromschlag, Verletzungen oder Fehlfunktionen des
Gerats fuhren.

- Horen Sie bei Feuchtigkeit bitte sofort auf, das Gerat zu verwenden und
entfernen Sie die Feuchtigkeit vollstandig.

« Die Flussigkeit in Ihrem nassen Gerat andert die Farbe der
Produktkennzeichnung im Inneren Ihres Gerats. Gerateschaden, die aufgrund

von eingedrungener Flissigkeit entstehen, werden nicht von der Garantie
abgedeckt.

Hartglasteile

Die Hartglasteile dieses Gerats sind nicht fiir Dauer ausgelegt und kdnnen im Laufe
der Zeit verschleiRen.

+ Wenn das Gerat auf eine harte Flache fallt oder starken StoRen ausgesetzt
wird, kann das Hartglas beschadigt werden.

In diesem Fall horen Sie bitte sofort auf, das Gerat zu verwenden und
kontaktieren Sie ein LG Servicezentrum.

+ Auf dem Markt sind Schutzhllen fir den Schutz Ihres Gerats erhaltlich.

Beachten Sie, dass diese Schutzhtllen nicht von dem durch LG Electronics
geleisteten Garantieservice abgedeckt sind und die Sicherheit nicht
gewahrleistet wird.

Akku nutzen
+ Das Produkt verfiigt tber keinen eigenen Akku.

+ Wenn das Produkt mit dem Mobiltelefon verbunden ist, benutzt es den Akku
des Mobiltelefons.
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Entsorgung lhrer Altgerate

1. Das durchgestrichene Symbol eines fahrbaren Abfallbehalters weist darauf
hin, dass Elektro- und Elektronik-Produkte (WEEE) getrennt vom Hausmdill
entsorgt werden mussen.

[ 2. Alte elektrische Produkte kénnen gefahrliche Substanzen enthalten,
die eine korrekte Entsorgung dieser Altgerate erforderlich machen, um
schadliche Auswirkungen auf die Umwelt und die menschliche Gesundheit
zu vermeiden. Ihre ausgedienten Gerate konnen wiederverwendbare Teile
enthalten, mit denen méglicherweise andere Produkte repariert werden
kénnen, aber auch sonstige wertvolle Materialien enthalten, die zur
Schonung knapper Ressourcen recycelt werden kdnnen.

3. Sie konnen Ihr Gerat entweder in den Laden zurtickbringen, in dem Sie
das Produkt urspriinglich erworben haben, oder Sie kontaktieren lhre
Gemeindeabfallstelle fir Informationen tber die nachstgelegene autorisierte
WEEE-Sammelstelle. Die aktuellsten Informationen fur Ihr Land finden Sie
unter wwwi.lg.com/global/recycling
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[TALIANO

Info sulla guida per l'utente

Grazie per aver scelto questo prodotto LG. Per garantire un uso sicuro e corretto
del dispositivo, si prega di leggere con attenzione la guida per l'utente prima di
utilizzarlo per la prima volta.

Utilizzare sempre accessori LG originali. Gli elementi forniti in dotazione sono
progettati esclusivamente per questo dispositivo e potrebbero non essere
compatibili con altri dispositivi.

Le descrizioni si basano sulle impostazioni predefinite del dispositivo.

Le app predefinite presenti sul dispositivo sono soggette ad aggiornamenti e il
supporto per tali applicazioni puo essere sospeso senza preawiso. Per eventuali
domande relative alle app preinstallate sul dispositivo, contattare un Centro di
assistenza LG. Per le app installate dall'utente, contattare il provider del servizio
di riferimento.

La modifica del sistema operativo del dispositivo o linstallazione di software
provenienti da fonti non ufficiali potrebbe danneggiare il dispositivo e causare
il danneggiamento o la perdita di dati. Tali azioni costituiscono una violazione
dellaccordo di licenza LG e annullano la garanzia.

Alcuni contenuti e illustrazioni potrebbero differire dal dispositivo acquistato
a seconda dellarea, del provider del servizio, della versione del software o del
sistema operativo e sono soggetti a modifiche senza preawiso.

| software, laudio, gli sfondi, le immagini e gli altri elementi multimediali forniti
con questo dispositivo sono concessi in licenza per uso limitato. Lestrazione e
[utilizzo di questi materiali per scopi commerciali o altri scopi potrebbe costituire
una violazione delle leggi sul copyright. La piena responsabilita per ['utilizzo
illegale degli elementi multimediali spetta agli utenti.

| servizi relativi ai dati, come ad esempio messaggistica, caricamento e
download, sincronizzazione automatica o servizi di posizionamento, potrebbero
comportare costi aggiuntivi. Per evitare costi aggiuntivi, selezionare un piano
dati adeguato alle proprie esigenze. Per ulteriori informazioni, rivolgersi al
proprio gestore di telefonia mobile.

La presente guida per l'utente e redatta nelle principali lingue per ogni paese. A
seconda della lingua di redazione, i contenuti potrebbero in parte variare.



Notifiche informative

& ATTENZIONE: situazioni che potrebbero provocare lesioni all'utente e a terze parti.

ATTENZIONE: situazioni che potrebbero provocare lesioni lievi o danni al
dispositivo.

E NOTA: awisi o informazioni aggiuntive.

Info sulla guida per lutente
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Indicazioni per un uso sicuro ed
efficiente

Leggere le semplici indicazioni riportate di sequito. Il mancato rispetto di tali indicazioni pud
rivelarsi pericoloso o illegale.

Nel caso si verifichino errori, il software integrato nel dispositivo crea un registro degli errori.
Questo strumento raccoglie solo i dati specifici dellerrore come l'intensita del segnale, la “cell ID
position” quando la chiamata viene interrotta e le applicazioni caricate. Il registro viene utilizzato
solo per determinare la causa dellerrore. Questi registri sono crittografati e possono essere
aperti solo nei centri di riparazione LG autorizzati, nel caso sia necessario restituire il dispositivo
per la riparazione.

Esposizione all'energia elettromagnetica a
radiofrequenze (RF)

Informazioni sullesposizione alle onde radio e sulla SAR (Specific Absorption Rate)
Questo dispositivo e stato progettato in conformita ai requisiti di sicurezza vigenti per
lesposizione alle onde radio. Tali requisiti si basano su precise indicazioni scientifiche che
definiscono, tra laltro, i margini di sicurezza necessari per salvaguardare tutte le persone,
indipendentemente dalleta e dalle condizioni di salute.

+ Le indicazioni sullesposizione alle onde radio fanno riferimento a un'unita di misura detta
SAR, acronimo per Specific Absorption Rate. Le prove relative ai valori SAR sono state
condotte mediante metodi standardizzati con il dispositivo in stato di trasmissione al
massimo livello di alimentazione certificato, con qualsiasi banda di frequenza.

Anche se si possono riscontrare differenze trai livelli SAR nei vari modelli di dispositivi
portatili LG, questi sono comunque stati progettati con unattenzione particolare alle
normative vigenti sullesposizione alle onde radio.

La commissione internazionale ICNIRP (International Commission on Non-lonizing
Radiation Protection) raccomanda un limite SAR pari a 2 \W/kg in media per dieci grammi
di tessuto.

Il valore SAR pili elevato registrato per questo modello per ['uso vicino allorecchio & pari a
0,551 W/kg (10 g) e paria 1,531 W/kg (10 g) a contatto con il corpo.



+ Questo dispositivo e conforme alle direttive sullesposizione alle radiofrequenze quando
utilizzato nella normale posizione d'uso vicino allorecchio o posizionato a una distanza di
almeno 5 mm dal corpo. Se una custodia, una clip per cintura o un altro sostegno vengono
posizionati a stretto contatto con il corpo, tali accessori non devono contenere metallo ed &
importante mantenere il dispositivo a una distanza di almeno 5 mm dal corpo. Il dispositivo
richiede una connessione ottimale alla rete per poter trasmettere file di dati 0 messaggi.

In alcuni casi, la trasmissione di file di dati o messaggi potrebbe essere ritardata fino a che
tale connessione diventi disponibile. Le istruzioni relative alla separazione del dispositivo dal
corpo devono essere rispettate fino alla fine della trasmissione.

Informazioni fornite dalla FCC in merito
all'esposizione alle frequenze radio

Nellagosto del 1996, la Federal Communications Commission (Commissione federale per

le comunicazioni, FCC) degli Stati Uniti, attraverso azione in Report and Order FCC 96-326,
ha adottato uno standard di sicurezza aggiornato relativo allesposizione umana allenergia
elettromagnetica delle frequenze radio emessa dai trasmettitori con normativa FCC. Tali linee
guida sono coerenti con gli standard di sicurezza in precedenza determinati da standard sia
internazionali sia statunitensi. La progettazione del presente dispositivo & conforme alle linee
guida FCC e a tali standard internazionali.

Parte 15.19

Questo apparecchio e conforme alla parte 15 delle norme FCC. Il funzionamento e soggetto
alle due condizioni riportate di seguito:

(1) Il dispositivo non deve generare interferenze dannose.

(2) Il dispositivo deve accettare eventuali interferenze ricevute, incluse quelle che potrebbero
comportare errori di funzionamento.

Parte 15.21

Modifiche non espressamente approvate dal produttore potrebbero annullare lautorita
dellutente all'utilizzo dellattrezzatura.
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Funzionamento del dispositivo indosso all'utente

Il presente dispositivo ¢ stato testato per le tipiche funzioni in cui lo siindossa, mantenendo

la parte posteriore del dispositivo a 1 cm (0,39 pollici) di distanza da corpo dell'utente. Per
rispettare i requisiti FCC relativi allesposizione alle frequenze radio, & necessario mantenere
una distanza di separazione minima tra il corpo dell'utente e la parte posteriore del dispositivo
di 1 cm (0,39 pollici). Potrebbe non essere possibile utilizzare fermagli da cintura, custodie

e accessori simili contenenti componenti in metallo. Gli accessori da indossare che non
mantengono una distanza di separazione di 1 cm (0,39 pollici) tra il corpo dellutente e la parte
posteriore del dispositivo e che non sono stati testati per le tipiche funzioni in cui si indossa il
dispositivo potrebbero non rispettare i limiti FCC relativi allesposizione alle frequenze radio e
devono dunque essere evitati.

Parte 15.105

Questa apparecchiatura é stata testata e rispetta i limiti di un dispositivo digitale di Classe B,

ai sensi della parte 15 delle norme FCC. Questi limiti sono stabiliti per fornire una protezione
adatta dalle interferenze dannose in un'installazione residenziale. Questo apparecchio genera,
utilizza e puo irradiare energia in radiofrequenza; inoltre, se non viene installato e utilizzato
secondo le istruzioni, pud causare interferenze dannose alle comunicazioni radio. Tuttavia, non
esiste alcuna garanzia che queste interferenze non si verifichino in una particolare installazione.
Se la presente apparecchiatura causa interferenze dannose o ricezione di canali televisivi,
determinabili accendendo e spegnendo il dispositivo, si consiglia vivamente di tentare di
correggere linterferenza attuando una o piti delle sequenti misure:

Orientare o posizionare di nuovo lantenna di ricezione.
+ Aumentare lo spazio che intercorre tra lapparecchio e il ricevitore.

+ Collegare lapparecchio a una presa su un circuito differente rispetto a quello a cui &
collegato il ricevitore.

Per assistenza, consultare il rivenditore o un tecnico radio/TV esperto.
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Manutenzione e cura del prodotto

Utilizzare solo gli accessori forniti autorizzati da LG. Qualsiasi danno o guasto causato da
accessori di terze parti non é coperto dalla garanzia LG.

Alcuni contenuti e illustrazioni possono differire dal dispositivo senza preawviso.

Non smontare [apparecchio. Se & necessaria una riparazione, rivolgersi presso un centro
assistenza autorizzato LG.

La garanzia copre, a discrezione di LG, la sostituzione di parti o schede nuove o riconvertite,
funzionalmente equivalenti.

Tenere lontano da apparecchiature elettriche quali TV, radio e PC.

Tenere lontano da fonti di calore quali termosifoni o fornelli.

Non far cadere lapparecchio.

Non sottoporre [apparecchio a scosse, urti o vibrazioni.

Spegnere il dispositivo nelle aree in cui e specificamente richiesto. Ad esempio, non
utilizzarlo all'interno di ospedali, in quanto potrebbe interferire con il funzionamento di
apparecchiature mediche sensibili.

Non afferrare il dispositivo con le mani bagnate mentre € in carica. Cio potrebbe provocare
scosse elettriche o danneggiare seriamente il prodotto.

Non ricaricare il telefono vicino a materiali infiammabili che potrebbero provocare incendi a
causa del calore sviluppato dal dispositivo.

Usare un panno asciutto per la pulizia esterna del cellulare (non usare solventi come
benzene, acquaragia o alcol).

Non caricare il dispositivo quando si trova su superfici morbide.

Il dispositivo dovrebbe essere caricato in unarea ben ventilata.

Non esporre [apparecchio a fumo o polvere.

Tenere lontano il dispositivo da carte di credito o supporti magnetici per evitarne la
smagnetizzazione.

Non toccare lo schermo con oggetti appuntiti per evitare di danneggiare il dispositivo.

Non esporre il dispositivo a umidita o a contatto con liquidi.

Usare gli accessori con attenzione e delicatezza. Non toccare [antenna se non strettamente
necessario.

In caso di vetro rotto o scheggiato, non utilizzare il dispositivo, non toccare il vetro, né
tentare di rimuoverlo o ripararlo. I danni al display in vetro dovuti ad abuso o utilizzo non
corretto non sono coperti dalla garanzia.
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Il dispositivo e un dispositivo elettronico che genera calore durante il normale
funzionamento. Il contatto diretto e prolungato con la pelle e lassenza di unadeguata
ventilazione possono provocare disagi e piccole bruciature. Pertanto, & necessario
maneggiare con cura il dispositivo durante o subito dopo ['utilizzo.

Se il dispositivo si bagna, scollegarlo immediatamente e farlo asciugare completamente.
Non tentare di accelerare il processo di asciugatura con una fonte di calore esterna, ad
esempio un forno, un forno a microonde o un asciugacapelli.

Il liquido presente nel dispositivo bagnato potrebbe modificare il colore delletichetta del
prodotto presente allinterno. | danni al dispositivo derivanti dallesposizione ai liquidi non
sono coperti da garanzia.

Un dispositivo mobile ha bisogno di una corretta circolazione dellaria per disperdere il
calore. Il contatto diretto con la pelle ed uninsufficiente circolazione daria sul dispositivo
potrebbe causare un surriscaldamento. Il dispositivo deve trovarsi ad almeno 1,0 cm dal
corpo dellutente.

Evitare che la polvere di sostanze estranee entri nel caricatore / porta del cavo USB. Pud
generare calore o fuoco.

Evitare di esporre il dispositivo a basse pressioni dellaria ad alta quota.

Non esporre il dispositivo a pressioni dellaria estremamente basse. Altrimenti cio pud
causare lesplosione della batteria o perdite di liquido o gas infiammabile.

Funzionamento efficiente del dispositivo

Dispositivi elettronici
Tutti i dispositivi possono subire interferenze che influiscono sulle prestazioni.

Non utilizzare il dispositivo in prossimita di apparecchiature mediche senza autorizzazione.
Consultare un medico per determinare se ['uso del dispositivo possa interferire con il
funzionamento dell'apparecchio medico.

+ | produttori di pacemaker raccomandano una distanza minima di 15 cm da altri dispositivi e
pacemaker per evitare possibili interferenze con quest'ultimo.

Il dispositivo potrebbe produrre una luce forte o lampeggiante.
Il dispositivo potrebbe interferire con alcuni tipi di apparecchi acustici.
+ Il telefono potrebbe interferire con apparecchi televisivi, radio, computer, ecc.

« Utilizzare il dispositivo a una temperatura compresa tra 0 °C e 35 °C, se possibile.
Lesposizione del dispositivo a temperature estremamente alte o basse puo causare danni,
malfunzionamenti o perfino esplosioni.
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Sicurezza in automobile
Verificare le leggi e le normative che riguardano ['utilizzo dei dispositivi quando si guida.

Non utilizzare il dispositivo in modalita manuale durante la quida.

Prestare la massima attenzione alla guida.

Se le condizioni di guida lo richiedono, accostare e parcheggiare prima di telefonare o
rispondere a una chiamata.

L'energia RF puo influire sul sistema elettronico del veicolo, ad esempio sullo stereo o sulle
apparecchiature di sicurezza.

Se il veicolo  dotato di airbag, non collocarvi accanto oggetti come apparecchi wireless
portatili o installati per evitare lesioni gravi causate dallerrato funzionamento dellair bag.

Durante lascolto della musica tramite il cellulare, assicurarsi che il volume sia
ragionevolmente basso da consentire il rilevamento dei rumori circostanti. Cio &
particolarmente importante in prossimita di strade.

Come evitare danni all'udito

Per evitare eventuali danni all'udito, non ascoltare audio ad alto volume per
lunghi periodi.

L'udito potrebbe danneggiarsi se viene esposto a volumi eccessivi e prolungati nel tempo. Si
consiglia pertanto di non accendere o spegnere il telefono indossando gli auricolari e di tenere il
volume di ascolto delle conversazioni e della musica a un livello ragionevole.
Quando si utilizzano gli auricolari, abbassare il volume se non si riesce a sentire le persone
nelle vicinanze o se il volume & tale da essere udito dalla persona accanto.

E « Lutilizzo di auricolari e cuffie a volume troppo elevato pud causare |a perdita
delludito.
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Parti in vetro

Alcune parti del dispositivo sono in vetro. Se il dispositivo cade su una superficie rigida o subisce
un forte impatto, il vetro pud rompersi. Se cio accade, non toccare o tentare di rimuovere il
vetro. Non utilizzare il dispositivo finché il vetro non viene sostituito da un centro di assistenza
autorizzato.

Aree a rischio di esplosione

Non utilizzare il dispositivo in aree dove sono in atto operazioni di detonazione. Rispettare le
restrizioni e osservare tutte le norme o i regolamenti al riguardo.

Atmosfere potenzialmente esplosive
+ Non utilizzare il dispositivo in prossimita di stazioni di servizio.
+ Non utilizzare [apparecchio in prossimita di combustibili o prodotti chimici.

+ Non trasportare né conservare sostanze esplosive, liquidi o gas infiammabili allinterno
dellautovettura in cuisi trovano il dispositivo o i relativi accessori.

A bordo di aeromobili
L'uso di dispositivi portatili pud causare delle interferenze al velivolo.
+ Spegnere il dispositivo prima di imbarcarsi su qualsiasi aeromobile.

« Utilizzarlo a terra (prima o dopo il decollo) solo con il permesso dellequipaggio.

Bambini

Conservare il dispositivo in un posto sicuro, lontano dalla portata dei bambini. Lapparecchio
& composto da parti smontabili di piccole dimensioni che, se ingerite, possono provocare
soffocamento.

Chiamate di emergenza

Le chiamate di emergenza potrebbero non essere disponibili su tutte le reti cellulari. Pertanto,
si consiglia di non affidarsi solo al dispositivo per eventuali chiamate di emergenza. Contattare
il fornitore di servizi locale per conoscere la disponibilita dei servizi di emergenza nel proprio
paese.
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Manutenzione e informazioni sulle batterie

Non & necessario scaricare completamente la batteria prima di ricaricarla. A differenza
dialtri sistemi a batteria, questo cellulare non presenta un effetto memoria in grado di
compromettere le prestazioni della batteria.

Utilizzare solo batterie e caricabatterie LG, in quanto sono progettati per consentire una
maggiore durata della batteria.

Non smontare né cortocircuitare la batteria.
Tenere puliti i contatti metallici della batteria.

Sostituire la batteria quando le prestazioni non sono pit accettabili. La batteria puo essere
ricaricata centinaia di volte prima che sia necessario sostituirla.

Se la batteria e rimasta inutilizzata per un lungo periodo, ricaricarla per ottimizzarne le
prestazioni.

Non esporre il caricabatterie alla luce solare diretta e non utilizzarlo in ambienti
particolarmente umidi, ad esempio nel bagno.

Evitare di lasciare il dispositivo in luoghi con temperature eccessivamente basse o elevate
per non comprometterne le prestazioni.

L'uso di un tipo di batteria errato pud comportare il rischio di esplosioni. Attenersi alle
istruzioni per lo smaltimento delle batterie usate.

Quando il dispositivo e completamente carico, scollegare sempre il caricabatterie dalla presa
di corrente per evitare consumi energetici non necessari.

La durata della batteria effettiva varia a seconda di configurazione di rete, impostazioni del
prodotto, uso, batteria e condizioni ambientali.

Assicurarsi che la batteria non venga a contatto con oggetti affilati come ad esempio,
forbici, denti o unghie di animali. Cio potrebbe causare incendi.

Consumo energetico (modalita standby di rete): 0,5 W
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Protezione delle informazioni personali

+ Assicurarsi di proteggere le informazioni personali per evitare la perdita e [uso improprio
delle informazioni sensibili.

Esequire sempre il backup dei dati importanti durante ['utilizzo del dispositivo. LG non &
responsabile di eventuali perdite di dati.

Assicurarsi di esequire il backup di tutti i dati e di ripristinare il dispositivo durante lo
smaltimento del dispositivo per impedire 'uso improprio delle informazioni sensibili.

Leggere attentamente la schermata delle autorizzazioni durante il download delle
applicazioni.

Utilizzare con cautela le applicazioni che hanno accesso a piti funzioni o a informazioni
personali.

Controllare regolarmente gli account personali. In caso di uso improprio, chiedere al provider
del servizio di eliminare o modificare le informazioni del proprio account.

In caso di perdita o furto del dispositivo, modificare la password dellaccount per proteggere
le informazioni personali.

Non utilizzare applicazioni provenienti da fonti sconosciute.

A Awviso sulla sostituzione della batteria

+ Una batteria agli ioni di litio & un componente pericoloso che puo causare lesioni
gravi.

« Lasostituzione della batteria da parte di personale non qualificato puo causare
danni al dispositivo.

« Non sostituire la batteria autonomamente. La batteria potrebbe essere
danneggiata, surriscaldarsi e provocare lesioni. La batteria deve essere sostituita
da personale qualificato. La batteria deve essere riciclata o smaltita separatamente
rispetto ai rifiuti domestici.

Nel caso in cui il prodotto contenga una batteria incorporata nel prodotto che
non puo essere facilmente rimossa dall'utente finale, LG raccomanda che la
batteria venga rimossa solo da professionisti qualificati, sia per la sostituzione sia
per il riciclaggio al termine della vita del prodotto. Per evitare danni al prodotto,

e per la propria sicurezza, gli utenti non devono tentare di rimuovere la batteria,
ma contattare il Servizio clienti di LG o altri fornitori di servizi indipendenti per
ottenere consiglio.

+ Larimozione della batteria comporta lo smantellamento della custodia del
prodotto, la disconnessione di cavi/contatti elettrici, e [attenta estrazione della
cella batteria utilizzando strumenti specifici. In caso di bisogno di istruzioni per
professionisti qualificati su come rimuovere la batteria in modo sicuro, si prega di
visitare http7//www.lge.com/global/sustainability/environment/take-back-recycling.
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Funzioni della fotocamera

Controllo time-lapse
E possibile registrare video TimeLapse ottimizzati per la situazione.

I video possono essere registrati con velocita ottimale e movimento costante
analizzando una varieta di ambienti di ripresa. La velocita di time-lapse puo essere
regolata automaticamente in base al soggetto e allambiente di ripresa. La velocita
di time-lapse puo anche essere selezionata manualmente.

1 Toccare (&) e selezionare TimeLapse scorrendo le modalita della fotocamera.

Imposta la fotocamera —e e—— Imposta la torcia
Selezionare le proporzioni I I Imposta Steady Cam
dello schermo
e—————————— Selezionare lo zoom
e———— Selezionare la velocita di
time-lapse
R 2

Selezionare time-lapse per le
modalita della fotocamera

2 Toccare e per registrare un video.

« Durante la registrazione time-lapse, & possibile cambiare lo zoom e la
velocita di time-lapse.

- Per mettere in pausa la registrazione, toccare @. Per continuare la
registrazione, toccare (® .

+ Mentre registri un video, puoi stringere o allargare due dita per ingrandire o
rimpicciolire.

+ Mentre registri un video, puoi toccare |'area desiderata per regolare la
luminosita.
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3 Toccare = per arrestare la registrazione.
« llvideo registrato viene salvato nella Galleria.

E « Durante la registrazione Time-lapse, laudio non viene registrato.

Effetto AR 3D

La fotocamera di profondita sul lato posteriore del prodotto consente di riprendere
realistici Effetto AR 3D riconoscendo i contorni del viso in modo pit dettagliato.
Poiché il viso viene riconosciuto con precisione, & possibile riprendere un adesivo
senza che appaiano le mani, anche se il viso & parzialmente coperto dalle mani.

1 Toccare @ e selezionare Sticker scorrendo le modalita della fotocamera.
7 Selezionare @

3 Scorrere lelenco di adesivi da sinistra a destra per selezionare ladesivo AR da
usare.

« llviso riconosciuto dalla fotocamera viene scansionato in 3D.
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/| Toccare () per scattare una foto, oppure toccare e tenere premuto () per
registrare un video.

+ Lafoto ol video vengono ripresi con I'Effetto AR 3D applicato.

E « Lafunzione di scansione 3D della fotocamera di profondita é disponibile solo per la
ripresa di primi piani rawvicinati.

Effetto Foto 3D

Effetto Foto 3D consente di scattare foto 3D che offrono una maggiore
sensazione di profondita ai ritratti utilizzando la fotocamera di profondita sul retro
del prodotto. Le foto scattate con Effetto Foto 3D possono essere visualizzate
come immagini in movimento nellapp Galleria.

1 Toccare (&) e selezionare Ritratto scorrendo le modalita della fotocamera.

7 Selezionare Effetto Foto 3D scorrendo le modalita di effetto disponibili per
Ritratto.

[ Selezionare Effetto Foto 3D
per le modalita di effetto

L SelezionareRitratto perle
modalita della fotocamera

Funzioni personalizzate 18



3 Sfiorare () per scattare una foto.
« Lafoto viene salvata nella Galleria.
- @ appare sullimmagine scattata con Effetto Foto 3D.
4 Selezionare una foto 3D dalla Galleria o da Anteprima e toccare (2 per
applicare un effetto fotografico.
+ Selezionare Salva una copia o OK dopo aver applicato leffetto.

E + Questa funzione e disponibile solo quando si scattano foto con la fotocamera
posteriore.

+ Quando appare il messaggio “Effetto Foto 3D é disponibile’, premere () per
scattare una foto. In caso contrario, Effetto Foto 3D non viene applicato alla foto
salvata.
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Funzioni di registrazione audio

Registrazione video con opzioni di registrazione

audio particolari

E possibile registrare un video con tre diverse opzioni di registrazione vocale, a
seconda della situazione.

1 Toccare @ e selezionare Video scorrendo le modalita della fotocamera.

2 Toccare @) e selezionare Base, Modalita ASMR o Bokeh vocale scorrendo le
opzioni audio.

e————— Opzioni audio

Base
E possibile registrare un video con un stabile stono stereo.

Modalita ASMR

E possibile registrare un video ASMR con i due sensibili microfoni integrati nel
dispositivo.
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Bokeh vocale
E possibile enfatizzare la voce del soggetto riducendo il rumore ambientale.
+ Perridurre il rumore ambientale, trascinare il dispositivo di scorrimento verso

o)

Registrazione di suoni ASMR

Questa funzione consente di registrare ['audio in modo chiaro e preciso
amplificando il suono rilevato dai microfoni.

1 Toccare Essenziali > Registratore Audio HD e toccare = > ASMR.

2 Toccare @ per registrare [audio.
- Per mettere in pausa la registrazione, toccare ). Per continuare la
registrazione, toccare .

3 Toccare @) per terminare la registrazione dellaudio.

LG 3D Sound Engine

La funzione LG 3D Sound Engine consente di sentire un suono stereoscopico e
ottimizzato. Durante la riproduzione di musica o video, & possibile ascoltare un
suono stereoscopico e awolgente come se fosse dal vivo.

1 Trascinare verso il basso il pannello notifiche.

2 Toccare (X) per attivare o disattivare la funzione LG 3D Sound Engine.
Oppure toccare Impostazioni > Suono > Qualita del suono ed effetti> LG
3D Sound Engine e toccare () ) per attivare la funzione.

E « Se si connette al prodotto un dispositivo audio esterno come cuffie o un
altoparlante, appare un pop-up che richiede di attivare la funzione LG 3D Sound
Engine.

Funzioni personalizzate

21



Assistente Google

Panoramica Assistente Google

Il tuo dispositivo dispone di Assistente Google incorporato. Trova le risposte e fai
cose mentre sei in giro.

5

« Per utilizzare questa funzione, stabilire prima la connessione alla rete.

Awvio di Assistente Google

1

Premere il tasto Assistente Google sul lato sinistro del dispositivo.
oppure
Scorrere diagonalmente da un angolo inferiore dello schermo.

5

Tocca INIZIA.

Sequire le istruzioni visualizzate sullo schermo.

Il dispositivo salva i dati della tua voce per il riconoscimento.

Imposta se usare la funzione di sblocco con Voice Match.

Utilizzando la funzione di sblocco con Voice Match, e possibile sbloccare il
dispositivo anche quando ha lo schermo spento o € in carica, pronunciando
"“OK Google” 0 “Hey Google.".

+ Questa funzione puo risultare piti vulnerabile in termini di sicurezza rispetto ad altri
metodi di blocco schermo come Sequenza, PIN o Password.
Se si utilizza un voce somigliante o una voce registrata, & possibile che il blocco schermo
venga rimosso.
Per usare questa funzione, nella schermata Home toccare Impostazioni > Blocco
schermo & sicurezza > Impostazioni di Blocco con sicurezza > Smart Lock, e quindi
usare il metodo di blocco schermo impostato per sbloccare il dispositivo. Toccare Voice
Match, quindi inserire nuovamente il metodo di sblocco correntemente in uso. Nota che
Swipe & esclusa.

+ Senon si riesce a sbloccare il dispositivo usando il riconoscimento vocale, & necessario
sbloccare il dispositivo usando il metodo specificato. Per ulteriori dettagli, consultare la
sezione Impostazione di un blocco schermo.

5 Toccare Fine.

Funzioni personalizzate
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Accesso vocale
1 Quando la schermata Home & spenta o bloccata, pronuncia “OK Google” o
“Hey Google.".

7 Quando appare la schermata di Assistente Google, pronuncia un comando o
poni una domanda.

Accesso dalla schermata Home

1 Premere il tasto Assistente Google sul lato sinistro del dispositivo.
oppure
Scorrere diagonalmente da un angolo inferiore dello schermo.

2 Pronuncia un comando o una domanda quando sulla parte inferiore dello
schermo appare «« -«

E + In'un ambiente in cui la connessione Wi-Fi o dei dati mobili & scarsa, la funzione
Assistente Google potrebbe essere limitata e la precisione del riconoscimento
vocale potrebbe essere ridotta.

Se la pronuncia & ambigua, il microfono e coperto, un lettore multimediale e

in riproduzione o 'ambiente circostante & rumoroso, il grado di precisione del
riconoscimento vocale potrebbe essere ridotto. Quando si utilizza il prodotto
mediante i comandi vocali, pronunciare le parole con precisione in un ambiente
silenzioso per una migliore precisione del riconoscimento vocale.

Funzioni personalizzate
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Riconoscimento delle impronte
digitali

Informazioni generali sul riconoscimento delle
impronte digitali

Prima di utilizzare la funzione di riconoscimento delle impronte digitali, € necessario

registrare la propria impronta sul dispositivo.

La funzione di riconoscimento delle impronte digitali puo essere impiegata nei casi

seguenti:
+ Per sbloccare lo schermo.
+ Per visualizzare i contenuti bloccati nella Galleria.

+ Per confermare un acquisto effettuando laccesso a un'app o identificandosi
tramite limpronta digitale.

E « E possibile utilizzare i dati dellimpronta digitale per [autenticazione dellutente.
possibile che il sensore di impronte digitali possa riconoscere un'impronta digitale
diversa ma molto simile a unimpronta digitale registrata. Per una maggiore
sicurezza, si consiglia di utilizzare il metodo della sequenza, del PIN o della
password per sbloccare lo schermo.
Se il dispositivo non riesce a individuare le impronte digitali o se si dimentica il
valore specificato per |a registrazione, recarsi presso il piti vicino Centro di servizio
clienti LG con il dispositivo e la scheda di identificazione.

Funzioni personalizzate
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Precauzioni per il riconoscimento delle impronte digitali
L'accuratezza del riconoscimento delle impronte digitali potrebbe diminuire a causa
di diverse regioni. Per massimizzarla, eseguire le sequenti verifiche prima dell'utilizzo
del dispositivo.

In basso al centro dello schermo del prodotto, & presente un sensore integrato
che riconosce le impronte digitali. Fare attenzione a non graffiare o danneggiare
il sensore diimpronte digitali con oggetti metallici come monete o chiavi.

In presenza di sostanze estranee (sudore, creme, acqua, sporco, grasso ecc.) sul
sensore di impronte digitali o sul dito da applicare sul sensore, il riconoscimento
delle impronte digitali potrebbe non funzionare correttamente. Pulire il sensore
e il dito e rimuovere tutta 'umidita prima di posizionare il dito sul sensore.

Se la superficie del dito e ruvida a causa di una cicatrice o di unimmersione
prolungata in acqua, il sensore potrebbe non essere in grado di riconoscere
limpronta digitale. In tal caso, registrare unaltra impronta digitale.

Se si piega il dito o si usa solamente la punta del dito, il riconoscimento
dellimpronta potrebbe non avere esito positivo. Assicurati che il tuo dito copra
lintera superficie del sensore per impronte digitali.

Eseguire la scansione di un solo dito per ciascuna registrazione. La scansione
di piti di un dito potrebbe compromettere |a registrazione e il riconoscimento
dellimpronta.

Il dispositivo potrebbe generare elettricita statica se laria circostante é secca. Se
laria circostante & secca, evitare la scansione delle impronte digitali o toccare un
oggetto metallico, quale ad esempio una moneta o una chiave, prima di eseguire
la scansione delle impronte al fine di eliminare lelettricita statica.
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Registrazione delle impronte digitali
E possibile registrare e salvare la propria impronta digitale sul dispositivo per
utilizzare l'identificazione tramite impronta digitale.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

E « E necessario impostare una schermata di blocco per poter utilizzare questa
funzione.

« Seil blocco schermo non € attivo, configurare la schermata di blocco seguendo le
istruzioni visualizzate sullo schermo. Per ulteriori dettagli, consultare la sezione
Impostazione di un blocco schermo.

2 Controllare la posizione del sensore di impronte digitali in basso al centro dello
schermo e poggiare leggermente il dito sul sensore.

E « Assicurarsi che il dito copra completamente il sensore di impronte digitali.

3 Seguire le istruzioni visualizzate sullo schermo.
+ Fino al completamento della registrazione dellimpronta digitale, muovere
poco a poco il dito sul sensore.
« Posizionare il dito sul sensore. Quando si avverte una vibrazione, rimuovere il
dito dal sensore.
/. Unavolta completata la registrazione dell'impronta, toccare OK.

« Toccare Aggiungi altro per registrare unaltra impronta digitale. Poiché il
grado di successo del riconoscimento delle impronte digitali dipende dalle
condizioni dellimpronta digitale registrata, si consiglia di registrare diverse
impronte digitali.
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Gestione delle impronte digitali
E possibile modificare o eliminare le impronte digitali registrate.

71 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

2 Sbloccare in base al metodo di blocco specificato.

3 Dallelenco delle impronte digitali, toccare un'impronta digitale per rinominarla.
Per eliminarla, toccare _||_jT

Visualizzazione dell'icona dell'impronta digitale

quando lo schermo é spento

E possibile impostare come visualizare la posizione del sensore di impronte digitali
sullo schermo quando lo schermo & spento.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

2 Sbloccare lo schermo con il metodo impostato.

3 Controllare se @ ¢ abilitato per lopzione Tocca per mostrare l'icona quando
lo schermo é spento. Per non utilizzare la funzione, disabilitarla trascinando
«.

Impostazione dell'effetto quando si tocca l'icona dell'impronta

digitale

E possibile cambiare leffetto dello schermo che appare quando si tocca licona

dellimpronta digitale.

1 Toccare Impostazioni > Blocco schermo & sicurezza > Impronte digitali.
2 Sbloccare in base al metodo di blocco specificato.

3 Toccare Effetto icona e selezionare leffetto desiderato.
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Sblocco dello schermo con un'impronta digitale

E possibile sbloccare lo schermo e visualizare i contenuti bloccati utilizzando la

propria impronta digitale. Attivare la funzione desiderata:

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza
> Impronte digitali.

7 Sbloccare in base al metodo di blocco specificato.

3 Nella schermata delle impostazioni dellimpronta digitale, attivare la funzione
desiderata:
+ Blocco schermo: Sbloccare lo schermo con un'impronta digitale.

« Blocco del contenuto: consente di sbloccare un contenuto con un'impronta
digitale. A questo scopo, assicurarsi che sia impostato il blocco contenuto.

Funzione Multitasking

Schermata Utilizzi recenti

Scorrere verso [alto e trattenere il pulsante Home — per visualizzare la cronologia
di utilizzo recente.

Finestra pop-up

E possibile aprire piti app sullo schermo e passare facilmente da una all’altra in
qualsiasi momento.

1 Scorrere verso lalto su=— dal lato inferiore dello schermo.

2 Toccare licona dellapp nella parte superiore sinistra della schermata dellapp e
selezionare Finestra pop-up.
« Se si tocca l'icona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.
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3 Lapp appare sullo schermo nella forma di una finestra pop-up.

L]

np np

E « Questa funzione potrebbe non essere disponibile per alcune app o schermate.

Utilizzo della finestre popup

+ — :Riduce a icona |a finestra pop-up La finestra pop-up viene ridotta a icona
mobile dell'app e puo essere spostata dove desiderato sullo schermo.

_ 2:Espande lapp a scherma intero.

X :Chiude app.

Per spostare la finestra pop-up: Trascinare la parte superiore della finestra
pop-up.

Per regolare le dimensioni della finestra pop-up: Trascinare il bordo sinistro,
destro o inferiore della finestra pop-up.

E possibile aprire fino a 5 app usando le finestre popup.

« Per selezionare un'app tra quelle aperte, toccare |a relativa finestra pop-up. La
finestra pop-up selezionata viene portata in primo piano.

« Le finestre popup non possono essere spostate nellarea della barra di stato o della
barra di navigazione.
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Uso della cartella delle app per le finestre popup
Toccando — sulla finestra pop-up, |a finestra popup viene ridotta a icona dellapp.
E possibile trascinare licona dell’app in qualsiasi punto trascinandola.

Se due o pit finestre popup sono ridotte a icona, viene creata la cartella delle app
per contenere le icone delle app.

E « Licona dellapp utilizzata piu di recente viene usata come icona della cartella delle
app. Toccando licong, tutte le icone delle finestre popup ridotte a icona appaiono
nella cartella delle app.

+ Sesitoccaalungo la cartella delle app delle finestre popup e si trascina la cartella
della app in Rimuovi, la cartella delle app viene rimossa.

+ Per rimuovere una delle app dalla cartella delle app, aprire la cartella delle app e
trascinare l'icona dell'app fuori dalla cartella delle app.

Finestra multipla

Quando si usa la navigazione a gesti
1 Scorrere verso lalto su — dal lato inferiore dello schermo.
« Vengono visualizzate le app utilizzate di recente.
« Se si tocca l'icona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.
2 Toccare licona dellapp nella parte superiore sinistra dellapp da visualizzare nella
finestra multipla e selezionare Multi Window.
« Le app selezionate vengono visualizzate nella parte superiore dello schermo.

3 Toccare laltra app da visualizzare nella finestra multipla.
« Le applicazioni selezionate vengono visualizzate nella parte inferiore dello
schermo.
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Quando si usa la navigazione sono con i pulsanti
1 Toccare |:] nella barra di navigazione.
« Vengono visualizzate le app utilizzate di recente.
+ Se si tocca licona dellapp, appaiono le opzioni Informazioni applicazione,
Multi Window, Finestra pop-up e Appunta app.
2 Toccare licona dellapp nella parte superiore sinistra dellapp da visualizzare nella
finestra multipla e selezionare =
« Le app selezionate vengono visualizzate nella parte superiore dello schermo.

3 Toccare laltra app da visualizzare nella finestra multipla.

E « Per regolare le dimensioni dello schermo diviso, trascinare la barra al centro dello
schermo.
« Per disattivare la funzione di finestra multipla, trascinare la barra al centro verso
[alto o verso il basso fino allestremita dello schermo.

La funzione Multi Window non é supportata da alcune app LG o da alcune app
scaricate dal Play Store.
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AOD (always-on display)
E possibile visualizzare la data, lora o la firma, anche se lo schermo principale e
spento.

Scorri fino in cima alla schermata di AOD (always-on display) per attivare diverse
funzioni, tra cui Camera, Capture+, Wi-Fi, impostazioni audio, Bluetooth®, Flash,
Musica e molto altro.

T Nella schermata Home, toccare Impostazioni > Display
> AOD (always-on display).

7 Seleziona limmagine che vuoi visualizzare e tocca SALVA.

Tocca limmagine desiderata tra Orologio digitale, Orologio analogico,
Doppio orologio e Firma o Immagine.

Toccare Mostra display e selezionare Tocca per mostrare per 10 secondi
0 Mostra sempre.

+ Toccare Strumenti rapidi e lettore musicale per scorrere sulle icone di
stato di Strumenti rapidi e lettore musicale.

+ Per aumentare la luminosita della funzione AOD (always-on display), toccare
Display pill luminoso.

« Per visualizzare la quida di Always-on display toccare Guida.

E « La batteria potrebbe scaricarsi piti velocemente quando si utilizza AOD (always-on
display). Spegnere questa funzione per risparmiare la batteria.

Per disattivare la funzione Always-on display, nella schermata Home toccare
Impostazioni > Display > AOD (always-on display), e quindi toccare @ .
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Note sulle proprieta di impermeabilita

Questo prodotto é resistente ad acqua e polvere in conformita con il grado di
protezione in ingresso IP68.

Il prodotto e stato sottoposto a test in un ambiente controllato ed e risultato
resistente all'acqua e alla polvere in determinate circostanze (soddisfa i requisiti
del grado di protezione IP68 specificati dallo standard internazionale IEC 60529
- Gradi di protezione per gli involucri [Codice IP]; condizioni di test: 15-35 °C, 86-
106kPa, 1,5 metri, per 30 minuti). Non esporre il dispositivo in condizioni diverse
dalle condizioni di test. | risultati possono variare in base all'uso effettivo.

A ATTENZIONE

Sebbene il dispositivo sia conforme allo standard IP68, potrebbe non essere
resistente alle condizioni non testate in un ambiente controllato da LG. Il colore
dell'indicatore LDI (Liquid Damage Indicator) cambia se si verificano danni provocati
da tali cause. Se il colore dell'indicatore LDl situato all'interno del prodotto cambia,
il dispositivo non verra considerato idoneo per i servizi di riparazione gratuiti forniti
con la garanzia limitata del prodotto.

Evitare di esporre il prodotto ad ambienti con eccessiva polvere o umidita. Non
utilizzare il prodotto nei seguenti ambienti.

@ Non immergere il prodotto in agenti chimici liquidi (come il sapone).
@ Non immergere il prodotto in acqua salata o acqua di mare.
Non immergere il prodotto in acqua calda.

Non nuotare portando il prodotto in acqua.

o fango.

Non immergere il prodotto in acqua profonda piti di 1,5 metri circa.
Non immergere il prodotto in acqua per pit di 30 minuti.

Non poggiare il prodotto direttamente su sabbia (ad esempio in spiaggia)

Funzioni personalizzate 33



Se il prodotto si bagna, strofinare il microfono, l'altoparlante e il jack stereo con
un panno asciutto prima dell'uso.

Se il prodotto o le proprie mani si bagnano, asciugarsi le mani e asciugare il
prodotto prima di toccare il dispositivo.

Non usare il prodotto in luoghi in cui potrebbe essere raggiunto da schizzi

di acqua ad alta pressione (ad es. vicino a un rubinetto o una doccia), né
immergerlo in acqua per periodi di tempo prolungati, poiché il prodotto non e
progettato per sopportare acqua ad alta pressione.

Questo prodotto e sensibile alle scosse elettriche. Non lasciar cadere o
sottoporre a scosse il prodotto, poiché cio potrebbe danneggiare o deformare
l'unita centrale provocando una perdita d'acqua.

Le caratteristiche di resistenza all'acqua e alla polvere del prodotto possono
risultare compromesse in sequito a una caduta o un urto.

Se il prodotto si bagna, utilizzare un panno morbido e pulito per asciugarlo
accuratamente.

Lo schermo a sfioramento e altre funzioni potrebbero non funzionare
correttamente se il dispositivo viene usato quando e bagnato.

Il prodotto e resistente allacqua solo quando il vassoio della SIM/Scheda di
memoria & inserito correttamente.

Non aprire o chiudere il vassoio della SIM/Scheda di memoria quando il prodotto
& bagnato o immerso in acqua. L'esposizione del vassoio aperto ad acqua e
all'umidita puo danneggiare il prodotto.

Il vassoio della SIM/Scheda di memoria contiene una guarnizione in gomma
che consente di impedire che polvere, acqua o umidita penetrino nel prodotto.
Non danneggiare la guarnizione in gomma perché polvere, acqua o umidita
potrebbero penetrare nel prodotto e arrecare danni.

A « Lamancata osservanza delle istruzioni fornite potrebbe rendere nulla la garanzia
limitata del dispositivo.

« Seil dispositivo & bagnato, I'LDI collocato all'interno del dispositivo cambia colore. In
questo caso, il dispositivo non sara idoneo per i servizi di riparazione gratuiti forniti
nel contesto della garanzia limitata del dispositivo

« Nonostante una valutazione IP68, il tuo dispositivo non & completamente
resistente all'acqua in tutte le situazioni.
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Componenti e accessori del prodotto

I sequenti articoli sono forniti in dotazione con il dispositivo.

+ Dispositivo + Caricabatteria
.+ Cavo USB + Guida introduttiva
+ Spillo di espulsione

A

Gli elementi descritti sopra possono essere facoltativi.

Gli elementi forniti in dotazione con il dispositivo ed eventuali accessori disponibili
possono variare a seconda dell'area e del provider del servizio.

Utilizzare sempre accessori LG Electronics originali. Lutilizzo di accessori di altri
produttori puo influire sulle prestazioni di chiamata del dispositivo o causare
malfunzionamenti. Il servizio di riparazione LG potrebbe non coprire simili
situazioni.

Alcune delle componenti del dispositivo sono fatte di vetro temperato. Se si lascia
cadere il dispositivo su una superficie dura o lo si espone a un urto violento, il vetro
temperato potrebbe danneggiarsi. In questi casi, interrompere immediatamente
['uso del dispositivo e contattare un Centro di assistenza clienti LG.

E + In mancanza di uno di questi elementi di base, contattare il rivenditore presso cui &
stato acquistato il dispositivo.
« Per acquistare altri elementi aggiuntivi, contattare un Centro di assistenza clienti
LG.
« Alcuni elementi contenuti nella confezione del prodotto sono soggetti a modifica
Senza preawiso.

L'aspetto e le specifiche del dispositivo sono soggetti a modifica senza preawviso ai
fini del miglioramento del prodotto.

Le specifiche del dispositivo possono variare a seconda dell'area o del provider del
Servizio.

Rimuovere la pellicola protettiva dal sensore di impronte digitali prima di utilizzare
la funzione di riconoscimento delle impronte digitali.
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Panoramica delle parti

Altoparlante auricolare ——

Obiettivo fotocamera anteriore ——

Tasti volume (+/-) —I:

Tasto Assistente Google —=
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e— Tasto accensione/blocco

— Touchscreen
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Jack stereo per auricolare
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Flash —
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Eﬂ:::*:\ Nano-SIM
©)
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D
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A Non tentare di rimuovere da sé il coperchio posteriore.

« Fare cio potrebbe danneggiare gravemente la batteria e il dispositivo, e cio
potrebbe causare surriscaldamento, incendi o infortuni. Il coperchio posteriore e
la batteria del dispositivo non devono essere rimossi o sostituiti da personale non
qualificato.

« Il telefono e un dispositivo elettronico che genera calore durante il suo normale
funzionamento. Il contatto diretto ed estremamente prolungato con la pelle
in assenza di unadeguata ventilazione puo provocare disagi e piccole ustioni.
Pertanto, maneggiare con cura il telefono durante o subito dopo ['utilizzo.

« Tastivolume

- Consentono di regolare il volume delle suonerie, delle chiamate o delle
notifiche.

- Durante [utilizzo della Fotocamera, premere delicatamente un tasto volume
per scattare una foto. Per scattare foto in maniera continua, tenere premuto
il tasto volume.

- Quando lo schermo & spento o bloccato, premere il tasto volume gili due
volte per awiare lapp Fotocamera. Premere due volte il tasto volume su per
awiare Capture+.

+ Tasto accensione/blocco
- Premere brevemente il tasto se si desidera accendere o spegnere lo schermo.
- Tenere premuto il tasto se si desidera selezionare unopzione di alimentazione.
+ Tasto Assistente Google
- Premere brevemente una volta per aprire Assistente Google. Tenere premuto
per aprire Assistente Google, quindi rimuovere il dito dal tasto per esequire la
funzione di comando vocale.
- Per ulteriori dettagli, consultare Assistente Google.
+ Sensore per impronte digitali
- E possibile utilizzare il sensore di impronte digitali in basso al centro
dello schermo per utilizzare la funzione di riconoscimento delle impronte
digitali. Per ulteriori dettagli, consultare la sezione Informazioni generali sul
riconoscimento delle impronte digitali.
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Alcune funzioni potrebbero essere limitate a seconda della regione e delle
specifiche del prodotto dei diversi fornitori di servizi di telecomunicazione.

i

Nella parte posteriore del prodotto sono integrati il chip NFC e le antenne di
ricarica wireless integrate. Fare attenzione a non danneggiare o coprire il chip NFC
o le antenne di ricarica wireless.

Non poggiare oggetti pesanti né sedersi sul dispositivo. In caso contrario, il
touchscreen potrebbe danneggiarsi.

La pellicola o accessori di protezione dello schermo potrebbero interferire con il
sensore di prossimita.

Se il dispositivo & bagnato o viene utilizzato in un luogo umido, il touchscreen o i
pulsanti a sfioramento potrebbero non funzionare correttamente.

Nel prodotto sono integrati due microfoni. Fare attenzione a non coprire i microfoni.
Mentre si parla al telefono, non coprire il microfono con le mani o le dita.

Non utilizzare custodie per telefono non originali, né coprire il microfono con
accessori, nastro adesivo ecc.

Quando si utilizza il prodotto, tenerlo correttamente, come mostrato nellimmagine.

Microfono Non coprite il microfono.

N

X

—— \

— !

4%
Microfono Non coprite il microfono.
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Accensione o spegnimento

Accensione
Quando il prodotto e spento, tenere premuto il tasto di accensione/blocco.
E + Quando si accende il dispositivo per la prima volta, viene avviata la configurazione

iniziale. La durata del primo awio dello smartphone potrebbe essere piti lunga di
quella abituale.

Spegnimento
Tenere premuto il tasto di accensione/blocco, quindi selezionare Spegni.

Riavvio del dispositivo

Se il dispositivo non funziona oppure non risponde ai comandi, riawviarlo seguendo
le istruzioni sottostanti.

1 Tenere premuti contemporaneamente il tasto di accensione/blocco e il tasto
volume giti fino a quando il dispositivo non si spegne.

7 Quando viene riawiato il dispositivo, rilasciare il tasto.

E + Questa funzione non é disponibile quando il dispositivo & collegato a LG Dual
Screen (LM-G905N).

Opzioni di alimentazione

Tenere premuto il tasto di accensione/blocco, quindi selezionare unopzione.
+ Spegni: Spegnere il dispositivo.
- Spegni e riavvia: consente di riawiare il dispositivo.
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Installazione della scheda SIM

Inserire la scheda SIM (Subscriber Identity Module, modulo d'identita dell'abbonato)
fornita dal provider del servizio per iniziare a utilizzare il dispositivo.

A « Utilizzare lo spillo di espulsione con cautela, poiché e dotato di unestremita
appuntita.

E « Affinché le caratteristiche di resistenza allacqua e alla polvere siano efficaci, &
necessario che lalloggiamento della scheda sia inserito correttamente.

1 Inserire la graffetta nel foro dellalloggiamento della scheda e premere la
graffetta, quindi estrarre lalloggiamento della scheda dal prodotto.

2 Allineare la scheda Nano-SIM o la scheda di memoria sullalloggiamento della
scheda e premere la scheda nella direzione della freccia come illustrato nella
figura.

Scheda SIM

Scheda di memoria (Opzionale, venduta
separatamente)
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E + Questo dispositivo supporta solamente le schede Nano SIM.

Nano Micro

« Affinché non si verifichino problemi di prestazioni, si consiglia di utilizzare il
dispositivo con il tipo corretto di scheda SIM. Utilizzare sempre una scheda SIM
realizzata in fabbrica, fornita dall'operatore.

« Non perdere la scheda SIM. LG non é responsabile di eventuali danni e altri
problemi causati dalla perdita o dal trasferimento di una scheda SIM.

Fare attenzione a non danneggiare la scheda SIM durante le operazioni di
inserimento e rimozione.

+ Quando siinserisce la carta SIM o la scheda di memoria, & necessario collocarla
correttamente nel foro di alloggiamento della scheda.

+ Quando inserisci di nuovo il foro di alloggiamento della scheda nel dispositivo, &
necessario inserirlo orizzontalmente seguendo la direzione della freccia, come
mostrato in figura. Assicurati che la scheda collocata sul foro di alloggiamento
della scheda non si sposti dalla posizione corretta.

Inserire la scheda SIM sull'alloggiamento con i contatti color oro rivolti verso il
basso.

Assicurati di inserire la carta SIM nel dispositivo seguendo le istruzioni nel manuale
utenti.

Se inserisci o rimuovi ['alloggiamento dal dispositivo, assicurati che non vi entrino
acqua o altri liquidi. Se un alloggiamento o una scheda bagnati vengono inseriti nel
dispositivo, questo potrebbe danneggiarsi.

« Lascheda di memoria e un elemento opzionale.

Operazioni frequenti di cancellazione e scrittura dei dati possono ridurre la durata
della scheda di memoria.

Alcune schede di memoria potrebbero risultare non completamente compatibili
con il dispositivo. Lutilizzo di una scheda incompatibile potrebbe causare il
danneggiamento del dispositivo o della scheda di memoria, oppure la corruzione
dei dati salvati al suo interno.
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Inserimento della scheda di memoria

Inserire la scheda di memoria nel dispositivo.

[l dispositivo e in grado di supportare una scheda microSD fino a 2 TB. A seconda
del produttore e del tipo di scheda di memoria, alcune schede di memoria
potrebbero non essere compatibili con il dispositivo.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda.

7 Estrarre lalloggiamento della scheda.

3 Posizionare la scheda di memoria sull'alloggiamento con i contatti color oro
rivolti verso il basso.

Scheda di memoria
(Opzionale, venduta separatamente)

L Scheda SIM )

/. Inserire nuovamente lalloggiamento nello slot.

A + Alcune schede di memoria potrebbero risultare non completamente compatibili
con il dispositivo. Lutilizzo di una scheda incompatibile potrebbe causare il
danneggiamento del dispositivo o della scheda di memoria, oppure la corruzione
dei dati salvati al suo interno.

E « Operazioni frequenti di cancellazione e scrittura dei dati possono ridurre la durata
della scheda di memoria.
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Rimozione della scheda di memoria

Per ragioni di sicurezza, disattivare la scheda di memoria prima di rimuoverla.
7 Nella schermata Home, toccare Impostazioni > Archiviazione > /\.

2 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda ed
estrarlo dal dispositivo.

w

Rimuovere la scheda di memoria.

4 Inserire nuovamente lalloggiamento nello slot.

A + Non rimuovere a scheda di memoria mentre il dispositivo sta trasferendo o
accedendo a informazioni. In caso contrario, potrebbe verificarsi la perdita o la
corruzione dei dati, oppure il danneggiamento della scheda di memoria o del
dispositivo. LG non & responsabile di eventuali perdite causate dallabuso o dall'uso
errato delle schede di memoria, compresa la perdita di dati.

Batteria

Carica della batteria
Prima di utilizzare il dispositivo, caricare completamente la batteria.
Caricare il dispositivo con il cavo USB tipo C.

Terminale del cavo di ricarica
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Non utilizzare o caricare il prodotto in presenza di umidita sulla porta di ricarica,
su terminali esposti, sul cavo di ricarica, sulladattatore di ricarica ecc. Il prodotto
potrebbe non funzionare correttamente o rompersi o danneggiarsi, e sussiste

il rischio di lesioni causate da scosse elettriche, incendio, surriscaldamento,
esplosione ecc. Se si nota la presenza di umidita in tali aree, interrompere
immediatamente ['utilizzo o la ricarica del prodotto e rimuovere completamente
l'umidita.

>

Non staccare il coperchio della batteria.

Questo prodotto utilizza una batteria non rimovibile. Non rimuovere o sostituire
il coperchio della batteria o la batteria. Se si rimuove o sostituisce il coperchio
della batteria o la batteria, il prodotto potrebbe venire danneggiato, e potrebbe
surriscaldarsi o esplodere.

Usare solo il cavo USB e ladattatore di ricarica forniti con il prodotto come
componenti di base.

Il dispositivo e dotato di una batteria ricaricabile interna. Per motivi di sicurezza,
non rimuovere |a batteria incorporata.

Lutilizzo del dispositivo durante il caricamento potrebbe causare scosse elettriche.
Per utilizzare il dispositivo, interrompere il caricamento.

Rimuovere il caricabatteria dalla presa di alimentazione una volta completato il
caricamento del dispositivo. In questo modo si evita un inutile consumo di corrente.

i

Un adattatore di ricarica che supporta la ricarica rapida e incluso nel prodotto. La
funzione di ricarica rapida potrebbe non funzionare se si utilizza un adattatore di
ricarica rapida diverso da quello originale fornito in dotazione con il prodotto.

Per caricare |a batteria, & anche possibile collegare un cavo USB tra il dispositivo
e un computer desktop o portatile. Questo metodo puo richiedere piti tempo
rispetto al collegamento delladattatore a una presa a parete.

Non caricare la batteria con un hub USB non in grado di mantenere la tensione
nominale. Il caricamento potrebbe non riuscire o arrestarsi inavvertitamente.

Quando ci si reca presso un centro di assistenza per un problema della batteria,
portare con sé il prodotto e il caricabatterie. Poiché la batteria & un materiale di
consumo, la durata della batteria potrebbe ridursi con il passare del tempo.
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Precauzioni per l'utilizzo del dispositivo

Assicurarsi di utilizzare il cavo USB fornito in dotazione, non utilizzare cavi USB
o caricabatterie di terze parti con il dispositivo. La garanzia limitata LG non copre
['uso di accessori di terze parti.

Il mancato rispetto delle istruzioni contenute in questa quida e [utilizzo non
corretto potrebbero portare al danneggiamento del dispositivo.

Ricarica wireless

Questo dispositivo supporta una funzione di ricarica wireless. Carica il dispositivo
con un caricabatteria wireless certificato Qi (opzionale, venduto separatamente).

Caricare la batteria con un caricabatteria wireless

1 Colloca il tuo dispositivo al centro del caricabatteria wireless, allineandolo con
I'antenna per la ricarica wireless sul retro del dispositivo.

+ Per controllare ['area dell'antenna per la ricarica wireless, vedere Panoramica
delle parti.

7 Quando la batteria & stata ricaricata, rimuovere il dispositivo dal caricabatteria.

A + Quando si ricarica la batteria con il caricabatteria wireless, evitare di porre materiali
magnetici, metallici o conduttori tra il dispositivo e il caricabatteria. Infatti, questi
materiali possono disturbare [a ricarica e far surriscaldare il caricabatteria. In
questo caso, il dispositivo, il caricabatteria o la carta SIM/scheda di memoria
possono essere danneggiati
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Se la temperatura della batteria supera un certo livello quando il dispositivo & in
carica, sara necessario interrompere (a ricarica.

Se materiali magnetici, metallici o conduttori dovessero trovarsi vicino al retro del
dispositivo, oppure fosse inserita una custodia protettiva, il dispositivo potrebbe
non essere caricato adeguatamente.

Se si ricarica la batteria con il caricabatteria wireless in aree in cui il segnale di
rete e debole, le prestazioni di rete del tuo dispositivo potrebbero essere ridotte
ulteriormente.

Carica il dispositivo con un caricabatteria wireless certificato Qi (opzionale, venduto
separatamente). Dato che la garanzia limitata LG non copre luso di accessori di
terze parti, contattare il produttore delle stesse.

Questo prodotto supporta la ricarica wireless. Per ricaricare il prodotto utilizzare
un caricabatterie wireless certificato Qi (venduto separatamente). Alcuni
caricabatterie wireless con cavo a spirale potrebbero non supportare |a ricarica
wireless. | caricabatterie che supportano il profilo EPP (Extended Power Profile)
consento la ricarica wireless ad alta velocita.

LG Electronics declina ogni responsabilita per problemi riguardanti accessori di
altre marche. Per tali problemi, contattare il produttore dellaccessorio.

Utilizzo efficiente della batteria

La durata della batteria puo diminuire se sul dispositivo sono in esecuzione diverse
app e funzioni contemporaneamente e in maniera continuativa.

Annullare le operazioni in background per aumentare la durata della batteria.

Per ridurre al minimo il consumo della batteria, sequire questi Consigli:

Disattivare la funzione Bluetooth o rete Wi-Fi quando non le si utilizza.

Impostare lo spegnimento dello schermo su un lasso di tempo il piti breve
possibile.

Ridurre al minimo la luminosita dello schermo.
Impostare un blocco schermo quando il dispositivo non € in uso.

Controllare il livello della batteria quando si utilizza una qualsiasi delle app
scaricate.
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Touchscreen

E possibile imparare a conoscere le modalita di controllo del dispositivo mediante
[utilizzo di gesti touch sul touchscreen.

Toccare

Toccare leggermente con la punta del dito per selezionare o eseguire unapp o
unopzione.

Tenere premuto

Toccare e tenere premuto per diversi secondi per visualizzare un menu con le
opzioni disponibili.
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Toccare due volte

Toccare rapidamente due volte per eseguire lo zoom avanti o indietro su una pagina
\Web o su una mappa.

Trascinamento

Toccare e tenere premuto un elemento, ad esempio un'app o un widget, quindi
spostare il dito in un'altra posizione con un movimento controllato. E possibile
utilizzare questo gesto per spostare un elemento.

Trascinare

Toccare lo schermo e muovere velocemente il dito senza fermarsi. E possibile
utilizzare questo gesto per scorrere un elenco, una pagina Web, delle foto, delle
schermate e altro ancora.

Funzioni di base 49



Awvicinare e allontanare le dita

Awvicinare due dita per eseguire lo zoom indietro, ad esempio su una foto o una
mappa. Per eseguire lo zoom avanti, allontanare le dita.

I

/,'

Non esporre il touchscreen a eccessivi urti fisici. |l sensore touch potrebbe
danneggiarsi.

Se il dispositivo viene utilizzato vicino a materiale magnetico, metallico o
conduttore, potrebbe verificarsi un guasto del touchscreen.

Se si utilizza il dispositivo sotto luci intense come la luce solare diretta, lo schermo
potrebbe non essere visibile a seconda della posizione. Utilizzare il dispositivo

in una posizione ombreggiata o con una luce ambiente non troppo intensa, ma
sufficientemente luminosa da consentire la lettura.

Non premere lo schermo applicando una forza eccessiva.

Toccare delicatamente ['opzione desiderata con la punta del dito.

Il controllo touch potrebbe non funzionare correttamente se si tocca lo schermo
indossando un guanto o con la punta dellunghia.

Il controllo touch potrebbe non funzionare correttamente se lo schermo & umido
0 bagnato.

Il touchscreen potrebbe non funzionare correttamente se sul dispositivo &
applicata una pellicola o un accessorio di protezione dello schermo acquistati da un
negozio di terze parti.

La visualizzazione di unimmagine statica per lunghi periodi di tempo potrebbe
causare il fenomeno delle immagini residue o di ritenzione delle immagini.
Spegnere lo schermo o evitare di visualizzare la stessa immagine per un lungo
periodo quando il dispositivo non € in uso.
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Schermata Home

Informazioni generali sulla schermata Home

La schermata Home ¢ il punto di partenza per accedere a diverse funzioni e app
sul dispositivo. Scorrere verso lalto dal bordo inferiore di qualsiasi schermata per
andare direttamente alla schermata Home.

Sulla schermata Home e possibile gestire tutte le app e i widget. Scorrere sulla
schermata verso sinistra o destra per visualizzare in un colpo docchio tutte le app
installate.

Layout della schermata Home

E possibile visualizzare tutte le app e organizzare i widget e le cartelle sulla
schermata Home.

Barra di stato —¢

Widget meteo —

+— Widget di ricerca di Google

Cartella —

[—%—————— Iconadella pagina
»— Area di accesso rapido

Barra di navigazione

E « Laschermata Home puo variare a seconda della politica del produttore, delle
impostazioni dell'utente, della versione del software o del provider del servizio.
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Barra di stato: consente di visualizzare le icone di stato, lorario e il livello della
batteria.

Widget meteo: consente di visualizzare le informazioni meteorologiche e
l'orario di una zona specifica.

Widget di ricerca di Google: digita o parla per aprire Google Search.

Cartella: £ possibile creare cartelle per classificare le app in base ai criteri
desiderati.

Icona della pagina: consente di visualizzare il numero totale di aree della
schermata Home. E possibile toccare licona della pagina desiderata per
accedere alla pagina selezionata. L'icona corrispondente allarea corrente verra
evidenziata.

Area di accesso rapido: e possibile fissare le app principali nella parte inferiore
dello schermo in modo che siano accessibili da qualsiasi area della schermata
Home.

Barra di navigazione: consente di andare alla schermata precedente o alla
schermata Home durante ['uso dellapp, e controllare lelenco delle app usate di
recente.

Uso della barra di navigazione
Questa ¢ la guida alle gesture per il controllo della barra di navigazione.
- Per andare alla schermata Home, scorrere verso 'alto dal bordo inferiore dello
schermo.
+ Per tornare alla schermata precedente, scorrere verso linterno dal bordo sinistro
o destro dello schermo.
+ Per andare alla schermata Panoramica, scorrere verso lalto e tenere premuto
dal bordo inferiore dello schermo.
+ Per passare rapidamente tra le app, scorrere verso destra sul bordo inferiore
dello schermo per andare alle app utilizzate in precedenza.

5 « Gesture é [impostazione predefinita per la barra di navigazione. Per cambiarla
aSolo pulsanti <] 1Q/ D nella schermata Home toccare Impostazioni >
Display > Barra di navigazione, quindi selezionare Solo pulsanti.
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Icone di stato

Quando & presente una notifica relativa a un messaggio non letto, un evento del
calendario o una sveglia, nella barra di stato viene visualizzata licona di notifica
corrispondente. Verificare lo stato del dispositivo visualizzando le icone di notifica
presenti nella barra di stato.

x

Nessun segnale

%

Trasmissione di dati tramite la rete 5G in corso

Sveglia impostata

Modalita vibrazione attiva

Bluetooth attivo

Collegato a un computer tramite USB

Livello batteria

Modalita Aereo attiva

Chiamate senza risposta

Wi-Fi attivo

Modalita silenziosa attiva

GPS attivo

Hotspot attivo

Nessuna scheda SIM

La modalita NFC ¢ attiva

Alcune di queste icone potrebbero apparire in modo diverso o non apparire
affatto a seconda dello stato del dispositivo. Fare riferimento alle icone in base
all'ambiente e alla zona effettivi in cui si utilizza il dispositivo nonché al provider
del servizio.

Le icone visualizzate possono variare a seconda dell'area o dei provider dei servizi.
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Pannello notifiche
E possibile aprire il pannello notifiche trascinando la barra di stato verso il basso
sulla schermata principale.
- E possibile trascinare verso il basso la finestra di awiso o toccare licona della
freccia per aprire l'elenco delle icone di impostazione rapida.
- E possibile toccare £ per aggiungere, eliminare o disporre le icone nella finestra
diawiso.
+ Tenendo premuta licona, viene visualizzata la schermata delle impostazioni
relative alla funzione in questione.

E - E possibile utilizzare il pannello notifiche anche durante il blocco schermo. Trascina
il pannello notifiche quando lo schermo & bloccato per accedere rapidamente alle
funzioni desiderate.
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Cambio di orientamento dello schermo

E possibile impostare il cambio automatico di orientamento dello schermo in base
allorientamento fisico del dispositivo.

Nel pannello notifiche, toccare Rotazione nellelenco delle icone di accesso rapido.

E possibile anche toccare Impostazioni > Display e attivare Rotazione automatica
nella schermata Home.

<ans

Modifica della schermata Home
Nella schermata Home, toccare e tenere premuto uno spazio vuoto, quindi awiare
l'azione desiderata da sotto.
+ Perridisporre le aree della schermata Home, toccare e tenere premuta un'area e
trascinarla in un'altra posizione.
+ Per aggiungere un widget alla schermata Home, toccare e tenere premuta
un‘area vuota della schermata Home, quindi selezionare Widget.

+ Per modificare sfondi, temi, icone e AOD, toccare e tenere premuta un'area
vuota della schermata Home, quindi selezionare Sfondo & Tema.
E inoltre possibile toccare Impostazioni > Display > Schermata Home >
Sfondo nella schermata Home, quindi selezionare sfondi, temi, icone e AOD da
applicare al dispositivo.
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Per modificare la griglia, toccare e tenere premuta un‘area vuota della
schermata Home, quindi selezionare Griglia. Toccare la griglia desiderata, quindi
toccare Applica.

Per configurare le impostazioni della schermata Home, toccare e tenere
premuta un'area vuota della schermata Home, quindi selezionare Imposta
schermata home. Per ulteriori dettagli, consultare la sezione Impostazioni della
schermata Home.

Per visualizzare o reinstallare le app disinstallate, toccare e tenere premuta
un‘area vuota della schermata Home, quindi selezionare Cestino app. Per
ulteriori dettagli, consultare la sezione Cestino app.

Per cambiare la schermata predefinita, toccare e tenere premuta un'area vuota
della schermata Home, spostarsi sulla schermata desiderata, toccare O, quindi
toccare nuovamente la schermata.

e—————— Schermata predefinita
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Visualizzazione del tema di sfondo

Nella schermata Home e possibile visualizzare solo l'immagine di sfondo
nascondendo app e widget.

Allontanare due dita sulla schermata Home.

+ Per tornare alla schermata originale con |a visualizzazione di app e widget,
awicinare le dita sulla schermata Home o trascinare verso lalto — dal bordo
inferiore dello schermo.

np

Spostamento di app sulla schermata Home
Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla in
un‘altra posizione.

+ Perinserire le app utilizzate pili spesso nella parte inferiore della schermata
Home, toccare e tenere premuta un'app, quindi trascinarla nellarea di accesso
rapido nella parte inferiore.

+ Per rimuovere un'icona dallarea di accesso rapido, trascinarla nella schermata
Home.
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Utilizzo delle cartelle dalla schermata Home

Creazione di cartelle

Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla su
un'altra app.
+ Viene creata una nuova cartella e le app vengono aggiunte al suo interno.

Modifica di cartelle

Nella schermata Home, toccare una cartella ed eseguire una delle seguenti azioni.
- Per modificare il nome della cartella, toccare il nome della cartella.
- Per modificare il colore, toccare il cerchio in alto a destra.

« Per aggiungere app, toccare e tenere premuta una app, quindi trascinarla sopra
la cartella e rilasciarla.

+ Per rimuovere un'app dalla cartella, toccare e tenere premuta l'app, quindi
trascinarla all'esterno della cartella. Se l'app rimossa e ['unica esistente nella
cartella, viene rimossa automaticamente anche la cartella.

- E possibile anche aggiungere o rimuovere le app dopo aver toccato ().

E + Quando si utilizza un tema scaricato, non e possibile modificare il colore della
cartella.
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Impostazioni della schermata Home
E possibile personalizzare le impostazioni della schermata Home.

1T Ne

lla schermata Home, toccare Impostazioni > Display > Sfondo.

7 Personalizzare le sequenti impostazioni:

Seleziona Launcher: consente di selezionare una modalita per la schermata
Home.

Sfondo: consente di cambiare lo sfondo della schermata Home.

Effetto scorrimento schermo: consente di selezionare un effetto da
applicare quando si passa a un‘altra area della schermata Home.

Aspetto delle icone: consente di scegliere se si desidera che le icone
abbiano gli angoli squadrati o arrotondati.

Feed Google: consente di visualizzare alla sinistra della schermata Home
principale.

Ordina le app per:Impostare la modalita di ordinamento delle app sulla
schermata Home.

Nascondi applicazioni: consente di selezionare le app da nascondere nella
schermata Home.

Scorrimento continuo: attivare per consentire lo scorrimento continuo della
schermata Home (ritorno alla prima schermata dopo ['ultima schermata).
Scorri verso il basso su Sfondo: consente di cercare app o contenuti, o
visualizzare le notifiche scorrendo verso il basso sulla schermata Home.
Scorri verso l'alto su Sfondo: consente di cercare app o contenuti, 0
visualizzare le notifiche scorrendo verso lalto sulla schermata Home.

Sfondo Lock: consente di impedire che le app o i widget siano spostati o
rimossi.
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Blocco schermo

Informazioni generali sul blocco schermo

Lo schermo del dispositivo si spegne e si blocca se si preme il tasto di accensione/
blocco. Il blocco awiene anche quando il dispositivo viene lasciato inattivo per un
determinato periodo di tempo.

Se si preme il tasto di accensione/blocco senza limpostazione di un blocco schermo,
viene immediatamente visualizzata la schermata Home.

Per maggiore sicurezza e per impedire |'accesso indesiderato al dispositivo,
impostare un blocco schermo.

E « Il blocco schermo impedisce inutili input tocco sullo schermo del dispositivo
e riduce il consumo della batteria. E altamente consigliabile attivare il blocco
schermo mentre non si usa il dispositivo.

Impostazione di un blocco schermo

Per la configurazione delle impostazioni del blocco schermo sono disponibili varie

opzioni.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Seleziona il blocco dello schermo e quindi selezionare il metodo preferito.

7 Personalizzare le sequenti impostazioni:
Nessuno: consente di disattivare la funzione di blocco schermo.

Trascina: consente di scorrere con un dito sullo schermo per sbloccarlo.

Sequenza: consente di disegnare una sequenza per sbloccare lo schermo.

PIN: consente di immettere una password numerica per sbloccare lo
schermo.

Password: consente diimmettere una password alfanumerica per sbloccare
lo schermo.

Impronte digitali: consente di sbloccare lo schermo utilizzando le impronte
digitali.
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Personalizza Blocco schermo

Puoi personalizzare il blocco schermo.

1 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Personalizza Blocco schermo.

2 Seleziona una funzione che vuoi impostare.
- Sfondo: Consente di impostare lo sfondo del blocco schermo.

+ Orologio: Consente di impostare il punto in cui posizionare ['orologio sul blocco
schermo.

« Collegamenti: Consente di scegliere le app da esequire sul blocco schermo.
Questa impostazione appare solo quando uno schermo di blocco viene
impostato.

+ Animazione meteo: Consente di visualizzare le animazioni meteo relative
alla posizione attuale sulla schermata di blocco.

+ Informazioni di contatto per telefono perso: Consente di impostare il
testo da visualizzare sulla schermata di blocco per identificare il proprietario
del telefono.

Impostazioni di Blocco con sicurezza
Puoi impostare blocchi schermo sicuri.

T Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Impostazioni di Blocco con sicurezza.

7 Seleziona una funzione che vuoi impostare.
- Rendi visibile la sequenza (visualizzato solo qguando come blocco schermo
@& impostata una sequenza): attivare questa opzione per rendere visibile la
sequenza.

+ Blocco timer: Consente di impostare l'intervallo di tempo prima che
lo schermo si blocchi automaticamente dopo lo spegnimento della
retroilluminazione (time out a causa di inattivita).

« Blocco istantaneo con tasto accensione: Attivare questa opzione
per bloccare istantaneamente lo schermo quando si preme il tasto di
accensione/blocco. Questa impostazione supera le impostaszioni del timer
del blocco di sicurezza.
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+ Mostra blocco (visualizzato solo quando & impostato un blocco schermo):
Attivare questa opzione per visualizzare l'icona di blocco tenendo premuto il
pulsante di accensione/blocco. Toccare l'icona di blocco per disattivare il smart
lock, lo sblocco biometrico e le notifiche sulla schermata di blocco.

+ Smart Lock: Consente di impostare dispositivi, luoghi, voce e/o rilevamento
su corpo affidabili che permettono al tuo telefono di restare sbloccato.

E « Le opzioni di menu disponibili possono variare a seconda del metodo di blocco
schermo selezionato.

Toc Toc
E possibile accendere o spegnere lo schermo toccandolo due volte.

E « Questa opzione é disponibile solo sulla schermata Home fornita da LG. Potrebbe
non funzionare correttamente su un launcher personalizzato o sulla schermata
Home installata dall' utente.

+ Quando si tocca lo schermo, utilizzare la punta di un dito. Non utilizzare un'unghia.

Per utilizzare la funzione Toc Toc, assicurarsi che il sensore di prossimita/luminosita
non sia ostruito da un adesivo o da un‘altra sostanza estranea.

Accendi lo schermo
Toccare due volte il centro dello schermo.

+ Sesitocca la parte superiore o inferiore dello schermo, la velocita di
riconoscimento potrebbe essere pit bassa.

Spegni lo schermo

Toccare due volte uno spazio vuoto nella schermata Home e nella schermata di
blocco.

In alternativa, toccare due volte uno spazio vuoto sulla barra di stato.

Disattivazione di Toc Toc
Se non si desidera utilizzare la funzione KnockON, impostare come segue:

Nella schermata Home, toccare Impostazioni > Estensioni > Toc Toc e trascinare
per disattivare la funzione.
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Crittografia della scheda di memoria

E possibile crittografare e proteggere i dati salvati sulla scheda di memoria.
l'accesso ai dati crittografati sulla scheda di memoria non sara possibile da un altro
dispositivo.

7 Nella schermata Home, toccare Impostazioni > Blocco schermo & sicurezza >
Crittografia e credenziali > Cripta la Scheda SD.

7 Leggere le informazioni generali sulla crittografia della scheda di memoria
visualizzate sullo schermo, quindi toccare Continua per continuare.
3 Selezionare un'opzione e toccare Crittografia.

- Crittografia del nuovo file: consente di crittografare solo i dati salvati sulla
scheda di memoria dopo la crittografia.

Crittografia completa: consente di crittografare tutti i dati attualmente
salvati sulla scheda di memoria.

+ Escludi file multimediali: consente di crittografare tutti i file ad eccezione di
quelli multimediali come musica, foto e video.

E + Una volta awiata la crittografia di una scheda di memoria, alcune funzioni non
sono disponibili.

Se il dispositivo si spegne mentre la crittografia e in corso, il processo di crittografia
non riuscira e alcuni dati potrebbero danneggiarsi. Occorre percio assicurarsi che il
livello della batteria sia sufficiente prima di awiare la crittografia.

L'accesso ai file crittografati & possibile solo dal dispositivo in cui i file sono stati
crittografati.

« Lascheda di memoria crittografata non puo essere utilizzata su un altro
dispositivo LG. Per utilizzare la scheda di memoria crittografata su un altro
dispositivo mobile, formattare la scheda

« E possibile attivare la crittografia della scheda di memoria anche se nel dispositivo
non é installata alcuna scheda di memoria. Qualsiasi scheda di memoria installata
dopo la crittografia verra automaticamente crittografata.
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Acquisizione di screenshot

E possibile acquisire screenshot della schermata che si sta visualizzando.

Tramite un collegamento rapido

Tenere premuti contemporaneamente il tasto di accensione/blocco e il Tasto
volume giu per almeno due secondi.

+ Gli screenshot possono essere visualizzati nella cartella Screenshots nella
Galleria.

Tramite screenshot
Nella schermata di cui si desidera acquisire uno screenshot, trascinare verso il basso
la barra di stato, quindi toccare o

E « Per ulteriori dettagli, consultare la sezione Scrittura di note su uno screenshot.

Funzioni di base 64



Immissione di testo

Utilizzo della barra degli strumenti Smart

E possibile usare vari metodi di immissione da tastiera da un'unica posizione. E
possibile selezionare il metodo di immissione desiderato dalla parte superiore della
tastiera.

1 Selezionare il metodo di immissione da tastiera desiderato dalla barra degli
strumenti Smart.

7 Toccare * « * e selezionare il metodo di immissione da visualizzare nella barra
degli strumenti Smart, oppure riorganizzarli.

_—
Barra degli strumenti —¢

Smart

E - E possibile aggiungere fino a 6 strumenti alla barra degli strumenti Smart.
+ | metodi di immissione supportati possono variare a seconda del dispositivo.

« E possibile attivare o disattivare la barra degli strumenti Smart dalle impostazioni
della tastiera.

« £ possiile anche utilizzare i metodi di immissione da tastiera toccando §83.

. @:Aggiungere €moji.
- [&): Aggiungere sticker.

- @ :Consente di usare la tastiera GIF di Tenor. Toccare Accetta per usare
questa funzione.

- (25 :Aggiungere emaji personali.
+ 22 :Aprire Draw Chat.
+ §63 : Accedere alle impostazioni della tastiera.

Funzioni di base 65



- :Toccare ® per inserire il testo con la propria voce.

- Per ottimizzare il riconoscimento dei comandi vocali, pronunciarli in modo
chiaro.

- Perimmettere testo con la voce, assicurarsi che il dispositivo sia connesso
aunarete.

- Per selezionare la lingua per il riconoscimento vocale, toccare %% > Lingue
sulla schermata del riconoscimento vocale.

- Questa funzione potrebbe non essere supportata o le lingue supportate
potrebbero variare a seconda della zona di copertura del servizio.

. - Aprire Appunti.

-/ :Inserire il testo mediante scrittura manuale. E necessario scaricare i
dati della lingua di immissione per la scrittura manuale. Toccare Scarica per
scaricare i dati della lingua di immissione per la scrittura manuale.

. Attivare a tastiera fluttuante quando si usa la funzione Multi Window. £
possibile anche spostare la testiera nella posizione desiderata.

- Toccare 59 nella barra degli strumenti Smart.

- Seil dispositivo é collegato a LG Dual Screen, e possibile acquisire lo
schermo di LG Dual Screen e allegarlo durante limmissione da tastiera.
Per maggiori informazioni, vedere Utilizzo di Cattura Immediata sul dual
screen.

- Toccare f8 nella barra degli strumenti Smart.

- Seil dispositivo & collegato a LG Dual Screen, e possibile espandere la
tastiera verticalmente e usare lo schermo superiore come schermo
dellapp e lo schermo inferiore come tastiera. Per maggiori informazion,
vedere Utilizzo della doppia tastiera sul dual screen.
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Utilizzo della tastiera Smart
E possibile utilizzare la tastiera Smart per immettere e modificare testo.

Con la tastiera Smart il testo viene visualizzato mentre lo si digita, senza dover
passare dalla schermata a una tastiera tradizionale e viceversa. In questo modo e
possibile trovare e correggere con facilita gli eventuali errori durante la digitazione.

Spostamento del cursore

Con la tastiera Smart & possibile spostare il cursore esattamente nella posizione
desiderata. Quando si digita un testo, toccare e tenere premuta la barra spaziatrice,
quindi trascinarla verso sinistra o destra.

E « Questa opzione é disponibile solo sulla tastiera QWERTY.

Suggerimento di parole

La tastiera Smart analizza automaticamente abitudini di utilizzo dell'utente per
suggerire le parole utilizzate pili spesso durante la digitazione. Quanto piu si utilizza
il dispositivo, tanto piti precisi saranno i Consigli.

Immettere un testo, quindi toccare una parola suggerita o trascinare delicatamente
verso [alto il lato sinistro o destro della tastiera.
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+ La parola selezionata viene inserita automaticamente. Non e necessario digitare
manualmente ogni lettera della parola.

- —
! !

e

")

Copia e incolla

E possibile tagliare o copiare del testo da unapp, quindi incollarlo nella stessa app. £
anche possibile eseguire altre app e incollare il testo al loro interno.

1 Toccare e tenere premuta l'area attorno al testo che si desidera copiare o
tagliare.

7 Trascinare @/ B per specificare l'area da copiare o tagliare.

3 Selezionare Taglia o Copia.
- Il testo tagliato o copiato viene aggiunto automaticamente agli Appunti.

/. Toccare e tenere premuta la finestra di inserimento del testo, quindi selezionare
Incolla.

E « Inassenza di un elemento copiato o tagliato, l'opzione Incolla non verra
visualizzata.
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Condivisione di contenuti

Riproduzione di contenuti da un altro dispositivo
E possibile riprodurre foto, video o canzoni salvate sul proprio dispositivo da una TV,
1 Connettere laTV e il dispositivo alla stessa rete Wi-Fi.

2 Mentre sivisualizzano gli elementi dell'app Galleria o Musica, toccare Cg o + >
Riproduci su un altro dispositivo.
Oppure, nella schermata Home toccare Impostazioni > Dispositivi connessi >
Condivisione schermo e quindi toccare () ) per attivare la funzione.

3 Selezionare la TV a cui si desidera connettersi.

E + Perlutilizzo con Chromecast, e consigliabile che i servizi di Google Play siano
aggiornati.

Visualizzazione di contenuti da dispositivi vicini

E possibile visualizzare contenuti da diversi dispositivi, come ad esempio un
computer; un dispositivo NAS o un dispositivo mobile, utilizzando le app Galleria o
Musica.

Connessione dei dispositivi

Connettere sia il proprio dispositivo che un altro dispositivo in grado di supportare
la funzione DLNA alla stessa rete wireless.

E « Assicurarsi che la Condivisione file (DLNA) sia attiva sia nel dispositivo mittente
che nel dispositivo connesso.
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Ricerca di dispositivi vicini
E possibile visualizzare un elenco di dispositivi DLNA connessi alla stessa rete
selezionando il menu ¢ > Dispositivi nelle vicinanze in ciascuna app.

Si possono utilizzare i contenuti di dispositivi vicini come se i si stesse utilizzando
sul proprio dispositivo.

Invio o ricezione di file

E possibile condividere file tra il proprio dispositivo e un altro dispositivo LG oppure
un tablet.

Invio di file

Dalla Galleria o altre app, toccare + > Condividi 0 <&, quindi selezionare un
dispositivo dallelenco di condivisione file.

Ricezione di file
Trascinare verso il basso la barra di stato e toccare Condivisione File.

Se il proprio dispositivo non supporta la funzione di condivisione file, nella
schermata Home toccare Impostazioni > Dispositivi connessi > Condivisione File
> SmartShare Beam () ).

E « E possibile condividere file con determinati dispositivi che supportano DLNA.
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Non disturbare

E possibile limitare o disattivare laudio delle notifiche per evitare di essere disturbati
per un determinato periodo di tempo.

Nella schermata Home, toccare Impostazioni > Suono > Non disturbare.
+ Toccare Modo e selezionare la modalita desiderata:

- Solo priorita: consente di ricevere le notifiche sonore o con vibrazione per le
app selezionate. Anche se ¢ attiva la modalita Solo priorita, le sveglie suonano
comunque.

- Silenzio totale: consente di disabilitare sia laudio che la vibrazione.

- Seleziona le priorita: rricevi allarmi e le notifiche per le app selezionate.
- Chiamate da:imposta una serie di notifiche quando ricevi una chiamata.

E « Chiamate ripetute: [a seconda chiamata dalla stessa persona entro 15 minuti non
viene resa silenziosa.

- Messaggi da:imposta una serie di notifiche quando ricevi un messaggio.
Utilizza modalita Non disturbare: Attiva la funzionalita Non disturbare.

Sonno:imposta il programma in base al quale attivare la funzionalita Non
disturbare.

Guida: Visualizzare la quida per Non disturbare.
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Installazione e disinstallazione di app

Installazione di app
E possibile accedere a uno store di app per cercare e scaricare delle app.

+ Sipuo utilizzare SmartWorld, Play Store o lo store di app fornito dal proprio
gestore del servizio.

E « Alcuni store di app potrebbero richiedere la creazione di un account e la
registrazione.

« Alcune app potrebbero essere a pagamento.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ SmartWorld potrebbe non essere supportato a seconda dell'area o del provider
del servizio.

Disinstallazione di app
Disinstallare le app inutilizzate dal dispositivo.

Disinstallazione con il gesto di tocco e pressione lunga

Tenere premuta unarea vuota della schermata, e quindi premere € dellapp da
eliminare.

Disinstallazione tramite il menu delle impostazioni
Nella schermata Home, toccare Impostazioni > Applicazioni > Informazioni
applicazione, selezionare unapp e quindi toccare Disinstalla.

E « Alcune app non possono essere disinstallate dagli utenti
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Disinstallazione di app dallo store di app

Per disinstallare un'app, accedere allo store di app da cui e stata scaricata e
disinstallarla.

Installazione e disinstallazione di app durante il

setup

Quando si accende il dispositivo per la prima volta, e possibile scaricare le app
consigliate.

E possibile saltare alla fase successiva senza linstallazione.

Cestino app
E possibile visualizzare le app disinstallate. E inoltre possibile reinstallare le app che
sono state disinstallate nelle ultime 24 ore.
1 Nella schermata Home, toccare Gestione > Cestino app.
Si puo inoltre toccare e tenere premuta unarea vuota della schermata Home,
quindi toccare Cestino app.
2 Attivare la funzione desiderata:
- Ripristina: consente di reinstallare lapp selezionata.
- T : consente di rimuovere definitivamente dal dispositivo le app disinstallate.

E « Le app disinstallate vengono rimosse automaticamente dal dispositivo 24 ore
dopo la disinstallazione. Se si desidera reinstallare le app disinstallate, & necessario
scaricarle nuovamente dallo store di app.

« Questa funzione ¢ attiva solamente sulla schermata Home. Se si disinstallano delle
app mentre si utilizza la schermata EasyHome o un altro launcher; queste vengono
immediatamente e definitivamente rimosse dal dispositivo.
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Scorciatoie applicazioni

Nella schermata Home, toccare e tenere premuta l'icona di una app come Chiama,
Invia messaggio, Camera, Galleria e Impostazioni per mostrare un menu di accesso
rapido. E possibile utilizzare le app in maniera pitt semplice grazie alle scorciatoie
per app.

- Toccare &) per impostare i widget per 'app.

+ Toccare (§) per visualizzare le informazioni sullapp.

E « Questa funzione é disponibile solo in alcune app.
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Telefono

Chiamata vocale

Per eseguire una chiamata vocale, utilizzare uno dei metodi disponibili, ad esempio
immettere manualmente un numero di telefono e selezionarlo dall'elenco dei
contatti o dall'elenco delle chiamate recenti.

Esecuzione di una chiamata dal tastierino numerico
71 Nella schermata Home, toccare (% > Componi.
2 Eseguire la chiamata utilizzando un metodo a scelta:

- Immettere un numero di telefono e toccare @@.

« Toccare e tenere premuto un numero di composizione veloce.

« Cercare un contatto toccando la lettera iniziale del relativo nome nell'elenco
dei contatti, quindi toccare 9.

E « Perimmettere "+" quando si esegue una chiamata internazionale, toccare e tenere
premuto il numero 0.

+ Consultare la sezione Aggiunta di contatti per ottenere ulteriori informazioni su
come aggiungere numeri di telefono all'elenco di selezione rapida.

Esecuzione di chiamate dalla Rubrica
1 Nella schermata Home, toccare (@ > Rubrica.

2 Dopo aver selezionato il numero da chiamare dallelenco dei contatti nella
rubrica, toccare &...
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Risposta a una chiamata
Per rispondere a una chiamata, trascinare ° sulla schermata della chiamata in
arrivo.
+ Se e collegato un auricolare stereo, e possibile eseguire le chiamate utilizzando il
pulsante di chiamata/fine sull'auricolare.
+ Per terminare una chiamata senza spegnere lo schermo, nella schermata Home
toccare Impostazioni > Rete & internet > Chiamata > Rispondi e termina
chiamate e quindi attivare Termina le chiamate con il tasto di accensione.

E « Nella schermata Home, toccare Impostazioni > Rete & internet > Chiamata >
Rispondi e termina chiamate > Termina le chiamate con il tasto di accensione,
& possibile terminare le chiamate premendo il tasto di accensione/blocco mentre &
attiva la schermata della chiamata in corso.

Rifiuto di una chiamata
Per rifiutare una chiamata in arrivo, trascinare ° attraverso la schermata della
chiamata in arrivo.
+ Per inviare un messaggio di rifiuto, trascinare ['opzione del messaggio di rifiuto
per la schermata.

Per aggiungere o modificare un messaggio di rifiuto, nella schermata Home
toccare Impostazioni > Rete & internet > Chiamata > Blocco chiamate &
Rifiuta con messaggio.

Quando & in arrivo una chiamata, premere il tasto volume su, volume giti o il
tasto di accensione/blocco per disattivare laudio della suoneria o la vibrazione,
oppure per mettere in attesa la chiamata.

Verifica di una chiamata in arrivo durante ['utilizzo
di unapp
Quando si riceve una chiamata mentre si sta utilizzando unapp, & possibile

visualizzare una notifica pop-up nella parte superiore della schermata. Si puo
accettare la chiamata, rifiutarla o inviare un messaggio dalla schermata pop-up.

E « Nella schermata Home, toccare Impostazioni > Rete & internet > Chiamata >
Altre impostazioni > Pop-up di chiamata in arrivo e quindi selezionare il modo
in cui si desidera visualizzare la chiamata in arrivo quando si usa un'app.
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Visualizzazione delle chiamate perse

In caso di una chiamata persa, nella barra di stato nella parte superiore dello
schermo viene visualizzato 4,

Per visualizzare i dettagli della chiamata persa, trascinare la barra di stato verso il
basso. E inoltre possibile toccare (& > Chiamate nella schermata Home.

Funzioni disponibili nel corso di una chiamata

Nel corso di una chiamata e possibile accedere a varie funzioni toccando i pulsanti
visualizzati sullo schermo:

Rubrica: consente di visualizzare l'elenco di contatti durante una chiamata.

Attesa: mette in attesa la chiamata corrente.

Tastiera: consente di mostrare o nascondere la testiera del telefono.

Vivavoce: consente di attivare la funzione vivavoce.

Muto: consente di silenziare la propria voce in modo che non possa essere udita
dall'interlocutore.

Bluetooth: consente di passare la chiamata a un dispositivo Bluetooth associato
€ Connesso.

- @ : consente di terminare una chiamata.
-+ :consente di accedere a opzioni di chiamata aggiuntive.

E + Levoci delle impostazioni disponibili possono variare a seconda dell'area e del
provider del servizio.
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Esecuzione di una chiamata a tre vie
E possibile esequire una chiamata a un altro contatto nel corso di una chiamata.

1 Durante una chiamata, toccare + > Aggiungi.

2 Immettere un numero di telefono e toccare .
+ Le due chiamate vengono visualizzate contemporaneamente sullo schermo
e la prima chiamata viene messa in attesa.

3 Per awiare una conferenza telefonica, toccare Unisci.

E « Puo essere addebitato il costo di ogni chiamata. Rivolgersi al proprio provider del
servizio per ulteriori informazioni.

Visualizzazione dei record delle chiamate
Per visualizgare i record delle chiamate recenti, nella schermata Home toccare (8 >
Chiamate. £ quindi possibile utilizzare le sequenti funzioni:
« Per visualizzare i record dettagliati delle chiamate, selezionare un contatto. Per
eseguire una chiamata a un contatto selezionato, toccare &...
+ Per eliminare i record delle chiamate, toccare = > Elimina.

E + Ladurata visualizzata delle chiamate potrebbe essere diversa da quella addebitata.
Rivolgersi al proprio provider del servizio per ulteriori informazioni.

« Lacronologia delle telefonate non pud essere recuperata una volta cancellata.

Stringi due dita o allargale per regolare la dimensione del carattere per i registri
delle chiamate o i contatti.

Configurazione delle opzioni di chiamata
E possibile configurare diverse opzioni di chiamata.
7 Nella schermata Home, toccare (% > Componi o Chiamate.

2 Toccare : > Impostazioni chiamate e quindi configurare le opzioni in base alle
proprie preferenze.
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Messaggi

Invio di un messaggio
E possibile creare e inviare messaqgi ai propri contatti utilizzando lapp di
messaggistica.

E « Linvio di messaggi all'estero potrebbe essere soggetto a ulteriori costi. Rivolgersi al
proprio provider del servizio per ulteriori informazioni.

1 Nella schermata Home, toccare ).

2 Toccare GHIID.

3 Specificare un destinatario e creare un messaggio.
+ Per usare le opzioni multimediali, tocca ().
« Per accedere alle voci di menu opzionali, toccare .

4 Toccare B> per inviare il messaggio.

Lettura di un messaggio

E possibile visualizzare i messaqgi scambiati organizzati per singolo contatto.

T Nella schermata Home, toccare ).

2 Selezionare un contatto dall'elenco dei messaggi.

E + Nell'elenco dei messaggi o nella finestra di chat, & possibile regolare le dimensioni

dei caratteri posizionando due dita sullo schermo e allontanando o awicinando
le dita.
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Configurazione delle impostazioni dei messaggi
E possibile modificare le impostazioni dei messaggi in base alle proprie preferenze.

1 Nella schermata Home, toccare B

2 Toccare ¢ > Impostazioni dall'elenco dei messaggi.

5 - E possibile specificare le impostazioni per la finestra di awiso, il blocco delle
chiamate, l'awiso di emergenza, i messaggi multimediali ecc.

Fotocamera

Awvio della fotocamera

E possibile scattare una foto o registrare un video per conservare tutti i momenti
memorabili

Nella schermata Home, toccare @

5

Prima di scattare una foto o registrare un video, pulire ['obiettivo della fotocamera
con un panno morbido.

Prestare attenzione a non macchiare [obiettivo della fotocamera con le dita o altre
sostanze.

Anche quando il telefono ¢ in vibrazione o silenzioso, il suono dell'otturatore si
attiva quando si scattano foto.

Le immagini incluse nella presente guida potrebbero essere diverse da quelle
effettive del dispositivo.

Le foto e i video possono essere visualizzati o modificati dalla Galleria. Per ulteriori
dettagli, consultare la sezione Informazioni generali sulla Galleria.

Non utilizzare il prodotto per scopi che potrebbero violare la privacy o i diritti di
altre persone.
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Scatto di una foto
E possibile scattare foto con la fotocamera del prodotto.

T Toccare (&) e mettere a fuoco il soggetto.
- E possibile toccare il soggetto da mettere a fuoco.
- E possibile allontanare o awicinare due dita per ingrandire o ridurre.

+ Selezionare uno zoom tra €19 / 9 / .

7 Sfiorare per scattare una foto.

- Einoltre possibile premere il tasto volume su o volume gili per scattare una
foto.

- E possibile scattare una foto durante la registrazione di un video premendo
® sullo schermo.

+ Le informazioni visualizzate nella schermata di ripresa possono variare a
seconda della fotocamera selezionata (anteriore o posteriore) e alla modalita
fotocamera.

« Lafotocamera si disattiva automaticamente se non la si usa per un po’ di
tempo dopo aver aperto lapp Fotocamera.

Awviare Google Lens

Modalita corrente della
Imposta/annulla _I fotocamera

limpostazione del timer ——— Passa alla fotocamera

anterlore/posterlore

Imposta/annulla —
limpostazione del flash

—

Applica leffetto filtro — l_—_l_'l e Scatta foto
| Selezionare lo zoom

Scegliere le proporzioni 1
dello schermo . N T Anteprima
Imposta la fotocamera I Ottimizzazione

automatica della scena
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E « E possibile aprire lapp della fotocamera premendo brevemente due volte il tasto
di accensione. Nella schermata Home, toccare Impostazioni > Estensioni >
Collegamenti e quindi toccare Apri Fotocamera per attivarla.

+ Quando lo schermo e spento o bloccato, awiare la fotocamera premendo due
volte il tasto volume gili.

+ Nella schermata Home, toccare Impostazioni > Estensioni > Collegamenti e
quindi toccare Apri Fotocamera @ ) per attivarla.

Personalizzazione delle opzioni della fotocamera
E possibile personalizzare varie opzioni in base alle proprie preferenze.

Toccare £33 sulla schermata.

E « Le opzioni disponibili potrebbero variare a seconda della fotocamera selezionata
(anteriore o posteriore) e alla modalita fotocamera selezionata.

Ottimizzazione
automatica della
scena

Riconoscendo la scena che viene registrata, applica automaticamente
limpostazione della risoluzione ottimale.

Riconoscendo la figura umana quando si scatta una foto a una

Composizione . . .

persona, consiglia la composizione ottimale.

Informa ['utente quando gli occhi del soggetto erano chiusi o
Consigli limmagine é sfocata, per consentire di ottenere una fotografia

ottimale.

Dimensioni foto

Consente di scegliere le dimensioni e le proporzioni della foto.

Consente di ottenere foto dai colori vividi ed effetti compensati
anche quando le foto sono scattate contro luce. Queste funzioni sono

HDR disponibili grazie alla tecnologia High Dynamic Range (HDR) integrata
nella fotocamera.
Correzione
distorsione Corregge la distorsione dello schermo quando si scattano foto ultra
scatti ultra grandangolari.
grandangolari
Risparmia spazio di archiviazione comprimendo il file immagine in
Salva in HEIF formato HEIF. Altri dispositivi potrebbero non supportare i file video

in formato HEIF
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Foto dal vivo Registra 'azione prima e dopo aver scattato una foto.

Consente di visualizzare le griglie di guida in modo da poter scattare
Griglia foto o registrare video in base alle linee di riferimento orizzontali e
verticali

Consente di scattare una foto pronunciando ‘Cheese, ‘Smile]

ScattoalCheese | \\\icverriimehi o G

Aggiungi firma Consente di visualizzare una firma personalizzata sulle foto.

Tag posizione Consente di salvare limmagine completa di dati sulla posizione GPS.

Consente di selezionare se si desidera archiviare le immagini e i video
Archiviazione nellArchivio interno o nella Scheda SD. (Disponibile quando la scheda
di memoria & inserita.)

Guida Fornisce una guida per ciascun menu della fotocamera.

Opzioni aggiuntive della fotocamera anteriore

Correzione della

distorsione selfie Corregge le parti distorte del viso

Salva come

Salva le immagini come capovolte dopo aver scattato dei selfie.
capovolta

Scatta un selfie selezionando le sue opzioni tra Scatto tramite gesto

i selfi
Scatto di selfie della mano e Scatto automatico.

E - E possibile applicare leffetto make-up quando si scatta un selfie con la fotocamera
anteriore,
+ Scatto con gesture viene effettuato mediante il riconoscimento della forma di
una mano e Scatto automatico viene effettuato mediante il riconoscimento di
un viso,
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Selezione della modalita

5 possibile selezionare comodamente tra le modalita visualizzate sullo schermo, che
sono selezionate per adattarsi all'ambiente di ripresa.

Toccare (&) e scorrere le modalita della fotocamera verso sinistra o destra, oppure
scorrere lo schermo a sinistra o a destra per selezionare una modalita della
fotocamera.

< lnmp

]

Modalita della fotocamera
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Uso delle modalita della fotocamera

Registrazione di un video
1 Toccare @ e selezionare Video scorrendo le modalita della fotocamera.

2 Toccare e per registrare un video.

Imposta la fotocamera ——e e—— Imposta/annulla
] ] limpostazione del flash

Applica leffetto filtro

Selezionare la risoluzione dello
schermo

Attiva/disattiva Steady Cam ——

e————————— Selezionare lo zoom
Anteprima ——— e——— Passaalla fotocamera
anteriore/posteriore

]

L———————————— Registrazione di un video

« Per scattare una foto mentre si registra un video, toccare © .

- Per mettere in pausa la registrazione del video, toccare (11
registrazione del video, toccare (® .

Per riprendere la

+ Mentre registri un video, puoi stringere o allargare due dita per ingrandire o
rimpicciolire.

+ Mentre registri un video, puoi toccare |'area desiderata per regolare la
luminosita.

E possibile passare dalla fotocamera anteriore a quella posteriore e viceversa
mentre si registra un video premendo {o.

3 Toccare (= per terminare la registrazione del video.

E « E possibile risparmiare spazio di archiviazione impostando lopzione Salva in HEVC
in §83. Questa comprime il file video in formato HEVC.

« Altri dispositivi potrebbero non supportare i file video in formato HEVC.
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Scatto di una foto
Toccare () e selezionare Foto scorrendo le modalita della fotocamera.
Per ulteriori informazioni, consultare la sezione Scatto di una foto.

Scatto di ritratti

E possibile scattare foto in cui il soggetto risalta ed & pits distinto sfocando lo
sfondo.

1 Toccare G e selezionare Ritratto scorrendo le modalita della fotocamera.

+ Selezionare un effetto desiderato scorrendo le opzioni di effetto disponibili
per Ritratto.

- Toccare &) per regolare il valore di apertura.

2 Sfiorare () per scattare una foto.

Imposta la fotocamera —- ~— Imposta il timer

Scegliere le proporzioni dello
schermo

Imposta il valore di apertura

«— Selezionare unopzione

di effetto per il ritratto.

Quando appare il messaggio “Ritratto & disponibile’, iniziare a scattare una foto.

i

« La funzione Ritratto potrebbe non essere disponibile se la fotocamera non € in
grado di riconoscere il soggetto-

« Durante lo scatto di foto, mantenere una distanza di 1,3 ~ 5 piedi dal soggetto.
« Questa funzionalita non & disponibile se 'ambiente e buio.
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Uso di un adesivo
E possibile applicare una varieta di adesivi alle foto o ai video.
E possibile creare contenuti pili ricchi usando Effetto AR 3D.
1 Toccare @ e selezionare Sticker scorrendo le modalita della fotocamera.
« Selezionare adesivo desiderato scorrendo gli adesivi.
7 Toccare(  per scattare una foto, oppure toccare e tenere premuto (| per
registrare un video.
+ Non & possibile passare dalla fotocamera anteriore a quella posteriore e
viceversa mentre si registra un video.
3 Toccare = per terminare la registrazione del video.
- Lafoto ol video viene salvato nella Galleria.

Imposta la fotocamera —* +— Imposta il timer
Scegliere le proporzioni dello —41
schermo

E - Toccare @ per usare Adesivi AR 3D.
Per ulteriori informazioni, consultare la sezione Effetto AR 3D.
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Uso di altre modalita della fotocamera
Toccare (&) e selezionare Altro scorrendo le modalita della fotocamera.

Vista notturna

E possibile scattare foto notturne vivide e nitide. Vista notturna si attiva
automaticamente quando si scattano foto in condizioni di luminosita ridotta.

E possibile anche riprendere scene notturne nitide utilizzando la funzione Vista
notturna manualmente.
1 Toccare () e selezionare Altro scorrendo le modalita della fotocamera.
2 Toccare (.
- Selezionare uno zoom tra @9 / @),
3 Sfiorare () per scattare una foto.
+ Per regolare la luminosita della foto, spostare & a sinistra o a destra.

Imposta la fotocamera ——e e—— Imposta il timer
Scegliere le proporzioni dello ——T
schermo

+—— Regola la luminosita

E « Rimanere fermi, in modo che la fotocamera non scuota mentre si scatta una foto.
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Panoramica

E possibile creare una foto panoramica spostando la fotocamera nella direzione da
fotografare e unire gli scatti continui di una vista ampia.

1 Toccare (&) e selezionare Altro scorrendo le modalita della fotocamera.
2 Toccare ;X
- Selezionare uno zoom tra @9 / @),
3 Toccare , quindi spostare lentamente la fotocamera in una sola direzione.

4 Toccare @ per interrompere acquisizione della panoramica.

Imposta la fotocamera —s

E + Quando si sposta la fotocamera in una direzione, assicurarsi che ['inquadratura
ripresa non sia fuori dalla linea guida.

App utili 90



Fotocamera manuale

E possibile creare foto dal tocco professionale grazie a varie funzioni avanzate.
1 Toccare G e selezionare Altro scorrendo le modalita della fotocamera.

2 Toccare &),

3 Personalizzare le sequenti impostazioni della fotocamera.

+ Selezionare uno zoom tra @9 / @3.

+ Se per le opzioni si imposta Auto, le opzioni vengono regolate
automaticamente in base al soggetto e allambiente di ripresa.
« Se e impostata lopzione Focus peaking, larea di messa a fuoco viene

evidenziata con u n colore. Questa funzione e disponibile solo nella modalita
Messa a fuoco manuale (MF).

Imposta la fotocamera ——e —— Imposta il timer
Scegliere le proporzioni dello ] ] Imposta il flash
schermo

Applica leffetto filtro —

Resetta le —————— o— Visualizza le varie
impostazioni opzioni di Graphy
~ Regolail —— L Regolareilla

bilanciamento velocita
del bianco dellotturatore
Regola la messa Regola la velocita
afuoco
ISO
Regola la
luminosita

A Toccare(  per scattare la foto.
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Se si tocca @ e si seleziona un effetto Graphy, appare un elenco delle foto

consigliate con varie impostazioni.

La selezione degli effetti Graphy consente di scattare utilizzando il bilanciamento

del bianco, la velocita dell'otturatore e i valori di impostazione ISO applicati alla foto
consigliata.

Questa funzione e disponibile solo nella modalita Fotocamera manuale.
E possibile vedere una varieta di foto consigliate scaricando l'app Graphy da

Google Play Store.

A seconda del proprio piano tariffario, potrebbe essere addebitato il costo dei dati

utilizzati per il download.

Toccare §83, quindi toccare @ ) nel menu Foto con Graphy per disattivare questa
funzione.

Personalizzazione delle opzioni della fotocamera

E possibile personalizzare varie opzioni in base alle proprie preferenze.

Toccare £33 in Fotocamera manuale.

Dimensioni foto

Consente di scegliere le dimensioni e |a risoluzione della foto.

Salvare come
RAW

Limmagine e salvata nel formato file RAW, in modo tale che sia possibile
modificarla.

Durante lo scatto vengono creati i file DNG e JPEG, poi vengono salvati
come immagini ad alta risoluzione non compresse.

Correzione
distorsione
scatti ultra
grandangolari

Corregge la distorsione dello schermo quando si scattano foto ultra
grandangolari.

Foto con Graphy

Regolare il bilanciamento del bianco, l1SO e la velocita dell'otturatore per
la foto consigliata.

Per ulteriori dettagli, consultare la sezione Fotocamera manuale.

Guida

Consente di visualizzare le griglie di guida in modo da poter scattare
foto in base alle linee di riferimento orizzontali e verticali.

Aggiungi firma

Consente di visualizzare una firma personalizzata sulle foto.

Tag posizione

Consente di salvare limmagine completa di dati sulla posizione GPS.
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Consente di selezionare se si desidera archiviare le immagini e i video
Archiviazione nellArchivio interno o nella Scheda SD. (Disponibile quando la scheda di
memoria & inserita.)

Guida Fornisce una guida per ciascun menu della fotocamera.

Slow Motion

Crea video divertenti modificando la velocita di movimento. Questa funzione e utile
quando si desidera riprodurre un video a una velocita inferiore rispetto alla velocita
effettiva della clip originale.

T Toccare (&) e selezionare Altro scorrendo le modalita della fotocamera.

7 Toccare @.
3 Selezionare un intervallo @ o il filmato intero L, a cui applicare leffetto slow
motion.
+ Parte al rallentatore: Consente di applicare leffetto slow motion a una
sezione specifica del video.

- Premere © nel momento in cui si desidera che venga applicato leffetto
slow motion. Con una breve pressione, leffetto slow motion viene
applicato per 0,5 secondi. Con una pressione prolungata, leffetto slow
motion viene applicato fino a quando non si rilascia il dito.

- Tutte le Slow Motion: Consente di applicare leffetto slow motion all'intero
video.

App utili 93



Impostazioni ——e e— Imposta il flash

Selezionare un intervallo —41

/L Toccare ‘e per riprendere un video.

+ Per mettere in pausa la registrazione del video, toccare (1), Per riprendere la
registrazione del video, toccare (@ .

5 Per terminare la ripresa, premere @.

YouTube Live
E possibile registrare un video e caricarlo direttamente su YouTube.

Per utilizzare questa funzione, & necessario soddisfare i requisiti di idoneita. Per i
requisiti, contattare YouTube.

1 Nella schermata Home, toccare G
7 Selezionare Altro scorrendo le modalita della fotocamera, quindi toccare ((e)).
E « YouTube Live & disponibile solo quando il proprio dispositivo & connesso a Internet.

Se si utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.
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Utili funzioni della fotocamera

Scatto di foto con la funzione Al

Quando si scatta una foto, la funzione Al riconosce il soggetto e applica l'effetto
ottimale alla foto.

5 + Toccare . per disattivare la funzione Al

Blocco Esposizione automatica/Messa a fuoco automatica

E possibile fissare il livello attuale di esposizione e mettere a fuoco la posizione
toccando e tenendo premuta lo schermo nella modalita automatica. Per disattivare
la funzione, toccare unarea vuota sulla schermata.

Blocco Esposizione
automatica/Messa a
fuoco automatica

E « Questa funzione é disponibile solo in alcune modalita specifiche.
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Passaggio dalla fotocamera posteriore a quella anteriore e
viceversa

E possibile passare dalla fotocamera anteriore a quella posteriore e vice versa in
base allambiente circostante.

+ Per passare tra la fotocamera anteriore e posteriore, scorrere lo schermo verso

lalto o verso il basso nella schermata di ripresa dellapp Fotocamera.

<=1 @ 11mp

E « Utilizzare la fotocamera anteriore per scattare i selfie. Per ulteriori dettagi,
consultare la sezione Scatto di selfie.

Zoom avanti o indietro

E possibile allontanare o awicinare due dita per ingrandire o ridurre quando si
scattano foto o si registrano video.

E « Lafunzione di zoom avanti/indietro non & disponibile in modalita selfie

(fotocamera anteriore).
+ Questa funzione non e supportata in diverse modalita.
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Utilizzo di Burst Shot

E possibile scattare foto consecutive e visualizzarle come immagini in movimento
nella Galleria.

T Toccare (&) e selezionare Foto.

2 Tenere premuto
+ Vlengono scattate pili foto consecutive mentre si tiene premuto

Scatto tramite gesto della mano
E possibile scattare selfie tramite gesti.

Mostrare il palmo della mano alla fotocamera anteriore e quindi stringere il pugno.

E inoltre possibile stringere il pugno e poi aprirlo verso la fotocamera anteriore.
+ Dopo tre secondi la foto viene scattata.

o

| S

m

« Per utilizzare questa funzione, passare alla modalita fotocamera anteriore, quindi

toccare §83 > Scatto di selfie > Scatto tramite gesto della mano.

« Assicurarsi che il palmo e il pugno siano all'interno della linea di riferimento in
modo che la fotocamera possa rilevarli.

« Questa funzione potrebbe non essere disponibile mentre sono in uso alcune altre
funzioni della fotocamera.
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Scatto automatico

E possibile utilizzare la funzione di rilevamento del volto per scattare selfie in
maniera semplice e comoda. Si pud impostare il dispositivo in maniera tale che,
quando ['utente quarda verso lo schermo, la fotocamera anteriore rilevi il volto e
scatti automaticamente un selfie.

+ Quando la fotocamera anteriore rileva il volto, viene visualizzata la cornice guida
di colore bianco. Se il soggetto allinterno della cornice guida smette di muoversi,
la cornice guida diventa blu, quindi la fotocamera scatta una foto.

- Toccare §83 > Scatto di selfie > Scatto automatico per attivare la funzione
Scatto automatico.

Scatto intervallato
E possibile scattare selfie a intervalli regolari.

Mentre & in uso la fotocamera anteriore, mostrare il palmo della mano alla
fotocamera, quindi stringere rapidamente il pugno per due volte.

+ Vengono scattate quattro foto a intervalli regolari dopo un timer di ritardo di tre
secondi.

Salva come capovolta

Prima di scattare una foto con la fotocamera anteriore, toccare §63 > Salva come
capovolta. Limmagine viene capovolta in senso orizzontale.

E « Durante [utilizzo della fotocamera anteriore, & possibile modificare le modalita di
scatto dei selfie nelle opzioni della fotocamera. Per ulteriori dettagli, consultare la
sezione Personalizzazione delle opzioni della fotocamera.

Scatto di selfie

E possibile utilizzare la fotocamera anteriore per visualizare il proprio volto sullo
schermo e scattare selfie.

1 Toccare @ e selezionare Foto scorrendo le modalita della fotocamera.
7 Toccare {o) per passare alla fotocamera anteriore.

3 Toccare(  per scattare le foto.
- Toccare §) per applicare vari effetti estetici.
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Galleria

Informazioni generali sulla Galleria
E possibile visualizzare e gestire le foto e i video salvati sul dispositivo.

Visualizzazione delle foto
E possibile visualizzare le foto salvate nel prodotto.
1 Toccare c e selezionare la cartella desiderata.

7 Toccare la foto desiderata.
+ Lacartella Galleria contiene Foto, Album, Ricordi, e Play.

| — Awviare Google Lens.
- . .
Consente di tornare alla —e +—— Consente di accedere a opzioni
schermata precedente. aggiuntive,

»— Galleria anteprime

Consente di aggiungereao —e — Consente di eliminare le

rimuovere dai preferiti —[ immagini.
Consente di condividere le

Consente di modificare le immagini.
immagini.

E « Toccando leggermente lo schermo, appare il menu Dettagli. Toccando nuovamente
lo schermo, il menu scompare.
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Riproduzione di un video
E possibile riprodurre i video salvati nel prodotto.

Consente di tornare —s «— Consente di accedere
alla schermata a opzioni aggiuntive.
precedente.

Consente di riprodurre. ———
o sospendere la
riproduzione del video.

»— Galleria anteprime

Consente di aggiungere ao —e o— Consente di eliminare le

rimuovere dai preferiti. —[ immagini.
Consente di condividere le

Consente di modificare le immagini.
immagini.

5 Per regolare il volume dell'audio, trascinare in alto o in basso il lato destro della
schermata del video.

Per regolare la luminosita dello schermo, trascinare verso lalto o verso il basso il

lato sinistro della schermata.

Trascinando lo schermo a sinistra nella schermata di riproduzione video e possibile

riawolgere (REW) e trascinando a destra & possibile avanzare rapidamente (FF).
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Eliminazione di file
E possibile eliminare file utilizzando una delle sequenti opzioni:
+ Toccare e tenere premuto un file nell'elenco, quindi toccare Elimina.

- Ifile eliminati vengono spostati automaticamente nel + > Cestino e possono

essere ripristinati nella Galleria entro 7 giorni.

- Toccare [x] per eliminare completamente i file. In questo caso, i file non potranno

essere ripristinati.

Condivisione di file
E possibile condividere file utilizzando una delle sequenti opzioni:

- Mentre si visualizza una foto o un video, toccare o< per condividere il file
utilizzando il metodo desiderato.

5

Se si scattano foto o si registrano video dopo aver toccato @ > €§3 >Tag
posizione @ ), dopo un po' di tempo nella scheda Memorie di Galleria viene
creato automaticamente un album di memorie specifiche della posizione.

toccando Q nella Galleria.

Alcuni formati file potrebbero non essere supportati a seconda del software
installato.

Alcuni file potrebbero non aprirsi a causa della codifica.
« [file di dimensioni superiori al limite massimo potrebbero generare un errore.

« Devi attivare la funzionalita GPS per creare album di Memoria.

Realizzazione di un collage
Puoi creare un collage dai contenuti associati.
T Toccare (M e selezionare : > Realizza collage.

2 Selezionare le immagini desiderate da aggiungere al collage, quindi toccare
Realizza collage.

+ Selezionare il layout desiderato sul fondo dello schermo.
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3 Toccare Crea.

E « Per creare un collage possono essere utilizzate un massimo di 9 immagini.

Creazione di un filmato

E possibile creare un nuovo filmato, mettendo insieme immagini e video.
T Toccare (Y e selezionare : > Crea filmato.

7 Selezionare immagini o video per il filmato e toccare Crea filmato.

3 Modificare le immagini e i video selezionati, quindi toccare Salva.

— File interessati
[— Reimpostazione dei file
— Anteprima di un file

Eliminazione di file —————

Aggiunta di file

E « Per creare un filmato possono essere utilizzati un massimo di 50 video.
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Realizzazione di una GIF
E possibile realizzare una GIF con facilita utilizzando un video registrato.
Toccare [ e selezionare Realizza una GIF.

Creazione di un video

1 Durante la visualizzazione del video, in corrispondenza del punto di partenza
desiderato, toccare @,

7 Selezionare la durata della GIF che si desidera creare.

+ Viene generata una GIF della durata desiderata a partire dal punto iniziale
specificato.

« Perivideo di durata inferiore ai 5 secondi, le immagini GIF vengono generate
automaticamente per il tempo restante.

Creazione di fotografie GIF
71 Nellelenco delle fotografie nella galleria, toccare > Crea GIF.

7 Selezionare unimmagine da trasformare in fotografia GIF e quindi toccare Crea
GIF.

- E possibile aggiungere/eliminare una fotografia, regolare la velocita o le
proporzioni dello schermo e impostare ['ordine delle fotografie.

E + La creazione di fotografie GIF e una funzione che consente all'utente di
produrre immagini creative. La violazione dei diritti di proprieta intellettuale o la
diffamazione della reputazione di altre persone mediante la funzione di creazione
di fotografie GIF possono comportare responsabilita civili o penali in conformita
con le leggi vigenti. Fare attenzione a non copiare o trasmettere opere di altre
persone senza autorizzazione. LG Electronics declina ogni responsabilita per tali
azioni degli utenti

Quando si crea una fotografia GIF, € possibile selezionare di produrre finoa 100
fotografie.
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Rubrica

Informazioni generali sui contatti
E possibile salvare e gestire i contatti.
Nella schermata Home, toccare Essenziali > Rubrica.

Aggiunta di contatti

Aggiunta di nuovi contatti

T Nella schermata dell'elenco dei contatti, toccare .

« Appare un pop-up che consente di selezionare la posizione di salvataggio del
contatto. Selezionare la posizione desiderata.

7 Immetterei dettagli del contatto e toccare Salva.

Importazione di contatti
E possibile importare contatti da un altro dispositivo di archiviazione.

1 Nella schermata dell'elenco dei contatti, toccare > Gestisci contatti >
Importa.

2 Selezionare le posizioni di origine e di destinazione del contatto che si desidera
importare, quindi toccare OK.

3 Selezionare i contatti e toccare Importa.

Aggiunta di contatti all'elenco di composizione veloce

1 Nella schermata dell'elenco dei contatti, toccare > Selezione rapida.
7 Toccare Aggiungi contatto da un numero di composizione veloce.

3 Selezionare un contatto.

E + Mentre siaggiunge un nuovo contatto, toccare [3{3 per aggiungere un numero di
chiamata rapida.
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Ricerca di contatti
E possibile ricercare contatti utilizzando una delle sequenti opzioni:

+ Toccare la barra di ricerca nella parte superiore della schermata Rubrica e
inserire il contatto o il numero di telefono che si desidera cercare.

« Scorrere |'elenco dei contatti verso lalto o verso il basso.

« Dall'indice della schermata dell'elenco dei contatti, toccare la lettera iniziale di
un contatto.

E + Premendo la barra di ricerca nella parte superiore della schermata Rubrica e
inserendo un contatto o un numero di telefono, vengono visualizzati i risultati della
ricerca integrati dalla cronologia delle chiamate e dall'elenco dei contatti salvati
nel prodotto.

Elenco dei contatti

Modifica di contatti
71 Nella schermata dell'elenco dei contatti, selezionare un contatto.
7 Nella schermata dell'elenco dei contatti, toccare f e modificare i dettagli.

3 Toccare Salva per salvare le modifiche.

Eliminazione di contatti
E possibile eliminare contatti utilizzando una delle sequenti opzioni:

+ Nella schermata dellelenco dei contatti, toccare e tenere premuto un contatto
che si desidera eliminare, quindi toccare 11}

- Toccare + > Elimina nella schermata dellelenco dei contatti.

E + | contatti cancellati non possono essere recuperati.
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Aggiunta ai preferiti
E possibile registrare i contatti utilizzati pili spesso come preferiti.
71 Nella schermata dell'elenco dei contatti, selezionare un contatto.

2 Nella schermata dei dettagli dei contatti, toccare sﬁ;

Creazione di gruppi

1 Dallelenco dei gruppi di contatti, toccare -

2 Immettere il nome del nuovo gruppo.

3 Toccare Aggiungi iscritti, selezionare i contatti, quindi toccare Aggiungi.

/. Toccare Salva per salvare il nuovo gruppo.

QuickMemo+

Informazioni generali su QuickMemo+

E possibile generare note creative utilizzando una varieta di opzioni su questa
funzione avanzata del blocco note, come ad esempio la gestione immagini e gli
screenshot, che non sono supportati dal blocco note tradizionale.

Questo dispositivo supporta Active Pen AES2.0 (Active Electrostatic).

Creazione di una nota
71 Nella schermata Home, toccare Essenziali > QuickMemo+.
2 Toccare @ per creare una nota.
- @ : consente di salvare una nota.
+ <5 :Annullare le modifiche precedenti.
+ (7 :Applicare di nuovo le modifiche annullate di recente.
T :consente di immettere una nota utilizzando la tastiera.
- 9 :consente di salvare i tipi di penna preferiti.
-/ :consente di scrivere delle note a mano.
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- & :consente di cancellare le note scritte a mano.
- g :consente di passare al font calligrafico quando si scrive a mano.
-+ :Consente di accedere a opzioni aggiuntive.

3 Toccare @ per salvare la nota.

Scrittura di note su uno screenshot

1 Mentre sivisualizza la schermata che si desidera acquisire, trascinare la barra di
stato verso il basso, quindi toccare @).

+ La schermata viene acquisita e visualizzata come miniatura nella parte
inferiore destra dello schermo.

7 Per scrivere note sullo schermo, toccare :d:
3 Scrivere note usando gli strumenti.
- T3 : consente di ingrandire o ridurre, oppure regolare larea da acquisire.
+ / :consente di scrivere delle note a mano.
- & :consente di cancellare le note scritte a mano.
+ €:Annullare le modifiche precedenti.
« 7 : Applicare di nuovo le modifiche annullate di recente.
+ (35 : consente diritagliare lo schermo come desiderato.
/L Toccare N/ e salvare le note.

+ Le note salvate possono essere visualizzate in Galleria.
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Funzioni aggiuntive dopo aver acquisito uno screenshot

— Toccare per acquisire l'intero
schermo utilizzando la funzione di
scatto di scorrimento.

e—— Toccare per registrare o schermo.

Toccare per scrivere note sulla Toccare per eliminare lo screenshot
schermata acquisita. acquisito.
' 1
Toccare per condividere lp. —————
screenshot acquisito.

E « Puoi scattare una foto dell'intero schermo, utilizzando la funzione di scatto di
scorrimento.

« Durante [uso di un‘app come Messaging e Chrome, trascinare verso il basso il
pannello notifiche e quindi toccare 0 Toccare quindi :sbz per acquisire lintera
schermata visualizzata come unico file.

« Questa funzione é disponibile solo in alcune app che supportano la funzione scatto
di scorrimento.

« Stringi due dita o allargale per regolare il layout del promemoria.
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Orologio

Sveglia

E possibile impostare una sveglia in modo che si attivi a un orario specificato.
1 Nella schermata Home, toccare Essenziali > Orologio > Sveglia.

7 Toccare -} per aggiungere una nuova sveglia.

3 Configurare le impostazioni della sveglia e toccare Salva.

« Sesi seleziona una sveglia impostata in precedenza, e possibile modificarla.

+ Pereliminare una sveglia, toccare + > Elimina nella parte superiore dello schermo.
In alternativa, toccare e tenere premuta la sveglia.

Fusi orari
E possibile visualizzare l'ora attuale delle citta di tutto il mondo.
71 Nella schermata Home, toccare Essenziali > Orologio > Fusi orari.

7 Toccare -} e aggiungere una citta.
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Timer

E possibile impostare il timer in modo da attivare un segnale acustico dopo un
periodo di tempo specificato.

T Nella schermata Home, toccare Essenziali > Orologio > Timer.

7 Impostare il tempo e toccare Inizio.

« Per sospendere il timer, toccare Pausa. Per riprendere il timer; toccare
Riprendi.

3 Toccare Stop per arrestare la sveglia del timer.

Cronometro
E possibile utilizzare il cronometro per registrare un tempo.
71 Nella schermata Home, toccare Essenziali > Orologio > Cronometro.
7 Toccare Inizio per awiare il cronometro.
« Per registrare un tempo, toccare Giro.
3 Toccare Pausa per sospendere il cronometro.
+ Per riprendere il cronometro, toccare Riprendi.

« Per cancellare tutte le registrazioni e awiare di nuovo il cronometro, toccare

Reset.
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Musica

E possibile riprodurre e gestire canzoni o album musicali

1 Nella schermata Home, toccare Essenziali > Musica.

2 Selezionare una categoria

3 Selezionare un file musical

le.

Consente di tornare alla —
schermata precedente.

Toccare per riprodurre il file —
corrente dall'inizio / Toccare due
volte per riprodurre il file
precedente / Toccare e tenere
premuto per riavolgere.

Consente di riprodurre in ordine —
casuale.

Consente di regolare il volume —

i

Y

—

— Consente di accedere a opzioni

Accendi/spegni Flash Light.

Consente di impostare effetti
sonori

aggiuntive.

— Consente di riprodurre o
sospendere la riproduzione.

— Toccare per riprodurre il file
successivo / Toccare e tenere
premuto per avanzare
velocemente.

—— Consente di selezionare una
modalita di ripetizione.

— Andare allelenco In

dellaudio.

Consente di aggiungere a o
rimuovere dai preferiti

installato.

L]

]

riproduzione ora.

Alcuni formati file potrebbero non essere supportati a seconda del software

I file di dimensioni superiori al limite massimo potrebbero generare un errore.

| file musicali potrebbero essere protetti dai titolari di copyright internazionali o da

leggi sul copyright. Prima di copiare un file musicale, potrebbe essere necessario
ottenerne l'autorizzazione legale. Per scaricare o copiare un file musicale, verificare
prima le leggi sul copyright del relativo paese.

licona Hi-Fi.
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Calcolatrice

E possibile utilizzare due tipi di calcolatrici: la calcolatrice semplice e la calcolatrice

scientifica.
71 Nella schermata Home, toccare Essenziali > Calcolatrice.

2 Utilizzare il tastierino numerico per eseguire un calcolo.
+ Per calcolare dallinizio, toccare e tenere premuto {X]

ThinQ

E possibile collegare facilmente il prodotto a dispositivi IoT per monitorarli e
utilizzarli comodamente.

Nella schermata Home, toccare Essenziali > ThinQ_

5

Lavatrice, asciugatrice, styler; lavastoviglie, forno e robot aspirapolvere possono
essere registrati solo quando il prodotto & in modalita standby.

Cercare il marchio ThinQ sul prodotto per vedere se puo essere collegato all'app
ThinQ.

Toccare = per vedere le varie funzioni dellapp ThinQ.
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LG Health

E possibile gestire il proprio stato di salute e mantenere buone abitudini di fitness
monitorando lesercizio fisico svolto.

Informazioni preliminari su LG Health
E possibile configurare LG Health al primo awio dellapp o dopo averla ripristinata.
1 Nella schermata Home, toccare Essenziali > LG Health.

2 Seguire le istruzioni visualizzate sullo schermo per completare la
configurazione.

Utilizzo di LG Health

E possibile visualizzare le informazioni principali su LG Health e gestire la quantita di
esercizio fisico e le informazioni relative alla salute.

1 Nella schermata Home, toccare Essenziali > LG Health.

2 Sono disponibili le sequenti opzioni.

-+ = :consente di visualizzare il registro del proprio esercizio fisico nel giorno
che si desidera monitorare.

- Q :consente diiniziare a monitorare una sessione di esercizio fisico. Il
percorso e la quantita di esercizio fisico svolto vengono registrati per
ciascuna tipologia di esercizio.

-+ :consente di impostare gli obiettivi giornalieri di esercizio fisico, compresi i
passi e le calorie, oppure di configurare diverse impostazioni di LG Health.

E + Le informazioni relative alla salute fornite da LG Health sono studiate per la
comodita dell'utente e non possono essere utilizzate a scopo di prevenzione,
trattamento e diagnosi di malattie né per altri scopi medici.

+ LG Health potrebbe variare o potrebbe non essere disponibile a seconda del paese
e del provider del servizio. Le funzioni di LG Health disponibili e le app che possono
essere abbinate a LG Health possono variare a seconda del paese. Le variazioni
sono dovute alle diverse leggi e normative vigenti.
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Registratore Audio HD

Il Registratore Audio HD ti consentira di configurare manualmente le impostazioni
audio in modo tale da poter registrare audio in base all'ambiente in cui ti trovi.

Modalita di registrazione

E possibile registrare un file audio ad alta definizione selezionando e configurando
la modalita audio desiderata, adatta allambiente di registrazione.

Nella schermata Home, toccare Essenziali > Registratore Audio HD >=—

Normale
E possibile registrare audio senza impostazioni aggiuntive.

ASMR

E possibile registrare suono ASMR.

Concerto
E possibile registrare audio durante un concerto o altri eventi musicall.

Personalizzato

E possibile configurare manualmente le impostazioni desiderate per registrare
laudio.

Modalita Studio

La modalita Studio consente di riprodurre un file audio o musicale e registrare
contemporaneamente la propria voce, creare un accordo registrando piti volte
la propria voce, nonché registrare i propri commenti sul file audio originale del
presentatore o del parlante.

1 Nella schermata Home, toccare Essenziali > Registratore Audio HD >=>
Personalizzato.

Toccare J -
Selezionare un file audio da utilizzare come musica di sottofondo.

Toccare @) per registrare la voce.

u b wN

Toccare @) per salvare il file registrato.
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La musica di sottofondo puo essere riprodotta solo attraverso gli auricolari.
Assicurarsi di collegare gli auricolari prima di utilizzare questa funzione.

Per modificare altre impostazioni, toccare E > Impostazioni, quindi personalizzare
il tipo di file, la profondita in bit, la frequenza di campionamento e altre
impostazioni.

Quando si seleziona la modalita Concerto o Personalizzato con gli auricolari
connessi, appare \[IJ*. Toccare \U* quindi selezionare il microfono da utilizzare

E possibile monitorare la qualita del suono mediante (altoparlante auricolare
collegato durante una registrazione audio. Durante una registrazione audio in
modalita Studio, il monitoraggio del suono non & supportato. E possibile sentire
solamente la musica di sottofondo.

Launcher Del Gioco

E possibile impostare se utilizzare il launcher del gioco, dove & possibile visualizzare
l'elenco dei giochi installati nel prodotto e selezionare le impostazioni di gioco quali
la disattivazione dellaudio multimediale, la limitazione degli awvisi ecc.

1 Nella schermata Home, toccare Launcher Del Gioco.

2 Selezionare lopzione desiderata.

Smart Doctor

E possibile utilizzare Smart Doctor per esequire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Nella schermata Home, toccare Gestione > Smart Doctor.
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LG Mobile Switch

E possibile trasferire dati con facilita da un dispositivo usato a un dispositivo nuovo
mediante LG Mobile Switch.

1 Nella schermata Home, toccare Gestione > LG Mobile Switch.
E possibile anche toccare Impostazioni > Sistema > Backup > LG Mobile
Switch.
+ Se l'app non ¢ installata nel prodotto, scaricare e installare I'app LG Mobile
Switch dal Google Play Store.

2 Sequire le istruzioni visualizzate sullo schermo per selezionare il metodo
desiderato per il trasferimento.

E + | datiin un account Google non saranno sottoposti a Backup. Quando si
sincronizza |'account Google, le app di Google, i contatti di Google, il calendario di
Google, i dati delle app di promemoria di Google e le app scaricate dal Play Store
vengono archiviati automaticamente sull'app Drive.

Caricare completamente la batteria prima del trasferimento di dati per evitare lo
spegnimento involontario durante il processo.

Cestino app

E possibile vedere lelenco delle app disinstallate sulla schermata Home. Le app
eliminate nelle ultime 24 ore possono essere recuperate.

Nella schermata Home, toccare Gestione > Cestino app.
Per maggiori informazioni, vedere Cestino app.
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SmartWorld

E possibile scaricare vari giochi, contenuti audio, app e tipi di carattere forniti da LG
Electronics. Si puo inoltre personalizzare il dispositivo in base alle proprie preferenze

utilizzando temi per la schermata Home e tipi di carattere.

E « Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ Questa funzione potrebbe non essere supportata a seconda dell'area o del
provider del servizio.

71 Nella schermata Home, toccare Servizi > SmartWorld.
7 Toccare > Account LG, quindi effettuare l'accesso.

3 Selezionare e scaricare i contenuti desiderati.

Download dell'app SmartWorld

Se I'app SmartWorld non e installata, sequire questa procedura per scaricarla.

71 Nella schermata Home, toccare Impostazioni > Sistema > Centro
aggiornamenti > Aggiornamento applicazione.

7 Dallelenco, selezionare SmartWorld e toccare Scarica.
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RemoteCall Service

Il dispositivo puo essere sottoposto a diagnostica in modalita remota per risolverne
i problemi. Innanzitutto, eseguire una chiamata telefonica a un Centro di assistenza
clienti LG come segue:

« Per servirsi di questa funzione, e prima necessario accettarne ['utilizzo.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

T Nella schermata Home, toccare Servizi > RemoteCall Service.
2 Collegare una chiamata al centro di assistenza clienti LG.

3 Al collegamento della chiamata, seguire le istruzioni dell'addetto al servizio per
immettere un numero di accesso a sei cifre.

+ Il dispositivo viene connesso in modalita remota e viene awviato il servizio di
assistenza remota.

Messaggio CB

E possibile visualizzare trasmissioni di testo in tempo reale su situazioni di
emergenza, come tifoni, inondazioni e terremoti.

Nella schermata Home, toccare Servizi > Messaggio CB.
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App di Google

E possibile utilizzare app di Google impostando un account Google. Quando si
utilizza un'app di Google per la prima volta, viene visualizzata automaticamente

la finestra di registrazione dell'account Google. Se non si dispone di un account
Google, crearne uno dal dispositivo. Per i dettagli su come utilizzare un'app, vedere
la Guida contenuta nell'app.

E « Alcune app potrebbero non funzionare a seconda dell'area o del provider del
Servizio.

Calendario

L'app Calendario consente di tenere traccia del proprio programma di eventi (che e
stato creato), organizzato per Giorno, 3 giorni, Settimana o Mese.

Chrome
Un browser web veloce, semplice e sicuro, costruito per la rete moderna.

Documenti

Docs e uno strumento collaborativo di elaborazione di testi che aumenta la
produttivita. Usa Docs per creare, modificare e lavorare insieme in tempo reale.

Drive

Drive e un'app di condivisione e immagazzinaggio di file che facilita l'individuazione,
la condivisone e la collaborazione su progetti di lavoro ovunque e in ogni istante.

Duo

Crea video chiamate semplici e di alta qualita verso i tuoi amici e famigliari su
telefoni Android e iPhones.

Gmail

Gmail & un'app facile da usare che tiene al sicuro i tuoi messaggj, rende pitt smart la
tua casella di posta e ti aiuta a restare organizzato.
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Google

L'app Google ti tiene aggiornato sulle cose che ti interessano. Trova risposte rapide,
esplora i tuoi interessi e ricevi un feed di storie e aggiornamenti su argomenti
importanti per te.

Maps

Stai andando da qualche parte? Vai con Maps, l'app con GPS in tempo reale sulla
quale puoi fare affidamento per navigazione, traffico, transito e dettagli su milioni di
luoghi, come recensioni ed eventi popolari.

Foto

La casa di tutte le tue foto e video, organizzata automaticamente per condividere e
salvare le cose pill importanti.

Play Film
Consente di utilizzare il proprio account Google per noleqgiare o acquistare film. E
possibile acquistare contenuti e riprodurli ovunque.

YT Music

Un nuovo servizio di streaming musicale da YouTube.

Fogli
Sheets e un foglio di lavoro collaborativo che aumenta la produttivita. Usa Sheets
per importare, organizzare e analizzare informazioni in tempo reale.

Presentazioni

Google Slides & uno strumento per presentazioni in tempo reale che aumenta la
produttivita. Usa Slides per organizzare informazioni, presentare risultati e prendere
decisioni insieme in tempo reale.

YouTube

Guarda i tuoi canali preferiti, ascolta la musica che ami e carica video da condividere
con le persone intorno a te.
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Assistente

Il tuo dispositivo dispone di Assistente Google incorporato. Trovale risposte e fai
cose mentre sei in giro. per inizare, basta toccare il tasto Assistente Google sul lato
del telefono o tenere premuto il pusante home del telefono.

E - Assistente Google non & disponibile in tutte le lingue o paesi.

Files
E possibile visualizzare e gestire file salvati sul dispositivo.
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Impostazioni

E possibile personalizzare le impostazioni del dispositivo in base alle proprie
preferenze.

Nella schermata Home, toccare Impostazioni.

E + Inserendo una parola chiave nella finestra di ricerca nella parte superiore dello
schermo, e possibile trovare comodamente gli elementi da impostare

Rete & internet

Wi-Fi

E possibile connettersi a dispositivi vicini tramite una rete \Wi-Fi.

Connessione a una rete Wi-Fi
T Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.
2 Toccare () ) per attivarlo.
« Vengono visualizzate automaticamente le reti Wi-Fi disponibili.
3 Selezionare una rete.
« Potrebbe essere necessario immettere la password Wi-Fi della rete.

+ Questo processo viene ignorato in caso di reti a cui & gia stato effettuato
l'accesso in precedenza. Se non si desidera eseguire automaticamente la
connessione a una determinata rete Wi-Fi, toccare la rete, quindi toccare
Elimina rete.
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Impostazioni della rete Wi-Fi
Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.

- Passa a rete dati: se la funzione connessione dati mobile ¢ attiva e il dispositivo
non & in grado di connettersi a Internet tramite la connessione Wi-Fi, il
dispositivo si connette a Internet tramite la connessione dati mobile.

5 + Questa funzione dipende dal provider del servizio.

-+ :consente di personalizzare le impostazioni della rete Wi-Fi.

Wi-Fi Direct

E possibile connettere il dispositivo ad altri dispositivi che supportano la funzione
\Wi-Fi Direct per condividere direttamente i dati con essi. Non & necessario disporre
di un punto di accesso. Utilizzando la funzione \Wi-Fi Direct, e possibile connettere
piti di due dispositivi.

T Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi> : >
Avanzate Wi-Fi > Wi-Fi Direct.

+ Vlengono automaticamente visualizzati i dispositivi vicini che supportano la
funzione Wi-Fi Direct.

2 Selezionare un dispositivo.
+ La connessione awiene quando il dispositivo accetta la richiesta di
connessione.

E - La batteria potrebbe scaricarsi piti rapidamente quando si utilizza il Wi-Fi Direct.
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Dati mobili

E possibile attivare o disattivare i dati mobili. E inoltre possibile gestirne lutilizzo.

Attivazione dei dati mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.

2 Toccare ()) per attivarlo.

Personalizzazione delle impostazioni dei dati mobili
1 Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.
7 Personalizzare le seguenti impostazioni:

« Attivo: consente di utilizzare le connessioni dati su reti mobil.

+ Limita l'utilizzo dei dati mobili: consente diimpostare un limite di utilizzo
dei dati mobili in modo da bloccarli al raggiungimento della soglia.

: :consente di personalizzare le impostazioni dei dati mobili.

+ Il volume di utilizzo dei dati misurato in base al prodotto e il volume calcolato
dal proprio gestore di telefonia mobile potrebbero essere diversi.

Impostazioni chiamate

E possibile personalizare le impostazioni di chiamata, ad esempio le opzioni per le
chiamate vocali e per quelle internazionali.

E « Alcune funzioni potrebbero non essere supportate a seconda dell'area o del
provider del servizio.

71 Nella schermata delle impostazioni, toccare Rete & internet > Impostazioni

chiamate.

2 Personalizzare le impostazioni.
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Tethering
Tethering USB

E possibile connettere il dispositivo a un altro dispositivo tramite USB e condividere
i dati mobili.

1 Connettere il dispositivo e gli altri dispositivi tramite il cavo USB.

2 Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Tethering USB e quindi toccare () ) per attivarlo.

E + Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

Quando si esegue la connessione a un computer;, scaricare il driver USB da
wwwlg.com e installarlo sul computer.

+ Non e possibile inviare o ricevere file tra il dispositivo e un computer quando il
tethering USB ¢ attivo. Disattivare il tethering USB per inviare o ricevere file.

| sistemi operativi che supportano il tethering sono Windows XP o versione
superiore, 0 Linux.

Hotspot Wi-Fi

E possibile impostare il dispositivo in modo da farlo funzionare come un router
wireless affinché altri dispositivi possano connettersi a Internet utilizzando i suoi
dati mobili.

T Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Hotspot Wi-Fi e toccare () ) per attivare la funzione.

2 Toccare Imposta hotspot Wi-Fi e immettere il Nome Wi-Fi (SSID) e la
password.

3 Attivare il Wi-Fi sull'altro dispositivo e selezionare il nome della rete del
dispositivo nell'elenco delle connessioni Wi-Fi.

/4 Immettere la password di rete.
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E « Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tetherswifi

Timer per lo spegnimento automatico dell'hotspot Wi-Fi

Se I'hotspot Wi-Fi non viene utilizzato per un determinato periodo di tempo,
viene disconnesso in automatico. Puoi impostare il periodo di tempo per la
disconnessione automatica.

Tethering Bluetooth

Un altro dispositivo connesso tramite Bluetooth puo connettersi a Internet

utilizzando i dati mobili del proprio dispositivo.

1 Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Tethering Bluetooth e quindi toccare (1)) per attivarlo.

7 Attivare il Bluetooth su entrambi i dispositivi e associarli

E « Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tether#Bluetooth_tethering

Guida

E possibile visualizzare la quida sull'utilizzo del tethering e degli hotspot.

Nella schermata delle impostazioni, toccare Rete & internet > Tethering > Guida.
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Modalita aereo

E possibile disattivare le funzioni di chiamata e dei dati mobili. Quando questa
modalita e attiva, restano disponibili le funzioni che non implicano il trasferimento di
dati, ad esempio i giochi e la riproduzione di brani musicali.

1 Nella schermata delle impostazioni, toccare Rete & internet > Modalita aereo.

7 Toccare Attiva nella schermata di conferma.

Reti mobili
E possibile personalizzare le impostazioni delle reti mobili
T Nella schermata delle impostazioni, toccare Rete & internet > Reti mobili.

7 Personalizzare le sequenti impostazioni:

+ Roaming dati: consente di navigare sul \Web, utilizzare e-mail, messaggi
multimediali e altri servizi di dati all'estero.

+ Modalita rete: consente di selezionare un tipo di rete.

+ Nomi punti di accesso: consente di visualizzare o cambiare il punto di
accesso per |'utilizzo dei servizi di dati mobili. Per cambiare il punto di
accesso, selezionarne uno fra quelli disponibili nel relativo elenco.

« Operatori di rete: consente di cercare gli operatori di rete e di connettersi
automaticamente a una rete.
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VPN

E possibile connettersi a una rete virtuale sicura, ad esempio a una Intranet. £
inoltre possibile gestire |a rete privata virtuale connessa.

Aggiunta di una rete VPN

1 Nella schermata delle impostazioni, toccare Rete & internet > VPN.

2 Toccare—+

E + Questa funzione é disponibile solo se il blocco schermo e attivato. Se il blocco
schermo e disattivato, viene visualizzata una schermata di notifica. Toccare Cambia
dalla schermata di notifica per attivare il blocco schermo. Per ulteriori dettagli,
consultare la sezione Impostazione di un blocco schermo.

3 Immettere i dettagli della rete VPN e toccare Salva.

Configurazione delle impostazioni della rete VPN
1 Toccare una rete VPN nell'elenco VPNS.

7 Immettere i dettagli relativi allaccount utente della rete VPN e toccare
Connetti.

« Per salvare i dettagli dell'account, selezionare la casella di controllo Salva le
informazioni sull'account.

DNS privato
E possibile configurare le opzioni del DNS (Domain Name System) privato.
1 Nella schermata delle impostazioni, toccare Rete & internet > DNS privato.

2 Selezionare lopzione desiderata e toccare Salva.
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Dispositivi connessi

Bluetooth

E possibile connettere il dispositivo a dispositivi vicini che supportano la funzione
Bluetooth per scambiare direttamente i dati con essi. Connettere il dispositivo a un
auricolare Bluetooth e a una tastiera. In questo modo sara pit semplice controllare
il dispositivo.

Associazione a un altro dispositivo

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Bluetooth.

2 Toccare () ) per attivarlo.
+ Vengono automaticamente visualizzati i dispositivi disponibili.
- Per aggiornare l'elenco dei dispositivi, toccare ().

E + Nellelenco sono visualizzati solamente i dispositivi impostati come visibili.

3 Selezionare un dispositivo dall'elenco.
A Seguire le istruzioni visualizzate sullo schermo per effettuare l'autenticazione.

E « Questo passaggio viene saltato per i dispositivi cui & stato effettuato laccesso in
precedenza.

Invio di dati tramite Bluetooth

1 Selezionare un file.
- E possibile inviare file multimediali o contatti.

2 Toccare <& > Bluetooth.

3 Selezionare un dispositivo di destinazione per il file.
« Il file viene inviato non appena viene accettato dal dispositivo di destinazione.

E « | processi di condivisione di file potrebbero differire, a seconda del file.
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Condivisione schermo
E possibile riprodurre la schermata e laudio del dispositivo su un altro dispositivo,
come ad esempio una TV, in grado di supportare la funzione Miracast.

T Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione schermo.

2 Toccare ()) per attivarlo.

3 Selezionare un dispositivo dall'elenco dei dispositivi vicini.

+ Seil dispositivo desiderato non é visualizzato, toccare Ricerca per aggiornare
l'elenco.

+ Una volta effettuata la connessione al dispositivo, sul relativo schermo viene
visualizzata la schermata del dispositivo.

E + La Condivisione schermo si spegne automaticamente se non vi & alcun dispositivo
compatibile per la condivisione nelle vicinanze.

NFC

E possibile utilizzare il dispositivo come tessera dei trasporti o carta di credito. E
inoltre possibile condividere dati con laltro dispositivo.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > NFC.

2 Toccare () ) per attivarlo.

+ Mettere a contatto il proprio dispositivo con laltro dispositivo che supporta
NFC per consentire la condivisione di dati.

E - L'antenna NFC potrebbe essere situata in una posizione diversa a seconda del tipo
di dispositivo. Per i dettagli relativi allarea dellantenna NFC, vedere Panoramica
delle parti.
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Pannello di condivisione

E possibile condividere i contenuti delle app Galleria, Musica e File Manager con i
dispositivi nelle vicinanze. Inoltre, & possibile condividere contenuti con delle persone
specifiche nelle app che utilizzano Google Direct Share.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Pannello di
condivisione.

2 Toccare @  per disattivare ciascuna opzione.

- Dispositivi nelle vicinanze: £ possibile visualizzare i dispositivi vicini con cui
e possibile condividere i contenuti delle app Galleria, Musica e File Manager.

« Condivisione diretta: da unapp che supporta Google Direct Share, &
possibile visualizzare un'icona che consente di condividere contenuti con
persone specifiche.

Condivisione File

E possibile inviare e ricevere file scambiandoli tra il dispositivo e altri dispositivi o
tablet LG.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione File.

7 Personalizzare le sequenti impostazioni:
+ VELVET: consente di modificare il nome del dispositivo.
+ Salva in: consente diimpostare la cartella di destinazione in cui salvare i file
inviati da altri dispositivi.
- Condivisione File: consente la ricezione di file inviati da altri dispositivi.

+ SmartShare Beam: consente di condividere file con altri dispositivi tramite
SmartShare Beam.

+ Guida: consente di visualizzare la guida alla condivisione dei file.
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Server multimediale

E possibile condividere contenuti multimediali presenti sul dispositivo con dispositivi
vicini che supportano la funzione DLNA.

T Nella schermata delle impostazioni, toccare Dispositivi connessi > Server
multimediale.
7 Personalizzare le sequenti impostazioni:

« Condivisione di contenuti: consente di condividere contenuti presenti sul
dispositivo con dispositivi vicini.

VELVET: consente di impostare il nome del dispositivo.

5 « Aseconda del prodotto dell'utente, i nomi dei menu potrebbero apparire in modo
diverso

- Contenuti da condividere: consente di selezionare il tipo di contenuti
multimediali da condividere con altri dispositivi.

Dispositivi consentiti: consente di visualizzare un elenco dei dispositivi a cui
& consentito accedere ai contenuti presenti sul dispositivo.

- Dispositivi non autorizzati: consente di visualizzare un elenco dei dispositivi
a cui non e consentito accedere ai contenuti presenti sul dispositivo.

Stampa

E possibile connettere il dispositivo a una stampante Bluetooth e stampare foto o
documenti salvati sul dispositivo.

Nella schermata delle impostazioni, toccare Dispositivi connessi > Stampa.

« Toccare Servizio di stampa predefinito per cercare le stampanti a cui e
possibile connettersi. Oppure, toccare + > Aggiungi stampante per aggiungere
manualmente una stampante.

- Toccare (+) Nuovo servizio per scaricare lapp della stampante desiderata.

E « Questa funzione é disponibile sono quando e attiva la funzione di rete mobile o
Bluetooth.

Per scaricare [app della stampante in (+) Nuovo servizio, & necessario prima
accedere al proprio account Google.
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Suono

E possibile personalizzare le impostazioni relative a suono, vibrazione e notifiche.

Nella schermata delle impostazioni, toccare Suono e personalizzare le seguenti
impostazioni:

Profilo audio: consente di passare alla modalita audio Suono, Vibrazione o
Silenzioso.

Volume: consente di regolare il volume dellaudio di diversi elementi.

Suonerie: consente di selezionare una suoneria per le chiamate in arrivo. £
possibile aggiungere o eliminare suonerie.

Suono di notifica: consente di selezionare una suoneria per le notifiche. £
possibile impostare un brano musicale salvato sul dispositivo come suoneria di
notifica.

Suoneria con vibrazione: consente di impostare sul dispositivo la vibrazione e la
riproduzione di una suoneria in contemporanea.

Suoneria contatto: consente di creare una suoneria per una chiamata in arrivo
da un determinato contatto.

Allerta flash per le chiamate in arrivo:imposta il lampeggiamento secondo la
suoneria LG.

Non disturbare: consente di impostare il tempo, l'intervallo e il tipo di app per
cui ricevere messaggi di notifica. E possibile ricevere messaggi di notifica solo in
particolari giorni della settimana.

Qualita del suono ed effetti: usare la funzione per impostare la qualita e gli
effetti audio quando si riproduce una canzone o video.

Volume: consente di regolare il volume dellaudio di diversi elementi.

- Normalizza volume: Usare la funzione per normalizzare i volumi di sorgenti
audio differenti.

Equalizzatore: Usare la funzione per regolare le impostazioni
dell'equalizzatore.

- LG 3D Sound Engine: Usare la funzione per riprodurre musica o video in un
audio tridimensionale, immersivo e vivido quando cuffie, altoparlanti, o altri
dispositivi audio esterni sono connessi. Per ulteriori dettagli, consultare la
sezione LG 3D Sound Engine.
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Sottotitoli in tempo reale: consente di impostare il dispositivo in modo che
rilevi la voce nel contenuto multimediale e generi automaticamente i sottotitoli.

Potenza vibrazione: consente di regolare l'intensita della vibrazione.

Tipo vibrazione: consente di selezionare il tipo di vibrazione per le chiamate in
arrivo.

Vibrazione al tocco: consente di impostare la vibrazione del dispositivo quando
si toccano determinati elementi sullo schermo.

Suono della tastiera di composizione: seleziona ['effetto sonoro del tastierino.
Suono della tastiera LG: seleziona 'effetto sonoro della tastiera LG.

Suono touch: Selezionare un effetto sonoro per quando si tocca un elemento.

Suoni di blocco schermo: selezionare un effetto sonoro per quando lo schermo
viene bloccato o sbloccato.

Notifiche

E possibile controllare lelenco delle app installate e configurare le impostazioni per
le notifiche.

1 Nella schermata delle impostazioni, toccare Notifiche.

7 Personalizzare le impostazioni come desiderato.
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Display
E possibile personalizzare le impostazioni dettagliate di ogni tipo di schermata.
Nella schermata delle impostazioni, toccare Display e personalizzare le seguenti

impostazioni:

Sfondo: consente di personalizzare le impostazioni per la schermata Home. Per
ulteriori dettagli, consultare la sezione Impostazioni della schermata Home.

Barra di navigazione:impostare o stile della barra d navigazione come Gesti
0 Solo pulsanti. Quando come stile della barra di navigazione si seleziona Solo
pulsanti, e possibile anche cambiare la combinazione di pulsanti. Per maggiori
informazioni, vedere Barra di navigazione.

Barra di stato: consente di impostare il colore della barra di stato nella parte
superiore dello schermo, o di impostare |a visualizzazione dell'icona di notifica e
della percentuale della batteria.

AOD (always-on display): consente di visualizzare sempre informazioni come
data, ora e notifiche, anche quando lo schermo e spento. Per maggiori dettagli,
vedere AOD (always-on display).

Vista comfort: consente di ridurre la quantita di luce blu sullo schermo del
dispositivo per limitare ['affaticamento degli occhi.

5 + Questa funzione non é disponibile quando il dispositivo & collegato a LG Dual

Screen (LM-G905N),

-+ Modalita notte: di notte e possibile applicare un tema dello schermo oscurato

per evitare |'abbagliamento.

Colore dello schermo: Regola colore e temperatura del colore per lo schermo
desiderato.

5 « Toccare 'O per ripristinare le impostazioni

Amplificatore Video: Durante |a riproduzione di un video in modalita schermo
intero, & possibile modificare le impostazioni per una visualizzazione a Colore
dello piti luminosa e dinamica.

- Carattere: modificare dimensione, grassetto, o facciata.

« Colore accento: consente di cambiare il colore di punta per impostazioni, menu,

finestre di notifica ecc.
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Dimensioni display: consente di impostare gli elementi presenti sullo schermo
su dimensioni facilmente visibili per [utente. Alcuni elementi potrebbero
cambiare posizione.

Schermo intero App: consente di regolare le dimensioni sullo schermo delle
app.

Luminosita: utilizzare a barra di scorrimento per modificare la luminosita dello
schermo. Per regolare automaticamente la luminosita dello schermo in base
allintensita della luce ambientale, toccare l'interruttore Automatico.

Automatico: consente di impostare la regolazione automatica della luminosita
dello schermo in base all'intensita luminosa dellambiente.

Timeout schermo: consente di disattivare automaticamente lo schermo
quando il dispositivo viene lasciato inattivo per un determinato periodo di
tempo.

Rotazione automatica: consente di ruotare automaticamente lo schermo a
seconda dellorientamento del dispositivo.

Screen saver: consente di visualizzare uno screen saver quando il dispositivo &
collegato al supporto o al caricabatteria. Selezionare un tipo di screen saver da
visualizzare.

Schermo a una mano: ridurre le dimensioni dello schermo in modo da poter
utilizzare il dispositivo con una sola mano. Trascinare il pulsante a sfioramento
Home verso 'angolo inferiore sinistro o destro dello schermo.

Sfondo & Tema

E possibile selezionare lo sfondo, il tema dello schermo, lo stile delle icone 0 AOD
(Always-on display) per il dispositivo.

1 Nella schermata delle impostazioni, toccare Sfondo & Tema.

2 Toccare Sfondo, Tema, Icona 0 AOD per personalizzare le impostazioni.
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Blocco schermo & sicurezza

E possibile personalizzare le impostazioni della schermata di blocco e della
sicurezza.

1 Nella schermata delle impostazioni, toccare Blocco schermo & sicurezza.

2 Personalizzare le impostazioni.

Google Play Protect: scansiona giornalmente il dispositivo per scoprire app
potenzialmente nocivi.

Trova il mio dispositivo: tracciare a distanza la posizione del dispositivo.
Puoi anche proteggere i tuoi dati in modo sicuro se hai smarrito il tuo
dispositivo.

Aggiornamento sicurezza: controlla gli aggiornamenti software e configura
le impostazioni di installazione automatiche.

Seleziona il blocco dello schermo: seleziona il metodo di blocco schermo
desiderato. Per ulteriori dettagli, consultare la sezione Impostazione di un
blocco schermo.

Personalizza Blocco schermo: modifica le informazioni visualizzate sullo
schermo bloccato.

Impostazioni di Blocco con sicurezza: modifica le impostsazioni di blocco
sicuro.

Impronte digitali: consente di usare impronta digitale per sbloccare

lo schermo o il contenuto. Per ulteriori dettagli, consultare la sezione
Informazioni generali sul riconoscimento delle impronte digitali.

Blocco del contenuto: consente di impostare un tipo di blocco (password o
sequenza) per i propri file della Galleria.
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- Crittografia e credenziali: configura le impostazioni per |a cifratura e le
credenziali della scheda SD.

- Cripta la Scheda SD: consente di crittografare la scheda di memoria per
impedire ['utilizzo su un altro dispositivo. Per ulteriori dettagli consultare
la sezione Crittografia della scheda di memoria.

- Protezione delle credenziali: consente di visualizzare il tipo di memoria
su cui sara salvato il certificato di sicurezza.

- Credenziali di fiducia: visualizza i certificati CA root e i certificati CA
installati dall'utente del tuo sistema.

- Credenziali dell'utente: visualizza e modifica le informazioni dei
certificati sicuri conservati sul tuo dispositivo.

Installa dalla memoria: installare un certificato sicuro da un archivio.

Cancella archivio: cancella i certificati sicuri installati da utente e le
credenziali relative.

Amministratori dispositivo: consente privilegi per limitare il controllo o
l'utilizzo del dispositivo a determinate app.

Trust agents: consente di visualizzare e utilizzare agenti attendibili installati
sul dispositivo.

Puntina schermo: consente di fissare la schermata dellapp in modo che sia
possibile utilizzare soltanto lapp attiva al momento.

Accesso all'utilizzo: consente di visualizzare i dettagli sull'utilizzo delle app
sul dispositivo.
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Privacy

E possibile trovare e regolare tutte le impostazioni sulla privacy.

T Nella schermata delle impostazioni, toccare Privacy.

2 Personalizzare le impostazioni.

Gestione autorizzazioni: Consente di controllare e cambiare le
autorizzazioni concesse alle app.

Blocco schermo: Consente di impostare le notifiche da visualizzare sul
blocco schermo.

Rendi visibili le password: attivare questa opzione per visualizzare
rapidamente ciascun carattere della password mentre si digita per vedere
cosa si staimmettendo.

Servizi di personalizzazione del dispositivo: consentono di ottenere
suggerimenti in base agli utenti, alle app e ai contenuti interattivi.

Compilazione automatica Google: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, 0 numero
di carta di credito con un singolo tocco. E possibile anche disattivare questa
opzione, usare la funzione Google Autocomplete, oppure aggiungere un
nuovo account di servizio.

Cronologia delle posizioni Google: Consente di abilitare o disabilitare

la Cronologia delle posizioni. Quando e abilitata, Google periodicamente
memorizza e utilizza i dati sulla posizione piti recenti del telefono in
connessione con laccount Google.

Nella schermata Cronologia delle posizioni, toccare ¢ per visualizzare e/o
gestire i dati sulla posizione.

Gestione attivita: Seleziona attivita e informazioni che si desidera vengano
salvate da Google.

Annunci: Consente di controllare D pubblicita e impostare le pubblicita
personalizzate.

Utilizzo e diagnostica: Abilitare questa opzione per migliorare ['esperienza
Android inviando automaticamente a Google dati diagnostici e sull'utilizzo
del dispositivo e delle app.
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Posizione

E possibile controllare come vengono condivise le informazioni sulla propria
posizione e configurare |'autorizzazione per accedere alle informazioni sulla propria
posizione.

Nella schermata delle impostazioni, toccare Posizione e impostare la funzione
desiderata.

Estensioni

Smart Doctor

E possibile utilizzare Smart Doctor per esequire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Nella schermata delle impostazioni, toccare Estensioni > Smart Doctor.

Context Awareness

E possibile modificare automaticamente le impostazioni del dispositivo in base alla
sequenza di utilizzo e alla posizione.

1 Nella schermata delle impostazioni, toccare Estensioni > Context Awareness.

7 Attivare gli elementi per i quali si desidera modificare automaticamente le
impostazioni.

- AUTOMATIZZATO: E possibile impostare il dispositivo in modo che modifichi
automaticamente il profilo audio, le opzioni Bluetooth e Wi-Fi in diversi
ambienti, ad esempio A casa, Fuori casa, Al lavoro e Non al lavoro. E possibile
anche impostare che unapp si apra quando vengono collegati gli auricolari o
quando viene connesso un dispositivo Bluetooth.

E + Per poter usare questa funzione, le posizioni di casa e lavoro devono essere
presenti in | miei luoghi. Nella schermata delle impostazioni, toccare Posizione > |
miei luoghi per impostare le posizioni.
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Servizio personalizzato
E possibile ottenere risultati intelligenti utilizzando la ricerca integrata.

1 Nella schermata delle impostazioni, toccare Estensioni > Servizio
personalizzato.

2 Toccare () ) per attivarlo.

Gaming

E possibile configurare le impostazioni di gioco per gli strumenti, la grafica e il
risparmio energetico.

1 Nella schermata delle impostazioni, toccare Estensioni > Gaming.

7 Personalizzare le sequenti impostazioni:

Launcher Del Gioco: Toccare () ) per usare la funzione Launcher Del Gioco.

Strumenti di gioco: E possibile esequire la funzione durante il gioco
toccando licona degli strumenti di gioco tra i pulsanti a sfioramento anteriori.

Grafica di gioco: Regola |a grafica di gioco.
E + Se simodifica la risoluzione video di alcuni giochi, le funzioni di visualizzazione dello
schermo potrebbero non funzionare correttamente.

+ Questa funzione potrebbe non essere disponibile per alcune app di gioco.

- Tempo di pausa: Riduce la luminosita dello schermo e le prestazioni, ogni
volta che si abbandona il gioco per piti di 5 minuti.
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Registrazione schermata

E possibile configurare le impostazioni della registrazione dello schermo.

1 Nella schermata delle impostazioni, toccare Estensioni > Registrazione
schermata.

7 Personalizzare le seguenti impostazioni:
« Includi te stesso nel video da: Selezionare una delle seguenti opzioni.

- Immagine:Include limmagine del profilo nel video durante la
registrazione. Una volta effettuata questa selezione, toccare @) e
selezionare unimmagine del profilo. Regolare quindi le dimensioni
dellimmagine usando la barra di scorrimento.

- Fotocamera anteriore: Include sé stessi registrati con la fotocamera
anteriore durante |a registrazione dello schermo.

- Mai: Non viene incluso niente.
+ Sorgente Audio: Scegliere [sorgente audio tra Microfono e Contenuti.

« Risoluzione video: Selezionare la risoluzione per la registrazione dello
schermo.

Per registrare lo schermo

1 Trascinare verso il basso la barra di stato per aprire lelenco delle icone di
accesso rapido.

2 (Se necessario, scorrere a sinistra sull'area delle icone di accesso rapido.) Toccare
.

3 Leggere la dichiarazione di non responsabilita e toccare Inizio. La registrazione
inizia in 3 secondi.

/| Per arrestare la registrazione, toccare G) nella parte inferiore destra dello
schermo. Il video registrato viene salvato nella Galleria.

E « Laviolazione dei diritti di altre persone, quali il diritto di ritratto o di proprieta
intellettuale, o la diffamazione della reputazione di altre persone utilizzando le
funzioni fornite per il servizio di registrazione dello schermo, possono comportare
responsabilita civili, penali o amministrative in conformita con le leggi vigenti. LG
Electronics declina ogni responsabilita legale per le azioni degli utenti.
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Dual App

E possibile installare app di messaqgistica duplicate nel prodotto e utilizzare due

account contemporaneamente.

T Nella schermata delle impostazioni, toccare Estensioni > Dual App.

2 Dopo aver letto la dichiarazione di non responsabilita, toccare Conferma.

3 Nell'elenco delle app disponibili, toccare Installa per installare una copia dellapp
desiderata e sequire le istruzioni visualizzate sullo schermo.

+ Sullo schermo viene visualizzato lelenco delle app duplicate disponibili.
Durante linstallazione, sulla schermata Home vengono generate le icone
delle app.

Penna

E possibile configurare le opzioni per ['uso di una penna attiva (opzionale, in
vendita separatamente). Questo dispositivo supporta Active Pen AES2.0 (Active
Electrostatic).

T Nella schermata delle impostazioni, toccare Estensioni > Penna.

7 Personalizzare le seguenti impostazioni:

- Tasto Penna Collegamenti: consente di configurare le scorciatoie per tutti i
pulsanti della penna attiva.

« Scorciatoie applicazioni: Selezionare quale app (fino a cinque) visualizzare
come collegamento quando la penna e rimossa dal dispositivo.

+ Anteprima promemoria: Attivare per visualizzare i promemoria recenti in
Pen Pop.

+ Suono scrittura: Attivare per applicare effetti sonori alla modalita disegno.

- Mostra puntatore: Attivare per visualizzare un puntatore della penna nei
puntiin cui si passa con la penna.

+ Gesti ignora barra di navigazioneta: Blocca limmissione di gesti per la
barra di navigazione, e risulta utile quando si disegna o si scrive sul bordo
dello schermo con una Active Pen.
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Collegamenti

E possibile utilizzare pulsanti quali accensione/blocco, volume e Assistente Google
per esequire direttamente determinate app o funzioni.

T Nella schermata delle impostazioni, toccare Estensioni > Collegamenti.

7 Personalizzare le seguenti impostazioni.

- Apri Fotocamera: premere il tasto di accensione due volte per awiare la
Fotocamera.

+ Apri Promemoria a schermo spento: quando lo schermo é bloccato o
spento, premere due volte il tasto volume su (+) per aprire promemoria off
screen.

« Apri Fotocamera: quando lo schermo é bloccato o spento, premere due
volte il tasto volume gili (-) per awviare Fotocamera.

« Apri Assistente Google: premere il tasto Assistente Google sul lato del
telefono.

- Parla con Assistente Google: tenere premuto il tasto Assistente Google
per parlare rapidamente con [Assistente.

E « Assistente Google non supporta alcune lingue.

Toc Toc
Esequire un doppio tocco sullo schermo per spegnerlo o accenderlo.
Per ulteriori dettagli, consultare la sezione Toc Toc.

Aumenta la sensibilita al tocco

E possibile aumentare la sensibilita al tocco del touchscreen. Si consiglia di attivare
questa funzione quando si usa una protezione per lo schermo.

Nella schermata delle impostazioni, toccare Estensioni > Aumenta la sensibilita al
tocco.
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Applicazioni

E possibile controllare lelenco delle app installate e configurare le impostazioni per
notifiche, autorizzazioni delle app e altro ancora.

1 Nella schermata delle impostazioni, toccare Applicazioni.

2 Personalizzare le impostazioni.

Batteria

E possibile visualizzare le informazioni sulla batteria corrente o attivare la modalita
risparmio energetico.

T Nella schermata delle impostazioni, toccare Batteria.

7 Personalizzare le seguenti impostazioni:

Utilizzo della batteria: consente di visualizzare i dettagli sull'utilizzo della
batteria.

Ricarica ottimizzata: regola automaticamente la velocita di carica in base a
come si carica, per ridurre il calore e prolungare la durata della batteria.

Batteria adattiva: consente di risparmiare la batteria impedendo
lesecuzione in background delle app.

Limitazione sfondo: abilitare questa opzione per limitare le app in
background e risparmiare la batteria durante ['uso del dispositivo. Le app
con limitazioni per il risparmio energetico potrebbero non funzionare
correttamente o potrebbero non inviare notifiche.

Risparmio energetico: consente di ridurre il consumo della batteria
riducendo alcune impostazioni del dispositivo, come la luminosita del display,
la velocita e lintensita della vibrazione.

Eccezioni del risparmio energetico: seleziona le app che vengono

utilizzare senza alcuna restrizione in modalita di risparmio energetico o di
ottimizzazione della batteria.
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Archiviazione

E possibile visualizzare e gestire la memoria interna sul dispositivo o lo spazio di
archiviazione della scheda di memoria.
1 Nella schermata delle impostazioni, toccare Archiviazione.

2 Personalizzare le seguenti impostazioni:

+ Archivio interno: consente di visualizzare lo spazio di archiviazione totale
e lo spazio libero nella memoria interna del dispositivo. Visualizza un elenco
delle app in uso e la capacita di archiviazione di ciascuna app.

« Scheda SD: consente di visualizzare lo spazio di archiviazione totale e lo
spazio libero nella scheda di memoria. Questa opzione compare soltanto
quando viene inserita una scheda di memoria. Per disattivare la scheda di
memoria, toccare

Account

E possibile aggiungere utenti con i quali condividere e registrare un account cloud.
1 Nella schermata delle impostazioni, toccare Account.

7 Personalizzare le impostazioni.

Benessere digitale e Controllo
genitori

E possibile visualizzare il tempo di utilizzo del prodotto e impostare il timer per
ciascuna app. E possibile inoltre gestire il tempo di utilizzo del telefono cellulare
utilizzando la modalita di preparazione al sonno e la modalita di messa a fuoco.
Nella schermata delle impostazioni, selezionare Benessere digitale e Controllo
genitori e impostare la funzione desiderata.
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Google

E possibile utilizzare le impostazioni di Google per gestire le proprie app e le
impostazioni dell'account di Google.

Nella schermata delle impostazioni, toccare Google.

Sistema

Centro aggiornamenti

Puoi controllare e installare la versione pili recente dell'app o del software fornito
alG

1 Nella schermata delle impostazioni, toccare Sistema > Centro aggiornamenti.

7 Personalizzare le sequenti impostazioni:

- Aggiornamento applicazione: controlla se e disponibile un aggiornamento.
Se disponibile, puoi installare 'aggiornamento.

- Aggiornamento software: controlla se e disponibile un aggiornamento
software. Se disponibile, puoi installare ['aggiornamento.

Lingua e tastiera
E possibile personalizzare le impostazioni di lingua e tastiera del dispositivo.
T Nella schermata delle impostazioni, toccare Sistema > Lingua e tastiera.
7 Personalizzare le seguenti impostazioni:
« Lingua: consente di selezionare una lingua da applicare al dispositivo.

- Gestisci tastiere: e possibile modificare le impostazioni di base della tastiera
del prodotto, impostare gli ambienti di utilizzo per la tastiera LG o altre
tastiere installate e impostare la funzione di riconoscimento vocale per i
comandi con Google Voice. E possibile inoltre impostare se visualizzare il
pulsante della tastiera nell'area dei pulsanti a sfioramento della schermata
Home, in modo da poter passare rapidamente a un‘altra tastiera.
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- Tastiera fisica: selezionare per usare |a tastiera fisica, o controllare i tasti dei
collegamenti da tastiera.

« Servizio Compilazione automatica: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, 0 numero
di carta di credito con un singolo tocco. Puoi anche disattivare questa
opzione, usare Google Autocomplete, 0 aggiungere un nuovo account di
servizio.

« Lettura text-to-speech: consente di configurare le impostazioni delloutput
sintesi vocale.

Velocita del puntatore: consente di regolare la velocita del puntatore di un
mouse o trackpad.

Inverti i pulsanti del mouse: consente di invertire il pulsante destro del
mouse in modo che esegua le principali azioni di manipolazione diretta.

Data e ora
E possibile personalizzare le impostazioni di data e ora del dispositivo.
1 Nella schermata delle impostazioni, toccare Sistema > Data e ora.

7 Personalizzare le impostazioni.

Memoria

Consente di visualizzare la quantita media di utilizzo della memoria in un
determinato periodo di tempo e la memoria occupata da unapp.

1 Nella schermata delle impostazioni, toccare Sistema > Memoria.

2 Toccare w per impostare una fascia oraria per il recupero dei dati.
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Backup
E possibile esequire il backup dei dati salvati sul dispositivo su un altro dispositivo o
account.

T Nella schermata delle impostazioni, toccare Sistema > Backup.

7 Personalizzare le sequenti impostazioni:
LG Mobile Switch: consente di trasferire i dati da un vecchio dispositivo LG a
quello nuovo. Per ulteriori dettagli, consultare la sezione LG Mobile Switch.

+ Backup e ripristino: consente di eseguire il backup dei dati del dispositivo o
ripristinare i dati di un backup nel dispositivo.

A - Ilripristino del dispositivo potrebbe eliminare i file di backup salvati nellarchivio.
Assicurarsi di copiare e salvare i file di backup importanti nel proprio PC.

- Google Backup: modifica le impostazioni di backup di Google. E possibile
anche controllare 'account di backup attualmente usato, o aggiungere un
nuovo account di backup.

Riavvio & Ripristino
E possibile ripristinare il dispositivo, includendo le impostazioni di rete e app.
71 Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino.

7 Personalizzare le sequenti impostazioni:

+ Riavvio automatico: riawia e ottimizza automaticamente il telefono all'ora
impostata. Toccare () ) per attivare la funzione. Il dispositivo si riawia
automaticamente all'ora impostata e si ottimizza. Seleziona la data e l'ora
del riawio.

Impostazioni 150



E - Puoiimpostare il dispositivo affinché si riawii una volta la settimana. Il dispositivo
si riavvia automaticamente entro un'ora dall'ora impostata.

+ Unavolta che il dispositivo si riawia, le notifiche e i badge sono cancellati. Salvare i
dati importanti prima dell'ora preimpostata.

+ Lafunzionalita di riavvio automatico non ¢ attivata nelle seguenti situazioni.
Quando lo schermo e acceso, quando il dispositivo & in uso, quando il livello della
batteria & il 30% o meno, o quando la scheda USIM ¢ bloccata.

- Aseconda del fornitore del servizio di telecomunicazione, la funzione di riavio
automatico potrebbe non essere disponibile.

+ Ripristino delle impostazioni della rete: consente di ripristinare Wi-Fi,
Bluetooth e altre impostazioni di rete.

- Ripristina preferenze applicazione: ripristina le impostazioni dio un'app. |
dati salvati nell'app non saranno cancellati.

- Ripristino dati di fabbrica: consente di ripristinare tutte le impostazioni del
dispositivo ed eliminare i dati.

E « |lripristino e il riawvio del dispositivo elimina tutti i dati presenti sullo stesso. Inserire
nuovamente il nome del dispositivo, laccount Google e altre informazioni iniziali.

« Dopo linizializzazione dei dati, i dati non possono piti essere recuperati.

Info sul telefono
E possibile visualizzare informazioni sul dispositivo, come nome, stato, dettagli
software e informazioni legali.

Nella schermata delle impostazioni, toccare Sistema > Info sul telefono e
visualizzare le informazioni.

Normative & Sicurezza

E possibile visualizzare i certificati normativi e le relative informazioni sul proprio
dispositivo.
Nella schermata delle impostazioni, toccare Sistema > Normative & Sicurezza.
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Accesso facilitato

E possibile gestire i plugin di accessibilita installati sul dispositivo.

1
2

Nella schermata delle impostazioni, toccare Accesso facilitato.

Personalizzare le sequenti impostazioni:

Visione > TalkBack: consente di impostare il dispositivo in modo da
notificare lo stato dello schermo o le azioni tramite voce.

Visione > Notifiche vocali:impostare sul dispositivo la lettura delle
informazioni del chiamante tramite voce.

Visione > Carattere: modificare dimensione, grassetto, o facciata.

Visione > Dimensioni display: consente di impostare gli elementi presenti
sullo schermo su dimensioni facilmente visibili per 'utente. Alcuni elementi
potrebbero cambiare posizione.

Visione > Zoom touch: consente di eseguire o zoom avanti o indietro
toccando lo schermo tre volte.

Visione > Zoom della finestra: consente di eseguire lo zoom avanti o
indietro allinterno di una finestra e invertire il colore.

Visione > Puntatore del mouse grande: consente di ingrandire il puntatore
del mouse.

Visione > Schermo ad alto contrasto: consente di modificare il colore di
sfondo in nero per uno schermo ad alto contrasto.

Visione > Inversione del colore dello schermo: consente di aumentare il
contrasto del colore del display per le persone ipovedenti.

Visione > Regolazione del colore dello schermo: consente di regolare il
colore del display.

Visione > Monocromatico: consente di far passare lo schermo alla modalita
scala di grigi.

Visione >Termina le chiamate con il tasto di accensione: consente di
terminare una chiamata premendo il tasto di accensione/blocco.

Udito > Sottotitoli dal vivo: consente di impostare il dispositivo in modo
che rilevi la voce nel contenuto multimediale e generi automaticamente i
sottotitoli.

Udito > Preferenze di didascalia: consente di attivare il servizio dei
sottotitoli durante la riproduzione di video per non udenti.
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+ Udito > Flash allarme: consente di impostare il dispositivo in modo da
notificare all'utente le chiamate in arrivo, i messaggi e le sveglie con una luce
lampeggiante.

+ Udito > Disattiva tutti i suoni: consente di disattivare tutti i suoni e
abbassare il volume sul ricevitore.

- Udito > Canale audio: consente di selezionare il tipo di audio.

« Udito > Bilanciamento del suono: consente di regolare il bilanciamento
dell'uscita audio. Consente di utilizzare la barra di scorrimento per modificare
il bilanciamento.

+ Movimento & cognizione > Touch assistant: consente di attivare il pannello
touch per facilitare lutilizzo di pulsanti e gesti.

+ Movimento & cognizione > Input tattile: consente di immettere il testo
toccando e tenendo premuto lo schermo, o di modificarlo semplicemente
toccando lo schermo.

+ Movimento & cognizione > Tastiera fisica: consente di personalizzare le
impostazioni della tastiera.

+ Movimento & cognizione > Click automatico del mouse: consente di
cliccare il puntatore del mouse automaticamente in caso di assenza di
movimento.

+ Movimento & cognizione > Tocca e tieni premuto per le chiamate:
consente di rispondere o rifiutare le chiamate toccando e tenendo premuto il
pulsante di chiamata, invece di trascinarlo.

+ Movimento & cognizione > Timeout schermo: consente di disattivare
automaticamente lo schermo quando il dispositivo viene lasciato inattivo per
un determinato periodo di tempo.

+ Movimento & cognizione > Aree di controllo tattile: consente di limitare
l'area touch in modo che soltanto una determinata porzione dello schermo
possa essere controllata dall'inserimento touch.

« Collegamento alle funzioni di accessibilita: consente di accedere
rapidamente a una funzione utilizzata di frequente toccando O tre volte.

- Rotazione automatica: consente di cambiare automaticamente
lorientamento dello schermo a seconda della posizione fisica del dispositivo.

Seleziona per ascoltare: consente di toccare gli elementi e ricevere una
risposta vocale.

+ Switch Access: consente di creare combinazioni di tasti per controllare il
dispositivo.
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Impostazioni della lingua LG

E possibile selezionare una lingua da utilizare sul dispositivo.
+ Nella schermata Home, toccare Impostazioni > Sistema > Lingua e tastiera >
Lingua > Aggiungi lingua, quindi selezionare una lingua.
- Toccare e tenere premuta = quindi trascinarla in cima allelenco delle lingue
per impostarla come lingua predefinita.

LG Bridge

Informazioni generali su LG Bridge

LG Bridge e unapp che aiuta a gestire comodamente dal proprio computer le foto,
la musica, i video e i documenti salvati sullo smartphone LG. E possibile eseguire

il backup dei contatti, delle foto e di altri elementi sul computer o aggiornare il
software del dispositivo.

E « Peridettagli vedere la guida di LG Bridge.
« Le funzioni supportate possono variare a seconda del dispositivo.

« Il driver USB LG e un programma necessario per connettere o smartphone LG con
il computer e viene installato quando si installa LG Bridge.

Funzioni di LG Bridge

+ Consente di esequire il backup dei dati dal dispositivo a un computer o
ripristinare i dati da un computer al dispositivo tramite un collegamento con
cavo USB.

- Consente di aggiornare il software del dispositivo da un computer tramite un
collegamento con cavo USB.
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Installazione di LG Bridge su un computer
1 Andare sul sito wwwlg.com dal proprio computer.

7 Selezionare la regione.

3 Fare clic su Supporto > Software e firmware.

4

Immettere il nome del dispositivo.
OPPURE
Selezionare Categoria prodotto.

5 Andare a Sync PC > LG Bridge per scaricare il file di installazione.

+ Andare su Dettagli per visualizzare i requisiti minimi per l'installazione di LG
Bridge.

Aggiornamento software del telefono

Aggiornamento software del telefono LG Mobile da

Internet

Per ulteriori informazioni sull'utilizzo di questa funzione, visitare
http//wwwi.lg.com/common/index,sp, selezionare il paese e la lingua.

Questa funzione consente di aggiornare facilmente il firmware del telefono a
una versione pitl recente da Internet senza la necessita di visitare un centro

di assistenza. Questa funzione sara disponibile solo se e quando LG mette a
disposizione una nuova versione del firmware per il dispositivo.

Poiché laggiornamento del firmware del telefono cellulare richiede la massima
attenzione da parte dell'utente per tutta la durata del processo di aggiornamento,
assicurarsi di controllare tutte le istruzioni e le note visualizzate a ogni passaggio
prima di procedere. Si prega di notare che la rimozione del cavo USB durante
laggiornamento puo danneggiare gravemente il telefono cellulare.

E « LGsiriserva il diritto di rendere disponibili aggiornamenti del firmware
esclusivamente per modelli selezionati a propria discrezione e non garantisce la
disponibilita della versione piti recente del firmware per tutti i modelli di cellulari.
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Aggiornamento software del telefono LG Mobile
tramite Over-the-Air (OTA)

Questa funzione consente di aggiornare facilmente il software del telefono a una

nuova versione tramite OTA, senza collegamento di un cavo USB. Questa funzione
sara disponibile solo se e quando LG mette a disposizione una nuova versione del

firmware per il dispositivo.

Per eseguire [aggiornamento del software del telefono,

Impostazioni > Sistema > Centro aggiornamenti > Aggiornamento software >
Controlla aggiornamenti.

E « | dati personali dell'utente presenti sulla memoria interna del telefono, ivi comprese
le informazioni relative allaccount Google e qualsiasi altro account, i dati e le
impostazioni di sistema/applicazioni, le app scaricate e la licenza DRM potrebbero
andare perduti nel processo di aggiornamento del software del telefono. Pertanto,
LG consiglia di eseguire il backup dei dati personali prima di aggiornare il software
del telefono. LG non si assume alcuna responsabilita per eventuali perdite di dati
personali.

+ Questa funzione dipende dallarea e dal provider del servizio.
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Guida antifurto

Configurare il dispositivo per impedire ad altre persone di utilizzarlo se é stato
ripristinato alle impostazioni di fabbrica senza permesso. Ad esempio, in caso
di smarrimento, furto o cancellazione dei dati del dispositivo, solo qualcuno in
possesso delle informazioni sullaccount Google o delle informazioni sul blocco
schermo puo utilizzare il dispositivo.

Per assicurarsi che il dispositivo sia protetto e sufficiente:

+ Impostare un blocco schermo: Se il dispositivo viene smarrito o rubato, ma
si dispone di un blocco schermo, il dispositivo non puo essere cancellato

utilizzando il menu Impostazioni a meno che lo schermo non venga sbloccato.

Aggiungere il proprio account Google sul dispositivo: Se il dispositivo viene
cancellato, ma e presente un account Google su di esso, il dispositivo non
puo terminare il processo di configurazione fino a quando le informazioni
dellaccount Google non vengono nuovamente inserite.

Dopo aver protetto il dispositivo, & necessario sbloccare lo schermo o immettere la
password dellaccount Google, se & necessario effettuare un ripristino di fabbrica.

Questo fa si che il ripristino venga effettuato da una persona di fiducia.

E + Non dimenticare account Google e la password aggiunti al dispositivo prima
di eseguire un ripristino di fabbrica. Se non & possibile fornire le informazioni

sullaccount durante il processo di configurazione, non sara possibile utilizzare il

dispositivo dopo aver esequito il ripristino di fabbrica
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Informazioni avviso software Open
Source

Per ottenere il codice sorgente contenuto in questo prodotto secondo quanto
consentito dalle licenze GPL, LGPL, MPL e altre licenze Open Source, visitare
http://opensource.lge.com.

In aggiunta al codice sorgente, sono disponibili per il download tutti i termini di
licenza, le esclusioni di responsabilita e e relative note di copyright.

LG Electronics fornira anche il codice open source su CD-ROM su richiesta tramite
e-malil all'indirizzo opensource@I|ge.com addebitando il costo delle spese di
distribuzione (ad esempio il costo di supporti, spedizione e gestione).

Lofferta e valida per un periodo di tre anni a partire dalla nostra ultima spedizione
di questo prodotto. Lofferta e valida per gli utenti che avranno ricevuto queste
informazioni.

Informazioni sulle normative
(Numero ID normativa, etichetta
digitale ecc.)

Per informazioni sulle normative, andare in Impostazioni > Sistema > Normative
& Sicurezza.
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Marchi di fabbrica

+ Copyright ©2020 LG Electronics Inc. Tutti i diritti riservati. LG e il logo LG sono
marchi registrati del Gruppo LG e delle sue entita correlate.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android, Chrome,
Google Photos, Google Play Protect, Google Calendar, Google Docs, Google Drive,
Google Sheets e altri marchi e logo correlati sono marchi di Google LLC.

- Bluetooth® & un marchio registrato di Bluetooth SIG, Inc. nel mondo.
+ Wi-Fi® e il logo Wi-Fi sono marchi registrati di Wi-Fi Alliance.
« Tutti gli altri marchi sono di proprieta dei rispettivi titolari.

HE HEVCAdvance™

‘: Covered by Patents at patentlisthevcadvance.com
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Dichiarazione sulla sicurezza del laser

Attenzione!

Questo prodotto utilizza un sistema laser. Per garantirne un utilizzo corretto,
leggere attentamente il presente manuale dell'utente e conservarlo come
riferimento per il futuro. Se 'unita richiede manutenzione, contattare un centro di
assistenza autorizzato.

Lutilizzo di controlli e regolazioni o lesecuzione di procedure diverse da quelle
specificate puo provocare lesposizione a radiazioni pericolose.

Per evitare lesposizione diretta al fascio laser, non tentare di aprire l'involucro o
entrare in contatto diretto con il laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT

CLASSE 1 PRODUIT LASER

DICHIARAZIONE DI CONFORMITA

Con il presente documento, LG Electronics dichiara che il prodotto
LM-G900EM e conforme ai requisiti essenziali e alle altre disposizioni della
Direttiva 2014/53/EU.

Una copia della Dichiarazione di conformita e disponibile allindirizzo
http7//wwwi.lg.com/global/declaration
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Contattare 'ufficio relativo alla
conformita del prodotto

LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

Labanda 5150 - 5350 MHz e limitata esclusivamente all'utilizzo domestico.
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Ulteriori informazioni

Parti in vetro temperato
Le parti in vetro temperato di questo dispositivo non sono permanenti e possono
usurarsi col passare del tempo.
+ Se silascia cadere il dispositivo su una superficie dura o lo si espone a un urto
violento, il vetro temperato potrebbe danneggiarsi.
In questi casi, interrompere immediatamente 'uso del dispositivo e contattare
un Centro di assistenza clienti LG.
+ Sul mercato sono disponibili apposite custodie per proteggere il dispositivo da
eventuali danni.
Tenere presente che tali custodie protettive non sono coperte dal servizio di
garanzia fornito da LG Electronics e non ne viene garantita la sicurezza.

Proporzioni
Questo dispositivo utilizza le proporzioni 20,59.
« Alcune app scaricate potrebbero non supportare le proporzioni 20,5:9.

In tal caso, selezionare le proporzioni dello schermo piti adatte allapp o
consultare il provider dell'app per ulteriori informazioni.
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Guida al trasferimento dati

+ Per i dati trasferibili tra dispositivi LG e tra un dispositivo LG e un dispositivo di
parti terze, vedere lo schema seguente.

Dispositivo Ii':z:s:;“;? Dispositivo
LG . i0S
parti terze
Tipo Dettagli dell'elemento - N —
Dlspféltwo Dispositivo Dlsplt-)éltlvo
LG
Contatti, messaggi, registri
chiamate, calendario, 0 0 0
Dati registrazioni audio
i
personat Promemoria X 0
Sveglie X X
Datll - Foto, wdeq, canzoni, 0 0 0
multimediali | documenti
Impostazioni della schermata
) 0 X X
home (cartelle e widget)
dischermo Impostazioni della schermata
di blocco (impostazioni di 0 X X
blocco schermo escluse)
App scaricate 0 0
Applicazioni | i personali contenuti nelle 0 X -
app scaricate
Certificato pubblico 0 0 X
A hamate o
' f 0 X X

e notifiche, accessibilita,
batteria)

E « Alcune dati potrebbero non essere trasmessi a seconda della versione del
software, della versione delle app, del sistema operativo, e delle politiche del

produttore del dispositivo o del gestore del servizio.
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Bande di frequenza supportate Potenza in uscita trasmettitore

GSM 900 33.7dBm
GSM 1800 30.7dBm
WB1 24.7 dBm
W B8 255dBm
LTE B1 24.2dBm
LTE B3 24.7 dBm
LTE B7 24.7dBm
LTE B8 255dBm
LTEB20 255dBm
LTEB28 255dBm
LTEB38 252dBm
LTE B40 25.2dBm
5G Sub6n1 24.7dBm
5G Sub6n3 24.7dBm
5G Sub6n28 24.5dBm
5G Sub6n40 252dBm
5G Sub6n78 227dBm
BT 2.4GHz 11dBm
WLAN 2.4GHz 19.5dBm
WLAN 5GHz 19dBm
NFC - 23 dBuA/m

Le informazioni sulladattatore da viaggio si possono trovare su
http/wwwi.lg.com/global/support/cedoc/cedoc
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Smaltimento delle apparecchiature obsolete

1. Tutte le apparecchiature elettriche ed elettroniche, contrassegnate da
questo simbolo ("bidone della spazzatura barrato da una croce”), devono
essere raccolte e smaltite separatamente rispetto agli altri rifiuti urbani
misti mediante impianti di raccolta specifici installati da enti pubblici o dalle

I autorita locali. Si ricorda che gli utenti finali domestici possono consegnare
gratuitamente le apparecchiature elettriche ed elettroniche a fine vita presso
il punto vendita all‘atto dellacquisto di una nuova apparecchiatura equivalente.
Gli utenti finali domestici possono inoltre consegnare gratuitamente
apparecchiature elettriche ed elettroniche di piccolissime dimensioni (non
eccedentii 25 cm) a fine vita direttamente presso un punto vendita a cio
abilitato, senza obbligo di acquistare una apparecchiatura nuova di tipo
equivalente. Si prega di informarsi previamente presso il punto vendita
prescelto circa tale ultima modalita di conferimento dellapparecchiatura a fine
vita.

2.1l corretto smaltimento dell'unita obsoleta contribuisce a prevenire possibili
conseguenze negative sulla salute degli individui e sullambiente. Una gestione
responsabile del fine vita delle apparecchiature elettriche ed elettroniche
da parte degli utenti contribuisce al riutilizzo, al riciclaggio ed al recupero
sostenibile dei prodotti obsoleti e dei relativi materiali.

3. Per informazioni piti dettagliate sullo smaltimento delle apparecchiature
obsolete, contattare ['ufficio del comune di residenza, il servizio di
smaltimento rifiuti o il punto vendita in cui & stato acquistato il prodotto.
(www.lg.com/global/recycling)

Smaltimento delle batterie/accumulatori

1. Questo simbolo potrebbe essere associato ai simboli chimici del mercurio (Hg),
cadmio (Cd) o piombo (Pb) se la batteria contiene piti di 0,0005% di mercurio,
0,002% di cadmio 0 0,004% di piombo.

2. Tutte le batterie e gli accumulatori devono essere smaltiti separatamente
rispetto alla raccolta differenziata municipale, mediante impianti di raccolta
specifici designati dal governo o dalle autorita locali.

3.l corretto smaltimento di batterie e accumulatori obsoleti contribuisce a
prevenire possibili conseguenze negative sullambiente, sulla salute degli
individui e su tutte le altre specie viventi.

4. Per informazioni piti dettagliate sullo smaltimento di batterie e accumulatori
obsoleti, contattare ['ufficio del comune di residenza, il servizio di smaltimento
rifiuti o il negozio in cui & stato acquistato il prodotto.
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FAQ

In questo capitolo sono descritti alcuni problemi che potrebbero verificarsi durante
l'uso del dispositivo. Alcuni problemi richiedono una chiamata al provider del
servizio, ma la maggior parte e facilmente risolvibile in autonomia.

Errore scheda SIM

Assicurarsi che la scheda SIM sia inserita correttamente.

Nessuna connessione alla rete o connessione di rete interrotta
Il segnale & debole. Spostarsi verso una finestra o in uno spazio aperto.
Sei al di fuori dellarea coperta dal fornitore di rete. Spostati e controlla la rete.

Le chiamate non sono disponibili
Nuova rete non autorizzata.

Assicurati di non avere impostato il blocco chiamate dal numero che effettua la
chiamata.

Assicurati di non avere impostato il blocco chiamate dal numero che stai
chiamando.

Non é possibile accendere il dispositivo
Quando la batteria & completamente scarica, il tuo dispositivo non si accende.
Ricaricare completamente la batteria prima di accendere il dispositivo.

Errore di caricamento

Assicurarsi che il dispositivo sia in carica a una temperatura normale.
Controllare il caricabatteria e il suo collegamento al dispositivo.
Utilizzare solo gli accessori forniti autorizzati da LG.

La batteria si scarica piu rapidamente rispetto a quando é
stata acquistata

Esponendo il dispositivo o la batteria a temperatura molto alte o molto basse, la
durata della batteria potrebbe ridursi.

Il consumo della batteria aumenta quando si usano certe app o funzionalita, come
GPS, giochi o internet.

La batteria e usurabile e la sua durata si riduce nel corso del tempo.
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Messaggi d'errore vengono visualizzati quando si avvia la
fotocamera.

Ricaricare la batteria.

Liberare memoria trasferendo i file a un computer o cancellando i file dal proprio
dispositivo.

consente di riawviare il dispositivo.

Se i problemi con app della fotocamera persistono dopo avere tentato con questi
suggerimenti, contattare il centro di assistenza LG Electronics.

La qualita delle foto & bassa.

La qualita delle foto potrebbe variare, a seconda dellambiente e delle tecniche
fotografiche usate.

Quando si realizzano foto e video, la qualita angolare standard & migliora rispetto al
grandangolo.

Realizzando foto in posti bui, di notte o interni, potrebbero essere presenti disturbi
o le immagini potrebbero essere sfocate.

In caso di problemi, azzerare le opzioni.

Lo schermo tattile risponde lentamente o in modo non
corretto

Collegando una protezione per lo schermo o accessori opzionali allo schermo tattile,
potrebbe non funzionare correttamente.

Indossando guanti, se le mani non sono pulite quando si tocca lo schermo tattile o
si sfiora lo schermo usando oggetti affilati o le punte delle dita, lo schermo tattile
potrebbe non funzionare.

Lo schermo tattile potrebbe non funzionare correttamente in condizioni di umidita
0 quando & esposto allacqua.

Riawviare lapparecchio per annullare eventuali bug del software.

Se lo schermo tattile e graffiato o danneggiato, visitare un centro di assistenza LG
Electronics.
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Chiude la chiamata o si blocca

Riavviare il dispositivo.
« Se il dispositivo si chiude la chiamata o si blocca, potrebbe essere necessario
chiudere le applicazioni o spegnere del tutto il dispositivo e riaccenderlo.

Eseguire un riavvio
- E possibile utilizzare un ripristino superficiale del dispositivo se lo schermo
si blocca oppure se i pulsanti, lo schermo a sfioramento o il dispositivo non
rispondono pill in modo corretto.
+ Per esequire un ripristino superficiale del dispositivo, tenere premuti i tasti
Volume giti e Power fino a quando il dispositivo non si riavvia.

E « Questa funzione non e disponibile quando il dispositivo e collegato a LG Dual
Screen (LM-G905N).

Azzerare il dispositivo
+ Seimetodiillustrati sopra non risolvono il problema, eseguire un ripristino dati

di fabbrica.

+ Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino >

Ripristino dati di fabbrica.

- Questo metodo consente di ripristinare tutte le impostazioni del dispositivo
ed eliminare i dati. Prima di eseguire il ripristino dei dati di fabbrica, effettuare
copie di backup di tutti i dati importanti salvati nel dispositivo.

- Seil dispositivo & associato a un account Google, effettuare laccesso allo
stesso account Google dopo il ripristino.
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L'apparecchio Bluetooth non € localizzato
Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo.

Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo a cui
vuoi connetterti.

Assicurarsi che il dispositivo e altri dispositivi Bluetooth siano nellarea massima del
Bluetooth (10 m)

Se i suggerimenti indicati non ti hanno aiutato a risolvere il problema, contatta un
centro di assistenza LG Electronics.

Quando colleghi il tuo apparecchio a un computer, non viene
stabilita una connessione.
Assicurarsi che il cavo USB che stai usando sia compatibile con il tuo apparecchio.

Assicurarsi che sul proprio computer siano installati e aggiornati i driver nella
versione corretta.

Un'applicazione scaricata sta causando molti errori.
L'applicazione presenta dei problemi.
Rimuovere e reinstallare applicazione.
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Descrizione di LG Dual Screen

E possibile collegare un LG Dual Screen a questo prodotto per [utilizzo.

5

E possibile collegare LG Dual Screen (di sequito “Dual Screen”) a LG VELVET
dedicato (di seguito “telefona”) per utilizzare il prodotto.

A seconda delle prestazioni del telefono dedicato, alcune funzioni del Dual Screen
potrebbero essere limitate. Il prodotto inoltre potrebbe non supportare altri
dispositivi mobili.

Questo prodotto non é resistente allacqua. Non esporre il dispositivo a liquidi o a
condizioni di umidita.

Se il dispositivo & bagnato, I'LDI collocato all'interno del dispositivo cambia colore. In
questo caso, il dispositivo non sara idoneo per i servizi di riparazione gratuiti forniti
nel contesto della garanzia limitata del dispositivo.

Indicazioni per un uso sicuro ed
efficiente

Leggere le semplici indicazioni riportate di seguito. Il mancato rispetto di tali indicazioni pud
rivelarsi pericoloso o illegale.

Manutenzione e cura del prodotto

+ Utilizzare solo gli accessori forniti autorizzati da LG. Qualsiasi danno o guasto causato da
accessori di terze parti non é coperto dalla garanzia LG.

Alcuni contenuti e illustrazioni possono differire dal dispositivo senza preawiso.

+ Non smontare [apparecchio. Se e necessaria una riparazione, rivolgersi presso un centro
assistenza autorizzato LG.

La garanzia copre, a discrezione di LG, la sostituzione di parti o schede nuove o riconvertite,

funzionalmente equivalenti.
+ Tenere lontano da apparecchiature elettriche quali TV, radio e PC.

+ Tenere lontano da fonti di calore quali termosifoni o fornelli.

Non far cadere lapparecchio.

Non sottoporre lapparecchio a scosse, urti o vibrazioni.
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Spegnere il dispositivo nelle aree in cui e specificamente richiesto. Ad esempio, non
utilizzarlo allinterno di ospedali, in quanto potrebbe interferire con il funzionamento di
apparecchiature mediche sensibili.

Non afferrare il dispositivo con le mani bagnate mentre € in carica. Cio potrebbe provocare
scosse elettriche o danneggiare seriamente il prodotto.

Usare un panno asciutto per la pulizia esterna del cellulare (non usare solventi come
benzene, acquaragia o alcol).

Non esporre lapparecchio a fumo o polvere.

Tenere lontano il dispositivo da carte di credito o supporti magnetici per evitarne la
smagnetizzazione.

Non toccare lo schermo con oggetti appuntiti per evitare di danneggiare il dispositivo.
Non esporre il dispositivo a umidita o a contatto con liquidi.

In caso di vetro rotto o scheggiato, non utilizzare il dispositivo, non toccare il vetro, né
tentare di rimuoverlo o ripararlo. | danni al display in vetro dovuti ad abuso o utilizzo non
corretto non sono coperti dalla garanzia.

Il dispositivo e un dispositivo elettronico che genera calore durante il normale
funzionamento. Il contatto diretto e prolungato con la pelle e lassenza di unadeguata
ventilazione possono provocare disagi e piccole bruciature. Pertanto, & necessario
maneggiare con cura il dispositivo durante o subito dopo [utilizzo.

Se il dispositivo si bagna, scollegarlo immediatamente e farlo asciugare completamente.
Non tentare di accelerare il processo di asciugatura con una fonte di calore esterna, ad
esempio un forno, un forno a microonde o un asciugacapelli.

Il liquido presente nel dispositivo bagnato potrebbe modificare il colore delletichetta del
prodotto presente allinterno. | danni al dispositivo derivanti dallesposizione ai liquidi non
sono coperti da garanzia.

Un dispositivo mobile ha bisogno di una corretta circolazione dellaria per disperdere il
calore. Il contatto diretto con la pelle ed un'insufficiente circolazione daria sul dispositivo
potrebbe causare un surriscaldamento. Il dispositivo deve trovarsi ad almeno 1,0 cm dal
corpo dell'utente.

Evitare che il prodotto venga a contatto con liquidi. Non utilizzare o caricare il prodotto se
& bagnato. Se il prodotto si bagna, lindicatore dei danni causati dai liquidi cambia colore.
Tenere presente che cio limitera la possibilita di ricevere eventuali servizi di riparazione
gratuiti previsti dalla garanzia.
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Funzionamento efficiente del dispositivo

Dispositivi elettronici

Tutti i dispositivi possono subire interferenze che influiscono sulle prestazioni.

+ Non utilizzare il dispositivo in prossimita di apparecchiature mediche senza autorizzazione.

Consultare un medico per determinare se ['uso del dispositivo possa interferire con il
funzionamento dell'apparecchio medico.

+ | produttori di pacemaker raccomandano una distanza minima di 15 cm da altri dispositivi e

pacemaker per evitare possibili interferenze con quest'ultimo.
Il dispositivo potrebbe interferire con alcuni tipi di apparecchi acustici.

Il telefono potrebbe interferire con apparecchi televisivi, radio, computer; ecc.

+ Utilizzare il dispositivo a una temperatura compresa tra 0 °C e 35 °C, se possibile.

Lesposizione del dispositivo a temperature estremamente alte o basse puo causare danni,
malfunzionamenti o perfino esplosioni.

Sicurezza in automobile

Verificare le leggi e le normative che riguardano l'utilizzo dei dispositivi quando si guida.

Non utilizzare il dispositivo in modalita manuale durante la quida.

Prestare la massima attenzione alla quida.

+ Sele condizioni di guida lo richiedono, accostare e parcheggiare prima di telefonare o

rispondere a una chiamata.

L'energia RF puo influire sul sistema elettronico del veicolo, ad esempio sullo stereo o sulle
apparecchiature di sicurezza.

+ Seil veicolo & dotato di airbag, non collocarvi accanto oggetti come apparecchi wireless

portatili o installati per evitare lesioni gravi causate dallerrato funzionamento dellair bag.

- Durante l'ascolto della musica tramite il cellulare, assicurarsi che il volume sia

ragionevolmente basso da consentire il rilevamento dei rumori circostanti. Cio &
particolarmente importante in prossimita di strade.
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Parti in vetro

Alcune parti del dispositivo sono in vetro. Se il dispositivo cade su una superficie rigida o subisce
un forte impatto, il vetro pud rompersi. Se cio accade, non toccare o tentare di rimuovere il
vetro. Non utilizzare il dispositivo finché il vetro non viene sostituito da un centro di assistenza
autorizzato..

Aree a rischio di esplosione

Non utilizzare il dispositivo in aree dove sono in atto operazioni di detonazione. Rispettare le
restrizioni e osservare tutte le norme o i regolamenti al riguardo.

Atmosfere potenzialmente esplosive
Non utilizzare il dispositivo in prossimita di stazioni di servizio.

+ Non utilizzare [apparecchio in prossimita di combustibili o prodotti chimici.

Non trasportare né conservare sostanze esplosive, liquidi o gas infiammabili all'interno
dellautovettura in cuisi trovano il dispositivo o i relativi accessori.

Bambini

Conservare il dispositivo in un posto sicuro, lontano dalla portata dei bambini. Lapparecchio
& composto da parti smontabili di piccole dimensioni che, se ingerite, possono provocare
soffocamento.
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Componenti e accessori del prodotto

| seguenti articoli sono forniti in dotazione con il prodotto.

+ Prodotto + Guida introduttiva
+ Adattatore di ricarica

A « Assicurarsi di utilizzare accessori originali forniti da LG Electronics. Luso di
prodotti non originali pud compromettere la qualita delle telefonate, causare
malfunzionamenti del dispositivo, ecc. In tal caso, potrebbe non essere possibile
ricevere il servizio fornito da LG Electronics.

Alcune delle componenti del Dual Screen sono in vetro temperato. Se si lascia
cadere il prodotto su una superficie dura o lo si espone a un urto violento, il vetro
temperato potrebbe danneggiarsi. In questi casi, interrompere immediatamente
['uso del prodotto e contattare un Centro di assistenza clienti LG.

L'aspetto e le specifiche del prodotto sono soggetti a modifica senza preawviso.

i

« Lesterno e le specifiche del Dual Screen possono subire modifiche senza preawviso
per migliorarne le prestazioni.
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Panoramica delle parti

Lato anteriore

o
N
o1
0—]
00—
—
Aperto
(4] =S U
(5
o 6]
(1) Display esterno © Schermo del prodotto
. Terminale di comunicazione/
@ Tasti volume alimentazione
© Tasto Assistente Google @ Porta Pogo pin

0 Foro per auricolare

E + Questo manuale é destinato agli utenti che connettono un telefono a questo
Dual Screen. Per ulteriori informazioni su come utilizzare questo Dual Screen e il
telefono, visitare www.lg.com e consultare il manuale d'uso dettagliato.
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Collegamento del telefono al Dual
Screen

1 Aprire completamente il Dual Screen, in modo che sia parallelo a una superficie
piana.

7 Farscorrerela parte inferiore del telefono nella parte inferiore del Dual Screen,
come illustrato nella figura. A questo punto accertare che la parte 0 del
telefono siinserisca correttamente nella parte 0 del Dual Screen.
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3 Premere la parte “ del telefono con un dito per far agganciare il bordo del

telefono a quello del Dual Screen.

U

4 Premere la parte 0 del telefono per innestare completamente il Dual Screen

nel telefono.
(- Y4 _
J\ﬂ:
N — \X 7

« Assicurarsi che il telefono sia completamente inserito nel Dual Screen prima
dell'uso.
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Rimozione del telefono dal Dual
Screen

1 Aprire completamente il Dual Screen e reggerlo saldamente con entrambe le
mani, come illustrato nella figura.

7 Premere la parte “ del Dual Screen con un dito spingendo
contemporaneamente la parte posteriore del telefono con un altro dito per
estrarre il bordo del telefono dal Dual Screen.
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3 Estrarre la parte e del telefono dal Dual Screen seguendo le stesse indicazioni
del passaggio precedente.

(4
O

4 Reggere il Dual Screen con entrambe le mani e far scorrere il telefono nella
direzione della freccia per rimuoverlo. Fare attenzione a non ruotare il telefono
a sinistra o a destra o spingerlo verso l'alto con un‘angolazione eccessiva.

/\\ ATTENZIONE:
« Non sollevare il telefono dal Dual Screen con un‘angolazione acuta, come illustrato sotto.
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LG Dual Screen (LM-G905N)

Se, quando si rimuove il telefono, si estrae il telefono dal Dual Screen con
un'angolazione eccessiva o con una forza eccessiva, si potrebbe danneggiare il
terminale di comunicazione/alimentazione nella parte inferiore del Dual Screen

o la porta di comunicazione dati USB e caricabatterie del telefono. Durante la
rimozione del telefono, assicurarsi di spingere verso [alto il telefono nella direzione
della freccia, come mostrato nella figura.

Fare attenzione a non far cadere il Dual Screen o il telefono durante l'inserimento
o larimozione del telefono.

Quando si inserisce o si estrae il telefono dal prodotto, fare attenzione a non
esercitare una forza eccessiva. Cio puo danneggiare il Dual Screen.

Alcune delle componenti del Dual Screen sono in vetro temperato. Se il Dual
Screen cade su una superficie dura o viene sottoposto a forti urti, il vetro
temperato si puo incrinare o usurare, con conseguente danneggiamento del Dual
Screen e possibili lesioni personali. In tal caso, interrompere immediatamente
l'uso del Dual Screen e rivolgersi al centro di assistenza clienti LG pili vicino per la
riparazione.

Nelle sequenti situazioni, la cover del Dual Screen potrebbe non chiudersi
completamente o il Dual Screen potrebbe non funzionare normalmente a
causa della scarsa comunicazione o della connessione difettosa del terminale di
alimentazione.

Se si applicano una pellicola o un vetro di protezione o altri accessori sul Dual
Screen o sullo schermo del telefono

Se si applicano una pellicola di protezione o adesivi spessi sull'area di
connessione del Dual Screen o sul lato posteriore del telefono

Se si inseriscono fogli di carta o tessere tra il Dual Screen e il telefono
Se si utilizza la funzione di ricarica wireless o NFC mentre il telefono e inserito nel
Dual Screen, la ricarica potrebbe non funzionare correttamente.

Quando il telefono & montato sul Dual Screen, non & possibile collegarlo a un
televisore con un cavo HDMI. Quando il telefono & smontato dal Dual Screen, pud
essere collegato a un televisore con un cavo HDMI.
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Utilizzo dell’adattatore di ricarica

E possibile utilizzare 'adattatore di ricarica per caricare il telefono o spostare i dati

mentre il telefono & inserito nel Dual Screen.

1 Conil telefono montato nel Dual Screen, collegare l'adattatore di ricarica alla
porta di ricarica nella parte inferiore del Dual Screen, come illustrato nella figura
sotto.

E + Pogo Pin non funziona se é collegato nella direzione inversa.

« La connessione USB tramite Pogo Pin non supporta OTG, audio, HDMI o USB 3.0
A questo scopo, collegare direttamente il cavo alla porta del telefono dopo aver
rimosso il Dual Screen.
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2 Collegare un cavo USB tipo C.
- E possibile caricare il telefono o spostare i dati.

",

Connettore del cavo di ricarica ),

E + Quando ladattatore di ricarica non é utilizzato, scollegarlo dallalimentazione e
mantenerlo separato dal connettore del cavo di ricarica. Se la parte magnetica
dell'adattatore di ricarica viene a contatto con metalli o sostanze conduttive
presenti nelle vicinanze, si potrebbe rompere, bruciare o danneggiare a causa di
scosse elettriche.

« Assicurarsi di utilizzare sempre ['adattatore di ricarica fornito con il Dual Screen.

In caso di smarrimento dell'adattatore di ricarica o se si desidera acquistarne uno
nuovo, chiamare il Centro assistenza clienti LG Electronics per informazioni.

|'adattatore diricarica e la porta di ricarica nella parte inferiore del Dual Screen
sono collegati magneticamente. Non agitare o estrarre ['adattatore di ricarica
durante ['utilizzo.
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Uso del Dual Screen

Non é possibile rispondere alle chiamate e

terminarle con il tasto Assistente Google
Con Dual Screen e il telefono collegato, & possibile rispondere alle chiamate
premendo una volta il tasto Assistente Google. per terminare le chiamate, premere
due volte il tasto Assistente Google.
- E possibile rispondere alle chiamate o terminarle con il tasto Assistente Google
solo se la cover del Dual Screen e completamente chiusa.
+ Accertare che il prodotto e il telefono siano collegati mediante almeno una
sincronizzazione.

Durante le chiamate
Durante le chiamate, & possibile piegare il Dual Screen verso lesterno a 360° o
verso linterno a 0°.

+ Sesi utilizza il Dual Screen piegandolo a 360°, assicurarsi che il lato anteriore
e quello posteriore del Dual Screen siano completamente a contatto. In questo
caso, lo schermo del Dual Screen si spegne automaticamente per risparmiare
energia.

360° 0°
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Uso del Dual Screen
Aprire il Dual Screen per affiancare i due schermi.

Schermo del —7——— e Schermo del
prodotto telefono

Regolazione del colore dello schermo
Quando si utilizzano contemporaneamente lo schermo del prodotto e quello del
telefono, si potrebbe notare una differenza di colore tra colore i due schermi.
+ Provare a regolare la temperatura del colore o i livelli RGB. Nella schermata
Home, toccare Impostazioni > Display > Colore dello schermo, quindi regolare
la temperatura del colore.

+ Colore dello colori possono apparire diversi a seconda dell'angolo di visione,
quindi regolare Colore dello colori nello stato completamente aperto.

Utilizzo della schermata Home di Dual Screen

Descrizione della schermata Home di Dual Screen
La schermata Home del Dual Screen puo funzionare indipendentemente dallo
schermo del prodotto.

+ Fornisce icone di awio rapido e una barra a sfioramento Home.

- E possibile cambiare lo sfondo e impostare widget.

+ Nella schermata Home & anche possibile eseguire diverse app dal cassetto delle
app e generare o eliminare cartelle.
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Descrizione del layout della schermata Home di Dual Screen

E possibile utilizzare varie funzioni mediante le icone presenti nella schermata
Home.

»— Area di accesso rapido

Barra di navigazione

E + Lo sfondo del Dual Screen puo differire dalla figura a seconda dei criteri del
produttore, delle impostazioni dell'utente, delle versioni del software, dei servizi
offerti dai fornitori di telecomunicazioni ecc

- Area di accesso rapido: e possibile fissare le app principali nella parte inferiore
dello schermo in modo che siano accessibili da qualsiasi area della schermata
Home.

- Barra di navigazione: E possibile usare i gesti per andare alla schermata
Home, alla schermata precedente, alla schermata Panoramica o per passare
rapidamente tra le app.
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Uso del pannello dual screen

E possibile aprire il pannello Dual Screen trascinando verso il basso il lato superiore
dello schermo.

- E possibile regolare la luminosita dello schermo nel pannello Dual Screen.

- Sesi attiva la sincronizzazione selezionando Sync, la luminosita del dual
screen si sincronizza con quella del prodotto connesso.

- E possibile toccare Screenshot per scattare una foto dello schermo del
prodotto.

- E possibile spegnere lo schermo del prodotto toccando Dual Screen.
- Ildual screen e il telefono connesso vengono disconnessi.
- E possibile toccare [ per accedere al menu delle impostazioni del dual screen.

. -— Impostazioni Dual Screen
Regolare la luminosita p—

I

Screenshot ——— e—— Dual Screen
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Modifiche della schermata Home di Dual Screen
Tenere premuta unarea vuota della schermata Home del dual screen ed esequire la
funzione desiderata.
+ Per aggiungere un widget alla schermata Home, toccare e tenere premuta
un‘area vuota della schermata Home, quindi selezionare Widget.
+ Per modificare lo sfondo, toccare e tenere premuta un‘area vuota della
schermata Home, quindi selezionare Sfondi.
+ Per cambiare la schermata predefinita, toccare e tenere premuta un'area vuota
della schermata Home, spostarsi sulla schermata desiderata, toccare 0, quindi
toccare nuovamente la schermata.

Schermata predefinita

Widget | L Sfondi
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Visualizzazione dello sfondo del Dual Screen

Nella schermata Home & possibile visualizzare solo limmagine di sfondo
nascondendo app e widget.

Allontanare due dita sulla schermata Home.

+ Per tornare alla schermata originale con la visualizzazione di app e widget,
awicinare le dita sulla schermata Home o toccare <

Impostazione dellambiente del Dual Screen
E possibile impostare lambiente del dual screen sul telefono ad esso connesso.

1 Nella schermata Home, toccare Impostazioni > Display > Dual Screen.

E « Per visualizzare la voce di menu per [impostazione dellambiente del dual screen,
necessario connettere il telefono al dual screen.
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7 Selezionare e impostare le funzioni desiderate.

5

Display esterno: Consente di impostare se utilizzare la visualizzazione della

copertina sul lato anteriore del dual screen.

- Timeout schermo / Timeout giornaliero: £ possibile impostare se usare
entrambi gli schermi contemporaneamente.

Strumento Dual Screen: Quando si collega il telefono al Dual Screen, sullo

schermo appaiono gli strumenti del dual screen. Il livello di luminosita &

sincronizzato con quello del Dual Screen.

Usa Dual Screen: £ possibile attivare e disattivare il dual screen, cambiare

schermate tra il telefono e il dual screen.

- Piega inversa: E possibile impostare il comportamento per lo schermo
opposto quando il dual screen e ripiegato.

Luminosita: Consente di regolare la luminosita dello schermo trascinando la

barra di controllo a sinistra o a destra.

- Mantieni come la schermata principale: Consente di sincronizzare il
livello di luminosita con quello del telefono connesso.

Estendi schermo: E possibile estendere la visualizzazione di unapp a

entrambi gli schermi.

Sfondo: Consente di selezionare lo sfondo della schermata Home.

Icone del cassetto delle app: Consente di visualizzare o nascondere il

cassetto delle app del prodotto.

Scorciatoia multi-app: E possibile impostare due app in modo che vengano

eseqguite contemporaneamente sulla schermata principale e sul dual screen.

App preferita: Consente di selezionare le app da eseguire automaticamente

ogni volta che si accende il dual screen.

+ Lelenco delle app che vengono visualizzate sullo schermo puo variare a seconda
delle app installate.
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Strumento Dual Screen

Quando si connette il telefono al dual screen e si accende il dual screen, sul lato
dello schermo del telefono appare licona del menu Strumenti Dual Screen 9
Toccare % per aprire il menu Strumenti Dual Screen e accedere alle opzioni
illustrate di sequito.

% /@ Toccare leggermente per visualizzare o nascondere il menu Strumenti Dual
Screen.

@ E possibile passare tra il dual screen e il telefono.

@ E possibile inviare la schermata dal telefono al dual screen.

@ E possibile riportare la schermata dal dual screen al telefono.

Se si utilizza solo il dual screen, & possibile ridurre il livello di luminosita dello
schermo del telefono (schermo principale) per risparmiare la batteria. Per non
utilizzare questa funzione, scorrere sullo schermo principale.

@ E possibile spegnere il dual screen.

)

*—— Strumento Dual Screen

»—— (ambia schermo
»—— Mostra principale su Dual Screen
»—— Mostra Dual Screen su principale

»—— \Vletti lo schermo principale a dormire

»—— Spegnere il dual screen
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E + Spegnendo il telefono, si spegne anche il dual screen. Tuttavia, se si spegne il dual
screen, il telefono rimane acceso.

+ Questa funzione non ¢ disponibile nella schermata di blocco e si attiva sbloccando
lo schermo.

Utilizzo della modalita multi-pagina

Per comodita e possibile estendere ['uso di un‘app allo schermo principale e allo
schermo del dual screen.

E + Questa funzione é disponibile anche in app partner in aggiunta alle app

Fotocamera e Galleria.
« Linterfaccia utente puo variare a seconda dellapp utilizzata.
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Utilizzo della modalita multi-pagina in Fotocamera

E possibile riprendere una foto o un video sul telefono o sul dual screen e
visualizzare il risultato sullaltro schermo.

1 Nella schermata Home, toccare @ sul telefono o sul dual screen e scattare una
foto o registrare un video.

2 Dopo aver ripreso una foto o un video, selezionare licona Anteprima.

« E possibile visualizzare la foto o il video ripresi sul dual screen sullaltro
schermo dove non e aperta la fotocamera.

Y

\

l

|
Icona Anteprima

E + Una volta toccata l'icona Anteprima per visualizzare una foto o un video, la
schermata di anteprima rimane attiva e visualizza automaticamente [ultima foto o
video ripresi nel caso siano stati ripresi piti foto o video.

« Questa funzione non rimane attiva se si chiude e si riapre ['app Fotocamera.
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Utilizzo della modalita multi-pagina in Galleria

Toccare [<J(]in una cartella nella Galleria sul dual screen o sul telefono per
visualizzare |a foto o i video ingranditi sullaltro schermo.

1 Nella schermata Home, toccare c sul telefono o sul dual screen.

7 Selezionare una cartella dell'album e quindi toccare (<]

+ Lafoto oil video vengono visualizzati in una vista ingrandita sullo schermo
opposto.

+ Toccare (] per uscire da questa funzione.

Icona di Estensione Icona Ripristina

I
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Utilizzo dell'app Dual Screen
Ogni volta che si accende il dual screen, le app dual screen preimpostate vengono
eseguite automaticamente.

T Nella schermata Home, toccare Impostazioni > Display > Dual Screen > App
preferita.

7 Selezionare le app da eseguire automaticamente allaccensione del dual screen.

+ Alcune app non possono essere eseqguite come app dual screen.

« Lelenco delle app che vengono visualizzate sullo schermo puo variare a seconda
delle app installate.

Effettuazione di una videochiamata usando il Dual

Screen
E possibile visualizzare la propria immagine sul Dual Screen, e limmagine
dell'interlocutore sul telefono.

+ Awiare una videochiamata sul telefono.

- Limmagine dell'interlocutore viene visualizzata sullo schermo del telefono e la
propria immagine viene visualizzata nellangolo inferiore destro dello schermo
del telefono.

- Toccare [§¢] nella parte superiore dello schermo del telefono per visualizzare la
propria immagine sul Dual Screen.

- Toccare nuovamente (35] per tornare alla modalita di visualizzazione
precedente.

E - |ltitoloin alto e il pulsante in basso appaiono contemporaneamente e scompaiono
dopo 4 secondi.

+ Nel corso delle videochiamate sul telefono, € possibile utilizzare altre app o
funzioni del Dual Screen
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Passaggio tra le schermate delle app sul dual screen

E possibile scorrere sullo schermo con tre dita per spostare la schermata di un'app
dallo schermo del dual screen allo schermo del telefono.
+ Scorrere sulla schermata dellapp con tre dita verso sinistra o verso destra per
spostarla liberamente dallo schermo principale al dual screen e viceversa.

o\

Scorrere sulla schermata dellapp con tre dita Sposta la schermata di un‘app sullo schermo
principale

o\

Scorrere sulla schermata dellapp con tre dita Sposta la schermata di unapp sul dual screen

E « Per usare questa funzione, le tre dita devono toccare lo schermo
contemporaneamente.
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Utilizzo della doppia tastiera sul dual screen

Quando si utilizza la tastiera in modalita orizzontale, & possibile espandere la
tastiera in modo da usare lo schermo superiore come schermo dellapp e lo
schermo inferiore come schermo della tastiera.

1 Portare il dual screen in modalita orizzontale nella schermata di immissione da
tastiera.
7 Toccare £ nella finestra di immissione da tastiera del dual screen.

- E possibile digitare sulla tastiera sullo schermo inferiore visualizzando il testo
inserito sullo schermo superiore.

« Toccare B8 nello stato espanso per riportare la tastiera inferiore nella
posizione originale.

Doppia tastiera

5 « Per spostare la schermata dellapp verso lalto o verso il basso, toccare lo schermo
con tre dita contemporaneamente e spostarla verso lalto o verso il basso. Per
ulteriori dettagli, consultare la sezione Passaggio tra le schermate delle app sul

dual screen,
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Utilizzo di Mirror Mode sul dual screen

Quando si scattano foto con la fotocamera, & possibile visualizzare le foto in
anteprima sul dual screen.

T Nella schermata Home, toccare (&)

2 Toccare [J{] nella parte superiore della schermata della fotocamera.
+ Mirror Mode appare sul dual screen.

Dual Mirror Mode

ri

I\ I\

E - E possibile anche scattare foto o riprendere video direttamente dal dual screen

Usare il dual screen per regolare l'angolo per varie situazioni, come illustrato sotto.

+ Scatto con angolo alto: Da utilizzare per scattare una foto di molte persone a un
concerto o altro evento oppure per scattare foto di spazi ampi.

+ Scatto con angolo basso: Da utilizzare per scattare immagini di bambini
allaltezza dei loro occhi o per scattare foto di edifici elevati ecc.

Scatto con angolo basso Scatto con angolo alto
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Utilizzo di Cattura Immediata sul dual screen
Quando il telefono é collegato al dual screen, la funzione Cattura Immediata :I}CJ] e
abilitata nella tastiera LG.
E possibile usare la tastiera nello schermo principale, scattare una foto dello
schermo del dual screen e inserirla direttamente nella finestra di immissione da
tastiera.
Toccare B9 sulla schermata di immissione della tastiera LG.

+ Lo schermo del dual screen viene acquisito e allegato automaticamente alla

schermata di immissione da tastiera.

l% Cattura Immediata

o\
§

e —— Schermata acquisita

E « Con questa funzione abilitata, & possibile estendere la tastiera a entrambi gli
schermi.
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Game Pad LG

E possibile usare comandi virtuali sullo schermo del prodotto mentre si usano giochi
nel telefono. Durante il gioco, allontanare lo schermo principale dal dual screen, in
modo che i comandi non blocchino lo schermo di gioco.

1 Nella schermata Home, toccare Launcher del Gioco e selezionare LG Game
Pad

Game Pad LG

- Game Pad LG appare sullo schermo del prodotto.

2 Toccare @l e scorrere a sinistra e a destra per selezionare lo stile di Game Pad
LG preferito.
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E possibile giocare reggendo il Dual Screen come illustrato sotto.

+ Game Pad LG é disponibile solo per i giochi che supportano i gamepad fisici

+ A seconda del gioco, alcune app o pulsanti potrebbero non supportare the Game
Pad LG.
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Crea Pad personalizzato

Oltre al Game Pad LG, & possibile personalizzare il proprio game pad. E possibile
creare un game pad personalizzato sincronizzato con i pulsanti per il gioco.

1 Aprireil gioco sul Dual Screen.

+ Ruotare il dispositivo orizzontalmente, in modo che il Dual Screen sia sopra e
lo schermo del telefono sia sotto.

Ve

A

7 Nella schermata Home, toccare Launcher del Gioco e selezionare LG Game
Pad [®], quindi farlo scorrere verso lestremita destra dello schermo.

« Sullo schermo appare Crea Pad personalizzato.
- Toccare 4 nella schermata Crea Pad personalizzato.
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3 Toccare - nella parte superiore destra della schermata Game Pad
personalizzato per visualizzare i pulsanti disponibili e selezionare un pulsante
da usare nel Game Pad personalizzato.

- Il pulsante selezionati appare nella schermata Game Pad personalizzato.

/. Guardando la schermata di gioco sul Dual Screen, portare il pulsante
selezionato nella posizione desiderata dello schermo del telefono.

+ Selezionare gl nel gioco sul Dual Screen e sincronizzarlo con il pulsante
appena creato.

+ Regola la posizione e le dimensioni del pulsante appena creato sullo schermo
del telefono.

E « Utilizzando il pulsante appena creato sullo schermo del telefono, si ottiene lo
stesso effetto dell'uso del pulsante sul dual screen.
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5 Toccare \/ per salvare il Game Pad personalizzato.

+ Quando si salva il Game Pad personalizzato, il titolo del gioco viene usato
come titolo del Game Pad personalizzato.

5 « IlGame Pad personalizzato creato sara il game pad dedicato per quel gioco.
« Alcuni pulsanti potrebbero non funzionare in seguito allaggiornamento del gioco.

« Game Pad personalizzato puo essere creato solo sullo schermo del telefono, il
Dual Screen non lo supporta.

LG Dual Screen (LM-G905N) 205



Marchi di fabbrica

+ Copyright ©2020 LG Electronics Inc. Tutti i diritti riservati. LG e il logo LG sono
marchi registrati del Gruppo LG e delle sue entita correlate.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Google Photos, Google Play Protect, Google Calendar, Google Docs,
Google Drive, Google Sheets e altri marchi e logo correlati sono marchi di Google
LLC.

Tutti gli altri marchi sono di proprieta dei rispettivi titolari.

DICHIARAZIONE DI CONFORMITA

Con il presente documento, LG Electronics dichiara che il prodotto
LM-G905N ¢ conforme ai requisiti essenziali e alle altre disposizioni della Direttiva
2014/35/EU e 2014/30/EU.

Una copia della Dichiarazione di conformita e disponibile allindirizzo
http7//wwwi.lg.com/global/declaration

Contattare 'ufficio relativo alla
conformita del prodotto

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands
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Ulteriori informazioni

Precauzioni per la manipolazione del prodotto
Questo prodotto non puod essere utilizzato da solo.

Non utilizzare o caricare il prodotto in presenza di umidita sui terminali di

comunicazione alimentazione del prodotto.

- Cio puo provocare incendi, scosse elettriche, infortuni o il malfunzionamento
del dispositivo.

- In caso di umidita, interrompere immediatamente ['utilizzo e rimuovere
completamente ['umidita.

+ Illiquido presente nel telefono bagnato potrebbe modificare il colore

delletichetta del prodotto situata allinterno del telefono. | danni al dispositivo

derivanti dallesposizione ai liquidi non sono coperti da garanzia.

Parti in vetro temperato

Le parti in vetro temperato di questo dispositivo non sono permanenti e possono
usurarsi col passare del tempo.

Se si lascia cadere il dispositivo su una superficie dura o lo si espone a un urto
violento, il vetro temperato potrebbe danneggiarsi.

In questi casi, interrompere immediatamente ['uso del dispositivo e contattare
un Centro di assistenza clienti LG.

+ Sul mercato sono disponibili apposite custodie per proteggere il dispositivo da
eventuali danni.

Tenere presente che tali custodie protettive non sono coperte dal servizio di
garanzia fornito da LG Electronics e non ne viene garantita la sicurezza.

Utilizzo della batteria
+ Questo prodotto non utilizza una propria batteria.

+ Quando e collegato a un telefono mobile, il prodotto utilizza la batteria del
telefono mobile.
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Smaltimento delle apparecchiature obsolete

1. Tutte le apparecchiature elettriche ed elettroniche, contrassegnate da
questo simbolo (“bidone della spazzatura barrato da una croce”), devono
essere raccolte e smaltite separatamente rispetto agli altri rifiuti urbani

—— misti mediante impianti di raccolta specifici installati da enti pubblici o dalle
autorita locali. Si ricorda che gli utenti finali domestici possono consegnare
gratuitamente le apparecchiature elettriche ed elettroniche a fine vita
presso il punto vendita all‘atto dellacquisto di una nuova apparecchiatura
equivalente. Gli utenti finali domestici possono inoltre consegnare
gratuitamente apparecchiature elettriche ed elettroniche di piccolissime
dimensioni (non eccedenti i 25 cm) a fine vita direttamente presso un punto
vendita a cio abilitato, senza obbligo di acquistare una apparecchiatura nuova
di tipo equivalente. Si prega di informarsi previamente presso il punto vendita
prescelto circa tale ultima modalita di conferimento dellapparecchiatura a
fine vita.

2. |l corretto smaltimento dell'unita obsoleta contribuisce a prevenire possibili
conseguenze negative sulla salute degli individui e sull'ambiente. Una
gestione responsabile del fine vita delle apparecchiature elettriche ed
elettroniche da parte degli utenti contribuisce al riutilizzo, al riciclaggio ed al
recupero sostenibile dei prodotti obsoleti e dei relativi materiali.

3. Per informazioni pit dettagliate sullo smaltimento delle apparecchiature
obsolete, contattare 'ufficio del comune di residenza, il servizio di
smaltimento rifiuti o il punto vendita in cui & stato acquistato il prodotto.
(wwwilg.com/global/recycling)
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NEDERLANDS
Over deze gebruikershandleiding

Hartelijk dank voor het kiezen van dit LG-product. Lees deze
gebruikershandleiding zorgvuldig door alvorens u het toestel voor het
eerst gebruikt om een veilig en juist gebruik te verzekeren.
+ Gebruik altijd originele LG-accessoires. De meegeleverde items zijn
alleen voor dit toestel ontworpen en zijn mogelijk niet compatibel met
andere apparaten.

+ De beschrijvingen zijn gebaseerd op de standaardinstellingen van het
toestel.

+ De standaardapps op het toestel kunnen worden bijgewerkt en de
ondersteuning van deze apps kan zonder voorafgaande kennisgeving
worden stopgezet. Bij eventuele vragen over een app die bij het toestel
wordt meegeleverd, neemt u contact op met een servicecenter van LG.
In het geval van apps die u zelf hebt geinstalleerd, neemt u contact op
met de relevante serviceprovider.

+ Wijzigingen aan het besturingssysteem van het toestel en de
installatie van software afkomstig van onofficiéle bronnen kan schade
aan het toestel veroorzaken en leiden tot de beschadiging of het
verlies van gegevens. Door dergelijke handelingen schendt u de LG-
licentieovereenkomst in en wordt de garantie ongeldig.

- Bepaalde inhoud en afbeeldingen wijken mogelijk af van uw toestel,
afhankelijk van de regio, de serviceprovider, de softwareversie of de
versie van het besturingssysteem, en kunnen zonder voorafgaande
kennisgeving worden gewijzigd.

+ De bij het toestel meegeleverde software, audio, achtergronden,
afbeeldingen en andere media zijn voor een beperkt gebruik
gelicentieerd. Als u dit materiaal extraheert of gebruikt voor
commerciéle of andere doeleinden, overtreedt u mogelijk de
auteursrechten. U bent als gebruiker volledig verantwoordelijk voor het
onwettig gebruik van media.



.

Bij het gebruik van dataservices zoals chatten, uploaden, downloaden,
automatisch synchroniseren en locatievoorzieningen worden mogelijk
extra kosten in rekening gebracht. Kies een data-abonnement dat aan
uw wensen voldoet om extra kosten te vermijden. Neem voor meer
informatie contact op met uw serviceprovider.

Deze gebruikershandleiding is voor elk land in de belangrijkste talen
geschreven. Een deel van de inhoud kan afhankelijk van de gebruikte
taal verschillen.

Aandachtspunten in dit document

WAARSCHUWING: situaties die kunnen leiden tot letsel bij de gebruiker
en derden.

A OPGELET: situaties die kunnen leiden tot gering letsel of geringe schade
aan het toestel.

E OPMERKING: kennisgevingen of aanvullende informatie.
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Richtlijnen voor veilig en efficiént
gebruik

Lees deze eenvoudige richtlijnen door. Deze richtlijnen moeten worden gevolgd.

Er is een hulpprogramma op uw toestel geinstalleerd dat eventuele fouten
registreert. Dit hulpprogramma registreert alleen specifieke gegevens met
betrekking tot de fout, zoals signaalsterkte, de Cell ID Position bij het onverwacht
wegvallen van een telefoongesprek en geactiveerde apps. Het logboek kan als
referentie worden gebruikt bij het bepalen van de oorzaak van een fout. De
logbestanden zijn geéncrypt. Alleen medewerkers van LG Repair Centres hebben
toegang tot deze bestanden. Zjj zullen deze bestanden raadplegen als u uw toestel
ter reparatie opstuurt.

Blootstelling aan radiogolven
Informatie over blootstelling aan radiogolven en SAR (Specific Absorption Rate).

Dit apparaat is ontwikkeld met het oog op naleving van de geldende
veiligheidsvoorschriften voor blootstelling aan radiogolven. Deze voorschriften
worden gebaseerd op wetenschappelijke richtlijnen waarin veiligheidsmarges zijn
ingebouwd om de veiligheid van alle personen te kunnen waarborgen, ongeacht de
leeftijd of gezondheidstoestand.

« De richtlijnen voor blootstelling aan radiogolven hanteren de maateenheid SAR
(Specific Absorption Rate). Bij tests voor SAR worden de standaardmethoden
gebruikt, waarbij het apparaat in alle gemeten frequentiebanden het hoogst
toegestane energieniveau gebruikt.

+ Hoewel de verschillende apparaatmodellen van LG kunnen opereren op
onderling verschillende SAR-niveaus, zijn ze allemaal zodanig ontwikkeld dat
naleving van de geldende richtlijnen wordt gewaarborgd.

- De SAR-limiet die wordt aanbevolen door de ICNIRP (International Commission
on Non-lonizing Radiation Protection) bedraagt 2 \W/kg evenredig verdeeld over
tien gram lichaamsweefsel.

+ De hoogst geteste SAR-waarde voor dit model voor gebruik op het oor is 0,551
W/kg (10 g) en voor gebruik op het lichaam 1,531 W/kg (10 g).



« Dit apparaat voldoet aan de richtlijnen voor blootstelling aan RF-signalen
wanneer het op normale wijze tegen het oor wordt gehouden of wanneer het
zich op een afstand van minimaal 5 mm van het lichaam bevindt. \Wanneer
het apparaat in een draagtasje, riemclip of houder op het lichaam wordt
gedragen, mogen deze hulpmiddelen geen metaal bevatten en moet het
product zich op een afstand van minimaal 5 mm van het lichaam bevinden. Voor
het overbrengen van databestanden of berichten moet dit apparaat kunnen
beschikken over een goede verbinding met het netwerk. In sommige gevallen
kan het overbrengen van databestanden of berichten vertraging oplopen
tot een dergelijke verbinding beschikbaar is. Houd u aan de bovenstaande
afstandsrichtlijnen tot de gegevensoverdracht is voltooid.

Informatie van de FCC over de blootstelling aan

RF-signalen

In augustus 1996 heeft de Amerikaanse Federal Communications
Commission (FCC) met haar actie in Report and Order FCC 96-326

een bijgewerkte veiligheidsstandaard aangenomen voor menselijke
blootstelling aan radiofrequente (RF) elektromagnetische energie die
wordt uitgestraald door FCC-gestuurde zenders. Deze richtlijinen komen
overeen met de veiligheidsstandaard die eerder is vastgesteld door zowel
internationale als Amerikaanse standaarden. Het ontwerp van dit toestel
voldoet aan de FCC-richtlijnen en de internationale standaarden.

Deel 15.19 verklaring

Dit toestel voldoet aan deel 15 van de FCC-regelgeving. Het gebruik is afhankelijk
van de volgende twee voorwaarden:

(1) Dit toestel mag geen schadelijke interferentie veroorzaken, en

(2) Dit toestel moet ontvangen interferentie accepteren, inclusief interferentie die
leidt tot ongewenst gebruik.

Deel 15.21 verklaring

Door wijzigingen of modificaties die niet expliciet door de fabrikant zijn
goedgekeurd, kan de gebruiker zijn bevoegdheid verliezen om de apparatuur te
gebruiken.
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Toestel op het lichaam dragen

Dit toestel is getest voor veelvoorkomende handelingen waarbij de afstand tussen
de achterzijde van het toestel en het lichaam van de gebruiker 1 cm is. Om aan de
FCC RF-vereisten voor blootstelling te voldoen, moet de afstand tussen het lichaam
van de gebruiker en de achterzijde van het toestel 1 cm zijn.

Riemklemmen, houders en soortgelijke accessoires die metalen onderdelen
bevatten mogen niet worden gebruikt. Op het lichaam gedragen accessoires waarbij
geen afstand van 1 cm tussen het lichaam van de gebruiker en de achterkant van
het toestel kan worden aangehouden, en die niet zijn getest op veelvoorkomende
handelingen, voldoen mogelijk niet aan de FCC-richtlijnen met betrekking tot
blootstelling aan radiofrequente straling, en moeten worden vermeden.

Deel 15.105 verklaring

Dit toestel is getest en voldoet aan de limieten voor een digitaal toestel (klasse

B), volgens deel 15 van de FCC-regelgeving. Deze limieten zijn opgesteld om
redelijke bescherming te bieden tegen schadelijke storing wanneer het toestel

in woongebieden wordt gebruikt. Deze apparatuur genereert, gebruikt en
verzendt mogelijk radiogolven en indien de apparatuur niet in overeenstemming
met de instructies wordt geinstalleerd en gebruikt kan dit schadelijke storing in
radiocommunicaties veroorzaken. Er is echter geen garantie dat er in een specifieke
installatie geen storing zal optreden. Als deze apparatuur schadelijke storing in
radio- of televisieontvangst veroorzaakt, hetgeen kan worden vastgesteld door de
apparatuur uit en in te schakelen, wordt de gebruiker aangeraden te proberen de
storing te verhelpen door een of meer van de onderstaande maatregelen:

+ Richt de ontvangstantenne opnieuw of verplaats hem.
+ Vergroot de afstand tussen de apparatuur en de ontvanger.

+ Sluit de apparatuur aan op een andere contactdoosgroep dan die waarop de
ontvanger is aangesloten.

+ Raadpleeg de verkoper of een ervaren radio- of tv-monteur.
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Onderhoud van het product

+ Gebruik uitsluitend de door LG goedgekeurde meegeleverde accessoires. LG
geeft geen garantie bij schade of defecten veroorzaakt door accessoires van
derden.

+ Bepaalde inhoud en afbeeldingen kunnen zonder voorafgaande kennisgeving
afwijken van uw toestel.

- Demonteer het toestel niet. Laat eventuele noodzakelijke reparaties uitvoeren
door een gekwalificeerd onderhoudstechnicus.

+ Reparaties die na beoordeling van LG onder de garantie vallen, omvatten
mogelijk vervangende onderdelen of kaarten die ofwel nieuw ofwel gereviseerd
zijn, op voorwaarde dat deze onderdelen of kaarten een gelijkwaardige werking
hebben als de onderdelen die worden vervangen.

+ Houd het toestel uit de buurt van elektrische apparaten zoals tv's, radio’s en pc’s.

+ Houd het toestel uit de buurt van warmtebronnen zoals radiatoren en
kookplaten.

+ Laat het toestel niet vallen.
+ Stel het toestel niet bloot aan mechanische trillingen of schokken.

+ Schakel het toestel uit wanneer dit door de speciale voorschriften wordt vereist.
Gebruik het toestel bijvoorbeeld niet in ziekenhuizen, aangezien het gevoelige
medische apparatuur kan storen.

+ Houd het toestel niet met natte handen vast tijdens het opladen. Hierdoor zou
u een elektrische schok kunnen krijgen en het toestel zou ernstig beschadigd
kunnen raken.

+ Laad het toestel niet op in de buurt van brandbare materialen. De telefoon kan
heet worden, waardoor brand kan ontstaan.

+ Gebruik een droge doek om het toestel aan de buitenzijde te reinigen (gebruik
geen oplosmiddelen zoals benzeen, verdunners of alcohol).

+ Laad het toestel niet op wanneer dit zich op zachte stoffering bevindt.
+ Laad het toestel op in een ruimte die goed geventileerd is.
- Stel het toestel niet bloot aan extreme omstandigheden met rook en stof.

- Bewaar het toestel niet in de buurt van creditcards, vervoerstickets en
dergelijke, omdat het de informatie op de magnetische strip kan beinvloeden.

+ Tik niet op het scherm met een scherp voorwerp, om beschadiging van het
toestel te voorkomen.

+ Stel het toestel niet bloot aan vloeistoffen of vocht.
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+ Ga behoedzaam om met de accessoires, zoals oordopjes. Raak de antenne niet
onnodig aan.

- Gebruik nooit gebroken, gesplinterd of gebarsten glas, raak het niet aan en
probeer het niet te verwijderen of te repareren. Schade aan het glazen materiaal
ten gevolge van verwaarlozing of verkeerd gebruik wordt niet door de garantie
gedekt.

+ Uw toestel is een elektronisch apparaat dat tijdens normaal gebruik warm
wordt. Langdurig direct contact met de huid zonder voldoende ventilatie leidt
mogelijk tot ongemak of kleine brandwonden. \Wees daarom voorzichtig tijdens
en vlak na het gebruik van uw toestel.

+ Als uw toestel nat is geworden, koppelt u dit dan onmiddellijk los en laat u het
volledig opdrogen. Probeer het apparaat niet sneller op te drogen met behulp
van een externe hittebron, zoals een oven, magnetron of féhn.

- Door het vocht in uw natte toestel verandert de kleur van het productlabel
binnen in uw toestel. Schade aan het toestel ten gevolge van blootstelling aan
vloeistof wordt niet door de garantie gedekt.

+ Een mobiel apparaat heeft een goede luchtcirculatie nodig om warmte te
vernietigen. Het apparaat kan te warm zijn als gevolg van direct huidcontact en
onvoldoende circulatie van de luchtstroom op het apparaat. Het apparaat moet
zich ten minste 1,0 cm tussen het lichaam van de gebruiker bevinden.

+ Voorkom dat stof van vreemde stoffen in de kabel van de oplader / USB-kabel
terechtkomt. Het kan hitte of vuur veroorzaken.

- Vermijd om het toestel bloot te stellen aan lage luchtdruk in hoge gebieden.

« Stel het toestel niet bloot aan extreem lage luchtdruk. Anders kan het een
ontploffing van de batterij veroorzaken of het lekken van ontvlambare vloeistof
of gas.
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Efficiénte bediening van het apparaat

Elektronische apparaten
Alle apparaten kunnen storingen opvangen die de werking kunnen beinvloeden.

+ Gebruik het apparaat niet in de buurt van medische apparatuur zonder dat u
eerst om toestemming hebt gevraagd. Ga bij uw arts na of uw toestel storing
van uw medische apparatuur kan veroorzaken.

+ Fabrikanten van pacemakers raden een minimale afstand van 15 cm aan tussen
andere apparaten en een pacemaker om mogelijke storing van de pacemaker te
voorkomen.

- Dit apparaat kan een fel of knipperend licht produceren.
+ Sommige hoortoestellen zijn gevoelig voor storing door apparaten.
+ Een geringe storing kan al van invloed zijn op TV's, radio’s, PC's enz.

+ Gebruik uw apparaat bij temperaturen tussen 0 °C en 35 °C, indien mogelijk.
Het blootstellen van het apparaat aan extreem lage of hoge temperaturen kan
leiden tot schade, storingen of zelfs explosies.
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Veiligheid onderweg

Stel uzelf op de hoogte van de wetten en voorschriften voor het gebruik van
apparaten in de gebieden waar u rijdt.

+ Gebruik het toestel niet tijdens het rijden.
+ Concentreer u op het rijden.

+ Verlaat de weg en parkeer de auto voordat u een oproep beantwoordt, als de
verkeerssituatie dat vereist.

+ RF-energie kan bepaalde elektronische systemen in de auto ontregelen, zoals
stereo-apparatuur en veiligheidsfuncties.

+ Als uw auto is voorzien van een airbag, mag u deze niet door geinstalleerde of
draagbare, draadloze apparatuur blokkeren. Als u dit wel doet, kan dit ertoe
leiden dat de airbag niet of niet goed functioneert met mogelijk ernstige
verwondingen tot gevolg.

+ Zet het volume niet te hoog als u buitenshuis naar muziek luistert, zodat u de
geluiden uit uw omgeving nog kunt horen. Dit is vooral belangrijk in het verkeer.

Voorkom gehoorbeschadiging

Vermijd lang muziek luisteren op hoge geluidsniveaus om mogelijke
gehoorschade te voorkomen.

Gehoorbeschadiging kan optreden als u te lang aan hard geluid wordt blootgesteld.
Daarom raden wij u aan de handset niet te dicht bij uw oren in of uit te schakelen.
Zet het muziek- en gespreksvolume niet te hoog.

+ Als u een hoofdtelefoon gebruikt, zet het volume dan laag als u personen die
vlakbij u staan niet kunt verstaan of als de persoon die naast u zit, kan horen
waar u naar luistert.

E + Hoge geluidsniveaus en overmatige druk van uw oordopjes en
hoofdtelefoon kunnen leiden tot gehoorverlies.
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Onderdelen van glas

Bepaalde onderdelen van uw toestel zijn van glas. Dit glas kan breken als u toestel
op een hard oppervlak laat vallen of als het een harde klap krijgt. Raak gebroken
glas niet aan en probeer het niet te verwijderen. Gebruik het toestel niet totdat het
glas door een erkende serviceprovider is vervangen.

Explosiewerkzaamheden

Gebruik het toestel niet in een omgeving waar met explosieve materialen
wordt gewerkt. Neem beperkende maatregelen in acht en houd u aan regels en
voorschriften.

Explosmgevaar
Gebruik uw toestel niet bij tankstations.
+ Gebruik het toestel niet in de buurt van brandstoffen en chemicalién.

+ Vervoer geen brandbare gassen, vloeistoffen en explosieven en sla deze ook
niet op in dezelfde ruimte van een voertuig waarin zich ook uw toestel of
accessoires bevinden.

In vliegtuigen
Draadloze apparaten kunnen storingen veroorzaken in vliegtuigen.
« Schakel uw toestel uit voordat u aan boord van een vliegtuig gaat.

+ Gebruik het toestel niet op het terrein van de luchthaven zonder toestemming
van de bemanning.

Kinderen

Bewaar het toestel op een veilige plek, buiten het bereik van kleine kinderen.
Het toestel bevat kleine onderdelen die, indien losgemaakt, verstikking kunnen
veroorzaken.

Noodoproepen

Noodoproepen zijn mogelijk niet via alle mobiele netwerken beschikbaar. U dient
daarom voor noodoproepen nooit volledig afhankelijk te zijn van uw toestel. Vraag
dit na bij uw plaatselijke serviceprovider.

Richtlijnen voor veilig en efficiént gebruik 13



Batterij en onderhoud

+ De batterij hoeft niet volledig ontladen te zijn voordat u deze weer kunt
opladen. In tegenstelling tot andere typen batterijen heeft de batterij geen
geheugen dat van invloed is op de prestaties.

+ Gebruik alleen batterijen en laders van LG. De laders van LG zijn zodanig
ontwikkeld dat deze de levensduur van de batterij optimaliseren.

- Demonteer de batterij niet en voorkom kortsluiting.
+ Houd de metalen contactpunten van de batterij schoon.

+ Vervang de batterij wanneer deze niet meer voldoende presteert. De batterij kan
honderden keren worden opgeladen, voordat deze moet worden vervangen.

+ Laad de batterij opnieuw op als deze gedurende langere tijd niet is gebruikt, om
de levensduur te verlengen.

« Stel de batterijlader niet bloot aan direct zonlicht en gebruik deze niet in
vochtige ruimten zoals een badkamer.

+ Bewaar het apparaat niet in erg warme of koude ruimten; dat kan ten koste
gaan van de prestaties van de batterij.

« Er bestaat explosiegevaar als de batterij wordt vervangen door een batterij van
een verkeerd type. Verwijder de gebruikte batterijen volgens de instructies.

+ Haal altijd de stekker van de oplader uit het stopcontact als de batterij van
het apparaat volledig is opgeladen, zodat u voorkomt dat de oplader onnodig
energie verbruikt.

+ De werkelijke levensduur van de batterij hangt af van de netwerkconfiguratie,
de productinstellingen, de gebruikspatronen en de omstandigheden waarin de
batterij wordt gebruikt.

+ Zorg dat er geen scherpe voorwerpen zoals tanden en nagels van huisdieren in
contact komen met de batterij. Dit kan brand veroorzaken.

+ Stroomverbruik (netwerk stand-by): 0,5 W

Persoonlijke gegevens beveiligen

+ Beveilig uw persoonlijke informatie om te voorkomen dat er data verloren gaan
of gevoelige informatie wordt misbruikt.

+ Maak een back-up van belangrijke data als u het toestel gebruikt. LG is niet
verantwoordelijk voor eventueel verlies van data.

+ Maak een back-up van alle data en reset het toestel voordat u het weggooit om
te voorkomen dat gevoelige informatie wordt misbruikt.
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+ Lees de machtigingen zorgvuldig door bij het downloaden van applicaties.

+ Wees voorzichtig met het gebruik van applicaties die toegang hebben tot
meerdere functies of uw persoonlijke informatie.

+ Controleer uw persoonlijke accounts regelmatig. Als u een teken van misbruik
van uw persoonlijke gegevens ziet, vraag uw serviceprovider dan om uw
accountgegevens te wissen of te wijzigen.

+ Als u uw toestel bent verloren of als het is gestolen, moet u het wachtwoord
van uw account wijzigen om uw persoonlijke informatie te beschermen.

+ Gebruik geen applicaties van onbekende bronnen.

A Notificatie voor vervanging batterij

De Li-ion-batterij is een gevaarlijke component die letsel kan
veroorzaken.

« Als een batterij wordt vervangen door iemand die daar niet voor is
gekwalificeerd, kan dit ernstige schade aan uw apparaat veroorzaken.

« Vervang niet zelf de batterij. De batterij kan beschadigd raken, wat
oververhitting en verwondingen tot gevolg kan hebben. De batterij moet
worden vervangen door een erkende professional. De batterij dient te
worden gerecycled of afzonderlijk van het huishoudelijk afval worden
ingeleverd.

« Inhet geval dat dit product een binnen het product opgenomen batterij
bevat, die niet gemakkelijk kan worden verwijderd door eindgebruikers,
raadt LG aan om de batterij alleen door gekwalificeerde professionals
te laten verwijderen, zijnde voor vervanging of voor recycling aan het
einde van de levensduur van dit product. Om schade aan het product
te voorkomen, en voor hun eigen veiligheid, moeten gebruikers niet
proberen om de batterij te verwijderen en moeten contact opnemen
met de LG-servicehulplijn of andere onafhankelijke serviceproviders voor
advies.

« Het verwijderen van de batterij betreft demontage van de
productbehuizing, verbreken van de verbinding van elektriciteitskabels/
contacten en het zorgvuldig uitnemen van de batterijcel met
gebruik van gespecialiseerd gereedschap. Als u de instructies voor
gekwalificeerde professionals nodig hebt betreffende het veilig
verwijderen van de batterij, gaat u naar
http7//wwwi.lge.com/global/sustainability/environment/take-back-recycling.
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Camerafuncties

Bediening TimeLapse

U kunt TimeLapse video's opnemen die geoptimaliseerd zijn voor de situatie.
Video's kunnen opgenomen worden met optimale snelheid en
gelijkmatige beweging door een variéteit aan opname-omgevingen te
analyseren. De timelapse snelheid kan automatisch aangepast worden
naargelang het opname-doelwit en omgeving. U kunt ook de timelapse
snelheid handmatig selecteren.

1 Tik op (&) en selecteer TimeLapse door over de camera modi te vegen.

Stel Camera in — «—— Instellen flitser

Selecteer beeldverhouding

Instellen steady cam

e———— Selecteer zoom

o——— Selecteer timelapse snelheid

1—_ .
Selecteer timelapse voor
camera modi

2 Tikop e om een video te maken.
+ U kunt een zoom en timelapse snelheid wijzigen tijdens het
opnemen met timelapse.
- Om het opnemen te pauzeren, tik op @. Om het opnemen te
hervatten, tik op (e.
« Tijdens het opnemen van een video kunt u twee vingers spreiden of
knijpen om in of uit te zoomen.

+ Tijdens het opnemen van een video, kunt u op het gewenste gebied
tikken om de helderheid aan te passen.
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3 Tikop = om de opname te stoppen.
- De opgenomen video zal opgeslagen worden in Galerij.

E + Audio wordt niet opgenomen tijdens het opnemen met TimeLapse.

3D AR Effect

Met de dieptecamera aan de achterzijde van het product kunt u een
realistisch 3D AR Effect gebruiken door gelaatstrekken meer in detail
te herkennen. Omdat uw gelaat nauwkeurig herkend wordt, kunt u een
sticker maken zonder dat uw handen verschijnen zelfs indien uw gelaat
gedeeltelijk bedekt is door uw handen.

1 Tik op (&) en selecteer Sticker door over de camera modi te vegen.
2 Selecteer @

3 Veeg over de lijst met stickers naar links of rechts om de te gebruiken
AR-sticker te selecteren.

- Het gelaat gedetecteerd door de camera wordt in 3D gescand.
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/' Tik op () om een foto te maken, of houd () ingedrukt om een video
op te nemen.

- De foto of video is gemaakt met het 3D AR Effect toegepast.

E + De 3D scanfunctie van de Dieptecamera is enkel beschikbaar om close-
up portretten te maken.

3D Foto Effect

Met 3D Foto Effect kunt u 3D Foto's maken die een groter gevoel van
diepte geven aan portretten door de Dieptecamera aan de achterzijde van
het product te gebruiken. Foto's gemaakt met 3D Foto Effect kunnen
bekeken worden als bewegende afbeeldingen in de app Galerij.

1 Tik op (&) en selecteer Portret door over de camera modi te vegen.

7 Selecteer 3D Foto Effect door over de effect modi voor Portret te
vegen.

— Selecteer 3D Foto Effect
voor effectmodi

L Selecteer Portret voor
camera modi
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3 Tik op () om een foto te maken.
+ De foto zal opgeslagen worden in Galerij.

. Verschijnt op de afbeelding gemaakt met 3D Foto Effect.

4 Selecteer een 3D foto uit Galerij of Voorbeeld en tik op (2:) om een
foto effect toe te passen.
- Selecteer Een kopie opslaan of OK na toepassing van het effect.

E « Deze functie is enkel beschikbaar als u een foto maakt met de
achtercamera.
« Als u de boodschap ziet “3D Foto Effect beschikbaar’, tik op ( ) om
een foto te maken. Anders zal het 3D Foto Effect niet toegepast
worden op de opgeslagen foto.
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Functies voor audio-opname

Video's maken met gespecialiseerde opties voor

audio-opnames

U kunt een video maken met drie verschillende opties voor spraakopname
om te voldoen aan uw doelstelllingen.

1 Tik op (&) en selecteer Video door te vegen over camera modi.

2 Tik op @ en selecteer Basis, ASMR Opnemen, of Bokeh spraak door
te vegen over de audio-opties.

«————— Audio-opties

Basis
U kunt een video maken met stabiel stereo-geluid.

ASMR opname

Met twee gevoelige microfoons in het toestel, kunt u een ASMR video
maken.

Speciaal ontworpen functies 21



Bokeh spraak

U kunt de spraak van een voorwerp benadrukken door het
omgevingsgeluid te verlagen.

+ Om het omgevingsgeluid te verlagen, sleep de schuifbalk naar o).

-

ASMR geluiden opnemen

Met deze functie kunt u de audio zuiver en precies opnemen door het
geluid uit de microfoons te versterken.

1 Tik op Hoofdzaken > HD-audiorecoder en tik op => ASMR.

2 Tik op @ om de audio op te nemen.

- Om het opnemen te pauzeren, tik op @). Om het opnemen te
hervatten, tik op @.

3 Tik op @ om de audio-opname te beéindigen.

LG 3D Sound Engine

Met de functie LG 3D Sound Engine kunt u stereoscopisch en

geoptimaliseerd geluid horen. Als u de muziek of de video afspeelt, kunt
uvan het stereoscopisch en onderdompelend geluid genieten alsof u ter

plaatse was.

7 Sleep het notificatiescherm neerwaarts.

2 Tik op (%) om de functie LG 3D Sound Engine aan of uit te schakelen.
Of tik op Instellingen > Geluid > Geluidskwaliteit en effecten > LG

3D Sound Engine en tik op () ) om het te activeren.

5 + Indien u een extern audio-apparaat zoals een oordopjes of een speaker
koppelt aan het product, verschijnt er een pop-up om de functie LG 3D

Sound Engine aan te zetten.
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Google Assistent

Overzicht van de Google Assistent.

Uw apparaat heeft de ingebouwde Google Assistent-functie. Vind
antwoorden en doe dingen die u doet terwijl u aan het werk bent.

E « Als u deze functie wilt gebruiken, maakt u eerst verbinding met het netwerk.

Lancering van Google Assistent

T Druk op de Google Assistent-toets aan de linkerkant van het toestel
of veeg diagonaal vanaf één van de benedenhoeken van het scherm.

2 Tik op AAN DE SLAG.

3 Volg de instructies op het scherm.
+ Het apparaat slaat uw spraakgegevens op voor herkenning.

4 Stelin of u de ontgrendelfunctie voor spraakovereenkomst wilt gebruiken.
« Indien u de ontgrendelfunctie spraakovereenkomst gebruikt, kunt
u het toestel ontgrendelen zelfs als het scherm van het toestel
uitgeschakeld is of het toestel aan het opladen is door te zeggen
"OK Google” of “Hey Google”.

E « Deze functie is mogelijk meer kwetsbaar voor beveiliging dan de andere
schermvergrendelingen, zoals Patroon, PIN en Wachtwoord.

\Wanneer een soortgelijke stem of uw opgenomen stem wordt gebruikt, kan het
scherm worden ontgrendeld.

+ Om deze functie te gebruiken, tik in het homescreen op Instellingen > Lock
screen & beveiliging > Veilige vergrendelingsinstellingen > Smart Lock,
en gebruik vervolgens de schermvergrendelingsmethode die u hebt ingesteld
om het apparaat te ontgrendelen. Tik op Voice Match, voer dan opnieuw de
huidige gebruikte ontgrendelingsmethode in. Houd er rekening mee dat Swipe
is uitgesloten.

+ U moet het apparaat ontgrendelen met de opgegeven methode als het
niet lukt om het apparaat te ontgrendelen met spraakherkenning. Zie Een
schermvergrendeling instellen voor details.
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5 Tik op Gereed.

Toegang via Spraak

T Als het homescreen uitgeschakeld is of vergrendeld, zeg "OK Google”
of “Hey Google”.

2 Als het scherm van Google Assistent verschijnt, zeg een commando of
stel een vraag.

Toegang vanuit het Homescreen

1 Druk op de Google Assistent-toets aan de linkerkant van het toestel
of veeg diagonaal vanaf één van de benedenhoeken van het scherm.

2 Spreek een commando of vraag uit wanneer je « -« onderaan het
scherm ziet.

E « In een omgeving waar de verbinding van Wi-Fi of mobiele data slecht
is, kan het zijn dat de functie Google Assistent beperkt is en dat de
nauwkeurigheid van de spraakherkenning verminderd is.

- Indien de spraak ambigu is, de microfoon bedekt, een mediaspeler
speelt of de omgeving is luidruchtig, dan kan de nauwkeurigheid van
de spraakherkenning verminderd zijn. Als u het product gebruikt via
spraakcommando’s, spreek met nauwkeurige uitspraak in een rustige
omgeving voor een betere nauwkeurigheid van de spraakherkenning.
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Vingerafdrukherkenning

Overzicht van vingerafdrukherkenning

Registreer eerst uw vingerafdruk op het toestel alvorens de functie voor
vingerafdrukherkenning te gebruiken.

U kunt de functie voor vingerafdrukherkenning gebruiken in de volgende
gevallen:

+ Voor het ontgrendelen van het scherm.
+ Voor het bekijken van de vergrendelde inhoud in de Galerij.

- Bevestig een aankoop door u aan te melden op een app of uzelf met
uw vingerafdruk te identificeren.

E « U kunt vingerafdrukken gebruiken voor gebruikersauthenticatie Er is
een mogelijkheid dat de vingerafdruksensor een verschillende maar
zeer gelijkaardige vingerafdruk herkennen als dezelfde geregistreerde
vingerafdruk. Voor een grotere veiligheid wordt er aanbevolen dat u
de methode patroon, PIN of wachtwoord gebruikt om het scherm te
ontgrendelen.

« Als het apparaat uw vingerafdruk niet kan detecteren of u de waarde
voor registratie bent vergeten, bezoekt u het dichtstbijzijnde LG
klantenservicecentrum met uw apparaat en ID-kaart.
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Voorzorgsmaatregelen voor de vingerafdruksensor

De nauwkeurigheid van de vingerafdrukherkenning kan om diverse
redenen afnemen. Voor een optimale herkenning controleert u het
volgende alvorens het toestel te gebruiken.

+ Onderaan in het midden van het scherm van het product is er een
ingebouwde sensor die vingerafdrukken herkent. \Wees voorzichtig
dat u de vingerafdruksensor niet beschadigt of krassen maakt met
metalen voorwerpen zoals muntstukken of sleutels.

Indien er zich vreemde substanties (zweet, lotion, water, vuil, vet, enz.)
op de vingerafdruksensor bevinden of op de vinger die op de sensor
moet geplaatst worden, kan het zijn dat de vingerafdrukherkenning
niet goed werkt. Veeeg de sensor en de vinger proper en verwijder alle
vocht alvorens de vinger op de sensor te plaatsen.

+ Indien het oppervlak van de vinger ruw is of met littekens door water,
kan het zijn dat de sensor de vingerafdruk niet kan herkennen. In zon
geval registreer een andere vingerafdruk.

Als u uw vinger plooit of alleen de top van uw vinger gebruikt, wordt
uw vingerafdruk mogelijk niet herkend. Zorg ervoor dat uw vinger het
volledige oppervlak van de vingerafdruksensor bedekt.

+ Scan bij elke registratie slechts één vinger. Als u meerdere vingers
scant, kan de registratie en herkenning van de vingerafdruk worden
beinvloed.

Het toestel genereert mogelijk statische elektriciteit als de lucht in de
omgeving droog is. Als de lucht in de omgeving droog is, kunt u beter
geen vingerafdrukken scannen, of u raakt védr het scannen van de
vingerafdrukken een metalen voorwerp zoals een munt of sleutel aan
zodat de statische elektriciteit wordt weggeleid.
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Vingerafdrukken registreren
U kunt uw vingerafdruk registreren en opslaan op het toestel om de
vingerafdrukherkenning te gebruiken.

T In het homescreen, tik op Instellingen > Lock screen & beveiliging >
Vingerafdrukken.

5 « Een vergrendelscherm moet worden ingesteld om deze functie te gebruiken

+ Als de schermvergrendeling niet actief is, configureer dan het
vergrendelscherm door de instructies op het scherm te volgen. Zie Een
schermvergrendeling instellen voor details.

2 Controleer de locatie van de vingerafdruksensor onderaan in het
midden van het scherm, en plaats lichtjes de vinger op de sensor.

5 « Zorg ervoor dat de vinger de vingerafdruksensor volledig bedekt.

3 Volg de instructies op het scherm.

- Tot de registratie van de vingerafdruk voltooid is, verplaats dezelfde
vinger rond op de sensor beetje bij beetje.

+ Plaats de vinger op de sensor. Als u een trilling voelt, verwijder de
vinger van de sensor.

A Wanneer de vingerafdruk is geregistreerd, tikt u op OK.

- Tik op Meer toevoegen om nog een vingerafdruk te registreren.
Daar het succes van de vingerafdrukherkenning afhangt van de
conditie van de geregistreerde vingerafdruk, wordt er aanbevolen
dat u meerdere verschillende vingerafdrukken registreert.
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Vingerafdrukken beheren
U kunt geregistreerde vingerafdrukken bewerken of verwijderen.

T Inhet homescreen, tik op Instellingen > Lock screen & beveiliging >
Vingerafdrukken.

2 Ontgrendel volgens de opgegeven vergrendelingsmethode.

3 Tikin de lijst met vingerafdrukken op een vingerafdruk om de naam
ervan te wijzigen. Als u deze wilt verwijderen, tikt u op i].

Het Pictogram Vingerafdruk weergeven als het
Scherm uit is

U kunt instellen hoe u de locatie van de vingerafdruksensor weergeeft op
het scherm als het scherm uit is

T In het homescreen, tik op Instellingen > Lock screen & beveiliging >
Vingerafdrukken.

2 Ontgrendel het scherm via de ingestelde methode.

3 Controleer of @  ingeschakeld is voor de optie Tik om het
pictogram te tonen als het scherm uit is Indien u de functie niet wilt
gebruiken, schakel de functie uit door @  te slepen.

Het effect instellen als u het pictogram
vingerafdrukken aanraakt

U kunt het effect wijzigen op het scherm dat verschijnt als u het
pictogram vingerafdrukken aanraakt.

1 Tik op Instellingen > Lock screen & beveiliging > Vingerafdrukken.
2 Ontgrendel volgens de opgegeven vergrendelingsmethode.

3 Tik op Pictogram effect en selecteer het gewenste effect.
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Het scherm ontgrendelen met een vingerafdruk

U kunt het scherm ontgrendelen of de vergrendelde inhoud bekijken met

behulp van uw vingerafdruk. Activeer de gewenste functie:

T In het homescreen, tik op Instellingen > Lock screen & beveiliging >
Vingerafdrukken.

2 Ontgrendel volgens de opgegeven vergrendelingsmethode.

3 Activeer op het scherm met de instellingen voor vingerafdrukken de
gewenste functie:
- Schermvergrendeling: Ontgrendel het scherm met een

vingerafdruk.

- Contentvergrendeling: ontgrendel inhoud met een vingerafdruk.
Zorg hiervoor dat de contentvergrendeling is ingesteld.

Functie voor multitasking

Scherm Recent Gebruik

Veeg de knop Home — omhoog en vasthouden om de historiek van
recent gebruik te bekijken.

Pop-upvenster

U kunt meerdere apps openen op het scherm en gemakkelijk op om het
even welk ogenblik van de ene app naar de andere gaan.

1 Veeg omhoog op — vanaf de onderkant van het scherm.

7 Tik op het app-pictogram links boven van het app-scherm en
selecteer Pop-upvenster.

+ Indien u op het app-pictogram tikt, verschijnen de App-info,
Meerdere vensters, Pop-upvenster en App vastzetten opties.
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3 De app verschijnt in de vorm van een pop-upvenster op het scherm.

L]

np np

E - Deze functie is mogelijk niet beschikbaar in sommige apps of schermen.

Het pop-upvenster gebruiken

« — :Minimaliseert het pop-upvenster. Het pop-upvenster wordt
geminimaliseerd in de app pictogram op het scherm en kan verplaatst
worden naar om het even waar u wenst.

- 1:Breidt de app uit naar het hele scherm.

+ X :Sluit de app.

- Om het pop-upvenster te verplaatsen: Versleep de bovenkant van
het pop-upvenster.

- Om de grootte van het pop-upvenster aan te passen: \ersleep de
linker-, rechter- of onderrand van het pop-upvenster.

5 + Ukunt tot 5 apps openen met de pop-upvensters

+ Om een app te selecteren uit de geopende apps, tik op één van de pop-
upvensters. Het geselecteerde pop-upvenster komt op de voorgrond.

+ Pop-upvensters kunnen niet verplaatst worden naar de zone van de statusbalk
of Navigatiebalk.
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De map met apps gebruiken voor pop-upvensters
Indien u tikt op — op het pop-upvenster, wordt het pop-upvenster
geminimaliseerd in het app-pictogram.

U kunt het app-pictogram naar om het even waar verplaatsen door het
te verslepen.

Indien twee of meer pop-upvensters geminimaliseerd worden, wordt de
map met apps aangemaakt om de app-pictogrammen te omvatten.

E + Het recent gebruikte app-pictogram wordt gebruikt als het pictogram
van de map met apps. Indien u het pictogram tabt, verschijnen alle
pictogrammen voor de geminimaliseerde pop-upvensters in de map met
apps.

+ Indien u de map met apps voor pop-upvensters aanraakt en vasthoudt
en de map met apps versleept naar Verwijderen, zal de map met apps
verwijderd worden.

+ Om één van de apps uit de map met apps te verwijderen, open de map
met apps en sleep het app-pictogram uit de map met apps.

Meerdere vensters

Bij gebruik van gebarennavigatie

1 Veeg omhoog op — vanaf de onderkant van het scherm.
- Recent gebruikte apps verschijnen.
- Indien u op het app-pictogram tikt, verschijnen de App-info,
Meerdere vensters, Pop-upvenster en App vastzetten opties.

2 Tik op het app-pictogram links boven van de app die moet
weergegeven worden in Meerdere vensters en selecteer Meerdere
vensters.

+ De geselecteerde app verschijnt aan de bovenste helft van het
scherm.

3 Tik op de andere app die moet weergegeven worden in Meerdere
vensters.

+ De geselecteerde app verschijnt in de onderste helft van het
scherm.
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Indien u de navigatie Alleen knoppen gebruikt

1 Tik op (] op de Navigatiebalk.
- Recent gebruikte apps verschijnen.
- Indien u op het app-pictogram tikt, verschijnen de App-info,
Meerdere vensters, Pop-upvenster en App vastzetten opties.
7 Tik op het app-pictogram links boven van de app die moet
weergegeven worden in Meerdere vensters en selecteer =.

+ De geselecteerde app verschijnt aan de bovenste helft van het
scherm.

3 Tik op de andere app die moet weergegeven worden in Meerdere
vensters.

E + Om de grootte van het gesplitste scherm aan te passen, sleep de balk
naar het midden van het scherm.

+ Om de functie Meerdere vensters te deactiveren, sleep de middenbalk
omhoog of omlaag naar het uiteinde van het scherm.

+ De Meerdere vensters functie wordt niet ondersteund in sommige LG
apps of apps gedownload uit de Play Store.
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AOD (always-on display)

U kunt de datum, tijd of handtekening zien wanneer het hoofdscherm is
uitgeschakeld.

Veeg de onderkant van het AOD (always-on display) scherm om functies

te activeren, waaronder Camera, Capture+, Wi-Fi, geluidsinstellingen,
Bluetooth®, Flits, Muziek en meer.

T In het homescreen, tik op Instellingen > \Weergave > AOD(always-on
display).
7 Selecteer de afbeelding die u wilt weergeven en tik op OPSLAAN.
- Tik op de gewenste afbeelding onder Digitale klok, Analoge klok,
Dubbele klok, Handtekening of Afbeelding.
+ Tik op Toon display en selecteer Tik om het 10 seconden te
tonen of Altijd weergeven.

+ Tik op Quick Tools en muziekspeler om over de
statuspictogrammen te vegen voor Snelle hulpmiddelen en de
muziekspeler.

- Om de helderheid van de AOD (always-on display)-functie te
verbeteren, tikt u op Helderder Display.
+ Om de helpfunctie voor Always-on display te bekijken, tik op Help.

E « De batterij loopt mogelijk sneller leeg wanneer u AOD (always-on
display) gebruikt. Schakel deze functie uit om batterijstroom te
besparen.

+ Om de functie Always-on display te deactiveren, tikt u in het
homescreen op Instellingen > Weergave > AOD(always-on display),
en tik dan op @ .
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Opmerkingen over waterbestendige
eigenschappen

Dit product is water- en stofbestendig in overeenstemming met de
Ingress Protection rating IP68.

Uw product is getest in een gecontroleerde omgeving en is in bepaalde
omstandigheden water- en stofresistent (voldoet aan de vereisten

van classificatie IP68, die zijn beschreven door de internationale

norm IEC 60529 - Mate van bescherming door behuizing [IP-code];
testomstandigheden: 15-35 °C, 86-106 kPa, 1,5 meter, 30 minuten).
Stel het toestel niet bloot aan andere omstandigheden dan de
testomstandigheden. De resultaten kunnen afwijken van het werkelijke
gebruik.

/\ WAARSCHUWING

Ondanks een rating van IP68 is uw toestel niet ongevoelig voor
omstandigheden waarop niet in de gecontroleerde omgeving van LG is
getest. Houd er rekening mee dat schade die optreedt als gevolg van
dergelijke oorzaken ervoor zorgt dat de kleur van de LDI (Liquid Damage
Indicator) verandert. Als de kleur van LDl in het product verandert, komt
dat product niet in aanmerking voor de gratis reparatieservice die onder
de beperkte garantie van het product valt.

Stel het product niet bloot aan omgevingen met extreem veel stof of
vocht. Gebruik het product niet in de volgende omgevingen.

Dompel het product niet onder in chemische vloeistoffen (zeep,
enz. ), maar alleen in water.

@ Dompel het product niet onder in zout water, zoals zeewater.
@ Dompel het product niet onder in een warmwaterbron.

@ Ga niet met dit product zwemmen.
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ﬁ@ Plaats het product niet direct op zand (zoals op een strand) of in
modder.

Dompel uw product niet onder in water dat dieper is dan ongeveer
1,5 meter.
Dompel uw product niet langer dan 30 minuten onder in water.

+ Als uw product nat wordt, dient u de microfoon, luidspreker en
stereoaansluiting schoon en droog te vegen met een droge doek
voordat u deze weer gaat gebruiken.

+ Als uw product of uw handen nat geworden zijn, droog ze dan af
voordat u het product gaat gebruiken.

- Gebruik dit product niet op plaatsen waar het kan worden besproeid
met water onder hoge druk (bijv. in de buurt van een kraan of
douchekop) of dompel het niet gedurende langere tijd onder in water,
als het product niet is ontworpen voor hoge waterdruk.

- Dit product is niet bestand tegen schokken. Laat het product niet vallen
en stel het niet bloot aan schokken. Dit kan beschadiging of vervorming
van de hoofdeenheid veroorzaken, waardoor het kan gaan lekken.

- De water- en stofresistente functies van het product kunnen
beschadigd raken als het valt of een klap/stoot krijgt.

« Als het product nat is geworden, gebruik dan een schone, zachte doek
om het grondig droog te wrijven.

+ Het aanraakscherm touchscreen en andere functies werken mogelijk
niet correct als het toestel wordt gebruikt als het nat is.

+ Uw product is alleen waterbestendig, wanneer de SIM-/
Geheugenkaartlade goed in het product is geplaatst.

+ Open of sluit de SIM-/Geheugenkaartlade niet als het product nat of
ondergedompeld in water is. Als de geopende lade aan water of vocht
wordt blootgesteld, kan het product beschadigd raken.

+ De SIM-/Geheugenkaartlade bevat een rubberen [afdichting] om
te voorkomen dat er stof, water of vocht het product binnendringt.
Beschadig de rubberen [afdichting] niet omdat hierdoor stof, water of
vocht het product kan binnendringen en schade veroorzaken.
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A « Als u deze instructies niet opvolgt, kan de beperkte garantie van uw
toestel ongeldig worden.

Als het apparaat nat is, verandert de LDl in het apparaat van kleur.

In dit geval komt het apparaat niet in aanmerking voor gratis
reparatiediensten die worden verstrekt onder de beperkte garantie van
het apparaat.

«+ Ondanks de classificatie van IP 68, is uw apparaat in geen enkele
situatie volledig ondoordringbaar voor water.
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Productonderdelen en accessoires

De volgende items worden bij uw toestel meegeleverd.

- Toestel - Lader
+ USB-kabel + Snelstartgids
- Verwijderpin

A .

« Afhankelijk van de regio en de serviceprovider kunnen de bij het toestel

Basisfuncties

De hierboven beschreven items zijn mogelijk optioneel.

meegeleverde onderdelen en de verkrijgbare accessoires verschillen.

- Gebruik altijd originele LG Electronics-accessoires. Het gebruik van

accessoires van andere fabrikanten is mogelijk van invloed op de
prestaties van uw toestel en kan storingen veroorzaken. Dit wordt
mogelijk niet gedekt door de reparatieservice van LG.

- Sommige onderdelen zijn gemaakt van gehard glas. Als u uw toestel

op een hard oppervlak laat vallen of het blootstelt aan zware schokken,
kan het geharde glas beschadigd raken. Als dit gebeurt, stop dan
onmiddellijk met het gebruiken van uw toestel en neem contact op met
de klantenservice van LG.

« Als een van deze basisonderdelen ontbreekt, neemt u contact op met

de dealer die u het toestel heeft verkocht.

« Om aanvullende items aan te schaffen, neem contact op met een LG

klantenservicecentrum.

« Bepaalde onderdelen in de verpakking kunnen zonder voorafgaande

kennisgeving wijzigen.

« Het uiterlijk en de specificaties van het toestel kunnen zonder

voorafgaande kennisgeving wijzigen voor verbetering van het product.

« Afhankelijk van de regio of de serviceprovider kunnen de specificaties

van het toestel verschillen.

« Verwijder de beschermfolie van the Fingerprint-sensor voordat u de

functie vingerafdrukherkenning gebruikt.
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Overzicht van onderdelen

Speaker —

Lens van camera aan
voorkant

Volumeknoppen (+/-) —I:

Google Assistent-toets —a!

Aansluiting voor stereo
headset

Microfoon ———

©)
Cameralensen achterzijde —i—©)

Flitser ——

Luidspreker

Basisfuncties

D)
|

————

() 1

o
— ) S— Nabijheids-

/Omgevingslichtsensor

o————— Touchscreen

— Vingerafdruksensor

—

Lader/USB-kabelpoort

— NFC

— Antennegebied voor
draadloos opladen

Microfoon

*— Aan-uit/Vergrendelen-toets

s——— Houder voor nanosimkaart
==y
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A Probeer de klep aan de achterzijde NIET zelf te verwijderen.

« Door dit te doen kunt u de batterij en het toestel ernstig beschadigen
en kan leiden tot oververhitting, brand en letsels. De achterklep en
batterij van dit apparaat mogen alleen worden verwijderd of vervangen
door erkende professionals.

+ De telefoon is een elektronisch toestel dat tijdens normaal gebruik
warmte genereert. Langdurig direct contact met de huid zonder
voldoende ventilatie leidt mogelijk tot ongemak of kleine brandwonden.
Wees daarom voorzichtig tijdens en vlak na het gebruik van uw
telefoon.

+ Volumeknoppen

- Pas het volume voor beltonen, oproepen of notificaties aan.

- Druk voorzichtig op een volumetoets om een foto te maken
wanneer u de camera gebruikt. Houd de volumetoets ingedrukt om
meerdere foto's achtereen te maken.

- Druk tweemaal op de toets Volume omlaag om de app Camera te
starten wanneer het scherm is vergrendeld of uitgeschakeld. Druk
tweemaal op de toets Volume omhoog om Capture+ te starten.

+ Aan-uit/Vergrendelen-toets

- Druk kort op de knop als u het scherm wilt inschakelen of
uitschakelen.

- Houd de knop ingedrukt als u een optie voor de toestelstatus wilt
selecteren.

- Google Assistent-toets

- Ukunt één maal kort drukken om Google Assistent te starten. U
kunt het ingedrukt houden om Google Assistent te starten en dan
de vinger loslaten van de toets om de functie spraakcommando te
starten.

- Zie Google Assistent voor details.

- Vingerafdruksensor

- U kunt de vingerafdruksensor gebruiken onderaan in het midden
van het scherm om de functie vingerafdrukherkenning te gebruiken.
Zie Overzicht van vingerafdrukherkenning voor details.
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E + Sommige functies kunnen beperkt zijn afhankelijk van de regio en de
productspecificaties van verschillende telecomproviders.

+ Er zijn NFC chip en draadloze oplaadantennes ingebouwd in het
achterste gedeelte van het product. Zorg ervoor dat u de NFC chip
draadloze oplaadantennes niet beschadigt of bedekt.

« Plaats geen zware voorwerpen op het toestel en ga er niet op zitten. Als
u dit toch doet, kan het touchscreen beschadigd raken.

+ Een beschermingsfolie voor het scherm of accessoires kunnen de
werking van de nabijheidssensor hinderen.

+ Als het toestel nat is of in een vochtige omgeving wordt gebruikt,
werken het touchscreen of toetsen mogelijk niet naar behoren.

Er zijn twee microfoons ingebouwd in het product. Zorg ervoor dat u de
microfoons niet bedekt. Terwijl u praat aan de telefoon, dek de microfoon
niet af met uw hand of vingers.

Gebruik geen telefoonhoes die geen authentiek product is of de
microfoon bedekt met toebehoren, tape, enz.

Houd het product correct zoals afgebeeld in de afbeelding als u het
gebruikt.

Microfoon Dek de microfoon niet af.
l .
s \‘
—— —gﬁr{\’*;
— ,Q\‘
4%
Microfoon Dek de microfoon niet af:
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De stroom in- of uitschakelen

De stroom inschakelen

Als de telefoon is uitgeschakeld, houdt u de Aan-uit/Vergrendelen-toets
ingedrukt.

E « Wanneer het toestel voor het eerst wordt ingeschakeld, vindt de initiéle
configuratie plaats. De eerste opstart van het toestel duurt mogelijk
langer dan gewoonlijk.

De stroom uitschakelen

Houd de Aan-uit/Vergrendelen-toets ingedrukt en selecteer dan
Uitschakelen.

Het apparaat opnieuw opstarten

Als het apparaat niet naar behoren werkt of niet reageert, start u het
opnieuw op volgens de instructies hieronder.

1 Druk op en houd de Aan/uit-/vergrendeltoets en de toets Volume
omlaag tegelijkertijd ingedrukt totdat het apparaat is uitgeschakeld.

7 Laat de knop los zodra het apparaat opnieuw is opgestart.

E - Deze functie is niet beschikbaar als het toestel gekoppeld is met het LG
Dual Screen (LM-G905N).

Opties voor toestelstatus

Houd de Aan-uit/Vergrendelen-toets ingedrukt en selecteer een optie.
- Uitschakelen: Schakel het apparaat uit.

- Opnieuw opstarten: start het toestel opnieuw op.
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De simkaart installeren

Plaats de simkaart (Subscriber Identity Module) van uw serviceprovider in
uw toestel om het te beginnen te gebruiken.

A « Wees voorzichtig met de verwijderpin want die heeft een scherpe rand.

E « Om de water- en stofbestendige functies doeltreffend te laten werken,
moet de kaarthouder correct zijn geplaatst.

1 Voer de pin in de opening van de kaartlade en druk op de pin en trek
dan de kaartlade uit het product.

2 Plaats de nanosimkaart of geheugenkaart netjes op de kaartlade en
druk de kaart in de richting van de pijl zoals getoond in de afbeelding.

Simkaart
Geheugenkaart (optioneel-apart
verkrijgbaar)
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E - Dit toestel ondersteunt alleen nano simkaarten.

Nano Micro Standaard

Voor een probleemloze werking wordt u aanbevolen het toestel te
gebruiken met het juiste type simkaart. Gebruik altijd een simkaart die
door de provider is geleverd.

« Verlies uw simkaart niet. LG is niet verantwoordelijk voor schade of
andere problemen die u kunt ervaren als u de simkaart verliest of in een
andere toestel plaatst.

« Zorg ervoor dat u de simkaart niet beschadigt wanneer u deze plaatst
of verwijdert.

« Wanneer u een Simkaart of geheugenkaart plaatst, plaatst u het
correct op de kaarthouder.

« Wanneer u de kaarthouder terug in het apparaat invoegt, doe dit
horizontaal in de richting van de pijl zoals te zien op de afbeelding. Zorg
ervoor dat de kaart, zodra op de kaarthouder geplaatst, niet van positie
veranderd.

« Plaats de Simkaart met de goudkleurige contacten naar beneden.

« Zorg ervoor dat de Simkaart in het apparaat wordt ingevoegd volgens
de instructies in de gebruikershandleiding.

- Zorg ervoor dat er geen water of andere vloeistof in de kaarthouder
komt wanneer u de kaarthouder in het apparaat plaatst of uit het
apparaat verwijdert. Als een natte kaarthouder of kaart in het apparaat
wordt gevoegd, kan uw apparaat beschadigd raken.

« De geheugenkaart is een optioneel artikel.

- Frequent gegevens schrijven en wissen kan de levensduur van de
geheugenkaart verkorten.

- Sommige geheugenkaarten zijn mogelijk niet volledig compatibel met
het toestel. Als u een niet-compatibele kaart gebruikt, kan dit het
toestel of de geheugenkaart beschadigen of de gegevens die erop zijn
opgeslagen onbruikbaar maken.
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De geheugenkaart plaatsen

Plaats de geheugenkaart in uw toestel.

Het apparaat ondersteunt microSD-kaarten van maximaal 2 TB.
Afhankelijk van de fabrikant en het type van de geheugenkaart, zijn
enkele geheugenkaarten mogelijk niet compatibel met uw toestel.

1 Steek de verwijderpin in de opening van de kaarthouder.

7 Trek de kaarthouder uit het toestel.

3 Plaats de geheugenkaart in de kaarthouder met de goudkleurige
contacten naar beneden.

Geheugenkaart (optioneel-apart
verkrijgbaar)

L Simkaart )

A Steek de kaarthouder opnieuw in de sleuf.

A « Sommige geheugenkaarten zijn mogelijk niet volledig compatibel met
het toestel. Als u een niet-compatibele kaart gebruikt, kan dit het
toestel of de geheugenkaart beschadigen of de gegevens die erop zijn
opgeslagen onbruikbaar maken.

E - Frequent gegevens schrijven en wissen kan de levensduur van de
geheugenkaart verkorten.
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De geheugenkaart verwijderen

Verwijder voor de veiligheid de geheugenkaart voordat u hem fysiek
verwijdert.

T In het homescreen, tik op Instellingen > Opslag > /..

72 Maak geen gebruik van de externe terminal, oplaadkabel of een
tussenstuk voor het apparaat in nabijheid van vocht.

3 Verwijder de geheugenkaart van de kaarthouder.
A Steek de kaarthouder opnieuw in de sleuf.
A + Verwijder de geheugenkaart niet wanneer het toestel informatie
overzet of leest. Hierdoor kunnen de gegevens verloren of onbruikbaar
raken, of kan de geheugenkaart of het toestel beschadigd raken. LG is

niet verantwoordelijk voor verlies dat voortvloeit uit misbruik of fout
gebruik van geheugenkaarten, inclusief het verlies van gegevens.

Batterij

Batterij opladen
Laad de batterij volledig op alvorens het toestel te gebruiken.
Laad het toestel met de USB-kabel van type C op.

Aansluiting van oplaadkabel
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« Indien er vocht op de laadpoort, blootgestelde terminals, laadkabel,
laadadapter, enz. is, gebruik of laad dan het product niet. Het product
kan defect zijn of gebroken of beschadigd, en er is risico op letsels
veroorzaakt door een elektrische schok, brand, oververhitting, explosie,
enz. Indien u vocht vindt op zulke vlakken, stop onmiddellijk met het
gebruik of het laden van het product en verwijder volledig het vocht.

« Maak het batterijdeksel niet los.

Dit product gebruikt een niet-verwijderbare batterij. Verwijder of
vervang het batterijdeksel of de batterij niet. Indien u het batterijdeksel
of de batterij verwijdert of vervangt, kan het product beschadigd,
oververhit zijn of ontploffen.

« Enkel de USB-kabel en laadadapter gebruiken die geleverd zijn bij het
product als basisonderdelen.

- In uw toestel zit een oplaadbare batterij. Verwijder de ingesloten batterij
niet voor uw veiligheid.

« Door het toestel tijdens het opladen te gebruiken kunt u elektrische
schokken oplopen. Stop het opladen als u het toestel wilt gebruiken.

«+ Haal de stekker van de lader uit het stopcontact wanneer het toestel
volledig is opgeladen. Zo voorkomt u dat onnodig energie wordt
verbruikt.

- Een oplaadadapter die snel opladen ondersteunt, is met het product
meegeleverd. De functie snel laden werkt mogelijk niet als u een andere
adapter voor snel laden gebruikt dan de bij het product meegeleverde
adapter.

« U kunt de batterij ook opladen door het toestel met USB-kabel aan te
sluiten op een desktopcomputer of een draagbare computer. Dit duurt
mogelijk l[anger dan wanneer u de adapter op een stopcontact aansluit.
« Laad de batterij niet op met een USB-hub die niet de nominale spanning
kan leveren. Het opladen kan mislukken of onbedoeld stoppen.

« Als u het Service Center bezoekt met een batterijprobleem, breng het
product en de lader mee omdat de batterij een verbruiksgoed is, de
batterijduur kan korter worden naarmate de tijd verstrijkt.
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Voorzorgsmaatregelen bij het gebruik van het toestel
+ Gebruik de meegeleverde USB-kabel; gebruik geen USB-kabels of
laders van andere fabrikanten met uw toestel. De beperkte garantie
van de LG dekt het gebruik van accessoires van andere fabrikanten
niet.

- Het toestel kan beschadigd raken als de instructies in deze handleiding
niet worden opgevolgd of bij oneigenlijk gebruik.

Draadloos opladen

Dit apparaat ondersteunt draadloos opladen. Laad het apparaat op met
een Qi gecertificeerde oplader (optioneel, apart verkrijgbaar).

De batterij opladen met een draadloze oplader

1 Plaats uw apparaat in het midden van de draadloze oplader in lijn met
de draadloze oplaadantenne aan de achterzijde van het apparaat.

+ Om te controleren waar de draadloze oplaadantenne zit, zie
Overzicht van onderdelen.

7 Zodra de batterij volledig is opgelaten, verwijdert u het apparaat van
de lader.

A + Als u de batterij oplaadt met een draadloze oplader, plaats dan geen
magnetische, metalen of geleidende materialen tussen het apparaat
en de lader. Dit kan het opladen verstoren van het apparaat en de lader
kan oververhit raken. In dit geval kunnen het apparaat, de oplader of de
SIM-/geheugenkaarten beschadigd raken.
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« Als de batterijtemperatuur een bepaald niveau overstijgt terwijl het

apparaat wordt opgeladen, kan het opladen worden onderbroken.

« Als magnetische, metalen of geleidende materialen worden

vastgemaakt aan de achterkant van het apparaat of als een
beschermhoes is geplaatst, kan het apparaat mogelijk niet goed
opladen.

- Als u de batterij oplaadt met een draadloze lader in gebieden waar

het netwerksignaal zwak is, kan de netwerkprestatie van het apparaat
verder worden aangetast.

« Laad het apparaat op met een Qi gecertificeerde oplader (optioneel,

apart verkrijgbaar). Omdat de LG beperkte garantie niet het gebruik van
accessoires van derde partijen ondersteunt, moet u contact opnemen
met de derde fabrikant

- Dit product ondersteunt draadloos opladen. Gebruik een Qi-

gecertificeerde draadloze oplader (afzonderlijk verkrijgbaar) om het
product op te laden. Sommige spiraalvormige draadloze opladers
ondersteunen draadloos opladen mogelijk niet. Met draadloze opladers
die EPP (Extended Power Profile) ondersteunen, kunt u supersnel
draadloos opladen.

« LG Electronics is niet verantwoordelijk voor problemen betreffende

toebehoren van andere merken. Voor zulke problemen, contacteer de
fabrikant van het toebehoren.

Batterij efficiént gebruiken

Als u veel apps en functies tegelijk actief houdt en langdurig gebruikt,
wordt de levensduur van de batterij mogelijk korter.

Stop bewerkingen die op de achtergrond worden uitgevoerd om de
levensduur van de batterij te optimaliseren.

Volg deze tips om het batterijverbruik te minimaliseren:

Schakel de Bluetooth of Wi-Fi-netwerkfunctie uit wanneer ze niet
gebruikt worden.

+ Stel de time-outwaarde voor het scherm zo laag mogelijk in.

Minimaliseer de helderheid van het scherm.
Stel een lockscreen in wanneer het toestel niet wordt gebruikt.
Controleer het batterijniveau wanneer u gedownloade apps gebruikt.
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Touchscreen

U kunt zich vertrouwd maken met de bediening van het toestel door
middel van bewegingen op het touchscreen.

Tikken

Tik zacht met uw vingertop om een app of een optie te selecteren of te
starten.

Vinger op het scherm houden

Houd uw vinger meerdere seconden op het scherm om een menu met
beschikbare opties weer te geven.
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Dubbel tikken

Tik snel twee keer om in of uit te zoomen op een webpagina of een kaart.

Slepen

Houd uw vinger op een item, zoals een app of een widget, en verplaats
dan uw vinger naar een andere locatie in een gecontroleerde beweging. U
kunt deze beweging gebruiken om een item te verplaatsen.

Vegen

Raak met uw vinger het scherm aan en verplaats hem snel zonder
te pauzeren. U kunt deze beweging gebruiken om door een lijst, een
webpaging, foto's, schermen en meer te scrollen.
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Samenknijpen en uiteenduwen

Knijp twee vingers samen om uit te zoomen op een foto of een kaart.
Duw uw vingers uiteen om in te zoomen.

A - Stel het touchscreen niet bloot aan sterke schokken. Hierdoor
beschadigt u mogelijk de aanraaksensor.

E - Het touchscreen werkt mogelijk niet naar behoren als u het toestel in
de buurt van magnetisch, metalen of geleidend materiaal gebruikt.

« Als u het toestel onder een fel licht gebruikt, zoals rechtstreeks zonlicht,
is het scherm mogelijk niet zichtbaar, afhankelijk van uw locatie. Gebruik
het toestel in de schaduw of in een omgeving met een licht dat net
voldoende helder is om boeken te lezen.

- Druk niet te hard op het scherm.

- Tik zacht met uw vingertop op de gewenste optie.

« De aanraakbediening werkt mogelijk niet naar behoren als u op het
scherm tikt wanneer u een handschoen draagt of het puntje van uw
nagel gebruikt.

« De aanraakbediening werkt mogelijk niet naar behoren als het scherm
vochtig of nat is.

- Het touchscreen werkt mogelijk niet naar behoren als een
beschermingsfolie is aangebracht of een accessoire aan het toestel
is vastgemaakt dat u in een winkel van andere fabrikanten hebt gekocht.

- Het weergeven van een stilstaand beeld voor een langere tijd kan leiden
tot nabeelden of inbranden van het scherm. Schakel het scherm uit of
vermijd het weergeven van hetzelfde beeld voor een lange tijd als u het
apparaat niet gebruikt.
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Homescreen

Overzicht van homescreen

Het homescreen is het uitgangspunt voor toegang tot diverse functies en
apps op uw toestel. Schuif omhoog vanaf de onderrand van om het even
welk scherm om rechtstreeks naar het Homescreen te gaan.

U kunt alle apps en widgets op het homescreen beheren. Veeg het
scherm naar links of naar rechts om alle geinstalleerde apps in een
oogopslag te zien.

Lay-out van homescreen

Op het homescreen kunt u alle apps bekijken en widgets en mappen
organiseren.

Statusbalk —s

Widget voor het weer —

+— Google Zoeken widget

Map —-

+—————— Paginapictogram
»— Gedeelte voor snelle toegang

Navigatie balk S—

E « Het homescreen kan verschillen afhankelijk van het beleid van de
fabrikant, gebruikersinstellingen, softwareversie of serviceprovider.
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Statusbalk: bekijk statuspictogrammen, de tijd en het batterijniveau.
Widget voor het weer: Geef weer- en tijdinformatie weer voor een
bepaald gebied.

Google Zoeken widget: Typ of zeg om Google Zoeken te openen.
Map: U kunt mappen maken om de app te klasseren op basis van
gewenste criteria.

Paginapictogram: Geef het totale aantal beginschermen weer. U
kunt op het pictogram van de gewenste pagina tikken om naar

de geselecteerde pagina te gaan. Het pictogram dat het huidige
beginscherm weergeeft, wordt gemarkeerd.

Gedeelte voor snelle toegang: zet de belangrijkste apps vast onder in
het scherm zodat u ze makkelijk kunt openen vanaf elk homescreen.

- Navigatie balk: U kunt naar het vorige scherm of het homescreen

gaan terwijl u de app gebruikt en de lijst van apps controleren die u
recent gebruikt hebt.

De Navigatiebalk gebruiken
Hier is de gebarengids om de Navigatie balk te regelen.
- Om naar homescreen te gaan, veeg omhoog vanaf de onderkant van

het scherm.

+ Om terug te keren naar het vorige scherm, veeg naar binnen van

linker- of rechterrand van het scherm.

Om naar het scherm Overzicht te gaan, veeg omhoog en houd vast
vanaf onderrand van het scherm.

Om snel over te schakelen tussen apps, veeg naar rechts op de
onderste rand van het scherm om naar eerder gebruikte apps te gaan.

E + Gebaren is de standaard voor de Navigatie balk. Om het te wijzigen naar

enkel knoppen Q/O/D, tik dan in het homescreen, op Instellingen
> Weergave > Navigatie balk, selecteer dan enkel knoppen.
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Statuspictogrammen

\Wanneer er een notificatie voor een ongelezen bericht, een agenda-
activiteit of een alarm is, geeft de statusbalk het overeenkomstige
pictogram van de notificatie weer. Controleer de pictogrammen van
notificaties in de statusbalk om de status van uw toestel te controleren.

x

Geen signaal
56 Data worden overgedragen via het 5G netwerk
[c] Alarm ingesteld
i Trilmodus ingeschakeld

Bluetooth ingeschakeld

USB-verbinding met een computer

Batterijniveau

Flightmode ingeschakeld

Gemiste oproepen

Wi-Fiis verbonden

Geluid uitgeschakeld

GPS ingeschakeld

Hotspot ingeschakeld

Geen simkaart

De NFC-modus is ingeschakeld

« Afhankelijk van de status van het toestel kunnen sommige van deze
pictogrammen anders of helemaal niet worden weergegeven. Raadpleeg
de pictogrammen volgens de huidige omgeving en gebied waarin u het
toestel gebruikt en uw serviceprovider.

« Afhankelijk van de regio of de serviceprovider kunnen de weergegeven

pictogrammen verschillen.
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Notificatiescherm
U kunt het notificatiescherm openen door de statusbalk omlaag te slepen
op het hoofdscherm.

+ Ukunt het berichtenvenster naar beneden slepen of tikken op het
pijltjespictogram om de lijst van pictogrammen voor snelle instelling te
openen.

+ U kunt tikken op /2 om pictogrammen toe te voegen, te wissen of te
schikken in het berichtenvenster.

+ Als u uw vinger op het pictogram houdt, verschijnt het scherm met de
instellingen voor de desbetreffende functie.

<=

~ |

E « U kunt het notificatiepaneel zelfs op het lockscreen gebruiken. Sleep het
notificatiepaneel terwijl het scherm is vergrendeld voor snelle toegang
tot de gewenste functies.
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Schermstand wijzigen

U kunt de schermstand instellen om automatisch te wijzigen volgens de
daadwerkelijke positie van het toestel.

Tik in het notificatiescherm op Rotatie in de lijst met pictogrammen voor
snelle toegang.

U kunt ook tikken op Instellingen > Weergave en Automatisch roteren
scherm activeren op het Homescreen.

<aus

Homescreen bewerken
Houd uw vinger op een lege ruimte op het homescreen en selecteer
vervolgens de gewenste actie hieronder.

+ Als u de beginschermen opnieuw wilt ordenen, houdt u uw vinger op
een scherm en sleept u het naar een andere locatie.

+ Als u een widget aan het homescreen wilt toevoegen, houd dan
uw vinger op een leeg gedeelte op het homescreen en selecteer
vervolgens Widgets.

- Om wallpaper, thema's, pictogrammen en AOD te veranderen, houd
dan uw vinger op een leeg gedeelte op het homescreen en selecteer
vervolgens Achtergrond & Thema.

U kunt ook tikken op Instellingen > \Weergave > Homescreen >
Achtergrond op het Homescreen, selecteer vervolgens achtergronden,
themas, pictogrammen en AOD om op het apparaat toe te passen.
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+ Om het raster te wijzigen, houd uw vinger op een leeg gedeelte op
het homescreen en selecteer vervolgens Raster. Tik op het gewenste
raster, tik dan op Toepassen.

+ Als u de instellingen van het homescreen wilt configureren, houd
dan uw vinger op een leeg gedeelte op het homescreen en selecteer
vervolgens Homescreen-instellingen. Zie Homescreen-instellingen
voor details.

+ Als u de verwijderde apps wilt bekijken of opnieuw wilt installeren,
houd dan uw vinger op een leeg gedeelte op het Homescreen en
selecteer vervolgens App-prullenbak. Zie App-prullenbak voor details.

Als u het standaardscherm wilt wijzigen, houd dan uw vinger op een
leeg gedeelte op het startscherm, verplaats die naar het gewenste
scherm, tik op £} en tik vervolgens nogmaals op het scherm.

e———— Standaardscherm
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Wallpaperthema bekijken

U kunt de achtergrondafbeelding alleen bekijken door de apps en de
widgets op het homescreen te verbergen.

Duw twee vingers uiteen op het startscherm.

+ Als u wilt teruggaan naar het originele scherm met apps en widgets,

knijpt u uw vingers op het Homescreen samen of sleept u — vanaf de
onderrand van het scherm.

Apps op het homescreen verplaatsen

Houd uw vinger op een app op het homescreen en sleep deze naar een
andere plaats.

+ Om vaak gebruikte apps onder in het homescreen te houden, houdt u
uw vinger op een app en sleept u deze naar het gedeelte voor snelle
toegang onderaan.

- Om een pictogram uit het gedeelte voor snelle toegang te verwijderen,
sleept u het pictogram naar het homescreen.
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Mappen op het homescreen gebruiken

Mappen maken

Houd uw vinger op een app op het homescreen en sleep deze over een
andere app.

- Een nieuwe map wordt gemaakt en de apps worden aan de map
toegevoegd.

Mappen bewerken

Tik op een map op het homescreen en voer een van de volgende acties
uit.

+ Als u de naam van de map wilt bewerken, tikt u op de naam van de
map.
« Als u de kleur wilt bewerken, tik op de cirkel rechtsboven.

- Om apps toe te voegen, houd uw vinger op een app en sleep deze over
de map en laat los.

« Als u een app uit de map wilt verwijderen, houdt u uw vinger op de app
en sleept u deze uit de map. Als de verwijderde app de enige app in de
map is, wordt de map automatisch verwijderd.

- U kunt ook apps toevoegen of verwijderen nadat u getikt hebt op (¥).

E + U kunt de kleur van mappen niet aanpassen wanneer u een gedownload
thema gebruikt.
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Homescreen-instellingen
U kunt de homescreen-instellingen personaliseren.

T In het homescreen, tik op Opties > \Weergave > Homescreen.

2 Pas de volgende instellingen aan:

.

Selecteer launcher: Selecteer een modus voor het homescreen.
Wallpaper: \Wijzig de achtergrondwallpaper van het startscherm.
Scroll effect: Selecteer een effect om toe te passen wanneer u van
homescreen wisselt.

Pictogramvormen:Kies of u pictogrammen met vierkante of
afgeronde hoeken wenst.

Google-feed: Toon naar links van het hoofdscherm Home.

Apps sorteren op: Stel in hoe apps worden gesorteerd op het
homescreen.

Apps verbergen: Selecteer welke apps u van het homescreen wilt
verbergen.

Homescreen looping toestaan: Schakel dit in om continu op het
homescreen te kunnen scrollen (na het laatste scherm terug naar
het eerste scherm gaan).

Veeg naar omlaag op het Homescreen: Schakel dit in om te
zoeken naar apps of inhoud, of om notificaties te bekijken door
naar omlaag te vegen op het homescreen.

Veeg naar omhoog op het Homescreen: Schakel dit in om te
zoeken naar apps of inhoud, of om notificaties te bekijken door
naar omhoog te vegen op het homescreen.

Homescreen slot: Schakel het in om te voorkomen dat apps en
widgets opnieuw worden gerangschikt of verwijderd.
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Lockscreen

Overzicht van lockscreen

Het scherm van uw toestel wordt uitgeschakeld en vergrendeld wanneer
u de Aan-uit/Vergrendelen-toets indrukt. Dit gebeurt ook nadat het
toestel een bepaalde tijd inactief was.

Als u de Aan-uit/Vergrendelen-toets indrukt wanneer geen lockscreen is
ingesteld, wordt het homescreen onmiddellijk weergegeven.

Stel een lockscreen in om uw toestel te beveiligen en ongewenste
toegang te voorkomen.

E + Schermvergrendeling voorkomt onnodige aanraakinvoer op het
apparaatscherm en vermindert batterijverbruik. \We raden u aan de
lockscreen te activeren wanneer u het toestel niet gebruikt.

Een schermvergrendeling instellen
U kunt kiezen uit verschillende opties voor de configuratie van de
lockscreen.
T In het homescreen, tik op Instellingen > Lock screen & beveiliging >
Kies scherm slot en selecteer vervolgens de gewenste methode.
7 Pas de volgende instellingen aan:
+ Geen: Schakel de functie voor de lockscreen uit.
+ Schuiven: Veeg op het scherm om het te ontgrendelen.
- Patroon: Teken een patroon om het scherm te ontgrendelen.

- PIN: Voer een numeriek wachtwoord in om het scherm te
ontgrendelen.

- Wachtwoord: Voer een alfanumeriek wachtwoord in om het
scherm te ontgrendelen.

.

Vingerafdrukken: Ontgrendel het scherm met uw vingerafdruk.
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Lockscreen aanpassen
U kunt het vergrendelscherm aanpassen.

T In het homescreen, tik op Opties > Lock screen & beveiliging >
Scherm slot aanpassen.

7 Selecteer een functie die u wilt instellen.

- Wallpaper: Hiermee kunt u de achtergrond instellen voor uw
vergrendelingsscherm.

+ Klok: Hiermee kunt u de positie van de klok instellen op het
vergrendelingsscherm.

- Sneltoetsen: Hiermee kunt u apps kiezen om uit te voeren op uw
vergrendelingsscherm. Deze instelling is alleen zichtbaar als de
schermvergrendeling is ingesteld.

+ Weerinfo: Schakel deze optie in om weeranimaties weer te geven
voor de huidige locatie op het vergrendelscherm.

- Contactinformatie voor verloren toestel: Hiermee kunt u instellen

dat tekst wordt weergegeven op het vergrendelingsscherm om de
eigenaar van de telefoon te identificeren.

Veilige vergrendelingsinstellingen
U kunt beveiligde vergrendelingsinstellingen instellen.

T In het homescreen, tik op Instellingen > Lock screen & beveiliging >

Veilige vergrendelingsinstellingen.

7 Selecteer een functie die u wilt instellen.

- Maak patroon zichtbaar (enkel afgebeeld als Patroon ingesteld is
als een schermvergrendeling): Schakel in om het patroon zichtbaar
te maken.

- Vergrendel timer: Hiermee kunt u de tijd instellen hoelang nadat
de achtergrondverlichting uit is (de time-out vanwege inactiviteit)
het scherm automatisch wordt vergrendeld.

- Uit-knop blokkeert onmiddellijk: Schakel deze optie in om het
scherm onmiddellijk te vergrendelen wanneer op de Aan-uit/
\ergrendelen-toets wordt gedrukt. Deze instelling heeft voorrang
op de timerinstelling van het veiligheidsslot.
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- Vergrendeling tonen (enkel afgebeeld als een schermvergrendeling is
ingesteld): Als u het pictogram Vergrendelen wilt weergeven wanneer
u de knop Aan/uit ingedrukt houdt, schakelt u deze optie in. Tik op het
pictogram Vergrendelen als u Smart Lock, biometrische ontgrendeling
en meldingen op het vergrendelingsscherm wilt uitschakelen.

+ Smart Lock: Hiermee kunt u een betrouwbaar apparaat, betrouwbare
locatie, stem en/of lichaamsdetectie instellen waardoor uw telefoon
ontgrendeld blijft.

5 + De beschikbare menu opties kunnen variéren afhankelijk van de
geselecteerde methode van schermvergrendeling.

Knock On

U kunt het scherm in- of uitschakelen door dubbel te tikken op het scherm.

E + Deze optie is alleen beschikbaar op het homescreen dat door LG is
ingesteld. De optie werkt mogelijk niet naar behoren bij een aangepaste
opstart of op het homescreen dat de gebruiker heeft geinstalleerd.

+ Gebruik uw vingertop om op het scherm te tikken. Gebruik uw nagel niet.

+ Als u de functie 'Knock On’ wilt gebruiken, zorgt u ervoor dat de
nabijheidssensor/omgevingslichtsensor niet is afgedekt door een sticker
of een ander vreemd voorwerp.

Het scherm uitschakelen
Tik dubbel op het midden van het scherm.

« Als u boven of onder op het scherm tikt, neemt de snelheid van de
herkenning mogelijk af.

Het scherm inschakelen
Dubbeltik op een lege ruimte op het homescreen en vergrendelscherm.
Of tik dubbel op een lege ruimte in de statusbalk.
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Schakel Knock On uit
Indien u de functie Knock On niet wilt gebruiken, stel in als volgt:

In het homescreen, tik op Opties > Uitbreidingen > KnockON en versleep
het om de functie uit te schakelen.

Codering geheugenkaart

U kunt de gegevens die worden opgeslagen op de geheugenkaart
encrypten en beveiligen. De encrypted gegevens op de geheugenkaart
kunnen niet vanaf een ander apparaat worden geopend.

T In het homescreen, tik op Instellingen > Lock screen & beveiliging >
Encryptie & persoonsgegevens > Encrypt microSD.

2 Lees het overzicht van de codering van de geheugenkaart op het
scherm en tik vervolgens op Doorgaan om door te gaan.
3 Selecteer een optie en tik op Encryptie.
+ Nieuwe encryptie: Encrypt alleen gegevens die na de encryptie
worden opgeslagen op de geheugenkaart.
- Volledige encryptie: Encrypt alle huidige gegevens op de
geheugenkaart.

- Mediabestanden uitsluiten: Ecnrypt alle bestanden behalve
mediabestanden zoals muziek, foto's en videos.
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E « Zodra de encryptie van de geheugenkaart is gestart, zijn bepaalde
functies niet beschikbaar.

« Als het toestel is uitgeschakeld wanneer de encryptie aan de gang is,
mislukt de encryptie en kunnen gegevens beschadigd raken. Daarom
moet u controleren of de batterij van het toestel voldoende opgeladen is
alvorens de encryptie te starten.

- Encrypted bestanden kunnen alleen worden geopend op het toestel
waarmee de bestanden zijn geéncrypt.

« De encrypted geheugenkaart kan niet op een ander LG-toestel worden
gebruikt. Als u de encrypted geheugenkaart op een ander apparaat wilt
gebruiken, formatteert u de kaart.

« Ukunt de encryptie van een geheugenkaart activeren zelfs als er geen
geheugenkaart in het toestel is geplaatst. Elke geheugenkaart die u
daarna plaatst, wordt automatisch geéncrypt.

Screenshot maken

U kunt screenshot van het huidige weergegeven scherm maken.

Via een snelkoppeling

Houd de Aan/uit-/vergrendeltoets en de toets Volume omlaag minstens
twee seconden tegelijkertijd ingedrukt.

+ Screenshots kunnen via de map Screenshots in Galerij worden
bekeken.

Via Screenshot
Op het scherm waarvan u een schermafbeelding wilt maken, sleept u de
statusbalk omlaag en tikt u op @.

E - Zie Notities op een schermafbeelding schrijven voor details.
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Tekst invoeren

De Smart toolbar gebruiken
U kunt verschillende toetsenbordinvoermethoden op één plaats

gebruiken. U kunt de gewenste invoermethode selecteren vanaf de
bovenkant van het toetsenbord.

1 Selecteer de gewenste toetsenbordinvoermethode via de Smart
toolbar

2 Tik op -+ en selecteer de invoermethode die u wilt weergeven in de
Smart toolbar, of reorganiseer ze.

.

Smart toolbar —¢

E « Ukunt tot 6 werktuigen toevoegen aan de Smart toolbar.

« Sommige ondersteunende invoermethoden kunnen verschillen,
afhankelijk van het apparaat dat u gebruikt.

+ U kunt de functie Smart toolbar in- of uitschakelen vanaf het
toetsenbord instellingen.

« Ukunt ook de toetsenbordinvoermethoden gebruiken door op te tikken

- © : Voeg emojis toe.
- [&) : Voeg stickers toe.

@ :U kunt het Tenor GIF-toetsenbord gebruiken. Tik op
Aanvaarden om deze functie te gebruiken.

+ (25 :Voeg mijn emojis toe.
+ 22 :Open chat met tekeningen.
- 63 :Toegang tot toetsenbord instellingen.
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«  :Druk op & om tekst in te voeren met uw stem.

Voor de beste herkenning van gesproken opdrachten spreekt u

duidelijk.

- Voor de invoer van gesproken tekst zorgt u ervoor dat het
toestel is verbonden met een netwerk.

- Voor de selectie van de taal voor spraakherkenning tikt u op £% >
Talen in scherm van spraakherkenning.

- Deze functie wordt mogelijk niet ondersteund of de
ondersteunde talen verschillen mogelijk van de regio waarin de
service wordt verleend.

- [6): Open de cliplade.

« ¢ :Voer handgeschreven tekst in. Het is nodig om de data van de
invoertaal te downloaden voor handschrift. Tik op Downloaden om
de data van de invoertaal voor handschrift te downloaden.
:Activeer zwevend toetsenbord wanneer u de functie Meerdere
vensters gebruikt. U kunt het toetsenbord ook naar de gewenste
locatie verplaatsen.

.

Tik op 8, in de Smart toolbar.

- Als het toestel verbonden is met LG Dual Screen, kunt u het
scherm van LG Dual Screen vastleggen en het bevestigen tijdens
de invoer van het toetsenbord. Voor meer details, lees Instant
vastleggen gebruiken op Dual Screen.

Tik op &3 in de Smart toolbar.

- Indien het toestel verbonden is met LG Dual Screen, kunt u
het toetsenbord verticaal uitbreiden en het bovenste scherm
gebruiken als een app scherm en het onderste scherm als een
toetsenbordscherm. Voor meer details, lees Dubbel Toetsenbord
gebruiken op Dual Screen.
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Selecteren met het Smart keyboard

U kunt het Smart keyboard gebruiken om tekst in te voeren en te
bewerken.

Met het Smart keyboard kunt u tekst bekijken terwijl u deze tikt zonder
dat u tussen het scherm en een conventioneel toetsenbord hoeft te
schakelen. Zo kunt u tijdens het typen eenvoudig fouten vinden en
corrigeren.

Cursor verplaatsen

Met het Smart keyboard kunt u de cursor verplaatsen naar de gewenste
plaats. Houd uw vinger op de spatiebalk tijdens het tikken en sleep dan
naar links of naar rechts.

< () =

E + Deze optie is alleen beschikbaar bij het QWERTY-toetsenbord.

Woorden voorstellen

Smart keyboard analyseert automatisch uw gebruikspatronen om tijdens
het typen vaak gebruikte woorden voor te stellen. Hoe meer u het toestel
gebruikt, hoe nauwkeuriger de suggesties zijn.

Voer tekst in en tik op een voorgesteld woord of sleep de linker- of
rechterkant van het toetsenbord traag omhoog.
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+ Het geselecteerde woord wordt automatisch ingevoerd. U moet niet
elke letter van het woord handmatig typen.

[— ]
g g
4

Kopiéren en plakken

U kunt tekst uit een app knippen of kopiéren en vervolgens in dezelfde
app plakken. Of u kunt andere apps starten en de tekst daarin plakken.

Ty

1 Houd uw vinger op de tekst die u wilt kopiéren of knippen.
2 Sleep @ /W om het gebied op te geven dat u wilt kopiéren of knippen.

3 Selecteer Knippen of Kopiéren.

- De geknipte of gekopieerde tekst wordt automatisch aan de Clip-
lade toegevoegd.

/A Houd uw vinger op het venster waar u de tekst wilt invoeren en
selecteer Plakken.

E + Als er geen item is gekopieerd of geknipt, wordt de optie Plakken niet
weergegeven.
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Het delen van content

Inhoud afspelen op een ander apparaat

U kunt foto’s, video's of nummers die zijn opgeslagen op het toestel
afspelen op TV.

1 Verbind de TV en uw toestel met hetzelfde Wi-Fi-netwerk.

7 Tijdens het bekijken van items vanuit de app Galerij of Muziek tikt u
op Cgof : > Afspelen op ander apparaat.
Of tik op het homescreen Instellingen > Aangesloten apparaten >
Schermdeling en tik vervolgens op (7)) om het te activeren.

3 Selecteer de TV waarmee u verbinding wilt maken.

E « Voor Chromecast moeten de Google Play-services up-to-date zijn.

Inhoud van apparaten in de buurt bekijken

U kunt inhoud van diverse apparaten, zoals een computer, een NAS of een
mobiel toestel, bekijken via de apps Galerij of Muziek.

Apparaten verbinden

Verbind zowel uw toestel als het andere apparaat met ondersteuning
voor DLNA met hetzelfde draadloze netwerk.

E « Zorg ervoor dat Delen van bestanden (DLNA) is geactiveerd op zowel
het toestel als het verbonden apparaat.
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Apparaten in de buurt zoeken

U kunt een lijst van DLNA toestellen bekijken op hetzelfde netwerk door
de : > Apparaten in de buurt menu te selecteren in elke app.

Gebruik inhoud van apparaten in de buurt alsof u deze op uw toestel
gebruikt.

Bestanden versturen of ontvangen

U kunt bestanden tussen uw toestel en een ander LG-toestel of een
tablet delen.

Bestanden versturen

Tik in de Galerij of andere app op @ > Delen of o<, selecteer dan een
toestel op de lijst voor bestandsdeling.

Bestanden ontvangen
Sleep de statusbalk omlaag en tik op Bestand delen.

Indien uw toestel de functie bestand delen niet ondersteunt, tik dan in
het homescreen op Instellingen > Aangesloten apparaten > Bestand
delen > SmartShare Beam

E + U kunt uw bestanden delen met bepaalde toestellen die DLNA
ondersteunen.
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Prioriteit
U kunt notificaties beperken of het geluid ervan uitschakelen zodat u
gedurende bepaalde tijdstippen niet wordt gestoord.
Tik in het homescreen op Instellingen > Geluid > Niet storen.
- Modus en selecteer de gewenste modus:

- Alleen prioriteit: Ontvang notificaties met geluid of trilling voor
de geselecteerde apps. Zelfs als Alleen prioriteit aan staat, zullen
alarmen nog te horen zijn.

- Totale stilte: Schakel zowel het geluid als de trilfunctie uit.

- Prioriteiten selecteren: Ontvang alarmen en de meldingen voor de
geselecteerde apps.

- Oproepen van: Een reeks meldingen instellen wanneer u een oproep
ontvangt.

E + Opnieuw bellen: Tweede telefoontje van dezelfde beller binnen 15 min
is niet het zwijgen opgelegd.

- Berichten van: Stel een reeks meldingen in wanneer u een bericht
ontvangt.
+ Gebruik Niet storen: Schakel de functie Niet storen in.

- Slaap: Stel het schema in waarvoor u de functie Niet storen wilt
inschakelen.

+ Help: Bekijk de hulp voor Niet storen.
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Apps installeren en verwijderen

Apps installeren
Open een app store om apps te zoeken en te downloaden.

+ Ukunt SmartWorld, Play Store of de app store van uw provider
gebruiken.

E + Bij bepaalde app stores moet u mogelijk een account aanmaken en
moet u zich aanmelden.

« Voor bepaalde apps worden mogelijk kosten in rekening gebracht.

+ Afhankelijk van uw abonnement worden mogelijk kosten in rekening
gebracht als u mobiele data gebruikt.

+ Afhankelijk van de regio of de provider wordt Smart\World mogelijk niet
ondersteund.

Apps verwijderen
Verwijder apps op het toestel die u niet langer gebruikt.

Apps verwijderen door uw vinger op de app te houden

Druk enige tijd op een lege zone van de homescreen en druk dan € te
wissen.

Apps verwijderen via het menu Instellingen
Tik in het homescreen op Instellingen > Apps > App info, selecteer een
app, tik dan op Verwijderen.

E + Bepaalde apps kunnen niet door gebruikers worden verwijderd.
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Apps verwijderen vanuit de app store

Als u een app wilt verwijderen, opent u de app store vanwaar u de app
hebt gedownload en verwijdert u de app.

Apps installeren en verwijderen tijdens de
installatie

\Wanneer u voor het eerst het apparaat inschakelt, kunt u aangeraden
apps downloaden.

U kunt doorgaan met de volgende stap zonder installatie.

App-prullenbak
U kunt de apps bekijken waarvan de installatie ongedaan werd gemaakt.
U kunt ook apps die binnen de laatste 24 uur zijn verwijderd opnieuw
installeren.
1 Tik op het homescreen op Beheer > App-prullenbak.
U kunt uw vinger ook op een leeg gebied van het homescreen houden
en vervolgens tikken op App-prullenbak.
2 Activeer de gewenste functie:
+ Herstellen:installeer de geselecteerde app opnieuw.
- [i] : Verwijder de verwijderde apps definitief van het toestel.

E « Verwijderde apps worden 24 uur na de verwijdering automatisch gewist
van het toestel. Als u de gewiste apps opnieuw wilt installeren, moet u
ze opnieuw downloaden vanaf de app store.

« Deze functie is alleen op het standaard homescreen geactiveerd.
Als u apps verwijdert terwijl u het EasyHome-scherm of een ander
startscherm gebruikt, worden deze onmiddellijk en definitief gewist op
het toestel.
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App snelkoppelingen

Op het homescreen tikt u op en houdt u app-pictogrammen vast, zoals
Oproepen, Berichten, Camera, Galerij en Instellingen, om een menu voor
snelle toegang weer te geven. Gebruik apps gemakkelijker met gebruik
van App snelkoppelingen.

- Tik op g) om de widgets voor de app in te stellen.

- Tik op () om de app-info informatie te controleren.

E - Deze functie is alleen in sommige apps beschikbaar.
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Telefoon

Telefoongesprek

Gebruik een van de beschikbare methoden om te bellen: een
telefoonnummer handmatig invoeren, een contact uit de lijst met
contacten bellen of een nummer uit de lijst met recente oproepen bellen.

Een nummer met het toetsenblok bellen
1 Tik op het homescreen op (M > Bellen.
2 Gebruik de gewenste methode om te bellen:

- Voer een telefoonnummer in en tik op @@.

-+ Houd uw vinger op een snelkiesnummer.

+ Zoek een contact door op de eerste letter van diens naam in de lijst
met contacten te tikken en tik vervolgens op @.

E + Houd uw vinger op 0 om ‘+"in te voeren wanneer u naar het buitenland
wilt bellen.

+ Raadpleeg Contactpersonen toevoegen voor meer informatie over het
toevoegen van telefoonnummers aan de lijst met snelkiesnummers.

Oproepen vanuit contacten
1 Tik op het homescreen op (M > Contacten.

2 Na het selecteren van het nummer dat u wenst te bellen uit de lijst
van contacten, tik op &...
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Een oproep beantwoorden

Als u een oproep wilt beantwoorden, sleept u @ op het scherm van de
inkomende oproep.

- Wanneer de stereo headset is aangesloten, kunt u bellen met de knop

Gesprek starten/stoppen op de headset.

- Om een oproep te beéindigen zonder het scherm uit te schakelen, tik

op het homescreen op Instellingen > Netwerk & internet > Bellen >
Gesprekken beantwoorden en beéindigen en activeer dan Beéindig
gesprekken met de aan-uitknop.

E « Tik op het homescreen op Instellingen > Netwerk & internet >

Oproep > Gesprekken beantwworden en beéindigen > Beéindig
gesprek met de aan-uitknop, u kunt een oproep beéindigen door te
drukken op de Vergrendelen/aan-uitknop terwijl het scherm van de
inkomende gesprekken ingeschakeld is.

Een oproep afwijzen

Als u een inkomende oproep wilt afwijzen, sleept u @ op het scherm van
de inkomende oproep.

+ Om een afwijsbericht te versturen, sleept u de optie afwijsbericht

over het scherm.

Om een afwijsbericht toe te voegen of te verwijderen, tik op het
homescreen op Instellingen > Netwerk & internet > Oproep >
Oproep blokkeren & weigeren met bericht.

- Bij een inkomende oproep drukt u op de toets Volume omlaag, Volume

omhoog of de Aan/uit-/vergrendeltoets om het geluid of de trilfunctie
uit te schakelen of om de oproep in de wacht te plaatsen.

Een inkomende oproep controleren wanneer u een
app gebruikt

Wanneer u tijdens het gebruiken van een app een oproep krijgt, kan

bovenaan het scherm een pop-upmelding worden weergegeven. U kunt

vanaf het pop-upscherm de oproep beantwoorden, de oproep afwijzen of
een bericht verzenden.
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E « Tik op het homescreen op Instellingen > Netwerk & internet >
Oproep > Overige instellingen > Pop-up inkomende oproep en
selecteer dan de gewenste manier waarop u de inkomende oproep wilt
weergeven terwijl u een app gebruikt.

Gemiste oproepen bekijken

Bij een gemiste oproep wordt 24 in de statusbalk boven in het scherm
weergegeven.

Sleep de statusbalk omlaag om de gegevens van de gemiste oproepen te
bekijken. U kunt ook tikken op (8 > Oproepinfo op het homescreen.

Toegankelijke functies tijdens een oproep

Tijdens een oproep kunt u talrijke functies openen door op de knoppen
op het scherm te tikken:

- Contacten: Bekijk tijdens een oproep de lijst met contacten.
+ In wacht: Plaats het huidig gesprek op stand-by.

- Toetsen: geef het toetsenblok weer of verberg het.

- Speaker: schakel de luidsprekerfunctie in.

- Dempen: schakel de microfoon uit zodat uw gesprekspartner u niet
kan horen.

+ Bluetooth: schakel de oproep door naar een gekoppeld en verbonden
Bluetooth-toestel.

- @ :besindig de oproep.
: :Ga naar extra oproepopties.

E « Afhankelijk van de regio en de serviceprovider kunnen de beschikbare
instellingen verschillen.
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Een nummer tijdens een oproep bellen
U kunt tijdens een oproep een ander contact bellen.
1 Tik tijdens een oproep op : > Oproep toevoegen.
2 Voer een telefoonnummer in en tik op @.
« De twee oproepen worden tegelijk op het scherm weergegeven en
de eerste oproep wordt in de wacht geplaatst.

3 Tik op Samenvoegen om een conferentiegesprek te starten.

E « Voor elke oproep worden mogelijk kosten in rekening gebracht.
Raadpleeg uw provider voor meer informatie.

Belgeschiedenis bekijken

Om de historiek van recente oproepen te bekijken, tik op het homescreen
op (9> Oproepinfo. U kunt dan de volgende functies gebruiken:

- Selecteer een contact om een gedetailleerde belgeschiedenis te
bekijken. Tik op &, om het geselecteerde contact te bellen.

- Om de omroepgeschiedenis te wissen, tikt u op ¢ > Verwijderen.
E « De weergegeven gespreksduur verschilt mogelijk van de gespreksduur

die in rekening wordt gebracht. Raadpleeg uw provider voor meer
informatie.

« Verwijderde oproepgeschiedenis kan niet worden hersteld.

« Als u de tekengrootte van oproeplogboeken of contacten wilt
aanpassen, knijp er twee vingers in of strek uw vingers.

Opties voor oproepen configureren
U kunt diverse opties voor oproepen configureren.
1 Tik op het homescreen op (® > Bellen of Oproepinfo.

7 Tik op : > Oproepinstellingen en configureer dan de gewenste
opties.
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Berichten

Een bericht versturen

U kunt berichten maken en versturen naar uw contactpersonen via de
app Berichten.

E « Voor de verzending van berichten naar het buitenland worden mogelijk
extra kosten in rekening gebracht. Raadpleeg uw provider voor meer
informatie.

1 Tik op het homescreen op @.

2 Tik op CHED.

3 Geef een ontvanger op en maak een bericht.
-+ Om multimedia opties te gebruiken, tik op ().
- Tik op : om optionele menuopties te openen.

A Tik op B> om het bericht te versturen.

Een bericht lezen
U kunt de uitgewisselde berichten met elk contact bekijken.

1 Tik op het homescreen op .

7 Selecteer een contact in de lijst met berichten.

E « Als u op de boodschappenlijst of chat venster bent, kunt u de
lettergrootte aanpassen door twee vingers op het scherm te plaatsten
en ofwel de vingers te verbreden of te versmallen.
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Instellingen voor berichten configureren
U kunt de instellingen voor berichten naar wens wijzigen.

1 Tik op het homescreen op ©.
2 Tikop : > Instellingen vanuit de ljst met berichten.

E U kunt instellingen toewijzen voor het kennisgevingsvenster oproepen
blokkeren, rampalarmen, multimediabooschappen enz.

Camera

Camera starten

U kunt een foto of een video maken om al uw mooiste momenten te
koesteren.

Tik op het homescreen op (&).

E « Veeg de cameralens schoon met een zachte doek voordat u een foto of
video maakt.

« Maak de cameralens niet vuil met uw vingers of andere vreemde
stoffen.

- Zelfs als de telefoon op trillen of stil staat, wordt het sluitergeluid
geactiveerd als u een foto maakt.

« De afbeeldingen in deze gebruikershandleiding kunnen afwijken van het
werkelijke toestel.

« In Galerij kunt u foto's en video's bekijken en bewerken. Zie Overzicht van
Galerij voor details.

- Vermijd het gebruik van het product voor een doeleinde dat de privacy
of rechten van een andere persoon zou kunnen schenden.
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Een foto maken
U kunt foto's maken met de camera in het product.
T Tik op ® en focus op het voorwerp.
+ U kunt het voorwerp aanraken om erop te focussen.
+ U kunt twee vingers spreiden of knijpen om in of uit te zoomen.

+ Selecteer een zoom vanuit €9 / @9 / (.

2 Tikop  om een foto te maken.

+ U kunt ook op de toets Volume omlaag of Volume omhoog drukken
om een foto te maken.

+ U kunt een foto maken terwijl u een video opneemt door te
drukken op ® op het scherm.

- De opties weergegeven op het scherm kunnen verrschillen
afhankelijk van de geselecteerde camera (voor of achter) en de
camera modus.

+ De camera zal automatisch uitschakelen indien u het een tijdje niet
gebruikt na het starten van de Camera app.

Start Visueel zoeken

Huidige
Instellen/Annuleren cameramodus.
timeroptie _|
P 3 i_ Schakel over naar
Instellen/Annuleren - camera gericht naar

flitseroptie \;gﬁ{/e%ericht naar
Toepassen filter —s l_—_l_'l «—— Maak foto

effect 1

— Selecteer zoom

Kies beeldverhouding 1

’ . L —— voorbeeld

Stel Camera in — I—Automatische
optimalisatie van
scénes
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E + U kunt de camera app starten door kort twee maal op de aan-uitknop
te drukken. Tik op het homescreen op Instellingen > Uitbreidingen >
Sneltoetsen en tik dan op Open Camera om het te activeren.

+ Wanneer het scherm is uitgeschakeld of vergrendeld, kunt u de camera
starten door tweemaal op de knop Volume omlaag te drukken.

« Tik op het homescreen op Instellingen > Uitbreidingen > Sneltoetsen
en tik dan op Open Camera @ ) om het te activeren.

De cameraopties aanpassen
U kunt talrijke camera-opties naar wens aanpassen.
Tik op het scherm op $83.

E « De beschikbare opties verschillen naargelang de geselecteerde camera
(camera vooraan of achteraan) en de geselecteerde cameramodus.

Automatische
optimalisatie van
scenes

Door de scene die opgenomen wordt te herkennen,
wordt de instelling optimale resolutie automatisch
toegepast.

Compositie

Door de menselijke figuur te herkennen als u een
portret maakt, wordt de optimale compositie
aanbevolen.

Tips

Verwittigt de gebruiker als de ogen van het onderwerp
gesloten waren of de afbeelding troebel is voor
optimale fotografie.

Fotoresolutie

Biedt u de mogelijkheid om de grootte van de foto en
de beeldverhouding te kiezen.

HDR

Maak foto's in levendige kleuren en gebruik
compenserende effecten, zelfs als de foto's of de
video's met tegenlicht worden gemaakt. Deze functies
worden geleverd door de HDR-technologie (High
Dynamic Range) van de camera.

Vervormingscorrectie
ultra brede opname

Corrigeert de schermdistorsie als u ultra
groothoekfoto's maakt.
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Opslaan als HEIF

Bespaart opslagruimte door het afbeeldingsbestand
te comprimeren in HEIF-formaat. Het kan zijn dat
andere toestellen afbeeldingsbestanden in HEIF-
formaat niet ondersteunen.

Live foto Neem de actie op voor en na het maken van een foto.
Geef een raster weer zodat u foto's of video's kunt
Raster maken met behulp van de horizontale en verticale

referentielijnen.

Cheese shutter

Biedt u de mogelijkheid om een foto te maken door te
zeggen ‘Cheese, ‘Smile; Whiskey; 'Kimchi, of 'LG!

Handtekening
toevoegen

Geef een gepersonaliseerde handtekening weer op
de foto's.

Tag locatie

Sla de afbeelding op met gps-locatiegegevens.

Opslagruimte

Selecteer of u de foto's en video's in het Intern
geheugen of op een SD-kaart. (Beschikbaar wanneer
de geheugenkaart is geplaatst.)

Help

Lever hulp voor elk cameramenu.

Extra opties op de camera vooraan

Vervormingscorrectie
voor selfies

Corrigeert vervormde delen van het gelaat.

Bewaard als gedraaid

Bewaart als gedraaide afbeeldingen bij het maken van
een selfie.

Selfie-opname

Neem een selfie door de optie te selecteren tussen
Opname met handgebaar en Automatische
opname.

E + U kunt het make-up effect toepassen als u een selfie maakt met de

camera vooraan.

+ Opname met handgebaar wordt gemaakt door de vorm van een hand
te herkennen en Automatische opname wordt gemaakt door een
gelaat te herkennen.

Nuttige apps

86



Selectie modus

U kunt gemakkelijk selecteren uit de afgebeelde modi op het scherm die
geselecteerd worden en die het best passen bij de omgeving.

Tik op (&) en veeg de camera modi naar links of rechts, of veeg het
scherm naar links of rechts om een camera modus te selecteren.

< nimp

|
l

Camera modi
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Cameramodi gebruiken

Een video maken
T Tik op (@ en selecteer Video door over de camera modi te vegen.

2 Tikop = om een video te maken.

Stel Camerain —e «—— Instellen/Annuleren
] ] flitseroptie

Selecteer schermresolutie Toepassen filter effect

Steady cam Aan/Uit —

e——— Selecteer zoom
Voorbeeld —— e——— Schakel over naar camera
gericht naar voor/gericht
I naar achter

L Fenvideo maken

Tik op ® om een foto te maken terwijl u een video maakt.

Tik op (1) om de video-opname te pauzeren. Tik op (@  om de video-
opname te hervatten.

Tijdens het opnemen van een video kunt u twee vingers spreiden of
knijpen om in of uit te zoomen.

Tijdens het opnemen van een video, kunt u op het gewenste gebied
tikken om de helderheid aan te passen.

+ U kunt overschakelen van de selfie camera naar de primaire camera
en omgekeerd terwijl u een video maakt door te drukken op o).

3 Tikop (= om de video-opname te beéindigen.
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E + U kunt opslagruimte besparen door de optie Opslaan als HEVC in te
stellen in §83. Het comprimeert het video-bestand in HEVC-formaat.

« Het kan zijn dat andere toestellen video-bestanden in HEVC-formaat
niet ondersteunen.

Een foto maken
Tik op (&) en selecteer Foto door over de camera modi te vegen.
Zie Een foto maken voor meer informatie.

Portretten maken

U kunt foto's maken die het voorwerp opvallender maken en duidelijker
zijn door de achtergrond troebel te maken.

1 Tik op (&) en selecteer Portret door over de camera modi te vegen.

- Selecteer een gewenst effect door over de effect opties voor
portret te vegen.

- Tik op & om de brandpuntsverhouding aan te passen.

2 Tik op () om een foto te maken.

1

Stel Camera in — — Instellen timeroptie

Instellen
brandpuntsverhouding

Kies beeldverhouding

«— Selecteer een

effect-optie voor
portret.
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E + Als u de melding ziet “Portret is beschikbaar’, start dan met het maken
van een foto.

+ De portretfunctie werkt mogelijk niet als de camera het onderwerp niet
kan herkennen.

- Terwijl u een foto, moet u de afstand tot uw onderwerp tot 1,3 ~ 5 voet
bewaren.

« Deze functie is niet beschikbaar als het erg donker is.

Een sticker gebruiken

U kunt een variéteit aan stickers toepassen voor uw foto's of videos.

U kunt rijkere content creéren met 3D AR Effect.

1 Tik op (@ en selecteer Sticker door over de camera modi te vegen.
« Selecteer een gewenste sticker door over stickers te vegen.

2 Tikop( om een foto te maken, of houd () ingedrukt om een video
op te nemen.

« Er kan niet overgeschakeld worden tussen de voor- en
achtercamera terwijl u een video maakt.
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3 Tikop = om de video-opname te beéindigen.
- De foto of video zal opgeslagen worden in Galerij.

Stel Camerain — +— Instellen timeroptie

Kies beeldverhouding —41

E - Tik op @ om 3D AR Sticker te gebruiken.
Zie 3D AR Effect voor meer informatie.
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Bijkomende cameramodi gebruiken
Tik op (&) en selecteer Meer door over de camera modi te vegen.

Nachtweergave

U kunt levendige en heldere nachtfoto's maken. Nachtweergave zal
automatisch starten als u een foto maakt bij weinig licht.

U kunt ook heldere nachtscénes schieten door de functie
Nachtweergave handmatig te gebruiken.
1 Tik op (&) en selecteer Meer door over de camera modi te vegen.
2 Tikop &S

- Selecteer een zoom vanuit @9 / @3.
3 Tik op () om een foto te maken.

- Om de helderheid van de foto aan te passen, schuif naar € links of
rechts.

Stel Camerain —9 *— Instellen timeroptie

Kies beeldverhouding - 1

+—— Pas de helderheid aan

E + Houd stevig vast zodat de camera niet trilt terwijl u een foto maakt.
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Panorama

U kunt een panoramische foto maken door de camera in een richting te
bewegen om beelden continu te fotograferen en samen te voegen zodat
u een breed beeld verkrijgt.

1 Tik op (@ en selecteer Meer door over de camera modi te vegen.

2 Tikopla
- Selecteer een zoom vanuit €9 / 3.

3 Tikop  enbeweeg dan de camera traag in een richting.

A Tik op @ om geen panoramisch beeld meer te maken.

Stel Camera in —.':I

E « Als u de camera in één richting beweegt, zorg ervoor dat het scherm dat
u maakt zich niet buiten de begeleidingslijn bevindt.
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Handmatige Camera
U kunt professionele foto's maken door talrijke geavanceerde functies te
gebruiken.

1 Tik op (&) en selecteer Meer door over de camera modi te vegen.
7 Tikop &.
3 Pas de volgende camera-instellingen aan.

- Selecteer een zoom vanuit €9 / @.

- Indien u Automatisch instelt voor opties, worden de opties
automatisch aangepast naargelang het doel en de omgeving.
- Indien de optie Focus peaking ingesteld is, wordt de focuszone

in kleur geaccentueerd. Deze functie is alleen beschikbaar in
Handmatige Focus (MF) modus.

Stel Camerain —e *— Instellen timeroptie

Kies beeldverhouding ] ] Instellen flitseroptie

Toepassen filter effect —

Instellingen ————¢ o Geeftde
resetten verschillende
Graphy opties
1 weer

1
Pas de witbalans ——
aan I— Pas de

sluitersnelheid aan

Pas de
Pas de helderheid ISO-snelheid aan
aan

Pas de focus aan

4 Tikop( om de foto te maken.

Nuttige apps 94



E + Indien u tikt op (®) en een Graphy foto effect selecteert, zal een lijst
van aanbevolen foto's met verschillende opties verschijnen.

« Als u de Graphy effecten selecteert kunt u foto's maken met de
waarden van witbalans, de sluitersnelheid, en de ISO instelling toegepast
op de aanbevolen foto.

« Deze functie is alleen beschikbaar in Handmatige cameramodus.

« U kunt een variéteit aan aanbevolen foto's zien indien u de app Graphy
foto downloadt uit Google Play Store.

« Er kunnen kosten in rekening worden gebracht voor uw datagebruik,
afhankelijk van uw bundel.

- Tik §63, tik vervolgens op @ ) vanuit het Graphy foto’s menu om deze
functie te deactiveren.

De cameraopties aanpassen

U kunt talrijke camera-opties naar wens aanpassen.

Tik op $63 in Handmatige camera.

Fotoresolutie

Biedt u de mogelijkheid om de grootte van de foto en de
resolutie te kiezen.

Opslaan als
RAW

De afbeelding wordt opgeslagen in de bestandsindeling RAW
zodat u ze kunt wijzigen.

De DNG- en JPEG-bestanden worden aangemaakt wanneer
u een foto maakt, en worden vervolgens opgeslagen als een
niet-gecomprimeerde afbeelding met hoge resolutie.

Correctie
distorsie ultra
brede opname

Corrigeert de schermdistorsie als u ultra breedhoekfoto's
maakt.

Pas de witbalans, ISO en sluitersnelheid aan voor de

Graphy foto aanbevolen foto.
Zie Handmatige Camera voor details.
Hulp Geef een raster weer zodat u foto's kunt nemen met behulp van

de horizontale en verticale referentielijnen.
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Handtekening
toevoegen

Geef een gepersonaliseerde handtekening weer op de foto's.

Tag locatie

Sla de afbeelding op met gps-locatiegegevens.

Opslagruimte

Selecteer of u de foto's en video's in het Intern geheugen of
op een SD-kaart. (Beschikbaar wanneer de geheugenkaart is
geplaatst.)

Help

Lever hulp voor elk cameramenu.

Slow Motion

Maak een fun video door de bewegingssnelheid te wijzigen. Deze functie
is nuttig als u een video wil afspelen tegen een lagere snelheid dan deze
van de werkelijke snelheid van de originele clip.

1 Tik op (@ en selecteer Meer door over de camera modi te vegen.

2 Tikop @.

3 Selecteer een interval & of volledige & om het effect slow motion
erop toe te passen.
- Deel in slow motion: Biedt u de mogelijkheid om een effect slow
motion toe te passen op een specifiek gedeelte van de video.

- Druk op © op het ogenblik waar u wenst da het effect
vertraagde beelden wordt toegepast. Met kort indrukken, zal
het effect vertraagde beelden toegepast worden gedurende 0.5
seconden. Met lang indrukken, zal het effect vertraagde beelden
toegepast worden tot u uw vinger los laat.

+ Alle Slow Motion: Biedt u de mogelijkheid om een effect slow
motion toe te passen op de volledige video.
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Instellingen —e «— Instellen flitseroptie

Selecteer een interval —41

A Tik op (e om een video te maken.

+ Tik op (1) om de video-opname te pauzeren. Tik op ‘@ om de video-
opname te hervatten.

5 Indien u de opname wenst te beéindigen, druk op (= .

YouTube Live
U kunt een video opnemen en direct uploaden naar YouTube.

Om deze functie te gebruiken, moet u voldoen aan de
ontvankelijkheidsvereisten. Contacteer YouTube voor de vereisten.

1 Tik op het homescreen op (&).
2 Selecteer Meer door te vegen over de cameramodi, tik dan op ((e).
E - YouTube Live zijn alleen beschikbaar wanneer uw apparaat is verbonden

met internet. Afhankelijk van uw abonnement worden mogelijk kosten
in rekening gebracht als u mobiele data gebruikt.
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Nuttige camerafuncties

Een foto maken met de Al functie

Als u een foto maakt, herkent de Al functie een voorwerp en past het
optimale effect toe op de foto.

5 - Tik op @ om de Al functie te deactiveren.

Automatische Belichting/Automatische Focus
vergrendeling

U kunt het huidige belichtingsniveau en de focuspositie verbeteren door
in automatische modus het scherm aan te raken. Om de functie uit te
schakelen, tikt u op een leeg gedeelte op het scherm.

Automatische
Belichting/Automa
tische Focus
vergrendeling

E - Deze functie is alleen beschikbaar in bepaalde modi.
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Schakelen tussen camera’s

U kunt schakelen tussen de camera’s aan de voorkant en de achterkant

naargelang de omgeving.
- Om over te schakelen tussen de voor- en achtercamera, veeg het
scherm omhoog of omlaag op het scherm in de Camera app

<= @ mp

E + Gebruik de camera aan de voorkant om selfies te maken. Zie Selfie-
opname voor details.

In- en uitzoomen

U kunt twee vingers spreiden of knijpen om in of uit te zoomen als u
foto's of video's maakt.

E + De functie zoom in- en uit is niet beschikbaar in de selfie modus

(camera vooraan).
« Deze functie wordt niet ondersteund in een aantal modi.
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De burst Shot gebruiken

U kunt opeenvolgende foto's maken en ze bekijken als bewegende
afbeeldingen in de Galerij.

1 Tik op (&) en selecteer Foto.
2 Houd ingedrukt
+ Meerdere opeenvolgende foto's terwijl u indrukt

Gesture Shot
U kunt selfies maken met behulp van gebaren.

Toon uw handpalm aan de camera aan de voorkant en bal dan uw vuist.

U kunt ook uw vuist ballen en vervolgens in de richting van de camera
vooraan openen.
+ Binnen drie seconden wordt een foto gemaakt.

o

z »

m

E + Als u deze functie wilt gebruikt, schakelt u naar de camera vooraan en

tikt u vervolgens op £33 > Selfie-opname > Opname met handgebaar.

+ Zorg ervoor dat uw handpalm en vuist zich binnen de referentielijn
bevinden zodat de camera ze kan detecteren.

+ Deze functie is mogelijk niet beschikbaar bij gebruik van enkele functies

van de camera.
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Automatische opname

U kunt de functie voor gezichtsherkenning gebruiken om eenvoudig
en handig selfies te maken. U kunt het toestel zodanig instellen dat
de camera aan de voorkant uw gezicht detecteert wanneer u naar het
scherm kijkt en automatisch een selfie maakt.

+ De witte hulpkader verschijnt wanneer de camera vooraan uw gezicht
detecteert. Als het onderwerp in de hulpkader stopt met bewegen,
wordt de hulpkader geel en maakt de camera een foto.

-« Tikop @ > Selfie-opname > Automatische opname om de functie
Automatische opname in te schakelen.

Intervalopname
U kunt selfies maken met een interval

Toon bij gebruik van de camera vooraan uw handpalm aan de camera en
bal vervolgens snel tweemaal een vuist.

+ Na een vertraging van drie seconden worden vier foto's met
regelmatige tussenpozen gemaakt.

Bewaard als gedraaid

Tik voordat u een foto met de camera vooraan maakt op 53 > Bewaard
als gedraaid. De afbeelding wordt horizontaal gedraaid.

E + Wanneer u de camera vooraan gebruikt, kunt u in de opties voor de
camera wijzigen hoe selfies worden gemaakt. Zie De cameraopties
aanpassen voor details.

Selfie-opname

U kunt de camera aan de voorkant gebruiken om uw gezicht op het
scherm te zien en selfies te maken.

1 Tik op (&) en selecteer Foto door over de camera modi te vegen.
2 Tik op {2 om over te schakelen naar de voorcamera.
3 Tikop(  om foto's te maken.

- Tik op §) om verschillende schoonheidseffecten toe te passen.
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Galerij

Overzicht van Galerij

U kunt foto's en video's die zijn opgeslagen op uw toestel bekijken en
beheren.

Foto's bekijken
U kunt de foto's bekijken die opgeslagen zijn in het product.
1 Tik op €8 en selecteer een gewenste map.

2 Tik op een gewenste foto.
+ De Galerijmap bevat Foto’s, Albums, Herinneringen, en Spel.

— Start Visueel zoeken.

Ga terug naar het vorige —¢ ~— Open extra opties.
scherm.

»— \oorbeeldgalerij

—I
*— Verwijder afbeeldingen.

Voeg toe of verwijder uit uw —
favorleten

Deel afbeeldingen.
Bewerk afbeeldingen.

E « Details menu verschijnt als het scherm lichtjes aangeraakt wordt. Het
scherm opnieuw aanraken zorgt ervoor dat het menu verdwijnt.
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Een video afspelen
U kunt de video's bekijken die opgeslagen zijn in het product.

Ga terug naar het —s +— Open extra opties.
vorige scherm.

Pauzeer of speel d¢ ————
video af

»— \oorbeeldgalerij

Voeg toe of verwijder uit uw — *— Verwijder afbeeldingen.

favorieten. ———— 1

Deel afbeeldingen.
Bewerk afbeeldingen.

E « Als u het volume wilt aanpassen, sleept u de rechterkant van het
scherm met de video omhoog of omlaag.

« Als u de helderheid van het scherm wilt aanpassen, sleept u de
linkerkant van het scherm met de video omhoog of omlaag.

« Met het scherm slepen naar links op het scherm video afspelen kunt
u terugspoelen (REW) en met naar rechts te slepen kunt u snel
doorspoelen (FF).
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Bestanden verwijderen
U kunt bestanden verwijderen via een van de volgende opties:

+ Houd uw vinger op een bestand uit de lijst met bestanden en tik op
Wissen.

- Verwijderde bestanden worden automatisch verplaatst naar : >
Prullenbak en ze kunnen Teruggeplaatst worden in de Galerij binnen
7 dagen.

- Tik op ] om de bestanden volledig te verwijderen. In dit geval kunnen
de bestanden niet worden hersteld.

Bestanden delen
U kunt bestanden delen via een van de volgende opties:

- Tik op < terwijl u foto of video bekijkt om het bestand via de
gewenste methode te delen.

5

+ Indien u foto’s of video's maakt na het intikken op (&) > ¢33 > Tag locatie

@ ), wordt het herinneringsalbum specifek voor de locatie automatisch
aangemaakt na een bepaalde tijd onder de Herinneringstab van Galerij.

« U kunt de foto’s of video's zoeken op plaats, tag, camera modus, enz.

door te tikken op Q in de galerij.

« Afhankelijk van de geinstalleerde software worden bepaalde

bestandsindelingen mogelijk niet ondersteund.

- Bepaalde bestanden kunnen vanwege de encryptie niet worden geopend.
- Bestanden die groter zijn dan de maximale bestandsgrootte kunnen een

fout veroorzaken.

« U moet de GPS-functie activeren om geheugenalbums te maken.

Een collage maken
U kunt een collage maken van verwante inhoud.

T Tik op @Y en selecteer : > Maak collage.

2 Selecteer de gewenste afbeeldingen om toe te voegen aan de collage
en tik dan op Maak collage.

« Selecteer de gewenste opmaak van de onderkant van het scherm.
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3 Tik op Maken.

5 « Maximaal 9 afbeeldingen kunnen gebruikt worden om een collage te
maken.

Een film maken

U kunt een nieuwe film maken door afbeeldingen en video's samen te
voegen.

1 Tik op (Y en selecteer : > Films aanmaken.

2 Selecteer afbeeldingen of video's voor uw film en tik op Films
aanmaken.

3 Pas de geselecteerde afbeeldingen en video's aan en tik dan op
Opslaan.

o— Bestanden met
[ effecten
Bestanden resetten

Voorbeeld van een
bestand zien

Bestanden ————
verwijderen

Bestanden
toevoegen

E « Maximaal 50 videos kunnen gebruikt worden om een film aan te maken.
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Een GIF-afbeelding maken
U kunt eenvoudig een GIF-bestand maken met opgenomen video.
Tik op [ en selecteer Een GIF-afbeelding maken.

Video aanmaken
T Tik terwijl u een video bekijkt op het gewenste beginpunt op @®.

2 Selecteer de lengte van de GIF die u wilt aanmaken.

+ De GIF wordt aangemaakt voor de geselecteerde duur vanaf het
gespecificeerde startpunt.

+ Voor video's van minder dan 5 seconden, worden GIF-afbeeldingen
automatisch aangemaakt voor de resterende duur.

GIF-foto's aanmaken
T Inde lijst met foto's in de galerij, tik op * > GIF aanmaken.

2 Selecteer een afbeelding om te veranderen in een GIF-foto en tik dan
op Volgende.

+ U kunt een foto toevoegen/wissen, de snelheid of beeldverhouding
aanpassen, en de volgorde van de foto’s instellen.

E « GIF-fotos aanmaken is een functie voor de gebruiker om creatieve
afbeeldingen te maken. Rechten schenden zoals intellectuele
eigendomsrecht of de reputatie van een andere persoon schenden
door de functie GIF-foto's aanmaken te gebruiken kan leiden tot een
burgerlijke of strafrechterlijke aansprakelijkheid in overeenstemming
met de betreffende wetten. \Wees voorzichtig om niet andermans werk
te kopiéren of over te dragen zonder goedkeuring. LG Electronics is op
geen enkel manier aansprakelijk voor dergelijke daden door gebruikerrs.

- Ukunt tot 100 foto's selecteren als u een GIF aanmaakt.
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Contacten

Overzicht van Contacten
U kunt contacten opslaan en beheren.
Tik op het homescreen op Hoofdzaken > Contacten.

Contactpersonen toevoegen

Nieuwe contacten toevoegen

1 Tikin de lijst met contacten op -+

« Erverschijnt een pop-up om de locatie te selecteren voor contact.
Selecteer de locatie die u wenst.

2 Voer de gegevens van de contactpersoon in en tik op Opslaan.

Contacten importeren
U kunt contacten vanaf een ander opslagapparaat importeren.

1 Tikin de lijst met contactpersonen op : > Contacten beheren >
Importeren.

7 Selecteer de bron- en doellocaties van het contact dat u wilt
importeren en tik dan op OK.

3 Selecteer de contactpersonen en tik op Importeren.

Contacten toevoegen aan de lijst met snelkiesnummers
1 Tikin de lijst met contactpersonen op : > Snelkeuze.

7 Tik op Contact toevoegen vanaf een snelkiesnummer.

3 Selecteer een contact.

E + Als u een nieuw contact toevoegt, tik op (315} om een snelkiesnummer
toe te voegen.
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Contacten zoeken
U kunt contacten zoeken met een van de volgende opties:

- Tik op de zoekbalk bovenaan het scherm van de Contacten en voer het
gewenste contact in of telefoonnummer waarnaar u zoekt. Scrol de
lijst met contacten omhoog of omlaag.

« Tik in de index van de lijst met contacten op de eerste letter van een
contact.

E - Door te drukken op de zoekbalk bovenaan het scherm van de
Contacten en een contact of telefoonnummer in te voeren krijgt u
de geintegreerde zoekresultaten uit de belhistoriek en de lijst met
contacten opgeslagen in het product.

Lijst met contacten

Contacten bewerken
T Selecteer een contact in de lijst met contacten.

2 Tik op het scherm met de gegevens van het contact op / en bewerk
de gegevens.

3 Tik op Opslaan om de wijzigingen op te slaan.

Contacten verwijderen
U kunt contacten wissen met een van de volgende opties:
+ Houd op het scherm met de lijst van contacten, een contact dat u wilt
wissen ingedrukt, tik dan op {i1).
- Tikop : > Verwijderen in de lijst met contacten.

E + Verwijderde contacten worden mogelijk niet hersteld.
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Favorieten toevoegen
U kunt vaak gebruikte contacten instellen als favorieten.

1 Selecteer een contact in de lijst met contacten.

2 Tik op het scherm met de gegevens van het contact op ¥y.

Groepen maken
1 Op de lijst met groepen contacten, tik op .
2 Voer de naam van een nieuwe groep in.

3 Tik op Leden toevoegen, selecteer de contactpersonen en tik
vervolgens op Nieuw.

A Tik op Opslaan om de nieuwe groep op te slaan.

QuickMemo+

Overzicht van QuickMemo+

U kunt creatieve notities maken met talrijke opties van deze
geavanceerde versie van kladblok (zoals het beheer van afbeeldingen en
screenshots) die niet worden ondersteund door de traditionele versie van
kladblok.

Dit toestel ondersteunt de Active Pen AES2.0 (Actief Electrostatisch).

Een notitie maken
1 Tik op het homescreen op Hoofdzaken > QuickMemo+.
2 Tik op @ om een notitie te maken.
- @ :Sla een notitie op.
+ <5 :Maak de vorige aanpassing ongedaan.
+ 7 :Doe de onlangs verwijderde aanpassingen opnieuw.
+ (T :Tik een notitie met behulp van het toetsenblok.
- ¥ : Uw favoriete pen-types opslaan.
« / :Schriff notities met de hand.
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- & :Wis handgeschreven notities.

+ G :Wijzig in het kalligrafisch lettertype terwijl u met de hand
schrijft.

-+ :Open extra opties.

3 Tik op @ om de notitie op te slaan.

Notities op een schermafbeelding schrijven
T Wanneer u het scherm bekijkt dat u wilt vastleggen, sleept u de
statusbalk omlaag en tikt u op @.
+ Het scherm wordt vastgelegd en weergegeven als een bladwijzer
rechts onder op het scherm.
2 Om notities te schrijven op het scherm, tik op ..
3 Notities schrijven met de tools.
-+ 1 :Zoom in of uit, of pas de zone aan die moet vastgelegd worden.
/ :Schriff notities met de hand.
+ & :Wis handgeschreven notities.
- €5 :Maak de vorige aanpassing ongedaan.
- 7 :Doe de onlangs verwijderde aanpassingen opnieuw.
+ (25 :Knip het scherm bij naar uw wens.
4 Tik op v en sla de notitie op.
- Opgeslagen notities kunt u bekijken in Galerij.
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Bijkomende functies na het vastleggen van een
screenshot

— Tik om het hele scherm vast
te leggen met gebruik van de
scroll capture functie.

e | Tikopom het scherm op te
nemen.

Tik om notities te schrijven Tik om de gemaakte

op het vastgelegde scherm. schermafbeelding te wissen.
1

Tik om de gemaakte _

schermafbeelding te delen.

E « U kunt het hele scherm vastleggen met gebruik van de scroll capture
functie.

« Terwijl u een app gebruikt zoals Messaging en Chrome, sleep het
notificatiescherm neerwaarts en tik dan op @. Tik dan op v om het
volledige scherm vast te leggen dat u momenteel bekijkt als één enkel
bestand.

- Deze functie is alleen beschikbaar in apps die scroll capture
ondersteunen.

- Knijp twee vingers in of spreid uw vingers uit elkaar om de memolay-out
te wijzigen.

Nuttige apps 111



Klok

Alarm

U kunt een alarm instellen om het op een bepaald tijdstip te laten afgaan.
1 Tik op het homescreen op Hoofdzaken > Klok > Alarm.

2 Tik op -+ om een nieuw alarm toe te voegen.

3 Configureer de alarminstellingen en tik op Opslaan.

+ Als u een eerder ingesteld alarm selecteert, kunt u het alarm bewerken.

+ Voor de verwijdeering van een alarm, tikt uop + > Wissen bovenaan in
het scherm. Of houd uw vinger op het alarm.

Wereldklok

U kunt de huidige tijd in steden over de hele wereld bekijken.

1 Tik op het homescreen op Hoofdzaken > Klok > Wereldklok.
2 Tik op - en voeg een stad toe.

Nuttige apps 112



Timer

U kunt de timer instellen om een alarm na een opgegeven tijdsduur te
laten afgaan.

1 Tik op het homescreen op Hoofdzaken > Klok > Timer.

2 Stel de tijid in en tik op Start.

+ Tik op Pauze om de timer te onderbreken. Tik op Hervat om de
timer te hervatten.

3 Tik op Stoppen om het timeralarm te stoppen.

Stopwatch
U kunt de stopwatch gebruiken om een rondetijd vast te leggen.
1 Tik op het homescreen op Hoofdzaken > Klok > Stopwatch.
2 Tik op Start om de stopwatch te starten.

+ Als u een rondetijd wilt vastleggen, tikt u op Ronde.

3 Tik op Pauze om de stopwatch te onderbreken.
+ Als u de stopwatch wilt hervatten, tikt u op Hervat.

+ Als u alle records wilt wissen en de stopwatch opnieuw wilt starten,
tikt u op Reset.
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Muziek

U kunt nummers of muziekalbums afspelen en beheren.
1 Tik op het homescreen op Hoofdzaken > Muziek.
2 Selecteer een categorie.

3 Selecteer een muziekbestand.
Schakel de flitslicht in/uit.

Stel geluidseffecten in.

Ga terug naar het vorige — «—— Open extra opties.
scherm.

— Pauzeer of speel af.

Tik om vanaf het begin van — — Tik om het volgende bestand
het huidige bestand af te af te spelen / Houd hierop uw
spelen / Tik dubbel om het vinger om vooruit te spoelen.

vorige bestand af te spelen /
Houd hierop uw vinger om
terug te spoelen.

L.

Speel in willekeurige volgorde — L— Selecteer een herhaalmodus.

af.

Pas het volume aan. —e «— Ga naar Nu afspeellijst.

Toevoegen aan of verwijderen —— |
uit uw favorieten.
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« Afhankelijk van de geinstalleerde software worden bepaalde

bestandsindelingen mogelijk niet ondersteund.

« Bestanden die groter zijn dan de maximale bestandsgrootte kunnen een

fout veroorzaken.

« Muziekbestanden zijn mogelijk beveiligd door de eigenaren van het

internationaal auteursrecht of de auteursrechtelijke wetgeving. Voordat
u een muziekbestand kopieert, moet u wettelijke toestemming hebben.
Controleer eerst de auteursrechtelijke wetgeving van het desbetreffende
land alvorens een muziekbestand te downloaden of te kopiéren.

- Dit model ondersteunt het afspelen van Hi-Fi-audio. Bij Hi-Fi-

audiobestanden wordt het Hi-Fi-pictogram weergegeven.

- Indien u het flitslicht instelt, blinkt het flitslicht en stemt overeen met de

muziek die afgespeeld wordt.

Rekenmachine

U kunt twee soorten rekenmachines gebruiken: de gewone rekenmachine
en de wetenschappelijke rekenmachine.

1 Tik op het homescreen op Hoofdzaken > Rekenmachine.

2 Gebruik het toetsenblok om een berekening uit te voeren.
- Indien u wilt berekenen vanaf het begin, houd (] ingedrukt.

ThinQ

U kunt het product eenvoudig verbinden met lol-apparaten om de
apparaten te bewaken en op een handige manier te gebruiken.

Tik op het homescreen op Hoofdzaken > ThinQ

E

« Wasmachine, droogkast, styler, vaatwasser; oven en robotreiniger

kunnen enkel geregistreerd worden als het product in de standbymodus
is.

« Zoek het ThinQ merkteken op het product om te zien of het verbonden

kan worden met de ThinQ app.

- Tik op = om verschillende functies te controleren van de ThinQ app.
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LG Health

U kunt uw gezondheid beheren en goede gewoontes op het gebied van
lichaamsbeweging onderhouden door uw trainingen bij te houden.

Aan de slag met LG Health

U kunt LG Health configureren wanneer u de app voor het eerst start of
nadat u de app hebt gereset.

1 Tik op het homescreen op Hoofdzaken > LG Health.

2 Volg de instructies op het scherm om de configuratie te voltooien.

LG Health gebruiken

U kunt de belangrijkste informatie over LG Health bekijken en het aantal
fysieke inspanningen en informatie over uw gezondheid beheren.

1 Tik op het homescreen op Hoofdzaken > LG Health.
2 De volgende mogelijkheden zijn beschikbaar.
+ = :Bekijk de gewenste dag in uw trainingslogboek.

- © :Begin een training bij te houden. De route en het aantal fysieke
inspanningen worden voor elk type training vastgelegd.

« + :Stel uw dagelijkse trainingsdoelen in, zoals calorieén en stappen,
of stel diverse LG Health- instellingen in.

E + De gezondheidsinformatie die wordt geleverd door LG Health is bedoeld
voor het gemak van de gebruiker en mag niet worden gebruikt voor
ziektepreventie, behandelingen, diagnoses of andere medische kwesties.

- Afhankelijk van het land en de serviceprovider is LG Health mogelijk
verschillend of niet beschikbaar. De beschikbare functies van LG Health
en de apps die aan LG Health kunnen worden toegevoegd, kunnen

naargelang het land verschillen. Dit is te wijten aan een verschillende
wet- en regelgeving.
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HD-audiorecoder

De HD-audiorecorder laat u de audio-instellingen handmatig instellen
zodat u audio kunt opnemen op basis van uw omgeving.

Opnamemodi

U kunt een High Definition audiobestand opnemen door de gewenste
audiomodus te selecteren en in te stellen die geschikt is voor de
omgeving.

Tik op het homescreen op Hoofdzaken > HD- audiorecorder >=.

Normaal

U kunt audio opnemen zonder extra instellingen.

ASMR
U kunt ASMR geluid opnemen

Concert

U kunt audio opnemen bij een concert of ander muziekevenement.

Aangepast

U kunt handmatig te gewenste instellingen aanpassen om audio op te
nemen.

Studiomodus

Met Studiomodus kunt u een audiobestand of muziek afspelen en

tegelijkertijd uw stem opnemen, een akkoord maken door uw stem
diverse malen op te nemen, en uw opmerkingen over het originele

audiobestand van de presenator of spreker opnemen.

1 Tik op het homescreen op Hoofdzaken > HD- audiorecoder > =>
Aangepast.

Tikop d4
Selecteer een audiobestand om te gebruiken als achtergrondmuziek.

Tik op @ om spraak op te nemen.

u b wWwN

Tik op @ om het opnamebestand op te slaan.
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E -+ Wallpapermuziek kan alleen via de oordopjes worden afgespeeld. Zorg
ervoor dat u de oordopjes aansluit voordat u deze functie gebruikt.

- Om extra instellingen te wijzigen, tikt uop + > Opties, past u
vervolgens het bestandstype, bitdiepte, bemonsteringsfrequentie en
andere instellingen aan.

« Als u de modus Concert of Custom selecteert met oortelefoontjes
aangesloten, @° verschijnt. Tik op 1(.]# en selecteer de te gebruiken
microfoon.

« Ukunt de geluidskwaliteit met het aangesloten oortje bewaken terwijl u
audio opneemt. \WWanneer u een opname maakt in Studiomodus, wordt
audiobewaking niet ondersteund. U kunt alleen de achtergrondmuziek
horen.

Game Launcher

U kunt instellen of u de game launcher gebruikt waar u de lijst

met spellen kunt bekijken die geinstalleerd zijn op het product en
spelinstellingen selecteren zoals het dempen van het mediavolume,
alarmen beperken, enz.

1 Tik op het homescreen op Game Launcher.

2 Selecteer de gewenste optie.

Smart Doctor

U kunt Smart Doctor gebruiken om problemen met het toestel vast te
stellen en het toestel te optimaliseren.

Tik op het homescreen op Management > Smart Doctor.
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LG Mobile Switch

Zet via LG Mobile Switch eenvoudig gegevens over van een gebruikt
toestel naar een nieuw toestel.

1 Tik op het homescreen op Beheer > LG Mobile Switch.
U kunt ook tikken op Instellingen > Systeem > Back-up > LG Mobile
Switch.
- Indien de app niet geinstalleerd is op het product, download en
installeer de LG Mobile Switch app vanuit Google Play Store.

2 Volgen de instructies op het scherm om een gewenste methode voor
overzetten te selecteren.

E + Er wordt geen back-up gemaakt van gegevens in een Google-Account.
Wanneer u uw Google-account synchroniseert, worden de Google-
contacten, Google-agenda, gegevens van de app Google memo en apps
die u hebt gedownload vanaf de Play Store automatisch bewaard in de
app Drive.

+ Laad de batterij volledig op voordat u gegevens overzet zodat het
toestel tijdens deze processen niet wordt uitgeschakeld.

App-prullenbak

U kunt de lijst zien van verwijderde apps op het homescreen. De app die
verwijderd werd binnen 24 uur kan gerecupereerd worden.

Tik op het homescreen op Management > App-prullenbak.

Voor meer details, lees App-prullenbak.
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SmartWorld

U kunt talloze games, audio, apps en lettertypen van LG Electronics
downloaden. Pas uw toestel naar wens aan door middel van thema's voor
het homescreen en lettertypen.

E + Afhankelijk van uw abonnement worden mogelijk kosten in rekening
gebracht als u mobiele data gebruikt.

+ Afhankelijk van de regio of de serviceprovider wordt deze functie
mogelijk niet ondersteund.

1 Tik op het homescreen op Services > SmartWorld.
2 Tik op * >LG Accounts en meld u aan.

3 Selecteer en download de gewenste inhoud.

SmartWorld downloaden

Als de app SmartWorld niet is geinstalleerd, volgt u deze stappen om de
app te downloaden.

1 Tik op het homescreen op Instellingen > Systeem > Update center >
Applicatie updaten.

7 Selecteer SmartWorld in de lijst en tik op Downloaden.
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RemoteCall Service

Het toestel kan op afstand worden gecontroleerd om problemen op te
lossen. Bel eerst naar de klantenservice van LG als volgt:

5 + Als u deze functie wilt gebruiken, moet u eerst akkoord gaan met het
gebruik van de functie.

+ Afhankelijk van uw abonnement worden mogelijk kosten in rekening
gebracht als u mobiele data gebruikt.

1 Tik op het homescreen op Services > RemoteCall Service.
7 Bel de klantenservice van LG.

3 Volg de instructies van de medewerker van de klantenservice om een
zescijferig toegangsnummer in te voeren.

- Er wordt op afstand verbinding gemaakt met het toestel en de
externe ondersteuning wordt gestart.

Cell Broadcast

U kunt realtime ooverheidsmeldingen zoals NL-alert voor noodsituaties
bekijken, zoals voor tyfoons, overstromingen en aardbevingen.

Tik op het homescreen op Services > Cell Broadcast.
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Google-apps

U kunt Google-apps gebruiken door een Google-Account in te stellen.
Het registratievenster voor het Google-Account verschijnt automatisch
wanneer u een Google-app voor het eerst gebruikt. Als u geen Google-
Account hebt, maakt u er een aan op uw toestel. Voor meer informatie
over hoe u een app gebruikt, raadpleegt u de Help in de app.

5 + Afhankelijk van de regio of de serviceprovider werken bepaalde apps
mogelijk niet.

Agenda

Met de Agenda-app kunt u uw planning (die u hebt gemaakt) bijhouden.
De agenda is georganiseerd per dag, per 3 dagen, per week of per maand.

Chrome

Een snelle, eenvoudige en veilige webbrowser, gebouwd voor het
moderne web.

Documenten

Documenten is een hulpmiddel voor samenwerking, tekstverwerking
dat de productiviteit stimuleert. Gebruik Documenten om in realtime te
maken, bewerken en samenwerken.

Drive

Drive is een app voor het opslaan en delen van bestanden waarmee u
projecten eenvoudig overal vandaan kunt vinden, delen en eraan kunt
samenwerken.

Duo

Maak eenvoudige, hoogwaardige videogesprekken met je vrienden en
familie op Android-telefoons en iPhones.

Gmail

Gmail is een eenvoudig te gebruiken e-mail-app die je berichten bewaart,
je inbox slimmer maakt en je helpt georganiseerd te blijven.
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Google

De Google-app geeft u informatie over de dingen waar u om geeft. Vind
snel antwoorden, ontdek uw interesses en ontvang feeds voor verhalen
en updates over onderwerpen die u belangrijk vindt.

Maps

Ga je ergens heen? Ga met Kaarten, de app waarop u kunt vertrouwen op
real-time GPS-navigatie, verkeer, doorvoer en voor meer informatie over
miljoenen plaatsen, zoals recensies en populaire tijden.

Foto's

Home voor al je foto's en video's wordt automatisch geregeld, zodat je
kunt delen en opslaan wat belangrijk is.

Play Films

Gebruik uw Google-Account om films te huren of te kopen. Koop
materiaal en speel het overal af.

YT Music

Een nieuwe muziekstreaming service van YouTube.

Spreadsheets

Sheet is een collaborative spreadsheet processing tool die de
productiviteit kracht bijzet. Gebruik het blad om informatie in realtime te
importeren, organiseren en analyseren.

Presentaties

Google Presentaties is een tool voor het samenstellen van presentaties
die de productiviteit mogelijk maken. Gebruik dia's om meldingen te
organiseren, resultaten te presenteren en real-time beslissingen te
nemen.

YouTube

Bekijk uw favoriete kanalen, luister naar muziek waar u van houdt en
upload video's om die te delen met mensen over de hele wereld.
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Assistent

Op je apparaat is Google Assistent ingebouwd. Vind antwoorden en maak
dingen gedaan tijdens het lopen. Tik om aan de slag te gaan op de Google
Assistent-toets aan de zijkant van de telefoon of houd de startknop van
de telefoon ingedrukt.

E + Google Assistent is niet beschikbaar in sommige talen en landen.

Files
U kunt bestanden die zijn opgeslagen op uw toestel bekijken en beheren.
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Instellingen
U kunt de apparaatinstellingen naar wens aanpassen.

Tik op het homescreen op Instellingen.

E + Indien u een sleutelwoord invoert in het zoekvenster bovenaan het
scherm, kunt u gemakkelijk de items opstarten die moeten ingesteld
worden.

Netwerk & internet

Wi-Fi

U kunt via een Wi-Fi-netwerk verbinding maken met apparaten in de
buurt.

Verbinding maken met een Wi-Fi-netwerk

1 Tikin hetinstellingenscherm op Netwerk & internet > Wi-Fi.

2 Tikop om deze functie te activeren.
« De beschikbare Wi-Fi-netwerken verschijnen automatisch.

3 Selecteer een netwerk.

- U moet wellicht het wachtwoord van het Wi-Fi-netwerk invoeren.

+ Het toestel slaat deze stap over als u verbinding maakt met eerder
verbonden Wi-Fi-netwerken. Als u niet automatisch wilt verbinden
met een bepaald Wi-Fi-netwerk, tik dan op het netwerk en tik op
Netwerk vergeten.
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Instellingen van Wi-Fi-netwerk
Tik in het instellingenscherm op Netwerk & internet > Wi-Fi.

- Overschakelen naar mobiele data: Als mobiele data is geactiveerd
maar het toestel geen verbinding met het internet kan maken via
Wi-Fi, maakt het toestel automatisch verbinding met het internet via
mobiele data.

E + Deze functie is afhankelijk van de serviceprovider.

-+ :Pas de instellingen van het Wi-Fi-netwerk aan.

Wi-Fi Direct

U kunt uw toestel verbinden met andere apparaten die Wi-Fi Direct
ondersteunen om rechtstreeks met deze apparaten gegevens te delen.
U hebt geen toegangspunt nodig. Met Wi-Fi Direct kunt u verbinding
maken met meer dan twee apparaten.

1 Tik op het scherm met de instellingen achtereenvolgens op Netwerk
& internet > Wi-Fi > : > Geavanceerd > Wi-Fi Direct.

- Apparaten in de buurt met ondersteuning voor Wi-Fi Direct
verschijnen automatisch.

7 Selecteer een apparaat.
+ De verbinding wordt gemaakt wanneer het apparaat het verzoek
accepteert.

E « Bij gebruik van Wi-Fi Direct kan de batterij sneller leeglopen.
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Dataverbinding

U kunt mobiele data in- en uitschakelen. Bovendien kunt u ook het
gebruik van mobiele data beheren.

Mobiele data inschakelen

1 Tik in hetinstellingenscherm op Netwerk & internet >
Dataverbinding.

2 Tikop om deze functie te activeren.

Instellingen van mobiele data aanpassen

1 Tik in hetinstellingenscherm op Netwerk & internet >
Dataverbinding.
7 Pas de volgende instellingen aan:

- Aan:stel in om dataverbindingen in mobiele netwerken te
gebruiken.

- Mobiele datalimiet: stel een limiet voor het gebruik van mobiele
data in om mobiele data te blokkeren als de limiet is bereikt.

- ¢ :Pas de instellingen van mobiele data aan.

+ Het volume van gegevensgebruik wordt gemeten op basis van het
product, en het volume berekend door uw mobiele provider kan
verschillend zijn.

Oproep
U kunt de oproepinstellingen aanpassen, zoals de opties voor
audiogesprekken en internationale gesprekken.

E + Afhankelijk van de regio of de serviceprovider worden bepaalde functies
mogelijk niet ondersteund.

1 Tikin het instellingenscherm op Netwerk & internet > Oproep.

7 Pas de instellingen aan.
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Tetheren

USB-tethering

U kunt het toestel via USB aansluiten op een ander apparaat en mobiele
data delen.

T Sluit de apparaten op elkaar aan met behulp van een USB-kabel.

2 Tikin het instellingenscherm op Netwerk & internet > Tetheren >
USB-tethering en tik vervolgens op (7)) om dit te activeren.

E + Deze optie gebruikt mobiele data en afhankelijk van uw tarief kunnen
hieraan kosten verbonden zijn. Raadpleeg uw provider voor meer
informatie.

+ Na de aansluiting op een computer downloadt u het USB-
stuurprogramma vanaf wwwi.lg.com en installeert u het op de computer.

- U kunt geen bestanden uitwisselen tussen uw toestel en een computer
terwijl USB-tethering is ingeschakeld. Schakel USB-tethering uit om
bestanden uit te wisselen.

+ Besturingssystemen met ondersteuning voor tethering zijn Windows
XP of hoger, of Linux.

Wi-Fi hotspot
U kunt het toestel als draadloze router instellen zodat andere apparaten

verbinding kunnen maken met het internet via de mobiele data van uw
toestel.

1 Tik in het scherm met instellingen op Netwerk & internet > Tetheren
> Wi-Fi hotspot en tik vervolgens op (1) ) om de functie te activeren.

2 Tik op Wi-Fi hotspot instellen en voer de Wi-Fi-naam (SSID) en het
wachtwoord van het Wi-Fi-netwerk in.

3 Schakel Wi-Fi op het andere toestel in en selecteer de naam van het
netwerk van het toestel in de lijst met Wi-Fi-netwerken.

/I Voer het wachtwoord van het netwerk in.
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E + Deze optie gebruikt mobiele data en afhankelijk van uw tarief kunnen
hieraan kosten verbonden zijn. Raadpleeg uw provider voor meer
informatie.

+ Kijk voor meer informatie op deze website:
http//www.android.com/tether#wifi

Uitschakeltimer Wi-Fi hotspot

Als het Wi-Fi hotspot gedurende een bepaalde tijd niet is gebruikt,
wordt de verbinding automatisch verbroken. U kunt instellen wanneer de
verbinding automatisch verbroken wordt.

Bluetooth-tethering

Een toestel dat via Bluetooth is verbonden, kan verbinding maken met

het Internet via de mobiele data van uw toestel.

1 Tikin het instellingenscherm op Netwerk & internet > Tetheren >
Bluetooth-tethering en tik vervolgens op (1)) om dit te activeren.

2 Schakel Bluetooth in op beide apparaten en koppel ze.

E + Deze optie gebruikt mobiele data en afhankelijk van uw tarief kunnen
hieraan kosten verbonden zijn. Raadpleeg uw provider voor meer
informatie.

+ Kijk voor meer informatie op deze website:
http//www.android.com/tether#Bluetooth_tethering

Help
U kunt hulp bij het gebruik van tethering en hotspots vragen.

Tik op het scherm met de instellingen op Netwerk & Internet > Tetheren
> Help.
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Flightmode

U kunt inkomende en uitgaande oproepen en mobiele data uitschakelen.
Wanneer deze modus is ingeschakeld, kunt u nog steeds andere functies
gebruiken die geen data vereisen, zoals games en muziek.

1 Tikin het instellingenscherm op Netwerk & internet > Flightmode.

2 Tik op Aanzetten in het bevestigingsscherm.

Mobiele netwerken

U kunt de instellingen van het mobiele netwerk aanpassen.

1 Tik in hetinstellingenscherm op Netwerk & internet > Mobiele
netwerken.

7 Pas de volgende instellingen aan:
- Data-roaming: surf op het internet, verstuur en ontvang e-mails

en multimediaberichten en gebruik andere dataservices in het
buitenland.

- Netwerkmodus: Selecteer een netwerktype.

- Toegangspunten: bekijk of wijzig het toegangspunt voor het
gebruik van mobiele dataservices. Als u het toegangspunt wilt
wijzigen, maakt u uw keuze uit de lijst met toegangspunten.

+ Mobiele providers: zoek netwerkproviders en maak automatisch
verbinding met een netwerk.
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VPN

U kunt verbinding maken met een veilig virtueel netwerk, zoals een
intranet. U kunt ook verbonden virtuele particuliere netwerken beheren.
VPN-netwerken toevoegen

1 Tikin het instellingenscherm op Netwerk & internet > VPN.

2 Tikop—+

E + Deze functie is alleen beschikbaar wanneer het lockscreen is
ingeschakeld. Als het lockscreen is uitgeschakeld, verschijnt een scherm
met een notificatie. Tik in het scherm met de notificatie op Wijzig om
de schermvergrendeling in te schakelen. Zie Een schermvergrendeling
instellen voor details.

3 Voer de gegevens van het VPN-netwerk in en tik op Opslaan.

VPN-instellingen configureren
1 Tik op een VPN in de lijst VPNS.

2 Voer de accountgegevens van de VPN-gebruiker in en tik op
Verbinden.

+ Schakel het selectievakje Bewaar account informatie in om de
accountgegevens op te slaan.

Private DNS
U kunt de Private DNS configureren (Domein Naam Systeem) opties.
1 Tikin hetinstellingenscherm op Netwerk & internet > Private DNS.

2 Selecteer de gewenste optie en tik op Opslaan.
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Aangesloten apparaten

Bluetooth

U kunt uw toestel verbinden met apparaten in de buurt die Bluetooth
ondersteunen om met deze apparaten gegevens uit te wisselen. Sluit uw
toestel aan op een Bluetooth-headset en -toetsenbord. Hierdoor kan het
toestel eenvoudiger worden bediend.

Koppelen met een ander apparaat

1 Tik op het scherm met de instellingen op Aangesloten apparaten >
Bluetooth.

2 Tikop om deze functie te activeren.
+ De beschikbare apparaten verschijnen automatisch.
« Tik op () om de lijst met apparaten te vernieuwen.

E + In de lijst verschijnen alleen apparaten die als zichtbaar zijn ingesteld.

3 Selecteer een apparaat in de lijst.
4 Volg de instructies op het scherm om de identiteitscontrole uit te voeren.

E + Deze stap wordt overgeslagen op apparaten waarmee eerder verbinding
is gemaakt.

Gegevens versturen via Bluetooth

1 Selecteer een bestand.
U kunt multimediabestanden of contacten versturen.

2 Tik op <& > Bluetooth.

3 Selecteer een doelapparaat voor het bestand.
+ Het bestand wordt verstuurd wanneer het doelapparaat het accepteert.

E + Afhankelijk van het bestand kan het proces voor het delen van
bestanden verschillen.
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Scherm delen

U kunt het scherm en het geluid van het toestel weergeven en afspelen
op een ander toestel (zoals een tv) dat de Miracast-functie ondersteunt.

1 Tik op het scherm met de instellingen op Aangesloten apparaten >
Scherm delen.

2 Tikop ()) om deze functie te activeren.

3 Selecteer een toestel in de lijst met apparaten in de buurt.

« Als het gewenste apparaat niet verschijnt, tikt u op Zoeken om de
lijst te vernieuwen.

+ Na de verbinding met het apparaat geeft dat apparaat het scherm
van uw toestel weer.

E + Schermdeling wordt automatisch uitgeschakeld als er zich geen
apparaat waarmee het scherm kan worden gedeeld in de buurt bevindt.

NFC

U kunt het toestel als een vervoerspas of een creditcard gebruiken. U
kunt gegevens ook delen met het andere toestel.

1 Tik op het scherm met de instellingen op Aangesloten apparaten >
NFC.
2 Tikop (1)) om deze functie te activeren.

- Raak uw toestel aan met een ander apparaat dat NFC ondersteunt
om gegevens te delen.

E « Afhankelijk van het type toestel bevindt de NFC-antenne zich op
een andere locatie. Raadpleeg Overzicht van onderdelen voor meer
informatie over het NFC-antennegebied.
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Deelvenster

U kunt inhoud delen uit de Galerij, Muziek- en Bestands beheerder
met apparaten in de buurt. U kunt de inhoud ook delen met specifieke
mensen in apps die met Google Direct Share werken.

1 Tik op het scherm met de instellingen op Aangesloten apparaten >
Deelvenster.
2 Tik op @  om elke optie te activeren.

- Apparaten in de buurt: U kunt de toestellen in de buurt
weergeven waarnaar u contents kan delen in de apps Galerij,
Muziek, en bestandsbeheerder.

- Rechtstreeks delen: Vanuit een app die Google Direct Share
ondersteunt, kunt u een pictogram weergeven waardoor u contents
kunt delen met bepaalde personen.

Bestand delen

U kunt bestanden uitwisselen tussen uw toestel en andere apparaten of
tablets van LG.

T In het instellingenscherm tik op Aangesloten apparaten > Bestand
delen.

7 Pas de volgende instellingen aan:
+ VELVET: wijzig de naam van het toestel.

+ Opslaan op:stel de doelmap in voor het opslaan van bestanden die
vanaf andere apparaten zijn verstuurd.

- Bestand delen: sta de ontvangst van bestanden vanaf andere
apparaten toe.

- SmartShare Beam: deel bestanden met andere apparaten via
SmartShare Beam.

+ Help: U kunt hulp bij het delen van bestanden vragen.
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Mediaserver

U kunt media op uw toestel delen met apparaten in de buurt die DLNA
ondersteunen.

1 Tik op het scherm met de instellingen op Aangesloten apparaten >
Mediaserver.
7 Pas de volgende instellingen aan:

- Het delen van content: deel de inhoud van uw toestel met
apparaten in de buurt.

.

VELVET: stel de naam van uw toestel in.

E + Afhankelijk van het product van de gebruiker, kunnen de namen van de
menu’s verschillend verschijnen.

+ Mijn gedeelde inhoud: selecteer het type media dat u met andere
apparaten wilt delen.

- Toegestane apparaten: bekijk een lijst met apparaten die toegang
hebben tot de inhoud van uw toestel.

- Niet-toegestane apparaten: bekijk een lijst met apparaten die
geen toegang hebben tot de inhoud van uw toestel.

Afdrukken

U kunt uw toestel verbinden met een Bluetooth-printer en foto's of
documenten op het toestel afdrukken.

Tik op het scherm met de instellingen op Aangesloten apparaten >
Afdrukken.

- Tik op Standaard afdrukservice om te zoeken naar printers waarmee
u verbinding kan maken. Of tik op ¢ > Printer toevoegen om
handmatig een printer toe te voegen.

- Tik op (4) Service toevoegen om de gewenste printer app te downloaden.

5 - Dit is enkel beschikbaar als het mobiele netwerk of de functie bluetooth
ingeschakeld is.

- Om de printer app te downloaden in () Service toevoegen, moet u
eerst inloggen in uw Google account.
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Geluid

U kunt de instellingen voor geluid, trillen en notificaties aanpassen.

Tik op het scherm met de instellingen op Geluid en pas de volgende
instellingen aan:

- Profielen: Wijzig de geluidsmodus naar Geluid, Alleen trilfunctie of
Stil.

Volume: pas het volume voor verschillende items aan.

- Beltoon: selecteer een beltoon voor inkomende oproepen. Voeg
beltonen toe of verwijder ze.

Notificatie geluid: selecteer een beltoon voor notificaties. Stel muziek

die is opgeslagen op het toestel in als beltoon voor notificaties.

- Beltoon met trillen: stel het toestel in om tegelijkertijd te trillen en
een beltoon af te spelen.

- Beltoon voor contact: maak een beltoon voor een inkomende oproep
van een bepaald contact.

- Flitser-waarschuwing voor binnenkomende oproep: Stel in om te

knipperen volgens de LG-ringtone.

Prioriteit: stel in wanneer en van welk type app u notificaties wilt
ontvangen. Ontvang notificaties op specifieke dagen van de week.

Geluidskwaliteit en effecten: Gebruik de functie om de
geluidskwaliteit en effecten in te stellen tijdens het afspelen van een
nummer of video.

- Volume: pas het volume voor verschillende items aan.

- Volume normaliseren: Gebruik de functie om de hoeveelheid
verschillende geluidsbronnen te normaliseren.

- Equalizer: Gebruik de functie om de equalizer-instellingen aan te
passen.

- LG 3D Sound Engine: Gebruik de functie om muziek of video
af te spelen in een driedimensionaal, meeslepend en levendig
geluid wanneer oortelefoons, luidsprekers of andere externe
audioapparaten zijn aangesloten. Zie LG 3D Sound Engine voor
details.
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- Live bijschrift: Stel het apparaat in om de stem te detecteren in de
media en automatisch ondertitels te genereren.

- Trilsterkte: pas de trilintensiteit aan.

« Triltype: U kunt het triltype voor het ontvangen van oproepen
selecteren.

- Trillen bij het aantikken: Stel het toestel in om te trillen wanneer u op
bepaalde onderdelen van het scherm tikt.

- Telefoontoetsen-geluid: Selecteer geluidseffect toetsenblok.
- LG-Toetsenbordgeluid: Selecteer geluidseffect LG toetsenbord.

- Touchtoon: Selecteer een geluidseffect om een onderwerp in te
tikken.

+ Schermblokkeringstoon: Selecteer een geluidseffect als het scherm
al dan niet vergrendeld is.

Notificaties

U kunt een lijst van geinstalleerde apps controleren, en de instellingen
voor kennisgevingen configureren.

1 Tik in het instellingenscherm op Kennisgevingen.

2 Pas de instellingen aan zoals gewenst.
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Weergave

U kunt gedetailleerde instellingen aanpassen voor elk type scherm.

Tik op het scherm met de instellingen op Weergave en pas de volgende
instellingen aan:

- Homescreen: pas de instellingen voor het homescreen aan. Zie
Homescreen-instellingen voor details.

- Navigatie balk: Stel de stijl van de Navigatiebalk in met Gebaren of
Alleen knoppen. U kunt ook de toetscombinatie wijzigen als u Alleen
knoppen instelt als een stijl van de Navigatiebalk. Voor meer informatie
zie Navigatie balk.

- Statusbalk: Stel de kleur van de statusbalk in bovenaan het scherm, of
stel de weergave van het notificatiepictogram en de weergave van het
batterijpercentage in.

- AOD (always-on display): Geef altijd informatie weer, zoals de datum,
tijd en notificaties, zelfs als het scherm is uitgeschakeld. Voor meer
informatie zie AOD (always-on display).

- Comfortabele weergave: Stel het toestel in om de hoeveelheid blauw
licht op het scherm te verminderen om de ogen minder te vermoeien.

E - Deze functie is niet beschikbaar als het toestel gekoppeld is met het LG
Dual Screen (LM-G905N).

- Nachtmodus: U kunt een gedimd schermthema toepassen om
flikkering te vermijden op het scherm tijdens de nacht.

+ Schermkleur: Pas de kleur, kleurtemperatuur aan voor het gewenste
scherm.

E - Tik op*©) om de instellingen opnieuw in te stellen.

- Video versterker: Als u een video afspeelt in de modus hele scherm,
kunt u de instellingen voor helderder en dynamischer kleurweergave
wijzigen.

- Lettertype: Verander het formaat, of het lettertype.
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- Accent kleur: Wijzig de indicatiekleur voor opties, menu'’s, notificatie
vensters, enz.

+ Scherm formaat: Stel de onderdelen op het scherm in op een formaat
zodat u ze gemakkelijk kunt zien. Enkele onderdelen kunnen van plaats
wijzigen.

+ Apps volledig scherm: Pas de schermgrootte van de apps aan.

+ Helderheid: Gebruik de schuifbalk om de helderheid van het scherm
van het toestel te wijzigen. Als u de helderheid van het scherm
automatisch aan het omgevingslicht wilt aanpassen, tikt u op de
Auto-schakelaar.

+ Auto: Stel het toestel zodanig in dat de helderheid van het scherm
automatisch wordt aangepast volgens de intensiteit van het
omgevingslicht.

- Time-out scherm: schakel het scherm automatisch uit wanneer het
toestel gedurende een bepaalde tijd niet wordt gebruikt.

- Automatische schermrotatie: draai het scherm automatisch
naargelang de stand van het toestel.

+ Screensaver: Geef een schermbeveiliging weer wanneer het toestel
in de houder of lader staat. Selecteer het type schermbeveiliging dat u
wilt weergeven.

- Enkelhandig scherm: Maak de schermgrootte kleiner om het

apparaat gemakkelijk met één hand te gebruiken. Sleep de touchtoets
onderaan het scherm naar links of rechts.

Achtergrond & Thema

U kunt de achtergrond, schermthema, stijl van het pictogram of AOD
(Always-on display) selecteren voor uw toestel.

1 Tik in het instellingenscherm op Achtergrond & Thema.

2 Tik op Achtergrond, Thema, Pictogram, of AOD om de opties aan te
passen.
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Lockscreen & beveiliging

U kunt de instellingen van het vergrendelscherm en de veiligheid
aanpassen.

1 Tik op het scherm met de instellingen op Lockscreen & beveiliging.

7 Pas de instellingen aan.

- Google Play Protect: Scant uw apparaat elke dag op potentieel
schadelijke toepassingen.

+ Vind mijn apparaat: Spoor de locatie van mijn apparaat op vanop
afstand. U kunt ook uw gegevens veilig beschermen indien u uw
toestel verloren bent.

- Beveiligingsupdate: Controleer op software-update en configureer
automatisch de instellingen van de installatie.

- Kies scherm slot: selecteer de gewenste methode voor de
schermvergrendeling. Zie Een schermvergrendeling instellen voor
details.

- Lockscreen aanpassen: Wijzig de informatie afgebeeld op het
vergrendelde scherm.

- Veilige vergrendelingsinstellingen: Wijzig de beveiliging voor de
instellingen voor de vergrendeling.

+ Vingerafdrukken: ontgrendel het scherm of de inhoud met uw
vingerafdruk. Zie Overzicht van vingerafdrukherkenning voor details.

- Contentvergrendeling: Hiermee kunt u een vergrendelingstype
instellen (wachtwoord of patroon) voor uw Galerijbestanden.
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- Encryptie & persoonsgegevens: Configureer de instellingen voor
de codering en gegevens van de SD-kaart.
- Encrypt microSD: Codeer de geheugenkaart zodat deze
niet op een ander toestel kan worden gebruikt. Zie Codering
geheugenkaart voor details.

Gegevensbeveiliging: bekijk het type opslag waar het
beveiligingscertificaat wordt opgeslagen.

Vertrouwde referenties: Bekijk de root CA certificaten en
de door de gebruiker geinstalleerde CA-certificaten van uw
systeem.

Gegevens gebruiken: Bekijk en wijzig beveiligde
certificaatinformatie opgeslagen in uw toestel.

Installeer vanuit opslagruimte: Installeer een beveiligd
certificaat vanuit een opslag.

- Opslag wissen: Wis door de gebruiker geinstalleerde beveiligde
certificaten en aanverwante gegevens.

- Apparaatbeheerders: stel bevoegdheden in om de bediening of het
gebruik van het toestel te beperken tot bepaalde apps.

- Trust agents: bekijk en gebruik de trust agents die op het toestel
zijn geinstalleerd.

+ Scherm pinnen: vergrendel het scherm van de app zodat alleen de
actieve app kan worden gebruikt.

- Gebruikstoegang: bekijk gegevens over het gebruik van apps op
het toestel.
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Privacy

U kunt al uw privacy-instellingen vinden en aanpassen.
1 Tik in hetinstellingenscherm op Privacy.

7 Pas deinstellingen aan.

- App-rechten manager: Biedt de mogelijkheid om de toelatingen
verleend aan de apps, te controleren en te wijzigen.

- Lockscreen: Hiermee kunt u de vertonen meldingen instellen op
het vergrendelingsscherm.

+ Maak wachtwoorden zichtbaar: Schakel deze optie in om elk
teken van het wachtwoord kort te bekijken terwijl u het intikt zodat
u kunt zien wat u ingevoerd hebt.

- Personaliseringsdiensten Apparaat: Biedt u de mogelijkheid
om een suggestie te krijgen op basis van gebruikers, apps en
interactieve inhoud.

- Google-service voor automatisch aanvullen: Schakel deze optie
in om uw informatie in te voeren die opgeslagen is in uw account
zoals wachtwoord, adres, of nummer van uw credit card met één
enkele klik. U kunt deze optie ook uitschakelen, gebruik de functie
Google Autocomplete, of voeg een nieuwe service-account toe.

- Locatiegeschiedenis van Google: Hiermee kunt u de
Locatiehistoriek in- of uitschakelen. Indien ingeschakeld, gebruikt en
slaat Google periodiek de recentste locatiedata van uw telefoon op
in verband met uw Google Account.

Vanuit het scherm Locatiehistoriek, tik op ¢ om uw locatiedata te
bekijken en/of te beheren.

- Activiteitsregelingen: Selecteer activiteiten en informatie die u
wenst op te slaan met Google.

+ Advertenties: Hiermee kunt u de advertising ID controleren en de
gepersonaliseerde advertenties instellen.

+ Gebruik en diagnostische gegevens: Schakel deze optie in om de
Android-ervaring te helpen verbeteren door automatisch diagnose,
apparaat en app gebruiksdata naar Google te verzenden.
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Locatie

U kunt controleren hoe uw locatie-informatie gedeeld wordt en de
toelating configureren voor toegang tot uw locatie-informatie.

Tik op het scherm met de instellingen op Locatie en stel de gewenste
functie in..

Uitbreidingen

Smart Doctor

U kunt Smart Doctor gebruiken om problemen met het toestel vast te
stellen en het toestel te optimaliseren.

Tik op het scherm met de instellingen op Uitbreidingen > Smart Doctor.

Context Awareness

U kunt de apparaatinstellingen automatisch wijzigen naargelang uw
gebruikspatroon en locatie.

1 Tik op het scherm met de instellingen op Uitbreidingen > Context
Awareness.

7 Activeer de items waarvoor u automatisch instellingen wilt wijzigen.
+ GEAUTOMATISEERD: U kunt instellen dat het apparaat het
geluidsprofiel, Bluetooth- en Wi-Fi-opties automatisch wijzigt
in verschillende omgevingen, zoals Thuis, Niet thuis, Op het werk
en Niet op het werk. U kunt ook instellen dat er een app wordt
geopend als u oortelefoons aansluit of er verbinding is met een
Bluetooth-apparaat.

E + Om deze functie te gebruiken moet de locatie thuis of werk vooraf
worden ingesteld in Mijn locaties. Tik op het scherm met de instellingen
op Locatie > Mijn plaatsen om de locaties in te stellen.
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Gepersonaliseerde service

U kunt intelligente resultaten bekomen als u geintegreerd zoeken

gebruikt.

1 Tik in hetinstellingenscherm op Uitbreidingen > Gepersonaliseerde
service.

2 Tikop () om het te activeren.

Gaming
U kunt de instellingen aanpassen voor game tools, grafische afbeeldingen
en batterij besparende functies.
1 Tik op het scherm met de instellingen op Uitbreidingen > Gaming.
7 Pas de volgende instellingen aan:
- Game Launcher:Tik op () ) om de Game Launcher te gebruiken.

- Game tools: U kunt de functie starten terwijl u spellen speelt door
het pictogram van de game tools aan te raken in de touchtoetsen.

- Grafische spelbeelden: Pas de grafische weergave van spellen aan.
E + Als uin sommige spellen de resolutie aanpast, kan de
schermweergavefunctie mogelijk niet correct werken.

+ Het kan zijn dat deze functie niet beschikbaar is in sommige game apps.

+ Onderbrekingstijd: Verminder de helderheid en prestaties van het
scherm wanneer u het spel langer dan 5 minuten laat draaien.
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Schermopnemen
U kunt de instellingen configureren voor schermopnamen.
1 Op het scherm instellingen, druk op Uitbreidingen >
Schermopnamen.
7 Pas de volgende instellingen aan:
- Voeg uzelf toe in video door: Eén uit de volgende opties te
selecteren.
- Afbeelding: Voegt uw profielfoto toe in video bij het opnemen.
Na het selecteren hiervan, druk op @) en selecteer een
profielfoto. Pas dan de grootte van de foto aan met de glijbalk.
- Camera voorkant: \Voegt u zelf toe opgenomen met de camera
vooraan bij het opnemen van het scherm.

- Nooit: Er wordt niets toegevoegd.
+ Audiobron: Kies de audiobron tussen Microfoon en Inhoud.
- Videoresolutie: Selecteer de resolutie voor de schermopname.

Om het scherm op te nemen:

1 Sleep de statusbalk naar beneden om de pictogrammenlijst Snelle
toegang te openen.

2 (Indien nodig, veeg links over de picotgrammenzone Snelle toegang.)
Tik op B

3 Lees de disclaimer en druk op Start. Het zal beginnen opnemen in 3
seconden.

4 Om het opnemen te stoppen, druk op (® rechts onder in het scherm.
De opgenomen video zal opgeslagen worden in Galerij.

E - Indien u de rechten schendt van een andere persoon zoals
portretrechten of rechten op intellectuele eigendom of de reputatie van
een andere persoon beschadigt door de functies te gebruiken voor de
dienst schermopname, kunt u aansprakelijk gehouden wordeen voor
burgerlijke, strafrechtelijke of administratieve lasten overeenkomstig
de betreffende wetten. LG Electronics is op geen enkel manier wettelijk
verantwoordelijk voor de daden door gebruikerrs.
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Dubbele app

U kunt duplicaat messenger apps installeren op het product en twee

accounts tegelijkertijd gebruiken.

1 Tik op het scherm met de instellingen op Uitbreidingen > Dubbele
app.

2 Tik na het lezen van de disclaimer op Bevestigen.

3 Inde lijst met beschikbare apps, tik op Installeren om een kopie van
een gewenste app te installeren en volg de instructies op het scherm.

+ Op het scherm wordt de lijst van beschikbare dubbele apps
vertoond. Tijdens de installatie worden app-pictogrammen
gegenereerd op het homescreen.

Pen

U kunt opties configureren om een Actieve pen (optioneel-afzonderlijk
verkocht) te gebruiken. Merk op dat dit toestel de Active Pen AES2.0
(Actief Electrostatisch) ondersteunt.

1 Tik op het scherm met de instellingen op Uitbreidingen > Pen.

7 Pas de volgende instellingen aan:

+ Pen-knop snelkoppeling: Configureer de sneltoetsen op elke knop
van uw Active pen.

- Applicatiesnelkoppelingen: Selecteer welke apps (maximaal vijf)
als snelkoppelingen worden weergegeven wanneer de pen van het
apparaat wordt verwijderd.

- Memovoorbeeldweergave: Zet aan om recente memo’s in Pen pop
weer te geven.

« Tekengeluid: Zet aan om geluidseffecten in de tekenmodus toe te
passen.

- Toon aanwijzer: Zet aan om een penaanwijzer te zien waarover de
pen beweegt.

- Gebaren navigatie balk negeren: Blokkeert de invoer van gebaren
navigatie balk, wat nuttig is als u tekent of schrijft in de rand van
het scherm met een Actieve pen.

Instellingen 147



Sneltoetsen
U kunt knoppen gebruiken zoals de knop Vergrendelen/Aan-uit, Volume,
en Google Assistent om bepaalde apps of functies onmiddellijk te starten.

1 Tik op het scherm met de instellingen op Uitbreidingen >
Sneltoetsen.
7 Pas de volgende instellingen aan.

- Camera Openen: Druk tweemaal op de uit-toets om de camera te
openen.

+ Openen Scherm-uit-memo: Druk twee keer op Volume omhoog
om Scherm-uit-memo te openen wanneer het scherm is
vergrendeld of uitgeschakeld.

- Camera Openen: Druk tweemaal op de toets volume-omlaag om
de Camera op te starten wanneer het scherm is vergrendeld of
uitgeschakeld.

- Openen Google Assistent: Druk op de Google Assistent-toets aan
de zijkant van de telefoon.

- Praat met Google Assistent: Houd de Google Assistent-toets
ingedrukt om snel met je assistent te praten.

E - Google Assistent ondersteunt niet bepaalde talen.

Knock On

Klik twee maal op het scherm om het scherm aan en uit te schakelen.
Zie Knock On voor details.

Aanraakgevoeligheid verhogen

U kunt het aanraakscherm gevoeliger voor uw aanraking instellen.

Het wordt aanbevolen om deze functie in te schakelen wanneer u een
schermbeschermer gebruikt.

Op het instellingenscherm, tik op Uitbreidingen > Aanraakgevoeligheid
verhogen.
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Applicaties

U kunt een lijst van geinstalleerde apps controleren, en de instellingen
voor kennisgevingen, app-vergunningen en meer configureren.

1 Tikin hetinstellingenscherm op Applicaties.

7 Pas de instellingen aan.

Batterij

U kunt actuele informatie over de batterij weergeven of de
energiebesparingsmodus inschakelen.

1 Tikin het instellingenscherm op Batterij.

7 Pas de volgende instellingen aan:
- Batterijgebruik: bekijk de informatie over het batterijgebruik.

- Geoptimaliseerd opladen: Pas de laadsnelheid automatisch aan
op basis van hoe u oplaadt om de hitte te verminderen en de
levensduur van de batterij te verlengen.

- Adaptieve batterij: Hiermee kunt u de batterij sparen door apps
die op de achtergrond worden uitgevoerd, te stoppen.

+ Achtergrond beperkingen: Schakel deze optie in om achtergrond-
apps te beperken, zodat u de batterij spaart bij gebruik van het
apparaat. Apps die zijn beperkt om energie te besparen werken
mogelijk niet goed of zenden u geen meldingen.

- Spaarstand: verminder het batterijverbruik door sommige
apparaatinstellingen te verlagen, zoals de helderheid van het
scherm, de snelheid van het besturingssysteem en de intensiteit
van de trilfunctie.

- Uitsluiten voor energiebesparing: Selecteer apps die u wilt
gebruiken zonder functionele beperkingen in energiebesparende of
batterij-besparende modus.

Instellingen 149



Opslagruimte
U kunt de interne opslagruimte van het toestel of de opslagruimte van de
geheugenkaart bekijken en beheren.
1 Tik in het instellingenscherm op Opslagruimte.
7 Pas de volgende instellingen aan:
- Intern geheugen: Bekijk de totale opslagruimte en de vrije ruimte

van de interne opslag van het toestel. Bekijk een lijst met gebruikte
apps en de opslagcapaciteit van elke app.

+ MicroSD: Bekijk de totale opslagruimte en de vrije ruimte van
de geheugenkaart. Deze optie verschijnt alleen wanneer een
geheugenkaart is geplaatst. Tik op /\ om de geheugenkaart te
verwijderen.

Accounts

U kunt gebruikers toevoegen om uw toestel met hen te delen en een
cloud-account te registreren.

1 Tik in het instellingenscherm op Accounts.

7 Pas de instellingen aan.

Digitaal welzijn en ouderlijk toezicht

U kunt de tijd van het productgebruik bekijken en de timer instellen voor
elke app. U kunt ook de gebruikerstijd van de mobiele telefoon beheren
door de modi Sleep Preparation en Focus te gebruiken.

Selecteer Digitaal welzijn en ouderlijk toezicht op het instellingen
scherm en stel de gewenste functie in.
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Google

U kunt Google-instellingen gebruiken voor het beheer van uw Google-
apps en accountinstellingen.

Tik in het instellingenscherm op Google.

Systeem

Update Center
U kunt de recentste versie van de app of software geleverd door LG
controleren.

1 Tik op het scherm met de instellingen op Systeem > Update Center.

7 Pas de volgende instellingen aan:
+ Applicatie updaten: Controleer of een app-update beschikbaar is.
Indien beschikbaar, kunt u de update installeren.

- Software-update: Controleer of een software-update beschikbaar
is. Indien beschikbaar, kunt u de update installeren.

Taal en toetsenbord

U kunt de instellingen voor de taal en het toetsenbord van het toestel
aanpassen.

1 Tik op het scherm met de instellingen op Systeem > Taal en
toetsenbord.

7 Pas de volgende instellingen aan:
- Taal: selecteer de gewenste taal voor het toestel.

- Toetsenborden beheren: U kunt de basisinstelling van het
toetsenbord van het product wijzigen, de gebruikersomgevingen
voor het LG-toetsenbord of andere geinstalleerde toetsenborden
instellen, en de functie spraakherkenning voor Google Voice input
instellen. U kunt ook instellen of u de toetsenbordknop in de
toetszone op het homescreen wilt weergeven zodat u snel kunt
overschakelen naar een ander toetsenbord.
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- Fysiek toetsenbord: Selecteer om het fysisch toetsenbord te
gebruiken, of controleer de sneltoetsen van het toetsenbord.

- Automatisch aanvullen-service: Schakel deze optie in om uw
informatie in te voeren die opgeslagen is in uw account zoals
wachtwoord, adres, of nummer van uw credit card met één
enkele klik. U kunt deze optie ook uitschakelen, gebruik Google
Autocomplete, ovoeg een nieuwe service-account toe.

- Text-to-speech uitvoer: configureer de instellingen voor tekst-
naar-spraak.

Pointer snelheid: pas de snelheid van de aanwijzer van een muis of
trackpad aan.

- Muisknoppen omkeren: gebruik de rechtermuisknop voor het
uitvoeren van primaire acties.

Datum en tijd
U kunt de instellingen voor de datum en tijd van het toestel aanpassen.
1 Tikin hetinstellingenscherm op Systeem > Datum en tijd.

7 Pas de instellingen aan.

Geheugen

U kunt zien hoeveel geheugen gedurende een bepaalde tijd is gebruikt en
hoeveel geheugen een app gebruikt.

1 Tikin hetinstellingenscherm op Systeem > Geheugen.

7 Tik op w om de periode in te stellen waarvoor u gegevens wilt
ophalen.
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Back-up
U kunt een back-up van de gegevens op uw toestel maken op een ander
toestel of in een ander account.

1 Tik in hetinstellingenscherm op Systeem > Back-up.

7 Pas de volgende instellingen aan:

+ LG Mobile Switch: Hiermee kunt u gegevens overbrengen van
een oud LG-apparaat naar uw nieuwe LG-apparaat. Zie LG Vobile
Switch voor details.

- Back-up maken en herstellen: Back-up uw toestelgegevens of
herstel gegevens uit een back-up naar uw toestel.

A + Tijdens het resetten van uw toestel worden mogelijk opgeslagen
back-upbestanden gewist. Kopieer en bewaar de belangrijke back-
upbestanden op uw pc.

- Google Back-up: Wijzig de instellingen van uw Google drive
backup. U kunt ook de backup account die momenteel gebruikt
wordt, controleren, of een nieuwe backup-account toevoegen.

Opnieuw opstarten & reset

U kunt het toestel resetten met inbegrip van de instellingen van het
netwerk en de apps.

1 Tik op het scherm met de instellingen op Systeem > Opnieuw
opstarten & reset.

7 Pas de volgende instellingen aan:

+ Automatische opnieuw opstarten: Herstart en pas de telefoon
automatisch aan op een vast tijdstip. Tik op () ) om deze functie
te activeren. Het apparaat start automatisch opnieuw op een
ingesteld tijdstip en optimaliseert zichzelf. Selecteer de datum en
tijd om opnieuw te starten.
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E « U kunt het apparaat instellen om eenmaal per week opnieuw te starten.
Het apparaat start automatisch opnieuw in één uur na de vooraf
ingestelde tijd.

- Nadat het apparaat opnieuw is opgestart, worden de meldingen
en insignes verwijderd. Sla belangrijke gegevens op véér de vooraf
ingestelde tijd.

- De automatische herstartfunctie is niet actief in de volgende situaties:
Wanneer het scherm is ingeschakeld, wanneer het apparaat in gebruik
is, wanneer het batterijniveau 30% of minder is, of wanneer de simkaart
is vergrendeld.

- Afhankelijk van de telecomprovider kan het zijn dat de functie
automatisch opnieuw opstarten al dan niet beschikbaar is.

- Reset netwerkinstellingen: stel de instellingen van Wi-Fi,
Bluetooth en andere netwerkinstellingen opnieuw in.

- Stel voorkeuren van apps opnieuw in: Reset de instellingen voor een
app. De gegevens opgeslagen in de app zullen niet gewist worden.

- Fabrieksinstellingen: stel alle instellingen van het toestel opnieuw
in en verwijder de gegevens.

5 « Als u uw apparaat opnieuw start en opnieuw instelt, worden alle
gegevens die erop staan verwijderd. Voer de apparaatnaam, uw Google-
account en andere oorspronkelijke gegevens in.

- Na gegevensinitialisatie kunnen de gegevens niet hersteld worden.

Over het toestel

U kunt informatie over het toestel bekijken, zoals de naam, status,
softwaredetails en wettelijke informatie.

Tik in het instellingenscherm op Systeem > Over het toestel en bekijk de
informatie.

Regelgeving & veiligheid
U kunt alle beschermde merken en verwante informatie op uw toestel
bekijken.

Tik op het scherm met de instellingen op Systeem > Regelgeving & veiligheid.
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Toegankelijkheid

U kunt de toegankelijkheidsplug-ins beheren die op het toestel zijn
geinstalleerd.

1
2

Tik in het instellingenscherm op Toegankelijkheid.

Pas de volgende instellingen aan:

Visie > TalkBack: stel het toestel in om gesproken notificaties over
de status van het scherm en acties te geven.

.

Visie > Spraaknotificaties: Stel het toestel in om informatie over
de beller voor te lezen.

.

Visie > Lettertype: Verander het formaat, of het lettertype.

Visie > Scherm formaat: Stel de onderdelen op het scherm in op
een formaat zodat u ze gemakkelijk kunt zien. Enkele onderdelen
kunnen van plaats wijzigen.

Visie > Aanraakzoom: tik driemaal op het scherm om in of uit te
zoomen.

Visie > VVensterzoom: Zoom in of uit in een venster en keer de kleur
om.

Visie > Grote muiscursor:vergroot de muisaanwijzer.

« Visie > Scherm met hoog contrast: verander de achtergrondkleur
in zwart voor een scherm met hoog contrast.

- Visie > Schermkleuren omkeren: verhoog het contrast van het
scherm voor slechtzienden.

- Visie > Afstelling scherm kleuren: pas de kleuren van het scherm
aan.

« Visie > Zwart-wit: Schakel het scherm naar grijstintenmodus.

- Visie > Beéindig gesprekken met de aan-uitknop: beéindig een
oproep door de Aan-uit/Vergrendelen-toets in te drukken.

- Gehoor > Live Bijschrift: Stel het apparaat in om de stem
te detecteren vanuit de media en automatisch ondertitels te
genereren.

+ Gehoor > Bijschriftvoorkeuren: schakel bij het afspelen van video's
de ondertiteling in voor slechthorenden.
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- Gehoor > Flits waarschuwingen: Stel het toestel in om bij
inkomende oproepen, berichten en alarmen een lampje te laten
knipperen.

+ Gehoor > Alle geluiden dempen: Schakel alle geluiden uit en
verlaag het volume van de ontvanger.

+ Gehoor > Audiokanaal: selecteer het audiotype.

- Gehoor > Geluidsbalans: pas de balans van de audio-uitvoer aan.
Gebruik de schuifbalk om de balans te wijzigen.

- Motoriek & cognitie > Touch assistant: schakel het aanraakbord
in om knoppen en gebaren eenvoudiger te gebruiken.

- Motoriek & cognitie > Aanraakinvoer: \oer tekst in door uw
vinger op het scherm te houden of wijzig de tekst door het scherm
aan te raken.

-+ Motoriek & cognitie > Fysiek toetsenbord: pas de instellingen van
het toetsenbord aan.

- Motoriek & cognitie > Automatisch klikken met muis: Bij geen
beweging wordt automatisch op de muisaanwijzer geklikt.

- Motoriek & cognitie > Ingedrukt houden voor oproepen:
beantwoord of wijs oproepen af door uw vinger op de beltoets te
houden in plaats van deze te verslepen.

+ Motoriek & cognitie > Time-out scherm: schakel het scherm
automatisch uit wanneer het toestel gedurende een bepaalde tijd
niet wordt gebruikt.

-+ Motoriek & cognitie > Aanraakcontrolegebieden: beperk het
aanraakgebied zodat slechts een specifiek deel van het scherm kan
worden bediend met aanrakingen.

- Snelkoppeling toegankelijkheidsfuncties: krijg snel toegang tot
een veelgebruikte functie door driemaal te tikken op O.

+ Automatische schermrotatie: wijzig de schermstand automatisch
overeenkomstig de fysieke stand van het toestel.

- Selecteer om uitgesproken te worden: Hiermee kunt u op items
tikken om gesproken feedback te krijgen.

- Toegang via schakelaar: maak toetscombinaties om het toestel te
bedienen.
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Taalinstellingen van LG

selecteer de taal die u op het toestel wilt gebruiken.
+ Op het homescreen, tik op Instellingen > Systeem > Taal en
toetsenbord > Taal > Een taal toevoegen en selecteer een taal

- Houd uw vinger op == en sleep deze naar de bovenkant van de lijst
met talen om de taal als standaardtaal in te stellen.

LG Bridge

Overzicht van LG Bridge

LG Bridge is een app waarmee u vanaf uw computer eenvoudig foto’s,
muzieknummers, videos en documenten kunt beheren die op uw LG-
smartphone zijn opgeslagen. U kunt op de computer een back-up maken
van contacten, foto's en meer of de software van het toestel bijwerken.

5 « Raadpleeg de Help-functie van LG Bridge voor meer informatie.
+ De ondersteunde waarden kunnen verschillen naargelang het toestel.

+ U hebt het USB-stuurprogramma van LG nodig om uw LG-smartphone
op de computer aan te sluiten. Het stuurprogramma wordt geinstalleerd
wanneer u LG Bridge installeert.

Functies van LG Bridge

+ Maak op een computer een back-up van de gegevens op het toestel
of zet de gegevens op een computer terug naar het toestel via een
USB-verbinding.

+ Gebruik een computer om de software van het toestel bij te werken
via een USB-verbinding.
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LG Bridge op een computer installeren
1 Ganaar www.lg.com op de computer.

2 Selecteer uw provincie.

3 Klik op Ondersteuning > Software en firmware.

4

Voer de naam van uw toestel in.
OF
Selecteer de productcategorie.

5 Ganaar PC Sync > LG Bridge om het installatiebestand te
downloaden.
- Ga naar Details om de minimale vereisten voor de installatie van LG
Bridge te bekijken.

Software van toestel bijwerken

Software van toestellen van LG bijwerken via het internet

Ga voor meer informatie over het gebruik van deze functie naar
http//www.lg.com/common/indexjsp en selecteer uw land en taal.

Met deze functie kunt u via het internet de firmware van het toestel
eenvoudig bijwerken naar de nieuwste versie zonder dat u daarvoor naar
een servicecenter hoeft te gaan. Deze functie is alleen beschikbaar als en
wanneer LG een nieuwere firmwareversie beschikbaar maakt voor het
toestel.

De firmware-update voor het toestel vereist de volledige aandacht van de
gebruiker tijdens het gehele proces. Lees alle instructies en opmerkingen
voordat u doorgaat naar de volgende stap. Koppel de USB-kabel niet los
tijdens de upgrade. Hierdoor kan het toestel immers ernstig beschadigd
raken.

E + LG behoudt zich het recht voor om updates naar eigen goeddunken
beschikbaar te maken voor specifieke modellen en kan de
beschikbaarheid van nieuwe firmwareversies niet garanderen voor alle
handsets.
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Software van toestellen van LG bijwerken via de

ether

Met deze functie kunt u via de ether de software van het toestel
eenvoudig bijwerken naar de nieuwste versie zonder een USB-kabel
aan te sluiten. Deze functie is alleen beschikbaar als en wanneer LG een
nieuwere firmwareversie beschikbaar maakt voor het toestel.

Als u de software van het toestel wilt bijwerken,

Instellingen > Systeem > Update Center > Software-update >
Controleer nu voor update.

E « Uw persoonlijke gegevens in de interne opslag van de telefoon (zoals
gegevens van uw Google-account en andere accounts, gegevens
en instellingen van het systeem en apps, gedownloade apps en uw
DRM-licentie) kunnen verloren gaan wanneer u de software van de
telefoon bijwerkt. Daarom raadt LG u aan een back-up te maken van uw
persoonlijke gegevens voordat u de software van de telefoon bijwerkt.
LG kan niet aansprakelijk worden gesteld voor het eventuele verlies van
persoonlijke gegevens.

« Deze functie is afhankelijk van de regio of de serviceprovider.
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Anti-diefstal

Configureer uw toestel zodanig dat anderen het niet kunnen gebruiken
als de fabrieksinstellingen zijn hersteld zonder uw toestemming. Als u
bijvoorbeeld uw toestel verliest of als het wordt gestolen of gewist, kan
alleen iemand die de gegevens van uw Google-account of lockscreen
weet het toestel gebruiken.

Het enige dat u moet doen om uw toestel te beveiligen, is:

+ Een lockscreen instellen: Als u het toestel verliest of als het wordt
gestolen maar u hebt een lockscreen ingesteld, kan het toestel
niet worden gewist via het menu Instellingen tenzij het scherm is
ontgrendeld.

+ Uw Google-account toevoegen op het toestel: Als het toestel wordt
gewist maar u hebt uw Google-account er op ingesteld, kan het
toestel het configuratieproces pas voltooien wanneer uw Google-
accountgegevens opnieuw worden ingevoerd.

Nadat u het toestel hebt beveiligd, moet u het scherm ontgrendelen

of het wachtwoord van uw Google-account invoeren als u de
fabrieksinstellingen wilt herstellen. Op deze manier weet u zeker dat u of
een vertrouwenspersoon het toestel opnieuw instelt.

E « Zorg ervoor dat u de gebruikersnaam en het wachtwoord van uw
Google-account niet vergeet dat u op het toestel had ingesteld
alvorens u de fabrieksinstellingen begint te herstellen. Als u tijdens het
configuratieproces de accountgegevens niet kunt opgeven, kunt u het
toestel niet meer gebruiken nadat de fabrieksinstellingen zijn hersteld.
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Informatiebericht over Open Source-
software

Ga naar http//opensource.lge.com om de broncode onder GPL, LGPL,
MPL en andere licenties voor open sources in dit product te achterhalen.

Naast de broncode zijn alle licentievoorwaarden, beperkingen van garantie
en auteursrechtaanduidingen beschikbaar om te downloaden.

LG Electronics zal u tevens open-source code ter beschikking stellen op
CD-ROM tegen de kostprijs van verspreiding (zoals de kosten voor media,
verzending en handling) na ontvangst van een verzoek per e-mail naar
opensource@lge.com.

Deze aanbieding is geldig voor een periode van drie jaar na onze laatste
zending van dit product. Deze aanbieding is geldig voor iedereen die deze
informatie ontvangt.

Regelgeving en veiligheid (ID-nummer
van regelgeving, E-labels, enz.)

Ga voor meer informatie over wetgeving naar Instellingen > Systeem >
Regelgeving & veiligheid.

Appendix 162



Handelsmerken

+ Copyright ©2020 LG Electronics Inc. Alle rechten voorbehouden. LG
en het LG-logo zijn geregistreerde handelsmerken van LG Group en
diens gelieerde partners.

- Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Foto's, Google Play Protect, Google Agenda,
Google Documenten, Google Drive, Google Spreadsheets en andere
gerelateerde merken en logo’s zijn handelsmerken van Google LLC.

- Bluetooth® s een gedeponeerd handelsmerk van Bluetooth SIG, Inc.
wereldwijd.

- Wi-Fi® en het Wi-Fi-logo zijn gedeponeerde handelsmerken van de
Wi-Fi Alliance.

+ Alle andere handelsmerken en auteursrechten zijn het eigendom van
hun respectieve eigenaren.

HE HEVC \dvance”

Covered by Patents at patentlisthevcadvance.com
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Veiligheidsverklaring laser

Let op!

Dit product maakt gebruik van een lasersysteem. Voor het juiste gebruik
van dit product dient u deze gebruikershandleiding aandachtig door te
lezen en te bewaren voor later gebruik. Als het apparaat onderhoud nodig
heeft, neem dan contact op met een geautoriseerd servicecentrum.
Gebruik van bedieningsfuncties, aanpassingen of het uitvoeren van
procedures anders dan hier beschreven kan leiden tot blootstelling aan
gevaarlijke straling.

Om directe blootstelling aan laserstraling te voorkomen, dient u de

behuizing niet te openen en ook geen rechtstreeks contact met de laser
te maken.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

VERKLARING VAN
OVEREENSTEMMING

Hierbij verklaart LG Electronics dat dit LM-G900EM-product voldoet
aan de belangrijkste voorschriften en andere relevante bepalingen van
richtlijin 2014/53/EU.

U vindt een kopie van de verklaring van overeenstemming op
http//www.lg.com/global/declaration
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Contactpunt voor naleving
regelgeving
LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

De band 5150 - 5350 MHz mag alleen binnenshuis worden gebruikt.
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Meer informatie

Onderdelen van gehard glas

De onderdelen van gehard glas van dit toestel zijn niet permanent en

kunnen na verloop van tijd verslijten.

+ Als u uw toestel op een hard oppervlak laat vallen of het blootstelt aan
zware schokken, kan het geharde glas beschadigd raken.
Als dit gebeurt, stop dan onmiddellijk met het gebruiken van uw
toestel en neem contact op met de klantenservice van LG.

+ U kunt in de handel beschermhoesjes kopen om uw toestel tegen
schade te beschermen.

Merk op dat deze beschermhoesjes niet gedekt zijn door de garantie
van LG Electronics en dat de veiligheid niet verzekerd is.

Beeldverhouding
Dit toestel maakt gebruik van de beeldverhouding 20,5:9.

+ Enkele gedownloade apps ondersteunen mogelijk de beeldverhouding
20,59 niet.

Selecteer in dit geval de optimaalste schermverhouding voor de app of
raadpleeg de leverancier van de app voor meer informatie.

Appendix 166



Gids voor gegevensoverdracht

+ Voor de gegevens die kunnen worden uitgewisseld tussen LG-
apparaten of tussen het LG-apparaat en een apparaat van een derde
partij, zie de volgende tabel.

a Lgr-aat Androidapparaat a '2f;at
PP van derde partij PP
Type Itemdetails — . —
LG- LG-
apparaat LG-apparaat apparaat
Contacten, berichten,
oproepgeschiedenis,
kalender, o o o
Persoonlijke | spraakopnames
gegevens
Memo's X (@)
Alarmen X X
. Foto's, video's, nummers,
Mediadata documenten o o o
Homescreen-
instellingen (mappen en O X X
widgets)
Scherm-
instellingen | Lockscreen-
instellingen (exclusief o % M
schermvergrendelings-
instellingen)
Gedownloade apps. (@) @)
s Persoonlijke gegevens o % }
van de gedownloade app
Publieke certificering O O X
Instellingen (Wi-Fi,
Overige Bluetooth, Oproepen,
geluid & notificatie, (@) X X
toegankelijkheid,
batterij)
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E - Sommige gegevens kunnen niet worden verstuurd afhankelijk van de
softwareversie, app-versie, het besturingssysteem, de fabrikant of het
beleid van de serviceprovider.

Ondersteunde Frequentiebanden Stroom Zenderoutput

GSM 900 33.7dBm
GSM 1800 30.7 dBm
W B1 247 dBm
W B8 25.5dBm
LTE B1 242 dBm
LTEB3 247 dBm
LTE B7 24.7 dBm
LTE B8 25.5dBm
LTEB20 255dBm
LTEB28 255dBm
LTEB38 252 dBm
LTE B40 252 dBm
5G Sub6n1 247 dBm
5G Sub6n3 247 dBm
5G Sub6n28 24.5dBm
5G Sub6 n40 252 dBm
5G Sub6n78 22.7dBm
BT 2.4GHz 11 dBm
WLAN 2.4GHz 19.5dBm
WLAN 5GHz 19 dBm
NFC - 23 dBuA/m

Info over de Reisadapter kunt u vinden op
http//www.lg.com/global/support/cedoc/cedoc
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Verwijdering van uw oude apparaat

1. Dit symbool van de doorgekruiste vuilnisbak geeft aan dat
afgedankte elektrische en elektronische producten (WEEE)
afzonderlijk van het huishoudelijke afval moeten worden verwijderd.

mmmm 2 Oude elektrische producten kunnen gevaarlijke stoffen bevatten,
dus een juiste verwijdering van uw oude apparaat helpt bij het
voorkomen van mogelijke negatieve gevolgen voor het milieu en de
volksgezondheid. Uw oude apparaat kan herbruikbare onderdelen
bevatten die gebruikt zouden kunnen worden voor het repareren
van andere producten, en andere waardevolle materialen die kunnen
worden gerecycleerd voor het behoud van beperkte grondstoffen.

3. U kunt uw apparaat meenemen naar de winkel waar u het
product hebt gekocht, of u kunt contact opnemen met uw
plaatselijke afvalinstantie voor de gegevens van uw dichtstbijzijnde
geautoriseerde WEEE-verzamelpunt. Voor de meest
geactualiseerde informatie voor uw land wordt verwezen naar
www.lg.com/global/recycling

Batterijen wegdoen

1. Dit symbool kan worden gebruikt in combinatie met chemische
symbolen voor kwik (Hg), cadmium (Cd) of lood (Pb) als de accu
meer dan 0,0005% kwik, 0,002% cadmium of 0,004% lood bevat.

2. Alle batterijen/accu’s mogen niet worden meegegeven met het
huishoudelijk afval, maar moeten worden ingeleverd bij speciale
inzamelingspunten die door de lokale of landelijke overheid zijn
aangewezen.

3. De correcte verwijdering van uw oude batterijen/accu’s helpt
negatieve gevolgen voor het milieu en de gezondheid van mens en
dier voorkomen.

4. Wilt u meer informatie over de verwijdering van uw oude batterijen/
accu's? Neem dan contact op met de plaatselijke autoriteiten, de
afvalophaaldienst of de winkel waar u het product hebt gekocht.
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Veelgestelde vragen

In dit hoofdstuk worden problemen behandeld waarmee u mogelijk te
maken krijgt tijdens het gebruik van uw toestel. Voor bepaalde problemen
moet u bellen naar uw serviceprovider maar de meeste problemen kunt u
zelf eenvoudig oplossen.

Foutmelding over simkaart
Zorg ervoor dat de simkaart juist is geplaatst.

Geen netwerkverbinding of netwerkverbinding valt weg
Signaal is zwak. Ga naar een raam of een open ruimte.

U bevindt zich buiten het bereik van het netwerk. Verplaats en controleer
het netwerk.

Oproepen zijn niet beschikbaar

Nieuw netwerk is niet toegestaan.

Controleer of u geen oproepen blokkeert voor het inkomende nummer.
Controleer of u geen oproepen blokkeert voor het gekozen nummer.

Het toestel kan niet worden ingeschakeld

Wanneer de batterij helemaal leeg is, kan uw toestel niet worden
ingeschakeld.

Laad de batterij volledig op voordat u het toestel inschakelt.
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Fout tijdens laden

Zorg ervoor dat het toestel oplaadt bij een normale temperatuur.
Controleer de oplader en de verbinding met het toestel.

Gebruik uitsluitend de door LG goedgekeurde meegeleverde accessoires.

De batterij raakt sneller leeg dan net na de aanschaf

Wanneer u het toestel of de batterij blootstelt aan zeer koude of warme
temperaturen, kan dit levensduur van de batterij verkorten.

Batterijverbruik neemt toe wanneer u bepaalde functies of applicaties
gebruikt, zoals GPS, games of internet.

De batterij is een verbruiksproduct en de levensduur zal steeds korter
worden.

Er verschijnen foutberichten wanneer de camera wordt
gestart
L.aad de batterij op.

Maak geheugen vrij door bestanden over te zetten naar een computer of
verwijder bestanden van uw toestel.

start het toestel opnieuw op.

Als u na het toepassen van deze tips nog steeds problemen hebt met de
camera-app, neemt u contact op met een LG Electronics Service Center.

De fotokwaliteit is slecht

De kwaliteit van uw foto's kan variéren, afhankelijk van de omgeving en de
fotografietechnieken die u gebruikt.

Als u foto's en video's maakt, is de kwaliteit bij standaardhoek beter dan
bij groothoek.

Als u foto's wilt maken in een donkere gebieden, ‘s nachts of binnen, kan
beeldruis optreden of kunnen beelden onscherp zijn.

Als u problemen ondervindt, stel de opties dan opnieuw in.
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Het aanraakscherm reageert traag of onjuist

Als u een schermbeschermer of optionele accessoires aan het
aanraakscherm bevestigt, werkt het aanraakscherm mogelijk niet goed.

Als u handschoenen draagt, als uw handen niet schoon zijn als u het
aanraakscherm aanraakt of als u met scherpe voorwerpen of uw
vingertoppen op het scherm tikt, werkt het aanraakscherm mogelijk niet
goed.

Het aanraakscherm werkt mogelijk niet goed in vochtige
omstandigheden of wanneer het wordt blootgesteld aan water.

Start het toestel opnieuw op om tijdelijke softwarebugs te verwijderen.

Als het aanraakscherm is bekrast of beschadigd, breng dan een bezoek
aan een LG Electronics Service Center.

Loopt vast of blokkeert

Start het toestel opnieuw op

- Als uw toestel blokkeert of vastloopt, dient u wellicht applicaties af te
sluiten of het toestel uit en weer in te schakelen.

Voer een opstart uit
- Een zachte reset kan worden gebruikt om het toestel te resetten als
het scherm vastloopt of wanneer de toetsen, het aanraakscherm of
het toestel niet meer reageren.
- Om een zachte reset van uw toestel uit te voeren, houdt u de toetsen
Volume omlaag en Aan/uit ingedrukt tot het toestel opnieuw opstart.

E - Deze functie is niet beschikbaar als het toestel gekoppeld is met het LG
Dual Screen (LM-G905N).
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Reset het toestel

+ Als de bovenstaande methoden het probleem niet oplossen, moet u
de fabrieksinstellingen herstellen.

+ Tik op het scherm met de instellingen op Systeem > Opnieuw
opstarten & reset > Fabrieksinstellingen.

- Met deze methode worden alle instellingen voor het apparaat
opnieuw ingesteld en worden gegevens verwijderd. Voordat u
de fabrieksinstellingen herstelt, zorgt u ervoor dat u een back-
up maakt van alle belangrijke gegevens die op het toestel zijn
opgeslagen.

Als u een Google-account op het toestel hebt geregistreerd, dient
u zich na reset van het toestel met dezelfde Google-account aan te
melden.

Bluetooth-toestel wordt niet gevonden

Controleer of de draadloze Bluetooth-functie is geactiveerd op uw
toestel.

Controleer of de draadloze Bluetooth-functie is geactiveerd op het
apparaat waarmee u verbinding wilt maken.

Zorg ervoor dat uw apparaat en het andere Bluetooth-apparaat zich
binnen het maximale Bluetooth-bereik (10 m) bevinden.

Als bovenstaande tips geen oplossing bieden voor uw probleem, neem
dan contact op met een LG Electronics Service Center.

Er wordt geen verbinding gemaakt wanneer u het
toestel op een computer aansluit
Controleer of de USB-kabel die u gebruikt compatibel is met uw toestel.

Controleer of u het juiste stuurprogramma hebt geinstalleerd en
bijgewerkt op uw computer.

De gedownloade applicatie veroorzaakt veel fouten
De toepassing ondervindt problemen.
Verwijder de applicatie en installeer deze opnieuw.
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Kennismaking met LG Dual Screen

U kunt een LG Dual Screen koppelen aan dit product voor gebruik.

E U kunt het LG-dubbelscherm (hierna te noemen "Dual Screen")
verbinden met een toegewezen LG VELVET (hierna te noemen
"telefoon"), om het product te gebruiken.

« Afhankelijk van de prestaties van de toegewezen telefoon kunnen
bepaalde Dual Screen-functies worden beperkt. Ook is het mogelijk dat
het product geen ondersteuning biedt voor andere mobiele apparaten.

« Dit product is niet waterbestendig. Stel het apparaat niet bloot aan
vloeistoffen en vocht.

+ Als het apparaat nat is, verandert de LDI in het apparaat van kleur.

In dit geval komt het apparaat niet in aanmerking voor gratis
reparatiediensten die worden verstrekt onder de beperkte garantie van
het apparaat.

Richtlijnen voor veilig en efficiént
gebruik

Lees deze eenvoudige richtlijnen door. Deze richtlijnen moeten worden gevolgd.

Onderhoud van het product

+ Gebruik uitsluitend de door LG goedgekeurde meegeleverde accessoires. LG
geeft geen garantie bij schade of defecten veroorzaakt door accessoires van
derden.

+ Bepaalde inhoud en afbeeldingen kunnen zonder voorafgaande kennisgeving
afwijken van uw toestel.

- Demonteer het toestel niet. Laat eventuele noodzakelijke reparaties uitvoeren
door een gekwalificeerd onderhoudstechnicus.

- Reparaties die na beoordeling van LG onder de garantie vallen, omvatten
mogelijk vervangende onderdelen of kaarten die ofwel nieuw ofwel gereviseerd
zijn, op voorwaarde dat deze onderdelen of kaarten een gelijkwaardige werking
hebben als de onderdelen die worden vervangen.
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+ Houd het toestel uit de buurt van elektrische apparaten zoals tv's, radio’s en pc’s.

+ Houd het toestel uit de buurt van warmtebronnen zoals radiatoren en
kookplaten.

+ Laat het toestel niet vallen.
+ Stel het toestel niet bloot aan mechanische trillingen of schokken.

- Schakel het toestel uit wanneer dit door de speciale voorschriften wordt vereist.
Gebruik het toestel bijvoorbeeld niet in ziekenhuizen, aangezien het gevoelige
medische apparatuur kan storen.

+ Houd het toestel niet met natte handen vast tijdens het opladen. Hierdoor zou
u een elektrische schok kunnen krijgen en het toestel zou ernstig beschadigd
kunnen raken.

+ Gebruik een droge doek om het toestel aan de buitenzijde te reinigen (gebruik
geen oplosmiddelen zoals benzeen, verdunners of alcohol).

« Stel het toestel niet bloot aan extreme omstandigheden met rook en stof.

+ Bewaar het toestel niet in de buurt van creditcards, vervoerstickets en
dergelijke, omdat het de informatie op de magnetische strip kan beinvioeden.

+ Tik niet op het scherm met een scherp voorwerp, om beschadiging van het
toestel te voorkomen.

- Stel het toestel niet bloot aan vloeistoffen of vocht.

+ Gebruik nooit gebroken, gesplinterd of gebarsten glas, raak het niet aan en
probeer het niet te verwijderen of te repareren. Schade aan het glazen materiaal
ten gevolge van verwaarlozing of verkeerd gebruik wordt niet door de garantie
gedekt.

+ Uw toestel is een elektronisch apparaat dat tijdens normaal gebruik warm
wordt. Langdurig direct contact met de huid zonder voldoende ventilatie leidt
mogelijk tot ongemak of kleine brandwonden. Wees daarom voorzichtig tijdens
en vlak na het gebruik van uw toestel.

+ Als uw toestel nat is geworden, koppelt u dit dan onmiddellijk los en laat u het
volledig opdrogen. Probeer het apparaat niet sneller op te drogen met behulp
van een externe hittebron, zoals een oven, magnetron of féhn.

+ Door het vocht in uw natte toestel verandert de kleur van het productlabel
binnen in uw toestel. Schade aan het toestel ten gevolge van blootstelling aan
vloeistof wordt niet door de garantie gedekt.

- Een mobiel apparaat heeft een goede luchtcirculatie nodig om warmte te
vernietigen. Het apparaat kan te warm zijn als gevolg van direct huidcontact en
onvoldoende circulatie van de luchtstroom op het apparaat. Het apparaat moet
zich ten minste 1,0 cm tussen het lichaam van de gebruiker bevinden.

LG Dual Screen (LM-G905N) 176



+ Zorg ervoor dat het product niet in contact komt met vloeistof. Gebruik het
product niet of laad het niet op wanneer het beschadigd is. Als het product nat
wordt, verandert de vloeistofschade-indicator van kleur. Houd er rekening mee
dat u hierdoor geen recht meer hebt op gratis reparaties onder garantie.

Efficiénte bediening van het apparaat

Elektronische apparaten
Alle apparaten kunnen storingen opvangen die de werking kunnen beinvloeden.

+ Gebruik het apparaat niet in de buurt van medische apparatuur zonder dat u
eerst om toestemming hebt gevraagd. Ga bij uw arts na of uw toestel storing
van uw medische apparatuur kan veroorzaken.

« Fabrikanten van pacemakers raden een minimale afstand van 15 cm aan tussen
andere apparaten en een pacemaker om mogelijke storing van de pacemaker te
voorkomen.

+ Sommige hoortoestellen zijn gevoelig voor storing door apparaten.
- Een geringe storing kan al van invloed zijn op TV's, radio's, PC's enz.

+ Gebruik uw apparaat bij temperaturen tussen 0 °C en 35 °C, indien mogelijk.
Het blootstellen van het apparaat aan extreem lage of hoge temperaturen kan
leiden tot schade, storingen of zelfs explosies.

Veiligheid onderweg

Stel uzelf op de hoogte van de wetten en voorschriften voor het gebruik van
apparaten in de gebieden waar u rijdt.

+ Gebruik het toestel niet tijdens het rijden.
- Concentreer u op het rijden.

+ Verlaat de weg en parkeer de auto voordat u een oproep beantwoordt, als de
verkeerssituatie dat vereist.

- RF-energie kan bepaalde elektronische systemen in de auto ontregelen, zoals
stereo-apparatuur en veiligheidsfuncties.

- Als uw auto is voorzien van een airbag, mag u deze niet door geinstalleerde of
draagbare, draadloze apparatuur blokkeren. Als u dit wel doet, kan dit ertoe
leiden dat de airbag niet of niet goed functioneert met mogelijk ernstige
verwondingen tot gevolg.

+ Zet het volume niet te hoog als u buitenshuis naar muziek luistert, zodat u de
geluiden uit uw omgeving nog kunt horen. Dit is vooral belangrijk in het verkeer.
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Onderdelen van glas

Bepaalde onderdelen van uw toestel zijn van glas. Dit glas kan breken als u toestel
op een hard oppervlak laat vallen of als het een harde klap krijgt. Raak gebroken
glas niet aan en probeer het niet te verwijderen. Gebruik het toestel niet totdat het
glas door een erkende serviceprovider is vervangen.

Explosiewerkzaamheden

Gebruik het toestel niet in een omgeving waar met explosieve materialen
wordt gewerkt. Neem beperkende maatregelen in acht en houd u aan regels en
voorschriften.

Explosmgevaar
Gebruik uw toestel niet bij tankstations.
- Gebruik het toestel niet in de buurt van brandstoffen en chemicalién.

+ Vervoer geen brandbare gassen, vloeistoffen en explosieven en sla deze ook
niet op in dezelfde ruimte van een voertuig waarin zich ook uw toestel of
accessoires bevinden.

Kinderen

Bewaar het toestel op een veilige plek, buiten het bereik van kleine kinderen.
Het toestel bevat kleine onderdelen die, indien losgemaakt, verstikking kunnen
veroorzaken.
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Productonderdelen en accessoires

De volgende items worden bij uw product meegeleverd.

+ Product + Snelstartgids

+ De laadadapter

A .

Zorg ervoor dat u de originele accessoires van LG Electronics gebruikt.
Het gebruik van producten die niet authentiek zijn kan verslechtering
van de kwaliteit van telefoongesprekken, defect van het toestel, enz.
veroorzaken in zo een geval kan het zijn dat u niet de service ontvangt
die door LG Electronics geleverd wordt.

- Bepaalde onderdelen van Dual Screen zijn gemaakt van gehard glas. Als

u uw product op een hard oppervlak laat vallen of blootstelt aan zware
schokken, kan het geharde glas beschadigd raken. Als dit gebeurt, stop
dan onmiddellijk met het gebruiken van uw product en neem contact op
met de klantenservice van LG.

« Het uiterlijk en de specificaties van het product kunnen zonder

voorafgaande kennisgeving wijzigen.

« De buitenkant en de specificaties van Dual Screen kunnen gewijzigd

worden zonder voorafgaande kennisgeving om de prestaties te
verbeteren.
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Overzicht van onderdelen

Voorzijde

T e
i
|
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Uitgevouwen

00— =——x

|0

@ Cover Display @ Scherm
@ Volumeknoppen ® Communicatie- en stroompoort
® Google Assistent-toets @ USB-C adapter aansluiting

O Opening voor oordopje

E + Deze handleiding is bestemd voor gebruikers die een telefoon met deze
Dual Screen verbinden. Voor meer informatie over hoe u deze Dual
Screen en de telefoon moet gebruiken, bezoek www.lg.com en lees de
gedetailleerde handleiding.
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De telefoon in de Dual Screen
pluggen

T Vouw de Dual Screen volledig uit elkaar zodat het parallel staat
tegenover een vlak oppervlak.

2 Glijd de onderkant van uw telefoon in de onderkant van de Dual
Screen zoals in de afbeelding getoond. Op dat ogenblik zorgt u ervoor
dat het o gedeelte van de telefoon correct past met het @ gedeelte
van de Dual Screen.
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3 Druk op het @) gedeelte van de telefoon met uw vinger om de rand
van de telefoon te koppelen met deze van de Dual Screen.

0
O

o 7\
@l
4 Druk op het 0 gedeelte van de telefoon om de Dual Screen volledig
te koppelen met de telefoon.

of

— =

7

!
P

A + Zorg ervoor dat uw telefoon volledig ingevoegd is in de Dual Screen
alvorens gebruik.
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De telefoon uit de Dual Screen
verwijderen

T Vouw de Dual Screen volledig uit elkaar en houd het stevig vast met
beide handen zoals afgebeeld in de afbeelding.

2 Druk op het @) gedeelte van de Dual Screen met uw vinger terwijl u
tegelijkertijd drukt op de achterzijde van de telefoon met uw andere
vinger om de rand van de telefoon uit de Dual Screen te trekken.

o/
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3 Trek het 0 gedeelte van de telefoon uit de Dual Screen en volg
daarbij dezelfde richtlijnen als in de vorige stap.

/A Houd de Dual Screen met beide handen vast en glijd de telefoon
in de richting van de pijl om het te verwijderen. Zorg ervoor om de
telefoon niet links of rechts te draaien of het opwaarts te duwen in
een extreme hoek.

/) OPGELET:
« Til de telefoon niet uit de Dual Screen met een grote hoek zoals afgebeeld hierna.
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A - Indien u de telefoon uit het product trekt met een te grote hoek of met
overdreven kracht bij het verwijderen van de telefoon, kunt u adapter
aansluiting of USB-C poort beschadigen. Zorg ervoor dat u de telefoon
opwaarts drukt in de richting van de pijl zoals in de afbeelding als het
verwijdert.

« Zorg ervoor dat u de Dual Screen of de telefoon niet laat vallen bij het
aansluiten of verwijderen van de telefoon.

« Wanneer u uw telefoon in de Dual Screen voert of uittrekt, zorg er dan
voor dat u niet te veel kracht gebruikt. Dit kan leiden tot schade aan de
Dual Screen.

« Bepaalde onderdelen van de Dual Screen zijn gemaakt van gehard glas.
De Dual Screen laten vallen op een hard oppervlak of het aan hevige
schokken onderwerpen kan tot gevolg hebben dat het gehard glas
kraakt of verslijt waardoor de Dual Screen beschadigd wordt of letsels
veroorzaakt. Indien dit gebeurt, stop onmiddellijk met het gebruik van
de Dual Screen en ga naar de dichtst bijzijnde Klantendienst van LG voor
herstelling.

« In de volgende situaties kan het zijn dat de map van de Dual Screen
niet volledig sluit of dat de Dual Screen niet normaal werkt door slechte
communicatie of verkeerde verbinding van de stroomterminal.

- Indien u een beschermlaag beschermend glas, of andere accessoires
op de Dual Screen of het scherm van uw telefoon aanbrengt.

Indien u een beschermlaag of dikke stickers in de verbindingszone van

de Dual Screen of de achterkant van uw telefoon hebt aangebracht
- Indien u vellen papier of kaarten tussen de Dual Screen en uw

telefoon hebt ingevoerd

« Indien u het draadloos opladen of de functie NFC gebruikt terwijl uw
telefoon ingevoerd is in de Dual Screen kan het laden mogelijks niet
goed werken.

« Als de telefoon op de Dual Screen gemonteerd is, kan het niet
verbonden worden met een TV met HDMI-kabel. Als de telefoon uit de
Dual Screen gehaald wordt, kan het verbonden worden met een TV met
HDMI-kabel.
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De laadadapter gebruiken

U kunt de laadadapter gebruiken om uw telefoon op te laden of gegevens
te verplaatsen terwijl uw telefoon met de Dual Screen verbonden is.

T Met de telefoon gemonteerd op de Dual Screen, verbindt u de
laadadapter met de laadpoort onderaan de Dual Screen zoals
afgebeeld in de afbeelding hierna.

J

5 + Pogo Pin zal niet werken indien het verbonden is in de omgekeerde
richting.
+ De USB-verbinding via Pogo Pin ondersteunt geen OTG, audio, HDMI
noch USB 3.0. Hiervoor verbindt u de kabel rechtstreeks met de poort
op de telefoon na het verwijderen van de Dual Screen.
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2 Verbind een USB Type C-kabel
+ U kunt de telefoon laden of gegevens verplaatsen.

.

Aansluiting van kabelconnector >

E « Als de laadadapter niet in gebruik is, koppel de stroom van de oplader
los en houd het apart van de kabelconnector. Indien het magnetisch
gedeelte van de laadadapter in contact komt met dichtbijgelegen
metalen of geleidende substanties, kan het breken, verbranden of
beschadigd worden door een elektrische schok.

« Zorg ervoor dat u altijd de laadadapter gebruikt die bij de Dual Screen
geleverd werd. Indien u de laadadapter verloren hebt of een nieuwe
wenst te kopen, bel de klantendienst van LG Electronics voor details.

« De laadadapter en de laadpoort onderaan de Dual Screen zijn
magnetisch verbonden. Schud niet of trek de laadadapter niet uit terwijl
u het gebruikt.
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De Dual Screen gebruiken

Telefoon opnemen en ophangen met de toets

Google Assistent
Met Dual Screen en als de telefoon verbonden is, kunt u de oproep
beantwoorden door éénmaal op de toets Google Assistent te drukken.
Om het gesprek te beéinidgen, druk twee maal op de toets Google
Assistent om op te hangen.
+ Ukunt enkel opnemen of ophangen met de toets Google Assistent als
het deksel van de Dual Screen volledig gesloten is.
+ Zorg ervoor dat het product en de telefoon verbonden zijn via
minstens één synchronisatie.

Als u belt

Als u belt, kunt u de Dual Screen naar buiten vouwen naar 360° of het
naar binnen vouwen naar 0°.

- Indien u de Dual Screen gebruikt door het 360° te vouwen, zorg er dan
voor dat de voor- en achterzijde van de Dual Screen volledig in contact
zijn. In dit geval wordt het scherm van de Dual Screen automatisch
uitgeschakeld om stroom te besparen.
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De Dual Screen gebruiken
Vouw de Dual Screen uit elkaar om de twee schermen zij aan zij te

plaatsen.
/ B
Scherm —5——— e Telefoonscherm
product

A

Het Schermkleur aanpassen

Als u het scherm van het product en het telefoonscherm tegelijkertijd
gebruikt, kan er een kleurverschil optreden tussen de twee schermen.

+ Probeer de kleurtemperatuur aan te passen. Tik op het homescreen
op Opties > Weergave > Schermkleur, pas dan Kleurtemperatuur aan.

+ Kleuren kunnen er anders uitzien afhankelijk van de gezichtshoek, pas
dus de kleuren aan in een volledig uitgevouwen toestand.

Dual Homescreen gebruiken

Kennismaken met Dual Homescreen

De Dual homescreen kan onafhankelijk van het productscherm werken.
+ Het biedt sneltoetspictogrammen en een home touch balk.

- Ukunt de achtergrond wijzigen en widgets instellen.

+ Op het homescreen, kunt u ook verschillende apps starten uit de lade
van apps en mappen genereren of wissen.
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Kennismaken met de opmaak van Dual Homescreen

U kunt verschillende functies gebruiken door de pictogrammen te starten
op het homescreen.

*— Gedeelte voor snelle toegang

Navigatie balk

E + De achtergrond van de Dual Screen kan verschillende van de afbeelding
afhankelijk van het beleid van de fabrikant, de instellingen van de
gebruiker, softwareversies, diensten verleend door telecomproviders,
enz.

- Gedeelte voor snelle toegang: zet de belangrijkste apps vast onder in
het scherm zodat u ze makkelijk kunt openen vanaf elk homescreen.

- Navigatie balk: U kunt enkele gebaren doen om naar het homescreen,
vorig scherm, scherm Overzicht te gaan , of snel over te schakelen
tussen apps.
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Het paneel Dual Screen gebruiken

U kunt het paneel Dual Screen openen door de bovenkant van het
scherm omlaag te slepen.

+ Ukunt de helderheid van het scherm aanpassen op het paneel Dual

Screen.

- Indien u synchronisatie activeert door Sync te selecteren, dan komt
de schermhelderheid van het dubbele scherm in sync met deze van
het verbonden product.

+ Ukunt op Screenshot tikken om een afbeelding van het
productscherm vast te leggen.
+ Ukunt het productscherm uitzetten door te tikken op Dual Screen.

- Het dubbele scherm en de verbonden telefoon worden
losgekoppeld.

- U kunt op [ tikken om toegang te krijgen tot het instellingenmenu
van het dubbel scherm.

g «— Dual Screen-opties
Schermhelderheid p—

Screenshot ——— e—— Dual Screen
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Wijzigingen aanbrengen aan het Dual Homescreen

Houd een lege zone ingedrukt op het Dual Homescreen en start een

gewenste functie.

+ Als u een widget aan het homescreen wilt toevoegen, houd dan
uw vinger op een leeg gedeelte op het homescreen en selecteer
vervolgens Widgets.

+ Houd uw vinger op een leeg gedeelte op het homescreen en selecteer
vervolgens Achtergronden als u achtergronden wilt wijzigen.

+ Als u het standaardscherm wilt wijzigen, houd dan uw vinger op een
leeg gedeelte op het startscherm, verplaats die naar het gewenste
scherm, tik op £ en tik vervolgens nogmaals op het scherm.

Standaardscherm

Widgets | L Achtergronden
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De achtergrond van de Dual Screen bekijken

U kunt de achtergrondafbeelding alleen bekijken door de apps en de
widgets op het homescreen te verbergen.

Duw twee vingers uiteen op het startscherm.

+ Als u wilt teruggaan naar het originele scherm met apps en widgets,
knijpt u uw vingers op het homescreen samen of tikt u op <]

De omgeving van de Dual Screen instellen
U kunt de omgeving van het dubbele scherm instellen op de telefoon die
verbonden is met het dubbele scherm.

T In het homescreen, tik op Instellingen > Weergave > Dual Screen.

E U moet uw telefoon verbinden met het dubbele scherm om het menu
item te zien voor de instelling van de omgeving van het dubbele scherm.
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2 Selecteer de gewenste functies en stel deze in.
« Cover Display: U kunt instellen of u de cover display wil gebruiken

aan de voorzijde van het dubbele scherm.

- Time-out scherm / Dagelijkse onderbreking: U kunt instellen
of u beide schermen tegelijkertijd wilt gebruiken.

« Dual Screen Tool: Als u uw telefoon met het dubbele scherm

verbindt, verschijnt het Dual Screen Tool op het scherm. De
helderheid wordt gesynchroniseerd met deze van de Dual Screen.

- Dual Screen gebruiken: U kunt het dubbele scherm aan- en

uitschakelen, schakelen tussen de schermen van de telefoon en het
dubbele scherm.

- Omgekeerd vouwen: U kunt het gedrag voor het

tegenovergestelde scherm instellen als het dubbele scherm
teruggevouwen is.

- Helderheid: U kunt de helderheid van het scherm aanpassen door

de balk voor helderheid naar links of rechts te schuiven.

- Zelfde houden als het hoofdscherm: U kunt de helderheid
synchroniseren met die van de verbonden telefoon.

+ Wide view: U kunt een app instellen die kan uitgebreid worden op

beide schermen.

- Wallpaper: U kunt een achtergrond voor het Homescreen

selecteren.

+ Pictogrammen app-drawer: U kunt de app-lade op uw product

tonen of verbergen.

- Sneltoets Multi App: U kunt twee apps instellen die tegelijkertijd

draaien op het hoofdscherm en op het Dual Screen.

« My Pick App: U kunt apps selecteren die telkens automatisch

5

opstarten als u het dubbele scherm aanschakelt.

+ De lijst van apps die op het scherm verschijnen kan verschillen,
afhankelijk van de apps die zijn geinstalleerd.
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Dual Screen Tool

Als u uw telefoon met het dubbele scherm verbindt en het dubbel scherm
activeert, verschijnt het menu pictogram Dual Screen Tool a op de kant
van het scherm van de telefoon.

Tik op 9 om het menu Dual Screen Tools te openen en toegang te krijgen
tot de hierna vertoonde opties.

9/@ U kunt er licht op tikken om het menu Dual Screen Tools weer te
geven of te verbergen.

@ U kunt tussen de schermen van het dubbele scherm en de telefoon
schakelen.

@ U kunt het scherm vanuit de telefoon naar het dubbele scherm
verzenden.

@ U kunt het scherm vanuit het dubbele scherm naar de telefoon
brengen.

Indien u enkel het dubbele scherm gebruikt, kunt u de helderheid
van het scherm van de telefoon (hoofdscherm) verlagen voor
batterijbesparing. Indien u deze functie niet wilt gebruiken, veeg dan
over het hoofdscherm.

@ U kunt het dubbel scherm uitzetten.

"

»—— Dual Screen Tool

»—— Scherm verwisselen

»—— Hoofdscherm tonen op
Dual Screen

»—— Dual Screen tonen op
hoofdscherm

»—— Zet het Hoofdscherm in
slaapstand

—— Zet het Dual Screen uit

T
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E « Als u uw telefoon uitschakelt, wordt het dubbele scherm ook
uitgeschakeld. Indien u echter het dubbele scherm uitschakelt blijft de
telefoon aan.

- Deze functie is niet beschikbaar bij een vergrendeld scherm en wordt
geactiveerd wanneer u het scherm ontgrendelt.

De Modus Multi-Page gebruiken

U kunt gemakshalve het gebruik van een app uitbreiden naar het
hoofdscherm en het dubbele scherm.

E « Deze functie is ook beschikbaar in partner apps bovenop de Camera- en

Galerij-apps.
- De Ul kan verschillen afhankelijk van de gebruikte app.
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De Modus Multi-Page gebruiken in Camera
U kunt een foto of video maken op de telefoon of dubbel scherm en het
resultaat bekijken op het andere scherm.

T Op het homescreen, tik op (&) op het telefoonscherm of Dual Screen
en maak een foto of video.

2 Na het maken van een foto of video, selecteer het Voorbeeld
pictogram.

+ U kunt de foto of video die u gemaakt hebt, bekijken op het andere
scherm waar de camera niet draait.

Y

\

l

|
Voorbeeld pictogram

E + Als u op het Voorbeeld pictogram hebt getikt om een foto of video te
bekijken, blijft het voorbeeldscherm aan en geeft automatisch de laatste
foto of video weer terwijl u meer foto's of video's maakt.

« Deze functie blijft niet actief indien u de Camera app uitschakelt en
opnieuw opent.

LG Dual Screen (LM-G905N) 197



De Modus Multi-Page gebruiken in Galerij

Tik op [¢J(] in een map in Galerij op het dubbel scherm of telefoon om een
vergrote foto of video te bekijken op het tegenovergestelde scherm.

T Op het homescreen, tik op 8 op het telefoonscherm of Dual Screen.

7 Selecteer een albummap en tik dan op [<J(].

- De foto of video zal weergegeven worden in verlengd bekijken op
het tegenovergestelde scherm.

+ Tik op (J[J om deze functie te verlaten.

Extensiepictogram Herstel pictogram

l
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Dual Screen-app gebruiken

Telkens als u dubbel scherm aanzet, worden de ingestelde dubbel

scherm-apps automatisch gestart.

T In het homescreen, tik op Instellingen > Weergave > Dual Screen >
My Pick App.

7 Selecteer de apps die automatisch worden gestart telkens als u het
dubbel scherm aanzet.

- Bepaalde apps kunnen niet worden gestart als dubbel scherm-apps.

« De lijst van apps die op het scherm verschijnen kan verschillen,
afhankelijk van de apps die zijn geinstalleerd.

Een Videogesprek maken met de Dual Screen

U kunt uw afbeelding weergeven op de Dual Screen en de afbeelding van
uw tegenpartij aan de telefoon.

« Start een videogesprek aan uw telefoon.

- De afbeelding van uw tegenpartij wordt weergegeven op het
telefoonscherm en uw afbeelding wordt weergegeven in de rechter
benedenhoek van het telefoonscherm.

- Tik op [§5) bovenaan het telefoonscherm om uw afbeelding weer te
geven op de Dual Screen.

- Tik opnieuw op (3%] om terug te keren naar de vorige
weergavemodus.

E « De titel bovenaan en de knop onderaan verschijnen tegelijkertijd en
verdwijnen 4 seconden later.

« Terwijl u een videogesprek maakt of beantwoordt, kunt u andere apps
of functies gebruiken op het Dual Screen.
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Bewegen tussen App-schermen op Dual Screen
U kunt met drie vingers over het scherm schuiven om het appscherm
tussen het dubbel scherm en het scherm van de telefoon te verplaatsen.
+ Schuif het appscherm met drie vingers naar links of rechts om vrij te
bewegen tussen het hoofdscherm en het dubbel scherm.

I\

Schuif het app-scherm met drie vingers Verplaats het app-scherm naar het
hoofdscherm

o\

Schuif het app-scherm met drie vingers Verplaats het app-scherm naar het dubbele
scherm

+ Om deze functie te gebruiken moet het scherm tegelijkertijd met drie
vingers worden aangeraakt.
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Dubbel Toetsenbord gebruiken op Dual Screen

Terwijl u het toetsenbord verticaal gebruikt, kunt u het toetsenbord
uitbreiden om het bovenste scherm te gebruiken als een app scherm en
het onderste scherm als een toetsenbordscherm.

1 Zet het dubbel scherm om naar landschapsmodus op het
toetsenbordinvoerscherm.
2 Tik op & in het toetsenbordinvoerscherm van het dubbel scherm.

U kunt typen op het toetsenbord op het onderste scherm terwijl u
de ingevoerde tekst bekijkt op het bovenste scherm.

- Tik op 83 in uitvergrote staat om het toetsenbord onderin terug te
brengen naar de oorspronkelijke positie.

Dubbel Toetsenbord

E + Raak het appscherm met drie vingers tegelijk aan en schuif het naar
boven of naar beneden om het naar het boven of naar beneden te
verplaatsen. Zie Bewegen tussen App-schermen op Dual Screen voor
details.
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Mirrormodus gebruiken op Dual Screen

Bij gebruik van de camera voor het nemen van foto's kunt u voorbeelden
van de foto's bekijken op het dubbel scherm.

1 Tik op het homescreen op ().

2 Tik op ] bovenaan het camerascherm.
- Spiegelmodus verschijnt op het dubbel scherm.

Dual Spiegelmodus

rl

I\

I\

E + U kunt ook direct van het dubbel scherm foto's maken of video's
opnemen.

Gebruik het dubbel scherm om de hoek aan te passen voor verschillende
situaties, zoals hieronder vermeld.
- Opname met hoge kijkhoek: Gebruiken bij het maken van een foto met
veel mensen bij een concert of festival of bij het maken van een foto
van een grote ruimte.

Opname met lage kijkhoek: Gebruiken bij het maken van een foto van
uw kind op ooghoogte van uw kind of bij het maken van foto's van
hoge gebouwen en dergelijke.

Opnamen met hoge kijkhoek  Opnamen met lage kijkhoek
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Instant vastleggen gebruiken op Dual Screen
Als de telefoon is verbonden met het dubbel scherm, wordt de functie
Instant vastleggen [ ingeschakeld op het LG-toetsenbord.
U kunt het toetsenbord op het hoofdscherm gebruiken, een
schermopname vastleggen op het dubbel scherm en het direct inbrengen
in het toetsenbordinvoerscherm.
Tik op % op het LG-toetsenbordinvoerscherm.

+ Het scherm op het dubbel scherm wordt vastgelegd en automatisch

bijgevoegd op het toetsenbordinvoerscherm.

l% Instant vastleggen

o\
§

e ——— Oc€Maakte
schermafbeelding

)\

E + U kunt het toetsenbord niet uitbreiden naar beide schermen als deze
functie ingeschakeld is.
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LG Game Pad

U kunt virtuele controllers gebruiken op het productscherm om
spelletjes te spelen op de telefoon. Scheid bij het spelen van een spel het
hoofdscherm en het dubbel scherm zodat de controller het spelscherm
niet blokkeert.

1 Tik oIP&het homescreen op Game Launcher en selecteer LG Game
Pad

LG Game Pad

- LG Game Pad verschijnt op het productscherm.

2 Tikop @ en schuif dan naar links en rechts om uw voorkeursstijl voor
de LG Game Pad te selecteren.
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U kunt het spel spelen door de Dual Screen vast te houden zoals
hieronder te zien is.

E - LG Game Pad is alleen beschikbaar voor spellen die hardware gamepads
ondersteunen.
« Afhankelijk van het spel kan het zijn dat bepaalde apps of knoppen LG
Game Pad niet ondersteunen.
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Custom Game Pad aanmaken

Bovenop de LG Game Pad, kunt u uw eigen game pad aanpassen. U kunt

uw eigen game pad aanmaken dat gesynchroniseerd is met de knoppen
om het spel te spelen.

1 Start het spel op de Dual Screen.

- Draai het toestel horizontaal zodat de Dual Screen boven is en het
telefoonscherm onderaan.

Ve

A

2 Tik op het homescreen op Game Launcher en selecteer LG Game
Pad @ en veeg het dan naar het rechter uiteinde van het scherm.
- Custom Game Pad aanmaken verschijnt op het scherm.

« Tik op =+ op het scherm Custom Game Pad aanmaken.
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3 Tik op 4 bovenaan rechts van het scherm Aangepaste gamepad om
de beschikbare knoppen weer te geven en selecteer een knop om te
gebruiken op mijn Aangepaste gamepad.

+ De geselecteerde knop verschijnt op het scherm Aangepaste
gamepad.

A Terwijl u kijkt naar het scherm van het spel op de Dual Screen,

plaats de geselecteerde knop op de gewenste locatie van uw
telefoonscherm.

+ Selecteer [§ op het spel van de Dual Screen en synchroniseer het
met de nieuw aangemaakte knop.

- Pas de positie en grootte van de nieuw aangemaakte knop aan op
uw telefoonscherm.

5 + Door de nieuw aangemaakte knop op uw telefoonscherm te bedienen,
kunt u hetzelfde effect bekomen als het bedienen van de knop op het
dubbel scherm.
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5 Tik op \/ om Aangepaste gamepadop te slaan.
+ Als u Aangepaste gamepadopslaat, wordt dezelfde titel van het
spel gebruikt als de titel van Aangepaste gamepad.

E + Aangepaste gamepad die u aangemaakt hebt, zal het toegewezen
game pad zijn voor het spel.
+ Het kan zijn dat sommige knoppen niet werken als het spel bijgewerkt
is.
+ Aangepaste gamepad kan enkel aangemaakt worden op het
telefoonscherm. Dual Screen ondersteunt het niet.
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Handelsmerken

+ Copyright ©2020 LG Electronics Inc. Alle rechten voorbehouden. LG
en het LG-logo zijn geregistreerde handelsmerken van LG Group en
diens gelieerde partners.

- Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Fota's, Google Play Protect, Google Agenda,
Google Documenten, Google Drive, Google Spreadsheets en andere
gerelateerde merken en logo’s zijn handelsmerken van Google LLC.

- Alle andere handelsmerken en auteursrechten zijn het eigendom van
hun respectieve eigenaren.

VERKLARING VAN
OVEREENSTEMMING

Hierbij verklaart LG Electronics dat dit LM-G905N-product voldoet aan
de belangrijkste voorschriften en andere relevante bepalingen van richtlijn
2014/35/EU en 2014/30/EU.

U vindt een kopie van de verklaring van overeenstemming op
http//www.lg.com/global/declaration

Contactpunt voor naleving
regelgeving

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands
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Meer informatie

Voorzorgsmaatregelen voor productbehandeling
+ Dit product kan niet zelfstandig worden gebruikt.

+ Het product niet gebruiken of opladen wanneer er vocht in de
communicatie- en stroomaansluiting van het product aanwezig is.
- Dit kan leiden tot brand, elektrische schokken, verwonding of
apparaatstoring.

- Als er vocht is, stopt u direct het apparaat te gebruiken en
verwijdert u het vocht volledig.

+ Door het vocht in de natte apparaat verandert de kleur van het
productlabel in uw apparaat. Schade aan het toestel ten gevolge van
blootstelling aan vloeistof wordt niet door de garantie gedekt.

Onderdelen van gehard glas
De onderdelen van gehard glas van dit toestel zijn niet permanent en
kunnen na verloop van tijd verslijten.

+ Als u uw toestel op een hard oppervlak laat vallen of het blootstelt aan
zware schokken, kan het geharde glas beschadigd raken.
Als dit gebeurt, stop dan onmiddellijk met het gebruiken van uw
toestel en neem contact op met de klantenservice van LG.

+ Ukunt in de handel beschermhoesjes kopen om uw toestel tegen
schade te beschermen.

Merk op dat deze beschermhoesjes niet gedekt zijn door de garantie
van LG Electronics en dat de veiligheid niet verzekerd is.

De batterij gebruiken
- Dit product maakt geen gebruik van een eigen batterij.

- Als het product op een mobiele telefoon gemonteerd is, gebruikt het
de batterij van de mobiele telefoon.
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Verwijdering van uw oude apparaat

1. Dit symbool van de doorgekruiste vuilnisbak geeft aan dat

afgedankte elektrische en elektronische producten (WEEE)
afzonderlijk van het huishoudelijke afval moeten worden
verwijderd.

2. Oude elektrische producten kunnen gevaarlijke stoffen bevatten,

dus een juiste verwijdering van uw oude apparaat helpt bij het
voorkomen van mogelijke negatieve gevolgen voor het milieu

en de volksgezondheid. Uw oude apparaat kan herbruikbare
onderdelen bevatten die gebruikt zouden kunnen worden voor het
repareren van andere producten, en andere waardevolle materialen
die kunnen worden gerecycleerd voor het behoud van beperkte
grondstoffen.

3. U kunt uw apparaat meenemen naar de winkel waar u het

product hebt gekocht, of u kunt contact opnemen met uw
plaatselijke afvalinstantie voor de gegevens van uw dichtstbijzijnde
geautoriseerde WEEE-verzamelpunt. Voor de meest
geactualiseerde informatie voor uw land wordt verwezen naar
www.lg.com/global/recycling
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